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DaVinci Resolve 11

Welcome to the world’s most powerful color correction and 
online editing system on Mac, Linux and Windows!

DaVinci Resolve 11 combines the world’s most advanced color 
corrector with professional multi track editing, so now you can 
edit, color correct, finish and deliver all from one system!

DaVinci color correctors have been the standard in post 
production since 1984. DaVinci Resolve is the real time grading 
system that’s been used worldwide on more feature films, 
episodic television productions, commercials, independent 
films and music videos than any other.

Even though DaVinci Resolve is known for it’s color correction 
ability, it’s also been designed to be an extremely powerful 
editor as well as a manager of your entire creative workflow. 
Each page in DaVinci Resolve is logically organized into work 
areas for each stage in the post production workflow.

We hope you enjoy reading this manual. DaVinci Resolve 
is easy to learn and features the timeline tools professional 
editors need and the color correction tools that makes high 
end work so breathtaking!

The DaVinci Resolve Engineering Team

Welcome to DaVinci Resolve 11

DaVinci Resolve 11
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Introduction to Resolve

DaVinci Resolve integrates editing, color correction, and finishing within a single, easy to learn 
application. The editing and grading tools found in Resolve should be immediately familiar 
to experienced artists who’ve used other postproduction applications, but they’re also very 
approachable to folks who are new to postproduction.

Additionally, dedicated tools available for on-set workflows integrate tasks such as media 
duplication, shot and metadata organization, and on-location look management into a complete 
tool set that lets you smoothly segue from the camera-original media being acquired in the field 
to the organization and use of that media in a wide variety of postproduction workflows that use 
DaVinci Resolve at their heart.

The tight integration in Resolve between on-set media, metadata, and “look” organization, editing, 
and grading means that you can freely move from one task to the next without skipping a beat. 
This makes it easy to color-correct clips in the middle of an edit, and then go right back to editing, 
without needing to export projects or launch other applications. And you can go further, using 
the collaborative features of DaVinci Resolve to enable multiple artists, for example an editor,  
a colorist, and assistants, to work together on the same timeline simultaneously, for the ultimate 
integrated workflow.

Of course, no postproduction professional works in a vacuum, and DaVinci Resolve makes it easy to 
work with other facilities by importing projects and exporting timelines among applications such as 
Apple’s Final Cut Pro 7 and Final Cut Pro X, Adobe Premiere Pro CC, Avid’s Media Composer, and 
many other applications via robust support of XML, AAF, and EDL import and export workflows.

This chapter introduces the DaVinci Resolve user interface (UI), explaining where to find each group 
of features, and how the highly focused and tightly integrated Media, Edit, Color, and Deliver 
pages of functionality work together to let you pursue nearly any postproduction workflow you 
can imagine. After this brief tour, the rest of this manual provides much more in-depth information 
about every aspect of functionality found in DaVinci Resolve.

Getting Started� 12

Logging In� 12

The Project Manager� 13

Preferences� 14

Project Settings� 15

Switching Among Pages� 17

The Media Page� 18

The Library� 19

Viewer� 20

Media Pool� 20

Metadata Editor� 21
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When you install DaVinci Resolve and then open it for the first time, there are a few things you’re 
going to want to do before you begin working on your first project.

Logging In

DaVinci Resolve was originally designed as a multi-user application for professional grading suites 
where an elaborately appointed room at a high-end facility was being shared among a stable of 
colorists. Resolve is still very much used in that capacity, and the login screen provides the interface 
that’s used to create and manage multiple users on a single workstation.

Another way of looking at the multi-user capabilities of Resolve is organizational in nature. Each 
login has individual settings, preferences, projects, and PowerGrades. This means that you can 
create users, not for specific individuals, but for specific types of projects that you want to share 
common project settings and PowerGrades.

To open a user, simply double-click that user’s icon, or follow the on-screen instructions to create a 
new user and then double-click it to open.

Whether you simply use the default admin login to do your work (which is fine), or you create your 
own individual login, there are several controls for creating and customizing user logins, all of which 
are covered in Chapter 2, “Logging in and the Project Manager.”

Getting Started

The login screen that appears when you first open Resolve
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The Project Manager

The Project Manager is a centralized interface for managing all projects belonging to the user 
who’s currently logged in, whose name appears at the bottom left-hand corner in a project title bar.  
This is the second window you’ll see when opening DaVinci Resolve. The Project Manager is also the 
place where you import and export projects to and from Resolve, whether you’re moving projects 
around from user to user, or moving projects from one Resolve workstation to another.

To open any project, double-click it. To create a new project, double-click the New User icon.

More information about the Project Manager appears in Chapter 2, “Logging in and the 
Project Manager.”

The Project Manager shows all projects belonging to the current user
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Preferences

The Preferences Window lets you set up the overall environment of your DaVinci workstation, 
choosing which language to display the interface with, what hard drive volume to use as the scratch 
disk, what I/O interfaces to use for playing audio and viewing video output, and which, if any, control 
surface to use while grading. If you have a system that doesn’t change very often, then you may 
only rarely use the Preferences window. On the other hand, if you’re working with a mobile system 
with changing video interfaces, control panels, and scratch volumes, then you may use this window 
more frequently.

Whenever you change any settings in the Preferences, you must quit and restart Resolve for those 
preferences to take effect.

The DaVinci Resolve Preferences let you set up your environment

A quick overview of the Preferences appears below, but for more information, see Chapter 3, 
“Project Settings, Caching, and Preferences.”

System Overview

Provides an overview, for reference, of all hardware and computer characteristics that are relevant 
to DaVinci Resolve running smoothly, including listing of installed GPUs. A Language pop-up at 
top lets you specify which language the DaVinci Resolve user interface displays. Resolve currently 
supports English, Chinese, and Japanese.
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Media Storage Volumes

This is a list within which you define the scratch disk used by your system. The first volume in this 
list is where Gallery stills and cache files are stored, so you want to make sure that you choose the 
fastest storage volume that’s connected.

Video I/O and GPU

The preferences in this panel let you choose video interfaces and GPU processing hardware on your 
workstation. If you have multiple Blackmagic Design I/O interfaces connected to your computer, 
you can choose one to use for monitoring video output, and one to use for Resolve Live, a feature 
that lets you grade camera output during a shoot as part of an on-set workflow.

Control Panels

Lets you choose and configure (if necessary) a control surface that’s connected for use during 
grading in Resolve.

Project Settings

Once you’ve created a project, all project-specific settings are found in the Project Settings 
window. The Project Settings window is divided into a series of panels which can be selected 
from a sidebar to the left. Each panel contains a collection of related settings that affects some 
category of Resolve functionality.

To open a panel of settings, simply click its name in the sidebar at the left.
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The Master Project Settings define the principal attributes of a project, such as the timeline 
resolution, timeline frame rate, color science, and bit depth. Image Scaling settings define how clips 
that don’t match the timeline resolution are scaled to fit. There are other panels for Editing settings, 
Color settings, Lookup Tables (LUTs), etcetera.

For more information about Project Settings, see Chapter 3, “Project Settings, Caching, and 
Preferences.”

The Project Settings show all project-specific settings and attributes
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DaVinci Resolve is divided into four main pages of functionality, which can be accessed using four 
buttons at the very bottom of the DaVinci Resolve interface. These buttons are organized in order 
of workflow, and they’re always available, letting you quickly switch between importing media, 
editing, grading, and outputting your project in a structured manner.

You can also switch pages using the following keyboard shortcuts. 

Buttons for switching pages appear at the bottom of the UI

Switching Among Pages

Page Alpha 

Media F3

Edit F4

Color F6

Deliver F8
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The Media Page

The Media page is the primary interface for media management and clip organization in DaVinci 
Resolve. It’s central to the way DaVinci Resolve works that the source media used by a project 
is organized separately from the project data that you import and manage in the Edit page. In 
this way, you can manage and update the clips used by timelines in the current project with ease, 
switching between offline and online media, reorganizing clips, and troubleshooting any problems 
that occur.

The Media page also contains much of the core functionality that will be used for on-set workflows, 
and in the ingest, organizational, and sound-synching steps of digital dailies workflows. This chapter 
covers most of the functionality found in the Media page, including functions in detail that are 
referenced throughout this manual.

The Media page is divided into six different areas, designed to make it easy to find, select, and 
work with media in your project. Much of the functionality and most of the commands are found 
within the contextual menus that appear when you right-click clips in the Library, File Browser, or 
Media Pool.

For more information on using the Media page, see Chapter 4, “Media.”

Media page
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The Library

The Library browser shows a list of all volumes that are currently available to your Resolve workstation. 
It’s used to locate media that you want to import manually into your project. 

Library with scrubbable clip view
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Viewer

Clips that you select in any area of the Media page show their contents in the Viewer. A jog bar 
appears directly underneath the image, letting you drag the playhead directly with the pointer. The 
full width of the jog bar represents the full duration of the clip in the Viewer. The current position 
of the playhead is shown in the timecode field at the upper right-hand corner of the Viewer. Simple 
transport controls appear underneath the jog bar, letting you Jump to First Frame, Play/Stop, and 
Jump to Last Frame.

Media Pool

The Media Pool contains all of the media that you import into the current project. It also contains any 
media that’s automatically imported along with Timelines that have been imported into Resolve. 
Ordinarily, all media imported into a project goes into the Master folder, however the Media Pool 
can be organized into as many user-definable folders as you like, depending on your needs. Media 
can be freely moved from one folder to another from within the Media Pool.

Viewer

Media Pool with the Bin View closed
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Metadata Editor

When you select a clip in any area of the Media page, its metadata is displayed within the Metadata 
Editor. If you select multiple clips, only the last clip’s information appears. The Metadata Editor’s 
header contains uneditable information about the selected clip, including the file name, directory, 
duration, frame rate, resolution, and codec. A series of editable fields within the Metadata Editor 
lets you review and edit the different metadata items that are available. A pop-up menu at the 
upper-right of the Metadata Editor lets you choose from many different sets of metadata fields and 
checkboxes, each grouped for a specific task or workflow.

Clip Metadata Editor
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Audio Panel

The Audio Panel can be put into one of two modes via a pop-up menu at the lower left corner. In 
the default Levels mode, Audio Meters are displayed that show the levels of audio in clips you’re 
playing. In Dailies mode, you can load audio clips side by side with video clips opened in the Viewer 
in order to sync them together manually. The Audio Panel can also be hidden.

Audio Meters exposed
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The Edit page exposes a source-record style NLE that incorporates many specialized features 
for finishing. The Edit page is divided into three main regions: the browsers found at the left, the 
Viewers at the top, and the Timeline at the bottom, all of which work together to let you import, 
edit, and trim timelines with a flexible variety of tools and methods.

For more information on the Edit page, see Chapter 6, “Edit.”

The Browser

A unified browser lets you organize and peruse all of the timelines and media in a project. The 
Browser can be switched among two different modes, showing Timelines or the Media Pool, by 
clicking the appropriate button.

Timeline Browsing

DaVinci Resolve projects contain one or more edited timelines (sometimes called a sequence 
in other applications) which are organized in the Timelines Browser, which contains all timelines 
that have been either imported or created within that project. A folder view at the left shows a 
hierarchical list of folders that you can use to organize your timelines. The folder view can be hidden 
or shown via the button at the far left of the Edit page toolbar.

The Edit Page

The Edit page

The Timeline list
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Media Pool Browsing

The Media Pool in the Edit page is identical to that shown on the Media page, and shows you all 
of the source clips that are available for editing. A folder view at the left shows a hierarchical list 
of folders that you can use to organize your media. By default, the Media Pool has a single folder, 
named “Master,” but you can add more folders as necessary to organize your clips. The folder view 
can be hidden or shown via the button at the far left of the Edit page toolbar. A panel to the right 
shows the contents of the currently selected folder.

The Media Pool in Thumbnail mode
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Effects Library Browsing

The Effects Library contains a folder with the different Video Transitions, Title Effects, Generators, 
and Filters that are available for editing in the Timeline. The Effects Library has two panels, a Toolbox 
panel that contains the default Transitions, Titles, and Generators that Resolve comes with, and an 
OpenFX panel that contains any OpenFX transitions and generators you might have installed on 
your system.

The Effects Library, made taller to show all of its contents



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

INTRODUCTION TO RESOLVE1

26

Edit Index

Clicking the Edit Index button opens the Edit Index. By default, this shows an EDL-style list view of 
all the edit events in the current Timeline. Whichever timeline is selected in the Timeline list displays 
its events here; each clip and transition is shown as an individual event, each of which contains 
multiple columns of information. If you re-edit a timeline, your changes are automatically reflected 
in this list. 

Source/Offline and Timeline Viewers

The Source Viewer lets you view individual clips from the Media Pool to prepare them for 
editing. Meanwhile, the Timeline Viewer shows the frame at the position of the playhead in the 
Timeline. You can select either viewer by clicking, and the name of the viewer that currently 
has focus appears in orange. The color shown in the Source Viewer always reflects that of the 
original source media, while the Timeline Viewer shows whatever grading you’ve done in the 
Color page.

Edit Index List shown open
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Inspector

The Inspector can be opened to let you customize compositing, transform, and cropping parameters 
for clips, as well as clip-specific retime and scaling options. Furthermore, the Inspector lets you edit 
the parameters of transitions, titles, and generators used in the Timeline, in order to customize their 
effect. When the Inspector is open, the Edit page switches to a single-viewer mode, showing you 
the Timeline item that you’re inspecting alongside the Inspector with that clip’s parameters.

Source and Timeline viewers

The Inspector, opened and showing a clip’s parameters
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Toolbar

Eleven buttons starting from the left, running along the top of the Timeline, let you choose different 
tools for performing various editing functions.

Timeline

The Timeline shows whichever timeline you’ve double-clicked in the Timelines browser. It’s the 
workspace where you either edit programs together from scratch, or import sequences from other 
applications to work on inside of Resolve. You can only have one Timeline open at a time.

The Timeline is divided into audio and video tracks, each of which has a series of header controls 
at the left that let you choose destination tracks for editing, name tracks, and turn tracks on and 
off, among other things. The appearance of the Timeline can be customized using the Customize 
Timeline pop-up at the bottom right.

An edited timeline

Buttons in the Toolbar
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The Color page is where you color correct, or grade, your program. It has all of the controls available 
for manipulating color and contrast, reducing noise, creating limited secondary color corrections, 
building image effects of different kinds, adjusting clip geometry, and making many other corrective 
and stylistic adjustments. The Color page is divided into seven main areas that work together to let 
you build a grade. It’s divided into seven regions.

The default layout of the Color Page

For more detailed information about the Color Page, see Chapter 11, “Color Page Basics.”

Viewer

The Viewer shows the frame at the current position of the playhead in the Timeline. The contents 
of the Viewer are almost always output to video via whichever I/O interface you have connected. At 
the top of the Viewer is a header that displays the Project and Timeline names, as well as a Viewer 
Timecode display that shows the source timecode of each clip by default. The Timeline name is also 
a pop-up display that lets you switch to any other timeline in the project. A scrubber bar underneath 
the image lets you drag the playhead across the entire duration of the clip, while transport controls 
underneath that let you control playback. A toolbar at the top provides controls governing Image 
Wipes, Split-Screen controls, and Highlight display. Additional controls let you turn audio playback 
on and off, and choose which on-screen controls are currently displayed.

The Color Page
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Viewer with transport controls

Gallery

The Gallery is used for storing still frames to use as reference when comparing clips to one another. 
Each still frame also stores that clip’s grade so you can copy it later; stills and grades are stored 
together. A button lets you open up the Album browser, used for organizing your stills. At the top 
of the Gallery, Memories let you store grade information that you can apply using a control surface 
or keyboard shortcuts. You can also open a larger Gallery window within the Color page that 
provides more room for organizing your saved stills and grades. For more information on the Gallery 
page, see Chapter 13, “The Gallery and Grade Management.”

The Gallery has Memories, Stills saved in Albums and your PowerGrades
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Node Editor

The Node Editor is where you assemble one or more individual corrections (nodes) together to 
create multi-correction grades (seen as node trees). This is a powerful way of assembling grades, 
since different combinations of nodes let you create different corrections and very specific 
adjustments by reordering operations, combining keys, or changing the layer order of different 
adjustments. For more information about the Node Editor, see the “Node Editor Basics” section of 
Chapter 12, “Advanced Color Features.”

Node Editor to construct your grade processing signal flow
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Timeline

The Timeline in the Color page reflects the contents of the Timeline in the Edit page, but has a 
different appearance that’s tailored to the requirements of the colorist. However, the content is 
identical, and changes made to the Timeline in the Edit page are immediately seen in the Color 
page as you switch back and forth. The Color page Timeline provides several ways of navigating the 
clips in your project, as well as keeping track of what has been done to which clips. 

The Timeline is divided into three parts, each of which shows different information and provides 
differing controls. A Timeline Ruler at the top lets you scrub the playhead across multiple clips, and 
can be zoomed out enough to show every clip in your entire program. Underneath, the Mini-
Timeline (which can be opened or closed via a button at the right of the palette bar) shows a small 
representation of the Timeline in the Edit page wherein each clip is as long as its actual duration. At 
the bottom of the Timeline is the Thumbnail timeline, in which each clip is represented by a single 
frame. The currently selected clip is outlined in orange, and information appears above and below 
each thumbnail such as each clip’s source timecode, clip number and track number, version name, 
whether it’s been graded, whether it’s been tracked, if it’s been flagged, and so on. 

The Timeline

Left Palettes

A series of palettes at the bottom left of the Color page provide access to different sets of grading 
tools, used principally for manipulating color, contrast, and raw media format settings. Each 
individual palette is opened by clicking the corresponding icon at the top of the Palette panel. 

The available palettes are the Camera Raw palette (for making metadata adjustments to raw 
media formats), the Color Match palette (for creating automatic grades by sampling on-camera 
color charts), the Color Wheels (graphical color balance controls and master wheels), the Primary 
controls (sliders for adjusting YRGB Lift/Gamma/Gain), the RGB Mixer (for mixing color channels 
into one another), and the Motion Effects palette (with controls for noise reduction and artificial 
motion blur).
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Left palette selection buttons

Center Palettes

At 1920x1080 resolution or higher, a second set of palettes is organized at the bottom center of the 
Color page. These palettes span a wide range of functionality, and the adjustments you make with 
them can be combined with those made using the Color palettes.

Center palette selection buttons

Note: At lower resolutions, the Left and Center palettes are merged to fit the Resolve interface into 
a smaller area.

The nine available Center palettes include the Curves palette, the Qualifiers palette, the Power 
Windows palette, and Tracker palette, the Blur palette, the Key palette, the Sizing and Stereoscopic 
3D palettes, and the Data Burn-In palette.
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Keyframes Editor

The Keyframes Editor provides an interface for animating Color, Sizing, and Stereo Format 
adjustments over time. Each node in the Nodes Editor corresponds to a track in the Keyframes 
Editor, which lets you animate each node’s adjustments independently.

Keyframe Editor displaying dynamic grade changes

Furthermore, each node’s track can be opened up to reveal Parameter Groups, so that you can 
animate subsets of an individual node’s functions independently of other functions within the 
same node.
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Once you’ve finished grading your project, you need to either render it, or output it to tape to 
deliver it to your client. This is where the Deliver page comes in. The Deliver page can be used both 
to output digital deliverables, or to output tape, depending on which mode you enable. Either way, 
the Deliver page is divided into five areas of functionality, each of which lets you set up a different 
part of a render or output to tape.

The Deliver page is set up to let you queue a series of individual jobs, each of which can have 
different settings, or be set up to render different parts of the Timeline. In this way, you can output 
multiple deliverables, or re-render multiple areas of a timeline, as your needs require.

For more information about using the Deliver page, see chapter 14, “Deliver.”

The Render Settings List

The Render Settings list contains the customizable settings that affect how media is rendered out 
of Resolve. These settings are covered in more detail later in “File-based Output.” If you’re using 
the Edit To Tape option, these settings are all disabled. 

>> Basic contains only the most essential controls needed for defining whether to render 
a single clip or multiple clips, the render format, audio settings, and the file name and 
destination for the media you’re delivering. This setting is appropriate for most situations 
where your output is fairly straightforward.

The Deliver Page

Deliver page
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>> Intermediate adds the Presets controls for using and saving Easy Setups for commonly 
performed delivery tasks. Additional parameters also appear for adjusting more specific 
aspects of your render, such as manual video/data level adjustment, data burn-in presets, 
and options for controlling sizing, debayer quality, and flat pass output. Intermediate also 
lets you create additional output passes, to output the same job with different format, 
codec, and data burn-in settings. 

>> Advanced provides all of the outputting options of DaVinci Resolve, including file name 
prefix and suffix editing, subfolder organization, render speed controls for limiting LAN 
bandwidth usage, commercial workflow options for rendering multiple versions and 
organizing media in different ways, and stereoscopic rendering control.

Render settings
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The Deliver Page Timeline

The Timeline mirrors the Timeline seen in the Color page. You can use the Timeline in the Deliver 
page to turn off tracks with clips you don’t want to include in the operation, define the range of clips 
you want to render or output to tape, and to choose which versions for each clip you want to output.

The Deliver page’s Thumbnail and Mini-Timeline match the Color page

The Deliver page Timeline also has the Timeline Filter pop-up at the right-hand side of the toolbar. 
Using this pop-up to filter the contents of the Timeline lets you restrict the range of media you want 
to output in different ways. For example, if you’ve already rendered a timeline, but you’ve since 
made some changes, you can use the “Show Modified Clips” option to display only the clips that 
have changed within a particular timeframe. Another possibility is to choose the “Show Unrendered 
Clips” option to show all clips that have not yet been rendered.

The Viewer

When rendering file-based media, the Viewer shows you exactly how the media being output will 
look using the current settings, and the Transport controls move the playhead throughout the 
current Timeline. 

Deliver Viewer
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When outputting to tape, the Viewer shows you the tape output so you can set up insert or assembly 
edit points, and the Transport controls move the tape in the deck if device control is enabled.

The Render Queue

The Render Queue is a list of all the jobs you’ve queued up for file-based rendering. Each job can 
have an individualized range of clips and render settings, which you can use to render multiple 
sections or clips of a timeline, the same timeline output to multiple formats, or multiple timelines.

The Render Queue displays all jobs

The Render Queue also has the option to show either just the jobs within the current project, or jobs 
queued up and saved within all projects for the current user.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

INTRODUCTION TO RESOLVE1

39

User Interface Conventions in Resolve

While each chapter covers the unique on-screen controls found in each page of DaVinci Resolve, 
this section summarizes how to use some of the more common controls you’ll see.

Customizing Pages

Each page of Resolve is divided into multiple panels, viewers, and palettes, each of which contains 
specific sets of functions. These can be customized in one of three ways. 

You can resize different regions of the interface by positioning the pointer at the border between 
any two panels, and dragging it to enlarge one and shrink the other.

(Before/After) Resizing UI regions

You can also open and close different panels by clicking the appropriate button. For example, the 
Audio panel on the Media page can be opened or closed by clicking the Audio panel button on 
the toolbar.

(Before/After) Showing and hiding panels
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Certain UI elements can be expanded, in the process rearranging another part of the UI, by clicking 
a small gray Expand button. For example, an expand button at the bottom left of the Keyframe 
Editor in the Color page can be clicked to make the Keyframe Editor wider, while at the same time 
hiding controls at the center to make room.

(Before/After) Expanding the Keyframe Editor

Lastly, there are two interface elements that are exposed in separate windows. The first of these, the 
Audio Mixer, lets you analyze the volume and set levels of tracks and clips in your timeline.  
The Audio Mixer can be opened by choosing View > Audio Mixer while you’re in the Edit page. 

The Audio Mixer

The Video Scopes let you precisely analyze the color and contrast of clips in the Color page. 
They’re available by right-clicking the Color page Viewer and choosing Show Scopes from the 
contextual menu.
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The Video Scopes

Both the Audio Mixer and Video Scopes can be moved to a second computer display if one’s 
available, and both disappear temporarily if you change pages or switch to another application.

Resetting the UI

If you’re unhappy with the way you’ve rearranged the Resolve UI, you can choose View > Reset UI 
Layout to restore the UI to the default arrangement.

Dual Monitor Layouts

The Media, Edit, and Color pages can be switched between single screen and dual screen layouts 
by choosing View > User Interface Layout > Dual Screen > On. Each dual screen layout makes it 
possible to see many more controls at once, often in a larger workspace that lets you manage more 
clips, more gallery stills, etcetera.
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The Edit Page dual screen layout

In single screen mode, you can choose which display shows the Resolve UI by choosing View > User 
Interface Layout > Primary Display > Display 1 or Display 2. In dual screen mode, this reverses the 
contents of both monitors.

Contextual Menus

Nearly every panel on every page exposes additional functionality via contextual menus, which 
appear when you right-click on the appropriate item. Sometimes, different commands become 
available depending on whether you right-click the background of a particular panel, or on an item 
such as a still or node.

Contextual menus expose additional controls in the Color page Viewer
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Buttons and Pop-up Menus

Most of the buttons and pop-up menus that appear in various toolbars are activated with a single 
click. Many panels and palettes appear with a Mode pop-up at the upper right-hand corner that lets 
you choose a different type of function within that palette.

Mode pop-up

Additionally, many panels, palettes, and windows expose an Option menu, that appears as three 
vertical dots, which expose additional commands related to that particular function.

Option menus
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Adjusting Parameters

Numeric parameters can usually be edited in a few different ways. If a slider appears, you can drag 
it to change the value. If a number field appears, it can also be used as a “virtual slider” by clicking 
and dragging to the right to raise the value, or to the left to lower the value (orange arrows indicate 
the direction of change).

Using virtual sliders

Double-clicking most numeric values highlights the number so that you can type a new value using 
the keyboard, pressing Return to confirm the change. Finally, to reset any editable parameter to its 
default setting, double-click its name.



2
Logging In and The Project Manager
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Logging In and The Project Manager

This chapter covers three vital steps in the process of setting up to work in DaVinci Resolve: creating 
a user within which you’ll be saving your projects, creating and organizing your projects, and saving 
projects. It’s a good idea to familiarize yourself with the information in this chapter prior to getting 
started with Resolve.

Logging In and Creating New Users� 47

Creating a User and Logging in� 47

Creating and Managing Projects� 50

Project Management� 51

Importing and Exporting Projects� 52

The Project Manager Interface� 52

Saving Projects� 57

Dynamic Project Switching� 58
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When you install DaVinci Resolve and then open it for the first time, there are a few things you’re 
going to want to do before you begin working on your first project.

Creating a User and Logging in

DaVinci Resolve was originally designed as a multi-user application in commercial suites. Resolve 
is still very much used in that capacity, and the login screen provides the interface that’s used to 
create and manage multiple users on a single workstation.

Each login has individual settings, preferences, projects, and PowerGrades. Furthermore, if you set 
up multiple logins, each user’s login can be password protected to keep it private.

On the other hand, if you’re in a single-user situation, this may be overkill. Regardless, whether you 
simply use the default admin login to do your work (which is fine), or you create your own individual 
login, there are several controls for creating and customizing user logins.

Logging In and Creating New Users

Login window
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To Create a New User:

1.	 Click the New User button at the bottom left, or double-click the New User icon in the middle 
of the login screen. 

2.	 Enter the following information:

>> 	Name: This is the only setting you really need to enter, to identify the user.

>> 	Password: (optional) If your login requires security, you can enter any password you like. 
You’ll need to enter the same password into the Confirm Password field to make sure a 
typo doesn’t cause you to create a password you didn’t intend.

>> Icon: (optional) If you have a picture you’d like to use as the icon for this login, you can click 
the photo region and choose one.

3.	 Click Setup New User.

To alter a user’s settings:

>> If you’ve already created a user, select that user’s icon and click the gear icon to open 
the Account Settings dialog for that user, in which you can change all of the settings you 
originally defined.

To delete a user:

>> Right-click on a user you’ve created, choose Delete User, then click Yes to confirm 
when prompted.

New user window
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Warning: Deleting a user also deletes all of the projects and PowerGrades associated with that user, 
so do this with care, and if necessary, back up all projects and/or databases associated with that 
user before deletion.

By default, every new installation of DaVinci Resolve starts out with two logins that cannot be 
deleted. The admin has special privileges for setting system configuration presets, while the guest 
login is useful for visitors to your suite who just need to log in quickly to get some work done.

To log in as a user:

1.	 If necessary, use the scroll bar along the bottom to find the login you want to use, and do one 
of the following:

>> Click to select a user’s icon, then click Log In.

>> Double-click any user’s icon to log in as that user.

2.	 If your login is password protected, you’ll be prompted to enter it now.

Before you log in, if you’ve just installed DaVinci Resolve and have opened it for the first time, it’s 
time to set the preferences. For more information about setting the preferences in Resolve, see 
Chapter 3, “Project Settings, Caching, and Preferences.”

Behind the Scenes: DaVinci Resolve Databases

By default, DaVinci Resolve uses a disk database to keep track of all of the users and projects you 
create. You’ll use the Project Manager (described in the next section) to manage your projects, 
which are saved to a specific directory on your system that corresponds to the operating system you 
use. However, you can create other databases of different kinds depending on whether or not you 
want to set up multiple DaVinci Resolve workstations to work together. For more information about 
creating and managing databases, see Chapter 16, “Managing Databases and Remote Grading.”
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Creating and Managing Projects

The Project Manager provides a centralized interface for managing all projects belonging to the 
user who’s currently logged in and whose name appears at the lower left-hand corner in a project 
title bar. This is the second window you’ll see when opening DaVinci Resolve.

If you’ve already opened a project, you can open the Project Manager at any time by clicking the 
Home button at the bottom left-hand corner of the Resolve window. If you need to return to the Log 
In screen, you can click the User Name pop-up menu at the lower left-hand corner.

Project Manager

The Project Manager button at the bottom left corner of the DaVinci Resolve interface

Project Manager and Project Settings buttons
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Project Management

The Project Manager provides an in-application interface for creating, renaming, and deleting 
projects saved within the current user account. Many of these commands exist within the contextual 
menu that appears when you right-click the background of the Project Manager.

Methods of project management:

>> To create a new project: Double-click the Default Project, or click the Plus button at the 
bottom left of the Project Manager. A new project is created, and Resolve opens up 
the Media page. To alter the project settings, open the Project Settings by clicking the 
gear icon.

>> To load a previously saved project: Double-click any Project icon, or Item if you’re in List 
view. Or, select a project and click the Open button in the lower right-hand corner.

>> To load a project in Read-Only Mode: Right-click a Project icon or Item, and choose Load 
in Read Only Mode. This lets you open a project without danger of altering it. If you make 
changes, then you can save a new copy of the project with a new name.

>> To rename a project: Right-click a Project icon or Item, choose Rename, and type a new 
name in the dialog that appears, clicking OK when you’re finished.

>> To load a config from another project to the currently open project: Right-click a Project icon 
or Item (other than the currently open project), and choose “Load config to current project.”

>> To delete a project: Right-click a Project icon or Item, and choose Delete. Click OK when a 
dialog asks you to confirm the operation.

Note: You cannot move or delete the currently loaded project.
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Importing and Exporting Projects

Another set of commands let you import and export projects. Because all projects are managed 
by a Resolve database, this is the only recommended way to export and import individual projects, 
even for file-based projects.

Methods of importing and exporting projects

>> To export a project: If you need to export a project to another location, such as to copy it to 
the disk of a client you’re delivering the project to, you can right-click a Project icon or Item, 
choose Export, then in the Save dialog choose a location, enter a name, and click Save. This 
can also be done from the File menu in the main Resolve interface.

>> To import a project: Right-click any empty area of the Project Manager and choose Import, 
then find and select a project file using the Import Project File dialog, and click Open.

Note: You cannot move or delete the currently loaded project.

The Project Manager Interface

The Project Manager’s contents are different for each user. Once you’ve logged in, you can create, 
delete, and import projects, as well as organize and search for projects if the Project Manager is 
very full.

Project View

Two buttons at the top right let you switch the Project Manager between Icon and List View. You 
can freely change views at any time.

In Icon View, each project is represented by a large image that can be hover-scrubbed to reveal 
five representative images from that project, with a brief description underneath that includes the 
frame size, number of timelines, and when that project was last modified.

Select Icon or List view
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In List View, every project appears as an item on a list that has six columns: Name, Last Modified, 
Timelines, Format, Frame Rate, and Date Created. You can click any column header to sort the 
contents of the Project Manager by that criteria; clicking the header a second time toggles that 
column between ascending and descending sorting. 

Project List view

Searching For Projects

A pop-up menu and search field at the upper right-hand corner of the Project Manager lets you 
search for specific projects.

Focus search criteria

Hover-scrub over project icon
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Using the pop-up menu, you can choose to search by name, or by project format. Once you’ve 
chosen a criteria, begin typing into the search field, and the Project Manager will immediately and 
dynamically begin to be filtered by your search text.

Creating Folders

If you’re organizing a lot of projects, you can create folders to put them into. 

Methods of working with project folders:

>> To create a folder: Click the Folder button at the bottom left area of the Project Manager, 
then enter a name into the Create New Folder dialog and click Create.

>> To delete a folder: Right-click a folder, choose Delete, and click Yes when prompted.  
All projects inside a deleted folder will be deleted as well.

>> To rename a folder: Right-click a folder, choose Rename, then enter a new name and  
click OK.

>> To open a folder: Double-click a folder to open it and view its contents. At the upper left-
hand corner of the Project Manager, a folder path view shows you which folder is open, as 
well as where you are within a nested series of folders if that’s what you’ve set up.

>> To exit a folder: Click the Home icon at the upper left-hand corner of the Project Manager.

>> To move a project into a folder: Drag the project onto a folder icon, and drop it to place it 
inside the folder.

>> To move a project out of a folder: Open a folder, select one or more projects you want to 
move, then right-click one or more selected projects and choose Cut from the contextual 
menu. Then, navigate to the next place in the Project manager where you want to place 
the cut projects, right-click the background of the Project Manager, and choose Paste.  
The projects should appear in the new location.

A Project (left) and a folder (right) in the Project Manager
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Group Projects Browser

The Group Projects button at the bottom left-hand corner of the Project Manager opens up the 
Group Projects browser. This browser lets you import projects from other users into the Project 
Manager for the current user that’s logged in.

Furthermore, if you’re on a system that’s configured to use databases for project management, a 
pop-up menu at the top of the Group Projects browser lets you open up another database entirely 
to browse its users and projects.

Group Projects browser button

Project manager with Group Projects browser displayed
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To use the Group Projects browser:

1.	 Click the Group Projects button to open the browser. It always appears in List view.

2. 	 Choose a disk or database from the pop-up menu at the top of the browser to reveal that disk 
or database’s users in the browser

3. 	 Click the disclosure triangle to the left of any user to reveal that user’s projects in a 
hierarchical list.

4. 	 To import a project into the current user, right-click it and choose Import.

5. 	 A dialog appears that lets you change the name of the project being imported. If you like, 
change the name, then click OK.

	 That project should now appear in the Project browser to the right. When you’re done 
importing projects, click the Group Projects button again to close the browser.

	 Note: For more detail on shared database setup and operation, see Chapter 16, “Managing 
Databases and Remote Grading.”
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Saving Projects

Once you’ve created and opened a project, you want to make sure that you regularly save your work.

Methods of saving projects:

>> Choose File > Save Project (Command-S).

>> Push the SAVE button on the DaVinci Control Surface.

>> To save the current state of your project as a copy with a new name, choose File > Save 
Project As, then enter a name into the Save Current Project window and click Save.

DaVinci Resolve also has an auto save mechanism that you can enable in the Project Settings.  
This means that every project has its own auto save settings individually enabled or disabled.

To enable Auto Save:

1.	 With a project opened, click the gear icon, at the bottom left-hand corner of the DaVinci 
Resolve interface.

2. 	 When the Project Settings window appears, click Auto Save in the left hand sidebar.

3. 	 There are three options in the Automatically Save project setting:

>>Off: Disables Auto Save. This is the default.

>>On: Automatically saves and overwrites the current project every few minutes, as defined 
by the pop-up menu below.

>> To backup project: Automatically saves new projects to a backup list. Each backup is an 
individual project file, so this lets you version your work. The total number of backup files 
that are saved can be selected via the “Retain the last X backups” pop-up menu. Backups 
are discarded in first in, first out fashion.

4. 	 Click Apply to confirm your change, and then close the Project Settings window.

Auto Save controls in the Project Settings
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Dynamic Project Switching

Dynamic Project Switching is an option in the Project Manager contextual menu that lets you load 
multiple projects into RAM simultaneously, so that you can quickly switch from one to the other. 
If you plan on opening many projects, or a few very large projects, you should be sure to use a 
workstation with lots of RAM installed or you could experience a slowdown in performance.

Using dynamic project switching, you could, for example, open two different projects, and then 
copy a node’s settings from the Node Editor of one project and paste those settings into a node 
within the Node Editor of another project.

Methods of using Dynamic Project Switching:

>> To enable Dynamic Project Switching: Open the Project Manager, right-click anywhere 
within the Project Manager and choose Dynamic Project Switching so that it’s checked.

>> To open multiple projects in RAM: Open any project, then reopen the Project Manager and 
open any other project. All projects you open are kept available in RAM.

>> To switch among open projects: Choose File > Switch Project and select the project you 
want to switch to from the submenu. That project immediately opens.

>> To close a specific project: Choose File > Close Project and select the project you want 
to close from the submenu. You may be prompted to save, after which the project closes.

>> To close all other open projects: Open the Project Manager. All open projects appear 
with a check mark in the upper left-hand corner; the currently open project has an orange 
corner mark, while other projects open in memory have a gray corner mark. Right-click 
anywhere within the Project Manager, and choose Close Projects in Memory to close all 
projects other than the current one.



3
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Project Settings, Caching, and Preferences

This chapter covers the settings used for defining the properties of each individual project. It’s 
a good idea to familiarize yourself with the information in this chapter prior to setting up your 
first project.

Opening Project Settings� 63

Presets� 64

Master Project Settings� 66

Timeline Format� 66

Video Monitoring� 67

Conform Options� 69

Image Scaling� 72

Image Scaling� 72

Input Scaling Preset� 73

Output Scaling Preset� 73

Editing� 75

General Settings� 75

Frame Interpolation� 75

Color� 76

Timeline Settings� 76

Ripple Mode� 77

Dynamics Profile� 77

General Settings� 78

Printer Light Step Calibration� 78

Camera Raw� 79

Timeline Lookup Tables� 80

Look Up Tables (LUTs)� 80

Broadcast Safe� 82

Generate Soft Clip LUT� 82

Generate LUT From Current Grade� 83

EasyDCP/JPEG2000 Color Management� 83

Versions� 84

Audio� 85

General Options� 86
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UI Settings� 86

General Options� 86

Working Folders� 87

Capture and Playout� 88

Deck Capture and Playback� 88

Capture� 89

Playout� 90

Control Panel� 91

Auto Save� 93

Keyboard Mapping� 94

Metadata� 95

Monitoring and Optimizing Performance in Resolve� 96

Understanding the GPU Status Display� 96

Using Proxies or Clip Cache When GPU Status Is in the Red� 97

Other Project Settings for Improving Real Time Performance� 97

Using the Render Cache� 99

Enabling Smart Cache� 100

Enabling User Cache� 101

When Caching Happens� 102

Controlling Source Caching� 102

Controlling Node Caching� 102

Clearing Cached Media� 102

Using the Cache During Delivery� 103

Data Levels Settings and Conversions� 104

Internal Image Processing and Clip Data Levels� 104

Assigning Clip Levels in the Media Pool� 105

Video Monitoring Data Levels� 106

Deck Capture and Playback Data Level� 106

Output Data Level Settings in the Deliver Page� 107

So, What’s the “Proper” Data Range for Output?� 108

Working With ACES� 109

Setting Up ACES in the Project Settings Window� 110
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Tips For Rendering Out of an ACES Project� 111

DaVinci Resolve Preferences� 112

System Overview� 112
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Once you’ve opened a project, all of the various project settings, deck capture and playback 
settings, LUT settings, and application preferences that are available in DaVinci Resolve can be 
found in the Project Settings window.

To open the Project Settings window:

>> Click the gear button at the bottom left on any page.

>> The Project Settings open in the middle of the screen.

The Project Settings window is divided into a series of panels which can be selected from a 
sidebar to the left. Each panel contains a collection of related settings that affects some category 
of Resolve functionality.

>> Click on the name of any group of settings in the sidebar at the left to open that panel.

Opening Project Settings

Project Settings window

Project Manager and Project Settings buttons
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The Presets panel lets you save customized collections of Project Settings for future recall. Presets 
can save the state of nearly every parameter and setting in every panel of the Project Settings 
window, and make it easy to switch among different setups for different tasks, or to accommodate 
different types of projects.

There are three default items in the Presets list:

>> Current Project: This is the current project’s settings. After you’ve loaded a preset, the 
current project becomes selected, showing that the preset you loaded has been applied 
to the current project.

>> System Config: The default configuration that’s applied as the User Default Config for all 
new users that are added to the Login screen.

>> User default config: The default configuration for all new projects created by the currently 
logged in user.

If you like, you can add your own presets, as many as you need to accommodate the kind of 
work you do.

To Create a New Preset:

1.	 Alter whichever settings in whatever panels you need to, using the different panels of the Project 
Settings window. In each panel you alter, click the Apply button to retain your changes.

2.	 Open the Presets panel and click Save As.

3.	 When a dialog appears asking “Apply Current Configuration to System?”, click Yes to apply 
these changes to the current project.

4.	 When the Preset Name dialog appears, type a name into the field and click OK.

	 The new preset appears as an item in the Presets list.

Once you’ve created one or more custom presets, you can load them at any time.

To Load and Use a Preset:

1.	 Click an item in the Presets list.

2.	 Click Load.

	 If a dialog appears saying either “Do you want to replace current project’s config with this 
selected Preset” or “Apply Current Configuration to System?”, click Yes.

If you want to change the default configuration that new users and new projects are automatically 
created with, you can edit the System Config or the User Default Config.

Presets
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To modify a System or User Configuration:

1.	 Exit to the Login Window, and do one of the following:

>> Log in as admin to modify the System Configuration.

>> Log in as a user to modify the User Default Configuration.

2.	 Open a new or existing project, then open the Project Settings.

3.	 Open the Presets panel, and do one of the following:

>> If you’re logged in as admin, select ”System Config” in the Presets list.

>> If you’re logged in as a user, select ”User default config” in the Presets list.

4.	 Make whatever changes you need in the different panels of the Project Settings. Click the 
Apply button for each panel to keep your changes. 

5.	 When you’re finished making changes, open the Presets panel again, and click the Save button 
immediately underneath the Presets list.

	 If you edited the System Config, then all new users that are added to the system automatically 
inherit these settings. If you edited the User Default Config, then all new projects created by 
that user will inherit those settings.

Finally, if there’s a custom preset that you’ve created that has outlasted its usefulness, you can 
delete it.

To Delete a Preset:

1.	 Click an item in the Presets list to select it.

2.	 Click Delete.

3.	 When the Confirm Delete dialog appears, click Yes.
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This panel is project specific, and lets you set up and adjust the most essential properties of a clip, 
including the timeline format, video monitoring method, and conform options. In many workflows, 
you’ll want to adjust these settings before getting started with your project. 

Timeline Format

This group of settings affects the geometry and image processing of the current project.

>> Timeline resolution: A pop-up menu that lets you choose a frame resolution preset to use 
for image processing while grading. DaVinci Resolve is resolution independent, so you can 
change the resolution at any time and all windows, tracks, sizing changes, and keyframe 
data will be automatically recalculated to fit the new size. For example, you can work on 
a 4K project while monitoring at HD resolutions if your room is only set up with an HD 
monitor, and then render the finished project at 4K resolution for final delivery. Alternately, 
you can downsize an HD project to an SD resolution to create another set of deliverables. 
For more information on Resolve’s resolution independence, see Chapter 12, “Advanced 
Color Features.”

>> Frame size: Lets you set resolutions not found in the “Timeline resolution” pop-up menu.

>> Pixel aspect ratio: Used to select PAR settings for image formats that don’t use the default 
square pixel format. You can apply a 16:9 anamorphic PAR, a 4:3 PAR for SD projects, or a 
Cinemascope ratio.

>> Timeline frame rate: Determines the primary frame rate used by the project. If you’re 
importing an AAF or XML file, this setting is automatically set via an option in the Project 
Import dialog. Ideally, you should choose a frame rate before importing media into the 
Media Pool. However, the first time you import media into an empty Media Pool, you’re 
prompted if the incoming media frame rate doesn’t match the Timeline frame rate set here, 
and you have the option of automatically updating this setting to match that of the media 
you’re importing. Once one or more files have been added to the Media Pool, this setting 
cannot be changed.

>> Use drop frame timecode: Enables or disables drop frame timecode for the current project. 
Off by default.

>> Playback frame rate: Usually based on the frame rate of the external display connected to 
your video interface and the “Timeline Frame Rate” setting. For example, a 50Hz monitor 
requires a 25 fps playback frame rate for synchronous display without dropped frames. If 
you want to see the playback at a slower rate, type the frame rate in this field and DaVinci 
Resolve will make the appropriate calculations to drop or repeat frames as necessary to 
match it. This can be useful for seeing how clips look in slow motion.

Master Project Settings
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>> Image processing: The only option is 32-bit floating point, which is how all image data is 
processed within DaVinci Resolve’s image processing pipeline.

>> Color science: There are three options. The default is the well established DaVinci YRGB 
color science. Alternately, you can choose the newer DaVinci ACES, or DaVinci ACES Log 
color science, available for facilities requiring ACES workflows. For more information about 
ACES, see Chapter 3, “Project Settings, Caching, and Preferences.”

>> ACES version: This pop-up only appears if you choose one of the DaVinci ACES options 
from the Color science pop-up menu. Lets you switch between different versions of the 
ACES specification. This lets you choose the appropriate older version of ACES whenever 
you open an older project.

>> Enable video field processing: Interlaced media is supported throughout DaVinci Resolve. 
A checkbox in the Master Project Settings, “Enable video field processing,” forces Resolve 
to process all operations using fields. A corresponding checkbox in the Format settings 
of the Deliver page, “Field rendering,” lets you enable and disable field rendering when 
setting up file-based output.

Whether or not it’s necessary to turn field processing on depends on what kinds of 
corrections you’re applying to your clips. If you’re applying any filtering or sizing operations 
such as blur, sharpen, pan, tilt, zoom, or rotate, then you should turn on field processing.  
On the other hand, if you’re only applying adjustments to color and contrast, it’s not 
necessary to turn on field processing, and in fact leaving it off may shorten your rendering 
time somewhat.

Video Monitoring

The settings available in this group control the signal that’s output by the video output interface 
that’s connected to your workstation, and let you specify what standard of signal is output, and via 
which signal path. 

By default the frame size and frame rate match those in the Timeline format and Conform options. 
However, if necessary you can change these settings to match those of the external display you’re 
using to monitor your work. For example, if you’re working with 2K files for 2K output, but you’re color 
correcting using a high definition monitor set to 1080 resolution, you can select the appropriate HD 
standard for that monitor without changing the Timeline Resolution settings.

>> Video format: Lets you choose a video standard combination of frame size and frame rate 
to be output via your connected video output interface.

>> Video connection checkboxes: Lets you choose the signal standard to output from your 
connected video output interface to the video monitor. Make sure to choose a standard 
that’s supported by both your video interface and your monitor. The options are:

>> Use 4:4:4 SDI: A signal path for monitoring image data to monitors that support 4:4:4 
chroma sampling via dual SDI connections.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

68

PROJECT SETTINGS, CACHING, AND PREFERENCES3

>> Use 3/6 Gb not Dual Link SDI output: A signal path for monitoring image data via a 
single 3 Gb/s or 6 Gb/s SDI connection.

>> Use left and right eye SDI output: All DaVinci Resolve systems can generate a side-by-
side display that can be sent to a Stereoscopic monitor via the HD-SDI output of an 
UltraStudio 4K or DeckLink card. When dual SDI 3D monitoring is enabled, each eye 
is output separately at full resolution. In this mode, split-screen wipes and cursors will 
not be visible on the grading monitor. 

>> Video/Data Level: This setting only affects the data levels being output via the video 
interface that connects the Resolve workstation to your external display. It has no effect on 
the data that’s processed internally by Resolve, or on the files written when you render in 
the Deliver page. It is imperative that the option you choose in Resolve matches the data 
range to which your external display is set. Otherwise, the video signal will appear to be 
incorrect, even though the internal data is being processed accurately by DaVinci Resolve. 
There are two options:

>> Video Levels: This is the correct option to use when using a broadcast display set to 
the Rec. 709 video standard.

>> Data Levels: If your monitor or projector is capable of displaying “full range” video 
signals, and you wish to monitor the full 10-bit data range (0- 1023) while you work, this 
is the correct option to use.

More information about data levels appears later in this chapter.

>> Video bit depth: Choose the bit depth that corresponds to the capability of your display. 
You can choose between 8-bit and 10-bit. Monitoring in 10-bit is more processor intensive, 
but preferable to avoid the appearance of banding that may not in fact be in the image 
data being processed by Resolve.

>> Video output sync source: This setting, when displayed, lets you select between internal 
and external bi- level or tri-level synchronization, which is used with some video interfaces, 
but not required by all.

>>Monitor scaling: Defaults to basic, and is only enabled to smooth the edges of video being 
viewed on a projector with very large screens. These settings minimize high frequency 
artifacts that may be seen. This may also be noticeable if you have a 2K or HD project but 
are monitoring on an SD monitor. The other option, Bilinear, has different effects on the 
monitored image depending on your display device, so you may need to check to verify 
that it’s appropriate for your environment.

>> Add 3:2 pulldown: When outputting 23.98 or 24 fps media to an external display that can 
only sync to 29.97, 59.94, or 60 fps signals, this option lets you output with a 3:2 pulldown 
pattern inserted into the signal.
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>> Use left and right eye SDI output: All DaVinci Resolve systems can generate a side-by-side 
display that can be sent to a Stereoscopic monitor via the HD-SDI output of an UltraStudio 
4K or DeckLink card. When dual SDI 3D monitoring is enabled, each eye is output separately 
at full resolution. In this mode, split-screen wipes and cursors will not be visible on the 
grading monitor, nor will you be able to view image resizing. 

>> Hide UI overlays for optimized playback: When using a single GPU for both display and 
CUDA or OpenCL processing, or if your display GPU is underpowered, or if you lack the 
PCIe bandwidth required for the currently specified resolution or frame rate, you may be 
able to improve real time performance by turning this option on. When enabled, on-screen 
controls such as the cursor, Power Window outlines, and split-screen views are disabled 
and hidden during playback. When playback is paused, all onscreen controls reappear.

>> Show all viewers on video output: When this setting is disabled, video output is locked to 
the Color page viewer only. When this setting is turned on, other elements of the GUI that 
have focus in the Media, Edit, and Deliver pages are also output to video.

Conform Options

The settings in this group determine how clips are conformed to match imported project files with 
source media on disk by extracting timecode, reel names, file names, file paths, and so on.

>> Use Timecode: Determines how DaVinci Resolve extracts timecode from referenced media 
files. There are two options:

>> Embedded in the source clip: The preferred setting for most projects to conform 
automatically and apply grades to the resulting clips. As long as DaVinci Resolve 
can reference the timecode in either a media file’s timecode track, or in the header 
metadata of the frames in a DPX sequence, you can use timecode to re-conform clips, 
or even completely change the media file to which a clip refers. 

>> From the source clip frame count: This setting is useful if the source media lacks 
timecode metadata, and all that’s available is a frame count that identifies frames via 
sequentially numbered integer values.

>> Conform partial clips with black gaps: Inserts black frames whenever you conform a clip 
that doesn’t contain all the required frames. When this option is selected, partial clips are 
flagged in the Edit page with a P in the thumbnail of the clip that it is lacking frames.

>> Assist using reel names from the: When this checkbox is turned on, DaVinci Resolve uses 
reel numbers when conforming clips to match any imported project. Turning this checkbox 
off forces DaVinci Resolve to identify clips using file names when conforming XML and AAF 
projects. File names can only be used for conforming XML or AAF files, or when importing 
a DaVinci project. There are four options:
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>> Source clip file pathname: Obtains the reel number by extracting it from each media 
file’s path. This makes it possible to extract a reel number from all or part of the file 
name, or from all or part of the name of any folder in the path that encloses that file. 
This extraction is defined using the Pattern field.

>> Pattern: A code that defines how a reel number should be extracted from the source 
clip path name. For more information about creating patterns, see “Using the Pattern 
Field” in Chapter 9, “Preparing and Conforming Projects.”

>>Media Pool folder name: The reel number is obtained from the name of the bin in 
the Media Pool that encloses that clip. This option is often used for stereo projects, 
deriving the reel number from “Left” and “Right” named directories. It’s also useful 
for projects that are inheriting new VFX clips on a daily basis.

>> Embedding in source clip file: Useful for file formats where the reel number is 
embedded within the media file itself. QuickTime files created by Final Cut Pro, DPX 
frame files, and CinemaDNG files are all formats that are capable of containing reel 
number header data.

>> Source clip filename: If there is no defined reel number, often it’s easy to just use the 
source clip filename.

>> Extract reel names from EDL comments: Media file formats such as R3D have reel names, 
obtained from the file names, that are longer than the eight characters that are allowable in 
a standard EDL. This option allows DaVinci Resolve to extract reel names from appropriately 
formatted EDL comments, such as those output from Final Cut Pro 7.

>> Show offline clips through conform gaps: If there’s a missing clip in a conformed timeline, 
the position of the clip is shown on the thumbnail and Viewer as black. Turning this option 
on permits offline media, if available and with the appropriate timecode synchronization, to 
be used in lieu of the online media when such holes in the Timeline appear, on the premise 
that offline media may be better than no media at all in an emergency.

>> Sort timeline using reel number and timecode: Lets you change the behavior of C mode 
sorting in the Timeline. With this checkbox turned on (the default), all clips in the Timeline 
are sorted by reel number first, and then by source timecode. This way, clips with similar 
timecode from the same reel will appear next to one another in C mode. If you turn this 
checkbox off, reel number is ignored, and all clips in the Timeline are sorted only by source 
timecode. This may result in clips from multiple sources being mixed together, but it is 
useful in specific situations.
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>>Mixed frame rate format: (Only available prior to importing media into a project) This pop-
up menu lets you choose the method used to conform mixed frame rates for rendering and 
playback. When none is selected, Resolve conforms and processes all clips in the Timeline 
to play at the frame rate that’s selected in the “Timeline frame rate” pop-up menu. For 
example, 23.98, 29.97, 30, 50, 59.94 and 60 fps clips will all play at 24 fps if that’s what “Timeline 
frame rate” is set to in the Master Project Settings. How clips in mixed frame rate timelines 
are rendered out depends on whether the Render Settings are set to render individual 
source clips or one single clip. When you render the Timeline as individual source clips, all 
clips are rendered individually at their original frame rate. If you select ‘single clip,’ all clips 
are converted to the “Timeline frame rate” frame rate and rendered as a single media file. 

 You can choose the “Final Cut Pro 7” or “Final Cut Pro X” methods of conform, while for 
projects imported from Premiere Pro, Smoke, or other NLEs, you should choose “Resolve.” 
You should also choose “Resolve” if your source clips are at different rates than the timeline 
rate and you would like each of the clips to be speed changed to the timeline rate by 
default. This uses the Retime selection you can find on the editing tab. This pop-up menu 
also appears in the Load AAF or XML dialogs when you import a project.
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Image Scaling

The Image Scaling panel contains settings that determine how and when clips are resized for 
various reasons.

Image Scaling

These settings affect the methods used to resize clips in various situations.

>> Resize Filter: The first group of settings lets you choose the mathematical method used to 
resize clips:

>>Optimize for playback: When this option is enabled, bilinear image scaling will be used 
during playback and sharper image scaling will be used while playback is paused, 
enabling low-performance workstations to play with better frame rates, albeit not at 
full quality. 

>> Uses sharper filter: Usually provides the best quality in projects using clips that must 
be scaled up to fill a larger frame size, or scaled down to HD resolutions.

>> Uses smoother filter: May provide higher quality for projects using clips that must be 
scaled down to fit an SD resolution frame size.

>> Uses Bilinear filter: A lower quality setting that is less processor intensive. Useful for 
previewing your work on a low-performance computer before rendering, when you 
can switch to one of the higher quality options.

>>Override input scaling: Checking this box lets you choose an Input Sizing preset to 
apply to the project.

>>Override output scaling: Checking this box lets you choose an Output Sizing preset 
to apply to the project.

>> Anti-alias edges: A second group of settings lets you choose how to handle edge anti-
aliasing for source blanking.

>> Auto: Adds anti-aliasing when any of the Sizing controls are used to transform the 
image. Otherwise, anti- aliasing is disabled.

>>On: Forces anti-aliasing on at all times.

>>Off: Disables anti-aliasing. It might be necessary to turn anti-aliasing off if you notice 
black blurring at the edges of blanking being applied to an image.

>> Debayer quality: A third group of settings lets you choose whether to apply sharpening 
when debayering raw media formats such as CinemaDNG.

>>Optimize for playback: When this option is enabled, a simple debayer will be used 
during playback and a sharper debayer will be used while playback is paused, enabling 
low-performance workstations to play with better frame rates, albeit not at full quality.
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>> Uses sharper filter: The default setting. Uses a debayer-specific, high-quality sharpening 
operation to improve the appearance of debayered media.

>> Uses smoother filter: Choosing this setting disables sharpening, providing access to 
the unaltered debayering result.

Input Scaling Preset

Contains one setting, Mismatched resolution files, that lets you choose how clips that don’t match 
the current project resolution are handled. There are four options:

>> Center crop with no resizing: Clips of differing resolution are not scaled at all. Clips that are 
smaller than the current frame size are surrounded by blanking, and clips that are larger 
than the current frame size are cropped.

>> Scale full frame with crop: Clips of differing resolution are scaled so that the clip’s shortest 
dimension is fit to match the frame. Excess pixels are cropped.

>> Scale entire image to fit: The default setting. Clips of differing resolution are scaled so that 
the clip’s longest dimension is fit to match the frame. The shorter dimension has blanking 
inserted (letterboxing or pillarboxing). 

>> Stretch frame to all corners: Useful for projects using anamorphic media. Clips of differing 
resolutions are squished or stretched to match the frame size in all dimensions. This way, 
anamorphic media can be stretched to match full raster, or full raster media can be squished 
to fit into an anamorphic frame. An added benefit of this setting is that it makes it easy to 
mix anamorphic and non-anamorphic clips in the same project.

Output Scaling Preset

These settings let you optionally choose a different resolution to be output via your video output 
interface, for monitoring, outputting to tape, or rendering. If you set the resolution in the Render 
Settings list of the Deliver page to something other than the Timeline Resolution, these settings are 
used to make the change. This can be used in situations where you’re working on a high resolution 4K 
project, but you want to monitor using an HD display and output HD resolution media for approval.

>>Match timeline settings: Turned on by default, so that these settings mirror the Timeline 
Resolution, Image Scaling, and Input Image Scaling settings described above. Turning 
this checkbox off lets you choose different settings for monitoring, outputting to tape, or 
rendering, using the other settings in this group.

>>Output resolution: Lets you choose an alternate resolution.

>> For: Lets you specify a different custom alternate resolution.

>> Pixel aspect ratio: Lets you specify an alternate pixel aspect ratio to match the alternate 
timeline format.
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>>Mismatched resolution files: Lets you choose an alternate way of handling mismatched 
resolution files given the alternate resolution you’ve chosen. These options work identically 
to those of the “Input Image Scaling” group.

Proxy Image Scaling

The proxy mode can be enabled by choosing View > Proxy On The Fly (Command-P), or on the 
DaVinci control surface by pressing the PROXY ON/OFF button on the T-bar panel. Proxies are 
useful when a complex color correction is created and the system begins to run a little slower than 
real time. When this occurs, turning on Proxy mode improves real time performance by temporarily 
lowering the resolution of the clips being processed. Alternatively, you can cache the clip to gain 
real time performance again.

>> Use real time proxies: A checkbox that turns on-the-fly proxy mode on and off.

>> Automatically scale to: The resolution at which proxies are generated. By default, this is 
one-half of the current system resolution. If anyone asks about the quality of grading with 
proxies, keep in mind that on- the-fly proxies in DaVinci Resolve are made using the same 
optical-quality resizing engine that is used for all other image transforms, and that this 
Proxy mode has been used to generate film out media for blockbuster films.

Note: There are actually two types of proxies. Traditional pre-generated proxies are managed from 
the Media page, and are often used for 4K projects where the system hardware in use only permits 
real time 2K performance. The proxy settings in this section have been referred to as OFP (On-the-
Fly Proxies) and are generated in real time as needed, with no rendering or caching necessary.
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The settings in this panel affect keyboard shortcuts and editorial default values.

General Settings
>> Standard generator duration: Defines the default duration of generators you edit into the 
Timeline, in Seconds or Frames. The default value is 20 seconds.

>> Standard transition duration: Defines the duration of transitions, in Seconds or Frames, that 
you add to an edit point in Resolve. The default value is 1 second.

>> Pre-roll time: Determines how much of the Timeline before the current position of the 
playhead to play when using the Play Around command.

>> Post-roll time: Determines how much of the Timeline after the current position of the 
playhead to play when using the Play Around command.

>> Default handles length: The value used when creating a timeline with handles. The default 
is one second worth of frames.

Frame Interpolation

These settings determine the default state for all retiming and speed change effects including 
when clips are in mixed frame rate timelines.

>> Retime Process: This pop-up menu lets you choose a default method of processing clips 
in mixed frame rate timelines and those with speed effects (fast forward or slow motion) 
applied to them, throughout the project. Since each clip in every timeline defaults to 
“Project Settings,” changing this setting will change the way most speed effected clips will 
be processed, except for those that have custom settings selected. 

There are three options:

>>Nearest: The most processor efficient and least sophisticated method of processing; 
frames are either dropped for fast motion, or duplicated for slow motion.

>> Frame Blend: Also processor efficient, but can produce smoother results; adjacent 
duplicated frames are dissolved together to smooth out slow motion effects. This 
option can provide better results when Optical Flow displays unwanted artifacts.

>>Optical Flow: The most processor intensive, but highest quality method of speed effect 
processing. Using motion estimation, new frames are generated from the original 
source frames to create slow motion effects. The result can be exceptionally smooth 
when motion in a clip is linear. However, two moving elements crossing in different 
directions or unpredictable camera movement can cause unwanted artifacts.

Editing
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>>Motion estimation mode: When using mixed frame rate timelines with Optical Flow retiming 
selected or Optical Flow speed changes this pop-up menu lets you choose between a 
higher speed or a higher quality processing.

>>Motion range: When using mixed frame rate timelines with Optical Flow retiming or Optical 
Flow speed changes, this pop-up menu lets you choose small, medium or large motion for 
all speed and motion related calculations.        
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The settings in the panel govern different behaviors in the Color page.

Timeline Settings

These settings affect clip versions and timeline interactions when working in the Color page.

>> Use local version for new clips in timeline: Automatically sets all new clips that are added 
to existing timelines, or all clips that are added to new timelines that are imported via AAF, 
EDL, or XML, to use local grades by default. If you want all clips added to new timelines to 
use remote grades instead, as with DaVinci Resolve version 9 and earlier, you can turn this 
checkbox off. 

>> Automatically match master timeline with media pool: If you turn on this option before 
importing any media into the Media Pool, or importing any timelines that will in turn import 
media into the Media Pool, you can create projects with a Master Timeline. When enabled, 
clips are added to and removed from the Master Timeline as they’re added to and removed 
from the Media Pool, so that the Master Timeline always contains all media in the Media 
Pool. Once media has been imported into a project, this setting cannot be changed.

>> Save timeline thumbnails with project: To minimize project size, and maximize the speed of 
saving and loading projects, you should leave this checkbox unchecked. If you select the 
checkbox, all of your Timeline thumbnails will be stored inside every project, instead of in 
the default directory that’s ordinarily dedicated to stills, during both Save and Auto Save 
operations. This provides a good history of the project, but takes much longer to complete 
and uses more hard disk space.

>> Automatically cue x frames into timeline clips: This setting affects the operation of the 
NEXT SCENE and PREV SCENE commands in the Color page. The default cue point when 
moving from one clip to the next is the first frame of each clip. Entering a value, in frames, in 
this field sets the default cue point to the specified number of frames after the first frame of 
each clip you move the playhead to. This can be convenient if the source material has black 
or camera rollup flashes at the beginning of every clip while you’re trying to grade dailies.

>>Next scene switches to visible track: When grading a project with multiple tracks, you can 
use this option to alter the “next scene” command to work better in projects with multi-
clip composites. With this option turned off, pressing NEXT SCENE on the DaVinci control 
surface, or using the Down Arrow keyboard shortcut, moves the playhead to the very next 
clip in the Thumbnail timeline, regardless of whether it’s in front of or behind another clip. 
Turning this option on causes the NEXT SCENE command to move the playhead to the 
clip in the highest track if the next clip is part of a multi-clip composite with multiple clips 
stacked over one another.

Color
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Ripple Mode

This setting determines the behavior of the Ripple command that’s initiated when using the RIPPLE 
VALUE button on the DaVinci control surface.

>> Target clips are set to: The Ripple mode that’s used when you press the RIPPLE VALUE 
button on the DaVinci control surface. For more information on using this function, see 
Chapter 13, “The Gallery and Grade Management.”

>> Exact values changed: Changes made to the current clip are rippled to the specified 
clips using the exact parameters that were changed. For example, if the Master Gain 
level in the current clip is changed to 0.75 of its range, each clip you ripple will have a 
Master Gain level of 0.75. Only parameters you adjust are rippled.

>> Percent value changed: Changes made to the current clip are rippled to the specified 
clips by the percentage of change you made to the altered parameters. For example, 
if the current clip has a Master Gain level of 1.00 and is changed to 0.90 units, then the 
Master Gain level of each clip you ripple will have a relative reduction of 10% relative 
to its previous value.

>> Unit value changed: Changes made to the current clip are rippled to the specified 
clips by the same delta of change, using whichever units make sense for the affected 
parameter. For example, if the current clip had a Master Gain of 0.80 and you increased 
it to 0.90, each rippled scene’s Master Gain level increases by 0.10.

>> All values are copied: The current clip’s grade is rippled to the specified clips in its 
entirety. No comparison is made with the original clip’s parameters, and all memory 
parameters are rippled.

Dynamics Profile

Defines the default transition from one dynamic keyframe to the next. By default this transition is 
linear, with the “Dynamic profile start” and “Dynamic profile end” parameters set to 1. However, if 
you need to alter the acceleration of the interpolation of values from one dynamic keyframe to the 
next, then you can change that keyframe’s Dissolve Type.
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General Settings

Affect a variety of behaviors while working in the Color page.

>> Luminance mixer defaults to zero: Selecting this option sets the Y channel of the YRGB 
parameters for all grades to zero. This is required to be able to export a compliant ASC-CDL, 
and will impact all grades that use the Lum Mix control.

>>Master reset maintains RGB balance: Defines how the DaVinci control surface trackball/ring 
reset buttons reset primary color adjustments. When this option is turned off (the default), 
pressing the ALL Reset button returns the primary correction values to their default values. 
When this checkbox is turned on, then pressing the ALL Reset button (a) resets the YRGB 
values so that the overall values are kept and the ratio of YRGB to each other is maintained, 
and (b) pressing the RGB Reset button sets the three color channels to the average of what 
they were previously set to.

>> Color picker: Changes the way that colors are selected when using the Secondary color 
correction controls. DaVinci Resolve is the normal and modern mode, however some 
colorists who are familiar with the legacy 2K prefer the DaVinci 2K mode.

>> Switching clips: When switching clips, DaVinci Resolve can switch to the same or another 
node in the node graph. The four options below determine which node is selected:

>> Selects last adjusted node: The default setting, where each clip in the Timeline retains 
its own independent node selection that’s remembered whenever you move back to 
that clip.

>> Selects first node: The first node is always selected when you move to another clip.

>> Selects last node: The last node is always selected when you move to another clip.

>> Selects same node: If the clip you’ve moved to has as many or more nodes as the last 
clip, the node of the same number will be selected. If the clip you’ve moved to has 
fewer nodes than the last clip, the next highest node will be selected.

Printer Light Step Calibration

For film projects, when you have tight integration with a film lab, it is possible to adjust the printer 
light calibration sets to match the lab you are using. You should work with your lab technician to 
set up the Lab Aim settings, the Steps adjustments, which is an incremental value, and the Density 
Increment adjustment, which is the amount of correction applied within each step. Usually, the Step 
and Density values will be identical, but this will be up to your lab and your preference.
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This panel contains groups of parameters that correspond to every camera raw media format that’s 
supported by DaVinci Resolve. Using these parameters in the Camera Raw panel, you can override 
the original camera metadata that was written at the time of recording, and make simultaneous 
adjustments to all camera raw clips using the “project” raw settings.

These settings are covered in detail in Chapter 5, “Camera Raw Settings.”

Camera Raw
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The pop-up menus in the Timeline Lookup Tables panel include a series of factory preset LUTs 
that were installed with Resolve, along with any LUTs that have been generated by Resolve, or that 
you’ve imported into the proper directory for your operating system.

>>On OS X: Library/Application Support/Blackmagic Design/DaVinci Resolve/LUT/ 

>>On Windows: C:\ProgramData\Blackmagic Design\DaVinci Resolve\Support\LUT 

>>On Linux: /home/resolve/LUT

Note: If you downloaded Resolve Lite from the Apple App Store, LUTs are saved in a different 
location in order for Resolve Lite to remain totally self-contained. In this case, you can click the 
“Open LUT Folder” button in the Lookup Tables panel of the Project Settings, to open up a Finder 
window at the location these LUTs are stored. You can use this window to copy LUTs that you want 
Resolve to have access to, or delete LUTs that you no longer need.

If you add a LUT to one of these directories after Resolve has been opened, you can click the 
Update Lists button to refresh the contents of the pop-up menus.

Resolve uses both 1D and 3D LUTs. 3D LUTs that are created by DaVinci Resolve are in the .cube 
format, configured as 33x33x33 cubes with 32-bit floating point processing. DaVinci Resolve can 
also read and use LUTs in the Cinespace and Shaperlut formats.

Timeline Lookup Tables

This group of controls lets you add LUTs to the Resolve image processing pipeline that affect 
every timeline in the entire project all at once. These LUTs can be used for a wide variety of 
functions, such as to trim Timeline grades, apply Log to Linear conversions, simulate film output, 
and limit the signal to accommodate Broadcast Safe requirements. Different options let you 
insert image processing to different stages of the pipeline as seen in the following diagram:
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Keep in mind that since you can apply both 1D and 3D LUTs simultaneously, 1D LUTs at each step 
are always applied before 3D LUTs.

>> 1D/3D Input Lookup Table: Two pop-up menus let you add 1D and/or 3D LUTs that process 
the current Timeline before every other image processing operation in DaVinci Resolve.

>> 1D/3D Output Lookup Table: Two pop-up menus let you add 1D and/or 3D LUTs that 
process the current Timeline after the operations applied in the Color page, but before the 
temporarily applied Display LUT. 

>> ACES IDT (Input Device Transform): When Color Science is set to ACES, this pop-up menu 
lets you choose which IDT to use for the dominant media format in DaVinci Resolve.

>> ACES ODT (Output Device Transform): When Color Science is set to ACES, this pop-up 
menu lets you choose an ODT with which to transform the image data for monitoring 
on your calibrated display, and when exporting a timeline in the Deliver page. For more 
information on ACES workflows using these settings, see Chapter 4, “Preparing and 
Conforming Projects.”

>> 1D/3D Video Monitor Lookup Table: Two pop-up menus let you add 1D and/or 3D LUTs 
that process the current Timeline after every other image processing operation in DaVinci 
Resolve. However, Display LUTs are only temporarily applied for purposes of monitoring; 
they’re never applied to rendered media, or to the signal that is output to tape using the 
controls in the Deliver page. Display LUTs are particularly valuable for applying a film 
print emulation LUT in a Log workflow, or for applying a monitor calibration LUT if you’re 
outputting to a single display and you don’t have dedicated outboard calibration hardware. 

Here’s an example. It’s common, when grading for film output using a Log workflow, that 
you’ll use the Display LUT pop-up menu to apply a film emulation LUT that simulates the 
image as it will be output from the film recorder, taking into account the film lab and print 
stock used, in order to make sure that the image you’re grading will appear as close as 
possible to what the eventual release print will look like in the cinema.

>> 1D/3D Color Viewer Lookup Table: Two pop-up menus let you add 1D and/or 3D LUTs that 
process the image shown in the Viewer on your computer display, independently of the 
Display LUT that’s used to output to your broadcast display. By default, this follows the 
Video Monitor LUT setting, but you can also use this option to apply a specific calibration 
transform for your computer monitor. Alternately, you could use it to desaturate the GUI 
Viewer to be able to specifically evaluate image contrast, or if you don’t want to have to 
argue with your client over which display looks correct.

>> 1D/3D Scopes Lookup Table: Ordinarily, Resolve’s internal software video scopes provide 
an unbiased analysis of the actual video data levels within the Resolve image processing 
pipeline. However, you can choose to have the software scopes use the Video Monitor LUT 
selection, or any other LUT installed on your system, to transform this analysis to reflect the 
monitored output.
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>> Update Lists button: Refreshes the LUT pop-up menus if you’ve added new LUTs to your 
system since DaVinci Resolve has been opened.

>>Open LUT Folder: This selection opens the master folder in your file system, as described 
in the list of DaVinci Resolve LUT paths shown above.

Broadcast Safe

Broadcast Safe settings can be enabled while you grade to limit both the luma and chroma of the 
video signal to one of three levels of acceptable overshoots and undershoots. 

>> Broadcast safe IRE (mV) levels: A pop-up menu for choosing one of three levels of 
aggressiveness when limiting the signal. Choose the range that corresponds to your 
QC requirements.

>>Make Broadcast Safe: A checkbox that turns broadcast safe limiting on and off.

Note: The clipping imposed by Broadcast Safe itself does not have an inherently soft roll-off. For 
best results, Broadcast Safe should be used in conjunction with the Soft Clip controls in the Color 
page, or a Soft Clip LUT (described in the following section).

Generate Soft Clip LUT

Similar to the Soft Clip mode of the Curves, a Soft Clip LUT lets you create an image processing 
LUT that applies a timeline-wide “knee” to any clipping that occurs at the upper or lower extremes 
of the image. Soft clipping in this context is used to quickly ease off any unpleasantly harsh loss of 
detail occurring as a result of blowing out the highlights or crushing the shadows too aggressively.

To be effective, a Soft Clip LUT should be ideally applied using the 3D Output Lookup Table pop-up 
menu in the Look Up Tables panel, so it’s the very last operation in the image processing pipeline.

>>Generate: Lets you choose whether you create a soft-clip LUT as a 1D or 3D LUT. 1D LUTs 
are more accurate for this operation, using 1023 data points, as opposed to the 33x33x33 
cube of the 3D LUT.

>>Generates LUT based on: Defaults to “No LUT selected,” which generates a soft clip 
LUT using only the settings within this panel. Choosing another LUT from the list lets you 
concatenate the calculations you specify in this panel with the selected LUT, thus outputting 
a single LUT that applies both sets of calculations all at once.

>> Scaled to clipping range: Enables the Maximum and Minimum settings below to work.

>>Maximum video level: Sets the maximum value that will be output. All image data above 
this value will be clipped.
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>> Upper Clipping softness: Sets the threshold, as a percentage below the clipping point, 
at which highlights in the image data begin to compress before hard clipping. At 0, no 
soft clipping occurs. As you raise this value, more of the clipped highlight values are 
compressed, rather then clipped, resulting in softer, more pleasant “glowing” highlights.

>>Minimum video level: Sets the minimum value that will be output. All image data below this 
value will be clipped.

>> Lower Clipping softness: Sets the threshold, as a percentage above the minimum clipping 
point, at which shadows begin to compress before hard clipping. At 0, no soft clipping 
occurs. As you raise this value, more of the clipped shadow values are compressed, rather 
then clipped, resulting in a softer, more pleasant rolloff in the toe of the shadows.

>> Save LUT as: A field into which you can enter a name for a Soft Clip LUT you want to save.

>>Generate LUT button: Click this button after entering a name in the Save LUT as field to 
save a Soft Clip LUT. Here’s a procedure for creating a Soft Clip LUT using the controls in 
this area.

To create a Soft Clip LUT:

1. 	 Open the Project Settings and open the Look Up Tables panel.

2. 	 Choose the settings for the Soft Clip LUT you want to create.

3. 	 Type a name for the new LUT in the “Save LUT as” field, click “Generate LUT.”

	 The new LUT is saved in the default directory for your system, and is now available in the LUT 
pop-up menus of this panel.

Generate LUT From Current Grade

Two controls let you export LUTs from the currently selected grade. The resulting exported LUT is 
the same as when you use the Generate 3D LUT command in the Color page.

>> Save LUT as: Enter a name for the LUT you want to save in this field. 

>>Generate LUT: Click this button to save a LUT.

EasyDCP/JPEG2000 Color Management

The Timeline Colorspace pop-up menu lets you define the colorspace and gamma of the current 
Timeline for purposes of rendering output using Fraunhofer’s easyDCP application, or playback 
if you’re using Resolve to evaluate a rendered DCP. Choose the option that reflects your current 
timeline’s color space.
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Ten text fields provide a way for you to designate automatic names for the versions of grades that 
you select in the Color page. To the right of each text field, a pop-up menu lets you add a name 
from a handy list of predefined terms that’s been provided. Alternately, you can simply click any 
field and type your own custom name.

When you change the name of a version in the Color page, the names you define in this list are 
available from a pop-up menu in the Version Name dialog.

Using a predefined list of names for your different versions avoids typos that can later create folder 
naming issues when you use the “Commercial Workflow” options for rendering your media in the 
Deliver page.

Using the named pop-up when editing the name of a version

Versions
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Audio

This panel contains options that control audio playback in DaVinci Resolve.

>> Enable Audio: Enables or disables audio playback in every page of Resolve. Disabling audio 
can improve real time performance by a minor amount.

>> Audio Meter Alignment Level: Redraws the dBU scale shown in all audio meters in Resolve 
to better match the reference alignment standard for your region. Defaults to –20, but can 
be adjusted from –24 to –15.
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This panel presents a selection of general preferences that affect the interface and operation of 
DaVinci Resolve.

General Options

A collection of operational preferences.

>> Reload last working project when logging in: Automatically reopens the last project a user 
had open whenever that user logs back into Resolve.

>>Output single field when paused: This setting will reduce flicker when grading using a 
computer monitor or when working with interlaced material. Ordinarily, when viewing 
interlaced material in Stop or Pause mode, field one is displayed followed by field two. 
Depending on the image, this can result in a flicker on the display. When this option is 
enabled, only field one will be shown on the monitor when playback is paused; however 
both fields will be shown when the clips are played.

>>Wipe wraps when viewing reference stills: Turning this on (the default) lets stills wrap 
around the edge of the screen while you’re adjusting the wipe using the mouse, rather 
than stopping at the screen’s edge. If you find this behavior awkward when trying to quickly 
create full-frame comparisons with stills to flip on and off, it can be disabled.

>> Cache frames in: Specifies the format in which render cache files will be written. You can 
choose from among a variety of Uncompressed, ProRes, and DNxHD formats, depending 
on your requirements.

>> Enable background caching after X seconds: Specifies the duration of inactivity after which 
automatic background caching will begin.

>> Use BGR pixel order for DPX v2: Lets you choose a different pixel order for projects using 
DPX version 2 media. 

More information on background render caching appears later in this chapter.

UI Settings

A collection of visual preferences, some of which affect real time performance.

>> Resize image in viewer for correct aspect ratio: This control will select between using a 
square or non- square pixel aspect ratio within the Viewer. This is important when working 
with SD images which do not have a square pixel aspect ratio.

>>Mattes display high contrast black and white: When enabled, the HILITE command, which 
displays the current key, shows a black and white matte (i.e., high contrast) rather than 
the standard gray matte. For more information on this setting, and on use of the HILITE 
command, see Chapter 12, “Advanced Color Features.”

General Options
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>>Minimize Interface updates during playback: When enabled, gives priority to real time 
performance during playback by reducing user-interface updates. This is helpful when 
you’re creating complex grades on systems with low processing power, or when working 
on projects at high resolutions.

>> Always highlight current clip in the media pool: When turned on, any clips at the position 
of the playhead on the Conform or Color pages will be automatically highlighted in the 
Media Pool.

>> Sync the Master Timeline to the current frame: If you turned on “Automatically match 
master timeline with media pool” in the Color settings, then this option lets you make sure 
that whenever you open the Master Timeline, the playhead is at the same clip and frame 
that it was in the previous timeline you were working on.

>> Use grey background for image in viewers: When turned on, sets the background of all 
Viewers to gray, making it easier to evaluate image blanking or minor sizing adjustments 
than with the default dark background.

Working Folders

Three fields let you specify which folders proxy, cache, and gallery files are written to.

>> Proxy files location: Proxy files, if generated, are written to the directory path specified by 
this field. By default this directory path is hidden from the user.

>> Cache files location: All render cache files that you create are saved in the directory path 
specified by this field. This path defaults to a hidden “CacheClip” directory that’s created 
at the location of the first Media Storage Volume you specify in the DaVinci Resolve 
Preferences window.

>>Gallery stills location: By default, all stills you save are saved in the DPX format, and are 
placed in the directory path specified by this field. This path defaults to a hidden “.gallery” 
directory that’s created at the location of the first Media Storage Volume you specify in the 
DaVinci Resolve Preferences window.

Note: If the volume you’ve selected to use for the cache becomes unavailable, Resolve will warn you 
with a dialog.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

89

PROJECT SETTINGS, CACHING, AND PREFERENCES3

Deck Capture and Playback

All settings in this panel let you define the functionality of capture and playout to tape using device 
controlled VTRs connected to your Resolve workstation via the connected video capture and output 
interface. For more information on deck capture, see Chapter 3, “Media.” For more information on 
video output to tape, see Chapter 14, “Deliver.”

Capture and Playout

These settings affect both capture and playback when using the tape ingest options of the Media 
page, or the tape output options of the Deliver page.

>> Video capture and playback: You can choose the video format (frame size and frame rate) 
with which to output to tape from this pop-up menu. HD timelines can be downconverted 
to SD, and SD timelines can be upconverted to HD using the format conversion of your 
DeckLink card.

>> Use left and right eye SDI: A checkbox that enables supported video interfaces to ingest 
and output muxed stereoscopic video when used with supported VTRs, such as HDCAM 
SR decks with 4:2:2 x 2 mode. (When muxed stereoscopic signals are ingested, each eye is 
separated into individual left-eye and right-eye image files.) This parameter only appears 
when your hardware is set up appropriately.

>> Video connection operates as: Selects between the available signal options: Use 4:4:4 SDI, 
and Use 3/6Gb SDI not Dual Link SDI output. Which options are available depend on which 
video capture card you are using. 

>> Video/Data Level: Lets you specify the data range (normally scaled or full range) that’s used 
when ingesting from or outputting to tape. This option switches the data range of the signal 
output by your video capture card, but only during capture from tape in the Media page, 
or output to tape in the Deliver page. When capture or output is not currently occurring, 
your video capture card goes back to using the identically-named data range setting in the 
Master Project Settings pane, which governs how you monitor the signal being output on 
an external broadcast display or projector.

>> Video bit depth: Choose the bit depth that corresponds to the capability of your deck. You 
can choose between 8-bit and 10-bit. Outputting to 10-bit is more processor intensive, but 
higher quality for compatible devices, and is the default setting.

>> Use deck autoedit: If supported by your video deck, this is the best method to record video 
to the deck, as it enables the deck to roll the edit using the specified preroll, and control 
the edits via serial device control. If this checkbox is turned off, a basic edit On/Off mode 
is used by the deck, with the potential for frame inaccuracies if the “Non auto edit timing” 
setting is not properly adjusted.

>>Non auto edit timing: Adjusts the edit synchronization of the connected deck when auto 
edit is turned off.
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>> Deck preroll: Sets the number of seconds for preroll. How much is appropriate depends on 
the performance of your deck. 

>> Video output sync source: When using a DeckLink card this is set to Auto. Other capture 
cards may require you to set the sync source to “Reference” for playout and “Input” for 
ingest. This setting is only available if you have a DVS card installed on your system.

>> Add 3:2 pulldown: Inserts or removes the 3:2 pulldown required to record or play 23.98 fps 
media to or from a 29.97 tape format.

Capture

These settings are used when you use the Capture mode in the Media page to capture clips from 
tape into the Media Pool. Media is captured as DPX image sequences.

>> Save clips to: A field that displays the directory path to which media files captured from 
tape are written. You want to choose a volume that’s fast enough to accommodate the data 
rate of the media format you’re capturing.

>> Browse: Click this button to choose a directory to write captured media to. The directory 
you choose appears in the field above.

>> Save in this folder path: A series of checkboxes let you specify what other information to 
use to define the directory hierarchy that will hold the captured media. Every checkbox you 
turn on adds an additional directory with a name defined by that checkbox’s metadata. 
You can choose any or all of the following: Program name, Clip number, Reel number, and 
Roll/Card.

>> Apply reel number to: Lets you choose how to write the reel name. Two checkboxes let you 
write the reel number to the file’s name, and/or to the Header data.

>> Use prefix: A field lets you type in a prefix to be used in the media file’s name. This lets you 
add text identification that will make the media more easily identifiable and searchable.

>> Apply prefix to: Two checkboxes let you choose to use the prefix you typed in the file name, 
and/or in the folder name.

>> Use frame number with: When capturing to image sequences, you can choose how many 
digits to use when writing the frame number into the name of each frame file.

>> Set batch ingest handles to: When capturing to image sequences from a batch list, defines 
how many frames of additional handles to ingest along with each logged clip.

>> Enable audio input: Turn this checkbox on to capture audio along with the video. If 
you’re capturing QuickTime or MXF files, the audio will be written as additional tracks 
inside each file. If you’re capturing to a DPX image sequence, then a broadcast .wav file 
is recorded separately.

>> Input: Lets you choose how many tracks of audio to capture, from 2 to 16.
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Playout

These settings only affect the video signal that’s output when you use the Edit to Tape mode of the 
Deliver page.

>>Output Source Timecode: Turn this checkbox on to output each individual clip’s source 
timecode. This option is only applicable when assemble editing to tape.

>>Output LTC: With a Blackmagic Design DeckLink or UltraStudio device using HD-SDI, 
longitudinal timecode (LTC) is available on track 16 of the HD-SDI video signal, making it 
easy to use a Mini Converter de-embedder to extract this analog timecode audio signal 
and feed it directly to a recording device. This is particularly helpful if you have outboard 
video processing equipment such as a noise reducer or format converter that does not 
pass through the VITC timecode.

>>Delay LTC by x frames: When outputting LTC to bypass outboard processing gear, such as a 
noise reducer or format converter, you can compensate for the processing delay by delaying 
the timecode by a matter of frames to ensure that the processed image and timecode reach 
the deck at the same time. With a DVS card there is a separate timecode output.

>> Enable audio output: When this checkbox is enabled, DaVinci Resolve will play a .wav or 
aif audio file, either the embedded source audio, or the currently specified Audio Chase 
Track, along with the video being output, so both can be recorded to tape. Select the 
appropriate audio file, then choose the appropriate settings for Offset, Channels, and Bit 
Depth. Use the “Offset (frames)” setting to sync the audio and video, if necessary.

>>Offset audio by x frames: Lets you specify an offset between the audio track and video 
to achieve proper A/V sync in cases where the video is being delayed by outboard 
processing hardware.

>>Output x channels of audio: Choose the number of audio tracks to output to tape.

>> Set batch playout head handle to x seconds: When batch outputting multiple clips, you can 
specify a number of frames before the In point of each clip to be output as well.

>> Set batch playout tail handle to x seconds: When batch outputting multiple clips, you can 
specify a number of frames after the Out point of each clip to be output as well.

>> Apply gaps between clips: This checkbox lets you add a black gap, of the specified duration 
in frames, between every two clips being output when outputting in batch mode.
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The parameters in this panel let you customize the functionality of the DaVinci Control panel. Some, 
but not all, of these settings apply to third party panels.

>> Lift RGB balance sensitivity: Controls how quickly adjustments made to the Lift trackball (on 
the left) will adjust the Lift Color Balance parameters in the Color page. This setting affects 
third party panels.

>> Lift master sensitivity: Controls how quickly adjustments made to the Lift ring (surrounding 
the leftmost trackball) will adjust the Lift Contrast parameter in the Color page. This setting 
affects third party panels.

>>Gamma RGB balance sensitivity: Controls how quickly adjustments made to the Gamma 
trackball (second from the left) will adjust the Gamma Color Balance parameters in the 
Color page. This setting affects third party panels.

>>Gamma master sensitivity: Controls how quickly adjustments made to the Gamma ring 
(surrounding the second trackball from the left) adjust the Gamma parameter in the Color 
page. This setting affects third party panels.

>>Gain RGB balance sensitivity: Controls how quickly adjustments made to the Gain trackball 
(third from the left) will adjust the Gain Color Balance parameters in the Color page. This 
setting affects third party panels.

>>Gain master sensitivity: Controls how quickly adjustments made to the Gain ring (surrounding 
the third trackball from the left) will adjust the Gain Contrast parameter in the Color page. 
This setting affects third party panels.

>> Cursor offset sensitivity: Controls how quickly adjustments made to the fourth trackball 
affect the cursor, window position, log-mode offset, and other controls that can be 
manipulated via this trackball.

>> Cursor master sensitivity: Controls how quickly adjustments made to the fourth ring affect 
log-mode master offset, and other controls that can be manipulated via this ring.

>> Hue/Saturation/Luminance qualifier sensitivity: Controls the sensitivity of the HSL panel 
control knobs. 

>>Grading style: Controls the orientation of the trackballs relative to the corrections they 
make. There are two options:

>> DaVinci: Most users will be familiar with the standard DaVinci controls as this mimics 
the vectorscope. If you move the trackball to the right, and lower, a little, the image will 
become more blue; move to the top for more red and to the lower left for more green.

>> Rank: The Rank settings are somewhat different, so this option is for users who are 
familiar with color controls that the Rank control system offered. In this mode, the 
orientation of red and green are reversed.

Control Panel
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>> LCD brightness: Controls the overall brightness of the lit buttons of the DaVinci 
control surface.

>> Red/Green/Blue key backlighting: Three sliders let you adjust the color balance of the lit 
buttons of the DaVinci control surface. The default is red.
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DaVinci Resolve’s Autosave feature can save you from the heartache of lost work resulting from an 
unexpected problem.

>> Automatically save project: Enables auto saving. There are three options.

>>Off: Disables auto saving.

>>On: Emulates a manual save, incrementally saving the current project. This is faster 
than the next option, and suitable for use during a grading timeline.

>> To backup project: Saves a full alternate copy of the active database while you work. 
While this full backup takes longer than the simpler incremental autosave option, it 
offers a complete backup, and is often used by colorists at the end of each workday 
or grading timeline.

>> Retain the last X backups: Sets how many backup versions of the project to save. Backups 
are eliminated in a first in, first out fashion. The default is 8 backups.

>> Every: A pop-up menu lets you define how frequently to execute the selected 
autosave behavior.

>> List Backups: Shows a window listing all auto saved backup projects. This list can be sorted 
by name, date modified, width, or height. Buttons running along the bottom provide an 
interface to Load or Delete any item in the list, Delete all, or Refresh the list. When you load 
an autosave backup, the current project is lost, and completely replaced by the autosaved 
project. You are recommended to export the project first, before loading, if you want to 
preserve the current state of the project.

Auto Save
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Keyboard Mapping

This panel lets you choose which set of keyboard shortcuts to use. Using the “Map keyboard 
to” pop-up, you can choose the default DaVinci Resolve set, or one of the other sets that mimic 
popular NLEs. You also have the ability to create your own custom sets of keyboard shortcuts. A 
hierarchical list of commands organized by the menu they appear within lets you select individual 
commands to remap.

Methods of creating and managing keyboard mappings:

>> To create a new keyboard mapping: Choose a keyboard mapping from the pop-up to use 
as your starting point, click the plus (+) button, then enter a preset name in the dialog, 
and click OK.

>> To change the keyboard shortcut for a particular command: Find the command you want 
to remap in the Keyboard Mapping list, double-click its keyboard shortcut, and type a new 
one using any combination of modifier keys you like. If you remap a key that was already 
assigned to another command, the previous command’s mapping is cleared. When you’re 
finished changing keyboard shortcuts, click the Save button at the bottom right of the 
Keyboard Mapping list.

>> To export a keyboard shortcut file for use by another Resolve workstation: Click Export, 
choose a name and a location for the new file, and click Save.

>> To import a keyboard shortcut file: Click Import, choose a DaVinci Resolve keyboard 
shortcut file, and click Open.

>> To delete a keyboard mapping: Choose a keyboard mapping to delete, then click the trash 
can button.
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The metadata panel lets you create custom sets of metadata parameters that will be exposed in 
the Metadata Editor. Using this panel, you can create customized subsets of metadata that are 
focused on your needs. Presets that you create are available from the preset pop-up menu at the 
upper right-hand side of the Metadata editor. You can always switch to the full default presets in 
the same pop-up.

To create a new metadata preset:

1.	 Open the Metadata panel of the Project Settings and click New.

2.	 Click the checkboxes of every metadata tag you want to include in this preset, or click the 
checkbox of a group name on the list to include all metadata tags within it.

	 Every single metadata tag available in DaVinci Resolve appears within one of several groups 
that appear as a list. To open any group to see its contents, move the pointer over that group’s 
entry on the list, and click the Show button when it appears.

3.	 When you’re finished, click the Save button.

To edit an existing metadata preset:

1.	 Select a preset from the list, and click Edit.

2.	 Turn checkboxes on and off to include or exclude whatever tags you need.

3.	 Click the Save button.

To delete a metadata preset:

>> 	Select a preset from the list and click Delete.

Metadata
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DaVinci Resolve is a high-performance piece of software designed to enable real time effects on a 
variety of workstations. This section describes the various ways you can monitor your performance 
to make sure you’re maintaining real time playback, along with different methods of optimizing real 
time performance, including using on-the-fly proxies and the background Render Cache.

Understanding the GPU Status Display

Every viewer in Resolve exposes a frame-per-second (FPS) meter and GPU status graph, which 
appears somewhere in the Viewer’s title bar. The most elaborate graph is presented in the Color 
page, at the top left-hand corner of the Viewer whenever playback is initiated. Since DaVinci Resolve 
uses one or more GPUs (graphics processing units) to handle all image processing and effects, 
the GPU status graph shows you how much processing power is being used by whichever grade 
is playing. 

A long green graph shows there is plenty of GPU processing headroom available. As the GPU 
resources is increasingly taxed, this green graph becomes shorter. Eventually, it turns red to show 
that the available GPU power is insufficient for consistent real time playback. 

Eventually, as you add more and more corrections, you’ll reach the limits of available performance, 
forcing DaVinci Resolve to play video at a slower speed in order to maintain high image quality (as 
shown by the FPS indicator).

Frame rate and GPU indication, green is good

Slower frame rate matches red GPU indication

Monitoring and Optimizing Performance in Resolve
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Using Proxies or Clip Cache When GPU Status Is in the Red

When the GPU Status indicator is in the red, you may continue playing your project at slower than 
real time speed, or you can turn on the Use Proxies option in the Image Scaling section of the 
Settings to enable DaVinci Resolve to generate proxy source images in real time. Proxies reduce 
processing demands by temporarily lowering the resolution of your clips, thereby increasing real 
time playback performance.

To turn Proxies on and off, do one of the following:

>> Choose View > Use Proxies (Command-P).

>> Press PROXY ON/OFF on the T-bar panel of the DaVinci control surface.

Alternately, you can use the Smart cache mode to automatically cache processor-intensive grades, 
or you can use the Render Cache Clip Output command to cache specific clips with processor-
intensive grades when the User cache mode is enabled. In cache mode, frames of each marked clip 
are cached as they play. Once cached, these clips play back in real time until they’re modified.

To use clip caching, do one of the following:

>> Choose Playback > Render Cache > Smart to set Resolve to automatically cache 
computationally intensive effects.

>> Choose Playback > Render Cache > User to set Resolve to only cache clips that have been 
flagged by the user.

>> Press Option-R to cycle among Off, Smart, and User.

>> Press CACHE MODE on the T-bar panel of the DaVinci control surface to toggle among the 
available options.

More information about using the Render Cache appears later in this chapter.

Other Project Settings for Improving Real Time Performance

In addition to working with proxies, there are seven options in the Project Settings window that you 
can use to improve real time performance if you’re working on an underpowered computer, at the 
expense of lower image quality while you work. These settings can then be changed back to higher 
quality modes prior to rendering.

>> Set timeline resolution to: (Master Project Settings, Timeline Format) DaVinci Resolve is 
resolution independent, so you can change the resolution at any time and all windows, 
tracks, sizing changes, and keyframe data will be automatically recalculated to fit the 
new size. Lowering the Timeline resolution while you’re grading will improve real time 
performance by reducing the amount of data being processed, but you’ll want to increase 
Timeline resolution to the desired size prior to rendering.
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>> Enable video field processing: (Master Project Settings, Timeline Format) You can leave 
this option turned off even if you’re working on interlaced material to improve real time 
performance. When you’re finished, you can turn this setting back on prior to rendering. 
However, whether or not it’s necessary to turn field processing on depends on what kinds 
of corrections you’re making. If you’re applying any filtering or sizing operations such as 
blur, sharpen, pan, tilt, zoom, or rotate, then field processing should be on for rendering. If 
you’re only applying adjustments to color and contrast, field processing is not necessary.

>> Video bit depth: (Master Project Settings, Video Monitoring) Monitoring at 8-bit 
improves real time performance, at the expense of possibly introducing banding to the 
monitored image.

>> Use optimized display mode during playback: (Master Project Settings, Video Monitoring) 
Enabling this setting improves real time performance by hiding on-screen controls such as 
the cursor, Power Window outlines, and split-screen views during playback. When playback 
is stopped, onscreen controls reappear.

>> Uses Bilinear filter: (Image Scaling) A lower quality image transform setting that is less 
processor intensive. A “Force sizing highest quality” checkbox in the Render Settings list 
of the Deliver page helps make sure you don’t accidentally render your final media at this 
lower quality setting.

>> Decode Quality: (Camera Raw) Camera raw formats such as R3D and F65 can be debayered 
at different levels of quality. For higher real time performance, you can choose a lower 
quality setting while you work, and then switch to a higher quality when rendering the final 
output. A “Force debayer res to highest quality” checkbox in the Render Settings list of the 
Deliver page makes it easy to follow this workflow.

>> Play Quality: (Camera Raw settings) This option provides the additional ability to set a 
lower resolution for debayering during playback than for when the playhead is stopped. By 
default playback uses the same setting as the Decode Quality pop-up menu.
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On all pages, you can use the options in the Playback > Render Cache submenu, selecting None, 
Smart, or User to either disable or initiate caching. In Smart mode, Resolve renders clips that 
will exceed your computer’s real time capabilities to the “Cache files location” specified in the 
General Options panel of the Project Settings, to enable real time playback of these clips even 
on underpowered workstations. Alternately, in User mode, Resolve only caches clips that you 
manually flag.

The Source, Node, and Sequence Caches are Separate

The cache mechanism in Resolve actually comprises three independently managed media caches 
that interact with one another. This is done to keep you working quickly by ensuring that changes 
you make to your timeline don’t require a grade to be re-cached, and that changes you make to a 
grade don’t require the timeline to be re-cached. The three levels of caching are:

>> Source cache: Caches the portion of each source media file that appears in the timeline 
in its pre-graded state. By caching media formats that Resolve considers to be processor-
intensive to decode, such as H. 264 and various raw camera formats, you’ll experience 
vastly improved editing and grading performance. At any time, you have the option to turn 
the source cache on or off for individual clips, or for multiple selected clips all at once. This 
lets you switch between using the native source format of each clip, or the cache format 
you’ve chosen.

>>Node cache: Acts to cache processor-intensive operations within a clip’s grade in the Color 
page. Ordinarily, only processor-intensive nodes (along with all nodes appearing upstream) 
are cached, meaning that, for example, if nodes 1 and 2 are cached, you can continue 
adjusting nodes 3, 4, and 5 to your heart’s content without needing to re-render your grade 
to the cache. However, there’s one other way the Node cache can be used, and that’s by 
turning on the “Render Cache Clip Output” option in the timeline of either the Edit or 
Color pages. This forces a clip’s entire grade to be cached all the way through the node 
tree’s output, which results in higher real time performance in the Edit page, at the expense 
of needing to completely re-cache a clip whenever you adjust any part of its grade.

>> Sequence cache: Caches timeline-specific effects such as transitions, opacity adjustments, 

and composite mode superimpositions.

Choosing a Cache Format and Location

The cache format is user selectable by opening the General Options panel of the Project Settings, 
and using the “Cache frames in” pop-up menu to choose one of the ProRes, DNxHD, uncompressed 
10-bit, or uncompressed 16-bit float formats. Selecting a higher quality cache format guarantees 
high quality image playback, but makes more demands on the throughput and size of your available 
disk storage. On the other hand, choosing a more highly compressed cache format makes realtime 
playback possible on less capable computers with slower and smaller storage, at the expense of 

Using the Render Cache
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slightly compromised image quality. Ideally, you should choose the highest quality cache format 
that your workstation’s storage can accommodate. 

The Cache files location defaults to the first volume you add to the Scratch Disks list of the Media 
Storage panel of the Resolve Preferences. If no scratch disk is specified, your System disk will be 
used, which may pose problems with capacity and/or performance depending on the size and type 
of System disk you’re using, and on the media format you choose to cache to. For this reason, it’s 
nearly always advisable to set your first scratch disk to the largest, fastest storage volume available 
to your workstation.

Enabling Smart Cache

The Smart Cache option of the Render Cache submenu provides the best user experience when 
you want to “set it and forget it.” Choosing Smart triggers a variety of automatic caching behaviors 
designed to optimize playback in DaVinci Resolve by rendering clip formats, grading operations, 
and timeline effects that are known to be performance-intensive. The rules for Smart mode 
caching are:

>> Source caching: Caches source media in its pre-graded state. By caching media that 
is processor-intensive to decode, you’ll experience improved editing and grading 
performance. In Smart mode, H.264, DCP, JPEG2K or camera raw clips that have been 
edited into a timeline are automatically cached at their source, and are resized to the 
current Timeline resolution regardless of the media’s original resolution. Camera raw clips 
are cached using the currently selected project or clip debayer settings. Source caching 
can also be manually controlled, as explained later in this chapter.

>>Node caching: Caches specific nodes in the Color page, along with all upstream nodes. 
By caching processor-intensive nodes, you free up real time capability for the remaining 
downstream nodes in a grade. In Smart mode, Resolve automatically caches any nodes 
that use Motion Blur, Noise Reduction, or OFX plug-ins. You can also manually flag a node 
for caching in Smart or User modes by right-clicking it and choosing Node Cache > On.

>> Clip caching: An alternate way of forcing node caching in either Smart or User modes is 
to right-click any clip in the timeline of the Edit page, or right-clicking a thumbnail in the 
Color page, and turn on “Render Cache Clip.” This caches the output of the Color page 
node graph, effectively caching every single node in the tree. Caching a clip’s entire grade 
is most useful when you want to improve trimming and playback performance in the Edit 
page. Flagging a clip for caching also causes EVERY VERSION associated with that clip to 
be cached as well.
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>> Sequence caching: Caches clips with effects applied to them in the Timeline, improving 
trimming and playback performance for clips using processor-intensive Edit page effects. 
In Smart mode, Resolve automatically caches all superimposed clips that use composite 
modes other then “Normal,” and any clips with opacity or speed effects. Clips cannot be 
manually flagged for Sequence caching.

Enabling User Cache

The User cache option of the Render Cache submenu provides a strictly user-controlled caching 
experience. In User mode, only clips and nodes that you manually flag will be cached. For example, 
if you don’t want to cache at the Node or Sequence level, but you do want to cache each clip at the 
source, you can set the cache mode to User, then select all the clips you want to cache, right-click 
them, and set “Render Cache Clip Source” to On.

Here’s how each of the caches work in User mode:

>> Source caching: The “Render Cache Clip Source” setting for clips in the timeline defaults 
to Auto, but you can manually set one or more selected clips to Render Cache Clip Source 
> On to force those clips to be cached in User mode.

>>Node caching: You can right-click any node in the Color page node tree and choose Node 
Cache > On to force that node to cache in User mode, along with all upstream nodes to 
the left of it.

>> Clip caching: An alternate way of forcing node caching in either Smart or User modes is 
to right-click any clip in the timeline of the Edit page, or right-clicking a thumbnail in the 
Color page, and turn on “Render Cache Clip.” This caches the output of the Color page 
node graph, effectively caching every single node in the tree. Caching a clip’s entire grade 
is most useful when you want to improve trimming and playback performance in the Edit 
page. Flagging a clip for caching also causes EVERY VERSION associated with that clip to 
be cached as well.

>> Sequence caching: Sequence caching cannot be done manually; it only happens in 
Smart mode.

Cache bars seen in the Timeline of the Edit page, red bars show areas of the timeline that need caching,  

blue shows areas that have been cached
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When Caching Happens

When either Smart or User caching is enabled, caching happens whenever you play clips that 
are to be cached. Cache indicators on the Edit and Color page timelines show the status of the 
cache. Red means “to be cached,” while blue means “has been cached.”

If background caching is enabled in the Project settings, and there are no UI or control panel 
adjustments made for a user-definable number of seconds (this is adjustable in the General 
Options panel of the Project Settings), caching will automatically begin during periods of user 
inactivity.

Controlling Source Caching

You can manually control which clips in the timeline are cached, and which are not. You can select 
one or more clips in the timeline of the Edit page, or in the Thumbnail Timeline of the Color page, 
right click one of the selected clips or thumbnails, and choose an option from the Render Cache 
Clip Source submenu. There are three options:

>> Auto: The clip will only be cached in Smart mode, and only if it’s a format designated 
for caching.

>>On: The clip will be cached in either Smart or User mode, no matter what format.

>>Off: The clip will not be cached, in either Smart or User modes.

Controlling Node Caching

You can manually control which nodes in a grade are cached, and which are not. Right-click any node 
in a node tree, and choose an option from the Node Cache submenu. There are three options:

>> Auto: The flagged node and all upstream nodes will only be cached in Smart mode if it 
contains an operation that’s designated for caching.

>>On: The node will always be cached in either Smart or User mode, no matter what operations 
it performs.

>>Off: The node will not be cached, in either Smart or User modes. This lets you exclude 
nodes from caching in smart mode if they’re capable of real time operation on your system.

Clearing Cached Media

Each project’s cache is persistent; the cache is saved for future use even when the project is closed 
and later reopened. If you need to delete a project’s cache to free up space on a storage volume, 
there are three options in the Delete Render Cache submenu:

>> All: You can delete all media in the cache to reset every single cached clip.
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>> Unused: You can choose to delete only Unused cache clips that no longer correspond to 
clips or effects in the timeline.

>> Selected clips: You can make a manual selection of clips in the timeline, and delete the 
cache corresponding to just those clips.

To clear a project’s cache:

>>Open the project, and choose Playback > Delete Render Cache > All, Unused, or 
Selected Clips.

Using the Cache During Delivery

An option in the Intermediate and Advanced panels of the Deliver page, “Use Render Cached 
Images,” lets you export media from the cache, rather then re-rendering from scratch, in order to 
save time. If you’re planning on using this option, it’s advisable to set the cache format to a suitably 
high-quality format to guarantee the best results.
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Data Levels Settings and Conversions

Different media formats use different ranges of values to represent image data. Since these data 
formats often correspond to different output workflows (cinema vs. broadcast), it helps to know 
where your project’s media files are coming from, and where they’re going, in order to define the 
various data range settings in DaVinci Resolve and preserve your program’s data integrity.

To generalize, with 10-bit image values (with a numeric range of 0-1023), there are two different data 
levels (or ranges) that can be used to store image data when writing to media file formats such as 
QuickTime, MXF, or DPX. These ranges are:

>> Video Levels: Typically used by Y’CBCR video data. All image data from 0 to 100 percent 
must fit into the numeric range of 64–940. Specifically, the Y’ component’s range is 64–940, 
while the numeric range of the CB and CR components is 64–960. The lower range of 4–63 
is reserved for “blacker-than-black,” and the higher ranges of 941/961–1019 are reserved for 
“super-white.” These “out of bounds” ranges are recorded in source media as undershoots 
and overshoots, but they’re not acceptable for broadcast output.

>> Data Levels: Typical for RGB 444 data acquired from digital cinema cameras, or film scanned 
to DPX image sequences. All image data from 0 to 100 percent is simply fit into the full 
numeric range of 0 to 1023.

Keep in mind that every digital image, no matter what its format, has absolute minimum and 
maximum levels, referred to in this section as 0–100 percent. Whenever media using one data range 
is converted into another data range, each color component’s minimum and maximum data levels 
are remapped so that the old minimum value is scaled to the new data level minimum, and the old 
maximum value is scaled to the new data level maximum:

(minimum Video Level) 64 = 0 (Data Level minimum)

(maximum Video Level) 940 or 960 = 1023 (Data Level maximum)

Converting an image from one data range to another should result in a seamless change. All “legal” 
data from 0–100 percent is always preserved, and is linearly scaled from the previous data range to 
fit into the new data range.

The sole exception is that the undershoots and overshoots of “Video Levels” media, if present, are 
usually clipped when converted to full-range “Data Levels.” However, Resolve preserves this data 
internally, and these clipped pixels of detail in the undershoots and overshoots are still retrievable 
by making suitable adjustments in the Color page to bring them back into the “legal” range.

Internal Image Processing and Clip Data Levels

It’s useful to know that, internally to DaVinci Resolve, all image data is processed as full range, 
uncompressed, 32-bit floating point data. What this means is that each clip in the Media Pool, 
whatever its original bit-depth or data range, is scaled into full-range 32-bit data. How each clip is 
scaled depends on its Levels setting in the Clip Attributes window, available from the Media Pool 
contextual menu.
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By converting all clips to uncompressed, full-range, 32-bit floating point data, Resolve guarantees 
the highest quality image processing that’s possible. As always, the quality of your output is 
dependent on the quality of the source media you’re using, but you can be sure that Resolve is 
preserving all the data that was present in the original media.

Assigning Clip Levels in the Media Pool

When you first import media into the Media Pool, either manually in the Media page or automatically 
by importing an AAF or XML project in the Edit page, Resolve automatically assigns the “Auto” 
Levels setting. When a clip is set to Auto, the Levels setting used is determined based on the codec 
of the source media.

DaVinci Resolve generally does a good job of figuring out the appropriate Levels setting of each clip 
on its own. However, in certain circumstances, such as when you’re mixing video-originated media 
and digital cinema camera-originated media, you may find that you need to manually choose the 
appropriate settings so that the levels of each clip are interpreted correctly. This can be done using 
each clip’s Levels setting in the Clip Attributes window, available from the Media Pool contextual 
menu in either the Media or Edit pages.

To change a clip’s Data Level setting:

1. 	 Open the Media or Edit page.

2. 	 Select one or more clips, then right-click one of them and choose Clip Attributes.

3. 	 Click the Levels ratio button corresponding to the data level setting you want to assign, 
then click OK.

Tip: If you need to change the Levels setting of a range of clips that share a unique property such 
as reel name, resolution, frame rate, or file path, you can view the Media Pool by column, and sort 
by the particular column that will best isolate the range of media to which you need to make a data 
level assignment.

Once you change a clip’s Levels setting, that clip will automatically be reconverted based on the 
new assignment. If it appears to be correct, then you’re ready to work. If it doesn’t, then you may 
want to reconsider the Levels assignment you’ve made, and you should check with the person who 
provided the media to find out how it was generated, captured, and exported.

Selecting data or video levels
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So long as the Levels settings used by your clips are accurate, you should be ready to work. However, 
problems can still occur based on what external video hardware you’re using with your workstation, 
and how you need to deliver the finished media to your client. For this reason, there are three 
additional data level settings that you can use to maintain data integrity, while at the same time 
seeing the proper image as you work.

Video Monitoring Data Levels

Superficial problems may result if the settings used by your external display differ from the settings 
you’re using to process data levels in Resolve. Accordingly, there is a Video/Data Level setting in the 
Master Project Settings panel of the Project Settings (in the Video Monitoring section).

When you change this setting, the image being output to your external display should change, but 
the image you see in your Viewer will not. That’s because this setting only affects the data levels 
being output via the video interface connecting the Resolve workstation to your external display. 
It has no effect on the data that’s processed internally by Resolve, or on the files written when you 
render in the Deliver page.

There are two options:

>> Video Levels: This is the correct option to use when using a broadcast display set to the 
Rec. 709 video standard.

>> Data Levels: If your monitor or projector is capable of displaying “full range” video signals, 
and you wish to monitor the full 10-bit data range (0- 1023) while you work, then this is the 
correct option to use.

It is imperative that the option you choose in Resolve matches the data range the external display 
is set to. Otherwise, the video signal will appear to be incorrect, even though the internal data is 
being processed accurately by DaVinci Resolve.

Video/Data Level selection for monitoring

Deck Capture and Playback Data Level

There is a separate “Video/Data Level” setting that is specific to when you’re capturing from or 
outputting to VTRs. This setting also affects the video signal that is output via the video interface 
connecting the Resolve workstation to your VTR (which is usually also in the signal chain used for 
monitoring). However, it only takes effect when you’re capturing from tape in the Media page, or 
editing to tape in the Deliver page. If you never capture or output to tape, this setting will never 
take effect.
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This setting is found in the Deck Capture and Playback panel of the Project Settings.

The reason for a separate option for tape capture and output is that often you’d want to monitor in 
one format (normally scaled Rec. 709), but output to tape in another (full range RGB 444). This way, 
you can set up Resolve to accommodate this workflow, and then not have to worry about manually 
switching your video interface back and forth.

There are two options:

>> Video Levels: This is the correct option to use when you want to output conventional Rec. 
709 video to a compatible tape format.

>> Data Levels: This is the correct option to use when you want to output “full range” RGB 444 
video to a compatible tape format.

Once tape ingest or output has finished, your video interface goes back to outputting using the 
setting specified by the “Colorspace conversion uses” setting in the Master Project Settings panel 
of the Project Settings (in the Video Monitoring section).

Output Data Level Settings in the Deliver Page

Finally, there’s one last set of data level settings, available in the Render Settings list, within the 
Format group. It’s the “Set to video or data level” pop-up menu. It’s there to give you the ability to 
convert the data level of your rendered output, if necessary.

All media is output using a single data level, depending on your selection. There are three options:

>> Automatic: The output data level of all clips is set automatically based on the codec you 
select to render to in the “Render to” pop-up menu.

>> Video (64-940): All clips are rendered as normally scaled. 

>> Data (4-1019): All clips are rendered as full range.

For most projects, leaving this setting on “Automatic” will yield the appropriate results. However, 
if you’re rendering media for use by another image processing application (such as a compositing 
application) that is capable of handling “full range” data, then full range output is preferable for 
media exchange as it provides the greatest data fidelity. For example, when outputting media 
for VFX work as a DPX image sequence, or as a ProRes 4444 encoded QuickTime file, choosing 
“Unscaled full range data” guarantees the maximum available image quality. However, it is essential 
that the application you use to process this media is set to read it as “full range” data, otherwise the 
images will not look correct.
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So, What’s the “Proper” Data Range for Output?

Strictly speaking, there is no absolutely “proper” data range to use when outputting image data. As 
long as the Levels setting of each clip in the Media Pool is set to reflect how each clip was created, 
your primary consideration is which data range is compatible with the media format or application 
you’re delivering to. If the media format you’re exporting to supports either normally scaled or full 
range, and the application that media will be imported into supports either normally scaled or full 
range, then it’s really your choice, as long as everyone involved with the project understands how 
the data range of the media is meant to be interpreted once they receive it.

Outputting to hardware is a bit trickier, in that you need to make sure that the external display or 
VTR you’re outputting to is set up to receive a signal using the data range you’ve chosen. If the 
device is limited to only one data range, then you need to be sure that you’re outputting to it using 
that data range, or the levels of the image will appear to be incorrect, even though the image data 
being processed by Resolve is actually fine.
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Working With ACES

The ACES (Academy Color Encoding Specification) color space has been designed to make scene-
referred color management a reality for high-end digital cinema workflows. ACES also makes it 
easier to extract high-precision, wide-latitude image data from raw camera formats, in order to 
preserve high-quality image data from acquisition through the color grading process, and to output 
high-quality data for broadcast viewing, film printing, or digital cinema encoding.

An oversimplification of the way ACES works is that every camera and acquisition device is 
characterized to create an IDT (Input Device Transform) that specifies how media from that 
device is converted into the ACES color space. The ACES gamut has been designed to be 
large enough to encompass all visible light, with more than 25 stops of exposure latitude. In this 
way ACES has been designed to be future-proof, taking into consideration advances in image 
capture and distribution.

Meanwhile, an RRT (Reference Rendering Transform) is used to transform the data provided by each 
image format’s IDT into standardized, high-precision, wide-latitude image data that in turn is 
processed via an ODT (Output Device Transform). Different ODT settings correspond to each 
standard of monitoring and output, and describe how to accurately convert the data within the 
ACES color space into the gamut of that display in order to most accurately represent the image in 
every situation. The RRT and ODT always work together.

ACES signal and processing flow

By using the ACES color space and specifying an IDT and an ODT, you can ingest media from any 
capture device, grade it using a calibrated display, output it to any destination, and preserve the 
color fidelity of the graded image.
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Setting Up ACES in the Project Settings Window

There are three parameters available in the Project Settings that let you set up DaVinci Resolve to 
use the ACES workflow. The first is located in the Project Settings panel:

>> Color science is: Using this pop-up menu, you can choose either DaVinci ACES, or DaVinci 
ACES Log color science, which enables ACES processing throughout DaVinci Resolve.

>> DaVinci ACES: Chooses DaVinci ACES color science, which applies a proprietary 
encoding to the ACES data before it is processed by Resolve. After processing, a 
reverse encoding is applied in order to output ACES linear data.

>> DaVinci ACES Log: Choose DaVinci ACES Log color science to apply a standard 
Cineon-style log encoding to the ACES data before it is processed by Resolve. This 
well defined common encoding makes it possible for ASC CDL values to be used 
across systems using the same ACES Log encoding. After processing, a reverse 
encoding is applied in order to output ACES linear data.

When you choose the ACES color science, two additional settings become available in the Look 
Up Tables panel:

>> ACES Input Device Transform: This pop-up menu lets you choose which IDT to use for the 
dominant media format in use. DaVinci Resolve currently supports the following IDTs:

>> RED/ALEXA/Canon 1D/5D/7D/Sony F65: Each listed camera has its own transform in 
this list that is specific to that camera’s sensor.

>> Rec. 709: A standard transform designed to move media in the Rec. 709 color space 
into the ACES color space. This option is used for any other file type that might be 
imported, such as ProRes from Final Cut Pro, DNxHD from Media Composer, and any 
media file captured from tape.

>> ADX: 10-bit or 16-bit integer film-density encoding transforms meant for use if you’re 
working with film scans that were initially encoded in an ACES workflow. This transform 
is designed to maintain the variation in look between different film stocks.

>> CinemaDNG: A transform intended to accommodate camera original media from the 
Blackmagic Cinema Camera’s sensor.

If you’re working on a project that mixes media formats that require different IDTs, then you can 
assign different IDTs to clips using the Media Pool’s contextual menu, or using the Clip Attributes 
window, which is also accessible via the Media Pool’s contextual menu.

>> ACES Output Device Transform: This pop-up menu lets you choose an ODT with which to 
transform the image data for monitoring on your calibrated display, and when exporting a 
timeline in the Deliver page. You can choose from the following options:
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>> Rec. 709: This ODT is used for standard monitoring and deliverables for TV.

>> DCDM: This ODT exports X’Y’Z’-encoded media with a gamma of 2.6 intended for 
handoff to applications that will be re-encoding this data to create a DCP (Digital 
Cinema Package) for digital cinema distribution. This can be displayed via an XYZ- 
capable projector.

>> P3 D60: Outputs RGB-encoded image data with a D60 white point, intended for 
monitoring with a P3- compatible display.

>> ADX: A standardized ODT designed for media destined for film output. This ODT is 
not meant to be used for monitoring.

>> sRGB: A standardized ODT designed for media destined for computer display in a 
consumer environment. Suitable for monitoring when grading programs destined 
for the web.

>> P3 DCI: A standardized ODT that outputs RGB-encoded image data with a D61 white 
point, intended for use when outputting media for DCI mastering.

You must manually select an ODT that matches your workflow and room setup when working in ACES.

The Initial State of Clips When Working in ACES

Don’t worry if the initial state of each image file appears differently than what was monitored 
originally on set. What’s important is that if the camera original media was well exposed, the IDT 
used in ACES mode will retain the maximum amount of image data, and provide the maximum 
available latitude for grading, regardless of how the image initially appears on the Timeline.

Tips For Rendering Out of an ACES Project

When choosing an output format in the Deliver page, keep the following in mind:

>> If you’ve delivering graded media for broadcast, set the ACES Output Device Transform to 
be Rec. 709, then you can output to whatever media format is convenient for your workflow.

>>When you’re delivering graded media files to another ACES-capable facility using the 
DCDM or ADX ODCs, you should choose the OpenEXR RGB Half (uncompressed) format 
in the Render Settings, and set the ACES Output Device Transform to “No Output Device 
Transform.”

>>When you’re rendering media for long-term archival, you should choose the OpenEXR 
RGB Half (uncompressed) format in the Render Settings, and set the ACES Output Device 
Transform to “No Output Device Transform.”
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If you have a system that doesn’t change very often, then you may only rarely use the Preferences 
window. On the other hand, if you’re working with a mobile system with changing video interfaces, 
control panels, and scratch volumes, then you may use this window more frequently.

The DaVinci Resolve Preferences window has three main settings that you need to define, if you 
haven’t already.

Hardware Preferences

System Overview

Provides an overview, for reference, of all hardware and computer characteristics that are relevant 
to DaVinci Resolve running smoothly, including listing of installed GPUs. A Language pop-up at the 
top lets you specify which language the DaVinci Resolve user interface displays. Resolve currently 
supports English, Chinese, and Japanese.

Media Storage Volumes

This is the list within which you define the scratch disk of the system. The first volume in this list is 
where Gallery stills and cache files are stored, so you want to make sure that you choose the fastest 
storage volume to which you have access.

The “Show all mounted volumes” checkbox lets Resolve access media on all temporarily and 
permanently mounted volumes, including USB, FireWire, or Thunderbolt connected hard drives, 
without having to add them to this list. This is on by default.

DaVinci Resolve Preferences
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Shared media path mapping support for Mac, Linux and Windows makes it easier for multi-system 
shops to share Resolve projects among different platforms that use different file path conventions. 

To add a mapped mount string:

1. 	 Open the Media Storage panel of the Resolve Preferences window.

2. 	 Add the volume you want to map to the Scratch Disks list.

3. 	 Double-click the Mapped Mount column of the drive you added to edit it.

4. 	 Enter the alternate file path you want that volume to have.

Note: If the volume you’ve selected to use for the cache becomes unavailable, Resolve will warn you 
with a dialog.

Video I/O and GPU

The preferences in this panel let you choose video interfaces and GPU hardware on your 
workstation.

>> For capture and playback use: If you have a compatible video capture card, you should 
choose from the card options that appear here. Leaving this set to “None” disables external 
video output. Disabling video output can improve real time performance when external 
monitoring and output is not a priority. You can also choose “None” when you’re using 
Resolve with another application open at the same time that’s using your workstation’s 
video output interface. When you’ve quit the other application, you can reselect the video 
output interface for use by Resolve.

Note: Disabling video output can improve real time performance when external monitoring 
and output is not a priority. You can also choose “None” when you’re using Resolve with 
another application open at the same time that’s using your workstation’s video output 
interface. When you’ve quit the other application, you can reselect the video output 
interface for use by Resolve.

>> For DaVinci Resolve Live use: When using Resolve Live to monitor the live output from a 
camera, you must have a video interface that’s dedicated to doing just that. If you have 
only one video interface connected to your computer, you’ll need to disable it for capture 
and playback, and enable it for Resolve Live use. However, if you have two video interfaces 
connected at the same time, you can use one to monitor camera output, and the other to 
output to a video display for critical evaluation.

>> Use Red Rocket if available: This checkbox lets you disable Red Rocket support if you need 
to force Resolve to use standard RED software CPU debayering to accommodate your 
specific workflow, or when troubleshooting. If you are required to debayer R3D media 
using your CPU, turn this checkbox off.
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>> Use GPU for RED Debayer: Lets you use your GPU to accelerate debayering of R3D media 
for systems without a RED Rocket installed.

>> Use Display GPU For Compute: By default, a single GPU system uses this one GPU for 
the DaVinci user interface and also for image processing. As greater processing speeds 
are achievable with two or more GPUs, if two GPUs are installed for image processing 
this checkbox enables the shared use of the display GPU instead of dedicating it to just 
the DaVinci user interface. Resolve Lite users are restricted to the use of a single GPU, 
unless Resolve Lite is installed on a 2013 or later Mac Pro, in which case both installed GPUs 
will be used.

>> Use System Audio Output: Lets you force Resolve to output audio via your workstation’s 
built-in audio output, even if a compatible video I/O interface is enabled for capture and 
playback or for Resolve Live. If no video I/O interface is installed, audio is output via system 
audio output automatically.

>>GPU processing mode: Lets you set Resolve to use either OpenCL or CUDA on systems that 
have both ATI and Nvidia GPUs installed, to make sure that you’re using your most powerful 
GPU for processing. If you’re using a system that only has ATI GPUs, you should only use 
OpenCL. Most users can leave this set to Auto, and Resolve will use what’s appropriate.

Setting a Control Panel

Every control surface that DaVinci Resolve is compatible with appears in this list. Click the button 
corresponding to your panel, and if you’re using a JLCooper Eclipse, enter the IP and Port number.

Advanced

This tab is used for special Resolve configurations and SAN parameters that are applicable to older 
file systems.

Saving Preferences and Restarting DaVinci Resolve

Whenever you change the preferences, you’re first asked to validate your computer’s password, and 
then you’re required to restart Resolve in order for the new settings you’ve chosen to take effect.



4
Media
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The Media page is the primary interface for media management and clip organization in DaVinci 
Resolve. It’s central to the way DaVinci Resolve works that the source media used by a project 
is organized separately from the project data that you import and manage in the Edit page. In 
this way, you can manage and update the clips used by timelines in the current project with ease, 
switching between offline and online media, reorganizing clips, and troubleshooting any problems 
that occur.

The Media page also contains much of the core functionality that will be used for on-set workflows, 
and in the ingest, organizational, and sound-synching steps of digital dailies workflows. This chapter 
covers most of the functionality found in the Media page, including functions in detail that are 
referenced throughout this manual.

This chapter covers the following topics:

Media
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The Media Page User Interface� 116

The Media Page User Interface� 116

The Library� 117

Viewer� 119

Media Pool� 120

Metadata Editor� 123

Audio Panel� 124

Dual Monitor Layout� 125

Customizing the Media Page� 126

Copying Media Using the Clone Tool� 127

Adding and Removing Media� 128

Adding Media Based On EDLs� 129

Splitting Clips Based on EDLs� 130

Adding Media With Offset Timecode� 130

Removing Media From the Media Pool� 131

Adding and Removing External Mattes� 131

Adding Offline Videos� 133

Organizing the Media Pool� 135

Organizing Media into Folders� 135

Using the Media Pool in Icon View� 135

Working With Columns in List View� 136

Finding Media in the Media Pool� 138
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Editing Clip Metadata� 139

Syncing Audio� 141

Batch Syncing Dailies Using Timecode� 141

Individually Syncing Clips in the Timeline� 142

Offsetting the Sync of Previously Synched Clips� 143

Changing Clip Attributes� 144

Media Management� 148

Relinking Media Using Change Source Folder� 148

Locating Media Files in the Media Library and in the Finder� 148

Copying Clips Between Volumes� 148

Updating Timecode for Audio - LTC� 149

Creating Subclips� 149

Creating and Using Proxy Media� 151

Organizing Stereo Media� 153

Camera Raw Decoding� 154

Using Scene Detection� 155

The Scene Detect Window Interface� 155

An Example Scene Detect Workflow� 160

Tape Ingest� 162

The Tape Capture Interface� 162

Setting Up to Capture From Tape� 163

The Three Methods of Capture� 165

Batch Capture Via EDL� 168
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The Media page is the primary interface for media management and clip organization in DaVinci 
Resolve. It’s central to the way DaVinci Resolve works that the source media used by a project 
is organized separately from the project data that you import and manage in the Edit page. In 
this way, you can manage and update the clips used by timelines in the current project with ease, 
switching between offline and online media, reorganizing clips, and troubleshooting any problems 
that occur. 

The Media page also contains much of the core functionality that will be used for on-set workflows, 
and in the ingest, organizational, and sound-synching steps of digital dailies workflows. This chapter 
covers most of the functionality found in the Media page, including functions in detail that are 
referenced throughout this manual.

Understanding the Media Page User Interface
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The Media Page User Interface

The Media Page User Interface

The Media page is divided into six different areas, designed to make it easy to find, select, and work 
with media in your project.

Much of the functionality and most of the commands are found within the contextual menus that 
appear when you right-click clips in the Library, File Browser, or Media Pool.

Media page
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The Library

The Library browser shows a list of all volumes that are currently available to your Resolve workstation. 

It’s used to locate media that you want to import manually into your project. The list is divided into 
two categories of volumes:

>> Scratch volumes: Indicated by globe icon, these are disks that you’ve added to the Media 
Storage Volumes list of the Preferences window. The topmost of these scratch disks is used 
to store Gallery stills and cache files.

>> Available volumes: Indicated by disk icons, this is a list of all fixed, removable, and network 
volumes that are currently available to your workstation.

Library with scrubbable clip view
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The Library browser is a hierarchical list; clicking the disclosure triangle to the left of any volume 
opens up an additional list of that volume’s subdirectories, with additional disclosure triangles next 
to each subdirectory. Using the Library browser, you can drill down into as many subdirectories as 
you need to. 

Once you’ve selected a volume or subdirectory in the Library (volume browser), you can view the 
Library browser in List view or Icon view. In List view, the following columns are available for sorting 
media prior to importing it into the Media Pool:

>> File name: The name of a file.

>> Reel name: The reel name as it’s currently derived according to the Conform Options that 
are currently chosen in the Master Project Settings.

>> Start TC: The first timecode value in the source media.

>> Start: The first frame number in the source media.

>> End: The last frame number in the source media.

>> Resolution: The frame size of the source media.

>> FPS: The frame rate of the source media.

>> Audio Ch: The number of audio channels within the source media.

>> Date Modified: The date modified metadata from the source media file.

While in Icon view, you can scrub through a clip’s icon to see its contents, and you can also click the 
Clip Info pop-up menu at the bottom right corner of any clip’s thumbnail to see an instant summary 
of that clip’s vital information, including:

>> File name: The name of that file.

>> In timecode: The first frame in the source media.

>>Out timecode: The last frame in the source media.

>> Duration: The total duration of the source media.

>> Resolution: The frame size of the source media.

>> Frame Rate: The frame rate, in fps, of the source media.

>> Pixel Aspect Ratio: The aspect ratio of the source media.

>> Codec: Which codec is used by the source media.

>> Date Created: The date created metadata from the source media file.

>> Flags: Flag metadata applied either by the camera that shot the media, in the Metadata 
Editor, or in the Color page Timeline.
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Viewer

Clips that you select in any area of the Media page show their contents in the Viewer. A jog bar 
appears directly underneath the image, letting you drag the playhead directly with the pointer. The 
full width of the jog bar represents the full duration of the clip in the Viewer. The current position of 
the playhead is shown in the timecode field at the upper right-hand corner of the Viewer.

Simple transport controls appear underneath the jog bar, letting you Jump to First Frame, Play/
Stop, and Jump to Last Frame. 

A pair of buttons to the left of the transport controls let you choose between Playback mode, where 
you can examine clips, and Capture mode, in which you can cue up a device-controllable deck, and 
batch record from tape.

To the right of the transport controls, In and Out buttons let you set In and Out points for the 
current clip. The current In and Out points are indicated in the jog bar, and their timecode values, 
along with the resulting clip duration, are shown in the In, Out, and Duration timecode fields below. 
The Cue buttons move the playhead to these In and Out cue points. The clip’s timecode is also 
displayed at the top right.

Viewer
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Media Pool

The Media Pool contains all of the media that you import into the current project. It also contains any 
media that’s automatically imported along with Timelines that have been imported into Resolve. 

The Folder View

Ordinarily, all media imported into a project goes into the Master folder, however the Media Pool 
can be organized into as many user-definable folders as you like, depending on your needs. Media 
can be freely moved from one folder to another from within the Media Pool. When working in 
projects with multiple folders, you can choose to expose the folder structure in one of two ways:

>> Folder view open: The Folder View button at the bottom left-hand corner of the Media Pool 
lets you open a separate list view showing all folders in your project, hierarchically. Folders 
that contain other folders appear with a disclosure button to their left, that you can use to 
show or hide the contents. With the Folder view exposed, it’s easy to organize clips among 
a large collection of folders.

>> Folder view closed: When the Folder view is closed, all folders are hidden, and contents of 
whichever folder is currently selected populate the Media Pool browser.

Media Pool with the Folder View closed
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Filtering Folders Using Color Tags

If you’re working on a project that has a lot of folders, you can apply “color tags” to identify particular 
folders with one of eight colors. For example, you can identify the folders that have clips you’re 
using most frequently with a blue tag. A folder’s color tag then appears as a colored dot at the right 
of that folder’s name.  

Using Color Tags to identify folders

Once you’ve tagged one or more Media Pool folders, you can use the Color Tag Filter pop-up 
menu (the magnifying glass icon at the bottom right of the Media Pool’s Folder view) to filter out all 
but a single color of folder.

Media Pool with the Folder View open
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To go back to seeing all available folders, choose Show All from the Color Tag Filter pop-up.

Icon View and List View

The contents of the Media Pool can be browsed one of two ways:

>> Icon view: Each clip is represented by an icon, with its file name appearing underneath. 
When you move the pointer over a clip’s icon, Resolve automatically scrubs through that 
clip, showing you its contents. Also, a Clip Info pop-up menu appears in the lower right-hand 
corner. Click the Clip Info pop-up to see an overlay appear showing essential information 
about that clip.

>> List view: Each clip is represented by an item on a text list. Additionally, multiple columns of 
information appear, organized by headers. Clicking any header lets you sort the list by that 
column, in either ascending or descending order.

Using Color Tag filtering to isolate the red folder
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Metadata Editor

When you select a clip in any area of the Media page, its metadata is displayed within the Metadata 
Editor. If you select multiple clips, only the last clip’s information appears.

The Metadata Editor’s header contains uneditable information about the selected clip, including 
the file name, directory, duration, frame rate, resolution, and codec.

A series of editable fields underneath the Metadata Editor lets you review and edit the different 
metadata items that are available. A pop-up menu at the upper-right of the Metadata Editor lets 
you choose from many different sets of metadata fields and checkboxes, each grouped for a specific 
task or workflow.

Clip Metadata Editor
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Audio Panel

The Audio Panel can be put into one of two modes via a pop-up menu at the lower left corner. In 
the default Levels mode, Audio Meters are displayed that show the levels of audio in clips you’re 
playing. In Dailies mode, you can load audio clips side by side with video clips opened in the Viewer 
in order to sync them together manually. The Audio Panel can also be hidden.

When set to Levels mode, you can check audio embedded within clips you’ve imported into the 
Media Pool. DaVinci Resolve recognizes up to 16 tracks of audio within supported media formats. If 
you have a display with 2560x1440 resolution you can see all 16 corresponding audio meters, but on 
lower resolution displays only 8 audio meters appear in the Media page at a time. As you play a clip, 
each audio meter shows the levels for whichever of these tracks contain audio. You can toggle 
individual tracks on and off by clicking the track number underneath. A Mute button, to the left of 
the meters, lets you disable and enable audio playback.

Audio Meters Exposed

Tip: A setting in the Audio panel of the Project Settings window, “Audio Meter Alignment Level,” 
lets you redraw the dBU scale shown in all audio meters in Resolve to better reflect the reference 
alignment standard in your region of the world. This setting defaults to –20 dBFS, but can be 
adjusted from –24 to –15 dBFS.
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Dual Monitor Layout

The Edit page has a dual monitor layout that provides maximum space for the Library and Media 
Pool on the primary monitor, and an enlarged Viewer, Audio Panel, and Metadata editor on the 
secondary monitor, along with a complete set of video scopes for helping you to evaluate media as 
you organize it.

To enter dual screen mode:

>> Choose View > User Interface Layout > Dual Screen > On.

To switch which UI elements appear on which monitors:

>> Choose View > User Interface Layout > Primary Display > Display 1 or Display 2, which 
reverses the contents of both monitors in dual screen mode.

The Media page in dual-screen mode
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Customizing the Media Page

The Media Page can be customized to create more room in different areas to accommodate 
specific tasks.

To resize any area of the Media page:

>> Drag the vertical or horizontal border between any two panels to enlarge one and shrink 
the other.

Methods of hiding different parts of the Media Page:

>> To toggle the Clone Tool on and off: Click the button at the far left of the toolbar.

>> To toggle the Audio Panel on and off: Click the button at the far right of the toolbar.

>> To toggle the Media Pool folder list on and off: Click the button at the bottom-left of the 
Media Pool.

>> To toggle the Metadata Editor on and off: Click the button at the bottom-right of the 
Metadata Editor.

To return all pages to their default layout:

1.	 Open the Project Manager by clicking the Home button.

2.	 Right-click anywhere between the projects in the Project Manager, and choose Reset 
UI Layout.

3.	 Click Close.
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Copying Media Using the Clone Tool

One of the few things you may want to do before you add media to your project is to clone camera 
original media onto a safe set of volumes, with redundancy in case any one volume fails. Whether 
you’re on-set working as a DIT, or doing data ingest at a post facility, the Clone Tool lets you safely 
and accurately copy media from SD Cards, SSDs, or disk drives, to multiple destinations, with a 
checksum report written to the root of each destination volume that verifies the absolute accuracy 
of the duplicate media saved to each destination.

To duplicate media using the Clone Tool:

1.	 Open the Clone tool by clicking the Clone button at the far left of the Media Pool tool bar, 
which reveals the Clone tool palette. 

2.	 Click the plus (+) button at the bottom left to create a new job. A job item appears within the 
Clone Tool Palette, with overlays to guide you through its use.

3.	 Drag a volume or folder from the Library to the “Drop source here” drop zone. Alternately, you 
can right-click any volume or folder in the Library and choose Set As Clone Source.

4.	 Next, drag one or more volumes or folders from the Library to the “Drop destination here” 
drop zone. Alternately, you can right-click any volume or folder in the Library and choose Set 
As Clone Destination. You can have more then one destination. 

5.	 If you want to preserve the name of the top directory in the source volume or folder, click the 
Clone tool panel’s option menu and choose “Preserve Folder Name.” 

6.	 When you’re ready, click the Clone button to initiate the cloning process.

The Clone Tool with a job set up
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Adding and Removing Media

At minimum, you’ll be using the Media page to add clips to a project for further processing. All 
clips you want to work with must first be added to the Media Pool to be available for grading 
and processing in DaVinci Resolve, regardless of whether or not there’s edited project data to go 
along with it.

If you import XML or AAF projects, you can choose to automatically import all accompanying media 
as part of the import process you initiate in the Edit page. However, if you find yourself needing to 
replace updated effects or stock footage in the Timeline, or you’re called upon to add additional 
media such as animated titles or superimposed clips for compositing, then you’ll still need to use 
the Media page to do so. 

Whatever kind of project you’re working on, you can add clips to the Media Pool from as many 
different volumes as you need. All imported clips are linked to the original media on whichever 
disks you found them; files are not moved, copied, or otherwise transcoded when you add them to 
the Media Pool. Consequently, it’s a good idea to make sure that all media you want to import into 
your project has already been copied to a suitably fast volume before importing it.

Important: Before you add media to a new project, if you’re not importing a project via an AAF 
or XML file, you need to make sure that the “Timeline frame rate” setting in the Master Project 
Settings is set to the same frame rate as the incoming media, since you cannot change this after 
media has been added to the Media Pool.

There are several ways of adding clips to the Media Pool by selecting them yourself.

To add individual clips to the Media Pool:

1.	 Use the Library to find a media file to import. 

2.	 Do one of the following:

>> Double-click that file to add it as a clip to the currently selected folder in the Media Pool.

>> Shift-click or Command-click multiple files, then right-click one of the selected files and 
choose “Add into Media Pool.”

3.	 When a dialog appears asking if you want to change your project to match the criteria, click 
“Change” to alter the project’s settings, or click “Don’t Change” to continue importing the 
media while leaving the project at its previous frame rate. Once clips have been imported into 
the Media Pool, the frame rate cannot be changed again, so choose carefully.

To add the contents of a directory of clips to the Media Pool:

1.	 Use the Library to find the directory containing the files you need to import.

2.	 Do one of the following:

>> Right-click the directory and choose Add Folder into Media Pool to add only clips from the 
selected directory. Subdirectories are ignored.
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>> Right-click the directory and choose Add Folder and SubFolders into Media Pool to add 
clips from the selected directory, and all subdirectories within.

>> Drag the folder you want to the browser area of the Media Pool to add its contents to the 
currently selected folder in the Folder View.

To add all clips and folders in a directory organized into matching folders in the Media Pool:

1.	 Use the Library to find the directory containing the files you need to import.

2.	 Do one of the following:

>> Right-click the directory and choose “Add Folder and SubFolders into Media Pool 
(as Folders)”

>> Drag the folder you want to import from the Library to the Folder View of the Media Pool to 
add that folder, and all subfolders within, as a new folder in the Folder View.

A folder appears in the Media Pool with the same name as the folder you dragged in. All 
clips and all subdirectories appear within, nested hierarchically in the Media Pool as they 
were in the file system.

Adding Media Based On EDLs

Another strategy for adding media to the Media Pool is to use an EDL to add only the clips it refers 
to from a directory. This lets you add only the clips that are necessary for conforming a particular 
imported project before conforming an EDL, and eliminates the need to add too much media to 
the Media Pool, which might slow you down in the case of projects referencing terabytes of media. 
Furthermore, you can choose multiple EDLs to base the import on, and many directories to examine.

The EDLs will reference clips via their timecode and sometimes reel name and path. It is these 
settings and the conform frame rate that you made previously in the Configuration screen that are 
now used to place images correctly into the Media Pool.

To add only media used in an EDL to the Media Pool:

1.	 If necessary, open the Master Project Settings panel of the Project Settings, turn on the “Assist 
using reel names from the” checkbox, and choose a method with which to extract reel name 
information from the media files you’re about to import. For more information, see Chapter 9, 
“Preparing and Conforming Projects.”

2.	 Right-click a directory in the Library browser, and choose one of the following commands:

>> Add Folder Based on EDLs into Media Pool

>> Add Folder and SubFolders Based on EDLs into Media Pool

3.	 Using the file dialog that appears, select one or more EDLs to use.

	 Resolve searches the directory hierarchy, either one level or all levels, for every media file 
matching the source timecode and the reel ID of an event in one of the selected EDLs.
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Splitting Clips Based on EDLs

You can also use EDLs to split a media file into multiple clips in the Media Pool, either as an alternate 
means of “preconforming” a flattened master media file, or to import multiple sections of a longer 
media file that happen to be referenced by an EDL.

To split and add clips based on an EDL:

1.	 Right-click a directory in the Library browser, and choose “Split and add into Media Pool.”

2.	 Using the file dialog that appears, select an EDL to use, and click Open.

3.	 Choose a frame rate to use to conform the clips to in the “File Conform Frame Rate” dialog, 
and click OK.

4.	 Choose a handle size, in frames, and whether or not you want to split unreferred clips from the 
“Enter handle size for splitting” dialog, and click Split & Add.

	 Tip: Turning on the Split Unreferred Clips checkbox automatically splits out sections of the 
file that were not referred to by the EDL you selected, and adds them to the Media Pool 
separately, giving you access to every piece of media that’s available.

	 The media file is split into the component clips specified in the EDL, and added to the 
Media Pool.

Adding Media With Offset Timecode

Sometimes source media was created with incorrectly offset timecode, due to mistakes made 
earlier in the postproduction process. If this offset is consistent, you can use the “Add Folder with 
Source Offset” command to add media to the Media Pool as clips with a timecode offset.

To add a folder of clips to the Media Pool with offset timecode:

1.	 Right-click a directory in the Library browser, and choose one of the following commands:

>> Add Folder with Source Offset

>> Add Folder and SubFolders with Source Offset

2.	 Choose a number of frames with which to offset the timecode from the “Change Frame 
Offset” dialog, and click Apply.

	 The media is imported as clips with offset timecode in the Media Pool. However, the original 
source timecode of the clips on disk has not been altered. All media rendered out of the 
Deliver page will reflect the offset timecode.
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Removing Media From the Media Pool

If you’ve added clips to the Media Pool that you need to eliminate, this is easy to do, either singly, 
or in the aggregate.

To remove clips from the Media Pool:

>> Select one or more clips in the Media Pool, right-click one of the selected clips, and then 
choose Remove Selected Clips

>> Right-click anywhere in the Media Pool, and choose Remove All Clips in Bin

Note: If you’ve turned on “Automatically match master timeline with media pool” in the General 
Options panel of the Project Settings, you cannot remove all clips from the Media Pool if there are 
other timelines using that media.

To remove clips from the Master Timeline:

>>Open the Edit page, then select one or more clips in the Media Pool, right-click one of the 
selected clips, and choose “Remove Selected Clips from Master Timeline.”

Adding and Removing External Mattes

If you’ve been provided with matte files to accompany one or more media files used by a program 
you’re grading, you can attach them directly to specific clips in the Media Pool, in order to use them 
as key sources for a Clip Grade in the Node Editor of the Color page. You can even use matte files 
that pack multiple mattes within a single piece of media. This can be done by either writing different 
mattes to each of the red, green, and blue channels of a clip, or by embedding multiple matte 
passes within a single OpenEXR file.

 

Matching RGB and Matte images
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Attached mattes appear listed underneath a clip in the Media Pool.

An attached matte, seen in List view

Alternately, you can add an unattached matte clip to the Media Pool, which isn’t attached to any 
clip, that can be used as a key source in the Color page within any clip’s Clip grade, or within a 
Timeline Grade. Unattached matte clips appear as stand-alone clips in the Media Pool. 

An unattached matte, seen in Thumbnail view

Matte files are useful for two things. Traditionally, mattes are grayscale media files that identify 
regions of varying opacity, with white representing solid areas, and black representing transparency. 
However, mattes can also be used as creative tools to apply grain and texture for effect. What a 
matte does depends on how you connect it in the Node Editor of the Color page.

If you have a clip from a VFX system there is occasionally an associated matte file. By using ‘Add 
as Matte’ you place the file in the Media Pool with the correct identification, shown as a Mask icon 
so that DaVinci Resolve can use the file as a matte. After you have placed the main image clip into 
the Media Pool, highlight the clip. Then find the matte in the Clip Details display, right-click on that 
matte and select ‘Add as Matte.’ In the Media Pool, the main clip will have a cyan box just before the 
clip name and if you double-click the main clip, the associated matte will be shown with the Mask 
icon; it is linked to the main clip.
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To add an assigned matte to a clip in the Media Pool:

1.	 Select a clip in the Media Pool to which you want to attach an external matte.

2.	 Select the matching external matte file in the Library browser, right-click it, and choose Add  
as Matte.

	 The external matte is attached to the clip, and can be seen if you put the Media Pool into List 
view as a nested item underneath that clip. 

Removing external mattes from clips in the Media Pool:

1.	 Put the Media Pool into List view.

2.	 Right-click the external matte file you need to remove, and choose Remove Selected Clips.

	 Removing an external matte clip also removes that matte’s key from any clip grades that use 
it, such that any clips using it as a key input change from a secondary operation to a primary 
operation, where the color adjustment affects the entire image.

To add an unassigned matte to the Media Pool:

1.	 Make sure no clip is selected in the Media Pool.

2.	 Select an external matte file in the Library browser, right-click it, and choose Add as Matte.

	 The external matte appears in the Media Pool, unattached.

For more information on using external matte clips as keys when grading, see the “External Mattes 
to Add Texture” section of Chapter 12, “Advanced Color Features.”

Adding Offline Videos

If a client has output the offline edit of an entire program being graded as a single media file for 
use as an Offline Reference Movie, you can import this file in a special way to use it for dual Viewer 
comparison in the Edit page, or in split-screen comparisons in the Color page.

To add a clip as an offline clip, right-click it in the Library browser, and choose “Add As Offline Clip.” 
That clip appears with a small checkerboard badge in its icon in the Media Pool, or as the icon to 
the left of the Media Pool.
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For more information on using an Offline video to compare with a conformed Timeline in the Edit 
page, see Chapter 6, “Edit.” For more information on split-screen reference of Offline video in the 
Color page, see Chapter 11, “Color Page Basics.”

Checkerboard icon indicating an Offline comparison video
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Whether you’re doing onset work, creating digital dailies, organizing media to edit, or ingesting 
media to conform to an imported project, it’s vitally important to stay organized. The Media Pool 
provides many different tools for doing so.

Organizing Media into Folders

You can easily organize clips into different folders in the Media Pool. For some workflows, this is 
required, while with other workflows it’s purely optional.

Methods of working with folders in the Media Pool:

>> To add a folder to the Media Pool: Click the + button at the bottom left of the Media Pool. 
Or, right-click the background of the Media Pool and choose Add Folder. To add a folder 
inside of another folder, select a folder first, then either click the + button, or right-click and 
choose Add Folder.

>> To rename a folder: Select the folder you want to rename, and then click its name a second 
time to make it editable. With the folder name highlighted, type a new name and press 
Return. Alternately, you can right-click a folder, choose Rename Folder, and then type a 
new name and press Return.

>> To add incoming clips to a specific folder in the Media Pool: Click a folder to select it, then 
use any of the previously described methods to add media from the Library directly to 
that folder.

>> To move media from one folder to another: Drag one or more selected clips from their 
current location in the Media Pool into that folder. Multiple clips in the Media Pool can be 
selected by Shift-clicking or Command-clicking them, or by dragging a bounding box over 
a group of clips. You can also drag one folder into another one.

>> To delete a folder: Select the folder you want to delete, and click the – button at the bottom 
left of the Media Pool. Or, right-click a folder and choose Delete Folder. Deleting a folder 
with nested folders inside of it results in that entire set of folders being deleted.

Using the Media Pool in Icon View

If you work in Icon View using the controls at the top right of the Media Pool, you have the option to 
resize the thumbnails to make them easier to see, and you can move the mouse pointer over each 
clip to hover scrub through its contents. Clicking any clip to select it displays it in the Media page 
Viewer. Whichever clip is currently selected is also output to video for monitoring.

Organizing the Media Pool
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Working With Columns in List View

If you work in List view using the controls at the top right of the Media Pool, you gain additional 
organizational control by exposing columns that show the metadata that each clip contains. You can 
use these columns to help organize your media.

Methods of customizing metadata columns in List View:

>> To show or hide columns: Right-click at the top of any column in the Media Pool and select 
an item in the contextual menu list to check or uncheck a particular column. Unchecked 
columns cannot be seen.

>> To rearrange column order: Drag any column header to the left or right to rearrange the 
column order.

>> To sort by any column: Click the column header you want to sort with. Each additional 
time you click, the same header toggles that column between ascending and descending  
sort order.

While these columns of metadata correspond to those fields shown in the Metadata Editor, the 
available columns in the Media Pool of the Media and Edit pages are a subset of the total amount 
of metadata that’s available, although they represent the most commonly used metadata you’ll find 
yourself referring to when editing and finishing. Available columns in List view include:

>>Name: The file name of that clip.

>> Reel Name: The reel name of that clip. Dynamically generated by the “Assist using reel 
names from the” setting of the Master Project Settings.

>> Start TC: The timecode value of the first frame in the media file.

>> End TC: The timecode value of the last frame in the media file.

>> Duration: The total duration of the clip, in timecode.

>> Start: The first frame number of the media file.

>> End: The last frame number of the media file.

>> Frames: The total duration, in frames.

>> Resolution: The frame size of the media file.

>> FPS: The frame rate of the media file.

>> Audio Ch: The total number of audio tracks in the media file.

>> File Path: The file path where that media file is located on disk.

>> Codec: The codec used by the media file.

>> Flags: Which flags, if any, have been added to a media file.
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>> Usage: After a Timeline has been created by importing an AAF, EDL or XML project, you can 
right-click the Media Pool and choose “Update usage” to refresh the information shown 
in the Usage column to reflect how many times each clip is used in the project. This makes 
it easy to identify clips that aren’t in use, and which can be removed from the Media Pool.

>> IDT: If ACES color science is selected in the Master Project Settings, the IDT used by that 
clip is listed here.

>> Input LUT: Which Input Look-Up-Table has been assigned, if any.

>> PAR: The Pixel Aspect Ratio, if assigned.

>> Data Level: The data level setting for the media file.

>> Date Created: The date the media file was created.

>> Date Modified: The last date the media file was modified.

>> Slate TC: The Slate timecode track used to sync audio with video.

>> Description: A user-editable field for entering information about that clip.

>> Comments: A user-editable field for entering information about that clip.

>> Keyword: A user-editable field for entering searchable keywords pertaining to that clip.

>> Shot: An editable field to contain the shot number of the media, relative to the scene.

>> Scene: An editable field to contain the scene number of the media, relative to the script.

>> Take: An editable field to contain the take number of the media, relative to the shot.

>> Angle: An editable field to contain the angle of the media in a multi-camera shoot.

>> Circled: An editable field to contain the circled state of media, relative to the script 
supervisor’s notes.

>> Roll/Card: An editable field to contain the roll number of media that was scanned from film.

>> HDRX: For R3D media, indicates whether it’s HDRX media.

>> Frame/Field: Whether that media file is progressive or interlaced.

>> H-FLIP: Whether that media file is horizontally flipped in Resolve.

>> V-FLIP: Whether that media file is vertically flipped in Resolve.

>> LUT: The LUT that’s currently applied to that media file in Resolve.

>> Input Sizing Preset: The currently selected Input Format Preset, if there is one.

>> Start KeyKode: The starting KeyKode value of a scanned negative.

>> Duration: The duration of the media file.

>> Bit Depth: The bit depth of the media file.
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>> Sample Rate: The sample rate of the media file’s audio, if there is any.

>> S3D Sync: Shows a frame count when you slip an eye to fix non-synced timecode using the 
“Slip Opposite Eye One Frame Left/Right” commands. This parameter is editable in the 
Media Pool.

>> Audio Offset: Lists the audio offset, in frames, for clips that have been synchronized to 
separately recorded audio. This parameter is editable in the Media Pool.

Finding Media in the Media Pool

The Search Field at the upper right-hand corner of the Media Pool can be used to locate one or more 
clips based on the metadata that’s selected in the Search Options pop-up menu to the left of it.

The Search Options pop-up menu (as seen in the Edit page Media Pool)  

lets you choose what metadata you’re searching

To find a clip in the Media Pool, first choose a criteria from the Search Options pop-up menu at 
the top right of the Media Pool; you can choose All Fields to do a simultaneous search of every 
metadata column in the Media Pool at once, or you can choose a specific criteria to restrict your 
search. Then, type a search term in the Search field. As soon as you start typing, all clips that don’t 
match the search criteria are temporarily hidden. To show all clips in the Media Pool again, click the 
cancel button at the right of the search field.
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Whenever you select a clip in the Media Pool, its editable metadata appears in the appropriately 
named Metadata Editor. You can use this editor to further massage the metadata of the clips in a 
project, adding information on set that will be of help later during editing and finishing. 

By default, clips initially appear with a set of clip metadata called “Clip Details,” that shows 
some of the most fundamental details of the clip such as start and end timecode, duration, bit 
depth, etcetera.

A pop-up menu at the upper left corner of the Metadata Editor lets you choose from multiple sets 
of metadata. Each set has individual fields and checkboxes that you can populate with different 
kinds of information.

A pop-up menu at the upper left corner of the Metadata Editor lets you choose from multiple sets 
of metadata. Each set has individual fields and checkboxes that you can populate with different 
kinds of information. 

Metadata Editor displays selected clip and editable items

Editing Clip Metadata
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If you want to see a list of every piece of metadata in a clip, you can choose All Groups. Otherwise, 
you can choose any set of metadata to narrow your focus to just those items of information.

To edit the metadata of a single clip:

>> Select a clip, choose a metadata set using the pop-up menu, and then type into any field 
or click any button. 

To edit the metadata of multiple clips:

1.	 Choose a metadata set using the pop-up menu in the Metadata Editor.

2.	 Select multiple clips in the Media Pool by Shift-clicking, Command-clicking, or dragging a 
bounding box around them.

3.	 You can click the checkboxes to the left of the labels of any items you want to edit in the 
Metadata Editor, or you can simply start making your edits and the appropriate checkboxes 
will be turned on automatically.

4.	 Click Save, or Revert if you want to back out of your changes.

Metadata categories pop-up menu
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If you’re processing dailies for a shoot that used dual-system recording, where audio is recorded 
to a separate device than video, you can sync the dailies in DaVinci Resolve in one of two ways. 
Synced clips can be output as media files with embedded audio, or output to tape, whatever your 
client requires.

Batch Syncing Dailies Using Timecode

Ideally, if the sound recordist on set was highly organized, and the camera and audio recorder both 
used synchronized timecode, you can use a single command to automatically sync every clip in a 
Timeline to a folder of Broadcast .wav files that have matching timecode.

To batch sync dailies:

1.	 Create a new project, open to the Media page by default, and import the video media you 
need to sync into any folder of the Media Pool.

2.	 Import the matching Broadcast .wav files into the same folder as the accompanying video 
media you imported in Step 1. If you want to stay more organized, you can create another 
folder to contain the audio clips, but it must be inside the folder containing the video files. The 
audio folder can be named anything you like.

3.	 Right-click the folder containing the matching audio and video clips, and choose one of the 
following commands from the contextual menu:

>> Auto-Sync Audio Based On Timecode: Replaces the media file’s previous audio tracks with 
the newly synced .wav files.

>> Auto-Sync Audio Based On Timecode and Append Tracks: Adds new tracks in addition to 
the audio tracks that were previously in the media file.

The Media Pool showing a folder containing both video clips and an Audio folder 

containing the Broadcast WAVE files to be synced

Syncing Audio
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	 Every clip in the selected folder for which there was an accompanying Broadcast .wav file with 
matching timecode is immediately synced with an audio track. All synced clips appear with an 
audio icon at the bottom left in the Media Pool when icon view is selected. Now that the clips 
are synced, you can edit them in the Edit page, or use the Deliver page to export offline dailies 
or online media with embedded synch audio for use in other applications.

Individually Syncing Clips in the Timeline

If you have a collection of WAV or AIFF audio files with video source media that lacks matching timecode, 
you need to manually sync each pair of media files together, one-by-one, using a sync reference such 
as the clap of a clapperboard, or any other sharp sound with a distinct audio/visual correspondence.

To manually sync dailies:

1. 	 Create a new project, and set change the project settings so that the timecode set by the “Timeline 
frame rate:” parameter of the Conform Options matches the timecode of your media. Now’s a 
good time to set the Timeline resolution to match the resolution of your media, as well.

2.	 Import the video media you need to sync into the Media Pool.

3.	 If you want to stay organized, create a second bin in the Media Pool, named Audio Clips, and 
import the matching Broadcast .wav files into it. The name of the bin is not important, and 
having all the audio in one bin is simply a matter of convenience.

4.	 Set the Audio Panel mode pop-up menu in the Media page to Dailies, which lets you view and 
scrub along the waveform of audio clips you select in the Media Pool.

5. 	 Select a video clip to sync, and move the Viewer playhead to line up with the first visual sync point 
in the first clip. This could be the clap of a clapper board, the red flash of a tablet computer’s 
slate app, a hand clap, or any clear visual cue to which there is a corresponding audible sound.

6.	 Now, select whichever audio clip matches the current video clip in the Viewer, to open its 
waveform into the audio panel.

7.	 Use the Audio panel transport controls and scrubber bar in the Source Viewer to move the 
playhead to the audio sync point that corresponds to that video sync point. This may be a 
clap, a beep, or some other staccato sound that’s easy to sync to. As you play through the 
clip, the bottom half of the Viewer shows a zoomed out waveform for the entire clip, while the 
top half of the Viewer shows a zoomed in section of the waveform that immediately surrounds 
the playhead. Hopefully, the sync point you’re looking for is a distinct, loud spike somewhere 
towards the beginning or the end (in the case of a tail slate) of the audio clip.
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8. 	 When you’ve found the audio sync point that matches the video sync point, click the Link/
Unlink Audio button to embed the now synched audio into the video clip.

Clicking the sync link button to lock sync

The audio and video items are linked. At this point, you can use the newly synced clips in the Edit 
page, and use the Deliver page to export offline or online media with embedded audio for editing.

Offsetting the Sync of Previously Synched Clips

If you need to offset the audio sync later on, you need only select the synced clip you want to resync 
in the Media Pool, then set the Audio Panel to Dailies mode, turn off the linked clip button, change 
either the audio or video sync points, and turn the linked clip button back on again. 

You can also use two sets of commands for slipping the sync of any clip:

>> Edit > Slip Audio/Eye > Slip Audio One Frame Forward/Reverse: (Option-period and 
Option-comma) Slips the audio/video sync of any clip in whole frame increments.

>> Edit > Slip Audio/Eye > Slip AudioOne Subframe Forward/Reverse: (Option-right arrow 
and Option-left arrow) Slips the audio/video sync of any clip in 1/10th frame increments.

Aligning video and audio sync points with the Audio Panel Set to Dailies mode
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Using the Clip Attributes window, you can alter additional attributes for multiple clips all at once. 
This window has some overlap with other clip attributes that are editable directly from submenus 
within the Media Pool clip contextual menu.

To edit the attributes of one or more clips:

1.	 Select one or more clips in the Media Pool by Shift-clicking, Command-clicking, or dragging a 
bounding box around them.

2.	 Right-click one of the selected clips, and choose Clip Attributes.

3.	 Click one of the categories in the sidebar at the left to reveal a page of the attributes you want 
to edit. If you’ve selected multiple clips, then click the checkboxes to the left of the ones you 
need to edit, and make your alterations.

4.	 When you’re finished, click OK to accept the changes.

The Clip Attributes window has five sets of attributes that you can edit.

Clip attributes window

Changing Clip Attributes
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Video Attributes

These affect individual clip frame rate, geometry, and data levels.

>> Video Frame Rate: In cases where a clip’s frame rate was specified incorrectly in another 
application, or if there is no frame rate metadata available at all, you can change the frame 
rate here.

>> Levels: In certain circumstances, you may find that you need to manually choose appropriate 
data levels for clips that are not being interpreted correctly, choosing between “Video 
Level” and “Data Level.” For more information on this setting, and how it affects the image 
data in your project, see Chapter 9, “Preparing and Conforming Projects.”

>> Pixel Aspect Ratio: In projects using a mix of media with different frame sizes, you can 
assign specific pixel aspect ratios using this pop-up menu.

>> Horizontal and Vertical Image Flip: Modifies the horizontal and vertical image flip camera 
metadata for r3d clips, which is useful for stereoscopic 3D projects shot with a mirrored 
camera rig that reverses the media from one eye, or in cases where steadicam rigs result in 
upside-down clips. These settings are different from the Flip Image controls in the Sizing 
palette of the Color page.

>> Input Format Preset: You can use this panel to assign a Sizing palette preset to select 
clips. For example, if you have a special Input Format Preset for standard definition PAL 
widescreen clips that you’ve edited into a high definition project, you can do a sort in the 
Media Pool to isolate them, and then select them all and apply this preset.

>> Select Alpha Mode: The options presented here depend on the format of the clip you’ve 
selected, since only certain formats (such as ProRes 444, OpenEXR, TIFF sequences, 
etcetera) are capable of containing alpha channels. If you’ve imported clips with embedded 
alpha channels, this panel lets you enable or disable their use in Resolve, choose the type 
of alpha channel (Premultiplied or Straight), or invert the alpha channel.

Timecode Attributes

If you find yourself dealing with clips that have incorrect timecode, or timecode with an incorrect 
relationship to the EDL, XML, or AAF project you’ve been given, you can use these attributes to 
modify the timecode and reel name of clips in the Media Pool. None of these tools alter the source 
media on disk. They simply change the timecode metadata in your Resolve project, which by 
extension affects the timecode of any media you render.

>> Start Timecode: Lets you assign a new time for the timecode at the currently viewed frame 
of the clip.

>> Slate Timecode: In situations where source media comes from a shoot where a timecode 
slate was used during the shoot, then you can assign the slate timecode as a second 
timecode track that can be used for various operations, without changing the primary 
timecode of the clip, which may already be in use for program sync. 



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

149

MEDIA4

To set appropriate Slate timecode, select a clip in the Media Pool with a visible timecode 
slate, and move the playhead to a frame where the timecode in the slate is clearly readable. 
Then, open the Timecode panel of the Clip Attributes window, and type the timecode 
value you see in the image into the Slate Timecode field.

>>Offset Source Timecode: If an entire set of clips has timecode that’s merely offset, you can 
correct the timecode offset for as many selected clips as you like.

Reel Name Attributes

The Master Project Settings window has a Master Project Settings panel with Conform Options 
parameters that provide options to extract reel names for clips in a variety of ways. These options 
are dynamic, and whenever you change them they affect every clip in your project.

You must first choose a Reel Assist setting in the Master Project Settings window for the Clip 
Attributes window to be editable,.

>> Source clip file pathname and Pattern: Functions identically to the Pattern setting discussed 
in Chapter 3, “Project Settings, Caching, and Preferences.”

>>Media Pool folder name: Lets you use the name of the folder that currently encloses that 
clip in the Media Pool as the reel name.

>> Embedding in source clip file: Lets you forcibly extract the reel name metadata from the 
header of the clip’s corresponding media file on disk.

>> Source clip filename: If there is no defined reel number often it’s easy to just use the source 
clip filename.

>> User defined: Use this option to enter whatever string you want.

Audio Attributes

The Audio panel lets you alter the channel format and channel assignments for one or more clips. 
These settings affect what appears in the audio tracks of the Timeline when you edit a clip. When 
you first import clips into the Media Pool, you can use the Audio Attributes panel to define which 
embedded audio tracks can be used for editing, and how they will appear in the Timeline.

>> Number of Audio Tracks: Shows how many channels (or tracks) of embedded audio 
a clip has.
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>> Channel Format: A pop-up that lets you choose what format a clip’s audio uses. The setting 
you choose here affects how many channels appear in the Channel Assignments list below, 
as well as how audio clips appear in the Timeline, and what kind of Timeline audio track 
will be required to contain them. The available options are Mono (appropriate for single-
channel clips), Stereo (appropriate for clips with two-channel left/right audio), and 5.1 
(automatically used for any clips with more then two channels, appropriate for 5.1 surround 
mixes). If you choose a Channel Format with fewer channels than are embedded in a clip, 
all extraneous channels will be disabled.

>> Channel Assignments list: his list shows you a line for each channel made available by 
the selected Channel Format. A pop-up menu lets you change which embedded clip 
audio channel is mapped to each available track as determined by the Channel Format. 
Alternately, you can disable channels you don’t want to use by choosing Mute.
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Managing media directly from within DaVinci Resolve lets you quickly take care of issues that can 
arise with the media in a project.

Relinking Media Using Change Source Folder

When you’ve used your file system to move media that’s used as a source clip in a Resolve project, 
you can use the ‘Change Source Folder’ command to relink one or more selected clips in the Media 
Pool to the new file path of the media.

To relink your Media Pool clips to a new location:

1.	 Select one or more clips in the Media Pool, right-click one of the selected clips, and choose 
‘Change Source Folder.’ 

	 The Relink Media window appears displaying the original path for the material, with controls 
for choosing a new directory.

2.	 Click the “…” button to the right of the “Change To” field, and then use the file navigation 
dialog to find the new location of the media file, select it, and click Open.

3.	 If you succeeded in finding the appropriate media file, click Change. Otherwise, click Cancel.

Locating Media Files in the Media Library and in the Finder

If you find yourself needing to determine the location of a clip’s source media file on disk, you can 
right-click an item in the Media Pool and choose Reveal in Media Library. The Library automatically 
opens to the folder containing the media file you’ve selected, with that media file selected in the 
Library browser to the right.

Another feature that’s only available for OS X systems is the ability to right-click an item in the Media 
Pool and choose Reveal In Finder. A file system window opens up, revealing the media file that clip 
is linked to.

Copying Clips Between Volumes

You can copy media from one disk location to another right from within the Media Pool, without 
needing to exit DaVinci Resolve to go back to the file system. 

1.	 Right-click a clip or folder in either the Media Pool or Library, and choose Copy.

2.	 Locate a destination directory in the Library, then right-click it and choose Paste.  

	 The Clip Task Manager window opens, with controls that let you either start or prioritize the 
Copy operation. 

Media Management
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3.	 Choose one of the following operations by clicking the corresponding button:

>>Move Up and Move Down: Two buttons let you move selected Copy operations up or 
down in the queue to prioritize when they’ll get done.

>> Start Processing: Initiates the process of copying the specified media.

>> Remove Finished: Removes finished Copy operations from the queue.

>> Remove Selected: Removes any Copy operations you’ve selected from the queue.

>> Reset Selected: Resets finished Copy operations you’ve selected from the queue in order 
to initiate them again.

>> Cancel Selected: Cancels the selected Copy operations so you can finish them at a 
later time.

>> Select All: Selects all Copy operations in the Clip Task Manager queue.

	 Note: If copy operations change the directory structure, or files and folders have been added 
to a volume, you may need to right-click the Media Storage display and choose “Refresh.”

Updating Timecode for Audio - LTC

Some cameras do not offer the ability to sync to an external timecode source. Their recorded 
timecode may be time of day or free run timecode, but it would not be frame accurately synced to 
other cameras, the dual system audio recorder or the digital slate. This makes multi-cam or dual 
sound system syncing a time consuming manual operation.

DaVinci Resolve offers a solution to this problem if, by connecting an externally generated timecode 
to the camera audio input, the video that’s recorded by the camera has a timecode reference 
recorded on the audio track during the shoot. 

Select this clip, or clips, in the media pool, then right-click on one of the highlighted clips and 
select “Update timecode from audio - LTC.” Resolve automatically and instantly updates the clip 
timecode using the LTC it finds on the audio tracks. You can now use the clips as though they were 
synced on set.

Creating Subclips

Subclips give you another way of organizing media in the Media Pool, letting you break excessively 
long clips into shorter ones. For example, if the director of a project is fond of “rolling takes” where 
multiple takes are all recorded within a single clip, you can break these takes up by making them 
into subclips.
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To create a subclip:

1.	 Select any clip in the Media Pool to open it into the Viewer.

2.	 Set In and Out points to define the section you want to turn into a subclip.

3.	 Right-click the jog bar and choose Make Subclip. 

	 A new subclip appears in the Media Pool, automatically selected so that you can immediately 
edit its metadata in the Metadata Editor.

Once created, subclips appear and work like any other clip in Resolve.
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Proxies are lower-resolution versions of the media files in your project that can be used in cases 
when your workstation lacks the horsepower to do the work you need to accomplish in real time. If 
you find yourself in a situation where real time performance is unable to keep up with the number 
of operations you’re trying to use in a grade, you can activate proxy mode.

To activate proxy mode, do one of the following:

>> Choose View > Proxy On The Fly (Command-P).

>>Click the Settings button, click Image Scaling, and turn on the “Use real time proxies” checkbox. 

>> Press the PROXY ON/OFF button on the DaVinci Resolve T-bar panel

When you activate proxy mode, DaVinci Resolve will do one of two things, depending on whether 
or not you’ve created proxy media in advance. Ordinarily, DaVinci Resolve will generate on-the-fly 
proxies at the resolution specified in the Image Scaling panel of the Settings window. 

However, if you first create pre-generated proxies, DaVinci Resolve will use them instead. Proxies 
may be generated at any time from DPX source media. 

Tip: When generating proxies, half or quarter of the resolution is recommended to obtain 
maximum speed. 

To add clips to the Proxy Manager, do one of the following:

>> Select one or more clips in the Media Pool, then right-click one of the selected clips, and 
choose Add Into Proxy Manager. 

>> To add an entire directory to the Proxy Manager, right-click a folder in the Library and 
choose Add Folder Into Proxy Manager.

Once you’ve added clips to the Proxy Manager, the Proxy Manager window opens, providing a 
variety of controls for managing the proxy generation process.

At the top, a Proxy Status area displays the name of selected clips and the resolution with which 
proxies will be generated (user customizable).

The Task Manager is a list that contains all the clips that have been added for generation and 
management. Eight columns display information about the items in the list, and let you sort in either 
ascending or descending order by clicking on that column. The available columns include:

>> Start Frame: Lists the first frame of the clip, by timecode

>> End Frame: Lists the last frame of the clip, by timecode

Creating and Using Proxy Media
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>> Time Elapsed: How long since proxy generation was initiated.

>> Time Left: How much longer it will take for proxy generation to finish.

>> Percentage: How many proxies in the current batch have been generated.

>> Status: The state of proxy generation.

At the bottom of the Task Monitor are five buttons for managing the generation of proxies. These 
buttons change depending on whether or not you’ve selected anything in the list.

>> Check Proxies verifies whether or not proxies already exist.

>> Check Selected Proxies checks the existence of only the selected files. 

>>Generate All Proxies initiates the process of proxy generation for all clips appearing in the list. 

>>Generate Proxies initiates the process of proxy generation for clips you’ve manually selected 
in the list. 

>> Cancel Tasks cancels all proxy generation in progress.

>> Cancel Selected Tasks cancels only the generation of proxies that you’ve selected. 

>> Remove Tasks clears the Task Manager list.

The Proxy Image Scaling options in the Project Settings
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When working with stereo media in DaVinci Resolve, one of the first tasks you must perform is that 
of syncing each stereo pair of clips to act as a single clip. This is easily accomplished so long as 
you’re careful about how you organize your media in the Media Pool.

Each set of right- and left-eye media should always be organized into separate left-eye folders and 
right-eye folders, to facilitate later syncing of these clips using the Stereo 3D Sync command in the 
Media Pool contextual menu. For more information about setting up media for stereo workflows, 
see the “Stereoscopic Workflows” section of Chapter 9, “Preparing and Conforming Projects.”

Organizing Stereo Media
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Camera raw media formats are so named because they capture raw color space data directly from 
the sensor of whatever digital cinema camera did the recording. Raw image data is not human 
readable, and must be debayered or demosaicked to convert the original raw data into image data 
that can be handed off to DaVinci Resolve’s image processing pipeline.

There are three ways you can control how camera raw media is debayered into a useful, “normalized” 
image for adjustment or output:

>> The Camera Raw panel of the Project Settings contain groups of parameters that 
correspond to every camera raw media format that’s supported by DaVinci Resolve. Using 
these parameters in the Camera Raw panel, you can override the original camera metadata 
that was written at the time of recording, and make simultaneous adjustments to all camera 
raw media throughout your project.

>>When you right-click one or more selected camera raw clips in the Media Pool, there are a 
series of “Edit Codec Settings” menu options corresponding to each supported camera 
format in the contextual menu that appears. Choosing one of these commands opens a 
Camera Raw window that exposes controls mirroring those found in the Camera Raw panel 
of the Project Settings.

>> The Camera Raw palette in the Color page lets you individually adjust Camera Raw 
parameters for individual clips in the Timeline.

For more information about each of the Camera Raw formats that can be adjusted in DaVinci 
Resolve, see chapter 5, “Camera Raw Settings.”

Camera Raw Decoding
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If you have a program that someone has delivered as a single media file, with no accompanying EDL 
with which to split it up, you can use DaVinci Resolve’s Scene Detect window to automatically find 
the cut points and split it into individual clips, ready for grading.

To open a clip into the Scene Detect window:

1.	 Open the Media page, and use the Library browser to find and select the clip you need to 
split apart.

2.	 Do one of the following:

>> Click the Scene button at the bottom left of the Media page.

>> Right-click the file and choose Scene Cut Detection.

>> Using the DaVinci control surface, press SHIFT DOWN and DECK/REVIVAL/SCENE on the 
T-bar panel.

The Scene Detect window opens up, containing the clip you selected.

The Scene Detect Window Interface

The Scene Detect Window is divided into three main areas, the Viewers, the Graph, and the Cut 
List. Together, these controls let you analyze the movie, examine the automatically found cuts, and 
manage the Cut List in preparation for sending back to your project.

Using Scene Detection

Scene Detector window
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The Scene Detect Viewers

A set of three viewers appear at the top of the Scene Detect window. These three viewers are 
designed to make it easy to test whether the playhead in the Scene Detect Graph is on a cut 
point or not. The leftmost viewer is the last outgoing frame of a detected cut point. The center 
viewer shows the first incoming frame of that cut point, and the rightmost viewer shows the second 
incoming frame of that cut point. 

If the playhead in the Scene Detect Graph is directly on top of an edit point, the leftmost viewer 
should show a completely different frame than the center and rightmost viewers, which should be 
very similar to one another. This can be seen in the following example. 

If all three viewers appear to display a continuous series of frames, then you’re not looking at  
a cut point.

Underneath the viewers are a series of nine controls.

>> Start: This initiates the scene cut detection process.

>> Transport Controls: A set of seven transport controls include: first frame, step back, play 
reverse, stop, play forward, step forward, last frame.

>> In: Lets you set a red In point, with which to define a range of the Scene Detection 
Graph to prune.

>>Out: Lets you set a cyan Out point, with which to define a range of the Scene Detection 
Graph to prune.

The left image shows the previous clip, center and right the next

No scene cut here as all images are almost the same
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>> Prune: If you’ve identified a number of false positive scene cuts, use the In and Out buttons 
to select a range of scene cuts in the Scene Detect Graph, and then choose Prune Scene 
Cuts to eliminate all scene cuts between these points that are within one frame of another 
scene cut. Within the group of identified cuts, the highest probability cut will remain while 
the other cuts are deleted.

>> Show Cut List: Shows and hides the Cut List, which shows the currently detected scene cuts.

The Scene Detect Graph

The majority of the bottom half of the Scene Detect window, to the left, consists of the Scene 
Detect Graph, which shows the scene detect analysis results after you’ve clicked the Start button.

Detection graph displays potential scene cuts

Frames that Resolve thinks are cut points appear as green vertical “scene cuts” of various heights. 
The height of each scene cut corresponds to the likelihood that frame is really an edit point, and 
not a swish pan, sudden jump in the motion of the frame, or abrupt change in color or lighting, all 
of which can fool the scene detection algorithm.

A horizontal magenta confidence bar lets you choose the threshold of confidence required for 
scene cuts to be added to the Cut List. If you drag this bar up above any shorter scene cuts of low 
confidence, those lines turn gray, and are omitted from the Cut List. 

Note: Dissolves and other transitions are not automatically detected, although dissolves most often 
appear as a triangular cluster of lines peaking in the middle.

Three controls appear underneath the graph.

>> Add: Lets you manually add a scene cut at the current position of the playhead. Sometimes 
two adjacent clips with similar color and lighting will appear to be a single clip to the scene 
detection algorithm. This lets you add scene cuts at frames where they weren’t initially found.

>> Delete: Lets you manually delete a scene cut located at the position of the current frame 
indicator within the graph.
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>> Zoom Slider: Lets you zoom into and out of the Scene Detect Graph to see more or less 
detail as you examine the results. 

Cut List

At the lower right of the Scene Detect window, the Cut List displays one entry for each of the scene 
cuts that intersect the confidence bar.

The cut list shows all currently detected cuts
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Three columns show each cut’s order number, frame number, and timecode value. You can select 
items in the Cut List to evaluate each cut using the three viewers above. Whenever you select a new 
item in the Cut List, the playhead jumps to that frame in the Scene Detect Graph. 

To select items in the Cut List:

>> Click any item in the Cut List.

>> Press N or the Down Arrow to select the next item down.

>> Press P or the Up Arrow to select the next item previous.

As you move up and down the list, you can delete items that you can confirm aren’t real cuts using 
the viewers above. If it’s a long list and you don’t have time to check it all at once, it can be saved for 
later recall using commands found in the Scene Detect Options pop-up menu.

Once you’re finished checking the list and are satisfied that each cut is accurate, you can use it to 
split the media file into individual clips in the Media Pool by clicking “Add Cuts to Media Pool,” 
located immediately below.

The Scene Detect Options Pop-Up Menu

The Options pop-up menu, located at the upper right-hand corner of the Scene Detect window, 
contains a variety of commands.

>> Reset Zoom: Sets the zoom level of the Scene Cut Graph such that the entire clip fits within 
the current width.

>> Reset Marks: Clears the current In and Out points you’ve set.

>> Save SceneCut: Saves the current scene cut detection information, including the probability 
metadata, to disk. SceneCut files use the file extension .sc and can be reimported later to 
continue working on a lengthy scene detection task.

>> Load SceneCut: Imports an existing .sc file into the Scene Detect window. You must first 
open the media file you’re working on into the Scene Detect window before you can load 
a SceneCut file.

>> Save EDL: Exports the Cut List as a CMX-style EDL.

>> Load EDL: Loads a CMX-style EDL into the Cut List, letting you use the cut information from 
the EDL during the Scene Cut Detection process.

>> Auto Cue: When enabled, the playhead jumps to each new scene cut as it’s detected when 
you initiate scene detection. This lets you evaluate each scene cut as it’s found using the 
three viewers above.
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An Example Scene Detect Workflow

This section describes an ideal workflow for using scene detection without an EDL.

To scene detect a media file:

1.	 Locate a media file to scene detect using the Library of the Media page. 

2.	 Verify its frame rate and if it uses drop-frame timecode, and make sure that the “Timeline 
frame rate” and “Use drop frame timecode” parameters in the Master Project Settings match. 
These parameters are not automatically set if the project already has media in the Media Pool, 
and you may have problems if they don’t match your media.

3.	 Right-click the media file, and choose Scene Cut Detection.

4.	 When the Scene Detect window appears, click the Options pop-up menu and choose Auto 
Cue (it should be on by default, but it’s always good to check), then click Start.

	 Scene detection initiates, and you can evaluate each scene cut as it’s found. If any scene cut 
looks wrong (three sequential frames in a row), note its place in the list for future evaluation.

5.	 When Resolve has finished scene detection, move the playhead to some of the shorter scene 
cuts, and verify if they’re actual cuts by checking the three viewers above. If the frames being 
displayed are “different-same-same,” then it’s a genuine cut. 

	 If the frames being displayed are “same-same-same” (actually three sequential frames), then 
these aren’t cuts.

	 Tip: Fast camera motion such as whip pans, sudden changes in lightness such as camera 
flashes, or even film coming up to speed causing the shutter to “flash” can confuse the analysis, 
which looks for large changes in the image.

6.	 If there are numerous low-confidence scene cuts that you’ve verified aren’t cuts, drag the 
magenta confidence bar so that the low-confidence scene cuts fall below it to automatically 
remove them all from the list.

7.	 Next, you may want to move down the Cut List, evaluating each scene cut to verify that it’s 
correct. Click the first scene cut in the list, check it, then press the keyboard down arrow to 
select the next list item down, check it, and repeat until you’ve checked every item in the list. If 
you need to move back up the list, you can press the up arrow to select the previous list item. 
If any item is not a cut point, click the “Minus” button at the bottom left corner of the Scene 
Detect window to eliminate that scene cut.

8.	 If there are sections in the Scene Detect Graph with dense groups of spikes, these are probably 
frames with types of motion that confused the Scene Cut Detector. To delete this unwanted 
“noise” in the data, use the In and Out buttons to isolate the data, and then click “Prune” to 
delete these unwanted scene cuts.
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9.	 If there’s a gap between any two scene cuts that you’re positive should have another scene cut, 
then scrub the playhead or use the transport controls to find the missing cut, and click the “Plus” 
button at the bottom left corner of the Scene Detect window to add another scene cut.

	 Tip: Adjacent shots with very similar ranges of color and contrast may sometimes go undetected 
by the scene detection algorithm. If you know of scenes in the media you’re analyzing that are 
like this, you may want to scrub through them a bit more carefully to make sure you’re not 
missing anything. However, if you find you’ve missed a cut later, you can always use the Split 
Clip control in the Edit page timeline to add a new edit point.

10.	 When you’re confident that the Cut List is accurate, split the media file into individual clips in 
the Media Pool by clicking “Add Cuts to Media Pool.”

11.	 When the Conform Settings dialog appears, click OK if you checked your settings in step 2.

12.	 Close the Scene Detect window.

	 The individually cut up clips of the media file you analyzed now appear in the Media Pool, and 
you can edit the entire sequence of clips into a new Timeline in order, ready for grading. 
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This chapter covers how to capture media from tape directly into the Media Pool in DaVinci Resolve. 
Whether you need to capture a handful of clips to incorporate into an existing project, or you need 
to recapture every clip corresponding to the events of an EDL, you can use the Media page in 
Capture mode to capture from any device-controllable deck via a compatible video interface.

To switch to tape capture in the Media page:

>> Click the Capture button, located to the left of the transport controls underneath the Media 
page Viewer.

The Capture page updates to reflect the relevant controls for editing to tape, and the 
Metadata Editor switches to a dedicated set of capture metadata to help you track the 
resulting clips.

The Tape Capture Interface

While in Capture mode, the Media page is used to control the VTR, in order to establish In and Out 
points for logging or capturing a selected range of the tape.  

>> Transport Controls: The transport controls, while similar in appearance to those used while 
in Playback mode, now work to control the VTR.

Tape Ingest

Tape Capture viewer in the Media page
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>> Shuttle Control: A Shuttle Control appears in what was formerly the Scrubber Bar, which 
lets you shuttle through the range of reverse and forward speeds compatible with the 
connected deck.

>> In and Out Controls: In Capture mode, the In and Out buttons to the right of the transport 
controls define a range of the tape from which to capture.

>>Metadata Editor: In Capture mode, the Metadata Editor automatically switches to the 
Capture set of metadata fields. Populating File Name Prefix updates the file name preview 
that’s shown above in the Header, that also shows the Capture directory, Resolution, and 
Frame Rate specified in the Deck Capture and Playback panel of the Project Settings.

Setting Up to Capture From Tape

Before you begin capturing from tape, you need to adjust a variety of settings in the Deck Capture 
and Playback panel of the Project Settings. Two groups of settings, in particular, need to be defined.

Editable capture metadata 



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

167

MEDIA4

Capture and Playback Project Settings

These settings affect both capture and playback when using the Tape Ingest options of the Media 
page, or the Tape Output options of the Deliver page.

>> Video capture and playback: You can choose the video format (frame size and frame rate) 
with which to output to tape from this pop-up menu. HD timelines can be downconverted 
to SD, and SD timelines can be upconverted to HD using the format conversion of your 
DeckLink card.

>> Enable stereo video: A checkbox that enables the Blackmagic Design DeckLink HD Extreme 
3D+ to ingest and output muxed stereoscopic video when used with supported VTRs, such 
as HDCAM SR decks with 4:2:2 x 2 mode. (When muxed stereoscopic signals are ingested, 
each eye is separated into individual left-eye and right-eye image files.)

>> Video connection operates as: Selects between the available signal options: YUV 422 
SDI, RGB 444 Dual Link and 444 single link using 3 or 6 Gb/s. Which options are available 
depend on which video capture card you are using. All three are available when using the 
Blackmagic Design DeckLink HD Extreme 3+ card.

>> Video/Data Level: Lets you specify the data range (normally scaled or full range) that’s used 
when ingesting from or outputting to tape. This option switches the data range of the signal 
output by your video capture card, but only during capture from tape in the Media page, 
or output to tape in the Deliver page. When capture or output is not currently occurring, 
your video capture card goes back to using the identically named data range setting in the 
Master Project Settings pane, which governs how you monitor the signal being output on 
an external broadcast display or projector.

>> Video bit depth: 10-bit is the only available option.

>> Use deck autoedit: If supported by your video deck, this is the best method to record video 
to the deck, as it enables the deck to roll the edit using the specified preroll, and control 
the edits via serial device control. If this checkbox is turned off, a basic edit On/Off mode 
is used by the deck, with the potential for frame inaccuracies if the “Non auto edit timing” 
setting is not properly adjusted.

>>Non auto edit timing: Adjusts the edit synchronization of the connected deck when auto 
edit is turned off.

>> Deck preroll: Sets the number of seconds for preroll. How much is appropriate depends on 
the performance of your deck.

>> Video output sync source: When using a DeckLink card this is set to Auto. Other capture 
cards may require you to set the sync source to “Reference” for playout and “Input” for 
ingest. This setting is only available if you have the DVS card installed on your system.

>> Add 3:2 pulldown: Inserts or removes the 3:2 pulldown required to record or play 23.98 fps 
media to or from a 29.97 tape format.
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Capture

These settings are used when you use the Capture mode in the Media page to capture clips from 
tape into the Media Pool.

>> Video Format: The format captured media will be saved to. The available options are DPX 
and QuickTime.

>> Codec: The codec used to write captured media. Options include the various type of Apple 
ProRes, 8 and 10-bit YUV 422, 10-bit RGB, and the various types of DNxHD.

>> Save clips to: A field that displays the directory path to which media files captured from 
tape are written. You want to choose a volume that’s fast enough to accommodate the data 
rate of the media format you’re capturing.

>> Browse: Click this button to choose a directory to write captured media to. The 
directory you choose appears in the field above.

>> Save in this folder path: A series of checkboxes lets you specify what other information to 
use to define the directory hierarchy that will hold the captured media. Every checkbox you 
turn on adds an additional directory with a name defined by that checkbox’s metadata. You 
can choose any or all of the following: Program name, Clip number, Reel number, Roll/Card.

>> Apply reel name to: Lets you choose how to write the reel name. Two checkboxes let you 
write the reel name to the file’s name, and/or to the Header data.

>> Use prefix: A field lets you type in a prefix to be used in the media file’s name. This lets you 
add text identification that will make the media more easily identifiable and searchable.

>> Apply prefix to: Two checkboxes let you choose to use the prefix you typed in the file name, 
and/or in the folder name.

>> Use frame number with: When capturing to image sequences, you can choose how many 
digits to use when writing the frame number into the name of each frame file.

>> Enable audio input: Turn this checkbox on to capture audio along with the video. If 
you’re capturing QuickTime or MXF files, the audio will be written as additional tracks 
inside each file. If you’re capturing to a DPX image sequence, then a Broadcast .wav file 
is recorded separately.

>> Input: Lets you choose how many tracks of audio to capture.

The Three Methods of Capture

Once you’ve set up all relevant settings in the Project Settings window, including at minimum 
“Video Capture and Playback,” “Capture Clips Saved to,” and Apply Reel Name to” settings, then 
you’re ready to start capturing. Depending on your workflow, there are three methods of capturing 
from tape that you can use.

For all capture methods, media can only be ingested as DPX image sequences.
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Using Capture Now

If you simply need to capture a section of tape quickly, you can use the Capture Now command.

To Capture Now:

1.	 Use the transport controls and the In button to identify what you want to capture.

2.	 Enter all relevant information into the various fields of the Metadata Editor. The Header 
updates to show a preview of the file name that will be saved.

3.	 Use the transport controls to start playback, and then click the Capture Now button at the 
bottom of the Metadata Editor.

4.	 When the section of tape you wanted to record has finished, click Capture Now again to 
stop capture.

	 A new clip appears in the Media Pool, automatically placed in a new folder in the Media Pool with 
a name defined by the timecode value converted into a frame count, based on the ingest frame 
rate. For example, 00086400.dpx is the file name of a clip captured at timecode 01:00:00:00.

Logging and Capturing Individual Clips

If you’re capturing an exact range of tape, or multiple sections at once, you can also work by logging 
each section of tape you want to capture in advance, before using the Capture Clip or Batch Clips 
commands in a second step.

To capture a single clip using device control:

1.	 Use the transport controls to find the beginning of the section of tape you want to record, and 
click the In button. Then, find the end of the section of tape you want to record, and press the 
Out button.

2.	 Enter all relevant information into the various fields of the Metadata Editor. The Header 
updates to show a preview of the file name that will be saved.

3.	 When you’re finished, click Capture Clip.

	 Deck control is automatically used to play through the specified range of tape and capture 
that clip. When capture is complete, the new clip appears in the Media Pool.
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Logging and Capturing Multiple Clips

For efficiency’s sake, you can also log multiple clips at once, from multiple tapes if necessary, and 
then batch capture them all at once.

To log one or more clips:

1.	 Use the transport controls to find the beginning of the section of tape you want to record, and 
click the In button. Then, find the end of the section of tape you want to record, and press the 
Out button.

2.	 Enter all relevant information into the various fields of the Metadata Editor. The Header 
updates to show a preview of the file name that will be saved.

3.	 When you’re finished, click Log Clip.

	 That clip is added to the Media Pool as an offline tape clip, indicated by a black icon with a 
tape badge.

To batch capture one or more logged clips:

1.	 (Optional) Put the Media Pool into List view, and click the Reel No column header to sort the 
Media Pool clips by reel number. This makes it easier to select a range of clips to capture from 
a particular reel. 

2.	 Select one or more offline tape clips in the Media Pool that come from a particular reel.

3.	 Click Batch Clips, at the bottom of the Metadata Editor. To interrupt capture at any time, click 
Batch Clips again.

Logged clip in the Media Pool prior to capture
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	 Deck control is automatically used to play through the current tape in the VTR and capture 
every logged clip you’ve selected that can be found on that tape, starting with the clip with the 
lowest timecode value and ending with the clip having the highest timecode value. A progress 
bar with accompanying text shows how much longer to go until capture is complete. As each 
clip is captured, its corresponding logged clip in the Media Pool updates with a thumbnail 
reflecting the captured media. 

	 When Resolve finishes capturing all clips from a particular reel, Batch Capture stops. 

Batch Capture Via EDL

You can also use an EDL to create offline tape clips, one for each event in the EDL, with which to 
batch capture all the media necessary to conform a project from tape.

To import an EDL as a batch capture list:

1.	 Open the Project Settings, click Master Project Settings, and make sure of the following:

>> Set “Timeline frame rate” to the frame rate of your EDL.

>> Turn on “Use drop frame timecode” if your EDL requires it.

>>Make sure “Use Timecode” is set to “Embedded in the source clip”

>> Turn on “Assist using reel numbers from the”

2.	 Choose File > Import Batch List From EDL.

3.	 When a Conform Settings dialog appears asking you to confirm the current Project Settings, 
click OK if the settings are good.

4.	 Use the controls of the Select EDL files dialog to select one or more EDLs, then click Open.  
If you select multiple EDLs, then every event in each EDL is imported at once.

5.	 In the dialog that appears next, choose a frame rate to conform the EDL at, and click OK.

	 Each event in the EDL now appears as offline tape clips in the Media Pool, ready for capturing. If 
you load an EDL and there are already clips in the Media Pool that have the same reel name and 
start timecode as events in the EDL, Resolve will not create new offline tape clips for those.
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6.	 (Optional) Put the Media Pool into List view, and click the Reel No column header to sort the 
Media Pool clips by reel number. This makes it easier to select a range of clips to capture from 
a particular reel.

7.	 (Optional) If there are any offline clips that you don’t need to capture, you can remove them 
from the Media Pool by right-clicking them and choosing Remove Selected Clips.

8.	 Select which of the offline tape clips you want to capture. It’s best to select ranges of clips that 
come from the same reel.

9.	 Click the Capture mode button to the left of the transport controls, and then click Batch Clips 
to begin capture. To interrupt capture at any time, click Batch Clips again. Deck control is 
automatically used to play through the current tape in the VTR and capture every logged 
clip you’ve selected that can be found on that tape, starting with the clip with the lowest 
timecode value and ending with the clip having the highest timecode value. A progress bar 
with accompanying text shows how much longer to go until capture is complete. As each 
clip is captured, its corresponding logged clip in the Media Pool updates with a thumbnail 
reflecting the captured media. 

	 When Resolve finishes capturing all clips from a particular reel, Batch Capture stops.

A set of logged clips imported from an EDL



5
Camera Raw
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The Media page is the primary interface for media management and clip organization in DaVinci 
Resolve. It’s central to the way DaVinci Resolve works that the source media used by a project 
is organized separately from the project data that you import and manage in the Edit page. In 
this way, you can manage and update the clips used by timelines in the current project with ease, 
switching between offline and online media, reorganizing clips, and troubleshooting any problems 
that occur. 

The Media page also contains much of the core functionality that will be used for on-set workflows, 
and in the ingest, organizational, and sound-synching steps of digital dailies workflows. This chapter 
covers most of the functionality found in the Media page, including functions in detail that are 
referenced throughout this manual.

This chapter covers the following topics:

Camera Raw

Camera Raw Decoding� 172

Using ARRI ALEXA files� 174

Using RED files� 177

RED Image Decoder� 180

Project & RED Default Image Decoder� 181

Using Sony Raw Files� 183

Master Settings� 183

Clip Decoder Settings� 184

Using CinemaDNG Files� 186

Master Settings� 186

Clip Decoder Settings� 188

Using Phantom Cine Files� 190

Master Settings� 190

Clip Decoder Settings� 190
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Camera raw media formats are so named because they capture raw color space data directly from 
the sensor of whatever digital cinema camera did the recording. Raw image data is not human 
readable, and must be debayered or demosaiced to convert the original raw data into image data 
that can be handed off to DaVinci Resolve’s image processing pipeline.

Raw decoding is the very first image processing operation that takes place, and it takes place before 
all other operations in the Color page, before even the Source bar in the Node Editor. For this reason, 
it’s important to understand that the ideal transformation of raw image data to Resolve-friendly 
image data is one that preserves the maximum amount of image data for continued processing. 
Since the 32-bit floating point accuracy of Resolve’s image processing pipeline preserves all 
transformed raw data with exceptional fidelity, the Camera Raw parameters are primarily useful for 
making whatever initial adjustments will produce the most optimum starting point for grading.

The Camera Raw panel of the Project Settings contain groups of parameters that correspond to 
every camera raw media format that’s supported by DaVinci Resolve. Using these parameters in the 
Camera Raw panel, you can override the original camera metadata that was written at the time of 
recording, and make simultaneous adjustments to all camera raw media throughout your project.

Camera Raw Decoding

Color Page 
Image Processing

Camera Raw 
Decoding

Deliver  
Page Output

Raw  
Image  
Data

Camera Raw project settings
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You will find Camera Raw controls for each supported camera in the Media Pool right-click contextual 
menu. These parameters are also mirrored in the Camera Raw palette in the Color page, which lets 
you individually adjust the Camera Raw parameters for individual clips in a Timeline.

Tip: DaVinci Resolve version 9 and later differs from earlier versions of DaVinci Resolve in that when 
you create new versions of grades with individual clip-based Camera Raw settings, you now have 
the option to save individual Camera Raw settings for each version, as long as the Save with Version 
checkbox is turned on in the Camera Raw palette.

Each group of Camera Raw settings is available from a pop-up menu. This description covers the 
settings that are available for each of the camera raw media formats supported by DaVinci Resolve.

The ARRI ALEXA can record ProRes, DNxHD, or raw image data. When shooting raw, image data is 
recorded straight from the Bayer sensor, and must be debayered by DaVinci Resolve.

Camera Raw clip settings in the Color page
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Using ARRI ALEXA files

The ARRI ALEXA can record ProRes, DNxHD, or raw image data. When shooting raw, image data is 
recorded straight from the Bayer sensor, and must be debayered by DaVinci Resolve.

Master Settings

ARRI ALEXA media is extremely simple to debayer. There is only one Master setting, for determining 
whether or not to alter the clip decoder settings.

>> Decode Quality: Lets you debayer ARRI ALEXA raw files at Full, Half, or Quarter resolution 
to improve performance on slower systems. Lower resolution media is lower quality, but 
faster to work with and process. If necessary, you can choose a lower resolution setting that 
provides better real time playback on systems with limited performance while you work, 
and then switch to a higher quality when rendering the final output. A “Force debayer res 
to highest quality” checkbox in the Render Settings list of the Deliver page makes it easy 
to follow this workflow.

>> Play Quality: This option provides the additional ability to set a lower resolution for 
debayering during playback than for when the playhead is stopped. By default playback 
uses the same setting as the Decode Quality pop-up menu.

>> Decode Using: The option you select determines whether all ARRI ALEXA media throughout 
the project is decoded using the original Camera Metadata settings (the default selection), 
using Project settings in which you choose custom settings to be applied to all clips, or 
using the ARRI default settings.

>> Lift: Adjusts the black point of the media, raising it or lowering it while scaling all midtone 
values between it and the white point. Regardless of how you adjust this control, all 
image data is preserved and can be retrieved in subsequent adjustments. The range is 
–100 to +100. 

>>Gain: Adjusts the white point of the media, raising or lowing it while scaling all midtone 
values between it and the black point. Regardless of how you adjust this control, all image 
data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is 
–100 to +100.

>> Contrast: Raising contrast reduces shadows and raises highlights, while leaving midtones at 
50 percent unaffected. Regardless of how you adjust this control, all image data is preserved 
and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.
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Clip Decoder Settings

Two decoder settings let you adjust the color temperature and exposure of ALEXA clips.

>> Color Temp: Adjusts color balance to alter the “warmth” of the image. Adjustable in Kelvin. 
Lower values correct for “warmer” lighting, while higher values correct for “cool” lighting. 
+2000 is unity. The range is +2000 to +11,000.

>> Tint: Adjusts color balance to push the image between magenta and green; useful for 
balancing images with a green or magenta color cast, such as fluorescent or sodium vapor 
bulbs. 0 is unity. The range is –150 to +150.

>> Exposure: Increases or lowers image lightness in units relative to ASA values. If your 
intended exposure adjustment lifts image data above the maximum white level, don’t 
worry; all image data is preserved and can be retrieved in subsequent adjustments. 160 is 
unity. The range is +160 to +3200.

>> Sharpness: A debayer-specific sharpness filter applied to provide the appearance of 
enhanced image detail. 20 is unity. The range is 0 to 100.

>> Highlights: Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-
range media by lowering this parameter, and achieves a smooth blend between the 
retrieved highlights and the unadjusted mid tones for a naturalistic result. 0 is unity. The 
range is –100 (minimum) through +100 (maximum).

>> Shadows: Lets you selectively lighten or darken shadow detail. Raising this value retrieves 
shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The 
range is –100 (minimum) through +100 (very high).

>> Shadows: Lets you selectively lighten or darken shadow detail. Raising this value retrieves 
shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The 
range is –100 (minimum) through +100 (very high).

>> Color Boost: Lets you naturalistically raise the saturation of regions of low saturation, 
sometimes referred to as a vibrance operation. Can be used also to lower the saturation of 
regions of low saturation. 0 is unity. The range is –100 (minimum) through +100 (very high).

>> Saturation: Adjusts the color intensity of the image. 0 is unity. The range is –100 (minimum) 
through +100 (very high).

>>Midtone Detail: When this parameter is raised, the contrast of regions of the image with 
high edge detail is raised to increase the perception of image sharpness, sometimes 
referred to as definition. When this parameter is lowered to a negative value, regions of the 
image with low amounts of detail are softened while areas of high detail are left alone. 0 is 
unity. The range is –100 (minimum) through +100 (very high).
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ARRI Media and Log-C

ALEXA media is usually recorded using Log-C gamma and color processing, which is very similar 
to the Cineon Log gamma curve, developed by Kodak to produce flat-contrast, wide-gamut 
image data that preserves image detail with a wide latitude for adjustment. There is no ALEXA 
raw parameter to adjust this, so for Rec. 709 monitoring and deliverables you need to “normalize” 
Log-C clips in one of two ways. 

You can create your own adjustment to normalize Log-C clips as part of the grading process, using 
the parameters of the Color page. This approach gives you the most flexibility, as you’ll be making 
custom settings that maximize the image data that’s available in every scene.

Alternately, you can use a LUT to normalize Log-C clips to obtain a fast starting point for additional 
grading. Used in this way, LUTs can be applied either as an output LUT, if the entire Timeline is 
nothing but ALEXA raw media, or as a LUT that’s applied to an individual node of a grade, if you’re 
mixing ALEXA raw media with other formats. This provides a fast and easy solution to linearizing 
ALEXA media that can be useful for creating dailies for offline editing. However, one LUT may not 
be suitable for all clips. If you’re applying individual LUTs to each clip, you can create multiple LUTs, 
each with differing contrast settings, in order to gain the speed benefits of using LUTs, while taking 
into account the individual differences among clips.

ARRI has a LUT generator available online that you can use to create custom LUTs for use with a variety 
of color correction applications at: www.arri.com/camera/digital_cameras/tools/lut_generator.html
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R3D source media, recorded by the various models of RED DIGITAL CINEMA cameras, contains 
one of the most elaborate sets of raw parameters of any of the camera formats. These settings are 
divided into four different groups.

Master RED Settings

The Master RED settings are the most important, handling decode quality and the control governing 
whether the original camera metadata is used, or if you’re overriding the camera metadata project-
wide with custom settings.

These settings also contain the pop-up menus that let you choose the color space and gamma curve 
used to transform the raw image data into image data for processing in Resolve when debayering 
R3D clips. Which Color Space and Gamma Curve settings you use are solely a matter of preference; 
there is no absolute requirement to use one or the other for any given type of workflow. You’re 
simply looking for settings that provide the best starting point for the media you have, given the 
type of grading you’re looking to do. 

For example, in many cases combining the REDcolor3 Color Space setting and REDlog Film 
gamma curve will offer a starting point that retains the most image detail with the greatest latitude 
for adjustment. On the other hand, if you’re working in a hurry, for example to generate dailies 
for offline editing, using one of the REDcolor Color Space settings with one of the REDgamma 
settings can offer an image that’s more immediately pleasing and that requires fewer adjustments 
to achieve an acceptable result. These are not recommendations, they’re only examples. As always, 
the ideal settings for your project depend heavily on the quality of the source media, so you should 
experiment with media from your own projects to find the most suitable results to your eye.

>> Decode Quality: Determines the image quality of the decoded R3D data that’s handed 
off to the Resolve image processing pipeline. The Decode Quality you select has a direct 
impact on real time performance. Decoding performance depends entirely on the hardware 
capabilities of your system. DaVinci Resolve decodes R3D files using multi-core CPU 
processing, but can also decode 4K at Premium quality if you’ve installed a RED ROCKET 
card. 5K R3D media requires two RED ROCKET cards or, subject to release, a single RED 
ROCKET-X for the same performance. 6K R3D media requires a RED ROCKET-X card.

If necessary, you can choose a lower quality setting that provides better real time playback 
on systems with limited performance while you work, and then switch to a higher quality 
when rendering the final output. A “Force debayer res to highest quality” checkbox in the 
Render Settings list of the Deliver page makes it easy to follow this workflow.

>> Play Quality: This option provides the additional ability to set a lower resolution for 
debayering during playback than for when the playhead is stopped. By default playback 
uses the same setting as the Decode Quality pop-up menu.

Using RED files
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>> Bit Depth: Resolve can decode R3D files with 8-, 10-, or 16-bit image data for processing. 
Choosing 16-bit for maximum quality may impact playback performance on some hardware.

>> Timecode: The timecode recorded for R3D media depends on the camera setting in use 
when it was shot. There are three choices:

>> Camera: This setting automatically selects between Absolute and Edge depending 
on what was chosen as the default timecode mode on the camera. This setting needs 
to be selected before you add R3D media to the Media Pool. If you’re browsing R3D 
media when you change this setting, you should refresh the folder in the Library of the 
Media Pool before adding media to the Media Pool.

>> Absolute: The default. Records “time of day” timecode. If an external timecode source 
was connected and the camera was put into Jam Sync mode, the external timecode 
would have been recorded instead.

>> Edge: The first recorded clip for each magazine starts at 01:00:00:00, and the timecode 
of each subsequent clip is recorded sequentially and continuously.

>> Decode Using: The option you select determines whether all R3D media throughout the 
project is decoded using the original Camera Metadata settings (the default selection), 
using Project settings in which you choose custom settings to be applied to all clips, or 
using the RED default settings.

>> Color Science: The two options are Original, which was the color science used by early 
builds of the REDone camera, and Version 2, which is the current version of color science 
used by the entire RED camera line. Unless you need to match the look of older projects 
using the older color science, the newest color science is generally preferable.

>> Color Space: Because RED cameras record R3D data which uses a raw color space, 
debayering the native R3D data requires choosing a color space to convert the raw signal 
into. Bear in mind that the color space you choose is merely a starting point for further 
correction. There is no requirement that you choose one or the other color space for any 
given workflow. You should choose the color space that provides the most pleasing starting 
point for your particular project.

>>CameraRGB: Outputs the original, unmodified sensor data. Not a recommended setting.

>> Rec. 709: Decodes into the standard color space specified by the Rec. 709 standard 
for high definition video. While you may find this option useful, it is not required for 
programs being output to video.

>> REDspace: Fits the raw R3D image data into a color space that’s larger than that of 
Rec. 709. Appropriate for digital cinema mastering and film output. REDspace was the 
predecessor to the REDcolor setting.
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>> REDcolor: A color space that’s similar to the Rec. 709 option, but modified to balance 
accuracy with pleasing color rendition, emphasizing accurate skin tones.

>> sRGB: Decodes into the standard color space defined by the sRGB standard, typically 
used for computer display.

>> Adobe1998: Decodes into Adobe’s unique version of the sRGB standard.

>> REDcolor2: Similar, but less saturated than, REDcolor.

>> REDcolor3: Similar saturation to REDcolor, but with additional modifications to 
improve the color rendition of skin tone. Introduced as the optimum color space for 
Epic cameras, but also appropriate for previous generations of RED cameras.

>> DragonColor: A color space optimized for cameras with the RED Dragon sensor, 
although this color space can be used for previous generations of RED cameras as well.

>>Gamma Curve: There are several options available for choosing a gamma profile to be used 
when debayering the raw R3D data:

>> Linear: No gamma adjustment is made, this is a linear-to-light representation of data 
from the RED camera’s sensor. 

>> Rec. 709: A gamma curve typical for Rec. 709 display. Does not provide an abundance 
of latitude for grading.

>> REDspace: Similar to Rec. 709, but slightly altered to be more appealing, primarily through 
higher contrast and lighter midtones. The predecessor to the REDgamma curve. 

>> REDlog: A logarithmic gamma setting that maps the original 12-bit R3D image data to 
a 10-bit curve. The blacks and midtones occupying the lowest 8 bits of the video signal 
maintain the same precision as in the original 12-bit data, while the highlights that 
occupy the highest 4 bits are compressed. While reducing the precision of highlight 
detail, the tradeoff is that there’s an abundance of precision throughout the rest of the 
signal. This is a good setting for maintaining maximum latitude.

>> PDlog 685: A logarithmic gamma setting that maps the native 12-bit RED image data 
into the linear portion of a Cineon or film transfer curve. 

>> PDlog 985: A logarithmic gamma setting with different mappings.

>> Custom PDlog: A logarithmic gamma setting that exposes user adjustable Black 
Point, White Point, and Gamma PDlog parameters so you can customize your own 
log gamma curve.

>> REDgamma: An improved gamma curve designed to be perceptually appealing on 
displays calibrated for Rec. 709, with an improved soft roll-off in the highlights to 
maintain highlight detail while grading. 

>> sRGB: Similar gamma setting to that employed by Rec. 709.
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>> REDlog Film: An improved logarithmic gamma setting that’s designed to remap the 
original 12-bit R3D data to the standard Cineon gamma curve. This setting produces 
flat-contrast image data that preserves image detail with a wide latitude for adjustment, 
and is compatible with log workflows, including those intended for film output.

>> REDgamma2: Similar to REDgamma, with higher contrast.

>> REDgamma3: The most recent iteration of the REDgamma curve. Based on a log 
starting point, but with a pleasing “ready to view” contrast curve applied, designed 
to be a visually pleasing starting point that maintains excellent dynamic range. 
REDgamma3 is also designed to work with REDcolor3.

>> REDgamma4: The latest iteration of the REDgamma curve, designed to give a good 
in-camera look without the need for grading, while retaining great dynamic range and 
highlight handling. REDgamma4 is suitable for all RED cameras.

>> Blend Type: Works to control how RED HDR media is used. When using either Simple or 
Magic Motion to blend HDR exposures, there’s no need to use the second output in the 
Node Editor. You can choose from three options:

>>None: Only the regular exposure is used.

>> Simple: Blends the two HDR exposures to achieve a pleasing middle ground.

>>Magic Motion: Uses a proprietary algorithm to combine the dual exposures to 
combine overexposed and well-exposed regions of the picture in a more targeted 
fashion, while blending the sharpness of the regularly exposed source with the motion 
blur of the underexposed source.

>> Blend Bias: Lets you adjust how much of the regular exposure and how much of the 
underexposure are combined.

>> Apply Metadata Curves: If the R3D media files were preprocessed in REDCINE X Pro, 
and saved with color curve metadata, you can use this setting to either use or discard 
that metadata.

>> Embedded Audio: Enables embedded audio in R3D media.

RED Image Decoder

This second group of settings contains additional controls for finessing the debayering of RED raw 
image data.

>> De-noise: Applies image-wide noise reduction. There are seven settings available, from 
mild to maximum, that you can use to balance noise reduction against any possible 
image degradation.

>>OLPF Compensation: OLPF compensation applies a low pass filter to reduce color moiré. 
There are four options: Off (the default), Low, Medium, and High.
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>> Image Detail: Controls the demosaicking algorithm that’s used for the software decoding 
of R3D media. You can choose a level of sensor detail extraction: Low, Medium, and High 
(recommended). If you’re using a RED ROCKET card, this setting is ignored as there is a 
fixed algorithm that’s used.

Project & RED Default Image Decoder

Many of the settings in this group are color correction adjustments, some of which resemble 
analogous controls in the Color page. However, the ISO, FLUT, and DRX controls manage the 
exposure of the debayered media being fed to the Resolve image processing pipeline, and so 
can be used to retrieve image detail from R3D source media in cases where the default settings 
are clipping or crushing detail in the highlights or shadows that would be unavailable to DaVinci 
Resolve as a result.

>> ISO: A gain operation that keeps the black point at 0 while raising or lowering the white 
point of the image, linearly scaling everything in between. Raising the ISO results only in 
boosted highlights being more compressed, no clipping will occur. 320 is unity. The range 
is 50–6400.

>> FLUT: A gain operation that lets you boost or attenuate the ISO in smaller increments. 0 is 
unity. The range is -8 to +8.

>> Contrast: Raising contrast reduces shadows and raises highlights, while leaving midtones 
at 50 percent unaffected. The image is compressed rather then clipped at the limits of 100 
and 0 percent. 0 is unity. The range is –1 to +1.

>> Saturation: Adjusts the color intensity of the image. 1 is unity. The range is 0 (minimum) 
through 5.0 (very high).

>> Color Temp: Designed to alter the “warmth” of the image while keeping white elements of 
the scene looking neutral. Adjustable in degrees Kelvin. Lower values correct for “warmer” 
lighting, while higher values correct for “cool” lighting. This parameter is designed 
specifically to adjust RED linear light image data to make the most photometrically accurate 
correction. 5600 is unity. The range is 1700 to 10,000.

>> Tint: Color balance correction for images with a green or magenta color cast, such as 
fluorescent or sodium vapor bulbs. This parameter is designed specifically to adjust RED 
linear light image data to make the most photometrically accurate correction. 0 is unity. The 
range is -100 to +100.

>> DRX: A Dynamic Range control (X) that lets you recover highlights while taking into account 
Color Temperature (degrees Kelvin) and Tint. 0 is unity, and 1.0 is the maximum value.

>> Shadow: Provides control over the toe (low range) of the FLUT adjustment. 0 is unity. The 
range is -2 to +2.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

185

CAMERA RAW5

>> Exposure: Increases or lowers image lightness in units relative to ƒ-stops. Using exposure to 
boost the image beyond 100 or to lower it below 0 will clip, not compress, the image data 
that’s passed along to the Resolve image processing pipeline. 0 is unity. The range is –7 to +7. 

>> Brightness: Adjusts image lightness. Image data is compressed rather then clipped at 100 
and 0 percent. 0 is unity. The range is –10 to +10. 



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

186

CAMERA RAW5

Using Sony Raw Files

Sony makes several digital cinema cameras, such as the F65 and F55, that record wide latitude, high-
gamut media either using Sony’s 12-bit SR codec, or as 16-bit raw media files. Since Sony’s cameras 
do not use a traditional Bayer pattern, special debayering is necessary when working with F65 raw 
media, and the image data is demosaiced using the following raw controls and parameters.

Master Settings

These parameters let you choose the decode quality, white balance, color space, and gamma that 
Sony raw clips will be transformed to use when debayered.

>> Decode Quality: Determines the image quality of the decoded Sony raw data that’s handed 
off to the Resolve image processing pipeline regardless of the Play Quality setting. The 
Decode Resolution you select has a direct impact on real time performance, and decoding 
performance depends entirely on the hardware capabilities of your system. 

If necessary, you can choose a lower resolution setting that provides better real time 
playback on systems with limited performance while you work, and then switch to a higher 
quality when rendering the final output. A “Force debayer res to highest quality” checkbox 
in the Render Settings list of the Deliver page makes it easy to follow this workflow.

>> Play Quality: This option provides the additional ability to set a lower resolution for 
debayering during playback than for when the playhead is stopped. By default playback 
uses the same setting as the Decode Quality pop-up menu.

>> Decode Using: The option you select determines whether all F65 media throughout the 
project is decoded using the original Camera Metadata settings (the default selection), 
using Project settings in which you choose custom settings to be applied to all clips, or 
using the Sony default settings.

>> Color Space: Two color spaces are adjustable, depending on your intended workflow:

>> Rec. 709: Decodes into the standard color space specified by the Rec. 709 standard for 
high definition video.

>>  P3 D60: Decodes RGB-encoded image data with a D60 white point, intended for 
monitoring with a P3-compatible display.

>> SGamut: Decodes into Sony’s wider S-gamut color space, designed to provide the 
widest range of image data for adjustment.

>> P3: Decodes to a RGB-encoded image data with a D61 white point, intended for use 
when outputting media for DCI mastering.

>>Gamma: Five gamma settings are available, depending on what starting point you want to 
use for further grading.

>>Gamma 2.4: A simple power-function gamma setting commonly used for broadcast.

>>Gamma 2.6: A simple power-function gamma setting commonly used for digital 
cinema projection.
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>> Rec. 709: A gamma curve typical for Rec. 709 display.

>> SLog: Designed to provide a wide latitude for grading.

>> SLog2: This version has a half stop offset to allow for a higher dynamic range.

>> Linear: A simple linear gamma setting.

>> Lift: Adjusts the black point of the media, raising it or lowering it while scaling all midtone 
values between it and the white point. Regardless of how you adjust this control, all 
image data is preserved and can be retrieved in subsequent adjustments. The range is 
–100 to +100. 

>>Gain: Adjusts the white point of the media, raising or lowing it while scaling all midtone 
values between it and the black point. Regardless of how you adjust this control, all image 
data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is 
–100 to +100.

>> Contrast: Raising contrast reduces shadows and raises highlights, while leaving midtones at 
50 percent unaffected. Regardless of how you adjust this control, all image data is preserved 
and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

Clip Decoder Settings

Three decoder settings let you adjust the color temperature, exposure, and sharpness of Sony  
Raw clips.

>>White Balance: Designed to very subtly alter the “warmth” of the image. Adjustable in 
degrees Kelvin. Lower values correct for “warmer” lighting, while higher values correct for 
“cool” lighting. +5500 is unity. The range is +3200 to +5500.

>> Exposure: Increases or lowers image lightness in units relative to ASA values. If your 
intended exposure adjustment lifts image data above the maximum white level, don’t 
worry; all image data is preserved and can be retrieved in subsequent adjustments. +800 
is unity. The range is +1 to +65,535.

>> Sharpness: A debayer-specific sharpness filter applied to provide the appearance of 
enhanced image detail. 20 is unity. The range is 0 to 100. 

>> Highlights: Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-
range media by lowering this parameter, and achieves a smooth blend between the 
retrieved highlights and the unadjusted mid tones for a naturalistic result. 0 is unity. The 
range is –100 (minimum) through +100 (maximum).

>> Shadows: Lets you selectively lighten or darken shadow detail. Raising this value retrieves 
shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The 
range is –100 (minimum) through +100 (very high).
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>> Color Boost: Lets you naturalistically raise the saturation of regions of low saturation, 
sometimes referred to as a vibrance operation. Can be used also to lower the saturation of 
regions of low saturation. 0 is unity. The range is –100 (minimum) through +100 (very high).

>> Saturation: Adjusts the color intensity of the image. 0 is unity. The range is –100 (minimum) 
through +100 (very high).

>>Midtone Detail: When this parameter is raised, the contrast of regions of the image with 
high edge detail is raised to increase the perception of image sharpness, sometimes 
referred to as definition. When this parameter is lowered to a negative value, regions of the 
image with low amounts of detail are softened while areas of high-detail are left alone. 0 is 
unity. The range is –100 (minimum) through +100 (very high).

Sony Media and S-Log

Sony’s proprietary S-Log gamma setting, which produces flat-contrast, wide-gamut image data 
that preserves image detail with a wide latitude for adjustment, is also available on some other 
Sony cameras. Similarly to working with clips using the ARRI ALEXA’s Log-C gamma, you need to 
normalize S-Log clips by either making a manual adjustment to color and contrast, or by applying 
a LUT, using the same techniques discussed previously.

When applying a LUT, there are two methods that Sony recommends. A 1D LUT can be used to 
transform S-Log clips into the standard Cineon (or Log-C) curve if your ultimate goal is to output 
Log media for film printing. If you’re planning to output to a normalized format, you can use a 
dedicated LUT to make this transformation.

For more information, search the web for Sony’s document “S-Log: A new LUT for digital production 
mastering and interchange applications.”
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CinemaDNG is an open format capable of high-resolution raw image data with a wide dynamic 
range, and is one of the formats recorded by the Blackmagic Cinema Camera when you shoot in 
raw mode. CinemaDNG images are decoded with full dynamic range when the Highlight Recovery 
checkbox is selected.

DaVinci Resolve version 11.2.1 introduced improved debayering for raw CinemaDNG media 
acquired using any of the Blackmagic Design cameras. The “Apply Pre Tone Curve” setting controls 
whether you’re using the older debayering method (when turned on), or the newer, visually improved 
debayering method (when turned off).

Master Settings

These parameters let you choose the decode quality, white balance, color space, and gamma that 
raw CinemaDNG clips will be transformed to use when debayered.

>> Decode Quality: Lets you debayer CinemaDNG raw files at Full, Half, or Quarter resolution 
to improve performance on slower systems. Lower resolution media is lower quality, but 
faster to work with and process. If necessary, you can choose a lower resolution setting that 
provides better real time playback on systems with limited performance while you work, 
and then switch to a higher quality when rendering the final output. A “Force debayer res 
to highest quality” checkbox in the Render Settings list of the Deliver page makes it easy 
to follow this workflow.

>> Play Quality: This option provides the additional ability to set a lower resolution for 
debayering during playback than for when the playhead is stopped. By default playback 
uses the same setting as the Decode Quality pop-up menu.

>> Decode Using: The option you select determines whether all CinemaDNG media throughout 
the project is decoded using the original Camera Metadata settings (the default selection), 
using Project settings in which you choose custom settings to be applied to all clips, or 
using the CinemaDNG default settings.

>>White Balance: The first seven options offer White Balance presets, which automatically 
adjust the Color Temp and Tint parameters. These options include Daylight, Cloudy, Shade, 
Tungsten, Fluorescent, and Flash. An eighth option, Custom, makes the Color Temp and 
Tint parameters user-adjustable.

>> Color Space: Two color spaces are adjustable, depending on your intended workflow:

>> Rec. 709: Decodes into the standard color space specified by the Rec. 709 standard for 
high definition video.

>> P3 D60: Decodes into the standard P3 color space specified by the DCI standard for 
digital cinema projection. 

>> BMD Film: Decodes into a log-encoded color space that remaps the raw data into an 

Using CinemaDNG Files
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approximation of the Log-C standard. Choosing BMD Film also forces the Gamma 
setting to BMD Film. This setting produces flat-contrast image data that preserves 
image detail with a wide latitude for adjustment, which is suitable as a starting point 
for linear output, and is also compatible with log workflows intended for film output.

>>Gamma: Five gamma settings are available, depending on what starting point you want to 
use for further grading.

>> 2.4: A simple power-function gamma setting commonly used for broadcast.

>> 2.6: A simple power-function gamma setting commonly used for digital cinema projection.

>> Rec. 709: A gamma of 2.35, with a linear segment near black, approximating the EBU 
recommended gamma for broadcast.

>> sRGB: A gamma of 2.2, with a linear segment near black, intended for reproduction on 
computer displays alongside the sRGB color space.

>> Linear: A simple linear gamma setting.

>> BMD Film: A log-encoded gamma setting that approximates Log-C encoding, the main 
difference being that more data is encoded in the darkest portion of the BMD Film signal.

>> BMD Film 4K: A log-encoded gamma setting that approximates Log-C encoding, but 
that’s optimized for the BMD 4K and URSA cameras.

>> Lift: Adjusts the black point of the media, raising it or lowering it while scaling all midtone 
values between it and the white point. Regardless of how you adjust this control, all 
image data is preserved and can be retrieved in subsequent adjustments. The range is 
–100 to +100. 

>>Gain: Adjusts the white point of the media, raising or lowing it while scaling all midtone 
values between it and the black point. Regardless of how you adjust this control, all image 
data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is 
–100 to +100.

>> Contrast: Raising contrast reduces shadows and raises highlights, while leaving midtones at 
50 percent unaffected. Regardless of how you adjust this control, all image data is preserved 
and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

>> Highlight Recovery: A checkbox that lets you include additional highlight sensor data that’s 
usually clipped by the standard decoding matrix. In cases where you have extremely clipped 
highlights, you may obtain additional image detail this way, although it may have unusual 
color artifacts. This checkbox is only available when Apply Pre Tone Curve is turned on.

>> Apply Pre Tone Curve: When this checkbox is turned off (the default for new projects created 
in Resolve 11.2.1 or later), DaVinci Resolve debayers CinemaDNG raw media using an 
improved method that delivers better-looking results, specifically for media acquired using 
any of the Blackmagic Design cameras. When this checkbox is turned on (the default for 
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projects created in earlier versions of Resolve), the older debayering method is reenabled 
for backwards compatibility. However, turning Pre Tone Curve on may also provide better 
results for CinemaDNG raw files coming from other sources. If you’re importing .dng media 
from cameras other than those from Blackmagic Design, you should try both settings to 
see which type of debayering you prefer.

>> Apply Soft Clip: This checkbox is only available when Apply Pre Tone Curve is turned 
off. When turned on, high dynamic range parts of the signal (super-white highlights) are 
brought back into the picture as visible image detail you can adjust, similar to using the 
Highlights control to retrieve these otherwise clipped parts of the signal. 

Clip Decoder Settings

CinemaDNG has four settings that can be adjusted to alter the image quality of the debayered 
result. The Color Temp and Tint parameters are only available if the White Balance pop-up menu 
is set to Custom.

>> Color Temp: Designed to alter the “warmth” of the image. Adjustable in degrees Kelvin. 
Lower values correct for “warmer” lighting, while higher values correct for “cool” lighting. 
+6500 is unity. The range is +2000 to +50,000.

>> Tint: Color balance correction for images with a green or magenta color cast, such as 
fluorescent or sodium vapor bulbs. 0 is unity. The range is –150 to +150.

>> Exposure: Increases or lowers image lightness in units relative to ƒ-stops. If your intended 
exposure adjustment lifts image data above the maximum white level, don’t worry; all 
image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The 
range is –4 to +4.

>> Sharpness: A debayer-specific sharpness filter applied to provide the appearance of 
enhanced image detail. 20 is unity. The range is 0 to 100.

>> Highlights: Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-
range media by lowering this parameter, and achieves a smooth blend between the 
retrieved highlights and the unadjusted midtones for a naturalistic result. 0 is unity. The 
range is –100 (minimum) through +100 (maximum).

>> Shadows: Lets you selectively lighten or darken shadow detail. Raising this value retrieves 
shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The 
range is –100 (minimum) through +100 (very high).

>> Color Boost: Lets you naturalistically raise the saturation of regions of low saturation, 
sometimes referred to as a vibrance operation. Can be used also to lower the saturation of 
regions of low saturation. 0 is unity. The range is –100 (minimum) through +100 (very high).

>> Saturation: Adjusts the color intensity of the image. 0 is unity. The range is –100 (minimum) 
through +100 (very high).
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>>Midtone Detail: When this parameter is raised, the contrast of regions of the image with 
high edge detail is raised to increase the perception of image sharpness, sometimes 
referred to as definition. When this parameter is lowered to a negative value, regions of the 
image with low amounts of detail are softened while areas of high-detail are left alone. 0 is 
unity. The range is –100 (minimum) through +100 (very high).

CinemaDNG Files and BMD Film

Blackmagic Design’s logarithmically-encoded BMD Film gamma setting, which produces flat-
contrast, wide-gamut image data that preserves image detail with a wide latitude for adjustment, 
is a modified version of the standard Log-C curve. However, the modifications are designed to 
emphasize the strengths of the sensors used by the Blackmagic Design cameras. Similarly to 
working with clips using the ARRI ALEXA’s Log-C gamma or Sony’s proprietary S-Log or S-Log2 
formats, you need to normalize clips using BMD Film by either making a manual adjustment to 
color and contrast, or by applying a LUT, using the same techniques discussed previously.
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The Phantom line of high-speed digital cinema cameras record wide latitude, high-gamut media 
using the Cine Raw format.

Master Settings

These parameters let you choose the decode quality, white balance, color space, and gamma that 
raw Phantom Cine clips will be transformed to use when debayered.

>> Decode Using: The option you select determines whether all Phantom Cine media 
throughout the project is decoded using the original Camera Metadata settings (the 
default selection), using Project settings in which you choose custom settings to be applied 
to all clips, or using the Cine default settings.

>> Timecode Type: There are four types of timecode that Phantom Cine files can be set to use:

>> Set to zero: Camera timecode is ignored, instead using a simple frame count with the 
first frame considered 0.

>> Time of day (Local): Time of day timecode recording.

>> Time of day (GMT): Time of day timecode recording based on Greenwich Mean Time.

>> SMPTE: Standard SMPTE timecode.

>> Lift: Adjusts the black point of the media, raising it or lowering it while scaling all midtone 
values between it and the white point. Regardless of how you adjust this control, all 
image data is preserved and can be retrieved in subsequent adjustments. The range is 
–100 to +100. 

>>Gain: Adjusts the white point of the media, raising or lowing it while scaling all midtone 
values between it and the black point. Regardless of how you adjust this control, all image 
data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The range is 
–100 to +100.

>> Contrast: Raising contrast reduces shadows and raises highlights, while leaving midtones at 
50 percent unaffected. Regardless of how you adjust this control, all image data is preserved 
and can be retrieved in subsequent adjustments. 0 is unity. The range is –100 to +100.

Clip Decoder Settings

One decoder setting lets you adjust the sharpness of Phantom Cine media.

>> Sharpness: A debayer-specific sharpness filter applied to provide the appearance of 
enhanced image detail. 20 is unity. The range is 0 to 100.

>> Highlights: Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-
range media by lowering this parameter, and achieves a smooth blend between the 
retrieved highlights and the unadjusted mid tones for a naturalistic result. 0 is unity. The 
range is –100 (minimum) through +100 (maximum).

Using Phantom Cine Files
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>> Shadows: Lets you selectively lighten or darken shadow detail. Raising this value retrieves 
shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The 
range is –100 (minimum) through +100 (very high).

>> Color Boost: Lets you naturalistically raise the saturation of regions of low saturation, 
sometimes referred to as a vibrance operation. Can be used also to lower the saturation of 
regions of low saturation. 0 is unity. The range is –100 (minimum) through +100 (very high).

>> Saturation: Adjusts the color intensity of the image. 0 is unity. The range is –100 (minimum) 
through +100 (very high).

>>Midtone Detail: When this parameter is raised, the contrast of regions of the image with 
high edge detail is raised to increase the perception of image sharpness, sometimes 
referred to as definition. When this parameter is lowered to a negative value, regions of the 
image with low amounts of detail are softened while areas of high detail are left alone. 0 is 
unity. The range is –100 (minimum) through +100 (very high).
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In this chapter, you’ll learn how to use the Edit page to assemble new timelines from scratch and 
modify existing timelines that you’ve imported for finishing. Whether you’re using Resolve as an 
NLE to edit an entire program, as a dailies system to create quick rough assemblies for grading and 
transcoding, or as a finishing system with which to replace VFX clips, fix problems with an errant 
conform, and make last-minute re-edits to a program to be graded, the Edit page has many of 
the tools you’re accustomed to using in other editing environments, and a few that are unique to 
DaVinci Resolve. 

For more information on how to use the Edit page to import and conform projects edited in other 
applications for color correction and finishing in DaVinci Resolve, see Chapter 9, “Preparing and 
Conforming Projects.”

This chapter covers the following topics:

Edit

The Edit Page User Interface� 196

Timelines� 196

The Browser� 198

Effects Library Browsing� 202

Edit Index� 204

Source/Offline and Timeline Viewers� 206

Inspector� 209

Timeline� 210

Toolbar� 213

Navigating the Edit Page Using the Keyboard� 215

Dual Monitor Layout� 215

Customizing the Edit page� 216

Undo and Redo in the Edit Page� 217

Creating and Duplicating Timelines� 218

Creating Blank Timelines� 218

Creating Timelines From Bins and Selections� 219

Selecting Clips in the Media Pool to Edit� 220

Transport Controls and Timeline Navigation� 222

Transport Controls� 222

Simple Keyboard Shortcuts for Playback and Navigation� 223

Using JKL to Control Playback� 224

Special-Purpose Playback Commands� 224

Enabling and Disabling Audio Scrubbing� 225
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Navigating Using Timecode� 225

Gang Viewers (Playhead Ganging)� 226

Setting In and Out Points� 227

Working With the Timeline� 229

Creating, Deleting, and Moving Timeline Tracks� 229

Using Snapping and Zooming� 229

Assembling Clips in the Timeline� 232

Drag and Drop Editing� 232

Appending Clips to the End of the Timeline� 233

Setting Destination Controls to Choose a Track to Edit Onto� 234

Source/Record Editing� 234

Setting In and Out Points in the Timeline� 236

Mark Clip and Mark Current Selection� 237

Assembling a Simple Sequence of Clips Using Overwrite Edits� 239

Three-Point Editing� 240

Different Types of Edits� 247

Overwrite Edits� 247

Insert Edits� 248

Replace Edits� 249

Fit to Fill� 251

Place On Top� 253

Append at End� 254

Match Frame Operations� 255

Matching From the Timeline� 255

Matching From a Source Clip� 256

Locating Source Viewer or Timeline Clips in the Media Pool� 257

Selecting and Deleting Clips in the Timeline� 258

Selecting Clips in the Timeline� 258

Using the Timeline Auto Select Controls to Define Selections� 259

Deleting Clips From the Timeline� 262

Finding, Selecting, and Deleting Gaps in the Timeline� 264

Trimming Gaps� 265
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Selecting Edits in the Timeline� 265

Linking and Unlinking Audio and Video� 267

Dealing with Audio Video Sync Offsets� 268

Locking Tracks� 269

Moving and Trimming Clips in Selection Mode� 270

Trimming Clips in the Source Viewer Using the Selection Tool� 272

Swap Edits and Swap Inserts� 274

Splitting and Joining Clips� 275

Copying and Pasting Clips in the Timeline� 276

Duplicating Clips and Transitions in the Timeline� 277

Flagging and Marking Clips for Reference� 278

Using Flags� 278

Using Markers� 279

Using Trim Mode and the Trim Tool� 282

Summarizing Trim Operations� 282

Rippling Gap� 282

Using the Trim Tool With the Mouse� 283

Trim Tool Operations With the Keyboard� 288

Trimming Using Timecode Entry� 290

Trimming Clips in the Source Viewer Using the Trim Tool� 290

Ripple Editing Rules� 292

Trimming Multiple Edits or Clips at Once� 295

Keyboard Trimming During Looped Playback� 297

Dynamic Trimming Using Command-JKL� 298

Trim Start and Trim End� 299

Extend Edits� 300

Enabling and Disabling Clips and Tracks� 301

Using Take Selectors� 302

Finding Media, Markers, and Gaps� 304

Compound Clips� 305

Subclips� 307

Working With Transitions� 308
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Adding and Editing Transitions� 308

Transition Properties in the Inspector� 309

DaVinci Resolve Transitions� 311

OpenFX Transitions� 312

Organizing Transitions and Setting the Standard Transition� 313
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Starting with Resolve 11, the Edit page has been organized into a source-record style NLE that adds 
many specialized features for finishing. The Edit page is divided into three main regions: the 
browsers found at the left, the Viewers at the top, and the Timeline at the bottom, all of which work 
together to let you import, edit, and trim timelines with a flexible variety of tools and methods.

The Edit Page in its entirety

Timelines

DaVinci Resolve projects contain one or more edited timelines (sometimes called a sequence in other 
applications) which are organized in the Timelines Browser, and displayed in the Timeline editor (referred 
to as “the Timeline”). Timelines contain clips, the source media of which is kept in the Media Pool, and 
which also appear as edit events in the Edit Index that can be shown at the right of the Timeline.

Timelines, Grades, and Versions

Within any given timeline, grades are associated with the timecode of the source clip they’re 
applied to. That means that as you alter the timeline, each clip’s grade moves along with it, making 
it extremely easy to move back and forth between editing and grading as your needs require. By 
default, each timeline in a project has independent sets of grades using Local versions; this is true 
even if your timelines are duplicates. That means each clip within every timeline has a completely 
independent grade.

However, if you switch the clips in one or more timelines to use Remote versions, a clip’s grades 
are shared by every instance of that clip in all timelines with clips that also use Remote versions. If 
you import a new timeline that rearranges clips into a different order and switch it to using Remote 
versions, then grades will automatically follow the clips, so that the clips within each new timeline 
inherits the grades applied to those same clips in other timelines.

The Edit Page User Interface
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You can switch a timeline between using Local and Remote grades at any time. For more information 
on using Local versus Remote versions, see “Using Versions to Manage Grades” in Chapter 13, 
“The Gallery and Grade Management.” You can also copy grades from one timeline to another 
using the ColorTrace feature. For more information about ColorTrace, see Chapter 9, “Preparing 
and Conforming Projects.

Enabling the Use of a Master Timeline

Previous versions of Resolve had a Master Timeline, which consisted of one long timeline containing 
every clip in the Media Pool, arranged by default in ascending order by timecode. While the Master 
Timeline was useful for a variety of tasks, architectural improvements have rendered it unnecessary, 
and by default the Master Timeline does not appear in new projects created by DaVinci Resolve 
version 10 or later.

However, if you want a Master Timeline in order to have a single timeline that always contains all 
clips currently in the Media Pool, there’s a way you can create one. You need to do it immediately 
upon creating a new project, before adding any media to the Media Pool. Once you’ve added one 
or more clips to the Media Pool, the option you need to do so will be disabled.

To create a new Master Timeline:

1. 	 Create a new project, open the General Options panel of the Project Settings, and turn on the 
“Automatically match master timeline with media pool” checkbox. If you also want all clips to 
use Remote versions as you grade by default as in previous versions of Resolve, you can turn 
off the “Store grade with local version by default.”

Turning on the option to use a Master Timeline

2. 	 Click Apply, and close the Project Settings window.

3. 	 Open the Edit page, and choose File > New Timeline.

4. 	 When the New Timeline Properties window appears, turn the Empty Timeline checkbox off, 
and click Create New Timeline.

	 Now, in addition to the new timeline, a Master Timeline appears in the Timeline list.
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	 Tip: If you want to make sure that you always have a Master Timeline when you create new 
projects, you can alter the Project Setting preset for your user account to reflect these settings, 
or you can create a new Project Setting preset with these settings that you can easily switch to.

Creating a Master Timeline

The Master Timeline consists of one long sequence of every clip in the Media Pool, arranged in 
ascending order by timecode. Each clip in the Master Timeline appears at its full duration, regardless 
of the duration of corresponding clips in an EDL-, AAF-, or XML-imported timeline. Whenever you 
add more clips to the Media Pool, they’re automatically added to the Master Timeline. 

The Master Timeline is useful for organizing media for which no editing has yet been done, such 
as when grading digital dailies. The Master Timeline is also useful for identifying a range of similar 
clips, based on their similar ranges of timecode. For example, you could find all the talking head 
shots from a particular section of tape clustered together in the Master Timeline.

The Browser

A unified browser lets you organize and peruse all of the timelines and media in a project. The 
Browser can be switched among two different modes, showing Timelines or the Media Pool, by 
clicking the appropriate button.

Timeline Browsing

The Timelines browser contains all timelines that have been either imported or created within that 
project. A folder view at the left shows a hierarchical list of folders that you can use to organize your 
timelines. You can create more folders by right-clicking anywhere in the empty area of the Media 
Pool and choosing Add Folder. You can rename any custom folder by double-clicking on its name 
and typing a new one, or by right-clicking a folder header and choosing Rename Folder. The folder 
view can be hidden or shown via the button at the far left of the Edit page toolbar. 
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The Timeline list

A panel to the right shows the contents of the currently selected folder. Every AAF, XML, or EDL 
file you import, and every timeline you create, appears as a new timeline in this panel. You can have 
as many timelines as you need within a single project. Since each timeline references clips in that 
project’s Media Pool, multiple timelines are often used for multiple edited versions of a particular 
program or reel. Additionally, multiple timelines can be used to create differently graded versions 
of a particular edit.

To switch timelines, do one of the following:

>> In the Edit page Media Pool, double-click a timeline in the Timeline list, or choose a timeline 
from the Timeline Viewer name pop-up menu.

>> In the Edit page Timeline Viewer, choose a timeline from the Timelines pop-up menu at the 
top of the viewer.

>> In the Color page, choose a timeline from the Timelines pop-up menu at the top of 
the viewer.

To switch timelines using the DaVinci control surface:

1. 	 Press MODES, above the fourth trackball on the Center panel.

2. 	 Press the SWITCH SESSION soft key repeatedly to switch among all available timelines in the 
Project Browser.

3. 	 Press MODES again when you’re finished.
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Media Pool Browsing

The Media Pool is displayed on both the Media and Edit pages, and shows you all of the source 
clips that are available for editing.

A folder view at the left shows a hierarchical list of folders that you can use to organize your media. 
By default, the Media Pool has a single folder, named “Master,” but you can add more folders as 
necessary to organize your clips. The folder view can be hidden or shown via the button at the far left 
of the Edit page toolbar. A panel to the right shows the contents of the currently selected folder. 

If you create multiple folders in the Media Pool, they appear as additional items in the Folder view. 
Each header has a disclosure triangle at its left that lets you show and hide the contents of 
that folder.

The Media Pool in Thumbnail mode
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You can create more folders by right-clicking anywhere in the empty area of the Media Pool and 
choosing Add Folder. You can rename any custom folder by double-clicking on its name and typing 
a new one, or by right-clicking a folder header and choosing Rename Folder. You can color code 
any folder by right-clicking it and choosing a color from the Color Tag submenu, and you can filter 
color-tagged folders using the filter pop-up at the bottom-right of the Folder view.

As in the Media page, the Media Pool can be displayed in either Icon or List view. In List view, you 
can sort the contents by any one of a subset of the total metadata that’s available in the Metadata 
Editor of the Media page. Of particular interest to editors are columns for Name, Reel Name, 
different timecode streams, Description, Comments, Keyword, Shot, Scene, Take, Angle, Circled, 
Start KeyKode, Flags, Usage, Resolution, and Frames Per Second.

A Search field at the upper-right of the Media Pool lets you search for any clip, and a pop-up menu 
to its left lets you choose specific metadata criteria to perform a more focused search. As soon as 
you enter any text into this field, clips that don’t match are temporarily hidden. To show all clips 
again, click the cancel button at the right of the search field.

For more information on using the Media Pool, see Chapter 4, “Media.”

Taking Advantage of the Media Pool’s Usage Column

In List view, the Usage column does not automatically update to show how many times a particular 
clip has been used. However, you can manually update this metadata by right-clicking within the 
Media Pool and choosing Update Usage Data from the contextual menu that appears. Afterwards, 
each clip will display how many times it’s been used in this column. Clips that have not been used 
yet display an x.
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Effects Library Browsing

The Effects Library contains a folder with the different Video Transitions, Title Effects, Generators, 
and Filters that are available for editing in the Timeline.

Transitions

You can drag any video transition to any edit point in the Timeline that has overlapping clip handles 
to add it to your edit; you have the option to drag the transition so that it ends on, is centered on, or 
starts on the edit point. You can also use various contextual menus and keyboard shortcuts which 
are described later in this chapter.

Titles and Generators

Titles and Generators can be edited into the Timeline like any other clip. Once edited into the 
Timeline, you can open that clip into the viewer to access its controls in the Inspector, for 
customization. You can choose a standard duration for generators to appear with in the Editing 
panel of the Project Settings.

The Effects Pool, made taller to show all of its contents
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OpenFX

DaVinci Resolve supports the use of third-party OpenFX transitions and generators in the Edit 
page. Once you install these effects on your workstation, they appear in the OpenFX panel of 
the Effects Library, organized by type and group depending on the metadata within each effect. 
These transitions and generators can be used in the same way as other transitions and generators 
in Resolve.

Effects Library Favorites

You can right-click any transition, title, or generator and choose “Add to Favorites” to flag that effect 
as a favorite effect. When you do so, choosing Favorites from the Effects Library option menu filters 
out all clips that are not favorites, letting you see only effects you most commonly use.

The Effects Pool, made taller to show all of its contents
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Edit Index

Clicking the Edit Index button opens the Edit Index. By default, this shows an EDL-style list view of 
all the edit events in the current timeline. Whichever timeline is selected in the Timeline list displays 
its events here. However, the contents of the Edit Index can be filtered using commands found in 
the Option pop-up, described later in this section. 

Edit Index List shown open

Each event populates several columns of information. These columns can be rearranged by 
dragging them to the left or right, depending on what information is most important to you.
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Whenever you move the Timeline playhead to intersect a clip, the Edit Index updates to show only 
the clips on the video track the intersecting clip is on, and that clip’s event is highlighted in the Edit 
Index. This makes it easy to see the correspondence between a clip in the Timeline and its event, 
which is helpful when troubleshooting problems. There are also commands available in the Option 
menu to display only clips on enabled tracks, only video clips, and only audio clips.

Each event populates several columns of information. These columns can be rearranged depending 
on what information is most important to you. The available columns of information are:

>> #: The event number (which corresponds to the clip number shown in the Thumbnail 
timeline of the Color page)

>> Reel: The reel name of the corresponding clip

>>Match: Offline clips that aren’t currently linked to source media display an X in this column. 
Indicates clips that are offline.

>> V: Video event

>> C: The event type (C for cut, D for dissolve or transition)

>> Dur: A number showing the duration of a transition in frames. 

>> Source In/Source Out: The Source In and Source Out timecode indicating the range of 
timecode referenced by that clip; corresponds to the timecode locations of each clip’s In 
and Out point relative to the source media it comes from.

>> Record In/Record Out: Record In and Record Out timecode indicating that clip’s position 
in the Timeline.

>>Name: The name of the clip.

>> Comments: Whatever comments were present in the EDL that was imported. For example, 
clip names exported from the original NLE to be used as reel names in RED workflows 
using EDL import.

>> Source Start/Source End: The very first and last frame of media available in the Source 
Media for that clip.

>> Source Duration: The duration, in timecode, of the total source media available in that clip.

>> Codec: The codec of the corresponding clip.

>> Source FPS: The frame rate of the corresponding clip.

>> Resolution: The frame size of the corresponding clip.

>> Color: The color of flags or markers applied to that clip.

>>Notes: Notes entered inside of markers applied to clips or the Timeline.
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Source/Offline and Timeline Viewers

The Source Viewer lets you view individual clips from the Media Pool to prepare them for editing. 
Meanwhile, the Timeline Viewer shows the frame at the position of the playhead in the Timeline. 
You can select either viewer by clicking, and the name of the viewer that currently has focus 
appears in orange. 

Source and Timeline viewers

Note: The Color Viewer Lookup Table options in the Look Up Tables of the Project Settings only 
affect the GUI Viewer in the Color page. They do not affect the viewers in the Edit page.

Both viewers share the following onscreen controls:

>> Zoom pop-up menu: Choosing Fit fits the currently visible frame to the available size of the 
viewer. Choosing a percentage zooms the visible frame to that size.

>> Duration field: At the top left-hand side of the Source Viewer, this displays the total duration 
of the clip, or the duration from the In to the Out point, if these have been placed. In the 
Timeline tab, this displays the total duration of the currently selected timeline.

>>Clip Name: The clip name is displayed at the center of the Source Viewer title bar. The 
Timeline Viewer displays the timeline name and is also a pop-up menu that lets you switch 
among other timelines in the current project. The clip/timeline name is highlighted orange 
when either the Source or Timeline Viewer has focus.

>> Source/Timeline Timecode Display: At the top right-hand side of the Source Viewer, this 
field shows the timecode of the current frame at the position of the playhead in the Source 
Viewer’s jog bar. In the Timeline Viewer, this field shows the record timecode of the current 
frame at the position of the playhead in the Timeline, and can be switched between source 
and record timecode by right-clicking and choosing from the contextual menu. 
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>>Option menu: The Option menu for each Viewer contains the Gang Viewers command. 
With Gang Viewers enabled, the movement of the Source and Timeline Viewer playheads is 
locked together, so that they move in unison. This is useful when you’re matching the timing 
of part of a clip in the Source Viewer to match an event in the Timeline.

>> Jog bar: In the Source Viewer, drag within the jog bar to reposition the Source playhead, 
scrubbing through the clip. In the Timeline tab, drag to reposition the playhead throughout 
the entire program.

>>Offline Mode button (Source Viewer only): If you’ve assigned an offline reference movie 
to the currently selected timeline, clicking the Offline Mode button lets you display the 
offline movie so you can compare it with the currently open timeline. In this mode, Source 
and Timeline playback are synched; an Offset field is available to resync the offline movie, 
if necessary.

>> Video button (Source Viewer only): Shows the video of the currently open clip in the 
Source Viewer.

>> Audio button (Source Viewer only): Shows the audio waveforms corresponding to all 
channels of the currently open clip in the Source Viewer. The top of this audio-only view 
shows the waveform for the entire duration of the clip, while the main region of the viewer 
shows a zoomed in section of the audio waveform. The level of zoom displayed is controlled 
by the zoom pop-up at the upper left-hand corner of the Source Viewer.

>> Transport controls: These controls include, from left to right, Jump to First Frame, Play 
Forward/Stop, Jump to Last Frame.

>>Match Frame: In the Source Viewer, Match Frame attempts to move the playhead in the 
Timeline to match the current frame of the clip in the Source Viewer. In the Record Viewer, 
Match Frame opens the Media Pool clip corresponding to the clip at the current position of 
the playhead into the Source Viewer, setting In and Out points and the playhead position 
to match those of the clip in the Timeline.

>> In/Out buttons: Places In and Out points with which to define a range of the clip, or of the 
Timeline, in preparation for making different kinds of edits.

When you turn on Offline Mode in the Source Viewer, one additional control appears that replaces 
the Duration field:

>>Offset field: Lets you specify an offset, in frames, with which to sync an offline-identified 
media clip that you’ve imported to compare to the currently selected timeline. You can 
select the number in this field in order to type a new value, or you can use the Up/Down 
arrow buttons to alter this value.
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Viewer Indicators

Certain frames trigger visible indicators in either the Source or Timeline viewers. For example, if the 
playhead is at the very first or last frame of media available to a particular clip, indicators appear in 
the lower-left or right corner of the frame to let you know there’s no more media in that direction.

If the playhead in the Timeline is on the first frame of black immediately after the last video clip 
in the Timeline, an end of sequence indicator appears in the Timeline viewer to let you know that 
you’re viewing the last frame of the current sequence of clips, even though the playhead is 
actually on a frame of black. This makes it easy to see what you’re doing while you’re first 
assembling clips together.

The end-of-sequence indicator

The first and last frame clip indicators
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Inspector

The Inspector can be opened to let you customize compositing, transform, and cropping parameters 
for clips, as well as clip-specific retime and scaling options. Furthermore, the Inspector lets you edit 
the parameters of transitions, titles, and generators used in the Timeline, in order to customize  
their effect.

The Inspector, opened and showing a clip’s parameters

When the Inspector is open, the Edit page switches to a single-viewer mode, showing you the 
Timeline item that you’re inspecting alongside the Inspector with that clip’s parameters. 

Methods of showing parameters in the Inspector:

>> To open a video or audio clip when the Inspector is closed: Select that clip, and then click 
the Inspector button at the far right of the Edit page toolbar.

>> If the Inspector is already open: You need only select a clip or effect to reveal its controls 
in the Inspector. 

>> If the Inspector is closed: Double-clicking any Transition, Title, or Generator will 
automatically open it. 

>> The Inspector shows different buttons at the top that let you switch among different pages 
of parameters. For example, when you select a clip with both audio and video components, 
the Inspector shows Video and Audio buttons at the top that let you switch among each 
set of controls. If you select a Generator effect, the Inspector only shows the controls 
corresponding to that generator.
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Timeline

The Timeline shows whichever timeline you’ve double-clicked in the Timelines browser. It’s where 
you either edit programs together from scratch, or import sequences from other applications. For 
imported programs, the Timeline provides a visual representation of the edited program that’s 
helpful for verifying that the project was imported correctly, checking the media corresponding to 
each clip in the program, and performing simple editorial tasks necessary to prepare a project for 
grading (such as replacing or adding clips, superimposing composites, and modifying composite 
modes or transitions).

An edited timeline

>> Timeline Ruler: The Timeline Ruler shows the program’s timecode, and the playhead 
indicates the current frame of the current clip. Whichever clip intersects the playhead is 
the one that you’ll be working on in the Color page. Dragging within the Timeline Ruler 
moves the playhead. When you add markers to the timeline, these markers appear within 
the Timeline Ruler, as well.

>> Playhead: The playhead automatically syncs with the Timeline Viewer’s jog bar playhead, 
the playheads in the Mini-Timeline and Thumbnail timeline of the Color page, and the 
playhead on the Deliver page. Furthermore, the Edit Index event that corresponds to the 
clip intersecting the playhead is automatically highlighted.

>> Timecode field: Shows the current timecode value corresponding to the position of 
the playhead.

>> Video Tracks: DaVinci Resolve supports multiple video tracks. At the left of each track is a 
header area that contains a number of controls.

>> Track Header: The Track Header contains different controls for selecting, locking/unlocking, 
and enabling/disabling tracks. Each track header also lists how many clips appear on that 
track. The Track Header contains the following five controls, from left to right:
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>> Destination control: Light gray with the text of the source track that’s being assigned 
when that track is selected, dark gray when that track is not selected. The Destination 
buttons dictate into which tracks audio and video media in the Source Viewer will be 
placed when an edit is executed. Ordinarily, there is one video destination control (V1) 
and one audio destination control (A1).

>> Track Number: Each track is numbered according to its position. The bottom track is 
“Video 1,” and subsequently numbered tracks appear higher in the Timeline. Click any 
track’s number to select that track for different editing functions; the selected track is 
highlighted black.

>> Track Name: Each track has a name that defaults to the type of track and the track 
number, such as Video 1, Audio 1. However, you can double-click any track’s name 
and edit it to be whatever you like. For example, you can rename each audio track with 
the type of audio you’re editing onto it, such as Production, Ambience, SFX, or Music.

>>Number of clips: The number of clips on that particular track of the Timeline is listed 
underneath the track name.

Track Header showing the Lock Track and Enable Track buttons enabled
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>> Auto Selection button: On by default. Light gray when that track is selected, dark gray 
when that track is not selected. Turning this control on enables clips on that track to 
be included in compatible operations that depend on the position of the playhead, or 
on Timeline In and Out points.

>> Enable Track button: A slash indicates when a track is disabled. This control lets you 
turn tracks on and off. Clips on tracks that are turned off aren’t visible in the viewer, 
don’t show up in the Color page, and aren’t available for rendering or output.

>> Lock Track button: Light gray when turned on, dark gray when turned off. When a 
track is locked, clips can’t be replaced, moved, or otherwise edited, although clips on 
locked tracks can be graded.

>> Audio channel type indicator: Audio tracks also have a small indicator showing 
which channel configuration that track uses, with different icons for stereo, mono, 
5.1, and adaptive.

>> Vertical and horizontal scroll bars: If your project is longer than the current width of the 
Timeline, or the number of video tracks is taller than the current height of the Timeline, 
these scroll bars let you drag to navigate around your program. You can also navigate left 
and right using the scroll wheel of your mouse. 

>> Zoom slider: Lets you zoom into or out of the clips in the Timeline. Use the scroll wheel of your 
mouse to horizontally zoom into and out of the Timeline. Scrolling up zooms in, while scrolling 
down zooms out. You can also use Command-Plus to zoom in, and Command-Minus to zoom 
out, and Shift-Z to fit every clip in your program into the available width of the Timeline.

>> Customize Timeline pop-up menu: Four sets of controls let you customize the look of the 
clips on the tracks (filmstrip, thumbnail, or minimized), whether or not to display audio 
waveforms, whether or not to display flags and markers, and the independently adjustable 
height of the video and audio tracks.

Selecting the Timeline Viewing options
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>> Individual Timeline track resizing: Any track in the Timeline can be individually resized by 
dragging its top divider in the Track Header area.

>> Show Edit Index button: Opens and closes the Edit Index, which shows a text list of all edits 
in the Timeline, with columns for edit number, reel, cut type, duration, source and record In 
and Out points, clip name, and comments. These columns can be rearranged, depending 
on what information is most important to you. There are also commands available in the 
Option menu to display only clips on enabled tracks, only video clips, and only audio clips

>> Show Audio Meters button: Opens and closes the Edit page audio meters, which also 
contain the audio mute button. If you have a display with 2560x1440 resolution you can see 
all 16 audio meters, but on lower resolution displays only 8 audio meters appear. 

Toolbar

Eleven buttons starting from the left, running along the top of the Timeline, let you choose different 
tools for performing various editing functions.

Buttons in the Toolbar

Normal Edit Mode: The default mode in which you can move and resize clips in the Timeline, roll 
edits, and do other basic editing tasks.

>> Trim Edit Mode: In this mode, the Trim tool lets you make slip, slide, ripple and roll edits by 
dragging different parts of clips in the Timeline, or by making specific selections and using 
the “nudge” keyboard shortcuts of comma and period to move the selection left or right.
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>> Razor Edit Mode: Lets you add cuts to the Timeline by clicking.

>> Insert Edit: Performs an insert edit to the Timeline with whatever clip is in the Source Viewer.

>>Overwrite Edit: Performs an overwrite edit to the Timeline with whatever clip is in the 
Source Viewer.

>> Replace Edit: Performs a replace edit to the Timeline with whatever clip is in the Source Viewer.

>> Snapping: Enables or disables clip snapping. When turned on, clip In and Out points, 
markers, and the playhead all snap to one another for reference while you’re editing.

>> Link Audio/Video: Enables or disables Audio/Video linking. When turned on, clicking a 
video clip in the Timeline automatically selects the corresponding audio clip if they’re 
linked together. When turned off, clicking a video clip won’t select its audio. Clip linking 
can be toggled while you work by pressing the Option key while clicking to make selections 
in the Timeline.

>> Loop Playback: Enables or disables looped playback. When enabled, each playback 
command loops back to the beginning when the end of that command’s range is reached. 
In and Out points in the Source or Timeline Viewers do not trigger looping. For example, 
when enabled, the Play command will play through the entire clip or timeline, and then 
loop back to the beginning when the end is reached and start playing automatically. The 
Play Around command, on the other hand, will start at the beginning of pre-roll, play 
through the post-roll, and then immediately loop back around to the beginning of pre-roll, 
continuing playback in this manner until you stop it.

>> Flag Clip/Flags pop-up menu: Flags identify clips, and indicate all clips that correspond to 
the same item of media in the Media Pool. Clips can have multiple flags. Clicking the Flag 
button automatically adds a flag to whichever clip is currently selected in the Timeline. A 
pop-up menu to the right lets you choose differently colored flags, and clear all flags from 
the currently selected clip.

>> Add Marker/Marker pop-up menu: Markers identify specific frames of individual clips. 
Clicking the Add Marker button adds a marker of the currently displayed color to the clip 
at the position of the playhead in the Timeline. A pop-up menu to the right lets you choose 
differently colored markers, and clear all markers from the currently selected clip.

These functions are described in greater detail in the following sections of this chapter.
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Navigating the Edit Page Using the Keyboard

The following keyboard shortcuts can be used to give focus to different parts of the Edit page in 
order to select bins, clips, the Source and Timeline Viewers, the Timeline, the Effects Library, Edit 
Index, and Inspector.

Dual Monitor Layout

The Edit page has a dual monitor layout that provides maximum space for the Timeline and Viewers 
on the primary monitor, and an enlarged Media Pool, simultaneously displayed Timelines browser, 
Edit Index, Effects Library, and Metadata editor on the secondary monitor.

To enter dual screen mode:

>> Choose View > User Interface Layout > Dual Screen > On.

The Edit page in dual-screen mode

Key Function

Q Toggle between Source and Timeline Viewers.

Command-1 Source Viewer

Command-2 Timeline Viewer

Command-3 Timeline

Command-4 Folder View

Command-5 Media Pool

Command-6 Effects Library

Command-7 Edit Index

Command-8 n/a

Command-9 Inspector
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To switch which UI elements appear on which monitors:

>> Choose View > User Interface Layout > Primary Display > Display 1 or Display 2, which 
reverses the contents of both monitors in dual screen mode.

Customizing the Edit page

The default layout is quite efficient for a number of tasks on most displays. You can always return to 
the default layout by choosing View > Reset UI Layout.

However, the Edit page can be customized to create more room for specific areas of the interface 
to accommodate different tasks.

To resize any area of the Edit page:

>> Drag the vertical or horizontal border between any two panels to enlarge one and shrink 
the other.

To expand the width of the Timeline:

>> Hiding both the Edit Index and the Effects Library causes the Timeline to expand to the full 
width of your screen.

To enable a full-screen timeline in Dual Screen mode:

>> Choose View > User Interface Layout > Dual Screen > Full Screen Timeline, which causes 
the Timeline to fully occupy the primary display, while the Browser, Viewers, Audio Mixer, 
Edit Index, and Effects Library appear on the secondary display.

To open and close the Edit Index List and Effects Library:

>> Click the Edit Index button in the group at the bottom left of the Edit page.

To open and close the Inspector:

>> Click the Inspector button at the far right of the toolbar.
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To customize the columns in the Edit Index:

>> To show or hide columns in the Edit Index: Right-click any column header, and choose the 
column you want to show or hide from the contextual menu. Checked columns are shown, 
unchecked columns are hidden.

>> To resize any column of the Edit Index: Move your pointer over the divider between any two 
columns and drag when the horizontal resize cursor appears.

>> To sort the Edit list by any column: Click the Option button at the top right to display all 
active tracks, just the video, or just the audio tracks.

To show and hide the Audio Meters:

>> Click the Audio Meter button in the group at the bottom right of the Timeline.

Undo and Redo in the Edit Page

The Edit page has its own multiple-undo stack, which is separate from the multiple-undo stacks of 
each clip in the Color page. The Edit page undo commands have been separated to make it easy 
and reliable to undo edits and other changes you make in the Timeline without disturbing your work 
in the Color page. 

To undo and redo:

>> Press Command-Z to Undo, and Shift-Command-Z to Redo.

Note: Each timeline has its own undo stack.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

222

EDIT6

If you’re not importing a project that’s been edited elsewhere, you can create a new timeline to cut 
together a new edit from scratch, or to grade a set of dailies. When you create a new timeline, you 
can either create a timeline that contains all clips found in the Media Pool to quickly create a big 
batch of offline dailies, or an empty timeline that’s ready for you to add specific clips to.

Creating Blank Timelines

If you’re cutting a new program, you’ll want a blank timeline. However, it’s often useful to create 
blank timelines when putting together dailies. For example, you could create an empty timeline, 
sort the Media Pool by reel name, and add all clips from a particular reel to a dedicated timeline.

To create a blank timeline:

1.	 Select or create a Folder in the Folder View in which to put the new timeline (optional).

2.	 Do one of the following:

>> Choose File > New Timeline.

>> Right-click within the Timeline list of the Edit page, and choose Create New Timeline.

3.	 When the New Timeline Options window opens, set the following options:

>> Start Timecode: You can change the Start Timecode if a specific start time is required.

>> Timeline Name: Enter a name into the Timeline Name field.

>> Empty Timeline: By default a new timeline will be empty. If you turn off the Empty Timeline 
checkbox, the new timeline that’s created will contain all the media found within the 
Media Pool.

>> Use Selected Mark In/Out: If you’ve selected one or more clips in the Media Pool, turning 
this checkbox on creates a new timeline and automatically populates it with the selected 
clips. Clips are edited according to the sort order of the Media Pool, and each clip’s duration 
matches that defined by the In and Out points of each clip.

4.	 Click OK.

A new timeline is created. If necessary, you can duplicate an existing timeline in order to alter an 
edit or create an alternate grade. 

To duplicate a timeline:

Right-click the sequence you want to duplicate in the Timeline list and choose Duplicate Timeline 
from the contextual menu. A new timeline will appear in the list with “copy” appended to the name.

Creating and Duplicating Timelines
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Creating Timelines From Bins and Selections

The “Create Timeline Using Bin” and “Create Timeline Using Selected Clips” commands let you 
quickly assemble a timeline using the contents of the Media Pool, using whatever In and Out points 
have been added to each clip, and using the sort order of the enclosing bin to determine the order 
in which the clips will be assembled.

Tip: These commands are especially useful for putting together quick assembly edits if you have 
metadata-rich media with scene, shot, and take information that you can use to sort clips into the 
proper order, and In and Out points that you’ve already logged.

To create a timeline using the full contents of a bin:

1.	 (optional) Put the Media Pool into List mode, set In and Out points for each clip in your Bin, 
and sort the Media Pool by the column that will put all clips in the order you want them to 
be assembled.

2.	 Right-click the bin in the Folder View, and choose “Create Timeline Using Bin.”

3.	 Type the name of the new timeline in the New Timeline Properties dialog. If you want to use 
the In and Out points of each clip, make sure “Use Selected Mark In/Out” is checked, and click 
Create New Timeline.

To create a timeline using manually selected clips:

1.	 (optional) Put the Media Pool into List mode, set In and Out points for each clip in your Bin, 
and sort the Media Pool by the column that will put all clips in the order you want them to be 
assembled.

2.	 Select one or more clips you want to assemble into a new timeline.

3.	 Right-click one of the selected clips, and choose “Create Timeline Using Selected Clips.”

4.	 Type the name of the new timeline in the New Timeline Properties dialog. If you want to use 
the In and Out points of each clip, make sure “Use Selected Mark In/Out” is checked, and click 
Create New Timeline.
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The following procedures show how to select one or more clips in the Media Pool to accomplish 
various editing tasks, either by opening a clip in the the Source Viewer, or selecting a group of clips 
with which you want to do drag and drop editing. This section starts by presenting different ways 
you can browse the contents of the Media Pool to find clips you want to use, in preparation for 
making a selection for your next operation.

Methods of browsing clips in the Media Pool:

>> Using thumbnail hover scrub in the Media Pool’s Thumbnail view: Drag the pointer over a 
thumbnail to scrub though its contents.

Thumbnail hover scrubbing

>> Using the Media Pool Filmstrip in the Media Pool’s List view: Select a clip to expose it in the 
Filmstrip at the top of the Media Pool, and drag the pointer through the Filmstrip to watch 
it play. At any time, you can double-click a clip in the Filmstrip to open it into the 
Source Viewer.

Using the Filmstrip when the Media Pool is in List view

Tip: When browsing media, you can open clips you want to have a closer look at in the Source 
Viewer by double-clicking them in the Media Pool. Meanwhile, you can continue to open other clips 
in the Filmstrip with a single clip in order to compare different clips with your main selection that 
remains in the Viewer.

Selecting Clips in the Media Pool to Edit
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Methods of selecting clips in the Media Pool:

>> To select a single clip using the mouse: Click a clip in the Media Pool with the mouse. 

>> To select a single clip using the keyboard: Use the Arrow keys to change the selection from 
clip to clip in the Media Pool, up, down, left, and right. If you’ve selected a folder, use the 
left arrow key to close the folder, and the right arrow key to open the folder. Once a clip 
is selected, you can press an edit keyboard shortcut to edit the selected Media Pool clip 
straight to the currently open timeline.

>> To select a contiguous range of clips: In Icon mode, drag a selection box over all the clips 
you want to select. In Icon or List mode, select the first clip in a series, then Shift-click the 
last clip to select those clips and everything in between.

Selecting a contiguous range of clips

>> To select a noncontiguous range of clips: Command-click each clip you want to include in 
the selection.

Selecting a discontiguous range of clips

>> To select all clips in the Media Pool: Make sure the Media Pool has focus, then press 
Command-A to select all clips.

Once you’ve opened a clip into the Source Viewer, you can use the transport controls to play through it.
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Once you’ve decided which clips you want to use in your program, you can open them into the 
Source Viewer to review them more completely.

To open a clip into the Source Viewer using the mouse:

>> Double-click any clip in the Media Pool, or in the Filmstrip of the Media Pool, to open it into 
the Source Viewer.

To open a clip into the Source Viewer using the keyboard:

1.	 If necessary, press Command-4 to select the Folder List, and press the Up and Down arrows to 
choose a folder to view its contents. Press the Right Arrow key to open folders and show any 
nested folders within, or the Left Arrow key to close folders and hide their nested contents. 

2.	 Press Command-5 to select the Media Pool browser, and use the Arrow keys to change the 
selection from clip to clip in the Media Pool, up, down, left, and right. 

3.	 When the clip you want is highlighted, press Return to open it into the Source Viewer.

Transport Controls

The Edit page has two viewers. The left viewer, when you’re editing, should be set to show either 
source video or source audio, so it shows the source clip in any edit you’re setting up. At right is the 
Timeline Viewer, that shows the frame at the current position of the playhead in the Timeline. Using 
the Source and Timeline Viewers, you can set up a wide variety of edits.

There are identical transport controls underneath each of the viewers. 

Monitoring With An External Video Display

While working in the Edit page, the image that’s displayed on an external video display (if one is 
connected) is determined either by the current selection in the Media Pool, or by which part of the 
Edit page interface has focus. For example, if you select a clip in the Media Pool so it’s displayed 
within the Filmstrip, that clip is output to video. If you then open it into the Source Viewer, then the 
contents of the Source Viewer are output to video. If you switch to the Timeline Viewer, then your 
timeline is output to video.

The transport controls at the bottom of the Source Viewer

Transport Controls and Timeline Navigation
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A jog bar appears directly underneath the image, letting you drag the playhead directly with the 
pointer. The full width of the Source Viewer’s jog bar represents the full duration of a clip, while the 
full width of the Timeline Viewer’s jog bar represents the full duration of the current timeline. The 
current position of each playhead is shown in the timecode field at the upper right-hand corner of 
each viewer.

Transport controls appear underneath the jog bar. In the Source Viewer, these controls let you 
Jump to the First Frame, Play Forward/Stop, and Jump to the Last Frame. In the Timeline Viewer, 
these control move to the Previous Edit, Play Forward/Stop, and move to the Next Edit.

Simple Keyboard Shortcuts for Playback and Navigation

There are many different keyboard shortcuts you can use to simply navigate clips and timelines, and 
control playback.

>> Spacebar: You can use the spacebar to start and stop playback.

>> Step Forward/Step Back: The Left Arrow and Right Arrow keys move back and forth one 
frame at a time, while Shift-Left Arrow and Shift-Right Arrow move the playhead in one 
second increments.

>>Next Edit/Previous Edit: Up Arrow moves the playhead to the previous edit and selects 
the edit point, while Down Arrow moves the playhead to the next edit and selects the 
edit point.

>> First and Last Frame of the Current Clip: The Semicolon key moves the playhead to the first 
frame of the clip intersecting the playhead, while the Apostrophe key moves the playhead 
to the last frame of the clip intersecting the playhead.

>> Previous Keyframe/Next Keyframe: Shift-Semicolon moves the playhead to the next 
previous keyframe on the left when keyframes are displayed in the Timeline, while Shift-
Apostrophe moves the playhead to the next keyframe to the right.

>> Timeline Start/Timeline End: The Home key moves the playhead to the first frame of the 
Timeline, while the End key moves the playhead to the last frame of the Timeline.

>> In Point/Out Point: Shift-I moves the playhead to the In point set in either the viewer or the 
Timeline. Shift-O moves the playhead to the Out point.

Tip: One of the General Options in the Project Settings window, “Always highlight current clip in 
the media pool,” lets you decide whether the current selection in the Timeline is mirrored in the 
Media Pool.
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Using JKL to Control Playback

The JKL keyboard shortcuts are common to many editing applications, and experienced editors 
know these to be some of the most useful controls for playback and editing there are. Here’s a list 
of the many different ways you can use these three keyboard shortcuts to play through clips and 
timelines as you work.

Once you learn all the different methods of JKL playback, they will probably become one of the 
main ways you move the playhead around in Resolve.

Special-Purpose Playback Commands

In addition to the standard transport controls, there are some additional playback controls, available 
via keyboard shortcuts or the Playback menu, that let you perform different playback operations.

>> Loop: Command-Forward Slash (/). Toggles looped playback off and on. While looped 
playback is on, playback initiated with any of the following commands will loop automatically 
until you stop playback.

>> Play around current frame: Forward Slash (/). Plays a section of the Timeline from x frames 
before to y frames after the current position of the playhead. This command is useful for 
previewing how edits play within the context of the clips immediately surrounding them. 
The pre-roll and post-roll time is customizable in the Editing panel of the Project Settings.
The pre and post roll duration of this preview can be customized in Project setting, editing.

Key Function

J Plays 100% backward.

K Stops playback.

L Plays 100% forward

Press J repeatedly Increases backward play speed each time you press 
J, for a range of fast-reverse speeds.

Press L repeatedly Increases forward play speed each time you press 
L, for a range of fast-forward speeds.

Shift-J Plays in fast reverse.

Shift-L Plays in fast forward.

K+J Plays backward at slow motion.

K+L Plays forward at slow motion.

Pressing K while tapping J Moves the playhead back one frame.

Pressing K while tapping L Moves the playhead forward one frame.

Command-JKL

Holding the Command key down while using the JKL keyboard 
shortcuts lets you dynamically resize or trim selected edit points or 
clips, depending on whether the Selection or Trim tool is enabled. 

More information on dynamic trimming appears later in this chapter.
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>> Play around current clip: (no default key assigned). Plays a section of the Timeline from x 
frames before to y frames after the current clip intersecting the position of the playhead. 
The pre-roll and post-roll time is customizable in the Editing panel of the Project Settings.

>> Play In to Out: Option-Forward Slash (/). If you’ve marked a section of a clip or timeline with 
In and Out points, this command lets you preview how it will play.

>> Play to In: (no default key assigned). Initiates playback and stops at the current In point.

>> Play to Out: Option-Command-Option-Forward Slash (/). Initiates playback and stops at 
the current Out point.

>> Play Around In: Option-Space. Plays a section of the Timeline from x frames before to y 
frames after the current assigned In point, letting you preview the transition from one 
clip to the next. The pre-roll and post-roll time is customizable in the Editing panel of the 
Project Settings.

>> Play Around Out: Shift-Space. Plays a section of the Timeline from x frames before to y 
frames after the current assigned Out point, letting you preview the transition from one 
clip to the next. The pre-roll and post-roll time is customizable in the Editing panel of the 
Project Settings.

Enabling and Disabling Audio Scrubbing

Audio scrubbing is enabled by default, meaning that you’ll hear audio when dragging the playhead 
with the mouse back and forth. While this can be useful when you’re searching for audio cues, it can 
also be distracting if you’re just focused on the picture.

To enable or disable audio scrubbing:

>> Choose Edit > Audio Scrubbing (Shift-S)

Navigating Using Timecode

You can use absolute or relative timecode entry to either move the playhead in both the Source and 
Timeline viewers, or to move or trim selected edit points or clips. When navigating the Timeline, 
timecode entry lets you move the playhead very precisely, or jump to specific timecode values 
really quickly.

When entering timecode, type each pair of hour, minute, second, and frame values from left to 
right, with a period representing a pair of zeros for fast entry. Press the Return key to execute the 
timecode command. 

The rules for timecode entry are as follows:

>> The right-most pair of timecode values (or period) you enter is always the frame number.

>> A period to the left of any number you type is considered to be a pair of zeroes. A single 
period between two numbers is considered to either be a single zero, or ignored if it’s 
between two pairs of numbers.
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>> Any untyped pairs of values to the left of what you enter are assumed to be whatever those 
values were prior to the timecode you entered; this makes it easy to type partial timecode 
values even when the Timeline starts at hour one. 

It’s not necessary to enter colons or semicolons. Simple In and Out points let you join the audio and 
video of two clips at a single edit point in the Timeline. However, setting split In or Out points sets 
you up to create split edits where the video is offset from the audio in a single step.

Absolute timecode is entered simply by typing in a timecode value. So long as no clips or edit 
points are selected when you press the Return key, the playhead will move to that timecode value. 
If an edit point or clip is selected, those will be moved or trimmed to the corresponding timecode 
value, if possible.

Here are some examples of absolute timecode entry using this method:

Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding 
a plus results in the value you type being added to the current timecode value for purposes of 
offsetting the playhead or moving a selection. Adding a minus will subtract the value you type from 
the current timecode value.

Here are two examples of relative timecode entry:

	 +20.		  00:00:20:00 is added to the current timecode value.

	 -5		  00:00:00:05 is subtracted from the current timecode value.

Gang Viewers (Playhead Ganging)

Ordinarily, the playhead movement in the Source and Timeline Viewers is independent. However, if 
you click the Option menu at the upper right-hand corner of either Viewer and turn Gang Viewers 
on, the movement of the Source and Timeline Viewer playheads is locked together, so that they 
move in unison. 

This is useful when you’re marking the In and Out points of a clip in the Source Viewer to match the 
duration of a clip or other event in the Timeline.

Original TC Value User-Typed Value New TC Value

01:10:10:10 15245218 15:24:52:18

01:10:10:10 2.. 01:02:00:00

01:10:10:10 15 01:10:10:15

01:10:10:10 12 01:10:10:12

01:10:10:10 1.2 01:00:01:02

01:10:10:10 115.. 01:15:00:00

01:10:10:10 23... 23:00:00:00
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Now that you’ve used playback commands to review your clips, you can place In and Out points to 
set the range of each clip that you want to edit into the Timeline. If you don’t set In or Out points, 
then the entire clip will be edited into the Timeline.

To set In and Out points using the Media Pool list view Filmstrip: 

>> Set the Media Pool to List view, then select a clip to expose it in the Filmstrip at the top of 
the Media Pool, drag the pointer through the Filmstrip to watch it play, and press I and O 
to set In and Out points to the appropriate range.

The Filmstrip will dim the heads and tails to let you see the range of media you’ve marked. Once 
you’ve marked In and Out points in the Filmstrip, you can drag them to the left and right to 
move them.

To set In and Out points in the Source Viewer:

1.	 Open a clip in the Source Viewer, or select the Timeline Viewer. 

2.	 Use keyboard shortcuts, the transport controls, or jog bar to move the playhead to where you 
want to set an In or Out point. 

3.	 Do one of the following: 

>> To mark simple In and Out points: Use the In and Out buttons to the right of the transport 
controls, or press the I or O keys.

>> To mark split In and Out points in preparation for making a split edit: Right-click the Jog Bar 
and choose Mark Split > Video/Audio In/Out.

Setting In and Out Points

Marking In and Out points in the Filmstrip of the Media Pool in List view
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Simple In and Out points let you join the audio and video of two clips at a single edit point in the 
Timeline. However, setting split In or Out points sets you up to create split edits where the video is 
offset from the audio in a single step.

To clear In and Out points:

>> To clear In or Out points: With the Source Viewer selected, press Option-I to clear the 
current In point, or Option-O to clear the current Out point.

>> To clear both the In and Out points at once: With the Source Viewer selected, press Option-X.

To jump the playhead to the current In or Out points: 

>> Press Shift-I to move the playhead to the current In point, 

>> Press Shift-O to move the playhead to the current Out point.

Once set, In and Out points remain in place within each source clip until you set new ones.

Marking In and Out points in the Source Viewer, both as simple and split edits
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Before you start editing clips into the Timeline, it’s a good idea to understand how to customize the 
Timeline’s view in different ways. Adding, rearranging, and removing tracks, zooming in and out, 
and scrolling around the Timeline are important to working efficiently.

Creating, Deleting, and Moving Timeline Tracks

When you’re getting ready to edit clips into the Timeline, you need to make sure you’ve got enough 
tracks to do the job. The following procedures cover the different methods available for adding, 
removing, and rearranging tracks as you work.

Methods for adding, deleting, and rearranging tracks:

>> To add a track to the Timeline: Right-click on the left of the Timeline and choose Add Track. 

>> To delete a track from the Timeline: Right-click on the left of the track and choose Remove  
Track. If there are clips on a track you remove, they are deleted from the Timeline.

>> To move tracks and the clips on them up and down: Right-click on the left of the track and 
choose Move Track Up or Move Track Down from the contextual menu. That track, along 
with all clips on it, will be moved up or down relative to the other tracks in the Timeline.

Using Snapping and Zooming

When preparing to make an edit into the Timeline, you can set the snapping and zoom controls to 
whichever state is most useful for the operation you need to perform. For example, if you’re editing 
an insert shot into a rapid-fire section of edits in the Timeline, you may want to zoom in to better see 
the exact place where you want to place the incoming clip. Since there are many edits at that point, 
disabling snapping might make it useful to avoid having the clip jump to the nearest edit point if you 
need to move the incoming clip to a very specific frame.

Playhead Snapping and Timeline Zoom:

>> To turn clip and playhead snapping on and off: Click the Snapping button in the toolbar, or 
press N. When snapping is turned on, the In and Out points and markers of clips all snap to 
one another and to the playhead. You can also press N to turn snapping on or off while 
dragging a clip in the Timeline.

The snapping button in the toolbar

>> To zoom into and out of the Timeline: Drag the zoom slider to the left to zoom out, and 
right to zoom in. You can also press Command-Minus (–) and Command-Equal (=) to zoom 
out and in. Either way, zooming is always centered on the current position of the playhead, 
even if the playhead is off screen.

>> To frame every clip into the width of the Timeline: Press Shift-Z.

Working With the Timeline
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Scrolling Through the Timeline 

When you’re zoomed into the Timeline, you can scroll left and right, or up and down, using horizontal 
and vertical scroll bars. You can also scroll through the Timeline using the scroll wheel of your mouse.

If you need to see more of the video or audio tracks in the available area of the Timeline, you can 
drag the horizontal divider that separates the audio and video tracks up or down to create room 
where you need it.

Dragging the Timeline center divider to make more room for audio or video tracks

Timeline View Options

As you’re working on an edit, it can often be useful to modify the appearance of the Timeline, 
changing the height of video or audio clips, choosing whether audio waveforms are drawn or not, 
etcetera. Using the Timeline View Options pop-up at the bottom right of the Timeline, you can 
make these kinds of changes as you work.

The Timeline View Options pop-up
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You have the following options:

>> Track appearance buttons: Four buttons let you choose the overall appearance of video 
and audio tracks. From left to right, the options are: Small Video Filmstrips with Large 
Audio tracks, Large Video Filmstrips with Small Audio tracks, Video tracks with thumbnails, 
Minimized tracks with no filmstrip or thumbnail.

>> Audio Waveform display checkbox: Lets you turn audio waveform viewing off and on.

>> Flags and Pins checkbox: Lets you turn the drawing of Flags and Markers off and on.

>> Video track height slider: Lets you resize the size of all video tracks at once, independently 
of the audio tracks.

>> Video track height slider: Lets you resize the size of all video tracks at once, independently 
of the audio tracks.

>> Audio track height slider: Lets you resize the size of all audio tracks at once, independently 
of the video tracks.

In addition, any track in the Timeline can be individually resized by dragging its top divider in the 
Track Header area.
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Once you’ve selected a clip to edit, marked In and Out points, and set up the Timeline for editing, 
it’s time to begin assembling your edited program together.

Drag and Drop Editing

The simplest method of editing is to drag clips from the Media Pool and drop them into the Timeline. 
You can do this with individual clips, or with selected groups of clips.

1.	 If you need to edit more specific ranges of the clips you’re editing, you can set In and Out 
points in source clips first by doing one of the following:

>> Using the Media Pool Filmstrip in the Media Pool’s List view: Set the Media Pool to List 
view, then select a clip to expose it in the Filmstrip at the top of the Media Pool, drag the 
pointer through the Filmstrip to watch it play and press I and O to set In and Out points to 
the appropriate range. The Filmstrip will dim the heads and tails to let you see the range of 
media you’ve marked.

>> Using the Source Viewer: Open a clip in the viewer by double-clicking it in the Media Pool, or 
selecting it in the Media Pool and pressing the Return key. Then use the transport controls, 
jog bar, or control surface buttons to move the playhead, and place In and Out points using 
the In and Out buttons to the right of the transport controls, or by pressing the I or O keys.

2. 	 If you want to edit several clips at once, select them in the Media Pool after you’ve finished 
setting In and Out points.

3.	 Drag the clip in the filmstrip of the Media Pool’s list view, the clip in the viewer, or any selected 
clips in the Media Pool, to the desired position in the Timeline to perform an overwrite edit. 
This replaces whatever was there before. Multiple clips dragged from the Media Pool will be 
edited in the order in which they’re sorted in the Media Pool, using each clip’s In and 
Out points.

Dragging a clip into the Timeline

Assembling Clips in the Timeline
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Appending Clips to the End of the Timeline

If you simply need to add one or more clips to the end of the currently open timeline, you can also 
use the Append Edit command, available from the Media Pool contextual menu.

To append one or more clips to the end of a track:

1.	 Select one or more clips in the Media Pool, or open a clip into the Source Viewer. If necessary, 
set In and Out points for the clip(s) you want to append.

2.	 Drag the video and audio destination controls to the tracks you want to append the video and 
audio of the incoming clip(s) to.

3.	 To perform the edit, do one of the following:

>> Choose Edit > Insert/Overwrite Action > Append at End

>> Press Shift-F12

>> Right-click one or more selected clips in the Media Pool, and choose “Append Selected 
Clips to Timeline.”

	 The selected clip(s) are appended as the very last clip on the destination track.
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A more controlled form of editing is to use three and four point editing to make a specific range of 
source media fit into a specific range of the Timeline. 

Setting Destination Controls to Choose a Track to Edit Onto

The destination controls, found in the Timeline header area, let you specify which video and audio 
tracks you want incoming source clips to be edited to when you use editing methods other then 
drag and drop. No matter how many video or audio channels may be embedded within a single 
clip of media, only one video and one audio destination control is available. In the case of video, 
you can only expose one video channel of a clip at a time. In the case of audio, all audio channels 
for a given clip are embedded within a single Timeline track, making it a snap to edit stereo or 
other multi-channel audio sources together. (For more information about working with audio, see 
Chapter 8, “Working with Audio.”)

Setting the destination control of a track is a vital step in the process of creating an edit, and is easy 
to do. You can set the video and audio destination controls to be separate tracks.

To set the destination tracks of incoming source clips, do one of the following:

>> Click the destination control of any unassigned track to enable that track as the destination.

>> Drag the destination control to any unassigned track in the Timeline.

>> Press Option-1 through 8 to set a video destination, or press Option-Command-1 through 
8 to set an audio destination on tracks 1 through 8.

Source/Record Editing

Selecting the Offline video to link to the current timeline
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You can also disable the video or audio destination controls in situations where you want to edit a 
source video clip into the Timeline without its audio, or vice versa. 

To disable or reenable a destination control, do one of the following:

>> Click an already assigned destination control to toggle it off and then on again. Disabled 
destination controls are highlighted red.

A disabled destination control

Setting In and Out Points in the Timeline

When you’re setting up an edit to the Timeline, you can often get away with simply putting the 
Timeline playhead at the frame where you want to edit the incoming source clip. In the absence of 
In or Out points, the playhead is used as the In point. However, you can set up different kinds of 
edits by setting specific In and Out points to define different ranges of the Timeline.

Methods of setting and clearing In and Out points in the Timeline:

>> To set an In or Out point: Select the Timeline or Timeline Viewer by clicking or pressing 
the Q key, then use the transport controls, jog bar, or control surface buttons to move the 
playhead, and press the I key to set an In point, or the O key to set an Out point.

>> To clear In or Out points: With the Timeline Viewer selected, press Option-I to clear the 
current In point, or Option-O to clear the current Out point.

>> To clear both the In and Out points at once: Press Option-X.

>> To jump the playhead to the current In or Out points: Press Shift-I to immediately move the 
playhead to the current In point, or Shift-O to move the playhead to the current Out point.
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In and Out points shown in the Timeline, with unmarked areas outside the selection dimmed

Methods of moving In and Out points in the Timeline:

>> Press the I or O keys at any time to change the In or Out points.

>> Drag any In or Out point in the Timeline ruler to another position.

The area of the Timeline outside the region that’s currently defined by In and Out points is dimmed, 
to call attention to the portion of the Timeline that will be affected by the next edit you’ll make.

Mark Clip and Mark Current Selection

These commands are automatic ways of setting In and Out points in the Timeline both at once, using 
the timing of other clips. They’re both exceptionally handy for defining the range of an incoming 
edit using clips that are already in the Timeline that you want to replace, or gaps in the Timeline that 
you want to fill. 

In short, Mark Clip uses the first and last frame of a target clip or gap in the Timeline to automatically 
set Timeline In and Out points for editing. For example, if there’s a shot in an edit that you want to 
replace with a different take of the same action, or there’s a gap in a sequence of clips that you’d 
like to quickly fill with b-roll, you can use the Mark Clip command to help set this up.

Mark Current Selection uses the first and last frames of a range of selected clips to automatically 
set Timeline In and Out points for editing. A good example is when you have a series of clips in the 
Timeline, all of which you’d like to overwrite with a single incoming source clip, you can use the Mark 
Current Selection command.
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To use Mark Clip:

1.	 Move the playhead to intersect either a clip you want to use to set In and Out points, or a gap 
(empty area) between two other clips that you want to target. The playhead can be on any 
frame of this clip, it doesn’t matter which.

Positioning the playhead at a clip you want to mark 

2.	 If there are other clips on a multi-track timeline that overlap the clip you’re targeting for this 
operation, then the clip on the lowest video track will be used as the target to set the In and 
Out points. If you want to target a clip on a higher track, then either disable the Auto Selection 
controls of all timelines underneath, or Option-Click the Auto Selection control of the track 
with the clip you’re targeting to solo it. (More information on using the Auto Selection controls 
of the Timeline appears later in this chapter.)

3.	 Press the X key to automatically set In and Out points that match the first and last frames of the 
target clip.

Using Mark clip to set In and Out points that match a clip’s duration

	 Tip: To clear both In and Out points, press Option-X, which is the opposite of this command.
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To use Mark Selection:

1.	 Select one or more clips in the Timeline.

Selecting clips you want to use as a range to mark In and Out points

2.	 Press Shift-A to automatically set In and Out points that match the first and last frames of 
the selection. A range of discontinuous clips will produce the same result as a range of 
continuous clips.

Marking a selection to set In and Out points
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Assembling a Simple Sequence of Clips Using Overwrite Edits

Overwrite edits are by far the most common type of edit in most projects. They’re flexible in that 
you can eliminate unwanted material in other clips while at the same time adding new clips to the 
Timeline. The following example shows how you can use the Edit page to assemble a quick first cut 
of edits using different features of the Media Pool, Viewers, and Timeline.

1. 	 Open a clip into the Source Viewer, and set In and Out points to define the section of that clip 
you want to edit into your program.

2. 	 Click the destination control of the Timeline tracks you want to edit the incoming media onto. 
By default, the destination controls are assigned to tracks V1 and A1.

3. 	 To perform the edit, do one of the following:

>> Drag the clip from the Source Viewer to Timeline Viewer and drop it on the Overwrite overlay.

>> Click the Overwrite Clip button at the middle of the Toolbar.

>> Choose Edit > Insert/Overwrite Action > Overwrite.

>> Press F10.

	 The selected clip(s) are overwritten to the selected track at the position of the playhead, 
and the playhead automatically moves to the end of the newly edited clip, ready for you to 
perform another edit. If that clip is the last one on the Timeline, you’ll see the last frame to the 
left of the playhead instead of the black that is the actual frame after that clip to make it easier 
for you to line up the next edit. Otherwise, the playhead will show whatever frame happens 
to be at that point in time.

4. 	 Open the next clip you want to edit into the viewer, set In and Out points, and use the Overwrite 
Clip button or command to edit it into the Timeline. Continue this process until you’ve edited 
together the assembly of edits you want.
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Three-point editing is a standard editorial method that’s shared with many other postproduction 
applications, so this procedure should feel familiar. The idea is that you need only set any 
combination of three In and Out points in the source clip and Timeline to edit a clip into your 
program at a specific time. Three-point editing is most commonly accomplished using Overwrite 
and Place-On-Top edits.

In the previous example of assembling a simple sequence of clips, three point editing was being used 
by virtue of source In and Out points being set to define a range of the source clip to be edited into the 
Timeline, and the Timeline playhead being used as the acting Timeline In point; three points defined the 
edit to be made. However, three point editing is also very useful when you need to overwrite sections 
of a previously edited timeline with new source clips in a controlled manner, such as when adding an 
insert shot to a scene to cover a particular change you’re making that would break continuity.

Depending on the combination of Source and Timeline In and Out points you set, the following 
rules govern three-point editing:

>> If there is no In point in the source clip: The first frame of media will be used as the acting 
source In point.

>> If there is no Out point in the source clip: The last frame of media will used as the acting 
source Out point.

>> If there are no In or Out points in the Timeline: The playhead will be used as the acting 
Timeline In point.

>> If you set a Timeline In point but no Timeline Out point: The whole range from the In to Out 
points of the source clip is edited into the Timeline such that the Source In point is aligned 
with the Timeline In point.

>> If you set a Timeline Out point but no Timeline In point: The incoming source clip will be 
backtimed so the Out point of the source clip is aligned with the Timeline Out point.

>> If you set Timeline In and Out points but only a Source Out point: In this case, the incoming 
source clip will also be backtimed so the Out point of the source clip is aligned with the 
Timeline Out point, with the Timeline edit points defining the duration of the source clip 
being edited.

>> If you set all four Source In and Out and Timeline In and Out edit points: The Timeline edit 
points dictate the duration of source clip that is edited into the Timeline, and the frame at 
the Source In point is aligned with the Timeline In point.

Tip: If you want to use all four Source and Timeline edit points to retime a source clip to fit into a 
specific range of the Timeline, use a Fit-to-Fill edit instead of an Overwrite edit.

The following sections provide common examples of three-point editing when performing edits in 
the middle of a previously edited timeline.

Three-Point Editing
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Editing Rules for Split In and Out Points

If you’ve created split In and Out points in the Source Viewer or Timeline, the following rules apply:

>> If the Source Viewer has split In and Out Points: The leftmost split point of the incoming clip, 
whether video or audio, will be aligned with the playhead when the clip is edited; the other 
split point will be offset to the right.

>> If the Timeline has split In and Out Points: The In point of the incoming clip will be aligned 
with the left-most split point, whether video or audio; the accompanying audio or video In 
point will be offset to the split point to the right.

Editing a Specific Range of the Source Clip Into the Timeline

This section provides some common examples of three-point editing when performing edits in the 
middle of a previously edited timeline. In the following example, you have a specific range of source 
media that you need to edit into the Timeline, and you don’t particularly care what gets overwritten 
in the Timeline by the incoming clip.

1.	 Set In and Out points in a source clip, either in the Media Pool or in the Source Viewer.

Setting source clip In and Out points

2.	 To set where you want the incoming clip to go, set the destination control to the tracks you 
want to edit onto, and then do one of the following:

>>Move the Timeline playhead to the frame you want to use as the Timeline In point for the edit.

>> Set a Timeline In point for the edit.
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Setting a Timeline In point

3.	 To make the edit, click the Overwrite Clip button in the toolbar, press the D key, or drag a clip 
onto the appropriate overlay in the Timeline Viewer.

The resulting edit; the duration of the source clip defines the duration of the edit

Editing Part of a Source Clip to Fit Into a Specific Range of the Timeline

In this example, you have a section of a clip or a gap in the edited sequence of clips in the Timeline 
that you want to fill with as much of the current source clip as it will take to “plug the hole.”

1.	 Set an In point in the source clip, if necessary, to define the first frame of the range of source 
media that you want to edit into the Timeline.
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2.	 Set In and Out points in the Timeline to set both where you want the incoming clip to go, and 
how much of the incoming clip you want to use.

Setting both In and Out points of the Timeline for a gap

3.	 To make the edit, click the Overwrite Clip button in the toolbar, press the D key, or drag a clip 
onto the appropriate overlay in the Timeline Viewer.

Setting a source clip In point only



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

248

EDIT6

Backtiming a Source Clip When Editing Into the Timeline

In this last example, you’ve got a specific moment in the second half of a source clip that you need 
to align with an Out point in the Timeline, such that the remaining duration of the incoming clip 
overwrites the edited sequence of clips from the right to the left. This is referred to as backtiming, 
when you’re lining up a Source Out point with a Timeline Out point in order to make an edit, and 
can be set up one of two ways.

Backtiming method one:

1.	 Set In and Out points in the source clip, either in the Media Pool or in the Source Viewer.

2. 	 Set an Out point in the Timeline, at the frame where you want the corresponding Out point of 
the incoming source clip to be aligned.

Setting up a backtimed match-on-action edit via In and Out points in the Source Viewer, and an Out point in the Timeline

The resulting edit; the duration of the Timeline edit points define how much of the source clip is edited
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3.	 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a 
clip onto the appropriate overlay in the Timeline Viewer.

The resulting edit, aligning the Out point of the source clip with the Out point of the Timeline

Backtiming method two:

1.	 Set an Out point in the source clip, either in the Media Pool or in the Source Viewer.

2.	 Set In and Out points in the Timeline to set both where you want the incoming clip to go, and 
how much of the incoming clip you want to use

3.	 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a 
clip onto the appropriate overlay in the Timeline Viewer.

Backtiming method two:

1.	 Set an Out point in the source clip, either in the Media Pool or in the Source Viewer.

2.	 Set In and Out points in the Timeline to set both where you want the incoming clip to go, and 
how much of the incoming clip you want to use.

Setting up a backtimed edit by setting an Out point in the Source Viewer, and In and Out points  

in the Timeline to define the duration of the edit
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3.	 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a 
clip onto the appropriate overlay in the Timeline Viewer.

The resulting edit, aligning the Out point of the source clip with the Out point of the Timeline
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This section covers the different types of edits that are available for cutting source clips into the 
currently open Timeline.

Overwrite Edits

The most common type of edit you’ll make, an overwrite edit eliminates whatever media was in the 
Timeline previously with the incoming source clip taking the place of whatever was there. Overwrite 
edits are commonly used when initially assembling clips, or doing three-point editing.

Overwrite edits do not ripple the Timeline.

To overwrite one or more clips in the Timeline:

1.	 Move the playhead to the frame of the Timeline where you want to insert a clip.

2.	 Click the appropriate audio and video destination controls of the tracks you want to edit the 
incoming source clip onto. If necessary, create new tracks.

3.	 Select a single clip in the Media Pool to open it into the Source Viewer, then set In and Out 
points to define the range of media you want to insert.

4.	 To make the edit, click the Overwrite Clip button in the toolbar, press the F10 key, or drag a 
clip onto either the Overwrite overlay in the Timeline Viewer, or onto any area of the Timeline 
Viewer outside the editing overlays.

The selected clips in the Media Pool are overwrite edited to the selected track starting at the 
position of the playhead, eliminating whatever was there originally while adding incoming clip. No 
other clips are rippled during this operation.

Different Types of Edits

Before and after an overwrite edit, the Timeline duration stays the same
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Insert Edits

An insert edit splits whatever media is already in the Timeline at the position of the playhead, and 
pushes that media to the right to make room for the incoming clip.

Insert edits have the effect of rippling almost all clips in the Timeline that are to the right of the 
Insert Edit point you’re making, pushing them further to the right by the duration of the incoming 
source clip. However, clips in any tracks of the Timeline that overlap to the left of the Insert Edit 
point aren’t rippled, and remain in place.

For example, if you’re insert editing a clip into the middle of a sequence of clips in track V1 and A1 
of the Timeline, and there’s also a clip of music edited into track A2 that overlaps well to the left of 
the insert edit point, the music clip remains where it is, but the other clips on track V1 and A1 that 
are to the right of your edit point on are pushed to the right.

To insert edit one or more clips into the Timeline:

1.	 Move the playhead to the frame of the Timeline where you want to insert a clip.

2.	 Click the appropriate audio and video destination controls of the tracks you want to edit the 
incoming source clip onto. If necessary, create new tracks.

3.	 If necessary, set In and Out points in the clip or clips you want to insert edit into the Timeline 
using the controls of the Media Pool or the Source Viewer.	

4.	 Do one of the following:

>> Select one or more clips in the Media Pool, right-click one of the selected clips, and choose 
“Insert Selected Clips to Timeline.” 

>>Open a clip into the Source Viewer, set In and Out points to define the range of media you 
want to insert, and then click the Insert Edit button in the toolbar, press the F9 key, or drag 
any clip onto the Insert overlay in the Timeline Viewer.

	 The selected clips are insert edited to the selected track at the position of the playhead, 
pushing all other media in the destination track back by the total duration of the selected 
clips, except for clips on other tracks that overlap to the left of the edit point (as seen by the 
overlapping music clip in the example below).
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Replace Edits

A replace edit automatically replaces a clip in the Timeline with a clip in the Source Viewer, using the 
duration of the Timeline clip to define the duration of the incoming media, and the positions of the 
Viewer and Timeline playheads to line up how the incoming media should be placed.

You can also use a replace edit to edit a clip into an empty track of the Timeline so that the frame 
at the position of the Source playhead is aligned with the Timeline playhead, and the In and Out 
points of the incoming clip fall where they may. This is useful when you want to “spot” a particular 
action of an alternate take or a cue in a sound effect to a specific frame of the Timeline.

Replace edits do not ripple the Timeline.

To replace a clip in the Timeline:

1.	 Move the playhead in the Timeline to the clip that you want to replace, and align it with a frame 
that you want to line up with a frame in the clip you want to replace edit into the Timeline.

2. 	 Click the appropriate audio and video destination controls of the track containing the clip you 
want to replace.

3. 	 Open a clip into the Source Viewer.

4. 	 Move the playhead in the Source Viewer to the frame that you want to line up with the frame 
at the position of the playhead in the Timeline.

Before and after an overwrite edit, the Timeline gets longer as non-overlapping clips to the left of the edit point are 

pushed to the right
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5.	 Click the Replace Clip button, press F11, or drag any clip onto the Replace overlay in the 
Timeline Viewer.

	 The clip in the Timeline is now replaced with the clip from the Media Pool, with the source 
frame at the Source Viewer playhead aligned with the frame at the Timeline playhead.

Move the playhead over the clip you need to replace, and position the Source Viewer playhead on the matching frame

The resulting replace edit



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

255

EDIT6

Fit to Fill

Fit-to-fill edits are the only edit type that actually use all four edit points, and it’s the only edit 
type that retimes clips at the same time as they’re being edited. By setting In and Out points in 
the incoming source clip, and another pair of In and Out points in the Timeline, you can stretch or 
compress the timing of the specified range of source media to cover the entire specified range of 
the Timeline. In the process, the speed ratio of the clip changes so the clip plays in either fast or 
slow motion.

Fit-to-fill edits are especially valuable when you have a source clip in which the action is slightly slow, 
and you just want to speed it up by squeezing it into a shorter duration of the Timeline. They’re also 
incredibly handy in situations when you have a gap in an edited sequence of clips to fill with a source 
clip that’s just not long enough, but in which slightly slower motion won’t be noticeable.

Fit-to-fill edits do not ripple the Timeline.

To use Fit-to-fill to edit a clip into the Timeline:

1.	 Set both In and Out points in the Timeline to define the duration you want to fill with the 
incoming source clip.

Setting timeline In and Out points to mark a gap
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2.	 Set In and Out points in a longer or shorter source clip that you want to fill into the 
available space. 

3.	 Click the audio and video destination controls of the tracks you want to edit the incoming 
source clip onto. If necessary, create new tracks. 

4.	 Drag any clip onto the Fit-to-Fill overlay in the Timeline Viewer, or press Shift-F11.

	 The incoming source clip is retimed, if necessary, to fit into the specified duration of the Timeline.

Setting In and Out points in a source clip to define a shorter duration

The resulting edit; the shorter source clip is retimed to fit into the longer timeline gap
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Place On Top

Place-on-top edits automatically superimpose clips onto the first empty track above any other clips 
in the Timeline that either intersect the playhead or fall in between the currently set Timeline In 
and Out points, regardless of the current track specified by the destination controls. It’s designed 
to make it easy to superimpose titles and other clips you want to composite over another clip, or to 
add additional versions of clips such as VFX on top of previous versions that you want to preserve.

Place-on-top edits create new timeline tracks if necessary, and do not ripple the Timeline.

To use Place-on-top to edit a clip into the Timeline:

1.	 To choose where in the Timeline the clip will be “placed on top,” do one of the following:

	 Move the playhead to intersect the clip you want to edit the incoming source clip on top of.

	 Set In and Out points in the Timeline to define the duration within which you want to place the 
incoming source on top.

2. 	 Set In and Out points in a source clip that you want to edit.

3. 	 Drag any clip onto the Place-on-Top overlay in the Timeline Viewer, or press F12.

>> Incoming video clips will be edited to the topmost video track so they are above any 
previously existing video in the Timeline. Incoming audio clips are edited to the bottom-
most audio track so they are below any previously existing audio. If necessary, new video 
and/or audio tracks will be created automatically to hold the new incoming clip.

Before and after using Place on top
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Append at End

Append at End always puts the edited clip at the very end of the current Timeline. It’s a very useful 
edit type when you’re quickly stringing together a series of clips.

To use Append at End to edit a clip into the Timeline:

1.	 Set In and Out points in a source clip that you want to add to the end of the current Timeline.

2. 	 Click the audio and video destination controls of the tracks you want to edit the incoming 
source clip onto. If necessary, create new tracks.

3. 	 Choose Edit > Append at End, or press Shift-F12.

	 Incoming video clips are added after the very end of the last clip in the Timeline.
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Match frame operations are a terrific time saver when you need to match the original source clip to 
a clip in the Timeline, or when you want to use a clip in the Source Viewer to find that same clip in 
the Timeline. With a single command, you can match one clip to another in order to set up a new 
edit to take care of a variety of tasks.

Matching From the Timeline

A classic example of using Match Frame is when you originally edited a video clip into the Timeline 
without its corresponding audio, and you later decide you want that audio in the Timeline after all. 
An easy fix is to move the playhead in the Timeline to intersect the clip you need to fix, and use 
the Match Frame command to automatically load the original source media for that clip into the 
Source Viewer, setting Source In and Out points that match those of the Timeline clip, and putting 
the Source playhead at the same frame as the Timeline playhead. At that point, you can simply edit 
the source audio and video back into the Timeline to overwrite the video-only clip you started with, 
confident that you’re editing exactly the same range of media at the same place.

To use Match Frame in the Timeline to find a source clip:

1.	 Move the Timeline playhead to intersect the clip you want to target.

2.	 If there are other clips on a multi-track timeline that overlap the clip you’re targeting for this 
operation, then the clip on the lowest video track will be used as the target for Match Frame 
operations. If you want to target a clip on a higher track, then either disable the Auto Selection 
controls of all timelines underneath, or Option-Click the Auto Selection control of the track 
with the clip you’re targeting to solo it. (More information on using the Auto Selection controls 
of the Timeline appears later in this chapter.)

Placing the playhead over a clip to match frame

Match Frame Operations
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3.	 Do one of the following:

>> Hold the Option key down and double-click the clip in the Timeline.

>> Click the Match Frame button at the bottom right of the Timeline Viewer (it’s at the left of 
the In and Out buttons).

>> Press the F key.

	 The original source media for that clip is automatically loaded into the Source Viewer, with In 
and Out points that match those of the targeted Timeline clip; the Source playhead is at the 
same frame as the Timeline playhead.

Matching From a Source Clip

Match Frame also works in the opposite direction. You can open a source clip into the Source 
Viewer that you know corresponds to a clip in the Timeline, and then you can use Match Frame to 
automatically find the next clip in the Timeline with media found within the source clip.

To use Match Frame in the Source Viewer to find a clip in the Timeline:

1.	 Open a clip in the Source Viewer that includes a range of media that’s already been edited 
into the Timeline. If no part of the source clip has been edited into the Timeline, source match 
framing won’t work.

2. 	 Move the Source Viewer playhead to a frame that you want to find in the Timeline. Again, if the 
frame at the position of the playhead in the Source Viewer hasn’t already been edited into the 
Timeline, the Source Match Frame command won’t work.

3. 	 Click the Match Frame button at the bottom right of the Source Viewer (it’s at the left of the In 
and Out buttons), or press the F key.

Placing the playhead over a clip to match frame
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	 The Timeline playhead automatically moves to the clip and frame after the current playhead 
position that matches the clip in the Source Viewer.

Locating Source Viewer or Timeline Clips in the Media Pool

There are two ways you can locate the original clips in the Media Pool using corresponding clips 
that you’re working with:

>> Press Option-F to locate a clip that’s open in the Source Viewer in the Media Pool. That clip 
appears highlighted in the Media Pool.

>> To locate a Timeline clip’s corresponding clip in the Media Pool, right-click any clip in the 
Timeline, and choose Find in Media Pool. That clip appears highlighted in the Media Pool.
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Once you’ve assembled a group of clips in the Timeline, you’ll probably need to manipulate them 
further, moving, deleting, trimming, and otherwise adjusting the clips in the Timeline to make the 
edit play with the pacing and verve you require.

Selecting Clips in the Timeline

Many operations require you to make a selection first, to define the scope of what you’re about to 
do. There are many ways to do so.

Selections you can make using the mouse:

>> To select one clip: Click a clip with the mouse. 

>> To select a continuous range of clips: Drag a bounding box from an empty area of the 
Timeline to surround a group of clips. 

>> To select a discontinuous range of clips: Command-click any clips to select them no matter 
where they appear on the Timeline.

Selecting a continuous range of clips in the Timeline

Selecting a discontinuous range of clips in the Timeline

Selecting and Deleting Clips in the Timeline
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Selecting clips using the keyboard or menu commands:

>> To select one clip: Using the keyboard, make sure the Auto Select button for the track the 
clip is on is enabled, then move the playhead over that clip and press Shift-V.

>> To select all clips forward on the current track: Move the playhead to the first clip you want 
to include in the selection, then press the Y key (Edit > Select Clips Forward On This Track) 
to select that clip and every clip to its right in the same track of the Timeline.

>> To select all clips forward of the playhead on all tracks: Move the playhead to the first clip 
you want to include in the selection, then press Option-Y (Edit > Select Clips Forward On 
All Tracks) to select that clip and every clip to its right in all tracks of the Timeline.

>> To select all clips backward on the current track: Move the playhead to the last clip you 
want to include in the selection, then choose Edit > Select Clips Backward On This Track to 
select that clip and every clip to its left in the same track of the Timeline. By default, there’s 
no keyboard shortcut for this command, but you can assign one.

>> To select all clips backward of the playhead on all tracks: Move the playhead to the last 
clip you want to include in the selection, then choose Edit > Select Clips Backward On All 
Tracks to select that clip and every clip to its left in all tracks of the Timeline. By default, 
there’s no keyboard shortcut for this command, but you can assign one.

>> To select all clips in the Timeline: Make sure the Timeline has focus, then press Command-A.

To change which clip is selected using the keyboard:

>> Select a clip, then use the Left Arrow and Right Arrow keys to change the selection to the 
previous or next clip among all tracks with Auto Select turned on.

To deselect all clips:

>> Using the mouse: Click in any empty area of the Timeline.

>> Using the keyboard: Press Shift-Command-A.

Using the Timeline Auto Select Controls to Define Selections

The Timeline Auto Select controls give you a way of specifying which tracks will be either affected 
or considered during operations in which there are multiple superimposed clips on multiple tracks 
of the Timeline. In the easiest example, if you have two superimposed clips, and you want to delete 
the media from only the clip on track V1, you can turn off the Auto Select control for track V2, set 
Timeline In and Out points to define the range of the clip you want to delete, and then when you 
press the Delete key, only the media on the Auto Select-enabled track is deleted.
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Another type of operation affected by Auto Select is when using the Mark Clip command, again on 
a section of the Timeline where there are multiple superimposed clips, each of which has a different 
duration. Ordinarily, the first and last frames of the clip on the lowest track is used to set Timeline In 
and Out points when using Mark Clip. 

However, if you disable the Auto Select control of track V1, then whichever clip is on the lowest 
video track with Auto Select still enabled is used as the target clip for the Mark Clip operation. In 
this example, the shorter clip on track V2 now sets the locations of the In and Out points.

Methods of enabling and disabling the Auto Select controls:

>> To toggle Auto Select for any track: Click any track’s Auto Select control.

>> To toggle Auto Select for video tracks: Press Option-F1 through F8 to toggle Auto Select 
for tracks V1 through V8. 

>> To toggle Auto Select for all video tracks off and on: Press Option-8.

Using Mark Clip with all Auto Select controls enabled

Using Mark Clip with all Auto Select controls enabled
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>> To toggle Auto Select for audio tracks 1-9: Press Option-Command-F1 through F8. 

>> To toggle all video track Auto Select tracks off and on: Press Option-F9.

>> To toggle all audio track Auto Select tracks off and on: Press Option-Command-F9.

>> To “solo” Auto Select for a track and disable Auto Select on all other tracks: Option-click 
any Auto Select control to leave that control on while turning off all other Auto Select 
controls of that type (video or audio).

>> To turn all audio or video Auto Select controls on and off: Shift-click any video or audio 
Auto Select control to toggle on or off all Auto Select controls of that type (video or audio).

The following operations are affected by the state of each track’s Auto Select control:

>> Deleting clips: When using Timeline In and Out points to delete a range of media from the 
Timeline, only media on tracks with an enabled Auto Select control will be deleted.

>> Deleting gaps: When selecting and deleting gaps in the Timeline, clips on other tracks 
that overlap the selected gap will also be deleted on tracks with an enabled Auto Select 
control. Media to the right of affected tracks will ripple left to close the gap.

>> Selecting clips using the keyboard: When a clip is selected, you can press the Up Arrow 
and Down Arrow keys to move the selection from clip to edit clip, but clips on tracks with a 
disabled Auto Select control are not seen by this operation.

>> Using Mark Clip: When making a Mark Clip operation, clips on tracks with disabled Auto 
Select controls are ignored. This lets you choose a target clip when there are multiple 
overlapping superimposed clips.

>>Match Frame: When making a Match Frame operation, clips on tracks with disabled Auto 
Select controls are ignored. This lets you choose a target clip when there are multiple 
overlapping superimposed clips.

>> Rippling the Timeline: Tracks with Auto Select turned off will not be rippled. More 
information on the rules of ripple trimming appear later in this chapter.

>> Pasting clips: All copied clips will be pasted to the lowest numbered track with Source 
Control enabled.

>> Finding gaps: When using Playback > Previous Gap or Next Gap, gaps on tracks with Auto 
Select disabled will be ignored.
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Deleting Clips From the Timeline

There are two ways you can delete clips you don’t want in the Timeline. Using the Delete key, 
you can perform what’s sometimes called a “lift edit,” removing the unwanted clips and leaving a 
gap. Using the Forward Delete key, you can perform a “ripple delete,” removing unwanted clips 
and closing the gap by rippling the rest of the edited Timeline to the right of the deleted clip/s by 
moving it to the left.

Deleting clips as a “lift edit” operation:

>> To remove one or more clips from the Timeline, leaving a gap: Select a clip in the Timeline, 
or Shift-click or Command-click to select the clips you want to remove, and press the Delete 
key (or right-click the selection and choose Delete).

>> To remove a range of media from the Timeline on multiple tracks, leaving a gap: Set Timeline 
In and Out points defining the range of media you want to delete, then turn off the Auto 
Select controls of any tracks with media you want to preserve, and press the Delete key (or 
right-click the selection and choose Delete).

Deleting a range of clips and leaving a gap
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Deleting clips as a “ripple delete” operation:

>> To delete one or more clips and close the gap by rippling the Timeline left: Select a clip in 
the Timeline, or Shift-click or Command-click to select the clips you want to remove, and 
press the Forward Delete key.

>> To delete a range of media and close the gap by rippling the Timeline left: Set Timeline In 
and Out points defining the range of media you want to delete, then turn off the Auto Select 
controls of any tracks with media you want to preserve, and press the Forward Delete key.

As with any ripple operation, any clips that overlap the affected range of media to the left 
are unaffected.

Deleting a range of clips and rippling the Timeline to close the gap
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Finding, Selecting, and Deleting Gaps in the Timeline

A gap is defined as a space between any two clips on the same track. Often gaps are desirable as 
they allow audio or video clips to be spaced apart from one another very specifically, but sometimes 
they’re not. If you want to find accidental gaps in your timeline that may be too small to see, a pair 
of commands lets you do this.

To move the playhead to the next gap on the Timeline:

1.	 Turn off the Auto Select controls of any tracks you want to omit from this operation.

2.	 Do one of the following:

>> Choose Playback > Previous Gap, or press Option-Command-Semicolon (;) to move the 
playhead to the next gap to the left of the playhead’s current position.

>> Choose Playback > Next Gap, or press Option-Command-Apostrophe (‘) to move the 
playhead to the next gap to the right of the playhead’s current position.

To select or deselect a gap:

>> Click once to select a gap, and click that gap again to deselect it.

You can only select one gap at a time. The principal reason to select gap is to delete it, in the 
process rippling the Timeline to close the gap. In the following example, there’s a gap between two 
clips on track V1 that you’d like to close.

Selecting a gap On Track V1

To delete a gap:

>> Press the Delete key to close the gap.,All clips to the right of it on tracks with Auto Select 
enabled will be rippled to the left to close the gap. Clips on tracks with Auto Select disabled 
will not ripple.
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If you select a gap in a timeline with clips on multiple tracks, which clips will be deleted depends on 
the state of the Auto Select controls for each track in the Timeline.

>> All tracks with Auto Select enabled: The range of media that overlaps the selected gap will 
also be deleted. Clips on those tracks will ripple left to fill the gap.

>> All tracks with Auto Select disabled: The range of media that overlaps the selected gap will 
be left intact, and clips on those tracks will not ripple left, going out of sync with whichever 
clips do ripple.

Trimming Gaps

The start and end of gaps can also be rippled using the Trim tool. For more information, see “Using 
Trim Mode and the Trim Tool” later in this chapter.

Selecting Edits in the Timeline

A variety of trimming methods require you to select an edit point, or part of an edit point, in order 
to resize, ripple, or roll an edit. You can do so using the mouse, or using the keyboard.

Methods for selecting edit points using the mouse:

>> To select an edit to roll: Move the mouse to the center of an edit point, and when the ripple 
cursor appears, click to select the edit.

>> To select just the incoming or outgoing half of an edit point to resize or ripple: Move the 
mouse to the left or right of the center of an edit, and when the resize/ripple cursor appears, 
click to select that portion of the edit.

Selecting an edit point to roll
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To select multiple edit points, do one of the following:

>> Command-click multiple edit points, up to one per track.

>> Click to select the Trim tool (T), and drag a bounding-box over the edit points you want to 
select, up to one per track.

There are also a flexible set of keyboard shortcuts that make it easy to select edit points in 
preparation for various operations if you like to avoid using the mouse.

Keyboard shortcuts for selecting edits:

>> V: Selects the nearest edit point to the playhead on the lowest track with Auto Select enabled.

>> U: Once you’ve selected an edit point, this shortcut toggles among selecting the outgoing 
half, incoming half, or the entire edit.

>>Option-U: Once you’ve selected an edit point, this shortcut toggles among selecting the 
video+audio of the edit, just the video, or just the audio.

To move the selection to another edit

>> Select an edit point, then use the Left Arrow and Right Arrow keys to change the selection 
to the previous or next edit point among all tracks with Auto Select turned on.

To deselect all edit points:

>> Using the mouse: Click in any empty area of the Timeline.

>> Using the keyboard: Press Shift-Command-A.

Here’s an example of how you would use these keyboard shortcuts together as a sequence of 
operations. To turn Audio/Video Linking off and on:

Selecting incoming or outgoing halves of an edit point to resize or ripple
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To select an edit point using the keyboard:

1.	 Move the Timeline playhead close to the edit point you want to select using the JKL keys.

2.	 Press the V key to select the nearest edit point to the playhead on the lowest track with Auto 
Select enabled. If there are overlapping superimposed clips on multiple tracks, turn off the 
Auto Select controls of tracks with edits you don’t want to select using Option-F1 through 
Option-F9 corresponding to the auto select controls on tracks 1-9. Using the mouse, you can 
solo a track’s Auto Select state by Option-clicking its Auto Select button.

3.	 Initially, the entire edit is selected, in preparation for a roll edit. To toggle among selecting the 
outgoing half, incoming half, and the entire edit, press the U key.

4.	 To toggle among selecting the video+audio of the edit, just the video, or just the audio, 
press Option-U.

5.	 Perform whatever operation you need to. When you’re finished, using Up-Arrow or Down-
Arrow to move the selection backward or forward in the Timeline, or press Command-Shift-A 
to deselect it.

Linking and Unlinking Audio and Video

While selecting edits and clips, you can also choose whether the video and audio associated with a 
clip should be selected together (linked) or not. This determines whether operations performed to 
the video of a clip automatically affect the audio of the clip, and vice versa. In most instances, you’ll 
probably want to leave Audio/Video Linking turned on, so that selecting the video of a clip to move 
it elsewhere in the Timeline also results in the audio being selected and moved at the same time. 
Disabling A/V linking in this case could cause your video and audio to go out of sync undesirably.

However, there are plenty of instances when you’ll want to temporarily suspend this linked A/V 
relationship, such as when you want to create a split edit, where a clip’s audio In point is at a different 
frame then the video In point. In this case, you can suspend Audio/Video Linking to select just the 
audio In point, then roll it either further back or forward to create the split, without changing the In 
point of that clip’s video. When you’re finished, you can re-enable A/V linking.

At all times, the state of Audio/Video Linking is visible via the chain-link button at the right of 
the toolbar.

The Audio/Video Linking button
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To turn Audio/Video Linking off and on:

>> Click the Link Audio/Video button (or press Shift-Command-L).

To temporarily suspend Audio/Video Linking while making a selection:

>> Press the Option key while clicking a clip or edit point to select the video without selecting 
the audio, or vice versa.

Methods of permanently changing Audio/Video Linking in the Timeline:

>> To unlink audio and video from one another: Select a clip, then right-click it and choose Link 
from the contextual menu (or press Command-L). Unlinked clips do not appear with a dot 
before the clip name in the Timeline.

>> To link audio and video clips to one another: Command-click an audio clip and a video 
clip so they’re both selected, then right-click the selected clips and choose Link from the 
contextual menu (or press Command-L). A dot appears before the name of linked clips in 
the Timeline.

Dealing with Audio Video Sync Offsets

Audio/Video sync is one of the most important things to maintain in any edited program. However, 
there are times when you may want to override the sync relationship of a clip’s audio and video to 
make a particular edit, so moving a clip’s audio and video out of sync is allowed.

If you disable Audio/Video Linking and then move the audio or video of a clip independently of its 
linked video or audio counterpart, you’ll see red windows overlapping the clip names that display 
the timecode offset by which the audio and video of that clip are out of sync. In the following 
example, the audio and video of a clip have been moved out of sync by Option-clicking the video 
and dragging it to the right.

Left - linked video and audio with a dot to the left of the name, Right - unlinked audio and video has no dot
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Commands for Slipping Sync

A set of commands in the Slip Audio/Eye submenu of the Edit menu let you alter the sync between 
the audio and video of any clip.

>> Slip Audio One Frame Forward

>> Slip Audio One Frame Reverse

Locking Tracks

Another step you can take to prepare before an edit is to lock tracks with media that you don’t 
want to be affected by operations you’re about to perform. For example, if you have a complex 
set of music edits on track A3 that you don’t want to be affected by operations that will ripple the 
Timeline, you can lock track A3 so those clips remain unaffected.

Clips on locked tracks cannot be moved, deleted, cut, or otherwise affected by editorial operations. 
Furthermore, parameters of locked clips cannot be edited in the Inspector. However, clips on locked 
tracks can be graded and otherwise modified in the Color page.

To toggle the lock or unlock state of tracks, do one of the following:

>> Click any track’s lock control.

>> Press Option-Shift-1 through 8 to lock or unlock tracks V1 through V8.

>> Press Option-Shift-9 to lock or unlock all video tracks.

>> Press Option-Shift-F1 though F8 to lock or unlock tracks A1 through A8.

>> Press Option-Shift-8 to lock or unlock all audio tracks.

Sync markers on a clip with audio and video out of sync
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After editing a series of clips into a timeline, the next thing even the most careful of editors probably 
needs to do is to start making changes. The simplest changes are made in Normal Edit Mode, using 
the regular arrow pointer. 

This is the default mode when you open Resolve, and allows you to move clips to other places in the 
Timeline, resize them to make them longer or shorter, and roll the edit points between two clips to 
move the edit to happen earlier or later.

Manipulating clips using the mouse:

1.	 Click the ”Normal Edit Mode” tool (the arrow).

2.	 Do one of the following:

>> To move clips in the Timeline: Drag any clip in the Timeline to any other position. If you drag 
a clip to overlap another clip, the clip you’re dragging overwrites the clip you’re 
dropping it onto.

Moving a clip in the Timeline to overwrite part of another clip; a tooltip shows you how many frames you’ve moved

The Normal Edit mode button at left, the Trim mode button at right

Moving and Trimming Clips in Selection Mode
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>> To move clips in the Timeline up or down to other tracks while keeping them at the same 
time: Hold the Shift key down while dragging clips up or down in the Timeline.

>> To shorten or lengthen clips: Move the Normal Edit Mode pointer over the beginning or 
end of a clip, and when it turns into the Resize cursor, drag the In or Out point to the left or 
right to change the clip’s length. 

>> To roll any edit: Move the Normal Edit Mode pointer over any edit point, and when it turns 
into the Roll Edit cursor, drag it to the left or right to move the edit point while simultaneously 
resizing the outgoing and incoming edits points of the two clips surrounding it.

Resizing a clip in the Timeline to create a gap; a tooltip shows the offset, and outlines show you how much media 

is available in the clip being adjusted

Rolling an edit; a tooltip shows the offset, and an outline shows the available area you can roll within
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Manipulating clips using the keyboard:

1.	 Press A to choose ”Selection Mode.”

2.	 Do one of the following:

>> To roll any edit: Select the closest edit point to the playhead using the V key, moving the 
selection to another edit if necessary using the Left Arrow and Right Arrow keys, and then 
press the Comma key (nudge 1 frame left) or Period key (nudge 1 frame right) to roll the 
selected edit to the left or right. Shift-Comma and Shift-Period nudges by 10 frames.

>> To shorten or lengthen clips: Select the closest edit point to the playhead using the V key, 
then use the U key to toggle the selection among the end of the outgoing clip and the 
beginning of the incoming clip. Then, press the Comma key (nudge 1 frame left) or Period 
key (nudge 1 frame right) to shorten or lengthen that side of the clip. If you nudge one 
end of a clip to overlap another, the clip you’re nudging overwrites the adjacent clip. Shift-
Comma and Shift-Period nudges by 10 frames.

>> To move clips forward or back in the Timeline: To select a clip in preparation for moving 
it, either click it, or move the playhead over it and press Shift-V. Then press the comma 
(nudge 1 frame left) or period (nudge 1 frame right) to move the clip to the left or right. If 
you nudge a clip to overlap another clip, the clip you’re nudging overwrites the adjacent 
clip. Shift-Comma and Shift-Period nudges by 10 frames.

>> To move clips up or down to other tracks: To select a clip in preparation for moving it, either 
click it, or move the playhead over it and press Shift-V. Then, press Option-Up Arrow to 
move the Video and Audio of that clip to the next higher-numbered track, or press Option-
Down Arrow to move the Video and Audio to the next lower-numbered track.

Trimming Clips in the Source Viewer Using the Selection Tool

You can also double-click a clip in the Timeline to open it into the Source Viewer for trimming. When 
the Selection Tool is selected, you can drag the In and Out markers, or use the playhead and I and 
O keyboard shortcuts to resize that clip in the Timeline.
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A Timeline clip being resized by opening it in the Source Viewer and dragging its In point

Additionally, you can open timeline clips into the Source Viewer for trimming using the Trim tool, 
dragging to ripple the In and Out points, and slipping the contents of the clip by holding the Shift 
key down and dragging the In and Out points.

Note: To open a match frame of a clip in the Timeline using the mouse as in previous versions of 
Resolve, hold the Option key down while double-clicking a clip.
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Swap Edits and Swap Inserts

A swap edit lets you rearrange clips in the Timeline by dragging them to the left or right within an 
edited sequence of other clips, and the surrounding clips automatically move to the right or left to 
switch places with the clip you’re dragging.

To swap edit one clip adjacent clips in the Timeline:

>> Select the clip you want to swap, then press and hold the Command and Shift keys down 
and drag the selected clip to the left or right. Adjacent clips will automatically switch places 
with the clip you’re dragging, until you drop it in the desired location.

A clip being swapped with adjacent clips in a scene in order to rearrange the sequence

To swap insert one clip into adjacent clips in the Timeline:

>> Select the clip you want to swap, then press and hold Command and Option keys down 
and drag the selected clip to the left or right. The clip you’re dragging will be inserted in 
the middle of adjacent clips as you drag, with the cut portion of each clip being moved 
into the gap left behind by the clip you’re dragging. Drop the clip into the desired location 
when you’re finished.
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A clip being inserted into the middle of adjacent clips; the split part of each clip is swapped  

with the inserted clip’s former location in order to rearrange the sequence

Splitting and Joining Clips

In many situations you may find yourself splitting clips in order to separate multiple clips that were 
inadvertently baked together, or to cut up clips into sections that you’re planning on applying 
different effects to or grading differently.

Methods of splitting and joining clips:

>> To split a clip once: Drag the playhead to the frame where you want to split a clip, and press 
Command-Backslash (\) to split every clip on a track with Auto Select enabled.

>> To split many clips: Click the Razor Edit mode button (or press B), and then click clips in the 
Timeline to split as many clips as you want.

>> To split clips using the DaVinci control surface on the Color Page: Move the playhead to the 
frame you want to split, then press SHIFT UP and SPLIT/UNDO on the T-bar panel.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

280

EDIT6

>> To join clips using the DaVinci control surface on the Color Page: Move the playhead to the 
edit point you want to join, and press SHIFT UP and JOIN/REDO on the T-bar panel. Both 
clips must be from the same media file, and the frames to either side of the edit point need 
to be continuous for those clips to be joined.

When you split a clip, a through edit appears to show that you currently have an edit with continuous 
timecode running from the outgoing to the incoming half. This is called a through edit, and is 
displayed with a dotted line running along its edge so you know that it’s special.

To eliminate a through edit:

>> Select it in the Timeline, and press Delete.

Note: You can show an isolated list of every through edit in the Timeline by opening the Edit Index 
and choosing “Show Through Edits Only” in the Edit Index Option menu. Clicking any item in 
the list jumps the playhead to that through edit, making it easy to check all the through edits in a 
timeline to see if they’re necessary or not.

Copying and Pasting Clips in the Timeline

Clips can be cut, copied, and pasted using standard keyboard shortcuts. You can cut or copy one 
clip or a selection of several, and you can also choose to copy or cut just the video or audio media 
of a clip. When pasting, you can paste to the same timeline, or to a different timeline if you want to 
move media from one to another.

Methods of doing cut, copy, and paste:

>> To Cut one or more clips, leaving a gap: Make a selection, and press Command-X.

>> To Copy one or more clips: Make a selection, and press Command-C.

A through edit seen in the Timeline
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>> To Paste one or more clips to the same track: Move the playhead to the frame where you 
want the pasted selection to start, Option-click the Auto Select control of the track you 
want to paste the clip(s) to so solo that track, and press Command-V. Pasted clips overwrite 
any clips in that track that are in the way.

If all Auto Select controls are turned on, clips are always pasted back to the same track they were 
copied from, starting at the position of the playhead. However, you can force paste the selection 
to a different track by Option-clicking that track’s Auto Select control to solo it before pasting 
the clip. 

When one or more Auto Select controls are disabled, then clips are pasted to the lowest-numbered 
track with an enabled Auto Select control. If you’ve copied clips on multiple tracks, clips on the 
lowest copied track will be pasted to the lowest Auto Select enabled track, and all other clips will 
be pasted to higher tracks, with new tracks automatically created, if necessary.

If Auto Select is disabled on every single track, then a new track will be created above all other video 
tracks and/or below all other audio tracks, and the clip will be pasted into this new track, which has 
Auto Select turned on.

Copying and pasting audio has one other consideration. If you’re force pasting a clip into a different 
track, the track you solo the Auto Select control of must be capable of holding the type of audio 
clip you’re pasting. Otherwise, the clip will be automatically pasted to the lowest-numbered track 
capable of holding that clip, or a new track will be created if none exist.

Duplicating Clips and Transitions in the Timeline

Clips can also be duplicated by making a selection, and then Option-dragging the selected clips to 
another position and/or track in the Timeline. Individual selected transitions can be duplicated by 
Option-dragging to another edit point. 
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You can call attention to different clips and frames using flags and markers. Generally speaking, 
flags are for calling attention to overall clips of media, while markers are meant to denote specific 
frames for a particular clip. This section describes different ways you can use flags for reference, and 
markers for taking notes and aligning frames together with snapping.

Using Flags

Flags are meant to mark an entire clip, and they also flag every other clip in the Timeline that shares 
the same Media Pool source clip, making this a handy way of quickly identifying which clips in a 
given timeline come from the same Media Pool source.

You can apply multiple flags to clips, with a variety of colors to choose from. In addition to flagging 
specific media files, flags can be useful for timeline filtering in the Color page, sorting by column in 
the Media Pool, and a variety of other operations.

Methods for flagging clips:

>> To flag a clip: Select one or more clips, and either click the Flag button to flag that clip with 
the current color, or click the Flag pop-up in the toolbar to choose a different color and 
then click the Flag button. In the Edit page, flags appear in the Timeline superimposed in 
the name bar of each clip.

>> To remove all flags from a clip: Select one or more clips with flags you want to remove, then 
click the Flag pop-up in the toolbar, and choose the top “Clear All” option.

>> To filter all flagged clips in the Edit Index: Click the Option menu of the Edit Index and 
choose Show Flags. Each flagged clip appears in a list, with a column showing the color(s) 
of the flags applied to each entry in the list.

The Flag and Marker buttons and pop-ups

Flagging and Marking Clips for Reference
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Using Markers

Markers are used to call attention to a particular frame within a specific clip. You can place markers 
on the jog bar of source clips in the Source Viewer (or the Media page Viewer), on clips in a timeline, 
or on the Timeline ruler. 

Markers placed on clips snap to clip In and Out points, edit points, the playhead, and other markers 
whenever snapping is enabled.

Methods of marking clips:

>> To mark a source clip in the Media Pool: You can also add markers to clips in the Media 
Pool, for future reference when editing, by opening a clip in the Source Viewer, moving 
the playhead to the frame you want to mark, and then pressing M. Source clip markers are 
preserved in the Media Pool for future reference.

>> To mark a clip in the Timeline: Select one or more clips you want to mark, and then move 
the playhead to a frame of a selected clip in the Timeline, and click the Marker button 
(or press M) to place a marker at that frame, using the current color. You can also click 
the Marker pop-up to choose a different color, and then click the Marker button. Markers 
appear in the Timeline at the top of the clip to which they’re applied.

>> To remove a single marker: Click to select the marker you want to delete, and press the 
Delete key (or press Option-M).

>> To remove all markers from a clip: Select one or more clips with markers you want to remove, 
then click the Marker pop-up, and choose Clear All.

(Top) Markers placed on a source clip, (Bottom) Markers placed on a clip in the Timeline



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

284

EDIT6

You can also place markers of any color into the Timeline ruler, to denote specific times for  
future reference.

You should note that all markers placed on clips or in the Timeline also appear within the Mini-
Timeline of the Color page, making it easy to place notes for later reference when grading.

Methods of marking the Timeline:

>> To mark the Timeline: Make sure all clips are deselected, then click the Marker button (or 
press M) to place a marker of the currently selected color in the Timeline ruler.

>> To remove a single marker from the Timeline: Move the playhead to the frame of the marker 
you want to remove, and press Shift-M.

>> To remove all marks from the Timeline: With all clips deselected, choose Clear All from the 
marker pop-up menu in the Toolbar.

Using Markers to Navigate

Markers can be used to aid navigation, via two keyboard shortcuts that let you jump the playhead 
from marker to marker. When moving the playhead among markers, clip and timeline markers are 
mixed together.

To move the playhead to the next or previous marker:

>> Press Shift-Up Arrow to move the playhead to the next marker to the left in the Timeline.

>> Press Shift-Down Arrow to move the playhead to the next marker to the right in the Timeline.

You can also use the Edit Index to filter out a list of all markers appearing within the current Timeline. 
Columns expose the notes and colors applied to each marker, making it easy for you to sort 
markers by color, alphabetically by note, or by the source or record timecode of the clip to which 
they’re applied.

Timeline markers placed for future reference
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Methods of working with markers in the Edit Index:

>> To filter all clips with markers in the Edit Index: Click the Option menu of the Edit Index and 
choose Show Markers. Each clip with one or more markers appears in a list, with column 
corresponding to the color(s) and notes of each timeline and clip marker.

>> To move the playhead to the position of a marker in the Edit Index: Click that marker’s entry 
in the list.

>> To show hidden marker columns: Right-click any column, and choose either Color or 
Notes to reveal that column. If necessary, columns can be rearranged by dragging them 
left or right.

Editing and Moving Markers

Markers and Flags can be edited after they’ve been added, and timeline markers can be set to 
optionally ripple to follow along with any ripple trimming done in the Timeline.

Methods of editing markers:

>> To add a note to a marker: Move the playhead to the frame containing the marker you want 
to annotate and press Option-M, or double-click the marker you want to edit, then type 
your note in the text field field within the marker dialog, and click Done.

>> To change a marker’s color: Move the playhead to the frame containing the marker you 
want to annotate and press Option-M, or double-click the marker you want to edit, click the 
button of the color you want to use in the marker dialog, then either click Done.

To enable Marker rippling:

>> Choose Edit > Ripple Timeline Markers. When checked, all markers to the right of a clip 
being ripple edited or ripple deleted will ripple to the left along with the rest of the Timeline. 
You can turn this behavior off and on at will.
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Most editors would agree that trimming is half the job of editing. While you can make many kinds of 
changes in the Timeline using the selection and razor blade tools, there is a dedicated Trim mode 
in which you can perform more sophisticated trim operations in fewer steps using either the mouse 
or keyboard shortcuts, depending on how you like to work. Mastering DaVinci Resolve’s trimming 
operations will save you time when doing the necessary work of fine-tuning your edit.

Trim mode differs from Selection mode in that operations that would move clips with the Selection 
tool will either slip or slide clips with the Trim tool. Other operations that would resize edits with 
the Selection tool instead ripple the Timeline to automatically close gaps when using the Trim tool. 
The following sections describe the various trim operations that are available, both when using the 
mouse, and when using the keyboard. 

To enter Trim Edit mode:

>> Click the Trim Edit button, or press the T key.

Summarizing Trim Operations

Before going into the different methods of trimming that are available, users who are new to editing 
might benefit from a quick summary of what each trimming operation actually does. Each trim 
operation is designed to let you move edits and clips in relation to whichever clips are around them, 
by performing several operations at once. The four primary methods of trimming are:

>> Roll: Moves an edit point to the left or right by either shortening the outgoing clip while 
lengthening the incoming clip, or vice versa. Roll edits do not change the duration of the 
overall Timeline.

>> Ripple: Shortens or lengthens the end of an outgoing clip or the beginning of an incoming 
clip, while simultaneously moving all clips to the right in the Timeline to fill the gap that 
would otherwise occur if you were doing a resize operation. Ripple edits do change the 
duration of the overall Timeline, and can alter the sync relation between different tracks if 
you’re not careful.

>> Slip: Keeps a clip in the same place in the Timeline, while changing the range of media that 
appears in that spot. Slip edits do not change the duration of the overall Timeline.

>> Slide: Keeps a clip’s range of media the same, but moves that clip to the left or right by 
either shortening the outgoing clip to its left while lengthening the incoming clip to its 
right, or vice versa.

Rippling Gap

You can also use the Trim Tool (or other trim operations described later in this chapter) to ripple the 
start and end of a gap in the Timeline. Rippling a gap lets you grow or shrink the gap while moving 
the portion of the Timeline to the right of the gap forward or backward in time.

Using Trim Mode and the Trim Tool
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Using the Trim Tool With the Mouse

When trimming using the mouse, you can perform every kind of trim operation that’s available using 
a single tool, simply by clicking the Trim mode/tool button, and then dragging on the appropriate 
area of a clip in the Timeline.

Methods of trimming with the mouse in Trim Edit mode:

>> To slip a clip: To slip a clip’s range of content without changing its position in the Timeline, 
click the middle top region of a clip, and then drag to the left or right to “slip” the clip to 
contain a different range of frames. A dashed overlay shows the total duration of media 
available for you to slip with, which moves left and right as you drag.

Clicking the top clip area before a slide, an overlay shows the clip’s available range of media

After dragging to slip, clips don’t move, but the slipped clip’s range of media has changed

When slipping clips, a 4-up display shows all relevant outgoing and incoming frames, so you 
can compare the continuity of action from one clip to the next. During a slip, the top two frames 
update to show you the new incoming and outgoing frames of the clip being slipped, relative to 
the unchanging outgoing frame of the clip to the left and incoming frame of the clip to the right.
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>> To slide a clip: To slide a clip, moving it to another position in the Timeline while 
simultaneously adjusting the Out point of the previous clip and the In point of the next 
clip to accommodate the change in position of the current clip being dragged, click the 
bottom-middle name bar of the clip and drag it to another position.

Four-up display when slipping a clip

After dragging to slide, the selected clip is at a new location, surrounding clips filled the gap
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When sliding clips, a 4-up display shows all relevant outgoing and incoming frames, so you can 
compare the continuity of action from one clip to the next. During a silde, the bottom two frames 
update to show you the new outgoing frame of the clip to the left, and the new incoming frame of 
the clip to the right of the clip being slid.

Four-up display when sliding a clip

>> To roll an edit point: To roll an edit, moving the Out point of the outgoing clip and the In 
point of the incoming clip at the same time, drag an edit point between two clips to the left 
or right. (Roll edits can also be done in Normal Edit mode.)

Selected edit point before roll
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When rolling an edit, a 2-up display shows the changing continuity of action from the outgoing 
frame of the clip to the left to the incoming frame of the clip to the right.

Four-up display when rolling an edit

>> Ripple Edit: To ripple the outgoing or incoming part of an edit to add or remove media to 
a clip while simultaneously moving all other clips at the left in the Timeline to make room, 
click the Ripple tool, and drag an edit point to a new position in the Timeline.

Edit point moved further to the right, both adjacent clips resized to prevent gap
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When rippling an edit, a 2-up display shows the continuity of action from the outgoing frame of the 
clip to the left to the incoming frame of the clip to the right. Which frame updates depends on 
which side of the edit you’re rippling.

Four-up display when rippling an edit

Rippled clip is shorter, the rest of the Timeline has moved left to fill the gap

Selected incoming half of an edit point before ripple
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Trim Tool Operations With the Keyboard

You can also perform every trim operation more precisely using the Nudge keyboard shortcuts.

To trim with the keyboard:

1.	 Press T to select the Trim tool. 

2.	 To trim the selection, do one of the following:

>> To slide a clip: Press Shift-V to select a clip, and press the Comma key to slip it one frame to 
the left, or the Period to slip it one frame to the right. Shift-Comma and Shift-Period slips 
the clip in 10 frame increments.

>> To slip a clip: Press Shift-V to select a clip, then press the S key to toggle to Slip mode 
(pressing S again toggles back to Slide mode) and press Comma or Period to slide its 
contents to the left or right. Shift-Option-Comma and Shift-Option-Period slides the 
contents in 10 frame increments.

>> To roll an edit: Press V to select an edit point, then press the Comma key to nudge it one 
frame to the left, or the Period to nudge it one frame to the right. Shift-Comma and Shift-
Period rolls the edit in 10 frame increments.

>> To ripple an edit: Press V to select an edit point, then press U to select either the incoming 
or outgoing side of the edit by itself. Then, press the Comma key to ripple the selected In 
or Out point of the clip to the left, or the Period to ripple it one frame to the right. Shift-
Comma and Shift-Period ripples in 10 frame increments.
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Important Trimming Keyboard Shortcuts

When trimming using the keyboard, the following keyboard shortcuts are important for you 
to remember.

Important: While the Slip, Roll, and Slide tools will change the sync relationship of the clips you’re 
adjusting with a matching soundtrack, the rest of the Timeline won’t be affected. Using the Ripple 
tool can alter the overall sync relationship of large portions of your timeline and its matching 
soundtrack, so you should use it with extreme care in situations when you’re grading a locked edit 
with audio that is being mixed at the same time.

Key Shortcut Function

T Trim mode, ripples edits and slips or slides clips.

A Selection mode, resizes edits and moves clips.

S Toggles between Slip and Slide mode when 
a clip is selected in Trim mode.

V Selects the edit point closest to the playhead, 
and moves the playhead there.

Shift-V

Selects the clip or gap that intersects the playhead, and 
moves the playhead to the center of the clip or gap. If there 

are superimposed clips, turn off the Auto Select controls 
of tracks containing clips you don’t want to select.

Option-F1 through F9
Toggles Auto Select for video tracks 1 through 9, 

making it possible to restrict certain selection and trim 
operations performed with the keyboard.

Command-Option 
F1 through F9

Toggles Auto Select for audio tracks 1 through 9, 
making it possible to restrict certain selection and trim 

operations performed with the keyboard.

U Toggles the currently selected edit point among the 
outgoing, centered, or incoming part of the edit.

Option-U Toggles the currently selected edit point or clip among 
Video+Audio, Video Only, or Audio Only.

Comma (,) After you’ve made a selection, nudges selected edits or clips 
one frame to the left. Shift-Comma nudges 10 frames.

Period (.) After you’ve made a selection, nudges selected edits or clips 
one frame to the right. Shift-Period nudges 10 frames.

Forward-Slash (/)
Play around. Plays around the current position of the playhead; good 
for letting you preview how the trim you just made plays. Pre-roll and 

Post-roll is adjustable in the Edit panel of the Project Settings.

Command-/ Toggles looped playback off and on.

Up Arrow, Down Arrow

Moves the selection state to the edit point or clip to the left or 
right. If multiple clips or edits are superimposed, the first clip 
on the lowest numbered track will be selected first, then the 

next clip up, and so on until the topmost superimposed clip is 
selected, before selecting the next clip in the Timeline.
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Trimming Using Timecode Entry

You can also use absolute or relative timecode entry to trim clips and edits. What is trimmed depends 
on the selection you’ve made prior to entering timecode. If you want to use timecode to trim the 
selection forward relative to its current position, be sure to type an equal sign or plus (= or +) before the 
timecode value; to trim the selection backward relatively, type minus (–) before the timecode value.

>> To roll an edit: Select the center of an edit point, enter a timecode value, and press Return.

>> To ripple an edit: Select either the outgoing or incoming half of an edit point, enter a 
timecode value, and press Return.

>> To slip a clip: Select a clip, and press S if necessary to switch to Slip mode, enter a timecode 
value, and press Return.

>> To slide a clip: Select a clip, and press S if necessary to toggle to Slide mode, enter a 
timecode value, and press Return.

When entering timecode, type each pair of hour, minute, second, and frame values consecutively, 
with a period representing a pair of zeros for fast entry. The last pair of timecode values (or period) 
you enter is always assumed to be the frame number, with any untyped values assumed to be zero. 
It’s not necessary to enter colons or semicolons. For more information on how timecode entry 
works, see “Navigating Using Timecode” in this chapter.

Trimming Clips in the Source Viewer Using the Trim Tool

You can also open Timeline clips into the Source Viewer for trimming using the Trim tool, dragging 
to ripple the In and Out points.
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A Timeline clip being ripple-resized by opening it into the Source Viewer  

dragging its In point using the Trim tool

You can slip the contents of the clip by holding the Shift key down and dragging either the In or 
Out point.

A Timeline clip being slipped by opening it into the Source Viewer and Shift-dragging its In point using the Trim tool

Additionally, you can double-click a clip in the Timeline to open it into the Source Viewer for 
trimming. When the Selection Tool is selected, you can drag the In and Out markers, or use the 
playhead and I and O keyboard shortcuts to resize that clip in the Timeline.

Note: To open a match frame of a clip in the Timeline using the mouse as in previous versions, hold 
the Option key down while double-clicking a clip.
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Ripple Editing Rules

Ripple operations are the only trim functions that change the duration of the overall Timeline, and 
that can potentially alter the sync relationship between multiple clips on different tracks. This makes 
them incredibly useful, but it’s important to understand which parts of the Timeline will move as 
part of a ripple operation, and which parts won’t.

The following operations ripple the Timeline:

>> Ripple deleting a clip

>> Rippling one or more edits or gaps using the Trim tool

>> Using the extend edit, trim start, or trim end commands in Trim mode

During a ripple edit, superimposed clips with an In point that’s to the left of the edit point or clip 
being rippled are not moved. This can be seen in the previous example via the audio clip at the 
bottom of the Timeline, which stays in place even as the clips on track V1 and A1 are rippled. All clips 
with In points to the right of the edit point or clip being rippled move left to follow the trim operation 
you’re making.

The rules of timeline rippling illustrated. All clips that are either to the left or that intersect the edit being rippled are left in place, while 

all clips to the right of the edit being rippled are moved to the right or left for the duration of the ripple operation

This simple rule means that, if you’re in the habit of building sequences of clips from left to right, 
long overlapping superimpositions such as titles, graphics, and music clips will stay in place while 
you’re rippling various clips within a montage that you’re editing in relation to these longer clips.

Using Auto Select Controls to Control Trimming

Each track’s Auto Select control can be used to control how trimming operations affect timelines 
with multiple tracks and superimposed clips by letting you turn off rippling on specific tracks, while 
leaving it on for others. The rules are simple:

>> Tracks with Auto Select turned on: Rippling or ripple deleting a clip ripples all clips to the 
right on that track.

Not Rippled Rippled
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>> Tracks with Auto Select turned off: Rippling is disabled on these tracks.

Before and After, All tracks with Auto Select on are being rippled

Before and After, Track V1 is rippling, but tracks V2 and A2 are not because their Auto Select controls are off
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>> Tracks with Auto Select turned off with an edit selection: If you select the outgoing or 
incoming half of an edit on a track that has Auto Select off, the result will be a resize 
operation. Ripple deleting clips leaves a gap.

>> Tracks with Auto Select turned off: Rippling is disabled on these tracks.

>> Tracks with Auto Select turned off with an edit selection: If you select the outgoing or 
incoming half of an edit on a track that has Auto Select off, the result will be a resize 
operation. Ripple deleting clips leaves a gap.

Typically, you’ll want to leave Auto Select on for all tracks when rippling clips, to ensure that all clips 
in your timeline stay in sync. However, when the occasion requires, this gives you the option to 
suspend rippling on specific tracks while allowing rippling on others.

Before and After, Track V1 is rippling, but the selection on track V2 is being resized because its Auto Select control is off
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Trimming Multiple Edits or Clips at Once

DaVinci Resolve lets you select multiple edit points or clips for certain trimming operations, 
making it possible to trim multiple edits and clips at the same time. In simple cases, this makes 
it easy to resize, ripple, slip, and slide several superimposed clips at the same time, which is a real 
convenience. In more complicated cases, this lets you create more complicated trimming scenarios, 
such as multi-track asymmetric trimming, to quickly take care of difficult tasks.

No matter how ambitious a trim operation you want to set up, the procedure is exactly the same as for 
an ordinary trim operation. Just make sure you follow these three general steps, and you’ll be good:

1.	 Choose Selection mode, and select the edit points or clips you want to trim. To make multiple 
selections, click once to select the first item, then Command-click each subsequent item 
you want to add to the selection. When making multiple selections for trim operations, the 
following rules apply:

>>When selecting multiple edit points: You can only select one edit point per track.

>>When selecting multiple clips: You can select as many clips as you like on any combination 
of tracks.

2.	 To ripple, slip, or slide each selected item at once, choose Trim mode. To resize or move each 
selected item at once, continue using Selection mode.

3.	 Use the mouse or keyboard shortcuts to execute the trimming operation, just as you would if 
a single item were selected.

The following sections describe each of the special-case multi-selection trim operations that are 
possible, along with each one’s special rules and limitations.

Resizing, Rippling, and Rolling Multiple Edit Points

You can resize, ripple, or roll multiple edit selections at once, up to one selection per track. In this 
way, you can adjust the edit points of multiple superimposed clips all together. Trimming multiple 
edit points essentially lets you “gang” them so that they all move together.

To resize or ripple multiple clips at once, select multiple edit points (only one per track), then use 
the Selection tool to drag those edit points to resize at the same time, or use the Trim tool to ripple 
all clips at the same time.

Note: You cannot combine ripple and roll operations at the same time.
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Asymmetric Trimming

Asymmetric resize or ripple trimming can also be done to multiple clips, with one selection per 
track allowable on as many tracks as you require. To asymmetrically trim two or more clips, select 
an outgoing edit point on one track, and then Command-click an incoming edit on another track.

To select the outgoing video edit of one clips and the incoming audio edit of the next clip in 
preparation for making a split edit, you can Option-click the outgoing video edit to suspend linked 
selection, and then Command-click the incoming audio edit to add it individually to the selection. 
Now when you drag, nudge, or use timecode to trim, each selected edit point will move in the 
opposite direction.

Asymmetric trimming can be done in either Selection or Trim mode, either to open and close gaps, 
or to move edit points to overlap one another to create split edits.

Selecting opposite outgoing and incoming edit points in preparation for making an asymmetric trim

Dragging to perform an asymmetric trim to create a split edit in Trim mode
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Slipping Multiple Clips

You can simultaneously slip any number of selected clips (so long as they have handles) on any 
combination of tracks by selecting the clips you want to slip, then choosing the Trim tool, and 
dragging their name bars or using the comma and period keys to nudge the selection.

Sliding Multiple Clips

You cannot currently slide multiple clips at once.

Keyboard Trimming During Looped Playback

A great technique for editors who like to do precision trimming using the Nudge tool is the ability to 
enable looped-playback so that the Play Around command (Forward Slash) will loop continuously 
around the edit point you’re trimming as you nudge one or ten frames at a time to fine tune the cut.

To trim while looping:

1.	 Move the playhead near the edit point you want to trim, and press V to select it.

2.	 Press the U to choose which side of the edit you want to select in order to ripple or roll it, 
and/or Option-U to choose whether you want to trim video+audio, the video only, or the 
audio only.

3.	 Press Command-Forward Slash (/) to enable looped playback.

4.	 Press Forward Slash (/) to play around the current edit. With looping on, playback will continue 
until you stop it. Pre-roll and post-roll can be changed in the Edit panel of the Project Settings.

5.	 During looped playback, press the comma (,) and period (.) keys to trim the selection back 
or forward by a single frame, or Shift-comma and Shift-period to trim the selection in 10 
frame increments.

6.	 When you’re finished, press the Space Bar or K key to stop playback.

Dragging to slip multiple selected clips at once
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Dynamic Trimming Using Command-JKL

One of DaVinci Resolve’s most exciting trimming features is the ability to dynamically resize, ripple, 
roll, slip, slide, or move selected edit points and clips using Command-JKL. This means that you 
can trim during playback, by making an appropriate selection in the Timeline (edit points to resize, 
ripple or roll, or clips to slip or slide) and then holding the Command key down while using the JKL 
keyboard shortcuts. 

Trimming while viewing the current clip playing back has the advantage of letting you get emotionally 
involved in what you’re watching, as well as experiencing the timing of a clip as it plays, in order to 
help you get a better feel for how, exactly, you need to trim a particular shot. Additionally, you have 
the option of using Command-JKL to trim at different speeds if you have a long trim operation and 
you’re feeling impatient.

While you’re dynamically trimming, you see the same two-up or four-up display, the same Timeline 
overlays, and the same dynamically updating Timeline that appear when you use the trim tool with 
the mouse. The only difference is that everything happens while your program plays.

>> To dynamically roll an edit: In either Selection or Trim mode, select the center of one or 
more edit points (one per track), and hold the Command key down while using JKL to move 
the selection around.

>> To dynamically ripple an edit: Choose Trim mode, select the outgoing or incoming half of 
one or more edit points (one per track), and hold the Command key down while using JKL 
to move the selection around.

>> To dynamically resize an edit: Choose Selection mode, select the outgoing or incoming half 
of one or more edit points (one per track), and hold the Command key down while using 
JKL to move the selection around.

>> To dynamically move a clip: Choose Selection mode, select one or more clips, and hold the 
Command key down while using JKL to move the selection around.

>> To dynamically slip or slide a clip: Choose Trim mode, select one or more clips to slip, or a 
single clip to slide, press S to toggle between Slip or Slide modes, then hold the Command 
key down while using JKL to execute either slip or slide operations.

Note: When you’re finished with a dynamic trim operation and you want to see how that edit plays, 
you can use press the Forward Slash key (/) to play around the position of the playhead to quickly 
preview that section of the Timeline.
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Trim Start and Trim End

Trim Start (Option-[) and Trim End (Option-]) let you resize the In or Out point of all clips that intersect 
the playhead as either a ripple operation (in Trim mode) or a resize operation (in Selection mode). 
You do not need to make a selection to use Trim Start and Trim End, making these commands fast 
to use in the right situation. A classic use of Trim End is when you have several superimposed clips 
of different lengths that you want to either start or end at the same time.

>> Trim Start resizes intersecting clips so that each clip’s In point is moved to the current 
playhead position. 

Trim End resizes intersecting clips so that each clip’s Out point is moved to the current 
playhead position.

You can exclude clips on specific tracks from this operation by disabling the auto-select controls on 
those tracks.

Before and After a Trim Start operation

Before and After a Trim End operation
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Extend Edits

The Extend Edit command lets you resize or ripple one or more selected edit points. Unlike Trim 
Start and Trim End, it doesn’t matter if the playhead intersects clips when doing an Extend edit. 
Make one selection per track of any combination of In or Out points, and press the E key to move 
those edit points to the current position of the playhead. 

In Trim mode, selected edit points will ripple instead of resizing affected clips. However, to simplify 
multi-track extend edit operations when using the Trim tool, the lowest numbered video track with 
auto-select enabled defines the track on which the extend edit performed will ripple the rest of the 
Timeline; all selected edit points on other tracks are simply resized.

Before and After a multi-track extend edit performed in selection mode

Before and After a multi-track extend edit performed in Trim mode shows that the lowest numbered track with a selection 

defines how the Timeline is rippled
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As you work in the Timeline, you’ll find there are times when you want to disable clips that you 
don’t want to appear during playback, without actually removing them from the edit. For example, 
you may decide to disable superimposed clips that are positioned as insert shots in the middle of 
a scene because of a client’s notes, but you don’t want to eliminate the clips because they might 
change their minds.

In another example, you’ve edited a series of titles on track V3, but you need to disable track V4 in 
order to output a textless version of the movie as a deliverable.

When a clip or track is disabled, it appears dimmed, and the disabled clips don’t appear in the Color 
page, and aren’t output to tape or rendered to disk in the Deliver page unless re-enabled first. 

To disable/enable one or more clips in the Timeline:

>> Select one or more clips, then right-click the selection and check or uncheck Clip Enable in 
the contextual menu, or press D to toggle a clip’s enabled state. 

To disable/enable an entire track:

>> Click the track enable button.

A disabled clip on track V2

Track V3 is disabled, making the Timeline textless as a result

Enabling and Disabling Clips and Tracks
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Take Selectors in DaVinci Resolve provide a way for you to manage multiple takes or versions of a 
particular clip in the Timeline. They’re ideal for storing multiple useful takes for scenes where you or 
the client can’t quite decide which one is the best, or for maintaining multiple versions of VFX clips 
that are going through different iterations. 

When you place a number of clips inside a Take Selector, only one clip appears in the Timeline, but 
you can open that Take Selector and switch to any other take or version that’s stored within to switch 
which clip appears in the Timeline whenever you want.

Take selectors are easy to create and use and populate. Once you’ve placed a number of clips 
inside the Take Selector, you can slip each clip’s range of media, or choose a new clip to appear in 
the Timeline, before closing the Take Selector. 

When closed, multi-take clips can be edited, trimmed, graded, and rendered like any other clip in 
the Timeline. A Take Selector badge appears to the left of the name of a clip to which it’s applied to 
show its status; double-clicking this badge opens the Take Selector so you can adjust its contents.

Methods of using Take Selectors:

>> To create a Take Selector: Right-click any clip that’s not a Title or Generator, and choose 
Take Selector from the contextual menu. The Take Selector interface appears, disabling 
the rest of the Timeline temporarily while you work with the Take Selector’s contents.

Using Take Selectors

A Take Selector, shown open, with several alternate takes placed within

When closed, a Take Selector appears as a regular clip with a badge
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>> To populate a Take Selector: Drag any clip from the Media Pool into the Take Selector, and 
it appears “stacked” on top of the original clip in the Timeline.

>> To choose the current clip: Click any clip so that it’s highlighted in blue, and click the close 
button at the upper-left corner of the Take Selector. When next you open the Take Selector, 
the current clip appears at the bottom of the stack, with a star at the upper-left corner.

>> To set a take selector to ripple the timeline when a longer or shorter take is selected: Click 
the Ripple Take button, at the upper right-hand corner of the Take Selector panel, to the 
left of the trash can button.

>> To slip a clip within the Take Selector: Drag any clip to the left or right to slip the range of 
media that appears within the Take Selector’s duration in the Timeline.

>> To remove a clip from a Take Selector: Click the clip you want to remove to select it, then 
click the garbage can button at the upper-right corner of the Take Selector.

>> To close a Take Selector: Click the X close button.

>> To reopen a Take Selector: Double-click the Take Selector badge at the left of a clip’s name, 
or right-click a multi-take clip and choose Take Selector from the contextual menu.

>> To eliminate a Take Selector: Close the Take Selector, if open, then right-click that clip in the 
Timeline and choose Finalize Take from the contextual menu.
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DaVinci Resolve has several methods of locating clips, markers, and gaps, to help you troubleshoot 
problem timelines, or to find media that you want to edit into a timeline differently.

Methods of finding clips:

>> To locate a clip in the Edit Index via the Timeline: Move the Timeline playhead to intersect 
a clip you want to find in the Edit Index. That clip’s corresponding event (or events if the 
playhead intersects multiple clips) are automatically highlighted in the Edit Index.

>> To locate a clip in the Timeline via the Edit Index: Click an event in the Edit Index and the 
Timeline playhead will automatically move to the In point of that clip.

>> To find a clip in the Timeline: Open the Edit Index, choose a criteria from the Search Options 
pop-up menu, and then type a search term in the Search field at the top right of the Edit 
Index. As soon as you start typing, all edit events that don’t match the search criteria are 
temporarily hidden. To show all of the clips in the Edit Index again, click the cancel button 
at the right of the search field.

>> To find a clip in the Media Pool: Open the Media Pool, if necessary. Then choose a criteria 
from the Search Options pop-up menu, and type a search term in the Search field at the 
top right of the Edit Index. As soon as you start typing, all clips that don’t match the search 
criteria are temporarily hidden.

>> To locate a Timeline clip in the Media Pool: Right-click any clip in the Timeline, and choose 
Find in Media Pool. That clip appears highlighted in the Media Pool. 

>> To locate a Source Viewer clip in the Media Pool: With any clip open in the Source Viewer, 
press Option-F.

>> To locate a media file in the Finder from the Media Pool: Right-click any clip in the Media 
Pool and choose Reveal in Finder. A Finder window, or its equivalent in Windows and Linux, 
opens to the directory with that clip, which appears highlighted.

>> To locate offline media in the current Timeline via the Edit Index: Click the Option menu of 
the Edit Index and choose Show Offline Clips. Each offline clip appears in a list, and you can 
click any item on the list to jump the playhead to that particular clip in the Timeline.

If you’re using markers to keep track of notes, issues, or items on your to-do list, there are a few 
different ways of finding and moving among them.

Methods of finding Markers:

>> To find all markers via the Edit Index: Click the Option menu of the Edit Index and 
choose Show Markers. Each clip with one or more markers appears in a list, with columns 
corresponding to the color(s) and notes of each timeline and clip marker.

>> To move the playhead to the next marker forward or previous: Choose Playback > Previous 
Marker (Shift-Up Arrow) or Next Marker (Shift-Down Arrow).

Finding Media, Markers, and Gaps
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You can select a series of clips in the Timeline, whether they are edited one after the other in serial 
or superimposed and stacked in parallel, and turn them into a Compound Clip, which is a single clip 
in the Timeline that’s actually comprised of many other audio and video clips embedded inside. 
This allows you to work with a block of clips as if it were a single unit, governed by a single set of 
Inspector controls, and able to be connected to another clip in your timeline by a single transition.

Editing a compound clip works the same as editing any other type of clip. They can be edited, 
trimmed, and deleted using all the same methods. In addition, compound clips can be renamed, 
and decomposed back into their component clips right in the Timeline.

To create a compound clip:

1.	 Select a range of clips.

2.	 Right-click one of the selected clips and choose New Compound Clip.

3.	 Enter a name and optional start timecode for the compound clip you want to create, and 
click Create.

	 A compound clip is created which takes the place of the original clips you selected on the 
Timeline. Additionally, a copy of that compound clip appears in the currently selected folder 
of the Media Pool.

Compound Clips

Selecting a range of clips to turn into a compound clip

The resulting compound clip
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To rename a compound clip:

1.	 If the Media Pool is in List view, click the name of a compound clip in the Media Pool to select 
the clip and highlight the Name column. If the Media Pool is in Thumbnail view, then just select 
the compound clip you want to edit.

2.	 Press the Return key to select the name of the compound clip.

3.	 Type a new name, and press the Return key to accept the change. 

To edit a compound clip:

1.	 Right-click any compound clip and choose Open in Timeline from the contextual menu. 

	 The Timeline updates with the contents of the compound clip, which you can re-edit at your 
discretion. 

2.	 To return to the original Timeline when you’re finished, click the close button in the compound 
clip item under the Timeline.

To decompose a compound clip into its individual clips:

>> Right-click any compound clip and choose Decompose in Place from the contextual menu. 
The compound clip is replaced by the individual clips it was made from.

Closing the compound clip
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Subclips

Subclips give you another way of organizing media in the Media Pool, letting you break excessively 
long clips into shorter ones. For example, if the director of a project is fond of “rolling takes” where 
multiple takes are all recorded within a single clip, you can break these takes up by making them 
into subclips.

To create a subclip:

1.	 Double-click any clip in the Media Pool to open it into the Source Viewer.

2.	 Set In and Out points to define the section you want to turn into a subclip.

3.	 Right-click the jog bar and choose Make Subclip from the contextual menu. 

	 A new subclip appears in the Media Pool, automatically selected so that you can immediately 
edit its metadata in the Metadata Editor.

Once created, subclips appear and work like any other clip in Resolve. You can also create subclips 
in the Media page while performing other organizational tasks there.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

312

EDIT6

Transitions provide another way of bridging the change from one clip to another, and are often used 
to indicate a change in time or location when changing scenes. DaVinci Resolve supports a variety 
of transitions ranging from various forms of the traditional cross-dissolve to different types of wipes, 
allowing for great flexibility when finishing creative edits. In addition, Resolve supports third-party 
OpenFX transitions that you install on your system. Transitions are applied at edit points, and 
appear as editable objects in the Timeline.

A transition in the Timeline

The default transitions that come with DaVinci Resolve appear within the Toolbox panel of the 
Effects Library, while OpenFX transitions appear within the OpenFX panel.

Adding and Editing Transitions

The following procedures describe how to work with transitions in the Timeline.

Methods of working with transitions:

>> To add a transition by dragging it from the Effects Library: Drag a video transition from the 
Effects Library to an edit point in the Timeline so that it’s centered at, ends at, or starts at 
the edit point. If there is no overlap between the heads and tails of the two clips, you may 
not be able to add a transition where you want.

>> To add a transition using the Effects Library contextual menu: Select one or more edit 
points (one per track), then right-click a video transition in the Effects Library and choose 
Add to Selected Edit Points.

>> To add a transition using the mouse: Right-click any edit point between clips with 
overlapping handles, and choose one of the four durations available for the Standard 
Transition; the available choices are quarter-second, half-second, one second, and two 
seconds, expressed in frames at whatever the current frame rate of the Timeline is.

Working With Transitions
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>> To add a transition using the keyboard: Using the Selection tool, select one or more edit 
points (as many as you like on any combination of tracks), and press Command-T to add 
the standard transition for either one second, or as long as there are overlapping handles 
available.

>> To add a transition with specific alignment using the keyboard: Select an edit, press the U 
key to choose the start, center, or end of the edit, then press Command-T. The standard 
transition will be added with its alignment based on the edit selection; selecting the start 
of the edit places a transition that ends on the edit; selecting the end of the edit places a 
transition that starts on the edit, and choosing the center of the edit places a transition that 
is similarly centered.

Methods of altering transitions in the Timeline:

>> To change a transition’s type: Drag a different transition from the Effects Library onto the 
current one in the Timeline.

>> To change a transition’s duration: Drag the beginning or end of the transition in the Timeline 
to be longer or shorter symmetrically about the current edit. Alternately, you can double-
click any transition to open it in the Inspector, and set a new duration in seconds or frames.

>> To change a transition’s alignment: Right-click a transition in the Timeline and choose a 
new method of alignment from the contextual menu. Alternately, you can double-click any 
transition to open it in the Inspector, and choose a new option from the Alignment pop-up.

>> To remove a transition: Select a transition in the Timeline and press the Delete key.  
Or, right-click a transition in the Timeline and choose Delete from the contextual menu.

Transition Properties in the Inspector

Double-clicking a transition in the Timeline opens that transition’s properties in the inspector. Each 
transition has the following properties you can edit.

>> Duration: The duration of the transition, shown in both seconds and frames.

>> Alignment: A pop-up that lets you choose the transition’s position relative to the edit point 
it’s applied to. Your choices are “End on Edit,” “Center on Edit,” and “Begin on Edit.”

>> Transition style: A pop-up that lets you change the type of transition; you can choose from 
among all of the transitions that come with DaVinci Resolve by default.

Additional properties that are specific to each type of transition appear in another group below. 
Since the Cross Dissolve transition is the most common transition used, its properties will be shown 
as an example.

>> Style: The different Dissolve transitions (Cross Dissolve, Additive Dissolve, etcetera) expose 
this pop-up that lets you choose different ways for the outgoing clip to blend into the 
incoming clip during the dissolve. There are six different options to choose from:
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>> Video: A simple linear dissolve; the outgoing clip fades out as the incoming clip fades in.

>> Film: A logarithmic dissolve, simulating film dissolves as created by an optical printer.

>> Additive: The outgoing and incoming clips are cross faded using the Additive 
composite mode. As a result, the transition seems to brighten at the halfway point.

>> Subtractive: The outgoing and incoming clips are cross faded using the Subtractive 
composite mode. As a result, the transition seems to darken at the halfway point.

>> Highlights: The outgoing and incoming clips are cross faded using the Lighten 
composite mode. The lightest parts of each clip are emphasized during this transition.

>> Shadows: The outgoing and incoming clips are cross faded using the Darken composite 
mode. The darkest parts of each clip are emphasized during this transition.

>> Start Ratio: Defines the percentage of completion for the transition at its first frame, from 0 
to 100 percent. Setting the Start Ratio to anything but 0 results in the transition immediately 
appearing at a more fully cross-dissolved state from the very first frame.

>> End Ratio: Defines the percentage of completion for the transition at its last frame. Setting 
the End Ratio to anything but 0 results in the transition never fully dissolving to the incoming 
shot at its last frame.

>> Reverse: Reverses the transition. This parameter is disabled for Dissolve transitions.

>> Ease: A pop-up that lets you apply non-linear acceleration to the beginning, ending, 
or overall duration of a transition. The result is to add inertia to the transition from the 
outgoing clip to the incoming clip, and providing a gentler change from each clip into and 
out of the transition.

>> In: The outgoing clip lingers as the beginning of the transition dissolves more slowly 
than the end.

>>Out: The outgoing clip fades away more quickly, as the beginning of the transition 
dissolves more quickly than the end.

>> In & Out: Both the outgoing and incoming clips make slower transitions at the beginning 
and end of the dissolve, but the very center of the transition is faster as a result.

Other types of transitions display other properties, which are described at length in the 
following section.
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DaVinci Resolve Transitions

The following are transitions that are available within Resolve by default, along with the parameters 
that are available from the Inspector:

>> Cross Fade: An audio-only transition that lets you fade 

>> Cross Dissolve: Start Ratio lets you adjust how far along the transition is when it first begins, 
from the very beginning of the transition to 50 percent through the transition. End Ratio lets 
you adjust how far the transition gets at the very end, from a complete transition through 
50 percent of the transition. The Reverse checkbox reverses the direction of the transition.

>> Additive Dissolve: Start Ratio lets you adjust how far along the transition is when it first 
begins, from the very beginning of the transition to 50 percent through the transition. End 
Ratio lets you adjust how far the transition gets at the very end, from a complete transition 
through 50 percent of the transition. The Reverse checkbox reverses the direction of the 
transition.

>> Dip to Color Dissolve: Start Ratio lets you adjust how far along the transition is when it first 
begins, from the very beginning of the transition to 50 percent through the transition. End 
Ratio lets you adjust how far the transition gets at the very end, from a complete transition 
through 50 percent of the transition. The Reverse checkbox reverses the direction of the 
transition. Color lets you choose what color the dissolve dips to at the midpoint.

>> Center Wipe: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Angle specifies the angle of the wipe as it 
emerges from the middle of the screen.

>> Clock Wipe: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Angle specifies the starting angle of the wipe 
as it spins around the center of the screen. The Clockwise checkbox sets the direction of 
the clock wipe.

>> Edge Wipe: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Angle specifies the angle of the wipe as it 
moves across the screen.

>> Venetian Blind Wipe: Color sets the color of the border, if there is one. Border sets the width 
of the border, in pixels, with 0 creating no border. Repeat specifies how many “blinds” 
appear within the wipe effect. Angle specifies the angle of this multi-wipe effect.

>> Cross Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Offset to Center identifies the center point at 
which the cross wipe begins, as X and Y coordinates on the screen.
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>> Diamond Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Offset to Center identifies the center point at 
which the diamond-shaped wipe begins, as X and Y coordinates on the screen.

>>Oval Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Offset to Center identifies the center point at 
which this circular wipe begins, as X and Y coordinates on the screen. Oval Ratio changes 
the aspect ratio of the oval, making it either wider or taller.

>> 5 Star: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Offset to Center identifies the center point at which this 
circular wipe begins, as X and Y coordinates on the screen. Feather blurs the border.

>> Box: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Box mode lets you choose one of the following options:

>> Upper Left

>> Upper Right

>> Lower Left

>> Lower Right

>> Left Center

>> Top Center

>> Right Center

>> Bottom Center

>> Heart: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Offset to Center identifies the center point at which this 
circular wipe begins, as X and Y coordinates on the screen. Feather blurs the border.

>> Triangle Left: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Feather lets you blur the edge of the transition 
from the outgoing to the incoming clip.

>> Triangle Right: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Feather lets you blur the edge of the transition 
from the outgoing to the incoming clip.

OpenFX Transitions

If you’ve installed one or more sets of OpenFX plugins on your DaVinci Resolve workstation, any 
transitions within those sets will appear in the OpenFX panel of the Effects Library.
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Organizing Transitions and Setting the Standard Transition

While DaVinci Resolve provides 24 transitions by default, most editors typically only use a subset of 
these in their day-to-day work. Furthermore, different projects may require different transitions be 
used as the Standard Transition. Resolve gives you several tools for dealing with this.

Methods of setting and filtering favorites in the Effects Library:

>> To set a transition or other effect as a favorite in the Effects Library: Right-click any transition 
or effect and choose “Add to Favorites.” Favorite transitions and effects appear with a star 
at the upper left-hand corner.

>> To display only your favorites in the Effects Library: Click the options menu at the upper 
right-hand corner of the Effects Library, and choose Favorites.

>> To display all effects in the Effects Library: Click the options menu at the upper right-hand 
corner of the Effects Library, and choose Favorites again so that it’s unchecked.

To change the Standard Transition:

>> Right-click any transition or effect and choose “Set as Standard Transition.”



Edit Page Effects
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The Edit page is also home to many of the compositing and effects features found in DaVinci 
Resolve. Many effects can be imported into DaVinci Resolve, including composite modes, opacity 
settings, linear and nonlinear speed changes, and clips using alpha channels. Once in Resolve, you 
can make changes to these effects in the Edit page. Alternately, you can also use Resolve’s controls 
to create effects from scratch.

Edit Page Effects
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Using the Inspector

The Edit page Inspector, which is closed by default, is the central area for editing effects parameters 
relating to compositing, sizing, titling, transitions, generators, and effects of all kinds. Many of 
the instructions in this chapter require the use of the Inspector, which can be opened or closed 
by clicking the Inspector button at the far right of the Edit page toolbar, or by double-clicking a 
transition or generator in the Timeline.

The Inspector, with the button that opens and closes it shown bottom right, displays different parameters depending on what you’ve 

selected in the Timeline; (left) parameters of a clip, (right) parameters of a title

The parameters displayed in the Inspector are those of the currently selected item in the Timeline. 
Changing the selection changes which parameters are displayed, and the parameters you edit 
in the Inspector only alter the currently selected clip. If multiple clips are selected, the Inspector 
displays and edits only the leftmost clip within the selection.

Most parameters in the Inspector are organized into groups, with a title bar providing the name 
of that group, along with other controls that let you control all parameters within that group at the 
same time.
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These controls include:

>> Enable button: A round orange button to the left of the parameter group’s name lets you 
disable and re-enable every parameter within that group at once.

>> Close button: This button only appears when you move the pointer over the title bar, 
revealing itself as the word “Close.” Clicking this button collapses the group so that only 
the title bar is displayed, freeing up room in the Inspector for other parameters. Option-
clicking the hide button collapses or opens all parameter groups at once.

>> Keyframe button: This button lets you add or remove keyframes at the position of the 
playhead to or from every single parameter within the group.

>> Reset button: Lets you reset all parameters within that group to their default settings.

Closed and open Inspector group controls
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There’s a collection of titles and generators in the Toolbox that you can use to create leader when 
outputting to tape, add slates, create subtitles, and otherwise fulfill any textual needs your  
program has.

The available titles in the toolbox

Titles and generators can be edited much like any other clip. Furthermore, when selected, both titles 
and generators expose the same Composite, Transform, and Cropping parameter groups as any 
other clip; these parameters can be used to composite titles and fly them around in order to create 
different text effects.

Methods of adding and editing generators and titles:

>> To drag and drop a generator directly into the Timeline: If you simply drag and drop titles 
or generators into the Timeline, the default duration of the resulting clip is 20 seconds. This 
duration can be customized in the Edit panel of the Project Settings.

>> To edit a generator using the edit overlays of the Timeline Viewer: Click the destination 
control of the clip you want to edit a generator into, then set Timeline In and Out points to 
define the duration of the resulting edit, and drag the generator you want to edit onto the 
edit overlay of the Timeline Viewer that corresponds to the type of edit you want to perform.

>> To edit the parameters of a generator or title: Open the Inspector, and select the generator 
or title you want to edit to open it into the Inspector.

Using Safe Area Overlays

If you’re working on a broadcast program and you want to adhere to guidelines for title safe and 
broadcast safe, you can choose to display overlays that indicate where these regions are in the Edit 
page. To do so, choose View > Safe Area > Master On/Off. 

Adding Titles
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The available safe area overlays

If necessary, there are a number of ways you can customize this overlay by choosing one of the other 
options in the View > Safe Area submenu to toggle specific parts of the Safe Area overlay on and 
off. These options include:

>> Extents: An outline showing the exact outer edge of the frame. Especially useful when the 
safe markers are set to an aspect ratio other than that currently used by the Viewer.

>> Action: An outline showing the outer 90% action safe area of the frame.

>> Title: An outline showing the outer 80% title safe area of the frame.

>> Center: A crosshairs showing the center of the frame.

>> Aspect: Enables use of the View > Select Aspect Ratio submenu to change the aspect ratio 
of the safe area markers. You can choose among the following aspect ratios: 1.33 (a.k.a. 4:3), 
1.66, 1.77 (a.k.a. 16:9), 1.85, and 2.35.

Types of Title Generators

When opened into the Inspector, titles expose a set of text parameters that allow you to style the 
contents of that clip’s Text field within the Inspector. Each of the titles supports rich text, so you 
can individually style words, lines, or paragraphs of text using the available parameters including 
Color, Font, and Size. Other attributes such as Alignment, Anchor, Position, and Shadow affect the 
entire title.

The following titles are available:

>> Simple: Useful for creating titles consisting of one word, line, or paragraph of text. A single 
body of text shares one set of rich text controls.
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>> Scroll: Automatically automates a scrolling title sequence from the bottom to the top of 
the screen. The duration of the generator clip in the Timeline determines the speed of the 
scroll. Identical parameters as the Simple title.

>> L Lower 3rd: Automatically positions two lines of text at the bottom left corner of title safe, 
each with a different set of rich text controls.

>>M Lower 3rd: Automatically positions two lines of text at the bottom middle of title safe, 
each with a different set of rich text controls.

>> R Lower 3rd: Automatically positions two lines of text at the bottom right corner of title safe, 
each with a different set of rich text controls.

Shared Title Generator Parameters

The title generators in Resolve are all capable of rich text styling, meaning that you can select any 
portion of a generator’s text and style it differently. For example, you could have three lines of text 
within a single generator, and style each line individually to create a particular design.

Each title generator shares the same parameters:

>> Rich Text: A control group consisting of a text entry field and parameters that can be used 
to style different parts of the text independently.

>> Text: A text entry field for editing the title being generated. If no characters are 
selected, the styling controls affect the entire block of text. If you select a specific set 
of characters, the styling controls only affect the selection.

>> Font family: A pop-up for choosing one of the font families installed on your workstation.

>> Font face: A pop-up for choosing which face of the font family currently selected to use.

A single generator with three lines of differently styled text
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>> Color: Opens the standard color picker for choosing a font color.

>> Size: Slider for choosing the text size.

>> Tracking: Slider that sets the spacing between characters.

>> Line spacing: Slider for setting the spacing between the selected line of text and the 
next one below.

>> Font style: Buttons to apply underline, overhead line, strikethrough, superscript, and 
subscript styling.

>> Font case: A pop-up for forcing the text selection to be Mixed Case (the default), All 
Caps, All Lowercase, Small Caps, or Title Caps.

>> Alignment: Buttons to select the method of alignment: left, centered, right, or justified.

>> Anchor: Buttons for selecting how text is anchored to the current position, both 
horizontally (top, centered, bottom) and vertically (right, centered, left).

>> Position: X and Y parameters determining the bottom left-hand corner (the default 
Anchor settings) of the rich text block being generated.

>> Drop shadow: Let you apply a customizable drop shadow to every character of text 
being generated.

>> Color: Opens the standard color picker for choosing a drop shadow color.

>>Offset: X and Y parameters determining how offset the drop shadow is from the 
original text.

>> Blur: A slider for blurring the drop shadow.

>>Opacity: A slider determining how transparent the drop shadow is.

>> Stroke: Lets you add an outline to every character of text being generated.

>> Color: Opens the standard color picker for choosing the stroke color.

>> Size: A slider lets you choose the thickness of the stroke, in pixels.

>> Background: The background controls provide an extremely flexible rectangle or 
rounded rectangle shape that you can use to add a background, bar, outline, or other 
intersecting shape to use when designing a title.

>> Color: Opens the standard color picker for choosing the interior color of the 
background shape.

>>Outline color: Opens the standard color picker for choosing outline color of the 
background shape.

>>Outline width: A slider lets you choose the thickness of the background shape outline, 
in pixels.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

326

EDIT PAGE EFFECTS7

>>Width: A slider lets you choose how wide to make the background shape.

>> Height: A slider lets you choose how tall to make the background shape.

>> Corner radius: A slider lets you choose the roundness of the rectangle edges.

>> Center: X and Y parameters you can use to offset the background shape from the text 
being generated.

>>Opacity: A slider lets you set the transparency of the background shape.
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Using Generators

Generators, with the exception of Solid Color, lack editable parameters with the exception of the 
Composite, Transform, and Cropping parameters that are standard for every clip.

The following generators are available:

>>Gray Scale: A simple grayscale ramp from black to white.

>> EBU Color Bar: A 1.77:1 aspect ratio set of color bars for PAL-using countries.

>> SMPTE Color Bar: An updated 1.77:1 aspect ratio set of color bars for NTSC-using countries.

>> 10 Step: A grayscale ramp segmented into 10 steps from black to white.

>> 100mV Steps: A grayscale ramp segmented into segments of exactly 100mV each.

>>Window: A simple white on black shape generator, defaulting to a white rectangle against 
a black background.

>> YCbCr Ramp: A gradient designed to test the Y’CbCr signal.

>> Solid Color: A simple fullscreen color generator. A Color parameter lets you choose what 
color this generator outputs.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

328

EDIT PAGE EFFECTS7

Using Stills

You can import still images into the Media Pool, and edit them into the Timeline as clips with 
custom durations. By default, imported stills are 10 seconds long, but you can extend a still image’s 
Out point to a maximum of 17 hours and 40 minutes in length, which ought to cover just about 
any project you’re planning on working on, so long as you’re not Andy Warhol. DaVinci Resolve is 
correspondingly capable of importing still image clips referenced by XML or AAF project files, so 
long as they’re in a supported format. 

DaVinci Resolve supports the use of stills in the following formats:

Once edited into the timeline, still image clips have the same Composite, Transform, Cropping, 
Retime and Scaling attributes as any other clip.

Photoshop File Support

Only the bitmapped layers of Photoshop (.psd) files appear within DaVinci Resolve as a single clip in 
the Timeline. Photoshop text layers and layer effects are not supported.

File Format Alpha 

.tif Yes

.png Yes

.jpg No

.dpx No

.exr Yes

.dng No

.psd No
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Composite modes are effects that use various mathematical operations to combine one superimposed 
clip with another, relying on standard image processing math for each color channel whereby black 
pixels have a value of 0, white pixels have a value of 1, and descending levels of gray are represented 
by decimal point values (for instance, 0.5 represents 50% gray). When using composite modes to 
blend two clips together on the Timeline, the three color channels of each pair of pixels are combined 
using that particular composite mode’s math. The results can create transparency effects, increase 
image exposure, and combine multiple images in many creative and useful ways.

When using composite modes, it’s easy to push parts of the resulting image above the maximum or 
below the minimum values for brightness. However, this image data is not clipped, even through such 
areas of the picture may appear flat white or black. Out-of-range data as a result of a composite mode 
effect is preserved, and may be retrieved by later image processing operations in the Color page.

When you import XML project files, Resolve imports whatever composite modes were used by clips 
in the original sequence. If necessary, you can then change a clip’s composite mode to one that will 
work better with whatever grade you’re creating. Of course, you can also add composite modes to 
clips that didn’t originally have them, adding new effects of your own. 

All composite modes interact with the Opacity slider (found below the Composite Mode pop-up 
menu in the Inspector) to make a clip more or less transparent in addition to compositing already 
being done.

Composite Modes and Transparency Effects

Two source clips combined with the Hardlight composite mode
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Composite modes can be used on clips that are superimposed over other clips in the Timeline. 
However, these composite modes are also available for use within a grade on the Color page using 
the Layer Mixer node, within which you can combine differently graded versions of an image in 
creative ways. For example, the Add and Overlay composite modes can be useful for creating glow 
effects, while Subtract and Difference can create more surreal effects.

Working with composite modes in the Edit page is simple.

To set or change a composite mode for any clip:

>> Select a clip in the Timeline, then open the Inspector and choose one of the options from 
the Composite Mode pop-up menu.

To turn a clip’s composite mode off:

>> Select a clip in the Timeline, then open the Inspector and choose Normal from the 
Composite Mode pop-up menu.

More About Composite Modes

There are ten composite modes to choose from. For clarity, simple image math is used to help 
explain the available Composite Mode effects.

Normal

No image compositing is done. The topmost image on the Timeline or the bottom input of the 
Layer Mixer node occupies the entire frame.

Add

Each pair of pixels in both superimposed layers is added together. Layer order does not matter. This 
can result in a dramatic brightening of light areas of both images with areas of the picture that are 
blown out to maximum white, and this effect is often used by adding the brighter part of an image 
to itself to create hot glow effects. Image data going above 1.0 is preserved and may be retrieved 
by later color correction operations. On the other hand, black areas of either image do not alter the 
combined image at all (0 + n = n).

Composite mode and opacity controls in the Timeline
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Subtract

Within each pair of pixels, those of the bottom layer are subtracted from those of the top. This can 
result in dark areas of the image that hit flat black, but image data going below 0 is preserved and 
may be retrieved by later color correction operations.

Difference

The absolute value is taken of the top layer minus the bottom layer, and returned as the result, which 
is always a positive number. Layer order does not matter. This Blend mode is often used to compare 
two differently-processed versions of the same image to see if there are any alterations, and how 
large they are.

Multiply

Each pair of pixels is multiplied together. Layer order does not matter. This generally has the effect 
of emphasizing the darkest parts of both images in the resulting output; in particular black areas of 
either image are preserved (0 * n = 0) while white areas of either image have no effect on the output 
image (1 * n = n). Multiply is good for compositing darker elements in a field of white into an image, 
and can be used to emphasize the darkest parts of a noise, grain, or damage layer you’re blending 
with an image.

Screen

The pixel values of each layer are inverted, then multiplied, and the result is itself inverted. Layer 
order does not matter. Screen is the inverse of Multiply, as it preserves the lightest parts of both 
images, and is useful when compositing lighter elements in a field of black into an image, and 
can be used to emphasize the lightest parts of a noise, grain, or damage layer you’re blending 
with an image.

Overlay

Overlay combines useful aspects of both the Screen and Multiply composite modes, based on 
the pixel values of the bottom-most image on the Timeline; all bottom layer pixels above 50% 
are Screened, while all bottom layer pixels 50% and below are Multiplied. Overlay is an excellent 
composite mode for combining a layer of noise, grain, or damage imagery with another clip,  
as it combines both images in visually useful ways throughout the tonal range of shadows 
through highlights.

Hardlight

Hardlight is the opposite of Overlay. All bottom layer pixels above 50% are Multiplied, while all 
bottom layer pixels 50% and below are Screened.
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Softlight

A less intense method of applying the Hardlight composite mode that results in a more even blend 
between the two layers.

Darken

Each pair of pixels is compared, and the darker of the two is the output. Layer order does not 
matter. Darken is useful when you want the darker features of both layers to take precedence.

Lighten

Each pair of pixels is compared, and the lighter of the two is the output. Layer order does not 
matter. Lighten is useful when you want the lightest features of both layers to take precedence.

Unknown

When importing XML or AAF project files with composite modes that aren’t available in Resolve, 
the Composite Mode pop-up menu is set to Unknown; practically, this is the same as Normal.

Opacity

Each clip has an Opacity parameter, available in the Inspector, that lets you make it more transparent, in 
a range from 0 (totally transparent) to 100 (totally opaque). When set to a value less then 100, the selected 
clip is mixed with whatever clip is underneath it on the Timeline, according to the composite mode 
that’s currently used. If no clip appears underneath the Timeline, then the clip is mixed with black.

By keyframing this parameter, you can create more complicated fade to black effects or cross-
dissolves. Keyframing is covered in more detail later in this chapter.

To change a clip’s opacity:

>>Open the Inspector, then select the clip you want to adjust, and set the Opacity slider to 
create the desired amount of transparency.

Video Fader Handles

If you want to dissolve a clip to or from another clip, or to or from black, the traditional way to do 
so has been to use one of the transitions in the Effects Library. However, you can now use Fader 
Handles that appear at the beginning and end a clip when you position the pointer right over it. 
Fader handles are a fast, ubiquitous method of creating a fade to or from black. However, they also 
make it easy to fade to or from other clips that are underneath one that’s superimposed, as seen in 
the following screenshot.
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To use a fader handle, move the pointer over the clip you want to adjust, and when small green 
fader handles appear at the upper left and upper right of the video of the clip, drag them to the left 
or right for the duration you want the fade effect to last.

Alpha Channel Support

If a superimposed video or still image clip in the Timeline has an embedded alpha channel, that 
alpha channel automatically creates transparency within that clip, compositing it against whatever 
is in the track underneath. There’s no need for you to do anything for this to work. 

However, if you want to disable the alpha channel for any clip, for example if a clip is being interpreted 
as having an alpha channel incorrectly, you can use the Find in Media Pool command to select that 
clip in the Media Pool, where you can right-click it and choose Change Alpha Mode > None.

However, if you want to disable the alpha channel for any clip, for example if a clip is being interpreted 
as having an alpha channel incorrectly, you can use the Find in Media Pool command to select that 
clip in the Media Pool, where you can right-click it and choose Alpha > None.

Superimposing a clip with an alpha channel above automatically composites that clip against the clip beneath it

Dragging a video fader handle on a clip in track V2
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Keying, External Mattes, and Window Compositing

It’s also possible to use the Qualifier, Power Window controls, and External Matte clips in the Color 
page to create compositing effects by connecting a key that you create to the optional Alpha 
Output that can be added to the Node Editor. In this way, you can pull a simple greenscreen key 
using a qualifier, do rotoscoping or matte work using a Power Window, or use an External Matte to 
composite two or more clips together, and see these effects on the Edit page.

For more information on use of the Alpha Output to do node-based compositing, see Chapter 12, 
“Advanced Color Features.”
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DaVinci Resolve is a resolution-independent application. This means that, whatever the resolution 
of your source media, it can be output at whatever other resolution you like. This also means that 
you can freely mix clips of any resolution, fitting 4K, HD, and SD clips into the same timeline, and 
scaling each to fit the project resolution as necessary.

Your project’s resolution can be changed at any time, allowing you to work at one resolution, and 
then output at another resolution. This also makes it easy to output multiple versions of a program at 
different resolutions, for example, outputting both HD and SD sized versions of the same program.

DaVinci Resolve has a powerful tool set for making geometric transforms, using advanced 
algorithms for optical-quality sizing operations. Within the Edit page, each clip has a set of transform 
parameters, principally for use in storing sizing data imported from AAF or XML when you turn on 
the “Use sizing information” checkbox. This has the advantage of keeping these imported settings 
separate from the Input Sizing parameters found on the Color page, which are typically used by the 
colorist to make Pan and Scan adjustments of various kinds.

Of course, you can also use these controls to create your own adjustments while working in the 
Timeline, zooming into clips, repositioning them to improve the composition, etcetera. While there 
is some overlap between these parameters and those in the sizing palette of the Color page, they’re 
both separate sets of parameters, so you can keep each set of adjustments separate. 

When the time comes to output your program, the final resolution of each clip is calculated taking into 
account the original resolution of the source media, the timeline resolution, image scaling settings, 
Edit page transforms, and Color page transforms, so that the final resolution correctly uses the 
cleanest geometric transformation based on the maximum resolution available to each source clip.

The Edit page transform group includes the following parameters, which are also editable in the 
Edit Sizing mode of the Sizing palette in the Color page:

>> Pan and Tilt: Moves the image within the frame, allowing pan and scan adjustments to be 
made. Pan moves the image in the X dimension, and Tilt moves the image in the Y dimension.

>> Zoom X and Y: Allows you to blow the image up or shrink it down. The X and Y parameters 
can be linked to lock the aspect ratio of the image, or released to stretch or squeeze the 
image in one direction only.

>> Rotation Angle: Rotates the image around the anchor point.

>> Anchor Point X and Y: Defines the coordinate on that clip about which all transforms 
are centered. 

The Edit page has an additional set of cropping parameters:

>> Crop Left, Right, Top, and Bottom: Lets you cut off, in pixels, the four sides of the image. 
Cropping a clip creates transparency, so that whatever is underneath shows through.

Transform and Cropping



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

336

EDIT PAGE EFFECTS7

The Retime and Scaling group also has a single parameters that affects clip scale:

>> Scaling: Lets you choose how clips that don’t match the current project resolution are 
handled. The default setting is Project Settings, so that all mismatched clips use the 
same method of being automatically resized. However, you can also choose an individual 
method of automatic scaling for any clip. The options are Crop, Fit, Fill, and Stretch, which 
are explained in more detail in the 2D Transforms section of Chapter 8, “Color.”

You also have the option of transforming or cropping clips using the Transform/Crop button at the 
bottom left of the Timeline Viewer.

Transform controls in the Timeline Viewer
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To transform a clip using graphical controls in the Timeline Viewer:

1.	 Click the Transform/Crop button at the bottom left of the Timeline Viewer to turn it on; orange 
is enabled, gray is disabled. 

2.	 Choose either the Transform or Cropping mode from the pop-up menu if necessary to 
change modes. The appropriate on-screen controls appear to let you manipulate the clip 
with the mouse.

Onscreen controls for transforming and cropping in the Timeline Viewer

>>When in Transform mode, you can drag anywhere within the clip’s bounding box to adjust 
pan and tilt, drag any diagonal corner to proportionally resize, drag any side to squeeze or 
stretch just width or height, or drag the center handle to rotate.

>>When in Crop mode, each side has a handle for cropping.

3.	 If necessary, choose a smaller viewing percentage from the Timeline Viewer scale pop-up to 
better see the on-screen controls if you’re rescaling the image.

4.	 When you’re finished, turn the Transform/Crop button off.
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DaVinci Resolve is capable of reading linear speed effects from imported EDL, AAF, and XML 
projects, and nonlinear speed effects from XML and AAF project files. When speed effects are 
present, Resolve plays clips at the specified speed. You can also create speed effects of your own 
using controls in the Edit page. There are three methods of adjusting clip speed; using the Inspector, 
using the Change Speed dialog, and using the Retiming effect in the Timeline.

Creating Simple Speed Effects

If all you need to do is to make a clip play in slow motion, speed it up, reverse the clip, or create a freeze 
frame, you can apply a simple speed effect using either the browser or the Change Speed dialog.

To change a clip’s speed, do one of the following:

>> Select a clip in the Timeline, open the Inspector, and scroll down to the Speed Change settings.

>> Right-click a clip in the Timeline, choose Change Speed, and use the controls of the Edit 
Speed Change dialog.

Speed Change operations have the following options:

>> Change Speed To parameter: Changes the speed of the selected clip by whatever 
percentage you like.

>> Ripple Sequence checkbox: If you want the speed change you’re about to make to ripple 
the Timeline, pushing or pulling all clips following the current one to accommodate the 
clip’s new size, then turn on the checkbox.

Speed effect parameters shown in the Speed dialog

>> Freeze Current Frame checkbox: Changes the entire clip to a freeze frame of whichever 
frame is at the current position of the playhead.

>> Reverse Clip button: Clicking this button sets the current speed to a negative value, 
reversing the motion of the clip.

Speed Effects
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Clip Retiming Controls

Another method of altering clip speed in the Timeline is to apply the Retime effect. This method of 
clip retiming provides a convenient control overlay that you can use to adjust clip speed directly in 
the Timeline, and it also provides the controls that are needed for creating variable-speed effects.

To apply the Retime effect to a clip:

>> Select a clip, and choose Edit > Retime Clip (Command-R).

>> Right-click a clip and choose Retime Clip from the contextual menu.

The Retime controls appear over that clip in the Timeline. They consist of a Retime control track 
running along the top of the clip with arrows that indicate the speed and direction of playback (the 
default blue right-facing arrows indicate normal 100% playback) and a Clip Speed pop-up menu at 
the bottom center of the clip, which also shows the current speed of the clip.

The Speed Effect controls in the Timeline

Retiming An Entire Clip

The simplest way of using the Retiming effect is to change the playback speed of the entire clip, 
in the process rippling the rest of the Timeline to the right of the retimed clip as you increase its 
duration by stretching or compressing its duration.

To retime a clip by dragging:

>>Move the pointer to the left or right edge of the Speed Change name bar on top of the 
clip, and when it turns into a Retime cursor, drag either side to stretch or squeeze the clip 
to retime it.

To retime a clip by specific amounts:

1.	 Select a clip and press Command-R.

2.	 Click the pop-up next to the speed percentage text at the bottom of the clip.
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3.	 Do one of the following:

>> Choose a new playback speed from the Change Speed submenu.

>> Choose reverse segment to make the clip play in reverse. Reverse speed is shown in the 
Retime control track as arrows facing left, instead of right.

To return a clip to its original speed:

>> Click the pop-up next to the speed percentage text at the bottom of the clip, and choose 
Reset to 100%.

Reading Clip Speed Arrows

When you retime a clip, the Clip Speed pop-up menu displays the current speed of the entire 
clip. Additionally, the arrows in the Retime control track show you the speed and direction of 
playback. When clip speed is slowed down below 100%, the Retime control track shows yellow 
playback triangles that are spaced farther apart. When clip speed is sped up above 100%, the 
Retime control track shows yellow triangles that are bunched closer together. At 100% normal 
speed, the Retime control track shows blue, evenly spaced triangles, while left-facing yellow 
arrows indicates reverse playback.

Three clips set to different speeds. From left to right, fast forward, slow motion,  

and reverse speeds are indicated by the yellow arrows.

Creating Variable Speed Effects

You can also use the Retime controls to insert freeze frames within the middle of a clip, and create 
other custom variable speed effects using speed points. Additional variable speed options include 
rewind and speed ramp effects, which automatically place speed points to create preset effects.

To create a freeze frame at a particular moment in time:

1.	 With the Retime controls exposed, move the playhead to the frame you want to freeze, within 
that clip. Ideally, this will be for an effect where you want a character in motion to suddenly 
stop at a particular frame.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

341

EDIT PAGE EFFECTS7

2.	 Open the Clip Speed pop-up menu, and choose Freeze Frame. Two new speed points are 
added to the clip, defining a range within which the clip is frozen at that frame. This can be 
seen by the vertical red bars in the retime control track. Past the second speed point, the clip 
resumes playback from the next frame forward.

Speed effect controls set to insert a momentary freeze frame within the clip

3.	 Drag the second speed point forward or back to define the duration of the freeze frame. The 
result is that the clip plays normally up until the first speed point, then freezes on that frame 
until the second speed point, at which playback resumes.

To create variable-speed effects:

1.	 With the Retime controls exposed, move the playhead to the frame at which you want to change 
the speed of the clip, and choose Add Speed Point from the Clip Speed pop-up menu.

2.	 Move the playhead forward to the next frame at which you want the clip speed to change 
again, and add another speed point. It takes a minimum of two speed points to create a 
speed effect.

3.	 To alter the speed of the clip segment appearing between these two speed points, do one of 
the following:

>> Using the pointer, drag the second speed point to the right to slow down clip playback, or 
to the left to speed up clip playback within just that segment.

>> Using the Clip Speed pop-up menu, choose a new speed for that segment from the 
Change Speed pop-up menu. You can also set any segment to play in reverse by choosing 
Reverse Segment.

4.	 To clear a speed point and eliminate that particular clip’s speed segment from the effect, 
choose Clear Speed Point from any Clip Speed pop-up menu to eliminate whichever speed 
point appears to its left.
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When you create variable-speed effects, the arrows in the Retime control track can help you 
keep track of what you’re doing, and each segment’s speed pop-up shows you the actual 
numeric speed. The change in speed from each speed segment to the next is automatically 
eased, for a smooth transition from one speed to another.

Speed controls set to ramp among three different playback speeds; arrow spacing shows the timing

There are two additional sets of commands for creating preset speed effects that use multiple 
speed points.

To add a rewind effect:

>>With a clip’s retime controls exposed, open any Clip Speed pop-up menu and choose a 
preset percentage from the Rewind submenu. This results in two additional speed points 
being added after the rightmost speed point in the current segment, which creates the 
effect of the current segment playing in fast reverse for the chosen percentage, and then 
playing a second time from the beginning.

Speed effect controls before and after creating a “rewind” effect
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To add a speed ramp:

>>With a clip’s retime controls exposed, open any Clip Speed pop-up menu and choose one 
of the two options from the Speed Ramp submenu to replace the current speed effect with 
a series of five speed segments that start at 10% and increase progressively to 30%, 50%, 
70%, and then 90%. Once created, you can drag the speed points to customize this effect 
to create whatever durations you require.

Speed effect controls set to create a gradual ramp from 0 to 100 percent playback speed

Closing Retime Controls

When you’re finished creating your Retime effect, you can close the Retime controls so that clip 
assumes a normal appearance again. Closing the Retime controls has no effect on the timing of the 
clip, it just ensures you cannot accidentally modify the speed of the clip with the mouse.

To close the Retiming controls in the Timeline:

>> Click the X button at the upper left-hand corner of the Retime control box.

>> Select the retimed clip, and either choose Edit > Retime Clip, or press Command-R.

When a retimed clip has its Retiming controls hidden, a Retime badge appears to the left of that 
clip’s name in the Timeline. You can reopen the Retiming controls whenever you need to make 
further changes.

The speed effect badge that shows a clip is being retimed
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To reopen the Retiming controls in the Timeline:

>> Select the retimed clip, and either choose Edit > Retime Clip, or press Command-R.

Once you’ve retimed a clip using the Retime effect, you can use that clip’s Retime Process parameter 
in the Inspector to define how that clip’s retiming is processed, using the low quality Nearest option, 
using Frame Blending, or using Optical Flow. 

Speed Effect Processing

Once you’ve retimed a clip, you have the additional ability to change how the retimed clip is 
processed in order to improve its visual playback quality, especially in the case of clips that are 
slowed down. There are two ways you can set this. First, there’s a project-wide setting available in 
the Master Project Settings. Secondly, you can change how clips are retimed via a per-clip setting 
available in the Inspector.

To change the Retime Process setting of an entire project:

1. 	 Open the Project Settings in the Master Project Settings panel.

2. 	 Scroll down to the bottom, and choose an option from the Retime Process pop-up menu.

To change an individual clip’s Retime Process setting:

>> Select a clip, then open the Inspector and choose an option from the Retime Process pop-
up in the Retime and Scaling group.
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Most parameters in the Inspector of the Edit page can be keyframed, in order to create animated 
effects such as zooming in via the Zoom parameter, fading out via the Opacity parameter, or 
cropping from one side to reveal a clip underneath via the Cropping parameters. Additionally, if you 
import a project from an NLE that has keyframed sizing settings, those keyframes will be imported 
and exposed within Resolve.

The primary controls for keyframing are within the Inspector. Any parameter that can be keyframed 
has a gray keyframe button to the right of its slider. If the playhead is on a keyframe, this button 
turns orange and small navigation arrows appear to its right and left, otherwise it stays gray.

Orange Keyframe buttons in the Inspector show there’s a keyframe at that frame

Once you’ve keyframed one or more parameters within a particular group in the Inspector, that clip 
displays a small button at the far right of its name bar in the Timeline. Only keyframed clips have 
this button.

The Keyframe track button in the Timeline appearing on a keyframed clip

Clicking this button exposes the keyframe tracks for that clip. Each group of parameters in the 
Inspector has a single keyframe track, that holds all the keyframes of all the parameters within that 
group. For example, the Pan, Tilt, Zoom, Rotation Angle, and Anchor Point keyframes all appear 
within the Transform track.

Keyframing Effects in the Edit Page
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Additionally, each keyframe track has a Curve button that, when clicked, exposes that parameter 
within a Curve Editor that’s attached to the clip in the Timeline.

A clip’s curve editor showing the Opacity curve

Multiple parameters can be opened within the Curve Editor at the same time, and you can choose 
which curve to work on by clicking it in the Curve Editor, or clicking one of that parameter’s keyframes 
in the keyframe track above. Selected control points can be moved, and their bezier interpolation 
changed using one of the four buttons located at the top of the Curve Editor.

Keyframing in the Inspector

Keyframing in the Edit page works slightly differently than when using the keyframe editor in the 
Color page. Most simple keyframing tasks can be performed in the Inspector using three buttons 
that appear to the right of any parameter that’s capable of being keyframed.

The three keyframe controls that appear in the Inspector, from left to right:  

Previous keyframe, Create/Delete keyframe, Next keyframe

A keyframe track for all of the Transform group parameters
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Methods of keyframing parameters in the Inspector of the Edit page:

>> To add a keyframe: Select a clip, open the Inspector, then move the Timeline playhead 
to the frame where you want to place a keyframe, and click the Keyframe button next 
to the parameter of the Inspector you want to animate. Once you’ve added at least one 
keyframe to a parameter, all other adjustments you make to parameters in the Inspector, 
or using the on-screen Transform/Crop controls in the Timeline Viewer add new keyframes 
automatically if the playhead is at another frame.

>> To move the playhead to the next or previous keyframe: Right-Bracket ( [ ) and Left-Bracket 
( ] ). You can also click the small left- or right-hand arrow to either side of a parameter’s 
keyframe control to jump the playhead to the next or previous keyframe.

>> To edit an existing keyframe of a parameter: Move the playhead to be on top of the 
keyframe you want to edit, and then change that parameter, either in the Inspector, or 
using the on-screen controls of the Timeline Viewer.

>> To delete a single keyframe: Open the Inspector, move the Timeline playhead to a frame 
with a keyframe, and click the orange Keyframe button in the Inspector to delete it.

>> To delete all keyframes for one parameter: Click the reset button to the right of a parameter’s 
keyframe control in the Inspector.

>> To delete all keyframes in a group of parameters in the Inspector: Click the reset button to 
the right of a parameter group’s title bar in the Inspector.

>> To disable or enable a single parameter’s keyframed effect: Click the orange dot at the left 
of a parameter’s keyframe track in the Timeline. Orange means that track’s enabled. Gray 
is disabled.

>> To disable or enable a group of parameters in the Inspector: Click the orange dot at the 
left of a parameter group’s title bar in the Inspector. Orange means that group is enabled. 
Gray is disabled.

Keyframing in the Timeline and Curve Editor

If you need to do more complicated keyframing than the relatively simple controls of the Inspector 
allow, you can use the Keyframe tracks and Curve Editor found in the Timeline.

The Keyframe Editor

When one or more clip parameters are keyframed, a small button appears at the far right of a clip’s 
name bar in the Timeline. Clicking this button opens the Keyframe editor, exposing one keyframe 
track for each group of parameters that’s keyframed. For example, Pan, Tilt, Zoom, and Rotation 
Angle keyframes all appear within a single keyframe track labeled Transform.
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These Keyframe tracks can be opened so you can drag keyframes left or right to control their 
timing. While you drag a keyframe, a tooltip appears showing you that keyframe’s offset in frames 
from the beginning of that clip’s source media, and the name of the parameter you’re modifying. 
You also have the option of disabling or re-enabling an entire track of keyframes by clicking the 
orange button at the far left of each Keyframe track. Click the small button at the bottom right of 
the clip’s name bar to close the Keyframe tracks when you’re finished.

The Curve Editor

If you want to work with keyframes in more detail, you can click the small Curve Editor button at the 
right of any Keyframe track, which opens the Curve Editor below.

The Curve Editor open in the Timeline

(Left) Button for opening Keyframe tracks, (Right) Keyframe tracks open in the Timeline
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You can open multiple parameters into the Curve Editor by clicking each Keyframe track’s Curve 
Editor button. When a group of parameters, such as Transform, is opened in the Curve Editor, a 
pop-up to the right of the Keyframe track’s Curve button lets you choose which parameters are 
exposed via checkboxes.

Choosing which parameters to display in the Curve Editor

While you can only work on one curve at a time, you can choose which curve is selected to edit. 
Using the control points exposed by each curve, you can edit parameters, alter keyframe timing, and 
change each control point’s interpolation to create custom easing effects affecting the acceleration 
of change from one keyframe to the next.

Methods of keyframing parameters in the Inspector of the Edit page:

>> To switch which curve you’re editing: Click the curve you want to edit in the Curve Editor so 
its name appears at the left of the Curve Editor’s title bar.

>> To drag a control point on a curve: Click any control point and drag left or right to retime 
it, and up or down to change the value of the control point. Once you begin to move the 
pointer, the control point is constrained in that direction.

>> To add a new control point to a curve: Option-click anywhere on a curve to add a new 
control point.

>> To delete a control point from a curve: Right-click a keyframe and choose Delete form the 
contextual menu.
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>> To change the interpolation of a control point: Click the control point you want to edit, and 
then click one of the four bezier interpolation buttons in the Curve Editor title bar.

>> To adjust a bezier handle: Drag the bezier handle in any direction to alter the curve.

The Curve Editor with bezier interpolated keyframes

When you’re finished working with the Curve Editor, do one of the following:

>> Click the Curve Editor button at the right of any Keyframe track to close that parameter or 
group’s curve.

>> Click the small button at the bottom right of the clip’s name bar to close the Keyframe 
tracks and the Curve Editor all at once.
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Paste Attributes

You can copy and paste attributes from one clip to multiple clips using the Paste Attributes 
command. This is a fast way to apply effects from one clip to many others in the Timeline.

To copy attributes:

1. 	 Select a clip with attributes you want to apply to other clips, and press Command-C.

2. 	 Select one or more other clips to paste to.

3. 	 Choose Edit > Paste Attributes (Option-V). 

4. 	 When the Paste Attributes window appears, click the checkboxes of each of the attributes you 
want to paste, and click Apply when you’re done.

The Paste Attributes window shows you the clip you’re copying from and the clip(s) you’re pasting 
to at the top, and provides checkboxes you can use to select which attributes you’d like to paste. 
A pop-up menu below lets you choose how you’d like to apply any keyframes that are part of the 
attributes being pasted; the options are Maintain Timing or Stretch-to-Fit.

The Paste Attributes window



8
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Working With Audio

DaVinci Resolve has simple, but effective, features for working with audio in your timelines. Whether 
you’re adjusting synced audio for dailies, finessing the levels of an edited project you’re assembling, 
or importing and laying in audio mix files from the sound designer to output for mastering, DaVinci 
Resolve has Level, Pan, and Channel Assignment controls that let you control your audio output for 
both monitoring and delivery.

Assigning Audio Channels in the Media Pool� 350

Working With Audio Clips in the Timeline� 352

Editing Audio Into the Timeline� 352

Understanding Multi-Channel Timeline Tracks� 352

Displaying Waveforms in the Timeline� 354

Setting Clip Levels and Pan in the Inspector� 355

Keyframing Audio� 355

Audio Fade Handles� 356

Audio Crossfades� 357

The Audio Mixer� 358

Track Mixing vs. Clip Mixing� 358

Audio Mixer Controls� 359

Disabling Track Audio vs. Muting Tracks� 360

Timecode Synced Audio Playback� 361
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When you first import audio into the Media Pool, it’s a good idea to make sure that whatever 
channels those files contain are assigned correctly before you start editing clips into the Timeline. 
In other words, you want to make sure that stereo files are set to be stereo clips, that 5.1 files are set 
to be surround clips, and that multi-channel files are set to expose however many channels you want 
to actually use in your program.

This is particularly important when clips have more than two channels of audio. For example, 
production sound recordists might record six or more audio channels, corresponding to a variety of 
microphones on set along with a pair of mixdown tracks. In this case, you need to define how many 
of these channels you want to actually play back in the Timeline. In this case, you might choose to 
only work with the two mixdown channels.

Clip channel assignments are made in the Audio panel of the Clip Attributes window, in the 
Media page.

Mono, stereo, and 5.1 clips are handled automatically, but multi-channel clips needing custom 
assignments in the Media Pool should be taken care of immediately, so that DaVinci Resolve can 
more easily place incoming audio clips into the correct track of the Timeline. 

Each clip has the following options:

>>Number of Audio Tracks: The number of source clip channels is given here; you can also 
change this value to redefine how many audio channels are mapped to the Edit timeline, 
excluding channels you don’t want to use.

Assigning Audio Channels in the Media Pool

The Channels controls in the Audio panel of the Clip Attributes window
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>> Channel Format: Select Stereo, Mono or 5.1 as appropriate for your clip. The selected 
channel format determines how many channels appear in the Source Channel list below.

>> Source Channel list: Each channel defined by the Channel Format setting presents an item 
on this list; a pop-up menu lets you select which source clip channel is routed to each 
of the tracks presented in the Timeline, and will determine how audio is output via the 
Audio Mixer.

You can alter the clip attributes for clips one at a time, or for multiple selected clips at once.  
For more information on these settings, see “Changing Clip Attributes” in Chapter 4, “Media.”
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Working With Audio Clips in the Timeline

A separate set of audio tracks contains the audio portion of video clips, as well as any stand-
alone audio files that might be imported along with an AAF or XML file, or that you edit into the 
Timeline yourself.

Editing Audio Into the Timeline

In the Edit page, opening an audio-only clip into the Source Viewer results in a split view of the 
waveform, with the complete waveform shown in the bottom half, and a zoomed in view of the 
waveform in the top half. This makes it easy to find the section of audio you need relative to the 
entire clip, and yet still place In and Out points with great precision.

You can set In and Out points for audio clips just like any other clip, in preparation for editing. 
However, the audio of clips with a particular number of audio channels must be edited into a 
Timeline track that is compatible with the number of audio channels you’re editing.

Understanding Multi-Channel Timeline Tracks

All multi-channel audio clips are fit into a single audio track that’s set to accommodate the number 
of channels within that clip. This means that whether an audio clip is stereo, 5.1, or has an arbitrary 
number of channels that were recorded in the field, it will fit into the Timeline as a single clip on a 
single track.

When you first create a new audio track, you have to choose what kind of audio track it will be. Right-
clicking in the bottom audio portion of the Timeline track header reveals a contextual sub-menu 
that lets you create one of three different kinds of audio tracks.

An audio clip opened into the Source Viewer
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>> Adaptive: Capable of holding up to 16 audio channels. An adaptive audio track can hold 
many different clips with different combinations of channels, up to the maximum number of 
channels allowed to that track. The number of channels allowable on a particular Adaptive 
track is user-definable (1–16) at the time that track is created. If you edit a clip with more 
channels into an Adaptive track that was created to hold fewer channels, the extra channels 
are ignored.

>>Mono: Holds a single channel.

>> Stereo: Holds stereo left and right channels. Stereo tracks can be panned.

>> 5.1: Holds the six channels corresponding to a 5.1 surround mix: left, center, right, surround 
left, surround right, and LFE.

If you edit a multi-channel audio clip into a Timeline that doesn’t have the correct type of track, a 
new audio track will be automatically created with the closest appropriate channel count. However, 
if you want to exert the most control over the organization of the Timeline, it’s best to make the 
appropriate clip assignments in the Media page first, and then set up your Timeline with audio 
tracks of the appropriate type.

Note: It is not possible to change what type of channels a track is set up for after it’s been created.

Four audio tracks with each type of audio track shown. From the top down, Stereo, Mono, 5.1, Adaptive
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Displaying Waveforms in the Timeline

The Timeline View options palette lets you turn Audio Waveform display on and off via a checkbox.

While audio waveforms are displayed, a small button in the lower right-hand corner of multi-channel 
audio clips lets you toggle between seeing a single averaged waveform that represents that clip’s 
Audio, and seeing each individual waveform in a vertical stack.

Top: Stereo audio drawn as individual waveforms.  

Bottom: Audio channels drawn as a single averaged waveform

Whenever you cut an audio clip, you cut all audio channels with it. Audio channels cannot be 
individually edited, but audio channels can be enabled and disabled individually using the Clip 
Attributes command in the Media Pool. For more information, see “Changing Clip Attributes” in 
Chapter 4, “Media.”

The Audio Waveform display option in the Timeline View pop-up
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Setting Clip Levels and Pan in the Inspector

Each clip has individual Level and Pan parameters, accessible in the Inspector when an audio clip 
is selected.

Selecting an audio clip in the Timeline and adjusting its Volume or Pan only alters that clip, which 
lets you set basic levels for individual clips in your program.

Keyframing Audio

There are two ways you can keyframe audio in the Edit page. You can use each clip’s Level Curve 
in the Timeline, or you can use the keyframe controls in the Inspector to animate the Volume 
or Pan of individual clips as you would any other clip attribute, fading the level up or down, or 
panning from left to right. For more information on keyframing in the Edit page, see Chapter 7, 
“Edit Page Effects.” Any Volume keyframes you create using the Keyframe controls of the Inspector 
automatically appear on the Volume Curve of that audio clip in the Timeline.

Using Level Curves

Each audio clip in the Timeline appears with a green curve control overlaid on top of it, that by 
default starts out completely flat. Similar to such controls found in other applications, the Level 
Curve lets you alter each clip’s volume, either overall, or dynamically using keyframes.

The Volume and Pan parameters available for audio clips in the Inspector

Level curves adjusting the level of a clip’s audio in the Timeline
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Methods of adjusting Volume curves

>> To adjust any level curve segment, position the pointer on top of the curve segment you 
want to raise or lower, and when the move cursor is displayed, click and drag up to raise the 
level, or down to reduce the level.

>> To add keyframes to the level curve, hold the Option key down and click the curve to place 
a keyframe at that frame. You must add at least two keyframes to create an automated 
change in volume.

>> To adjust keyframes on a level curve, move the pointer over a keyframe so that the four-way 
cursor appears, and then click and drag in the intended direction of adjustment, either 
vertically to change the volume of the clip at that frame, or horizontally to move the keyframe 
to a different point in time. Once you start dragging a keyframe into a particular direction, 
keyframe movement is constrained in that direction until you release that keyframe.

>> To delete keyframes from a level curve, open the Inspector, move the playhead to the 
frame of the keyframe you want to delete, and click the orange Keyframe button to make 
it disappear.

Audio Fade Handles

When you position the pointer directly over an audio clip, a pair of Audio Fade handles appear at 
the In and Out points.  Dragging each of these handles towards the center of the clip lets you fade 
in the clip volume at the beginning of the clip, and fade out the clip volume at the end of the clip.

Note: When you import a Final Cut Pro X project, the fade handles for each clip automatically 
import as well.

Audio Fade handles at either end of an audio clip
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Audio Crossfades

You can also add Cross Fade transitions to any edit point between two overlapping audio clips. 
Cross Fade transitions fade the volume of the outgoing clip down while simultaneously fading the 
volume of the incoming clip up, letting you create a smooth aural transition between two 
audio clips.

An audio Cross Fade transition applied between two clips

You can double-click a Cross Fade transition to open it into the Inspector, revealing the 
following parameters:

>> Duration: The duration of the transition, shown in both seconds and frames.

>> Alignment: A pop-up that lets you choose the transition’s position relative to the edit point 
it’s applied to. Your choices are “End on Edit,” “Center on Edit,” and “Begin on Edit.”

>> Transition style: For Cross Fade transitions, there is only one style available.

>> Fade In/Fade Out levels: There are three options that affect the incoming and outgoing 
halves of the Cross Fade effect independently. 0dB applies a linear fade. +3dB applies 
a boosted curve; when applied to both Fade In and Fade Out, this can compensate for 
diminished levels in the middle of a Cross Fade. -3dB applies an attenuating curve, which 
deliberately lowers the level of the Cross Fade.
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The Audio Mixer

The Audio Mixer provides a set of graphical controls you can use to set levels, pan stereo audio, and 
mute and solo tracks, while you work. The Audio Mixer can only be opened from the Edit page.

To open the Audio Mixer:

Choose View > Audio Mixer.

The Audio Mixer exposes channel strips with controls for the tracks in the Timeline, one for each 
track, plus an Output strip that adjusts the overall level of the mix.

Track Mixing vs. Clip Mixing

How the Audio Mixer functions depends on the mode pop-up menu at the upper right-hand corner. 
There are two modes, Track and Clip:

>> Track Mode: While in Track mode, each channel strip’s controls affect the audio of every 
single clip on a particular track. Furthermore, the Channels pop-up menu corresponding 
to the Output controls lets you define how many channel outputs you’re sending to your 
A/V output device for monitoring, and Channels pop-up menus for each audio track let you 
assign which output channels that track is mapped to.

The Audio Mixer, with three channel strips corresponding to the three tracks in the Timeline
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>> Clip Mode: While in Clip mode, each fader’s controls affect only the clip in each track that 
intersects the playhead at that time. Using the Audio Mixer in this mode when a clip is 
keyframed results in additional keyframes added to whichever clip intersects the playhead 
on the track being adjusted.

There are entirely separate controls for making track-based audio adjustments. These can be 
accessed via the pop-up at the upper right-hand corner of the Audio Mixer.

Audio Mixer Controls

Each track’s channel strip has the following controls:

>>Name: The name of the audio track that channel strip corresponds to.

>>Mute: Mutes that track. Orange when enabled.

>> Solo: Mutes all tracks other than ones that are soloed. Blue when enabled.

>> Stereo/Mono toggle: This button toggles that track between Stereo mode (the button is 
highlighted orange, channels are shown as “1 + 2”) or Mono mode (the button is gray, 
channels are shown as “1, 2”). In Stereo mode, stereo panning is enabled. In Mono mode, 
stereo panning is disabled.

>> Send pop-up: Reveals a set of checkboxes that lets you send that track’s audio to multiple 
outputs. 5.1 tracks have a button that opens a Channel Output Mapping window with pop-
ups to map each of the six 5.1 audio channels. The settings you choose here determine how 
audio is output when rendered or output to tape in the Deliver page.

>> Pan knob: Lets you pan a Mono channel’s audio from left to right, or invert a Stereo channel’s 
left and right audio channels. The pan knob is disabled for 5.1 tracks.

>> Fader: A vertical slider that lets you adjust the volume of the channels on that track.

>>Weighted dBFS audio meters: Audio meters to the right of each fader display the audio 
volume of all channels on that track during playback. Each channel strip has individual 
meters corresponding to the number of channels that track has been set to accommodate. 

The Output strip has the following controls:

>>Mute: Mutes all audio playback from all tracks.

>>Output pop-up: (Only enabled in Track mode) Lets you set how many channel outputs of 
the available A/V interface are available for audio assignments.

>> Fader: A vertical slider that lets you adjust the volume of the entire mix.

>>Weighted dBFS audio meters: Audio meters display the audio volume of the entire mix 
during playback. The number of individual meters corresponds to the number of outputs 
that have been selected.

The controls of the Audio Mixer cannot currently be automated.
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Disabling Track Audio vs. Muting Tracks

When you use the mute or solo controls of the Audio Mixer, track audio is disabled during playback. 
However all muted (or non-soloed) tracks are re-enabled for output to tape or rendering as file-
based output when you use the controls in the Deliver page. If you want to disable tracks for output, 
you can use the Enable Track button, in the track header of the Timeline in the Edit page or the 
Deliver page, to turn any tracks off that you don’t want to output.
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DaVinci Resolve lets you synchronize a timeline to a timecode-controllable audio playback device 
connected externally, such as a DAT deck, so you can grade it within context to the program’s 
soundtrack, and host client review timelines with synced audio.

To synchronize a timeline to audio from a timecode-controllable playback device:

1. 	 Right-click the Timeline you want to link audio to, and choose Chase Audio Settings.

2. 	 Turn on the “Enable External LTC” checkbox to sync that Timeline to a timecode controllable 
device connected to your workstation.

3. 	 If necessary, enter a Synchronization Delay to account for any latency between DaVinci Resolve 
and the audio playback device you’re using, using the pop-up menu to the right to choose 
either seconds or frames for the delay.

4. 	 When you’re finished, turn on the Enable checkbox and click Apply.

Once synchronized, LTC timecode output from your Resolve workstation’s video I/O card (audio 
channel 16 of a DeckLink or UltraStudio interface) will lock and synchronize the external audio 
device whenever you play the Timeline.

Timecode Synced Audio Playback
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Preparing and Conforming Projects

This chapter provides detailed information about the nuts and bolts of project import, with in-depth 
information about preparing projects for import into DaVinci Resolve, how effects are imported 
and handled, and how to conform XML, AAF, and EDL project exchange formats in the Edit page. 
Additional information is provided about Stereoscopic workflows and copying grades from one 
project or timeline to another using the powerful ColorTrace™ function.

Preparing Your Project for Color Correction� 365

Move Clips to the Lowest Video Track� 365

Organize Unsupported Media Files� 365

Creating an Offline Reference Movie� 365

Mixed Frame Sizes and Mixed Codecs� 366

Mixing Frame Rates� 366

Importing Effects When Conforming Edits� 368

Rules for Conforming Media in DaVinci Resolve� 374

Defining Clip Metadata When Importing XML and AAF� 374

Defining Clip Metadata When Adding Media to the Media Pool� 376

How Reel Names are Identified� 377
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Examples of Reel Name Extraction Patterns� 379

Consolidate Media� 381

Conforming Projects� 384

Workflows that Start With DaVinci Resolve� 385

Digital Dailies in a Round Trip Workflow� 385

Conforming XML Files� 390

Preparing An XML Round Trip� 390

Importing XML Project Files� 390

Conforming AAF Files� 395

Supported Media Types in AAF Round Trips� 395

Performing an AAF Avid Round Trip� 397

Relinking Transcoded Media to AMA Media� 403

Conforming EDL Files� 405

EDL Export of a Project and Its Media� 406

Conforming EDLs to Individual Media Files� 406

Preconforming “Flat” Media Files to EDLs� 408
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Conforming “Flat” Media Files Using Split and Add� 409

Importing an EDL to a New Track� 410

Checking a Conform Using an Offline Reference Clip� 412

Setting Up an Offline/Timeline Comparison� 412

Fixing Common Conform Problems� 415
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When you’re preparing to move a project from another NLE to DaVinci Resolve, there are a few 
steps you can take to make your work more organized.

Move Clips to the Lowest Video Track

Increasingly, editors are using the multiple tracks NLEs offer as they build the creative edit of a 
show. While this is convenient for offline editorial, it is less convenient when you’re trying to conform, 
grade, and render the media used by a project as quickly and efficiently as possible.

For this reason, it’s a good idea to move all clips that are not stacked or superimposed as part of 
a compositing operation down to track V1 of the Timeline in your NLE. This produces a simplified 
edit that has many advantages. The project becomes smaller to move because there’s less media 
in the Timeline, and consequently becomes faster to render. Furthermore, the colorist is spared 
confusion because this eliminates “hidden” media that is nonetheless connected to other clips that 
can be seen.

It’s also helpful, once you’ve reorganized the Timeline, to eliminate any empty tracks that are left. 
This can be done from within DaVinci Resolve, but doing it in your NLE further simplifies the project 
import process.

Organize Unsupported Media Files

Depending on your workflow and on the NLE you’re working with, there may be clips that will not 
be supported in DaVinci Resolve. Unsupported generators, unsupported types of title objects, 
unsupported media formats, and other effects constructs may simply not be seen in Resolve, and 
will consequently appear as unlinked clips.

Knowing this in advance, you can move all such clips into dedicated tracks where they can be 
isolated, and the track can be turned off to hide the unsupported clips, simplifying timeline 
navigation. This also saves the colorist from the need to worry about why there are offline clips in 
the Timeline at 3 o’clock in the morning, immediately before starting a render.

Creating an Offline Reference Movie

Even though the colorist in any given workflow is likely to be building new grades from scratch, 
it can be valuable to have a reference movie showing any color corrections, filters, or effects that 
the offline editor applied during the editing process. This offline reference can be imported into a 
Resolve project, and used as a split- screen reference whenever there’s some question about a look 
or effect from the offline edit.

Offline reference movies also serve as a useful tool when conforming a project in the Edit page. After 
project conform, you can compare the project as seen in the Record Viewer with the synchronized 
offline movie as seen in the Source Viewer set to Offline mode. This makes it easy to scrub through 
a project to make sure that each clip has imported correctly and is in sync.

Preparing Your Project for Color Correction
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Mixed Frame Sizes and Mixed Codecs

Most NLEs can freely mix media using different frame sizes, different codecs, and different frame 
rates. DaVinci Resolve deals with these combinations in different ways, depending on what settings 
you’ve selected in the Project Settings.

>>Mixing Frame Sizes: Mixed frame sizes are easily handled. The Set Timeline Resolution To 
parameter in the Master Project Settings panel of the Project Settings dictates the current 
resolution of the project. Any clips with a frame size that doesn’t match the project is resized 
according to the option selected in the Image Scaling panel of the Project Settings. You 
can, of course, always manually readjust the sizing of any clip if you want to make a specific 
adjustment. All resizing is done using the optical-quality resizing algorithms in DaVinci 
Resolve. For more information, see Chapter 6, “2D Transforms.”

>>Mixing Codecs: Mixed codecs are also not a problem, as long as the different codecs used 
by the media in your project are compatible with the list of codecs and formats that DaVinci 
Resolve supports. For more information about the currently supported list of codecs and 
formats, check the Blackmagic Design support page for DaVinci Resolve. This list is updated 
often with newly supported formats.

Mixing Frame Rates

DaVinci Resolve also supports mixed frame rates, although there are a variety of settings you must 
choose to ensure the best results. By default, mixed clip frame rate support is enabled via the 
“Mixed frame rate format” pop-up menu that appears either in the Master Project Settings, or in 
the Import AAF or XML dialog. 

The different options available in the “Mixed frame rate format” pop-up are available to let you 
conform projects using the method of mixed frame rate calculation used by the NLE a project was 
originally edited in; different NLEs have different ways of mixing frame rates, and that used by Final 
Cut Pro 7 is different from that used by Final Cut Pro X or Avid Media Composer. If you need to 
change this setting, you must do so before you import any media into the Media Pool; once the 
Media Pool is populated, this setting can no longer be changed.

Mixed frame rate format selection
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This Mixed frame rate format pop-up menu is also found in the Load AAF and Load XML dialogs. 
Resolve automatically chooses a setting from the “Mixed frame rate format” pop-up menu that 
corresponds to the project file you’re importing, but you can override this setting if necessary. For 
projects sent from Final Cut Pro, you can choose either “Final Cut Pro 7” or “Final Cut Pro X” to 
match the type of project you’re importing. On the other hand, you should choose “Resolve” for 
projects imported from Premiere Pro, Smoke, Media Composer, or other NLEs.

When “Mixed frame rate format” is set to anything but None, DaVinci Resolve conforms and 
processes all clips in the Timeline to play at the frame rate that’s selected in the “Calculate Timecode 
At” pop-up menu. For example, 23.98, 29.97, 30, 50, 59.94 and 60 fps clips will all play at 24 fps if 
that’s what “Timeline frame rate” is set to in the Master Project Settings. Clips with different source 
frame rates will be retimed to match the timeline conform frame rate. 

The Retime process that’s used to render clips with differing frame rates can be changed for 
individual clips via the Retime Process parameter in the Inspector, or it can be changed project-
wide using the Retime Process parameter found in the Editing panel of the Project Settings. For 
more information on how each of the three available options work, see the “Frame Interpolation” 
section of Chapter 2, “Project Manager and Settings.” 

If you choose “None,” then clips with mixed frame rates will ignore their original frame rate and will 
play at the timeline rate, resulting in either faster or slower motion, depending on the difference 
between the original and timeline frame rates.

Note: Because DPX files often either lack or have incorrect frame rate information in the header 
data, you may need to select None when conforming a project using image sequences to make 
sure your media is not incorrectly interpreted.

How clips in mixed frame rate timelines are rendered depends on whether the Render Settings are 
set to render individual source clips or one single clip. When you render the Timeline as ”Individual 
Source Clips,” then all clips are rendered individually at their original frame rate. If you select ”Single 
Clip,” then all clips are converted to the “Timeline frame rate” frame rate setting, and rendered as 
a single media file.
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Importing Effects When Conforming Edits

DaVinci Resolve is capable of translating a subset of the effects exported within XML, AAF, and 
EDL project files into their Resolve equivalents. The following chart illustrates which effects are 
supported, and for which project import formats.

Unsupported effects are neither imported nor displayed in Resolve. However, the majority of 
unsupported effects are preserved internally, and are reinserted into exported XML or AAF files so 
that those effects will reappear in your NLE once the project is reimported.

EDL FCP 7 XML FCP X XML AAF

Color Corrections No No Yes No

Composite Modes No Yes Yes Overlay only

Multiple Tracks No Yes Yes Yes

Transitions Yes Yes Yes Yes

Opacity Settings No Yes Yes
Yes, via 3D Warp 
or Superimpose

Position, Scale, Rotation No Yes Yes Yes, via 3D Warp

Linear Speed Effects Yes Yes Yes Yes

Variable Speed Effects No Yes Yes Yes

Still Image Clips No
.tif, .jpg,  

.bmp, .dpx, 
.dng, .psd

.tif, .jpg,  
.bmp, .dpx, 
.dng, .psd

.tif, .jpg,  
.bmp, .dpx, 
.dng, .psd

Freeze Frames No No No Yes

Nested Sequences No Yes Yes No

Linked Clip Audio Yes Yes Yes Yes

Mixed Frame Rates No Yes Yes Yes

Text Generators No Yes Yes No

Effects supported with imported AAF, XML and EDL
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About Supported Color Corrections

At the time of this writing, only Final Cut Pro X XML projects are capable of exporting color 
correction data that can be imported as primary grades in DaVinci Resolve. For obvious reasons, 
color correction import is a one-way street, and imported color corrections cannot be output 
back to Final Cut Pro. Imported Final Cut Pro X color adjustments appear in the Color page as 
primary corrections.

Other workflows for importing color correction information are available using ColorTrace to import 
grade data from CDLs. For more information, see the “Copying Grades Using ColorTrace” section 
later in this chapter.

About Supported Transitions

EDLs are the most restrictive when it comes to transition support in Resolve, as only Cross Dissolves 
will be read. Any other transitions appearing in an EDL will be automatically converted to a Cross 
Dissolve of the same duration when it’s imported into DaVinci Resolve.

On the other hand, Resolve supports the import of ten different transitions when importing XML 
project files from Final Cut Pro 7 and Final Cut Pro X, or nine different transitions when importing 
AAF files from Avid Media Composer or Symphony.

EDL FCP XML AAF

Clock Wipe No Yes Yes

Center Wipe No Yes Yes

Cross Dissolve Yes Yes Yes

Additive Dissolve No Yes No

Dip to Color Dissolve No Yes Yes

Edge Wipe No Yes Yes

Venetian Blind Wipe No Yes Yes

Cross Iris No Yes Yes

Diamond Iris No Yes Yes

Oval Iris No Yes Yes

Supported transitions for imported EDL, XML and AAF
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Transition Names

To help you prepare projects for export, note that the names of transitions vary between XML 
and AAF project files. Here are the supported transitions as they appear in Avid Media Composer 
and Symphony.

>> Dip to Color Dissolve = Dip to Color effect in the Blend category

>> Edge Wipe = Horizontal/Vertical/Lower Left/Lower Right/Upper Left/Upper Right Diagonal 
effects in the Edge Wipe category

>> Center Wipe = Horizontal Open and Vertical Open effects in the Edge Wipe category

>> Clock Wipe = Clock effect in the Shape Wipe category

>> Venetian Blind Wipe = Vertical Blinds and Horizontal Blinds effects in the Shape Wipe category 

>> Cross Iris = 4 Corners effect in the Shape Wipe category

>> Diamond Iris = Diamond effect in the Shape Wipe category 

>>Oval Iris = Circle effect in the Shape Wipe category

About Supported Opacity, Position, Scale, and Rotation Settings

DaVinci Resolve supports the import of Opacity, Position, Scale, and Rotation settings when 
importing XML project files from both Final Cut Pro 7 and Final Cut Pro X. Imported Composite and 
Transform settings for any given clip appear in the Inspector of the Edit page, or in the Edit Sizing 
mode of the Sizing palette in the Color page. If these settings have been keyframed, the animation 
will appear in DaVinci Resolve.

DaVinci Resolve supports the import of Opacity, Resize and 3D Warp effects when importing AAF 
files from Media Composer or Symphony, which are converted into Pan, Tilt, Zoom, and Rotate 
settings in Resolve. As of Resolve version 11.1, there is also improved support for Bezier and cubic 
interpolated keyframes in AAF files.

About Speed Effects

DaVinci Resolve supports the import of Speed Effects from different applications, but different 
project formats have different Speed Effect support.

>> EDL: Resolve only supports the import of linear Speed Effects when importing EDLs. 

>> XML: Resolve supports the import of both linear and variable Speed Effects when importing 
XML project files from both Final Cut Pro 7 and Final Cut Pro X. In Resolve version 11.1, XML 
from Final Cut Pro X can also provide information about whether frame blending or optical 
flow is used, and also contains information about the Bezier curve transitions of speed effects.

>> AAF: Resolve supports the import of both linear and variable Speed Effects when importing 
AAF files from Media Composer or Symphony that use Timewarp effects.
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About Nested Sequences and Compound Clips

DaVinci Resolve supports the import of nested sequences from Final Cut Pro 7 and of compound 
clips from Final Cut Pro X. Both appear within Resolve as compound clips, in both the Timeline and 
the Media Pool. As of Resolve version 11.1, compound clips with mixed frame rates are supported, 
as well as multi-cam and a/v synchronized clips from Final Cut Pro X, which will be represented in 
Resolve as compound clips. For more information about creating and using compound clips in 
Resolve, see the “Compound Clips” section of Chapter 4, “Edit.”

About Supported Composite Modes

DaVinci Resolve supports the import of eight different Composite modes when importing XML 
project files from both Final Cut Pro 7 and Final Cut Pro X. When importing AAF files from Media 
Composer, the Overlay composite mode is supported when the source AAF file has a Superimpose 
effect applied to it.

About Supported Still Image Formats

DaVinci Resolve supports the import of greater-than-one-frame-in-duration TIF, JPG, PNG, DPX, 
and DNG still image files that appear in Final Cut Pro 7 and Final Cut Pro X XML files, and AAF 
files exported from Media Composer. These clips appear as ordinary clips in the DaVinci Resolve 
Timeline. Export of still images is limited to Final Cut Pro 7 and Final Cut Pro X XML.

FCP 7/X XML AAF

Add Yes No

Subtract Yes No

Difference Yes No

Multiply Yes No

Screen Yes No

Overlay Yes Yes

Lighten Yes No

Hardlight Yes No

Softlight Yes No

Darken Yes No

Supported composite modes with imported XML and AAF 
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About Supported Alpha Channels

Media with embedded alpha channels is supported for any project as long as it’s in a media format 
that DaVinci Resolve supports; this includes TIFF, OpenEXR image sequence formats, and four-
channel QuickTime formats such as ProRes 4444. Alpha channels are automatically enabled, and 
can be used for compositing directly within the Resolve Timeline.

While alpha channels can be imported into Resolve, and can be used to composite layers in a 
timeline, alpha channels cannot be exported along with clips in round-trip workflows when rendering 
individual source clips. However, when rendering a program as a single clip, all composited effects 
are rendered together to produce a single output media file.

About Imported Text Effects

DaVinci Resolve supports the import of text generators when importing XML project files from both 
Final Cut Pro 7 and Final Cut Pro X. All imported text effects appear in the DaVinci Resolve Timeline 
as Basic text generators. Some, but not all, formatting parameters are imported, depending on the 
project file format being imported.
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Preparing Unsupported Clips and Effects You Want to Grade

If there is an unsupported effect within your NLE of choice that you want to move into DaVinci 
Resolve for grading (for example, clips with effects filters that are native to a particular NLE), here’s 
a simple workflow to follow.

To “bake” an effect into a clip you’re sending to DaVinci Resolve:

1.	 Export that clip as a self-contained media file using whatever Resolve-compatible mastering 
codec you prefer.

2.	 Reimport the resulting media file into your project.

3.	 Edit it into your project’s timeline to replace the original effects clip.

4.	 Export a version of the resulting sequence for use in Resolve.

This is a good way of prepping the titles and effects of projects that you want to finish in DaVinci 
Resolve. If you create self-contained media files for all title clips and effects, then these elements 
will import cleanly and easily, and you can export a complete, texted version of your program out 
of Resolve.

Additionally, if a composited clip is using unsupported effects (for example, a filtered still image 
with animated position that’s superimposed using the Overlay composite mode and set to 70% 
opacity), an ideal way to prep this clip for XML export to Resolve is to set the composite mode 
to Normal, set Opacity to 100%, and then export the resulting clip as a self-contained QuickTime 
movie. Reimport the result, edit it back into the Timeline to replace the original superimposed clip, 
and then set its composite mode to Overlay and its Opacity to 70% to match the original settings. 
Now the unsupported effects are “baked” into the clip, but the effects that Resolve does support 
are still live, and can be readjusted in context while grading.
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Rules for Conforming Media in DaVinci Resolve

When conforming projects in Resolve, the accuracy and integrity of your clip metadata is critical for 
a successful result. Keep the following three issues in mind when you’re preparing media to use in 
DaVinci Resolve.

>> Accurate timecode: Essential for every clip. If you have problems with your timecode, Resolve 
has tools you can use to edit or offset timecode to account for known inconsistencies. By 
default, the “Use Timecode” project setting is set to “Embedded in the Source Clip,” so 
that timecode is read from the embedded timecode track within a QuickTime or MXF file, 
or from the header data of a DPX frame file. However, you can also choose the “From the 
source clip frame count” option which enables timecode to be read from the Source clip’s 
frame count for image sequences.

>> Reel Name: Only used for conforming if “Assist using Reel Names” is on in the Master 
Project Settings panel of the Project Settings. Assigning reel names to your media is 
not essential, but recommended, and can make media management easier for certain 
operations. However, if you experience problems conforming clips with “Assist using Reel 
Names” turned on, you should try turning it off.

>> File names: Turning “Assist using Reel Names” off forces Resolve to refer to clips using file 
names when conforming XML and AAF projects. File names can only be only used when 
conforming XML or AAF files, or when importing a DaVinci project; file names are never 
used when conforming EDLs.

How DaVinci Resolve matches media files to clips in an imported project depends on how you’re 
importing the project.

Defining Clip Metadata When Importing XML and AAF

For workflows where you’re importing XML or AAF projects, and conforming the resulting clips 
in Resolve to media files that are either on disk or in the Media Pool already, the rules for how clip 
metadata is defined depend on two settings in the Load XML or EDL dialog: “Automatically Import 
source clips into media pool,” and “Ignore file extensions when matching.”

The ways in which these two checkboxes interact to let you choose how media is conformed to an 
imported AAF or XML file are complex, but here are the rules.

The most important settings for conforming media in the Load dialog
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Importing Clips With File Extensions Matching Those in the AAF or XML File

Turn “Automatically Import” on and “Ignore file extensions” off.

This is the default setting, and is most useful when the AAF or XML file you’re importing contains 
references to the high-quality media you want to grade, and you want to automatically add it to the 
Media Pool.

>> First, if there are already clips in the Media Pool, Resolve tries to conform as many of these 
clips as possible by matching the file paths in the XML or AAF to the stored file paths of 
each clip in the Media Pool. 

>> Second, for all remaining clips not found, Resolve imports as many clips as possible into the 
Media Pool from any storage volumes that are visible to Resolve, using the file paths from 
the XML or AAF.

>> Third, for all remaining clips not found, Resolve tries a clip name match of clips that are 
already in the Media Pool.

>> Fourth, for all remaining clips not found, Resolve tries a timecode match (along with a reel 
name match if this is enabled) of clips that are already in the Media Pool.

>> Finally, for all remaining clips not found, the user is prompted to manually choose another 
folder to search.

Importing Clips With Different File Extensions

Turn “Automatically Import” on and “Ignore file extensions” on.

Turning both of these options on is useful in situations where the sequence you’re importing was 
originally edited using offline quality media, and you want to conform to high-quality online media in 
a completely different format, possibly in the Media Pool, possibly on another disk. One example of 
this is as when the edit was done using QuickTime or Avid DNxHD media, but you’re reconforming 
to CinemaDNG files on another disk in order to grade the camera original raw media. Leaving 
“Automatically Import source clips into media pool” on, in this case.

>> First, if there are already clips in the Media Pool, Resolve tries to conform as many of these 
clips as possible by matching clip names.

>> Second, for all remaining clips not found, the user is prompted to choose another folder to 
search, and Resolve imports as many clips as possible by matching clip names.

>> Third, for all remaining clips not found, Resolve tries a timecode match (and reel name 
match if this is enabled) of clips that are already within the Media Pool.

>> Fourth, for all remaining clips not found, the user is prompted to manually choose another 
folder to search.
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Don’t Import Any Clips, Relink to Clips In the Media Pool Only

Turn “Automatically Import” off.

Turning “Automatically Import source clips into media pool” off is useful in situations where you 
only want to conform the imported AAF or XML to clips in the Media Pool. This is most useful in 
situations where you’ve imported all of the camera original media into the Media Pool first, for 
example when creating the dailies that were then edited, and you want to conform the imported 
AAF or XML to the media that’s already there.

>> First, if there are already clips in the Media Pool, Resolve tries to conform as many of these 
clips as possible by matching the file paths in the XML or AAF to the file paths stored for 
each clip in the Media Pool.

>> Second, for all remaining clips not found, Resolve tries a clip name match of clips that are 
already in the Media Pool.

>> Third, for all remaining clips not found, Resolve tries a timecode match (and reel name 
match if this is enabled) of clips that are already within the Media Pool. In this case, the file 
name is not used.

Beware When Choosing a Volume or Folder to Search

You can choose an entire volume when relinking, and eventually all media on that volume will be 
found. However, depending on the size and number of files on the selected volume, this operation 
could take a very, very long time.

Defining Clip Metadata When Adding Media to the Media Pool

For workflows where you’re manually adding media files to the Media Pool when you’re processing 
dailies, or as a separate step before importing EDL, XML, or AAF project files and reconforming 
them to a higher-quality set of media, the rules for how clip metadata is defined are a bit different.

>> Timecode: Calculated using the “Calculate Timecode At” setting in the Master Project 
Settings panel of the Project Settings.

>> Reel Names: Determined depending on whether the “Assist using Reel Names from the” 
checkbox is on or off, and on which option you’ve selected. Reel names are extracted 
dynamically, so any time you change this setting the reel names in the Media Pool update 
to reflect the change.

>> Clip Names: Read and stored, but not used for imported EDLs.
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How Reel Names are Identified

The “Assist using Reel Names” checkbox in the Master Project Settings panel of the Project Settings 
is an extremely important setting for controlling how the conform process works. As previously 
mentioned, reel names are extracted dynamically, so any time you change this setting the reel 
names in the Media Pool update to reflect the change.

There are four options that are available for determining how reel names are extracted from the 
source media when this setting is turned on.

>> Source clip file pathname: Obtains the reel name by extracting it from each media file’s 
path. This makes it possible to extract a reel name from all or part of the file name, or from 
all or part of the name of any folder in the path that encloses that file. This extraction is 
defined using the Pattern field.

>> Pattern: A code that defines how a reel name should be extracted from the source clip 
pathname. More information about creating patters appears later in this chapter.

>>Media Pool folder name: The reel name is obtained from the name of the bin in the 
Media Pool that encloses that clip. For example, in a stereoscopic workflow you might 
want to export offline stereo media with the “Left” and “Right” bin names in which they’re 
organized as reel names. Another example would be organizing VFX being incrementally 
processed in individually named bins, such as “VFX_Tuesday_10-12.”

>> Embedding in Source clip file: Useful for file formats where the reel name is embedded 
within the media file itself. CinemaDNG and other digital cinema cameras, QuickTime  
files created by Final Cut Pro, and DPX frame files are formats that can contain reel name 
header data.

>> Source clip filename: If there is no defined reel number, often it’s easy to just use the Source 
clip filename.

An additional checkbox is available, “Extract reel names from EDL comments,” which is primarily 
useful when conforming EDLs exported from Final Cut Pro 7 to R3D media.

>> Extract reel names from EDL comments: Some media file formats, such as R3D, have reel 
names, obtained from the file names, that are longer than the eight characters that are 
allowable in a standard EDL. This option allows DaVinci Resolve to extract reel names from 
appropriately formatted EDL comments, such as those output from Final Cut Pro 7.

Using the Pattern Field

If you’re using the Pattern option to extract the reel name from a clip’s source file pathname, you 
have the option to create your own search pattern, enabling you to have DaVinci Resolve extract the 
reel name for more exotic workflows.
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Extraction patterns are interpreted from right to left, deciphering each clip’s file path starting with 
the file name, and then considering each enclosing directory’s name to the left. Each extraction 
pattern consists of a series of text characters and “wild card” operators in unique combinations 
corresponding to the length and names used in the file path.

Here are a series of search characters that may be used.

If you’re trying to create a new extraction pattern for a unique workflow, there’s a test dialog you can 
use to try different patterns out before applying them to your project.

To test the extraction path:

1.	 Click the Test button next to the current Pattern in the Master Project Settings panel of the 
Project Settings. The “Specify Reel Extraction Pattern” dialog opens.

2.	 Type the extraction patten you want to test into the Pattern field. 

3.	 Using whatever method you prefer, find the file path of the media file that you want to test the 
extraction pattern on, and copy or type it into the Sample Path field. 

4.	 Click TEST. 

5.	 If the reel name that appears below is correct, then click Apply to copy the extraction pattern 
into the Pattern field of the Master Project Settings. If the reel name that appears is not correct, 
modify the extraction pattern and try again.

Extraction Pattern Operators

?
Looks for matches of any single character. Add as many question marks as there are 
characters you want to match. ?? matches two characters such as 02, ???? matches 

four characters such as 0002.

* A wildcard that creates matches for any sequence of zero or more characters.

%R
Specifies the reel name’s actual location. Reel names may contain any character, but 

should not contain a directory separator (forward slash).

%_R
Extracts the reel name and strips out the R3D file name underscores found in EDLs 

from Final Cut Pro 7 or earlier.

%D
Matches any directory name or file name. When this is the last operator in a pattern, 

do not add a forward slash.

/ Used to separate any two operators
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Examples of Reel Name Extraction Patterns

To better understand how this process works, below are several examples showing the various 
methods of reel name extractions. The / is used as the separator between control parameters.

Example 1: 

This example shows the reel name stored within the parent folder name of the clip..

>> Pattern: */%R/%D

>> File path: vol0/MyMovie/Scans/004B/Frame[1000-2000].dpx

>> Reel Name: 004B

Parsing takes place from right to left so to analyze this pattern start at the right end. In this case the 
%D matches to the file name “FrameNNNN.dpx” where NNNN is the frame number in each file of 
the clip. Moving left of the file name, the /%R/ section of the string is next. This specifies that the 
reel name will be the entire name of the parent directory immediately above the file. Then the * at 
the beginning of the string says match any pathname in front of the directory name that has the reel 
name. This string would find the parent directory regardless of how many levels deep it is nested 
on the directory path.

Example 2: 

Here we see the reel name stored in the parent folder name of the clip and prefixed with the  
reel name. 

>> Pattern: */????%R/%D or alternatively */Reel%R/%D

>> File path: /vol0/MyMovie/Scans/Reel1234/Frame[1000-2000].dpx

>> Reel Name: 1234

In this example both of these extraction patterns produce the same result. They are also similar to 
the first example. The reel name is still in the parent directory name but in this case it will have the 
fixed characters “Reel” prefixed in front of the reel name. The first pattern with ???? would actually 
match with any 4 character in front of the reel name. The second pattern is more specific and would 
only match the word “Reel” in the directory name.

Example 3:

This example shows the reel name stored within the parent folder name two directory levels up. 

>> Pattern: */%R/%D/%D

>> File path: /vol0/MyMovie/Scans/004B/134500-135000/Frame[1000-2000].dpx

>> Reel Name: 004B
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This example is again similar to Example 1. The difference is that in Example 3, the reel name is the 
directory name two levels above the clip. In Example 1, the reel name was in the directory name 
only one level up.

Example 4:

Finally, we see the reel name that is embedded within the clip name of the material. 

>> Pattern: */Reel%R_*

>> File path: /vol0/MyMovie/Scans/Reel004B_[1000-2000].dpx

>> Reel Name: 004B

This example shows a method for extracting the reel name from the file name of the clip. Again, 
starting at the right the two pattern characters “_*” match any series of characters up to the first 
underscore character. In this case it will pick up the file extension (.dpx) and the frame number 
portion of the file name. Next, the “/Reel%R” characters indicate the reel name is the characters 
between the ‘/Reel” and _ character. The * at the beginning of the pattern will match a file path any 
number of directories deep in front of the file name.
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If you’ve been given an enormous amount of source media to conform to, you may be hesitant to 
copy all of it to your accelerated storage, since (a) most of it is likely unused by the project file you’ve 
been given, (b) it’ll take forever to copy, and (c) it will clog up your local storage, taking valuable 
space away from other projects. In this case, you can use the Consolidate command to copy a 
reduced set of media files consisting of only the clips used in the current Timeline of the Edit page. 

But the Consolidate command isn’t just useful for projects you’re bringing in from other sources. If 
you’ve edited a program within DaVinci Resolve, you can use the Consolidate command to bundle 
the media used by a particular Timeline in preparation for handing it off to another Resolve user, or 
to someone employing a completely different NLE or finishing application. 

No matter what you use if for, the Consolidate command has been expanded to work with 
QuickTime, MXF, R3D, and Image Sequences (including CinemaDNG media), making it useful for 
media management of all kinds of projects.

To use Consolidate to create a consolidated duplicate of media in a timeline:

1.	 Connect the hard drive containing the media to be conformed to your workstation.

2.	 Import the edited project file, as an EDL, AAF, or XML file, into the Edit page, and conform 
it to the media on whatever portable storage media you’ve been given, as usual. You’re only 
doing this to identify what clips you need to consolidate, not because you’ll be working off 
that volume.

3.	 Manually select the clips in the current Timeline that you want to consolidate to your accelerated 
volume. If this includes the entire Timeline, you can press Command-A to select all clips.

	 Tip: If there’s a specific range of the current Timeline you want to select, you can also press 
Shift-Z to fit every clip in your program into the current width of the Timeline, and then drag a 
bounding box to select as large a portion of the Timeline as you need.

4.	 Now, right-click any one of the selected clips, and choose Consolidate.

5.	 In the file dialog that appears, choose the appropriate settings for how you want to consolidate 
the media.

Consolidate Media
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>> Trim to: Click the button to the right of the Trim to field to choose a destination to which 
to copy the consolidated media. To create a new directory, right-click a Volume icon in the 
File Browser list, choose New Folder, type a name into the resulting dialog, and click OK.

>> Use source clip full extents: Forces this operation to copy the full amount of source media 
corresponding to each selected clip in the Timeline, without omitting unused extents 
before or after the In and Out points of each selected clip. Use when you simply want to 
make a complete duplicate of all source media referenced by the current Timeline selection.

>> Consolidate multi-edit extents: If multiple clips in the selection come from a single media 
file, then a single consolidated media file will be generated that contains all frames from 
each of these clips, along with whatever additional frames lie between them. Even though 
this option results in more media being copied, it’s extremely useful if you’re consolidating 
media that you want to grade using remote versions with automatic linking, as each clip’s 
original relationship to the source media file it’s from is preserved.

>> Add handles: Adds additional frames of media to the head and tail of each trimmed clip.

>> Preserve levels after head: Retains a user-specified depth of the original directory structure 
used by a clip’s corresponding source media file, recreating it when rendering new files for 
output. The number you select determines how many levels of subdirectories Resolve will 
automatically create within the currently specified “Render job to” directory to match the 
path used by the source files. Defaults to 0, which creates no matching subdirectories. The 
number of path levels is defined relative to the head of each media file path.

>> Preserved path: Shows you a preview of the file path that will be written by this operation.

	 All selected media is copied to the specified directory in the manner you’ve selected. At this 
point, you can relink the current Timeline to the new media in the next step.

6. 	 Right-click anywhere in the Media Pool and choose Remove All Clips in Bin. This empties out 
the Media Pool, and the clips in the conformed timeline go offline.

The Consolidate dialog lets you choose how and where to copy the trimmed media
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	 Note: You can only remove all clips so long as the Master Timeline (if there is one) is not what’s 
currently selected.

7.	 Now, open the Timelines browser, then right-click the conformed Timeline you’re working on, 
choose Import > Additional Clips With Tight Filename Match, and then choose the directory 
to which you copied the trimmed media in step 5.

	 The consolidated media now populates the Media Pool, and the clips in the selected timeline 
are automatically reconformed to the new media. You are now ready to grade the project.

Using Consolidate Multi-Edit Extents and Preserve Levels  
After Head Together

When the “Consolidate multi-edit extents” checkbox is off and “Preserve levels after head” is 
left at the default of 0, timelines that use multiple clips derived from the same media file generate 
multiple trimmed media files. Each of these newly generated media files are renamed with an 
additional number; examples include _0, _1 for DPX files, _S000.RDC, _S001.RDC for R3D files, and 
_S000.mov, _S001.mov for QT media, etcetera. 

If the “Consolidate multi-edit extents” checkbox is off, and “Preserve levels after head” is set to a 
value of 1 or more, then the results will be different. For DPX media, all consolidated frames appear 
in the same folder. For R3D and QuickTime/MXF media, the original file name will be used for each 
consolidated clip that is derived from a particular media file, and each previously consolidated clip 
from that file will be silently overwritten by the next.
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If you need to color correct a project that was edited elsewhere, the Edit page can be used to 
import projects from other applications via the EDL, AAF, or XML project exchange formats, and 
conform them to the high-quality media you want to grade. When you go through the process of 
conforming a project, you use the imported project data to arrange the clips in the Media Pool into 
a timeline that constitutes the program that’s about to be graded.

This chapter covers the many conform workflows supported by DaVinci Resolve. For more 
information about the editing capabilities found in the Edit page, see Chapter 4.

It’s because Resolve organizes edited Timelines and the media they use separately that it’s possible 
to import multiple versions of a project using several EDL, AAF, or XML files. The result is a Resolve 
project with multiple Timelines, each having a differently edited arrangement of the same clips, 
each of which can share grades if you’re using remote versions (for more information on versions, 
see Chapter 13, “The Gallery and Grade Management”).

While some project formats make it possible to import a project’s referenced media at the same 
time as its edit data, that just means that the media is automatically placed into the Media Pool, 
instead of you having to put it there yourself. 

In Offline mode, the Edit page can also be used for loading an Offline Reference Clip, which is 
typically a flattened movie output from the original edited sequence. Using an Offline Reference 
Clip, you can confirm that the conformed project in fact matches the original edit in the source NLE. 
Furthermore, you can use an Offline Reference Clip to compare the new color adjustments and 
geometric transforms you’re making against offline effects that were created by the editor.

Conforming Projects
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A common workflow using DaVinci Resolve is the processing of digital dailies for media formats and 
projects where the camera original media would benefit from an initial grade, or from conversion 
into another more workflow-friendly format. Examples include programs shot using Log-C or 
S-Log media that require some form of grading to produce acceptable-looking media for editing, 
or converting processor-intensive raw formats into other high-quality media containers for offline 
editing and/or finishing.

In the process, Resolve offers numerous tools that let you add organizational metadata, synchronize 
dailies in dual-recording workflows, apply processing LUTs for color management, and output a 
wide variety of NLE-friendly media with exactly specified file naming conventions, file structures, 
and timing metadata.

Digital Dailies in a Round Trip Workflow

This section provides an overview of the different features that DaVinci Resolve offers for undertaking 
any workflow that begins with media processing in Resolve.

Step 1—Ingest Media and Add/Edit Metadata

It’s not necessary to have a project file exported from an NLE to start working in Resolve. Using 
the Library browser on the Media page, you can access any volume that’s currently available to the 
system, and import any compatible media format into the Media Pool.

Workflows that Start With DaVinci Resolve

Library with scrubbable clip thumbnails
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The Media Pool is Resolve’s internal database of available media for the currently open project. If 
you like, clips in the Media Pool can be organized into multiple bins. Once media has been added 
to the Media Pool, you can access a variety of descriptive metadata using the Metadata Editor, 
adding descriptions, notes, scene and take information, flags, day and date information, program 
and episode information, etcetera. This data can populate metadata tags when exporting ALE lists 
to move the metadata to a compatible NLE.

For more information on ingesting media in the Media page, see Chapter 3, “Working in the  
Media Page.”

Step 2—Sync Audio to the Dailies

If your video format has embedded audio, Resolve can simply pass that audio through when 
outputting media from the Deliver page. However, if the program you’re working on employs dual-
system audio recording, you can also import timecoded Broadcast WAVE files into the same bin 
as its accompanying video clips (you can place them into a sub-bin if you like), in preparation for 
syncing the dailies in Resolve. Once you’ve imported the video and audio media you want to sync 
into the Media Pool of the Media page, you can right-click the enclosing folder and choose “Auto-
Sync Audio Based on Timecode” which automatically syncs every timecode-matched pair of audio 
and video media clips within the same folder, all at once.

Tip: For the best results, consider using different folders for each day’s audio and video clips.

If there is no timecode relationship between the audio and video clips, you can create manual 
sync relationships by selecting a video clip to open into the Media page viewer, and then change 
the mode of the Audio panel to dailies so you can select the corresponding audio file and see its 
waveform. In this way, you can find the video and audio sync points, and click the Audio panel’s link 
button to lock the A/V sync of that clip.

For more information on syncing audio and video in the Edit page, see Chapter 3, “Media.”

Step 3—Do Whatever Grading is Necessary

Many shoots record a “flat” image to preserve the most image data for grading without clipping 
highlights or shadows. This can be accomplished using in-camera settings that record log-encoded 
QuickTime or MXF media, or via raw video formats that can be debayered as log-encoded video using 
gamma curves such as Log-C, S-Log, S-Log2, S-Log3, BMD Film, or REDlog Film, among others.

The Media Pool
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If you’re outputting high-quality media files meant to be used themselves for later finishing, then 
you may want to simply pass the source image data through unaltered. However, if you’re creating 
offline media for editors, directors, and producers to watch for the next three months, you can 
grade this data in a variety of ways to provide more pleasing output.

In the case of Log media, you could apply a LUT to the entire project that’s designed to 
“normalize” the particular log characteristics of the media you’re processing. Project-wide LUTs 
can be applied in the Look Up Tables panel of the Project Settings. For more information, see 
Chapter 2, “Project Settings.”

Project-wide LUT table settings on the Look Up Tables panel of the Project Settings

In the case of LUT-managed shooting workflows where a variety of LUTs have been designed to 
monitor different collections of source media, you can manually apply individual LUTs to one or 
more selected clips using the Media Pool’s contextual menu. You can also apply individual LUTs 
in the Node Editor of the Color page. For more information, see Chapter 12, “Advanced Color 
Features.” Alternately, if you’ve been provided with a CDL-compliant EDL that was used to manage 
the looks from a project being organized, you can use the ColorTrace™ from CDL command to 
batch import grading information from another application, described later in this chapter.
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If a LUT is not appropriate, you can manually grade individual clips as you would with any project. 
However, if you want to create a fast “one-light” adjustment for every clip in the Master Timeline 
at once, you can use the Track grade mode of the Node Editor in the Color page to apply a single 
correction simultaneously to every clip in the Master Timeline. This is particularly useful as you can 
readjust the Track grade as much as you like, and the changes are automatically applied to every 
clip in the Timeline. For more information, see Chapter 6, “Node Tree Structures.” 

Step 4—Export Media Suitable for Editing

Once you’ve organized your clips, synced the dailies, and applied whatever grading is necessary for 
the purpose at hand, you’ll use the Deliver page to set up the format, file naming convention, and 
organization of the media you’re outputting for editing or finishing.

Deliver page with Source order selected for rendering

Furthermore, if you need to apply a window burn, watermark, or logo to the media you’re processing, 
that can be accomplished in the Data Burn-In palette of the Color page. Window burns can be 
formatted with a lot of flexibility, and are written out to media that’s either rendered or output to 
tape. For more information, see Chapter 6, “Data Burn In.”

Selecting Track in the Node Editor
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Selections on the Data Burn-in palette

Once you’ve selected the appropriate Render settings and Window Burn options, you can output 
one or several versions of the media, to accommodate jobs where you need to provide several 
media deliverables. For more information on setting up and using the Deliver page, see Chapter 8, 
“File-Based Output.”

Step 5—Reconform Media to an EDL, AAF, or XML Project File

Once the offline media you’ve delivered has been edited, it’s simple to reimport the edited project 
via an EDL, AAF, or XML file, depending on which is most suitable to your application. This edit data 
can be used to reconform the original media that you imported into the Media Pool, so that you 
immediately have access to whatever graded adjustments you made to create the offline media, as 
applied to the source media. 

Imported project exchange files create new Timelines in the Edit page, and you can import multiple 
subsequent Timelines to accommodate changes that have been made to the edit, if you find 
yourself grading a project that is in progress editorially. In fact, depending on how you set up your 
grades, they can automatically ripple to follow each clip when you import a re-edited version of the 
program as a new timeline, saving you from having to recreate your work. For more information on 
this, see Chapter 13, “The Gallery and Grade Management.”

Step 6—Output Final Media for Finishing

Once you’re finished with your final grade, you’ll again use the controls of the Deliver page to render 
the program’s final media, either as individual clips for a round-trip workflow, or as a single media 
file or image sequence for delivery as a digital master.
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XML and AAF import are the most straightforward methods of bringing edits with as many video 
tracks as you need from different NLEs into DaVinci Resolve. XML and AAF import have the added 
benefit of allowing a variety of supported effects to be imported along with the edit data, as well 
as multiple tracks of video data. This chapter covers the relatively simple procedure used to import 
XML projects into DaVinci Resolve. The same procedure is used for AAF import, although for a 
smooth round trip you’re encouraged to consult Chapter 4, “Before You Conform.”

Preparing An XML Round Trip

There are currently three NLEs that can use XML to round trip projects to DaVinci Resolve and back 
again. In general, exporting XML for use by DaVinci Resolve is straightforward, and there really 
aren’t any settings you need to manage when exporting an XML file other than the version of XML 
you want to export. For this reason, it’s best to do whatever timeline management you need to 
before XML export. For more information on best practices, see Chapter 4.

Final Cut Pro X, Final Cut Pro 7, and Premiere Pro XML Round Trips

DaVinci Resolve can import projects that were exported to the Final Cut Pro 7 or Final Cut Pro X 
XML formats. 

Premiere Pro also uses the Final Cut Pro XML project exchange format to accommodate round-
trip workflows. You need to make sure that you’re exporting XML from Premiere Pro version 
5.5.1 or newer.

Managing Your Media

When importing XML projects (or EDLs, or AAFs for that matter), it’s easier to conform to the 
accompanying media files if they’re all located in a single directory. Having media sorted into 
multiple directories is fine as long as they’re all within a single main directory that you can select at 
the appropriate stage of project import.

Importing XML Project Files

This section covers the AAF/XML import dialog in much more detail. One procedure lets you 
accomplish any of the following workflows:

Importing an XML or AAF file and automatically conforming to and importing the media 
it’s linked to.

Importing an XML or AAF file and manually choosing another set of media, presumably in 
a different format or resolution, with identical metadata, to conform to instead.

Importing an XML or AAF file that’s linked to offline media derived from a camera original 
format, and automatically conforming it to and importing the camera original media.

Each of these workflows is possible by choosing the correct combination of options.

Conforming XML Files
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To load an XML or AAF file and automatically link to its referenced media:

1.	 Do one of the following:

>> From any page, choose File > Import AAF, EDL, XML.

>>Open the Edit page, right-click the Timelines list, and choose Import > AAF/EDL/XML.

2.	 Using the file dialog that appears, find the project file you want to import, and Clip Open.

	 The Load AAF or Load XML window appears, depending on your selection.

3.	 Choose the options that are applicable to your particular project. By default, these options are 
based on metadata within the file you selected.

>> Source File: The file you selected in the previous step.

>> Import Timeline: This pop-up menu lets you choose which sequence to import as a 
DaVinci Resolve timeline, if there are multiple sequences within the source file.

>> Timeline name: The name of the Timeline you’re about to create. This defaults to the 
name of the sequence that was exported.

>>Master timeline start timecode: The timecode at which the imported edit will start. 
This automatically matches the start timecode of the selected Timeline.

>> Automatically set project settings: Turn this option on if you want to overwrite the frame 
size and frame rate settings in the Project tab of the Config page with those in this window.

Options when importing an XML
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>> Automatically import source clips into media pool: Leave this checkbox on to automatically 
import the media referenced by the AAF or XML project file you selected into the Media 
Pool for immediate reconnection. If the media files are not automatically located, you will 
be prompted to manually select the directory where the clips are located.

>> Ignore file extensions when matching: Turn this checkbox on if you want to manually 
choose a different directory of media to link to, for example if the XML you’re 
importing links to ProRes Proxy media, and you want to relink to another directory of 
corresponding ProRes 4444 media.

>> Link to source camera files: Turn this checkbox on if you want to reconform the 
imported project file to the camera original files that correspond to the offline media 
that’s currently referenced.

>> Use sizing information: Lets you import position, scale, and rotation data from AAF and 
XML project files.

>> Use color information: This option is only available for Final Cut Pro X XML files, letting you 
import selected color correction data from the Final Cut Pro X color board controls.

>> Set timeline resolution to: Two fields let you specify the width and height of the frame size 
you want to work at in Resolve. The default is whatever resolution is specified in the project 
file being imported.

>> Timeline framerate: By default, this is derived from the frame rate of the selected project 
file being imported.

>> Use drop frame timecode: By default, this is derived from the frame rate of the selected 
project file being imported.

>> EDL framerate: By default, this is derived from the frame rate of the selected file.

>> Use drop frame timecode: By default, this is derived from the frame rate of the selected file.

>> Handle mixed frame rate material: When this checkbox is enabled, Resolve conforms and 
processes all clips in the Timeline to play at the frame rate selected in the “Calculate Timecode 
At” setting for that project. When mixed frame rate timelines are rendered out as individual 
source clips, all clips are rendered individually at their original frame rate. If rendered as a 
‘single clip’, all clips are converted to the “Calculate Timecode At” frame rate and rendered 
as a single media file. This checkbox also appears in the Master Project Settings.

>>Mixed frame rate format: This pop-up menu lets you choose the method used to conform 
mixed frame rates for rendering and playback. You can choose the “Final Cut Pro 7” or 
“Final Cut Pro X” methods of conform, while for projects imported from Premiere Pro, 
Smoke, or other NLEs, you should choose “Resolve.” This pop-up menu also appears in the 
Load AAF or XML dialogs when you import a project.

4.	 After choosing all necessary settings, click OK.
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5.	 Assuming you left “Automatically import source clips into media pool,” turned on, if the media 
linked to by the XML or AAF file is not in the expected disk location, or if you turned on the 
“Ignore file extensions when matching” checkbox, then another window appears prompting 
you to choose the folder within which the media for this project is stored. 

	 If necessary, navigate to the folder containing your media (all subfolders will be automatically 
traversed as well), select it, and click OK.

	 Important: It’s always possible to choose the top level of any volume to automatically find all 
media in any directories located within, but if the volume is large and full of many files, scanning 
every folder and document of the volume may be an extremely time-intensive process.

Selecting the source folder for your XML imported clips

Selecting the source folder for your XML imported clips
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The AAF/XML file is imported. A new Timeline appears in the Timelines list, the referenced 
media files appear in the Media Pool, and the clips appear in the Timeline Editor. Clips that 
could not be linked to a corresponding file in the Media Pool appear with a red x to indicate 
that they’re unconformed.

If you find there are many unconformed clips in the resulting imported Timeline, and that these clips 
correspond to media that was placed in another directory, there’s an easy way to fix this.

To import unconformed clips and reconform them to the Timeline:

1.	 On the Edit page, right-click a timeline in the Timelines list that has unconformed clips, and 
choose one of the following commands:

>> Import > Additional Clips With Loose Filename Match: Searches the Timeline for all 
unconformed clips, and prompts you to specify a directory of media with which to attempt 
to conform them, adding only the media that’s necessary to the Media Pool. The “Loose 
Filename Match” command ignores file extensions, which lets you replace offline media 
with online media in a different format.

>> Import > Additional Clips With Tight Filename Match: Searches the Timeline for all 
unconformed clips, and prompts you to specify a directory of media with which to attempt 
to conform them, adding only the media that’s necessary to the Media Pool. The “Tight 
Filename Match” command searches only for media with identical file extensions.

2.	 Choose the directory with the remaining media to be conformed in the dialog that appears, 
and click OK.

	 If the conditions necessary for matching the media files in the directory you selected to the 
unconformed clips in the current Timeline are met, then the needed files are automatically 
added to the Media Pool, and the unconformed clips become conformed.

If there are other problems in your imported Timeline such as reel conflicts, incorrectly conformed 
media, or clips you need to simply replace, there are numerous procedures available to deal with 
these issues in Chapter 5, “Working in the Edit page.”

Conformed Timeline showing missing clips
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Conforming AAF Files

AAF (Advanced Authoring Format) is a project exchange format, originally developed by the 
Advanced Media Workflow Association (AMWA). Commonly used applications that export project 
data in the AAF format include Avid Media Composer, Avid Symphony, and Adobe Premiere Pro.

This chapter describes some recommended workflows for moving projects from Media Composer 
(or Symphony) to DaVinci Resolve for grading, and then returning to Avid Media Composer  
for finishing.

Supported Media Types in AAF Round Trips

Media Composer provides several methods of ingesting and managing compatible media formats. 
Ultimately, which formats are suitable for a Media Composer to Resolve round trip depends on 
whether they’re compatible with Resolve.

There’s one other thing to keep in mind as you’re managing media in Media Composer; not all 
formats are compatible with all media management operations. This combination of format 
compatibility and operational compatibility requires you to carefully tailor your workflow around 
which media files you’ll be using.

Transcoding to DNxHD Always Works

Since DNxHD was developed as Media Composer’s core codec, workflows where you transcode 
other media formats to MXF-wrapped DNxHD before editing will always work, and are the simplest 
when round tripping between Media Composer and DaVinci Resolve. At the time of this writing, 
Resolve supports both MXF-wrapped and QuickTime-wrapped DNxHD media. 

Linking to Media Using AMA and Consolidating

Avid Media Access (AMA) is a means of directly linking clips to media files in Media Composer 
without needing to either transcode them to DNxHD MXF files, or copy them to an Avid MediaFiles 
directory. While convenient, workflows involving media that’s linked using AMA require a bit more 
forethought.

Not all AMA-compatible media formats can be consolidated, which limits your ability to create 
a smaller, more portable collection of media to move into DaVinci Resolve. Whether or not an 
AMA-linked clip can be consolidated depends on its media format; Media Composer can only 
consolidate formats that it can write. For example, since Media Composer cannot write R3D media, 
then R3D media cannot be consolidated.

Furthermore, not all AMA-compatible media formats are compatible with DaVinci Resolve. Simply 
being able to edit a media format in a Media Composer timeline doesn’t guarantee you can use it 
in Resolve. The following table lists which media formats can be AMA-linked in Media Composer, 
which formats can be consolidated, and which are compatible for use in DaVinci Resolve.
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If you’re prepping a sequence that uses a mix of media formats, some of which can be consolidated, 
and some of which can’t, you should transcode all clips that aren’t compatible with consolidation to 
an Avid native codec before beginning the process of consolidating media and exporting an AAF 
to DaVinci Resolve.

Fast Imported Media

Another wrinkle is that Media Composer supports a media ingest method called “Fast Import,” 
where imported media is quickly copied to the Avid MediaFiles directory by inserting the original 
image data using the original codec into an MXF wrapper. This is an extremely fast and efficient way 
to bring media into Media Composer projects, but the resulting files are not typically compatible 
with DaVinci Resolve.

On the other hand, keep in mind that any media format that can be Fast Imported can also be 
consolidated. If you’re planning to round trip a sequence that uses Fast Imported media, it’s 
recommended that you either transcode the Fast Imported clips to DNxHD prior to AAF export, or 
conform your exported AAF project to the camera original media in Resolve instead.

Tip: Whenever you use a combination of media in your project that includes formats that aren’t 
compatible with DaVinci Resolve, you can use the “Transcode Video To” checkbox in the options 
of the Export As dialog when exporting an AAF project. This option lets you to transcode all media 
that isn’t a compatible format into a format that is compatible. 

Can be Natively 
AMA-Linked

Can Be 
Consolidated

Resolve 
Compatible

ARRI ALEXA Raw Yes Yes Yes

AVCHD No No No

Canon XF (C300) Yes Yes Yes

CinemaDNG No No Yes

GFCAM (Ikegami) Yes Yes No

P2 Yes Yes No

QuickTime (ProRes) Yes Yes Yes

R3D (RED) Yes No Yes

Sony F65 Raw Yes No Yes

Sony HDCAM SR (SStP) No No Yes

Sony XDCAM Yes Yes Yes

Compatible AMA linked formats
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Performing an AAF Avid Round Trip

This section outlines a comprehensive workflow for creating projects in Media Composer that will 
be compatible with DaVinci Resolve, moving projects from Media Composer to DaVinci Resolve, 
then grading, rendering, and sending the final graded project back to Media Composer. The 
following steps include procedures covering the following tasks:

Ingesting all media as high quality MXF-wrapped DNxHD, then round tripping from Media 
Composer to DaVinci Resolve.

Importing and editing Resolve-compatible AMA-linked media formats, then round tripping 
from Media Composer to Resolve.

Transcoding AMA-linked media files into offline-quality DNxHD clips for editing, then 
exporting an AAF file and reconforming it in Resolve to high quality camera-original media 
as part of the round trip.

Because there are so many variations in the way that Media Composer can ingest media and output 
AAF projects, you should familiarize yourself with the following procedures before continuing with 
your own project.

Step 1—Create a Project in Media Composer

1.	 When creating a project in Media Composer, take note of the image format details, as these 
should be matched in DaVinci Resolve. In particular, set the image format (e.g., 1080p/24) and 
raster dimensions (e.g., 1920x1080) to match your desired mastering format. Also, color space 
should be set to RGB 709 if you’re planning to send ingested/transcoded media from Media 
Composer to Resolve for grading.

	 Note: This information can also be found in the Avid Project Format tab.

2.	 Open your project, and ingest all necessary media into a new Bin using one or both of the 
following methods:

>> Transcode media for editing: The simplest workflow for AAF import and round-trip workflows 
is to ingest transcoded, native MXF-wrapped DNxHD media using the Import command.

>> Import AMA-linked clips: You can also import AMA-linked clips, so long as all AMA-
linked files are in a format that’s compatible with Resolve. Keep in mind that not all AMA-
compatible formats can be consolidated in Media Composer. In this case, import AMA-
linked media into a new Bin using the Link to AMA File(s) command, and edit as usual.

Once you’ve ingested all necessary media, you can edit your project as you would any 
other, keeping in mind which effects are compatible with DaVinci Resolve. For more 
information on effects in Media Composer to Resolve round trips, see Chapter 4, “Before 
You Conform.”
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Step 2—Exporting an AAF for DaVinci Resolve

When you’re finished editing, you need to export an AAF that will conform the .mxf media you used 
in Media Composer into a DaVinci Resolve timeline. Two export configuration options are available, 
depending on whether DaVinci Resolve and Media Composer are on the same system.

1.	 Select the sequence you want to export, and choose File > Export.

2.	 In the Export As dialog, type a name for the AAF file you’ll be exporting.

3.	 Choose a location to save the AAF. You can save it anywhere you like, but if you’re moving the 
project to another workstation, you may want to save it to a specific folder on a removable 
hard drive where you store your AAF and XML files. The location you choose can also be used 
as the location of the media that’s exported to accompany the AAF.

4.	 Click the Options button to open a more detailed window of export settings.

5.	 Turn on the AAF Edit Protocol checkbox. This option forces Media Composer to export 
a simplified AAF file that’s more compatible with the project exchange workflows of 
different applications.

6.	 Choose the appropriate option from the Export Method pop-up menu to configure how 
the AAF and its accompanying media will be exported. The option you choose depends 
on the following:

>> If Media Composer and Resolve Are on the Same System: Choose “Link to (Don’t Export) 
Media” to export an AAF file that links to the existing media in its current location. Click 
the Audio Details tab and choose “Link to (Don’t Export) Media” from the Export Method 
pop-up menu.

>> If Media Composer and Resolve Are on Different Systems: Choose one of the two following 
export methods:

>> Choose Copy All Media: For each source clip used, the entire corresponding media 
file is copied. This can be useful when you want to preserve the original relationship 
of each clip to the source media file it came from. However, be aware that you’ll 
potentially be exporting a lot of media when you use this option.

>> Choose Consolidate Media: This is a more efficient media management workflow for 
finished projects, since unused media will not be copied. You can specify additional 
handles to add to the beginning and end of each exported media file, in frames, in the 
Handle Length field. Should any media file and its handles overlap another media file 
and its handles, both will be combined into a single exported media file.
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7.	 (Optional) If you’re using a combination of media in your project that includes formats that 
aren’t compatible with DaVinci Resolve, you can optionally turn on the “Transcode Video 
To” checkbox and choose a media format from the pop-up menu to the right. This option 
automatically transcodes all media in your sequence that doesn’t match the format specified 
in the pop-up to match that format.

8.	 If you’re copying or consolidating media to another drive, choose “Folder” from the Media 
Destinations Video/Data pop-up menu. Turn on the “Use Same Folder As AAF File” checkbox 
to save the exported media to the same folder you selected in step 3. If you leave this checkbox 
turned off, you can click Select Folder to choose another location.

9.	 Click Save, and when you return to the Export As dialog, click Save again.

Once export is complete, you’ll see a duplicate sequence and duplicate media populating your 
Media Composer bin, with the suffix “.Exported” appended to the sequence, and “.new” appended 
to each media clip.

In the file system, the resulting folder contains an AAF file, and an Avid MediaFiles folder that 
contains the exported media.

Step 3—Conforming Your AAF in Resolve

1.	 Open DaVinci Resolve and create a new project.

2.	 First, you need to set Resolve to properly read the timecode and reel number information from 
the Media Composer files. Click the gear button at the lower left-hand side of the Resolve 
window to open the Project Settings window, click Master Project Settings, scroll down to the 
Conform Options, and do the following:

>> Set “Use Timecode” to “Embedded in the source clip.”

>> Turn the “Assist using reel name from the” checkbox on, and choose “Embedding in source 
clip file.”

Conform assistance with reel names embedded in the source clip
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3.	 Click Save.

4.	 Do one of the following:

>> From any page, choose File > Import AAF, EDL, XML.

>>Open the Edit page, right-click the Timelines list, and choose Import > AAF/EDL/XML. 

5.	 When the File Selection window opens, select the AAF file you exported from Media 
Composer, and click Open.

6.	 When the Load AAF dialog appears, the settings you choose determine which media files the 
AAF will be conformed to:

Import AAF window conform options

>> To conform to the transcoded or AMA-linked media files you edited: Turn on the 
“Automatically import source clips into media pool” checkbox. 

>> To conform to a different set of camera-original files: Turn on both the “Automatically import 
source clips into media pool” checkbox, and the “Link to source camera files” checkbox, 
which properly accounts for the difference in file naming between transcoded and camera 
original raw media.

>> To conform to a directory of media of your choosing: Turn on both the “Automatically 
import source clips into media pool” checkbox, and the “Ignore file extensions when 
matching” checkbox.

7.	 Additionally, you want to always make sure that the “Automatically set project settings” 
checkbox is on. Optionally, you can turn on the “Use Sizing Information” checkbox if you want 
to import position, scale, and rotate transform data from the project into Resolve.

8.	 Click OK.

	 As long as the media remains where it was when you exported it from Media Composer, the 
timeline and all its media should now import.
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	 However, if the location of the media files you’re conforming to has changed, then you may 
need to identify the location of the media in a second step. For example, if you’ve copied the 
media from the portable hard drive it was originally conformed to, to a faster storage volume, 
then a file dialog appears, requesting that you choose the folder containing the media used 
by your project. If prompted, do so and click OK.

Once import is complete, the Media Pool fills with the source media used by the imported project, 
and the edit appears as the current Timeline.

Step 4—Grade the Project

Grade each clip on the Color page as you would any other. However, you should be aware that if you 
use the tools found in the Edit page to make any editorial changes to the timeline you’ve imported, 
your export options will change later on:

>> If you don’t make editing changes: Then you have the option to have DaVinci Resolve use 
the Avid AAF file that you originally imported to generate an updated one. This preserves 
audio and all other unsupported effects from the original AAF file, so that they reappear 
when you export a new AAF back to Media Composer. If you use this option, you need to 
make sure the original AAF file you import remains in the same location.

>> If you do make editing changes: Then you need to use the “Generate New AAF” command 
to export an AAF of the re-edited timeline from Resolve back to Media Composer. This 
newly generated AAF file will not include audio, nor will it include any effects that are not 
supported by Resolve.

Step 5—Render and Export a New AAF

1.	 When you’re ready to send a graded project back to Media Composer, Open the Edit page 
and select the Timeline you graded.

2.	 Open the Deliver page.

3.	 Choose “Avid AAF Round-Trip” from the Easy Setup pop-up menu in the Render Settings list.

Selecting the AAF easy setup for Round-Trip 
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4.	 In the Output section, choose the MXF codec you want to render to.

5.	 Make sure you leave the Output Options checkbox “Render Clip with Unique Filename” 
turned on. This ensures that each clip rendered has a different file name as multiple clips in 
the edited sequence may originate from the same source clip.

6.	 If you require handles for your rendered output, you can enter a number into the Frame 
Handles field of the Output options.

7.	 Choose the appropriate file destination path for the rendered media. This folder can be 
anywhere you want, but the location you choose depends on whether Media Composer and 
Resolve are on the same computer or not.

>> If Media Composer and Resolve are on the same computer: Create a new folder within 
your Avid MediaFiles folder (Avid MediaFiles/MXF/) named with a number. Make sure you 
choose a previously unused number.

>> If Resolve is on a different computer using different storage: Select any directory on the 
portable hard drive you’ll be using to bring the media back to the Media Composer 
workstation from which it came.

8.	 Click Add Job to add the current render setting to the Render Queue, and click Start Render.

9.	 After rendering is complete, open the Edit page, make sure the Timeline you rendered is still 
selected, and do one of the following, depending on whether you made editorial changes to 
the Timeline in the Edit page:

>> If you didn’t make any editing changes to the timeline you imported, then choose File > 
Save XML/AAF, and choose “AAF” from the Format pop-up menu. This exports all audio 
and effects using data from the original AAF file that was exported from Media Composer, 
regardless of whether or not they’re supported in Resolve. 

>> If you did make editing changes to the timeline you imported, then you need to right-click 
the Timeline you want to export in the Timelines list and choose Export > Generate New 
AAF. This option creates a brand new AAF file that preserves your editorial changes, but 
audio and effects that are not supported in DaVinci Resolve are discarded. 

10.	 If you like, enter a new title for the sequence. By default, the exported file is named identically 
to the original, but with the suffix (Resolve) appended.

11.	 Click Save.

Note: When you export an unedited AAF, DaVinci Resolve uses the Avid AAF file that you originally 
imported to create an updated one; make sure it’s still in the same location as it was when you first 
imported it into Resolve.
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Step 6—Copy the Graded Media to Avid MediaFiles

1.	 For workflows where Resolve and Media Composer are on separate workstations, locate the 
media directory containing the media files that were rendered out of Resolve on the portable 
hard drive being used to transport the project back to your Avid workstation, and copy it to 
the Avid MediaFiles/MXF/ directory.

2.	 Rename the directory to be a number. Make sure you choose a previously unused number.

Step 7—Import the Graded AAF

1.	 Reopen the original project in Media Composer. If the media in the new directory of the 
Avid MediaFiles folder is in a compatible format, it will automatically be added to the internal 
database of media.

2.	 Create a new bin to contain the graded sequence you’re about to import.

3.	 Open the new bin, then choose File > Import, select the graded AAF file that you exported 
from Resolve, and click Open.

	 As long as the media is available in the Avid MediaFiles directory, the new bin you’ve created 
should automatically fill up with the clips that were rendered out of Resolve, and a new 
sequence should appear.

4.	 Double click the sequence you’ve imported to open it into the Record monitor and Timeline, 
fully conformed with the color corrected clips from DaVinci Resolve. 

	 This sequence is now ready for finishing in either Media Composer or Symphony.

Relinking Transcoded Media to AMA Media

This next workflow is useful when you’ve been editing transcoded, offline versions of processor- or 
bandwidth-intensive media, but you want to send the original high-quality source media (such as 
ALEXA or RED raw files) to Resolve for grading. In certain situations, it may be better to reconform 
your sequence to the original AMA-linked media files in Media Composer before you round trip 
from Media Composer to DaVinci Resolve.

Step 1—Relink Your Transcoded Media to AMA-Linked Source

1.	 Edit a sequence using media that you’ve transcoded within Media Composer.

2.	 When you’re finished, open the bin that contains your project’s camera original media, and 
select the AMA-linked clips that correspond to the transcoded clips you’ve been editing.

3.	 Right-click the edited sequence in its bin, and choose Relink from the contextual menu.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

408

PREPARING AND CONFORMING PROJECTS9

4.	 When the Relink dialog appears, turn on “Select items in ALL open bins,” and leave the 
“Create new sequence” checkbox turned on.

	 A new sequence is created that is now linked to the AMA-linked camera originals.

Step 2—Export an AAF File

1.	 Select the new sequence that was created, and choose File > Export.

2.	 Type a new name, choose a location for the file, and click Options.

3.	 Choose AAF from the Export As pop-up menu, and choose “Link to (Don’t Export) Media” 
from the Export Method pop-up menu.

4.	 Click Audio Details, and choose “Link to (Don’t Export) Media” from the Export Method 
pop-up menu.

5.	 Click Save to exit the Export Settings dialog, and then click Save again to export the file.

Step 3—Import the AAF, Grade, Render, and Export

1.	 Open Resolve, and import the AAF file you exported into the Edit page. You’ll need to 
manually select the media in a second dialog.

2.	 Grade the project as you would any other.

3.	 When you’re done grading, use the AAF Round Trip option in the Deliver page to render the 
graded media into a new (numbered) directory in the Avid MediaFiles directory.

4.	 Open the Edit page, select the original AAF timeline you imported, right-click it, and choose 
Export AAF/XML. Pick a location for the file and click Save.

Step 4—Reimport the AAF into Media Composer/Symphony

1.	 Open Media Composer, and import the AAF you exported from Resolve. 

	 Your graded sequence is now ready for finishing.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

409

PREPARING AND CONFORMING PROJECTS9

DaVinci Resolve supports the CMX 3600 format for EDL import and export. The edit decision list 
(EDL) is the lowest common denominator project exchange format there is, and most professional 
postproduction applications are capable of exporting and importing projects in this format.

The universality of EDLs is due, in part, to their longevity; different EDL formats have been in use 
for decades. It’s also due to their simplicity. At least as used by DaVinci Resolve, EDLs describe a 
very narrow range of editorial information, including clip arrangement, clip name (via embedded 
comments), video transitions (cuts or dissolves), and linear speed settings (percentage of fast 
forward or slow motion) for a sequence of shots on a single video track.

Note: While the EDL format supports a variety of SMPTE-defined video transition codes, all EDL 
transitions are turned into cross dissolves of identical duration in Resolve.

If you’re not familiar with the EDL format, each edit appears as a numbered event that contains 
the reel number, edit type, source timecode (In and Out points), and record timecode (In and Out 
points). Here’s a sample of a simple four event EDL:

TITLE: RESOLVE PROMO CUT 9

FCM: NON-DROP FRAME

001	 BM_COUNTDOWN.MOV	 V	 C		  00:01:20:00 00:01:28:01 00:01:20:00 00:01:28:01

002	 BL	 V	 C		  00:00:00:00 00:00:01:23 00:01:28:01 00:01:30:00

003	 BL	 V	 D	 050 00:00:00:00 00:00:02:02 00:01:30:00 00:01:32:02

004	 BL	 V	 C		  00:04:05:10 00:04:09:10 00:01:32:02 00:01:37:02

Since DaVinci Resolve was originally designed to work by importing and exporting EDLs, there 
are several methods you can use to import projects using EDLs. In all cases, you must first add the 
media referenced by that EDL to the Media Pool before you can import its EDL.

The three primary workflows are:

>> Conforming an EDL to individual media files: Importing an EDL that references a collection 
of discrete media files.

>>Notching a “Flattened” master media file using an EDL: Importing an EDL that references 
a “flattened” master media file. Flattened master media files are created when an entire 
program is exported from an NLE as a single self-contained media file.

>> Importing an EDL Directly to a New Track of an Existing Edit: If you’re importing a multi-
track video project, and the only means of doing so is using EDLs, you can export each 
track of the source project as an individual EDL, and then import each EDL into Resolve 
directly into additional tracks of the same Timeline. This is also useful for workflows where 
effects clips are being managed on a separate track assembled elsewhere, that you can 
then import directly into a graded Timeline to place many new effects clips all at once.

This description covers the different ways that EDLs can be used in DaVinci Resolve.

Conforming EDL Files
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EDL Export of a Project and Its Media

Make sure that every clip in your edited sequence, and every source media file it’s linked to, has 
an appropriate reel number/reel name. When conforming EDLs, Resolve requires reel names and 
accurate timecode to successfully conform the project to media in the Media Pool.

To export an EDL that can be easily conformed by Resolve, each NLE has particular settings that 
you should use. The primary supported format is CMX 3600, although Resolve also supports the 
DEDL format exported by both Smoke and Flame. 

There are other details, however, that vary by application. For example, when exporting an EDL 
from Final Cut Pro 7, you need to make sure you set Reel Conflicts to Generic Edits, and turn on the 
File Names checkbox. All other settings are optional, but for a cleaner, easier to read EDL, you can 
turn off the other options for exporting various kinds of EDL Notes.

Conforming EDLs to Individual Media Files

The advantage of working with discrete media files is that they are the “purest” version of the 
media, without any effects (such as dissolves or superimpositions) “baked” into the visuals that 
might create issues when you’re grading. 

1.	 Before you import any media, make sure that the “Timecode calculated at” pop-up menu in 
the Master Project Settings panel of the Project Settings is set to a frame rate that matches 
your project and media. Otherwise, the EDL’s timecode will be misinterpreted.

2.	 Open the Media page, use the Library browser to locate the media you want to add to the 
project, and add it to the Media Pool by right-clicking the enclosing directory and choosing 
one of the following commands:

>> Add Folder into Media Pool: Adds all compatible media files within that folder to the Media 
Pool. Subfolders are not traversed.

>> Add Folder and SubFolders into Media Pool: Adds all compatible media files from that 
folder, and all subfolders within that folder, to the Media Pool.

>> Add Folder Based on EDLs into Media Pool: Prompts you to choose an EDL. Only media 
referenced by that EDL is imported, and only the selected folder is searched for that media.

>> Add Folder and SubFolders Based on EDLs into Media Pool: Prompts you to choose an 
EDL. Only media referenced by that EDL is imported, and the selected folder and all 
subfolders are searched for that media.

Tip: The “Add...Based on EDLs” commands are useful for efficiently adding just the media you need 
to the Media Pool in instances where there might be many terabytes of unmanaged source media, 
most of which is unused.
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3.	 Do one of the following:

>> From any page, choose File > Import AAF, EDL, XML.

>>Open the Edit page, right-click the Timelines list, and choose Import > AAF/EDL/XML.

	 A window appears prompting you to “Choose a file to import.” 

4.	 Navigate to the EDL file you want to use, select it, and click Open.

	 The Load EDL window appears.

5.	 Choose the options that are applicable to your particular project. All grayed out options are 
not editable, either because they’re not applicable, or are not defined by the Project Settings 
that are currently applied. The options you can set include:

>> Source File: The file you selected in the previous step.

>> Timeline name: The name of the Timeline you’re about to create. This defaults to the name 
of the EDL file you selected.

>> Automatically set project settings checkbox: Turn this option on if you want to overwrite the 
frame size setting in the Master Project Settings panel of the Project Settings. You cannot 
overwrite the Timeline frame rate when importing an EDL.

>> Set timeline resolution to: Two fields let you specify the width and height of the frame size 
you want to work at in Resolve. This defaults to your Project settings, but can be overridden 
by turning on the “Automatically set project settings” checkbox.

>> EDL framerate: Choose the frame rate of the sequence that you exported as an EDL. You 
can convert the EDL frame rate from 30 to 24 frames per second if you set the Timeline 
frame rate to 24 fps and if the EDL frame rate is set to 30 fps; this is useful when an offline 
edit is done at 30 fps with media using 3:2 pulldown. Note that 25 fps to 24 fps conversion 
is not supported.

>> Use drop frame timecode checkbox: Only enabled if the EDL frame rate pop-up menu is 
set to 30 fps. Turn this on if your EDL uses drop-frame timecode.

6.	 When you’re finished choosing options, click OK.

	 The EDL is imported, a new Timeline appears highlighted in the Timelines list, and its 
corresponding sequence of clips appears in the Timeline editor. Clips that could not 
be linked to a corresponding file in the Media Pool appear with a red x to indicate that  
they’re unconformed. 
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Preconforming “Flat” Media Files to EDLs

Preparing an edited sequence for grading, along with each individual clip of media, can be time 
consuming for effects-intensive projects, or it may be an unnecessary step for a project with no 
effects whatsoever. 

In these cases, it can be simpler and quicker to export a flattened master media file that can 
be split back apart into its individual clips in DaVinci Resolve. This workflow is similar to a more 
traditional tape-to-tape workflow, except that you’re working from a digital master, rather then a 
tape-based master.

The easiest way to do this is to use the Preconform button in the Edit page to split a single master 
file that you’ve imported into the Media Pool back into individual clips in a new timeline.

To preconform a flattened master media file to an EDL:

1.	 Before you import any media, make sure that the “Timecode calculated at” pop-up menu in 
the Master Project Settings panel of the Project Settings is set to a frame rate that matches the 
media and EDL you’re preconforming.

	 Make sure you’ve picked the correct frame rate, since this option can’t be changed once 
you’ve added media to the Media Pool.

2.	 If necessary, turn on the “Assist using reel numbers from the” checkbox in the Master Project 
Settings panel of the Project Settings, and click to choose the appropriate option underneath. 
For example, if you’re relinking to R3D media, the default setting of the “Source clip file 
pathname” will base the reel names of each clip on the source media’s file name.

	 If you discover later that you’ve chosen the wrong option, you can change this setting, as 
reel numbers for clips in the Media Pool are dynamically regenerated whenever you change 
this setting.

3.	 Open the Media page, use the Library browser to navigate to the flattened master media file 
that contains the entire program, and double-click that file to add it to the Media Pool.

4.	 Do one of the following:

>> From any page, choose File > Import AAF, EDL, XML.

>>Open the Edit page, right-click the Timelines list, and choose Import > AAF/EDL/XML.

5.	 In the “Select an EDL file” dialog that appears, navigate to the EDL that matches the flattened 
master media file, select it, and click Open.
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6.	 In the “Parse preconform options” dialog that appears, give the new timeline a name, 
and click OK.

	 A new timeline appears in the Timelines list, and the Timeline editor shows its clips, ready for 
grading. Clips that could not be linked to a corresponding file in the Media Pool appear with 
a red x to indicate that they’re unconformed.

Conforming “Flat” Media Files Using Split and Add

The second method of conforming an EDL to a flattened file is to use the “Split and Add” command 
in the Media page to split one or more master media files into individual clips that match those of 
an EDL, then importing the EDL itself in the Conform page in a second step. 

This method is useful if there are clips in different folders or volumes that you want to conform to 
a single EDL. For example, the majority of the first reel of a program may have been exported as a 
single flattened file, but the corresponding EDL may require that an additional folder of effects clips 
be added to the Media Pool to be fully conformed.

To split a flat media file in the Media page, and import its EDL in the Edit page:

1.	 Before you import any media, make sure that the “Timecode calculated at” pop-up menu in 
the Master Project Settings panel of the Project Settings is set to a frame rate that matches 
your project.

2.	 Open the Media page, use the Library browser to navigate to the flattened master media file 
that contains the entire program.

3.	 Select the flattened media file, right-click it, and choose “Split and Add into Media Pool.”

4.	 In the “Select EDL files for splitting clips” dialog that appears, navigate to the EDL that matches 
the flattened master media file, select it, and click Open.

5.	 Select the frame rate of the project from the File Conform Frame Rate dialog that appears. This 
frame rate should be identical to the “Timecode calculated at:” pop-up you set in step 1. 

6.	 Choose the appropriate options in the “Enter handle size for splitting” dialog that appears:

>> Handle size in number of frames: Enter a number of frames to be added as handles to 
the first and last frame of the clip. This is useful when you’re using the “Split and Add into 
Media Pool” command to import only the referenced sections of a directory of individual 
media files.

>> Split Unreferred Clips: Useful when the referenced media files include segments that aren’t 
“referred to” by any events within the EDL used to split them. Turning this checkbox on 
adds all such unreferred clip segments to the Media Pool as separate clips, for possible 
later use.
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7.	 Click Split & Add.

	 The Media Pool fills up with individual segments of the flattened master media file, each of 
which matches an event in the EDL you used to split it.

8.	 Do one of the following:

>> From any page, choose File > Import AAF, EDL, XML.

>>Open the Edit page, right-click the Timelines list, and choose Import > AAF/EDL/XML.

9.	 In the “Choose a file to import” dialog that appears, navigate to the EDL that matches the 
flattened master media file, select it, and click Open.

10.	 Choose whatever options are necessary from the Load EDL dialog that appears (the default 
settings should work fine), and click OK.

	 The Master Timeline and the timeline you just imported appear in the Timelines list, the 
Conform EDL list updates with the events from the imported EDL, and the Timeline editor 
shows the edited clips, ready for grading. Clips that could not be linked to a corresponding 
file in the Media Pool appear with a red x to indicate that they’re unconformed.

Importing an EDL to a New Track

This last procedure describes how to add an EDL, not as an individual new Timeline, but as an 
additional video track to an existing Timeline. There are many reasons you might want to do this. 
For example, if you need to move a multi-track project to DaVinci Resolve from an application 
that can’t export either AAF or XML project exchange files that Resolve understands, you can use 
multiple EDLs. Simply export each track of the source project as an individual EDL, and then import 
each EDL into Resolve as additional tracks of the same Timeline.

This is also useful for workflows where effects clips are being managed on a separate track 
assembled elsewhere, that you can then import directly into a graded Timeline to place many new 
effects clips all at once.

To import an EDL to a new track of an existing timeline:

1.	 In this procedure, you have the option of adding whatever media is required by the EDL you’re 
about to import to the Media Pool first, or you can add the media after the EDL has been 
imported. It’s your choice.

2.	 Open the Edit page, select a timeline in the Timelines list, then right-click it and choose Import 
> EDL to New Track.

	 A window appears prompting you to “Choose a file to import.” 
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3.	 Navigate to the EDL file you want to use, select it, and click Open.

	 A new video track is created above any previously existing tracks, and events from the 
selected EDL are immediately loaded into it according to their record timecode positions.  
If you loaded the media needed by the new clips at the beginning of this procedure, that 
media should be conformed. Otherwise, you’ll need to track down the media files needed by 
the new unconformed clips and add it to the Media Pool now.
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When you set the Left Viewer in the Edit page to Offline mode, you’re able to compare an Offline 
Reference Clip to a timeline with both playheads ganged together. As you play the timeline, the 
Offline Reference Clip file plays as well. 

An Offline Reference Clip must be added to the Media Pool specifically as an “offline” clip, and is 
associated with a particular timeline by right-clicking that timeline in the Timelines list and choosing 
it from the Link Offline Video submenu.

The idea is that if your client exports a flattened version of their edited sequence at the same time 
as they export the EDL, AAF, or XML project file they want graded, then you can compare the 
project data that’s imported into Resolve to the actual video of the offline edit. 

Note: Typically, the flattened version of the program you’re given uses a low-quality codec, and 
contains effects and color correction that’s not final, which is why it’s called an Offline Reference Clip.

There are two reasons for comparing an Offline Reference Clip to a timeline:

>> Verifying the clip order: If you’re unsure whether or not you’ve properly resolved reel 
conflicts or other problems that occurred while you were conforming a timeline, you can 
compare each edit to the offline version of the program to spot problems and identify the 
proper media that should correspond to any clip.

>> Recreating effects: If there are offline effects, such as temporary grades made in the NLE, 
or pan and scan transforms that you want to check, the Offline reference mode lets you 
split-screen your current grade against the Offline Reference Clip in the Color page.

Setting Up an Offline/Timeline Comparison

Here’s how to compare Offline Reference Clips to a timeline.

Important: You need to make sure that the media you’ve imported as an Offline Reference Clip has 
a valid timecode track, otherwise this procedure won’t work.

To compare a timeline with an Offline Reference Clip:

1.	 Open the Media page, and use the Library browser to find the flattened Offline Reference Clip 
that you want to use for comparison.

2.	 Right-click the Offline Reference Clip file and choose Add as Offline Clip.

	 That clip appears with a small checkerboard badge in its icon in the Media Pool.

Checking a Conform Using an Offline Reference Clip
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Checkerboard indicating an Offline video

3.	 Open the Edit page, right-click the timeline you want to review against the Offline Reference 
Clip, and choose the offline clip you imported from the Link Offline Reference Clip submenu.

Selecting the Offline video to link to the current Timeline

4.	 Click the checkered Offline button at the left of the Source Viewer’s transport controls.

Selecting the Offline video in the Source Viewer

	 The Offline Reference Clip now appears within the Offline Viewer, and plays back in sync with 
the Timeline. If your clips are graded, you can see the comparison between the state of each 
clip in the Offline Reference Clip, and the graded timeline clip.
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The Viewers in Offline/Timeline mode
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DaVinci Resolve provides tools to help you deal with problems that can occur when importing 
project files in any format from a variety of sources.

Relinking Unconformed Clips by Importing Additional Media

There are two more Import commands that are useful when there are unconformed clips in a 
timeline because the media files were missing from the directory that was initially selected when the 
XML or AAF project was imported. If you find that these unconformed clips correspond to media 
that was placed in another directory, there’s an easy way to fix this.

To import unconformed clips and reconform them to the Timeline:

1.	 In the Edit page, right-click the problem timeline in the Timelines list, and choose one of the 
following commands:

>> Import > Additional Clips With Loose Filename Match: Searches the Timeline for all 
unconformed clips, and prompts you to specify a directory of media with which to attempt 
to conform them, adding only the media that’s necessary to the Media Pool. The “Loose 
Filename Match” command ignores file extensions, which lets you replace offline media 
with online media in a different format.

>> Import > Additional Clips With Tight Filename Match: Searches the Timeline for all 
unconformed clips, and prompts you to specify a directory of media with which to attempt 
to conform them, adding only the media that’s necessary to the Media Pool. The “Tight 
Filename Match” command searches only for media with identical file extensions.

2.	 Choose the directory with the remaining media to be conformed in the dialog that appears, 
and click OK.

	 If the conditions necessary for matching the media files in the directory you selected to the 
unconformed clips in the current Timeline are met, then the needed files are automatically 
added to the Media Pool, and the unconformed clips become conformed.

Dealing With Reel Conflicts

When importing projects from other applications, clips with overlapping timecode and reel names 
will cause reel conflicts. This often occurs when media has been added with timecode but no reel 
identifier (for example, shots from multiple unidentified reels that all start at 0 hour). This may also 
occur if shots are added to the Media Pool incorrectly, such as when replacement shots are added 
to the Media Pool but the original media is still there.

Tip: Overlapping timecode often occurs in the normal course of work, but should be managed by 
altering each clip’s embedded reel name, or by organizing media in different folders.

Reel conflicts within a Timeline can be identified in the Timeline editor by an “attention” icon in 
the thumbnail.

Fixing Common Conform Problems
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Fortunately, DaVinci Resolve has an easy way of resolving reel conflicts.

To resolve a reel conflict by relinking a clip’s media:

1.	 Right-click the “attention” icon of any clip in the Timeline.

	 The Conflict window appears, showing a list of all files in the Media Pool with timecode that 
overlaps the clip you right-clicked. Each item in the list has a thumbnail of the clip, the path 
of the file, file name, starting timecode, reel name, and creation date, to help you determine 
which of the clips in that list is the correct one.

2.	 Click the radio button of the correct media file for that clip, and click Apply.

	 The clip in the Timeline changes to reflect the media you selected, and the “attention” icon is 
replaced with a “resolved” icon indicating the conflict has been resolved.

Conflict Resolution window showing what other clips have overlapping timecode and reel information

Conflict icon indicating at least two clips have matching conform parameters
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Dealing With Linked and Unlinked Grades in Multiple Timelines

If you’ve set your project up to use Remote versions, then any clips that refer to the same file in the 
Media Pool are linked and share the same Remote versions of grades that are applied to them. For 
example, two clips that are close-ups from the same take refer to the same media file, so they’re 
both automatically linked to one another and share the same remote grades. 

Clips using Remote versions also exhibit this behavior when they appear in multiple timelines. Clips 
using Remote versions that are located in different timelines, but that refer to the same file in the 
Media Pool, are linked and share the same remote versions of grades. This is why you can grade 
one timeline, and then import a re-edited version via EDL, AAF, or XML, and have the new timeline 
automatically inherit all grades from the previous timeline.

However, you can override this behavior to have one timeline that’s independently graded from 
the others. Simply select that timeline, open the Color page, right-click any clip in the Thumbnail 
timeline, and choose Copy Remote Grades to Local from the contextual menu. All grades are 
copied to Local versions, and from that point on all changes you make to grades in that timeline 
have no effect on the other timelines in your project. 

For more information about Local and Remote versions, see Chapter 9, “Gallery.”

Re-editing Media Directly in the Timeline

Often you have to replace one clip in a timeline with a different clip. For example, you may need to 
replace an old version of an effects shot with a newer one that’s just been delivered, or an offline 
version of a stock footage shot with a higher quality one. This is easily done using the various editing 
tools described in Chapter 4, “Edit.” For example, you could use a replace edit to match a new 
incoming clip’s timing to the old one. Or you could use a three-point edit, a place-on-top edit, or even 
a simple drag and drop edit to put the new clip into the timeline to take the place of the old one.

A clip badge showing that the conflict was resolved
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Reconform From Bins

The “Reconform From Bins” command is useful for helping you to manually choose which media, in 
projects with multiple Media Pool bins that contain duplicate versions of clips, you want the current 
timeline to be conformed to.

By default, all clips that you add to the Media Pool are stored in the Master folder, which can be 
seen at the top of the Media Pool.

However, you can create bins, located within the Master bin, for adding media that you want to 
organize separately. For example, you could use bins to:

>> Add new versions of VFX clips that you need to place.

>> Add online-quality media with which to replace the offline-quality media you’ve been 
working with so far.

>> Add rescanned stock footage to replace temp clips you were originally given.

In all of these cases, a good way to organize new clips is to create a new Media Pool bin by right-
clicking the Master bin, choosing Add New Bin, and then selecting the new folder when you add 
new clips to the Media Pool.

Once you’ve organized bins of clips in this way, you can use “Reconform From Bins” to select which 
bins you want to conform to the current Timeline. Keep in mind that for this to work, the replacement 
media that you’re adding to these bins must have identical timecode and reel names to the media 
that it’s meant to replace. If the timecode doesn’t match, you’ll need to manually replace the clip in 
the Timeline.

To reconform a timeline to clips within a specific Media Pool bin:

1.	 Double-click the Timeline you want to reconform to open it..

2.	 Press Command-A to select every clip in the Timeline, right-click one of the selected clips, and 
choose “Force Conform Enabled” to disable force conform for each clip.

3.	 Right-click the current Timeline in the Timelines list, and choose Reconform From Bins.

	 A folders list dialog appears, with the Master folder displayed.

4.	 Click the disclosure triangle to the left of the Master bin to reveal the bins contained within.

5.	 Turn on the checkboxes for the bins with media you want to conform the Timeline to, and turn 
off the checkboxes for bins with media that you want to ignore. 
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6.	 Click OK.

	 The Timeline is automatically updated to conform to the media contained within the bins 
you checked.

If you use “Reconform From Bins” and two clips with identical timecode and reel names are in 
selected folders, you’ll have a reel conflict in the Timeline. By default, the clip that was most recently 
added to the Media Pool is used by default, but you may want to manually resolve such reel conflicts 
just to be sure that you’re using the correct version.

Force Conform

If you have a problem with a Timeline such that an unconformed clip simply won’t automatically 
conform to any clip in the Media Pool, even if you know the clip is there, you can use the Force 
Conform command to force a clip in the Timeline to conform to a clip of your choosing. 

To force conform an unconformed clip to another clip in the Media Pool:

1.	 Select a clip in the Media Pool.

2.	 Right-click an unconformed clip in the Timeline, and choose “Force Conform With Selected 
Media Pool Clip” from the contextual menu.

Selecting folders for reconform
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	 The selected clip in the Timeline is conformed to the clip you selected in the Media Pool in 
one of two ways:

	 If the selected clip in the Media Pool has matching timecode and reel name metadata, then the 
new clip is perfectly conformed as originally specified by the original EDL/AAF/XML project data.

	 If the Media Pool clip does not have timecode that matches the selected clip in the Timeline, 
then the new clip is conformed such that the first frame of the Media Pool clip is aligned with 
the first frame of the reconformed clip in the Timeline, and occupies the same duration.

	 If you right-click that clip again, you’ll see that the box next to the Force Conform menu item 
is checked, showing you that the clip has been force conformed to media for which it wasn’t 
originally a match.

	 Important: The clip you select in the Media Pool must be equal in length or longer than the 
clip you select in the Timeline for Force Reconform to work.
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Creating a stereo 3D project is a multi-step process that benefits from careful media organization. 
This chapter covers how to set up for working on stereoscopic projects, how to import stereoscopic 
projects, and how to export stereoscopic media. Incidentally, if you’re used to how Resolve used to 
handle stereo timelines and media in past versions, be aware that DaVinci Resolve versions 10.1 and 
later simplify the way stereo is handled, making the overall process easier to manage.

First, stereoscopic pairs of clips, i.e., the individual left- and right-eye media files, are imported 
into the Media Pool, organized, and then linked together using the “Stereo 3D Sync” command 
to create a new set of linked stereo clips. Then, these clips stereo clips can be either edited or 
conformed to imported project data using a single Timeline. DaVinci Resolve lets you manage left- 
and right-eye grades and sizing in the Color page using the controls found in the shortcut menu of 
the Thumbnail timeline, and in the Stereo 3D palette. 

If you’re using stereoscopic CineForm media, which contains muxed left-eye and right-eye image 
data that can be decoded by DaVinci Resolve, you still need to go through this process, although 
you’ll be using duplicate clips to populate Left and Right folders with matching sets of clips.

Hardware Requirements for Working in Stereo 3D

With DaVinci Resolve on Mac systems, dual 4:2:2 Y’CbCr stereoscopic video streams are output via 
HD-SDI on the DeckLink HD Extreme 3D+, DeckLink 4K Extreme, or UltraStudio 4K. You can select 
either Side-by-Side or Line Mesh output to be fed to your stereo 3D-capable display, depending 
on its compatibly. Alternately, if you turn on the “Enable Dual SDI 3D Monitoring” checkbox on the 
Settings tab of the Config page, the DeckLink HD Extreme 3D+ outputs full resolution 4:2:2 Y’CbCr 
for each eye to compatible displays.

When setting up a 3D-capable Resolve workstation, keep in mind that the dual video streams of 
3D projects make greater demands on disk bandwidth, media decoding via CPU or RED ROCKET, 
and effects processing via GPU. On Linux systems, stereoscopic performance is similar to that of a 
qualified Mac Pro with the same number of GPUs. Similarly to the Mac Pro, stereo 3D is output via 
HD-SDI on a Blackmagic DeckLink 4K Extreme using either Side-by-Side or Line Mesh output.

Setting Up to Display Stereo 3D

All DaVinci Resolve systems can output a side-by-side frame-compatible signal that can be viewed 
on a stereo 3D-capable display via a single HD-SDI connection, output from a DeckLink HD Extreme 
card. Other Blackmagic Design video interfaces with HDMI 1.4 outputs can also output stereo 3D 
signals; see the documentation accompanying your video interface for more information.

For higher-quality monitoring, two HD-SDI signals can be used to output the left-eye and right-eye 
images separately at full resolution using the DeckLink HD Extreme 3D+, DeckLink 4K Extreme, or 
UltraStudio 4K. Legacy systems accomplish this via NVIDIA dual SDI monitoring outputs. 

Stereoscopic Workflows
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Note: If your stereo display is not capable of multiplexing the two incoming HD-SDI signals by itself, 
you can accomplish this using an external device to multiplex both HD-SDI signals into a single 
stereo 3G signal that will be compatible. Check with your display manufacturer in advance to see if 
this is necessary.

The following procedures describe how to set up stereo 3D monitoring in two different ways.

Monitoring via dual HD-SDI to dual HD-SDI:

1.	 Open the Master Project Settings panel of the Project Settings, then do the following:

>>Make sure Video Connection is set to YUV 4:2:2 SDI.

>> Turn on the “Use left and right eye SDI output” checkbox.

2.	 Open the Stereo 3D palette, and do the following:

>> Set Vision to Stereo.

>> Set the Out pop-up menu to None.

If your stereo-capable display only has HDMI input, you can convert the two HD-SDI signals being 
output into a single stereo HDMI signal using a device such as the Blackmagic Design HDLink.

Converting dual HD-SDI to HDMI for monitoring:

1.	 If you’re using an HDLink to convert the dual HD-SDI channels being output by your 
DeckLink HD Extreme 3D card, then open the Blackmagic HDLink Utility application and do 
the following:

>> Click the 3D tab.

>> Set 3D stereoscopic to Enabled.

>> Set the “3D stereoscopic output format” pop-up menu to the setting that’s compatible 
with your stereo 3D-capable display.

2.	 Close the Blackmagic HDLink Utility.

3.	 Turn on the “Enable dual SDI 3D monitoring” checkbox in the Master Project Settings panel 
of the Project Settings.

4.	 Open the Stereo 3D palette, and set Vision to Stereo.

5.	 Set the Out pop-up menu to none.

Note: When “Enable dual SDI 3D monitoring” is turned on, split-screen wipes and cursors will not 
be visible on the grading monitor, nor will you be able to view image resizing.
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Supported Stereo 3D Media

When importing stereo 3D media from other applications, there are two types of media that are 
compatible with DaVinci Resolve stereoscopic workflows.

Using Dual Sets of Media in Any Supported Format

When originally shot, the media corresponding to stereo 3D workflows consists of two directories, 
one for the left-eye media, and one for the right-eye media. For the most automated workflow 
possible, this media must be tightly organized. Each pair of left-eye and right-eye media files in both 
directories should have matching timecode, and reel numbers that clearly indicate which are the 
left-eye shots, and which are the right-eye shots.

Using CineForm Media

CineForm stereo QuickTime files are compatible with DaVinci Resolve. CineForm clips encode the 
media corresponding to both eyes and mux (multiplex) it together in such a way so that CineForm 
files may output either a single frame of image data, if used in an application that is not capable of 
stereoscopic processing, or stereo 3D media when used with an application that is, such as Resolve. 
This means that you can edit CineForm media using nearly any NLE, export a project via whatever 
workflow is convenient, and end up with a stereoscopic project that can be graded in Resolve.

There are two ways of creating CineForm files. One is by using a camera or recording system that 
processes dual synchronized video signals to create a single set of CineForm media. The other is to 
use the CineForm conversion tools that come with GoPro CineForm Studio to reprocess dual sets 
of stereo 3D assets into the CineForm format.

The CineForm codec itself encodes full-frame image data using wavelet compression, at any 
resolution, at up to 12-bits, in a choice of RGB, Y’CbCr, or RAW color spaces. DaVinci Resolve is 
compatible with CineForm in a QuickTime wrapper using any supported color space, allowing 
access to the dual streams of image data that are provided.

When the time comes to output your program, keep in mind that while Resolve can read CineForm 
files, CineForm files cannot be rendered out of Resolve unless you’ve purchased an encoding 
license for OS X or Windows from GoPro. Furthermore, Resolve cannot render Stereoscopic 
CineForm files.

Creating Stereo 3D Clips

The very first thing you need to do when working on any stereo 3D project is to create the stereo 
3D clips that you’ll be using. This is a two-step procedure.

Step 1—Import and Organize Your Media

You need to import all of the left-eye and right-eye media into separate bins.
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1.	 Open the Media page, and create three Media Pool bins named “Left,” “Right,” and “Stereo 
Clips.” The exact names are not important, but the way the media is organized is. 

2.	 Import all left-eye media into the ”Left” bin, and all right-eye media into the ”Right” bin. If 
you’re importing stereoscopic Cineform media, you still need to create this kind of organization, 
which requires you to place duplicates of each clip into each of the “Left” and “Right” bins.

Step 2—Generate 3D Stereo Clips

Once you’ve organized your media appropriately, you’re set up to synchronize the left- and right-
eye clips using timecode.

1.	 Create a new bin in the Media Pool, and name it “Stereo Clips.” This is the bin that will eventually 
contain the linked stereo clips you’re about to create.

How to organize media for working in stereo 3D

2.	 Right-click anywhere within the Media Pool and choose Stereo 3D Sync.

	 The Stereo 3D Sync dialog appears, with buttons for choosing the left-eye folder, choosing the 
right-eye folder, choosing the output folder, and checkboxes for specifying whether to match 
reel names and file names, and additional fields for entering characters that identify left- and 
right-eye clips.
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3.	 Click the Browse button corresponding to “Choose left eye folder” and then use the 
hierarchical list of bins that appears to choose the bin you named “Left.” Follow the same 
procedure to choose the right-eye media. 

4.	 Click the Browse button corresponding to “Output folder” and then use the hierarchical list of 
bins that appears to choose the bin you named “Stereo Clips.”

5.	 Choose which matching criteria to use. Ideally, you only need to use whichever one of the 
three criteria that apply. The three options are:

>> 	Match Reel Name: If the reel names of the left- and right-eye media match, turn this 
checkbox on.

>>Match File Name checkbox: If the file names of the left- and right-eye media match, 
turn this checkbox on.

>> Left Identifiers and Right Identifiers fields: If the left- and right-eye clips are identified 
by a special subset of characters within the file name (for example, “3D_R” and “3D_L”) 
then you can type each into the appropriate field, and these characters will be used to 
match the left and right eyes together.

6.	 Click OK.

	 The original clips in the Left and Right bins disappear, and a full set of Stereo 3D clips appear 
in the output bin you selected in step four.

The Stereo Media Sync window
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Attaching Mattes to Stereo 3D Clips

If you have left- and right-eye mattes that need to be attached to stereo clips, the process works 
identically to importing mattes for regular clips, except that when you’ve selected a stereo 3D clip 
in the Media Pool, you have two matte import commands, “Add As Left Eye Matte,” and “Add As 
Right Eye Matte.”

Organizing and Grading Stereo 3D Dailies

A common workflow is the creation of digital dailies within DaVinci Resolve before editing in an NLE. 
This provides the editors, director, and producers with the advantage of having more attractive 
media to work with, that’s also more comfortable to view if handled with the automatic geometry 
and color-matching functions that match the media of each pair of shots together for a preliminary 
left- and right-eye balance. The resulting Timelines can then be output to whichever media format 
is most convenient to use.

Step 1—Create 3D Stereo Clips

The very first step in the process of creating dailies is to import all of the left-eye and right-eye 
media into individually organized bins, and to then link them together to create stereo 3D clips, as 
described in the previous section. 

Step 2—Edit the New Stereo Clips Into One or More Timelines for Grading

Now that you’ve created a set of Stereo 3D clips, you’re ready to edit them into one or more timelines 
for grading. You can do this by simply creating a new timeline and deselect the ‘Empty Timeline” 
checkbox. A new timeline will be created with the stereo 3D clips you created. 

Final stereo clips, ready to be edited and graded
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Step 3—Align Your Media

For the stereoscopic effect to work without causing headaches, it’s critical that both eyes 
are aligned. This can be tricky to adjust using manual controls, but is something that can be 
automatically analyzed. You can perform stereo 3D alignment to a single clip using the Stereo 3D 
Palette controls, or you can select a range of clips to align all of them automatically at once. There 
are two methods of alignment; which is more appropriate depends on the type of geometry issues 
you have to address.

>> Transform Alignment: Analyzes the image and makes vertical and rotational adjustments to 
line up the left- and right-eye images as closely as possible.

>> Vertical Skew: Analyzes the images and makes a vertical-only adjustment to line up the 
left- and right-eye images.

Step 4—Grade Your Media

Grade the clips in the Timeline as you would any other digital dailies, with the sole addition of using 
the controls in the Stereo 3D palette to control monitoring and manage the adjustments made 
to each eye as necessary. As when creating any other kind of dailies, you can use LUTs, the Track 
Grade, and individual clip grading to make whatever adjustments are necessary to create useful 
media for editing. 

To help you manage the visual differences between left- and right-eye clips, there are also two 
automatic color matching commands that can be used to batch process as many clips as you need 
to adjust at once.

>> Stereo Color Match (Primary Controls): Uses the Lift/Gamma/Gain controls to match one 
eye to the other. The result is a simple adjustment that’s easy to customize, but may not 
work as well as Custom Curves in some instances.

>> Stereo Color Match (Custom Curves): Uses the Custom Curves to create a multipoint 
adjustment to match one eye to the other. Can be more effective with challenging shots.

>> Stereo Color Match (Dense Color Match): Performs a pixel by pixel, frame by frame color 
match that is incredibly accurate. This operation is processor intensive, so if you’re going to 
batch process many clips, or if you’re matching long clips, you’ll want to make sure you have 
adequate time. Because this is so precise match, it’s recommended to use Dense Color 
Match after you’ve used one of the stereo alignment commands.

Final stereo clips, ready to be edited and graded
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For more information on working in the Stereo 3D palette, and on using the various auto processing 
options for stereo 3D clips, see Chapter 12, “Advanced Color Features.” For more tips on digital 
dailies grading, see“Preparing to Conform,” earlier in this chapter. 

Step 5—Output Offline or Online Media for Editing

When you’re done applying whatever grading is necessary to make the media suitable for 
editing, you’ll need to export each clip as separate left- and right-eye clips using the controls of 
the Deliver page. 

1.	 Open the Deliver page, and set up your render to output the format of media you require. Be 
sure to do the following:

>> Set Render Timeline As to Individual source clips.

>> Turn on the Use Source Filename checkbox.

>> To render both eyes’ worth of media, choose “Both eyes as” from the Render Stereoscopic 
3D option, and choose Separate Files from the accompanying pop-up menu. 

2.	 Click “Add Job to Render Queue.”

3.	 Click Start Render.

	 DaVinci Resolve will now render two sets of left- and right-eye clips. 

To make sure that the resulting edited project conforms easily to the originating DaVinci Resolve 
project, it’s important to be sure that you render individual source clips, and that you turn on the 
Use Source Filename checkbox, in order to clone the timecode, reel numbers, and file names of the 
source media.

Conforming Projects to Stereo 3D Media

Since Resolve manages stereo via a single set of specially created stereo 3D clips, you can use the 
same project import methods to import stereo 3D projects as you would for any other project. Only 
a single imported timeline is necessary.

This also means that you can edit stereo projects in NLEs that aren’t otherwise stereo-aware, and 
finish them in full stereo 3D in DaVinci Resolve. To do this, you need to make sure that you edit the left-
eye media in your NLE, and then export either an EDL or XML file to conform in DaVinci Resolve.

Final stereo clips, ready to be edited and graded
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To conform an EDL to stereo 3D media:

1.	 Open the Media page, and create the necessary set of stereo 3D clips that will correspond to 
the project you’re going to import, as described previously. 

2.	 Open the Edit page, and then use the Import AAF/EDL/XML command to import your edit.

3.	 When the Load EDL/XML dialog appears, do the following:

>> If importing an EDL, verify that the frame rate is correct, and click OK.

>> If importing XML, make sure you turn off the “Automatically import source clips into Media 
Pool” checkbox, since you want to relink the imported project to the stereo 3D clips you 
created in step one.

	 The left-eye media timecode and reel information that’s embedded within each stereo 3D 
clip will be used to conform the stereo 3D clips with the imported EDL, and you should be 
ready to work.

Grading Mastered Stereoscopic Media From Tape

If you’ve been handed a stereo 3D muxed tape with a mastered program that needs to be graded, but 
you haven’t been given a project file or EDL, you can ingest it as individual left- and right-eye media files 
with a supported VTR, such as HDCAM SR with 4:2:2 x 2 mode, by turning on the “Enable stereo video” 
checkbox in the Deck Capture and Playback panel of the Project Settings. When muxed stereoscopic 
signals are ingested, each eye is separated into individual left-eye and right-eye image files.

Once ingested, you can use Scene Detection to split the left-eye media in one bin, and to create an 
EDL, you can use to split the right-eye media in the same way in another bin, so that you can create 
a sequential set of stereo clips for grading.

Grading in Stereo 3D

Once you’ve either created or imported stereoscopic 3D-identified timeline, you’re ready to begin 
grading. The left eye will be displayed in the Edit and Color pages by default however you can right-
click on the timeline and select to view the other eye. Most colorists work by grading one eye first 
(typically the left), and rippling their grades to the other eye, making separate adjustments to each 
eye’s clips when necessary to match undesirable variation between cameras.

Setting up stereo 3D media enables the Stereo 3D palette on the Color page. This palette contains 
all the controls necessary for working on stereoscopic projects. It provides controls for choosing 
which eye to grade, adjusting convergence, swapping and copying grades and media between 
matching left- and right-eye clips auto-processing the color and geometry of left- and right-eye 
clips to match, stereo 3D monitoring setup, and controls for floating windows.

For more information on making adjustments to stereo 3D clips, see the “Stereo 3D Palette” section 
of Chapter 8, “Color.”
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Outputting Stereo 3D Media in the Deliver Page

To render full frame media, you’ll need to render each stereo 3D timeline separately using the 
controls of the Deliver page, outputting whatever media format is required by the client.

Rendering Frame-Compatible Media

Frame-compatible media has both the left- and right-eye images squeezed anamorphically into a 
single media file. You can turn on the “Enable 3D Stereoscopic Render” checkbox at the bottom of 
the Output options of the Deliver page, and then choose a method of output from the Mesh 
Options pop-up menu. 

Stereoscopic 3D mesh render options on the Deliver page

You can choose Side-by-Side or Line-by-Line. You can also choose Anaglyph if you want to output 
a traditional anaglyph red/cyan stereo 3D image for viewing on any display.

Rendering Individual Left and Right-Eye Clips

If your workflow requires you to deliver separate sets of left- and right-eye media, this is easily 
accomplished by either setting up a render job with “Render Stereoscopic 3D” set to either “Right 
eye” or “Left eye,” or selecting “Both eyes as” and choosing the “Separate files” option.

The Stereo Palette of the Color page
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ColorTrace is a key feature of DaVinci Resolve, which lets you copy grades quickly and easily from 
the clips of one timeline to those within another, based on the source timecode of each clip (or 
using clip names when in Automatic mode). You can even use ColorTrace to copy grades between 
timelines within the same project, and ColorTrace one stereo timeline to another.

Users familiar with previous versions of Resolve will be happy to know that as of Resolve version 
11, ColorTrace copies whichever version of a clip’s grade was applied in the Source timeline you’re 
copying from, either local or remote, depending on which grades each clip in the Source timeline 
is set to use. Furthermore, in Resolve version 11.1, ColorTrace gained support for copying Group 
Pre-Clip and Group Post-Clip grades. These improvements make this an extremely reliable tool for 
copying grades from one timeline to another in a wide variety of situations.

To use ColorTrace:

1.	 Open the Edit page and select the Timeline you want to use ColorTrace with in the Timeline 
Management list.

2.	 Right-click anywhere within the Timeline, and choose ColorTrace from Timeline.

	 The ColorTrace Setup window appears, which shows every database, user, project, and 
timeline within a single hierarchical list.

3.	 Using the Project List, select the specific Timeline you want to copy grades from.

	 You’ll need to click the disclosure triangle to the left of the database, user name, and project 
that contains that Timeline in order to select it.

Copying Grades Using ColorTrace

ColorTrace project and Timeline selection window
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4.	 (Optional) If you’re using ColorTrace with a project that has numerous VFX clips in a workflow 
where all VFX clips have specific reel names that identify them, you can enter these names 
(with asterisks (*) used as wildcards that indicate text in each Reel Name that can vary) in 
the “Effects Shot Definitions” field. This speeds automatic ColorTrace operations by enabling 
Resolve to use fuzzy string matching when a clip’s reel number qualifies it as a VFX shot so 
that the best match is displayed first on the list. You can enter multiple VFX reel names with 
wildcards, one per line, for simultaneous string matching. You can use whatever Reel Name 
text makes sense for your workflow, some examples of VFX reel names are as follows:

*_COMP_*

VFX*

EFFECTS*

5. 	 Click Continue.

	 The ColorTrace window appears with two tabs that let you choose how to work.

6.	 Choose which mode to work in by clicking the Automatic or Manual tab:

	 In Automatic mode, ColorTrace automatically searches for matching clips between the 
selected timeline and the current timeline. Each clip is color coded depending on the 
correspondence that’s been identified.

	 In Manual mode, you copy grades yourself, using the Copy and Paste procedures, or by 
dragging and dropping using your mouse.

	 The ColorTrace window is complex; details about the operation of each mode are covered 
separately in the following sections.

7.	 When you’re finished using ColorTrace, click Close.

Using ColorTrace in Automatic Mode

In Automatic mode, ColorTrace automatically finds the correspondences between clips in the 
selected timeline that you want to copy grades from (the Source timeline), and those in the current 
timeline that you want to copy grades to (the Target timeline).

Selecting the Automatic or Manual ColorTrace 
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Each clip in the Target Timeline Thumbnail timeline is outlined with a color that indicates its status.

>> Red: No match was found at all. 

>> Blue: Due to overlapping timecode and reel names, multiple correspondences have been 
found (similar to a reel conflict), and you must select the correct one for each clip.

>>Green: A perfect match has been found. 

ColorTrace Thumbnail outlines indicate matching, overlapping and non matching clips

In Automatic mode the correspondence between each clip in the Source timeline and each clip in 
the Target timeline should be automatically made. However, overlapping timecode and reel names 
can cause problems. The other controls in the ColorTrace window help you deal with the subset of 
clips that can’t be automatically matched, or are matched in error. These controls are:

The ColorTrace window shown in Automatic mode

>>Matching Source Clips list: Shows a scrollable collection of thumbnails that might correspond 
to the selected clip in the Target timeline.

>> Target Timeline: Shows each clip in the Timeline you want to copy grades to, color coded 
according to how good a match it is.

>> Clip Info pane: Displays two columns of properties for the source clip and the target clips 
that you’ve selected. These properties include the reel, source timecode, record timecode, 
clip name, project names, and timeline names of each clip, for easy comparison.

>> Attributes and options checkboxes: A series of checkboxes lets you specify which clip 
attributes are copied as part of the ColorTrace operation.

>> Color: Enables the copying of grades.
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>> Preserve Num Nodes: When copying grades, lets you prevent the first X nodes of the 
target clip grades from being overwritten by the first X nodes of the source clip grades.

>> Sizing: Enables the copying of Edit sizing attributes.

>> Input Sizing: Enables the copying of Input Sizing attributes.

>> Convergence: Enables the copying of Convergence for Stereo 3D projects.

>> Floating Windows: Enables the copying of Floating Windows for Stereo 3D projects.

>> Auto Align: Enables the copying of Auto Align settings for Stereo 3D projects.

>> All Versions: Copies all versions, rather then just the current version, from the source 
to the target clips. The currently selected version of each source clip is always 
correctly copied.

>> Version Camera Raw Settings: Enables the copying of versioned Raw settings, rather 
than just the current Raw setting.

>> Track Marks: Enables the copying of keyframes.

>> Hide Matching Clips: Hides all clips which have been successfully matched, and 
only show the clips with multiple or no matches. This lets you focus on the subset of 
problem clips within a potentially long Timeline.

>> Ignore Reel Names: If you believe the reel names are in error, you can turn this checkbox 
on to ignore them, matching all source and target clips by timecode alone.

>> Copy Grades: Copies the matched source grades to each green and purple target clip.

>> Copy Grades & Exit: Once you’ve finished making all the grade matches you can, click this 
button to copy the matched source grades to each green and purple target clip, and close 
the ColorTrace window.

Here’s how to use these controls to sort out which source clips to copy from for each blue and red 
target clip in the Target timeline.

To manually choose which source grades should be copied to which target clips:

1.	 Click any blue clip thumbnail in the Target timeline.

	 A collection of clips with overlapping timecode and reel names appears. If you want to 
ignore the reel names because you believe they might be in error, turn on the Ignore Reel 
Names checkbox.
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2.	 If a comparison of the Source and Target thumbnails doesn’t make the choice obvious, then 
click any of the clips in the Matching Source Clips timeline to view its metadata for comparison 
in the source/target columns below.

3.	 Once you’ve decided on a clip correspondence, double-click the Matching Source Clip 
thumbnail you want to copy from. If no clip in the Matching Source Clip pane is a good match, 
double-click the “Set As New Shot” box.

	 The Source and Target thumbnails both turn purple, to show that you’ve created a 
correspondence. 

Source and Target clip metadata for comparison

The matching Source and Target clips now both marked with purple outline

Revealing a number of different possible correspondences in the Matching Source Clips timeline
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	 Continue working your way through every thumbnail with Blue and Red Xs until you’ve found 
matches for every clip in the Timeline for which it’s possible.

4.	 When you’re finished, click Copy Grades & Exit.

Using ColorTrace in Manual Mode

Manual mode is ideal for situations where you want to copy grades between programs with clips 
that have no timecode or reel name correspondence at all. The Manual ColorTrace interface is 
designed to let you move through two different timelines, either a clip at a time, or in matching 
multiples of clips, copying grades from the Source timeline to the Target timeline.

For example, if you’re trying to copy grades from a timeline that was conformed from individual 
media files, to another timeline that was conformed from a flattened master media file, you can use 
the ColorTrace Manual mode to accomplish this.

The manual interface consists of two sets of controls that correspond to the Source timeline (labeled 
“Timeline to copy from”), and the Target timeline (labeled “Timeline to paste to”). The general idea 
is that you move through both sets of timelines one clip at a time, or in matching multiples of clips 
at a time, and copy grades from the “Copy from” timeline to the “Paste to” timeline.

Manual mode has the following controls:

>> Copy Range controls: Two fields show the range of clips in the current selection that you’ll be 
copying from, referred to by their numeric position in the Source timeline. You can change 
the range numerically by either entering new numbers in the fields, or by using the up/
down arrow buttons to alter the value by one. The First button automatically adds all clips 
from the first one in the Timeline into the current selection. The Last button automatically 
adds every clip going to the last one in the Timeline to the current selection.

ColorTrace Manual window
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>> Source timeline: Shows all clips in the Source timeline you selected; the clips you’re 
copying grades from. Click any one clip thumbnail to select it, or click a thumbnail, and 
then shift-click another thumbnail to select a contiguous range of clips. You cannot select 
a noncontiguous range of clips.

>> Target timeline: Shows all clips in the Target timeline you selected; the clips you’re pasting 
grades to. Selecting clips works identically as with the Source timeline.

>> Paste Range controls: Two fields show the range of clips in the current selection that you’ll 
be pasting to, referred to by their numeric position in the Source timeline. All controls work 
identically to the Copy Range controls.

>> Attributes and options checkboxes: Turn off the checkboxes of any clip characteristics that 
you don’t want to copy as part of the ColorTrace operation. A more complete description 
of these options appears in the section on the Automatic ColorTrace mode.

>> Paste button: Once you’ve selected one or more source clips and a matching number of 
target clips, clicking Paste copies the grades, PTZR settings, and marks (depending on the 
corresponding checkboxes).

>> Undo Last: Lets you undo the most recent paste action.

>> Undo All: Lets you undo all paste actions in Manual mode.

>> Done: Finishes the operation and closes the ColorTrace window.

If you’re cherry picking individual grades from one timeline to paste into shots in another, you can 
copy grades one at a time.

To copy one source grade to one target clip:

>> Click a thumbnail in the Source timeline (on top) to copy from, then click a thumbnail in the 
Target timeline (on the bottom), and click Paste.

You can also simultaneously copy the grades of entire scenes of clips from one timeline to another. 
For example, if you’re copying grades from an originally graded timeline to a re-edited version of 
the same program, you can copy every grade from a 10-clip scene in the Source timeline to the 
same 10 clips in the Target timeline which have been pushed back later in the Timeline.

To copy a group of source grades to a group of target clips:

1.	 Choose a continuous range of source clips by doing one of the following:

>> 	Click the first clip in the range, and then Shift-click the last clip in the range.

>> 	Enter the clip number of the first clip in the left “Copy Range” field, and then enter the clip 
number of the last clip in the right field.

>> 	Click a clip, and then click First to select every clip from that one to the first clip in the timeline.

>> 	Click a clip, and then click Last to select every clip from that one to the last clip in the timeline.
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2.	 Choose a continuous range of target clips by using the same procedures as in the previous 
step, but using the “Paste Range” controls.

	 Important: You must select the same number of target clips as you did source clips for the 
Paste button to become enabled.

Group copy and paste of grades

3.	 When you’ve made your selections, click Paste.

	 The grade settings from the source clips are pasted to the destination clips, in order. In other 
words, if you copy from clips 27, 28, and 29 to clips 4, 5, and 6, then grade 27 is copied to shot 
4, grade 28 is copied to shot 5, and grade 29 is copied to shot 6.

Importing CDL Data Using ColorTrace

The ColorTrace CDL command lets you import ASC CDL file formats from other applications into 
DaVinci Resolve. Resolve version 11.1 also added the ability to read DRX filenames from CDL files, 
allowing a CDL to load exported Resolve grades.

There are three supported file formats:

>> CMX EDL: An EDL with comments referring to CCC/CDL XML files, or even Slope, Offset, 
and Power (SOP) data within the comment area.

>> CCC and CDL XML: A file format that contains various color correction looks, and even 
references.

To import CDL data into DaVinci Resolve:

1.	 If you’re importing CCC/CDL XML correction looks:

>>Open the Gallery page, right-click anywhere within the Stills tab, and choose “Import” from 
the contextual menu. 

>>When the Import Stills dialog appears, open the CDL/CCC files. When these are finished 
importing into the Gallery, an ASC logo will appear along with them.

2.	 Open the Edit page and select the Timeline you want to use ColorTrace with in the Timeline list.
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3.	 Right-click anywhere within the Timeline, and choose ColorTrace from CDL.

4.	 Select an EDL using the Select EDL dialog, and click Open.

5.	 Select its corresponding CDL and CCC files using the Select CDL Files dialog. If there are 
no CDL or CCC files (which is the case if there are inline SOP comments within the EDL), you 
should click cancel.

6.	 Using the ColorTrace With CDL window, copy the source grades from the CMX EDL/CCC & 
CDL XML files to the Target timeline.

	 At this point, the ColorTrace window works identically as previously described.

For formatting reference, here are some examples of CMX, CCC and CDL files.

Example CMX EDL File
TITLE: Final EDL FCM: NON-DROP FRAME 010 001 V C 01:19:28:16 

01:19:28:16 01:00:41:18 01:00:42:18 *ASC_CC_XML test_cc.102 

011 001 V C 00:00:00:00 01:19:28:16 01:00:42:18 01:00:43:18 

*ASC_SOP (0.9 1.2 0.5)(0.4 -0.5 0.6)(1.0 0.8 1.5)

Example CCC File
<ColorCorrectionCollection xmlns:”urn:ASC:CDL:v0.5” >

<InputDescription> test corrections for ref_input_image.1920

</InputDescription> <ViewingDescription>

for mathematical analysis only </ViewingDescription>

<ColorCorrection id=”test_cc.100”> <SOPNode>

<Description> for ref_output_image.0100 </Description> <Slope> 1.0 1.0 

1.0 </Slope> <Offset> 0.0 0.0 0.0 </Offset> <Power> 1.0 1.0 1.0 </Power>

</SOPNode> </ColorCorrection>

<ColorCorrection id=”test_cc.101”> <SOPNode>

<Description> for ref_output_image.0101 </Description> <Slope> 1.0 1.5 0.6 

</Slope> <Offset> 0.0 -0.1 0.01 </Offset> <Power> 1.0 1.5 0.5 </Power>

</SOPNode> </ColorCorrection>

</ColorCorrectionCollection>
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Example CDL File
<ColorDecisionList xmlns=<94>urn:ASC:CDL:v0.5<94> >

<InputDescription> GeneralProducts M1 std thru GP M1 LUT4 </

InputDescription> <ViewingDescription> GP P1, DCI P3, Pathe 

color emul </ViewingDescription> <ColorDecision>

<MediaRef ref=<94>/some/Project/frame%250900-0954%5B.

dpx<94>/> <ColorCorrection id=”cc03340”>

<SOPNode> <Description>change +1 red, contrast boost</

Description> <Slope>1.2 1.3 1.4</Slope> <Offset>0.3 

0.0 0.0</Offset> <Power>1.0 1.0 1.0</Power>

</SOPNode> </ColorCorrection>

</ColorDecision> </ColorDecisionList>

Calculating CDL Functions

To turn the SOP values into a primary correction, the following math is used by DaVinci Resolve:

Output = (Input * Slope + Offset)Power

Output refers to the final grade. Input is the value of each pixel within each color channel (on a scale 
from 0-1). The detente value for Slope is 1. The detente value for Offset is 0. The detente value for 
Power is 1.



Introduction to Color Grading

10



INTRODUCTION TO COLOR GRADING

446

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

10

Introduction to Color Grading

For thirty years, DaVinci has pioneered the development of color correction hardware and 
software designed to enhance visual images acquired from film and video. DaVinci Resolve 11 
possesses our newest and most evolved professional color correction tools yet. However, for 
all its technological sophistication, Resolve is merely a tool that requires the hands of a skilled 
artist to realize its full potential.

Subsequent chapters of this user manual cover the DaVinci Resolve grading tools in the Color page 
in great detail, but before getting into the specifics of color balancing and contrast adjustment, 
Power Windows and Custom Curves, it’s important to step back and consider what these tools are 
for, and why you’re learning to use this application in the first place.

This introduction is for those of you who are new to this process we call color correction, or color 
grading. If you’re a veteran colorist then you might want to skip ahead, but if you’re just starting 
out, the following sections are intended to describe the many goals of color correction, and how 
the DaVinci Resolve toolset has been designed to address them; making it fast and efficient to alter 
images in innumerable ways as we elevate raw footage to cinematic art.

The Goals of Color Correction� 443

Maximizing the Look of Your Media� 444

Emphasizing What’s Important� 447

Audience Expectations� 449

Balancing Scenes� 451

Adding Style� 453

Quality Control� 457

Never Stop Experimenting� 459
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If reality is a fire hose of visual information, then digital cinema and broadcast would be represented 
by a garden hose. Color correction, therefore, could be considered the process of choosing which 
parts of the fire hose of raw image data to fit into the garden hose of our displays in order to create 
a pleasing image for the viewer.

The Goals of Color Correction
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Maximizing the Look of Your Media

Clearly, the most fundamental aspect of the color correction process is that of making every clip 
look its best. While the job of the cinematographer is to light and expose the image with an artistic 
intent, your job is to realize this intent by making adjustments to the color and contrast of the 
image, so that the final result is as close to what the director and cinematographer had in mind as 
is humanly possible. In the process, you have the opportunity to overcome inconsistencies with 
exposure and white balance that were, for various reasons, unavoidable. Furthermore, you can 
make subtle adjustments to add warmth or contrast that was not available during the shoot, but 
that the cinematographer would have liked.

Increasingly, color correction is seen as a critical stage in the postproduction process. For example, 
the newer generation of digital cinema cameras are capable of shooting raw colorspace image 
data, or RGB image data with a log exposure, in order to preserve the maximum amount of image 
data for manipulation during the color correction process. However, when you acquire image data 
this way, it must be transformed into a viewable image via color correction in the same way that film 
negative must first be developed and printed to positive film.

Of course, there are also situations in which you may find it necessary to attempt to fix source media 
with far more substantial problems in color and exposure. In these cases, the tools exist to make far 
more involved adjustments to the image; however, the quality of your results will depend heavily on 
the data quality and “latitude” of your source media. For example, ARRI ALEXA and RED DRAGON 
cameras record quite a bit of image data, making extreme corrections far more possible than 
more heavily compressed camera formats such as the Canon 5D. However, in either case, Resolve 
provides the tools to process images in many different ways to adjust the image for a better look.

Log encoded source Corrected linear

Source footage courtesy of Gianluca Bertone DP, www.bertonevisuals.com
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Whether clips need changes large or small, the primary DaVinci Resolve toolset adjusts the 
characteristics of hue, saturation, and contrast in a variety of ways. Color balance wheels in the 3-way 
Color palette let you adjust all three color channels at once, altering the color temperature of the 
scene at specific ranges of tonal detail referred to as lift, gamma, and gain. Alternately, the slider-
based interface of the Primaries palette lets you make the same kinds of controls via independently 
adjustable red, green, and blue lift, gamma, and gain controls.

All of these controls let you adjust the color tone of the shadows independently from that found in 
the brightest highlights of an image.

Meanwhile, Master Lift wheels work together to let you alter image contrast in different ways: 
deepening shadows, lightening highlights, and brightening or darkening the midtones in between 
to create whatever image tonality you prefer for a given scene.

Balanced and gain correctedUnder exposed source

Primary correction wheels Primary correction bars

Cool look Warm look
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Source footage courtesy of Gianluca Bertone DP, www.bertonevisuals.com

Separate saturation controls let you increase or decrease color intensity throughout the scene, 
while the Sat vs. Lum and Sat vs. Sat give you the ability to fine-tune saturation very specifically.

For more information on these controls, which are essential to the color correction process, see 
Chapter 11, “Color Page Basics.”

Low ContrastHigh Contrast

Low SaturationHigh Saturation
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Another important aspect of the color correction process is the ability to make adjustments 
to emphasize or de-emphasize specific elements within the frame. It’s similar in concept to 
equalization in audio mixing, in that you’re choosing which color values to boost or suppress using 
a variety of techniques.

This can be done to direct the viewer’s gaze, for example by surrounding a specific part of the 
image with a Power Window, which lets you restrict specific adjustments made to the inside and 
outside of the Window’s shape.

Specific alterations can also be made to prevent audience distraction. For example, a 
low-saturation monochromatic tint may be a pleasing look overall, but in the soft wash of 
color, the viewer might lose track of the watch that’s preoccupying the protagonist. Using 
tools such as the Hue Curves and HSL Qualifier, you can quickly and easily tune the color of the 
woman’s hands and of the watch to guide the viewer’s eye, and bring some needed depth to 
the scene.

Emphasizing What’s Important
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For more information on Power Windows, see Chapter 8, “Power Windows.” For more information 
on Hue Curves, see Chapter 11, “Color Page Basics.”

Source image Curves and HSL qualification used to distinguish hands and 

highlight watch
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There is another family of tools, the HSL, RGB, and Luma Qualifiers, that provide even more specific 
control, and they’re useful for adjusting ranges of color to either play into or against the audience 
expectations for color in a scene. Substantial research into what has been termed “memory color” 
shows that people have finely tuned expectations for the hues of particular subjects, such as 
flesh tone, foliage greens, and sky blues. Deviation from these expectations can create a sense of 
something being not quite right, which can be either detrimental or beneficial, depending on your 
goals for a particular scene.

HSL Qualification is effectively a chroma keyer, that lets you sample the image to create a key that’s 
used to define where to apply a specific correction. For example, if you’re happy with the rest of the 
image but the skin tone of the actor has an unhealthy green tinge to it as a result, you can isolate 
the color of that actor’s skin and adjust it to a healthier hue.

Another common example is the adjustment of skies. If you’re aiming for a gorgeous summer day, a 
washed out sky in the source media can be a bit of a bummer. However, using qualification it’s easy 
to isolate that wedge of blue, then push and pull it into just the right amount of summertime joy.

Audience Expectations

Source Image HSL qualification on the skin

Skin now has warmer grade
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For more information on using Qualifiers, see Chapter 8, “Secondary Qualifiers.”

Originally graded scene HSL qualification of the sky

Corrected and sky enhanced
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It’s rare when the uncorrected shots of a scene match one another perfectly. Even the most carefully 
exposed angles of coverage can have small variances that need to be evened out. On the other end 
of the spectrum, run-and-gun programs using available light often result in edited scenes with huge 
changes in lighting and color as each shot cuts away to the next.

Small or large, unintended variations from one shot to the next can call undue attention to the 
editing, and jar the audience’s attention in ways that throw them out of the program. Evening out 
these differences and balancing the clips in each scene to match is another of the fundamental 
tasks of the colorist. You know you’re finished when the color in the scene flows unnoticeably from 
one clip to the next.

Resolve has a variety of tools that you can use to help you compare images with one another, the 
most important of which is the Gallery, in which you can save still images of clips that you can then 
compare to other clips using an adjustable split screen.

Thumbnail view of balanced clips, rainbow graphic indicates graded clips

Timeline thumbnail view of unbalanced clips

Balancing Scenes
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By using the Gallery to play stills, either split or whole (flipping back and forth between the clip 
you’re adjusting and the still), it becomes easier to use the extensive Resolve toolset to match the 
color and exposure of every clip in a scene.

Left image corrected to match right

An additional set of features let you manage grades by copying them from clip to clip, or by linking 
similar clips, either automatically, or manually using groups.

Link icon indicates clips are grouped for grading

For more information on using the Still Store, see Chapter 8, “The Color Page Interface.” For more 
information on grade management, see Chapter 9, “Copying and Managing Grades.”

Split screen of two shots
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Of course, it’s not all about subtlety and correction. It’s often appropriate, when grading music 
videos and commercials, for instance, to add some radical style to a piece. Here, too, DaVinci 
Resolve provides an abundance of features for manipulating unexpected aspects of the image; for 
example, by abusing the Custom Curves to create the illusion of chemical cross-processing.

Resolve’s node-based image processing makes it possible to use more exotic node structures to 
create effects using composite modes, such as a colored glow generated by adding two differently 
graded versions of the same image together using a Layer node.

Image enhanced with curves

Source

Custom Curves controls

Adding Style
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You can also create complex node trees to build specific mattes, to use for isolating specific 
elements of the image. For example, if you wanted to isolate an actor in color against a background 
turned monochromatic, you can create multiple keys (pulled via HSL Qualification) and combine 
them using a Key Mixer node to build that effect.

(Top) Original Image, (Middle) Node tree adding two different treatments together,  

(Bottom) Enhanced and balanced final
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(Top) Original image, (Middle) Node tree to isolate the man’s face and clothes,  

(Bottom) The final effect, desaturating everything except for the man

Finally, Resolve doesn’t just have tools governing color and contrast. A Blur palette provides controls 
over blurring, sharpening, or adding mist to all or part of the image. When combined with the other 
tools that are available for isolation and color adjustment, these are powerful additions to your 
creative arsenal.
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For more information on all of these features, see chapters 11 through 13 of this manual.

Defocus effect created in real time
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Lastly, it’s important to keep in mind that, for all the creative possibilities that DaVinci Resolve affords, 
it’s still important that the final deliverables that you give to your client has appropriate signal levels 
relative to their requirements. In particular, programs destined for broadcast have specific outer 
boundaries of luma and chroma that you must not exceed, or you’ll risk having a show rejected for 
QC (quality control) violations.

However, even if you’re not delivering a show for broadcast, it’s important to be aware of the 
mathematical limitations of a digital video signal to make sure you’re not clipping or crushing image 
detail through overzealous adjustments that you may, in fact, want to preserve.

For example, if you take a look at the next two images, you can see the perils of overzealous 
adjustments when compared to a clip that, while graded creatively, has been adjusted with respect 
to the mathematical boundaries of image data.

Here, too, Resolve provides tools designed to help you exercise control over the fine-tuning of 
the image. A Video Scopes window provides the standard Waveform, Parade, Vectorscope, and 
Histograms that are used to analyze your image data. These scopes let you see the boundaries of 
what’s possible, and make it easy to spot subtle problems, and compare the characteristics of one 
image to another.

Image graded to preserve detail in highlights Image graded with highlight detail blown out

Quality Control
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When the time comes that you want to start clipping data in the highlights and shadows, as part of 
a creative look, the Soft Clip controls let you introduce a subtle or large roll-off, compressing the 
extremes of the signal so that what clipping you do is softer and more pleasing.

For more information about the Video Scopes and the Soft Clip controls, see Chapter 11, “Color 
Page Basics.”

Video Scopes
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Never Stop Experimenting

So now that you’ve gotten an extremely brief overview of the grading process as seen through the 
toolset of DaVinci Resolve, we invite you to use this manual to explore Resolve more thoroughly. 
You may discover that, the more you work with the different features that are available, the more 
unexpected uses you’ll find for different controls that you thought you knew well.

Have fun.
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The Color page is the heart of DaVinci Resolve. Within the Color page are all of the controls 
available for manipulating color and contrast, reducing noise, creating limited secondary color 
corrections, building image effects of different kinds, adjusting clip geometry, and making many 
other corrective and stylistic adjustments.

Color Page Basics

The Color Page Interface� 464

Viewer� 464

Gallery� 466

Node Editor� 467

Timeline� 468

Left Palettes� 469

Center Palettes� 469

Keyframe Editor� 471

Dual Monitor Layout� 471

On-Screen Controls and External Displays� 473

The On-Screen Control (OSC) Menu� 474

The Viewer Toolbar� 475

Zooming into the Viewer� 475

Using the Scubber Bar and Transport Controls� 476

Controlling Playback Using the Spacebar and JKL Keys� 477

Navigating Using Timecode� 477

Navigating Using the DaVinci Control Surface� 477

Viewer and Transport Timecode Displays� 478

Enhanced Viewing, Full Viewing, and Cinema Viewing� 479

Safe Area Overlays in the Viewer� 482

Monitor Calibration� 484

Viewing Broadcast Safe Exceptions� 485

Saving and Wiping Stills in the Gallery� 487

Different Viewer Reference Modes� 490

Using Split Screen Modes� 491

Show Current Clip With Handles� 496

Thumbnail Info� 498

Changing Timelines� 500

A and C Mode Sorting� 500

Flags and Markers� 502
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Timeline Filtering� 503

Clip Info�

System Info�

Clip Details�

Customizing the Color Page� 471

Using the Viewer� 472

Comparing Clips in the Viewer� 484

Using Video Scopes� 490

Navigating Using the Color Page Timeline� 493

Sorting and Filtering Clips in the Timeline� 496

Using the Lightbox� 501

The Info Palette and Clip Information� 503

About Undo and Redo� 506

Color Controls� 507

Camera Raw� 508

How to Use Color Balance Controls and Master Wheels� 517

Understanding the Primaries Mode Controls� 519

The Log Mode of the Color Wheels Palette� 525

RGB Lift/Gamma/Gain Sliders� 531

Offset Sliders and Wheel� 532

Saturation, Hue, and Lum Mix in the Primaries palette� 535

Preserve Luminance� 537

Resetting the RGB Mixer� 537

Swap Channels Buttons� 537

Using the RGB Mixer in Monochrome Mode� 538

RGB Mixer Controls on the DaVinci Control Surface� 510

Copying, Versioning, and Protecting Camera Raw Settings� 511

Making Changes to Clip Camera Raw Settings�

Clip Decoder Settings�

Resetting Camera Raw Settings�

Color Match Palette� 513
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In this chapter, you’ll learn how to understand the Color page interface, how to customize it, and 
how to work within it to play through and navigate your project’s timeline. You’ll also learn how to 
analyze and compare clips in preparation for grading using stills, playheads, and DaVinci Resolve’s 
own internal video scopes.

Configuration Controls� 515

Reset Controls� 516

Adjustments Controls� 516

Color Wheels Palette� 517

Primaries Palette� 529

RGB Mixer Palette� 533

Motion Effects Palette� 539

Noise Reduction Controls� 539

Motion Blur� 546

OpenFX� 547

Applying OpenFX Plug-Ins� 548

OpenFX Settings� 549

OpenFX On-Screen Controls� 550

Using OpenFX� 550

Curves� 552

Adjusting Curves Using the Mouse� 552

Custom Curves� 553

Soft Clip� 559

Automatic Broadcast Safe Limiting� 575

Monitoring What Broadcast Safe Will Clip� 576

Resolve Live� 577

Configuring Your System for Resolve Live� 577

Grading Live� 578

Using Resolve Live Grades Later� 581

Using LUTs in Resolve Live Workflows� 582
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The Color page is divided into seven main areas that work together to let you build a grade.  
This section provides an overview of what these areas are and how they function.

The default layout of the Color Page

Viewer

The Viewer shows the frame at the current position of the playhead in the Timeline. At the top of the 
Viewer is a header that displays the Project and Timeline names, as well as a Viewer Timecode 
display that shows the source timecode of each clip by default. The Timeline name is also a pop-up 
display that lets you switch to any other timeline in the project. A scrubber bar underneath the 
image lets you drag the playhead across the entire duration of the clip, while transport controls 
underneath that let you control playback. A toolbar at the top provides controls governing Image 
Wipes, Split-Screen controls, and Highlight display. Additional controls let you loop playback, switch 
Unmix mode on and off, turn audio playback on and off, and choose which on-screen controls are 
currently displayed. More information about using the Viewer appears later in this chapter.

Viewer with transport controls

The Color Page Interface
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Gallery

The Gallery is used for storing still frames to use as reference, and grades you might like to copy; 
stills and grades are stored together. A button lets you open up the Album browser, used for 
organizing your stills. At the bottom of the Gallery, Memories let you store grade information that 
you can apply using a control surface or keyboard shortcuts. The Gallery on the Color page mirrors 
the contents of the Gallery page. For more information on the Gallery page, see Chapter 13, “The 
Gallery and Grade Management.”

The Gallery has Memories, stills saved in Albums and your PowerGrades
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Node Editor

The Node Editor is where you assemble one or more individual corrections (nodes) together into a 
complete multi-correction grade (node tree). This is a powerful way of assembling grades, since 
different types of nodes let you create different combinations of corrections and very specific 
adjustments by reordering operations, combining keys, or changing the layer order of different 
adjustments. For more information about the Node Editor, see the “Node Editor Basics” section of 
Chapter 12, “Advanced Color Features.”

Node Editor to construct your grade processing signal flow
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Timeline

The Timeline provides several ways of navigating the clips in your project, as well as keeping track 
of what has been done to which clips. The Timeline is divided into three parts, each of which shows 
different information and provides differing controls.

A Timeline Ruler at the top lets you scrub the playhead across multiple clips, and can be zoomed 
out enough to show every clip in your entire program. Underneath, the Mini-Timeline (which can be 
opened or closed via a button at the right of the palette bar) shows a small representation of the 
Timeline in the Edit page wherein each clip is as long as its actual duration. 

The Thumbnail timeline with a Mini-Timeline above

The currently selected clip is orange, and you can click any clip to select it. A scroll bar at the bottom 
lets you navigate to the left and right, while using the scroll wheel of your mouse zooms in and out. 
The Mini-Timeline shows at most six tracks of video. If your project has more tracks than that, you can 
scroll up and down to reveal the hidden tracks. Any markers that were placed on clips or the Timeline 
in the Edit page appear here, and you can click any marker to reveal and edit its color and notes. 

At the bottom of the Timeline is the Thumbnail timeline, in which each clip is represented by a single 
frame. The currently selected clip is outlined in orange, and information appears above and below 
each thumbnail such as each clip’s source timecode, clip number and track number, version name, 
whether it’s been graded, whether it’s been tracked, if it’s been flagged, and so on.

Clip Thumbnail

More information about working with the Timeline appears later in this chapter.
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Left Palettes
A series of palettes at the bottom left of the Color page provide access to different sets of grading 
tools, used principally for manipulating color, contrast, and raw media format settings. Each 
individual palette is opened by clicking the corresponding icon at the top of the Palette panel.

Left palette selection buttons

The six available palettes are the Camera Raw palette (for making metadata adjustments to raw 
media formats), the Color Match palette (automatic grading based using test charts), the Color 
Wheels (graphical color balance controls and master wheels), the Primary controls (sliders for 
adjusting YRGB Lift/Gamma/Gain), the RGB Mixer (for mixing color channels into one another), and 
the Motion Effects palette (with controls for noise reduction and artificial motion blur).

These palettes can be used individually or together depending on what you’re trying to accomplish. 
More information about each color palette appears in “Color Controls.”

Center Palettes

At 1920x1080 resolution or higher, a second set of palettes is organized at the bottom center of the 
Color page. These palettes span a wide range of functionality, and the adjustments you make with 
them can be combined with those made using the Color palettes.

Center palette selection buttons

Note: At lower resolutions, the Left and Center palettes are merged to fit the Resolve interface into 
a smaller area.

The nine available Center palettes include the Curves palette, the Qualifiers palette, the Power 
Windows palette, and Tracker palette, the Blur palette, the Key palette, the Sizing and Stereoscopic 
3D palettes, and the Data Burn-In palette.
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Keyframe Editor

The Keyframe Editor provides an interface for animating Color, Sizing, and Stereo Format 
adjustments over time.

Keyframe Editor displaying dynamic grade changes

Each node in the Node Editor corresponds to a track in the Keyframe Editor, which lets you animate 
each node’s adjustments independently. Furthermore, each node’s track can be opened up 
to reveal Parameter Groups, so that you can animate subsets of an individual node’s functions 
independently of other functions within the same node.

More information about working with the Keyframes Editor can be found in “Keyframing.”

Dual Monitor Layout

The Color page has a dual monitor layout that provides maximum space for the Viewer, Node Editor, 
and Control palettes on the primary monitor, and a simultaneously displayed Gallery, Keyframe 
Editor, Metadata Editor, and Video Scope panel on the secondary monitor.

To enter dual screen mode:

>> Choose View > User Interface Layout > Dual Screen > On.

To switch which UI elements appear on which monitors:

>> Choose View > User Interface Layout > Primary Display > Display 1 or Display 2, which 
reverses the contents of both monitors in dual screen mode.

The Color page in dual screen mode
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The various sections of the Color page can be resized, hidden, and rearranged as needed to 
accommodate different working styles. This section covers all of the methods that are available for 
Color page customization.

You can easily resize the Viewer, Gallery, and Nodes Editor relative to one another to make the 
Viewer larger, expand the width of the Node Editor to have more workspace, or to create more or 
less room for stills in the Gallery.

To resize the Viewer, Gallery, and Node Editor:

>>Move the pointer over the vertical divider between any two areas. When the resize icon 
appears, drag the divider to the left or right to make one area larger while making the 
other smaller.

You can also fully expand the Gallery, the Memories, the Node Editor, and the Keyframe Editor to 
replace completely whichever interface area is adjacent.

To expand the Keyframe Editor:

>> Click the Expand control at the bottom left of whichever interface area you want to expand. 
Once expanded, clicking the Expand control again will collapse that interface area back to 
its original size, revealing whatever was hidden.

In Display mode, you can completely hide the Viewer, pushing the Gallery all the way to the right 
side of the Resolve window, and expanding the Node Editor to take the rest of the space.

To toggle Display mode, do one of the following:

>> Right-click in the empty area of the Node Editor, and choose Display Mode from the 
contextual menu. Do this again to toggle Display Mode off and return the interface to the 
way it was.

>> Press SHIFT UP and DISPLAY/CURSOR, above the fourth trackball of the Center panel of 
the DaVinci control surface.

To show and hide the Mini-Timeline:

>> Click the Timeline button at the right of the palette button bar.

To show and hide the Color page Viewer upper toolbar:

>> Click the viewer option menu and choose Show Viewer Options to uncheck it.

To return all pages to their default layout:

>> Choose View > Reset UI Layout

Customizing the Color Page
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The Viewer is your window into the Timeline. The clip and frame at the current position of the 
playhead appears in the Viewer. The Viewer also provides a workspace for picking colors, adjusting 
Power Windows, using split-screen stills for reference, and many other display-oriented tasks. If you 
have a video out interface connected to a broadcast display or projector, then the contents of the 
Viewer are typically mirrored by the video output.

On-Screen Controls and External Displays

DaVinci Resolve has been designed for use with calibrated external displays connected to video 
output interfaces, and for most colorists working on broadcast or theatrical programs, this is the 
recommended way to work for color critical evaluation. 

Because of this, many of the on-screen controls associated with tasks such as color sampling, 
window adjustment, and key manipulation are mirrored to your video output, making it possible to 
hide the Viewer on your computer’s monitor and work with only an external display.

To choose whether on-screen controls are mirrored to video out, or disabled:

>> Choose an option from the View > Window Outline submenu. There are three options:

>>Off: Hides the window outline on both the external display and the Viewer.

>>On: The default, shows the window outline on both the external display and the Viewer.

>>Only UI: Hides the window outline on your external display, but leaves it in the Viewer.

To show or hide window on-screen controls using the DaVinci control surface:

>> Press SHIFT UP and then DISPLAY/CURSOR, above the fourth trackball on the Center panel. 
This command is a three-way toggle. The first use of this command hides the window outline 
on your external display, but leaves it in the Viewer. The second use of this command hides 
the window outline on both the external display and Viewer. The third use of this command 
shows the window outline on both the external display and Viewer.

Using the Viewer
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The On-Screen Control (OSC) Menu

The On-Screen Control pop-up menu lets you choose which on-screen control you want to display 
in the Viewer. There are four choices:

The on-screen control menu for the Viewer

>>Off: All on-screen controls are hidden from view, giving you an unimpeded display of the 
image in the Viewer.

>>Qualifier: Turns on the Color Sample cursor, which lets you choose a color using the fourth 
trackball of the DaVinci control surface. For more about using Color Sample controls, see 
“Secondary Qualifiers.” 

>> Power Window: Turns the Power Windows on-screen control on and off. For more about 
adjusting windows in the Viewer, see “Power Windows.”

Grading With the Viewer on a Computer Display

Since most computer displays do not operate at the color critical tolerances or specifications 
required for broadcast or theatrical delivery, you’ll likely need an external broadcast display of some 
type. However, it’s worth noting that the Viewer displays each clip’s image data as it is handled by 
the calibration that your operating system applies to your computer display, making it eminently 
suitable for monitoring projects destined for the sRGB standard of the web if you have a high-
quality, sRGB-calibrated computer monitor.

Additionally, you can apply a dedicated Viewer LUT using the 1D/3D Color Viewer Lookup Table 
pop-up menu, found in the Look Up Tables panel of the Settings window. This lets you calibrate 
a computer display in the same way you would calibrate an external display, using a probe and 
color management software, and apply the resulting calibration LUT in Resolve. Keep in mind that 
monitor calibration can only make a high-quality display standards compliant, it cannot make up 
for a display gamut that’s too small. For more information, see the “Look Up Tables” section of 
Chapter 23, “Project Settings, Caching, and Preferences.”
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>> Image Wipe: Toggles mouse control of dragging the split screen directly on the Viewer on 
and off. For more about working with split screens, see “Comparing clips in the Viewer.”

>> Dust Removal Tool: Activates the interactive Dirt and Dust tool. For more information, see 
later in this chapter.

>>OpenFX: Shows and hides whatever on-screen controls are exposed by an OpenFX plug-in 
in the currently selected node.

>> Color Chart: Shows and hides the color chart overlay that lets you identify a color chart in 
the picture that you want to use with the Color Match palette to create an automatic grade.

The Viewer Toolbar

The Color page has a toolbar at the top of the Viewer that makes it easy to enable and disable 
Image Wipe, Split-Screen, and Highlight viewing by clicking one of these three buttons. In the 
process, these buttons provide an easy reference for when a comparison mode is enabled. In each 
of these Viewer modes, the appropriate controls for customizing that view appear to the right of 
the Viewer toolbar.

This toolbar can be hidden by clicking the Viewer option menu and unchecking Show Viewer Options. 

Zooming into the Viewer

When using the Viewer to sample tricky colors or draw a detailed PowerCurve, it can be advantageous 
to zoom into the image.

To zoom into or out of the Viewer, do one of the following:

>>Make sure that View > Allow Mouse Zoom is on, then move the pointer to within the Viewer, 
and then roll the scroll wheel to zoom in or out of the image.

>> Press Command-Equal to zoom in, or Command-Minus to zoom out.

To pan around the Viewer:

>>Move the pointer to within the Viewer, then middle-click and drag to pan around the image.

To reset the size of the viewer image:

>> Choose View > Actual Size (Option-Shift-Z)

>> Choose View > Zoom to Fit (Shift-Z)

Selecting a range of clips to turn into a compound clip
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>> Right-click anywhere within the Viewer, and then choose one of the following options from 
the contextual menu:

>> Actual Size: Zooms to the native resolution of the clip. If the clip is larger than the 
Viewer, it will be cut off around the edges.

>> Zoom to Fit: Zooms so that the entire image fits within the Viewer.

Using the Scubber Bar and Transport Controls

One of the principal uses of the Viewer is to control playback. The scrubber bar, directly underneath 
the image in the Viewer, contains a playhead that you can drag to the left and right to navigate 
quickly through the currently selected clip as fast as you can move the pointer. The playhead in the 
scrubber bar is locked to the playheads found in the Timeline and Keyframe Editor. Moving one 
playhead moves all three.

How much of the Timeline the scrubber bar navigates depends on whether the Node Editor is set 
to Clip or Track mode. In Clip mode, the scrubber bar width equals the duration of the currently 
selected clip. In Track mode, the scrubber bar width equals the total duration of the entire Timeline.

A row of transport controls below the scrubber bar provides more specific control over 
timeline playback.

>> Previous clip: Moves the playhead to the first frame of the previous clip.

>> Reverse: Initiates 100% playback in reverse.

>> Stop: Stops playback.

>> Play: Initiates 100% playback.

>>Next clip: Moves the playhead to the first frame of the next clip.

>> Loop: Lets you restrict playback to the current clip, looping to the first frame if you’re playing 
forward to the end of a clip, or looping to the last frame if you’re playing in reverse to the 
beginning of a clip.

Two other buttons let you control playback and display in the Viewer:

>> Unmix: Turning on Unmix disables all transitions, composited superimpositions, and effects 
that mix two or more clips together. Unmix allows you to judge the appearance of a clip 
without distraction whenever you need to make an adjustment based on how the clip looks 
on its own, or whenever you need to make changes based on frames that would otherwise 
be hidden underneath a transition such as a dissolve or fade from black. When you’re ready 
to see how your grades work in context with transitions and composites again, turn Unmix off.

>>Mute: Lets you turn audio playback off and on if you’ve loaded an Audio Chase Track for 
the current edit.
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Controlling Playback Using the Spacebar and JKL Keys

You can also use the spacebar to start and stop playback, or the JKL keyboard shortcut convention 
for controlling playback, where J plays in reverse, K stops playback, and L plays forward. There 
are many additional uses of of these keyboard shortcuts, for more information see “Using JKL to 
Control Playback” in Chapter 6, “Edit.”

Navigating Using Timecode

You can also use absolute or relative timecode entry to move the playhead in both the Source 
and Timeline viewers. When entering timecode, type each pair of hour, minute, second, and 
frame values consecutively, with a period representing a pair of zeros for fast entry. The last pair of 
timecode values (or period) you enter is always assumed to be the frame number, with any untyped 
values assumed to be zero. It’s not necessary to enter colons or semicolons. For more information, 
see “Navigating Using Timecode” in Chapter 6, “Edit.”

Navigating Using the DaVinci Control Surface

It’s also possible to navigate the Timeline using the DaVinci control panel. A set of buttons on the 
Transport panel include:

>> PREV/NEXT SCENE: Moves the playhead among the first frame of each clip.

>> STEP REV/FWD: Moves the playhead from frame to frame.

>> FIRST FRAME/LAST FRAME: Jumps the playhead to the first and last frame of any given clip.

>> RWD/FFWD: Moves the playhead in rewind of fast forward.

>> REV/STOP/FWD: The standard play reverse, stop, and play forward commands.

Another set of navigation controls is available by pressing the MODE button above the fourth 
trackball on the Center panel, and then pressing the CUE MODE soft key.

You can also use the jog wheel and shuttle control on the Transport panel. The jog wheel lets you scrub 
frame by frame, while the shuttle control moves among preset rewind and fast forward speeds.

Note: If a Gallery still is turned on for split screen comparison, the shuttle control will adjust the split 
screen center, and not the playhead position. Turning Reference Wipe off again frees up the shuttle 
control to affect playback again.

Finally, there are two additional methods of navigating using the DaVinci Control Panel that make it 
easy to jump to a specific clip or timecode value.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

480

COLOR PAGE BASICS11

To move the playhead to the first frame of a specifically numbered clip:

>>On the Transport panel, enter a clip number using the number pad, then press TAKE ENTER.

To move the playhead relative to its current position:

1.	 Press + or – on the number pad.

2.	 Enter either a number of frames, or a timecode value using colons to divide each pair of digits 
(for example +01:00:23:12). 

3.	 Press TAKE ENTER.

To move the playhead to an exact timecode value:

1.	 Using the number pad, enter a timecode value, using colons to divide each pair of digits (for 
example 01:00:23:12). 

2.	 Press TAKE ENTER.

Viewer and Transport Timecode Displays

The Viewer has two timecode displays, each of which defaults to a different timecode setting. 

A timecode display at the top, the Header Timecode Display, shows the Source timecode by 
default. The timecode display at the bottom, the Transport Timecode Display, shows the Record 
timecode by default. The bottom timecode display can be changed to show one of four different 
options, which are similar to those found in the Data Burn In palette.

The bottom timecode display can be changed to show one of four different options, which are 
similar to those found in the Data Burn In palette.

To change a timecode display to a different setting:

>> The top Timecode display is a pop-up menu that can be changed to whatever timecode, 
frame number, or keykode you want to display. The bottom Timecode display can also be 
changed by right-clicking on it and choosing the type of value to show from the contextual 
menu that appears.

>> TimelineTimecode: The timecode corresponding to the playhead’s position in the 
overall Timeline.

>> Source Timecode: The timecode corresponding to the playhead’s position relative to 
the currently selected clip.

>> Timeline Frame Number: The frame count corresponding to the playhead’s position 
in the overall Timeline.

>> Source Frame Number: Source Frame Number: The frame count corresponding to the 
playhead’s position relative to the currently selected clip.
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>> KeyKode: The KeyKode number corresponding to the media’s KeyKode track, if 
there is one.

>> Show Timecode at 30 FPS: Displays 24 fps timecode, via 3:2 pulldown, as 29.97 fps 
timecode. Has no effect on video playback.

In the same way, the top timecode display can alternately be changed to show keykode, if it’s 
available, within a DPX media file’s header.

Enhanced Viewing, Full Viewing, and Cinema Viewing

A button at the far right of the Color page toolbar lets you expand the Viewer into Enhanced 
Viewing mode. Alternately, you can choose View > Enhanced Viewer mode (Option-F), or you can 
press CURRENT/VIEWER on the T-bar panel of the DaVinci control surface.

In Enhanced Viewing mode, the Viewer works exactly as it does at its regular size, but it expands to 
fill up the entire area of the screen above the palettes and Keyframe Editor. To exit Enhanced 
Viewing mode, click the lower right-hand corner button again.

Enhanced Viewer button, at the far right above the Timeline

This can be useful if you need a closer view of the image for purposes of making detailed 
corrections, examining noise patterns up close, making a tricky color selection, or drawing a 
complicated PowerCurve.
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Color page in Enhanced viewer mode

In Full Viewing mode (available by choosing View > Full Screen Viewer, pressing Shift-F, or Option-
clicking the Enhanced Viewing mode button), the Viewer takes up even more room by hiding the 
palette controls, but leaves room for the transport controls, the On-screen Control pop-up menu, 
the timecode display, and the page buttons along the bottom of the Resolve UI. This mode is useful 
when you need an even closer look at the image, but you still want access to a minimal set of on-
screen controls.

Color page in Full Viewer mode
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Another option, Cinema mode, allows for full-screen viewing. Cinema mode is available by choosing 
View > Cinema Mode (Command-F). In Cinema mode, the menu bar is hidden, and the image is 
presented full screen without any of the ordinary on-screen controls. Moving the pointer over the 
screen reveals a set of hidden on-screen controls that include a play button, scrubber bar, mute 
button, and exit button (which lets you turn off Cinema mode).

Color page in Cinema mode

Cinema mode is useful for doing detailed reviews of media in on-set and digital dailies workflows 
when working remotely without a secondary video display.

Tip: If you’d like to superimpose timecode over the image in Cinema mode for reference, you can 
use the controls within the Data Burn-In palette to set up whatever information you’d like to display 
during playback.
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Safe Area Overlays in the Viewer

You can show or hide a series of safe area overlays in the Viewer. All safe area overlay options are 
found in the View > Safe Area menu. Each safe area overlay option can be individually enabled or 
disabled from this menu.

Viewer displaying extents, center, safe, action and title area overlays

>>On/Off: Turns all currently selected safe area marker options on or off at once.

>> Extents: An outline showing the exact outer edge of the frame. Especially useful when the 
safe markers are set to an aspect ratio other than that currently used by the Viewer.

>> Action: An outline showing the outer 90% action safe area of the frame.

>> Title: An outline showing the outer 80% title safe area of the frame.

>> Center: A crosshairs showing the center of the frame.

>> Aspect: Enables use of the View > Select Aspect Ratio submenu to change the aspect ratio 
of the safe area markers. You can choose among the following aspect ratios: 1.33 (a.k.a. 4:3), 
1.66, 1.77 (a.k.a. 16:9), 1.85, and 2.35.

You can also access these options directly using the DaVinci control surface.

To customize safe area markers using the DaVinci control surface:

1.	 Press MODES, above the fourth trackball on the Center panel.

2.	 Press the SAFE AREA soft key. The Center panel soft keys are remapped with all of the available 
safe area options.

3.	 When you’re finished, press EXIT.
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Monitor Calibration

If you use Light Illusion’s LightSpace CMS or SpectraCal’s Calman for display calibration, you 
can now use DaVinci Resolve as a sync-able pattern generator. This means you can use Resolve 
to output color patches, synchronized by LightSpace, to your display through whichever video 
interface is connected to your computer. These synchronized color patches will be analyzed by a 
monitor probe that’s also controlled by LightSpace, which stores the probe data and compares it to 
the original color values of the output color values in order to characterize that display.

To use this feature, you must first have a licensed copy of LightSpace CMS, which is a Windows 
application. Synchronization depends on a wired or wireless LAN being available to connect the 
LightSpace application with Resolve.

To synchronize LightSpace CMS to DaVinci Resolve as a pattern generator client:

1.	 Open LightSpace on the Windows computer that’s running it.

2. 	 When LightSpace is open, click the Network Manager button. A window appears displaying 
the two network IP addresses used by LightSpace. Note these, and click the Enable button.

The Network Manager dialog in LightSpace CMS 

3. 	 In DaVinci Resolve, choose Monitor Calibration > LightSpace. 

4.	 When the LightSpace dialog opens, enter the second of the two network IP addresses 
LightSpace lists into the Remote Machine field, and make sure the Port number matches.  
Then click the Connect button.
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The Calibration dialog in Resolve, connected to LightSpace CMS via WiFi

	 If everything is working correctly, the LightSpace dialog in Resolve should show the word 
“Connected,” and the Network Manager dialog in LightSpace should show that there is “1 
available client/s.” 

	 You can now close the Network Manager dialog in LightSpace and follow the procedures 
outlined in the LightSpace CMS documentation for characterizing your display and building 
and exporting a display LUT (in the .cube format) that you can use as a display LUT in Resolve. 
Alternately, you can export a display LUT from LightSpace that can be loaded onto an outboard 
video processing device connected between your video

5.	 When you’re finished, click Disconnect in the LightSpace dialog, and then click Cancel to close 
the window.

Viewing Broadcast Safe Exceptions

Choosing View > Display Broadcast Safe Exceptions sets the Color Page viewer to show a false-
color overlay that indicates regions of the picture that violate the currently selected broadcast safe 
level in the Project Settings in blue. 

More information about Broadcast Safe limiting in the Project Settings appears later in this chapter.

Areas of the image that violate broadcast safe are highlighted in blue
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The ability to compare different clips to one another is an important part of the color correction 
process. DaVinci Resolve provides three different ways of doing so. You can use the Gallery to 
display two clips for split-screen comparison. You can also use different reference modes to see a 
timeline clip or reference movie directly as part of a split-screen comparison. Finally, you can use 
the playhead’s interface to display up to four clips simultaneously using a two, three, or four-up 
arrangement in the Viewer.

Saving and Wiping Stills in the Gallery

The Gallery on the Color page provides fast access to stills that you’ve saved from various clips in the 
Timeline. While the dedicated Gallery page provides a more comprehensive interface for browsing 
pre-saved “Looks,” as well as for importing stills from other projects, you can save, organize, and 
browse stills directly within the Gallery of the Color page.

Stills are saved in the DPX file format. Once you’ve saved one or more stills, you can set up split-
screen wipes in the Viewer, which will be mirrored to your external display. 

Stills from the Gallery can be compared to the current shot making it easier to match grades

This section provides an abbreviated summary of still store and split-screen functionality to get you 
started quickly.

Comparing Clips in the Viewer
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To save a still, do one of the following:

>> Choose View > Grab Still (Option-Command-G).

>> Right-click on the Viewer and choose Grab Still.

>> Press GRAB STILL on the Transport Panel of the DaVinci control surface.

To wipe a still, do one of the following:

>> Select a still in the Gallery, and click the Image Wipe button on the top Viewer toolbar. 
Or, choose View > Wipe On/Off (Command-W), or right-click in the Viewer and choose 
Toggle Wipe.

>> Double-click a still in the Gallery.

>> Press PREV STILL or NEXT STILL on the Transport Panel of the DaVinci control surface to 
select a still, then press PLAY STILL.

To adjust a wipe in the Viewer, do one of the following:

>> Drag the pointer within the Viewer to move the wipe.

>> Push the T-bar control up and down on the T-bar panel of the DaVinci control surface.

To customize a wipe in the Viewer:

>> Choose one of the following from either the View menu or the Viewer contextual menu:

>>Wipe Type: Cycles among the Vertical Wipe, Horizontal Wipe, Blend Wipe, and Alpha 
Wipe modes.

>> Invert Wipe: Reverses each half of the wipe.

Copying Grades from Stills in the Gallery

Stills also store the grade from the clip they came from, and can be used to copy grades from one 
clip to another, or to store grades that you might want to use later.

To copy a grade from a still to a clip, do one of the following:

>> Select a clip in the Timeline, then right-click a still in the Gallery and choose Add Correction.

>> Select a clip in the Timeline, then middle-click a still in the Gallery.

When you copy a still in this way, the saved grade completely overwrites the grade in the target 
clip, unless you’ve used the “Preserve number of nodes” option, found in the contextual menu of 
the Gallery. For more detailed information on using the Gallery, including options for organizing 
the Gallery browser, instructions for using Albums, Power Grades, and Memories, as well as other 
methods of copying grades and performing advanced grade management tasks, see Chapter 13, 
“The Gallery and Grade Management.”
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Different Viewer Reference Modes

While it’s common to use the Gallery to wipe against reference stills, by changing the reference 
mode you can create a wipe against a clip in the Timeline, or against an offline video, if one has 
been assigned to the current Timeline.

To change the Viewer reference mode, do one of the following:

>> Choose an option from the View > Reference Wipe Mode submenu.

>> Right-click the Viewer and choose Toggle Ref Mode from the contextual menu.

>>On the T-bar panel of the DaVinci control surface, press REF ON/OFF to toggle the 
reference mode immediately to Offline mode and back again, in order to split screen the 
current clip against an offline video.

There are three Reference Modes:

>>Gallery: The default reference mode. Lets you wipe the current clip against a Gallery still.

>> Timeline: Lets you wipe the current clip against another clip in the Timeline using the Wipe 
Timeline Clip command (see below).

>>Offline: Lets you wipe the current clip against an offline video that’s been assigned to the 
current Timeline.

If you want to split screen the current clip against another clip in the Timeline, without saving a still 
to the Gallery first, there’s a special procedure you can follow.

To split screen two clips using the Timeline reference mode:

1.	 Click the thumbnail of the first clip you want to compare.

2.	 Right-click the thumbnail of the second clip you want to compare against, and choose Wipe 
Timeline Clip from the contextual menu.

	 Both clips appear split screened against one another.

	 Note: Wipe Timeline Clip only appears in the contextual menu if you right-click on a thumbnail 
in the Timeline that has not been selected.
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Using Split Screen Modes

A set of Split Screen modes provides additional ways of comparing multiple images in the Viewer 
at the same time. These provide side-by-side and grid comparisons of multiple shots and multiple 
versions, all of which are output to video for monitoring on your external video display. For example, 
you can use the Split Screen Versions mode to display every single version that’s applied to the 
current clip in a grid, for easy evaluation. The currently selected clip in the Timeline is highlighted in 
gray, so you can keep track of what you’re doing.

To enable a split screen mode, do one of the following:

>> Click the Split Screen button on the top Viewer toolbar, and choose a split screen method 
from the pop-up menu that appears in the Viewer toolbar at the right.

>> Choose an option from the View > Split Screen submenu.

>> Right-click the Viewer and choose an option from the Split Screen submenu in the 
contextual menu.

Four shots shown in a grid using the Split Screen > Selected Clips mode

In any of the split screen modes, the current clip is indicated by a gray outline. This outline can be 
disabled for a more direct comparison by choosing View > Split Screen > Show Outline to toggle 
the outline off and on.
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Note: When any of the Split Screen modes are selected, you cannot see any other on-screen 
controls in the Viewer, such as Power Window shapes, until you first disable Split Screen.

Available Split Screen modes, and their effects:

>> Versions: Shows up to sixteen versions for the current clip, all at once, making it easy to 
evaluate a series of different versions in relation to one another. If you have more then 
sixteen versions, you deserve some manner of award.

>> Versions and Original: Shows up to the first fifteen versions for the current clip, along with 
the original ungraded clip at the upper left-hand corner.

>>Group: Shows up to sixteen clips that share the same group as the current clip.

>> Selected Clips: Shows all currently selected clips in the Timeline, up to sixteen at one time.

>>Neighbor Clips: Shows four clips that immediately surround the current clip. The previous 
two clips appear as the upper left- and right-hand clips, the current clip appears at the 
lower left-hand corner, and the next clip appears at the lower right.

Previewing four gallery grades using the Split Screen > Gallery Grades mode

>>Gallery Grades: When you choose this option, the act of selecting stills in the Gallery of the 
Color page shows each of the grades associated with those stills as they appear applied to 
the current clip, in a split screen arrangement.

>> Highlight Modes: Shows a four-up display that lets you simultaneously see (clockwise) 
the clip’s RGB image, the gray matte, the the high contrast matte, and a difference matte 
generated by the node’s input compared against its output.
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Viewing a key using the Split Screen > Highlight Modes
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DaVinci Resolve has a set of four video scopes that you can use to monitor the internal data levels 
of clips in your project. These include the WFM (waveform monitor), Parade (RGB parade scope), 
Vectorscope, and Histogram (RGB parade histogram). All four video scopes can be displayed either 
together, or individually, within the customizable Scopes window.

Video scopes showing an analysis of the current frame

Because you’re evaluating the internal state of the image data, the scales of the WFM and Parade 
scopes always reflect 10-bit full range data from 0-1023, regardless of your project’s Colorspace 
Conversion settings. This gives you a window into how the image is being processed by Resolve 
prior to being output via your computer’s video I/O interface.

Methods of customizing the Scopes window:

>> To change the aspect ratio of the Scopes window: Click either the 16:9 or 4:3 buttons at the 
upper left-hand corner of the window.

>> To change the size of the Scopes window: Drag the lower right-hand corner to resize the 
Scopes window to any size and aspect ratio.

>> To change how many scopes are displayed at once: Click one of the buttons in the upper 
right-hand corner of the Scopes window to set 1, 2, or 4 up arrangements of the video scopes.

>> To change which scopes appear in which pane: Click the Name pop-up at the upper left 
corner of each Scope’s pane, and choose a different scope.

>> To change whether a scope appears in color or monochrome: Click the Option pop-up 
menu at the upper right-hand corner of any Scope pane, and choose Color to toggle color 
display on and off for that scope.

Using Video Scopes
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Once open, you can resize the Scopes window to make it as large or small as you require, positioning 
on a second display if you want to make it even larger. Additionally, each video scope has different 
display options.

1.	 Click the Option pop-up menu at the upper right-hand corner of any Scope pane, and choose 
Option to open that scope’s Custom Controls window.

Adjust the waveform and graticule brightness independently

2.	 Click anywhere outside of the custom controls window to make it disappear.

These custom controls include:

>> Color/Monochrome button: Toggles color on and off for that scope. Color can make it 
easier to understand what the scopes are showing you, but if you find it a distraction it’s 
easily disabled.

>>Waveform/Parade/Vectorscope/Histogram slider: Makes that scope’s graph brighter or 
dimmer. Brighter graphs make it easier to see fine detail, but harder to see which parts of 
the graph are stronger and weaker.

>>Graticule slider: Makes that scope’s scale brighter or dimmer, making it more or less visible 
(or distracting) relative to the graph.
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>> Show Reference Levels: (Waveform, Parade, and Histogram only) You can set low and high 
reference level markers for any scope but the Vectorscope by setting the Low and High 
values to something other than their defaults.

>> Show Graticule checkbox: (Vectorscope Only) Lets you show or hide the circular degrees 
indicator surrounding the outer edge, and the cross hairs that indicate the center of the 
Vectorscope.

>> Skin Tone Indicator checkbox: (Vectorscope Only) Shows a line at the traditional Inphase 
angle that is useful as a general guidepost for average skin tone hue.

>> 2X Gain: (Vectorscope Only) zooms the vectorscope graph by 200%, making it easier to see 
fine detail, and use the Vectorscope with charts.

Note: Because they analyze every line of the image, the video scopes require a certain amount 
of video processing power to operate. Whenever you open any of the video scopes, you may 
notice your real time processing capabilities slightly diminish. Closing the video scopes frees up all 
processing for color correction and effects.
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The Timeline in the Color page is primarily used for navigating the current arrangement of clips, and 
for keeping track of clip properties such as whether they’re graded and ungraded, whether they use 
tracking, which version they’re using, and so on. 

Color page timeline

The Timeline consists of three parts:

>> Timeline Ruler: Contains the playhead, displays the record timecode of the current edit, 
and acts as a scrubber bar that spans multiple clips. The scroll wheel of your mouse lets 
you zoom in and out of your edit, and if you zoom all the way out you can fit every clip in 
the Mini-Timeline into the available width of the ruler, letting you scrub through every clip 
in the Timeline quickly. Clicking anywhere within the ruler instantly jumps the playhead to 
that frame. 

>>Mini-Timeline: Shows a miniature representation of the Timeline in the Edit page, where 
each clip’s width is proportional to its duration. The Mini-Timeline can show a maximum 
of six video tracks; if your edit uses more, a scroll bar lets you change which tracks are 
displayed. If a track has been disabled in the Edit page, it will appear grayed out in the 
Mini-Timeline. Clicking a clip in the Mini-Timeline both selects it and moves the playhead 
to its first frame. The scroll bar for the Mini-Timeline is independent of the scroll bar for the 
Thumbnail timeline, and both can be set to show different ranges of clips.

>> Thumbnail Timeline: Provides a concise visual representation of your project where each clip 
is a single thumbnail, regardless of its duration. Clicking a thumbnail moves the playhead to 
the first frame of that clip. Whichever clip is at the current position of the playhead appears 
with its thumbnail outlined in orange. Each thumbnail displays a variety of information 
above and below it, and differently colored outlines indicate clip groups, where existent.

Show Current Clip With Handles

If you’re working on a project that’s part of a round-trip workflow, and you know you’ll be rendering 
handles for each clip, it can be useful to temporarily expose these handles while you grade, so that 
you can apply tracking or keyframing effects to the full frame range of each clip.

To show or hide clip handles in the Mini-Timeline of the Color page:

>> Choose View > Show Current Clip With Handles.

Navigating Using the Color Page Timeline
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While this mode is enabled, Unmix is turned on and cannot be disabled, in order to let you view the 
overlapping handles of each clip clearly. The duration of handles that are exposed is defined by the 
Default Handles Length parameter of the Editing panel in the Project Settings. Clip Handles can be 
shown or hidden at any time.

Thumbnail Info

The thumbnails make it easy to find the clips you’re looking for visually, and they always show the 
media as it’s currently graded. The most obvious piece of information is the frame that’s used for 
each clip’s thumbnail. If you feel that a particular clip’s thumbnail isn’t representative of its content, 
you can change it.

To change the current thumbnail:

>>Move the pointer over a thumbnail, drag to the left or right to scrub through the clip, and 
stop when you find a frame you want to use as the new thumbnail.

If media is replaced in the middle of a color correction timeline, or if you copy or ripple a grade to a 
range of clips, the thumbnails may not immediately update to accurately represent the current state 
of each clip. In this case, you can manually refresh the thumbnails.

To refresh all thumbnails in the Timeline:

>> Right-click anywhere in the Thumbnail timeline and choose Update All Thumbnails.

You can also choose to display the codec used by each clip in the Timeline.

To switch the Thumbnail timeline between showing clip names and codecs:

>> Double-click the thumbnail clip name of any clip to display each clip’s codec, and vice versa.

Additional information appears above and below each thumbnail, providing a way of keeping track 
of which clips have been graded, which clips are using different versions, which clips have been 
cached, and so on.

Each clip thumbnail has a number of valuable indications permitting quick comparison to other shots.
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The following list explains each piece of information that can appear above, within, or below the 
thumbnails in the Timeline.

>> Flag icon: If a clip has been flagged, a flag icon of the appropriate color appears at the upper-
left of its thumbnail. If a clip has multiple flags, they’ll appear along the left of the thumbnail.

>> Source Timecode: The source timecode from the first frame of each clip appears on top of 
each thumbnail.

>> Linked media or group icon: If multiple clips share the same source media file, then by 
default their remote version 1 grade will be automatically linked. If the current clip is linked, 
a small link icon appears on top of every clip in the Timeline that’s also linked to that clip. 
When you select another clip that’s not linked, the linked clip icons disappear.

>> Tracker icon: If any node within a particular clip’s grade has been tracked, a small crosshairs 
tracker icon appears on top of its thumbnail.

>> Cache icon: If you’ve used the Mark Clip for Render Cache command on a clip, a small 
cache icon appears at the bottom left corner, over the thumbnail. 

>> Cache percentage: If the Clip Cache mode is set to anything other than off, a percentage 
value appears within the thumbnail of every clip in the Timeline. This shows the percentage 
of the clip that’s been cached so far. At 100%, the clip is fully cached to the scratch disk.

>> Clip number: Each clip’s number appears at the left underneath its thumbnail. Clips are 
numbered in ascending order according to the position of their first frame, from left to 
right, regardless of the video track in which they appear. 

>> Track number: The video track in which a clip is edited appears to the right of the clip number. 

>> Version name/Source format: If you create a version for a clip, the version name appears to 
the right, below its thumbnail. The version name provides information about whether a clip 
is using a remote version, or a local version, indicated by an (L). If you’ve given the current 
version a name, it appears; otherwise the version will be labeled “Version” with its number. 
Double-click the version name to toggle between displaying version names and the source 
format of that clip.

>>Grade indicator: If a clip has been graded, a thin rainbow indicator the width of its thumbnail 
appears below.

>> 3D indicator: All stereo 3D clips in the Timeline appear with this icon. Its color indicates 
which eye you’re monitoring; red indicates the left eye, while blue indicates the right eye.

By default, the Timeline displays every clip of the currently selected edit in the Edit page, sorted in 
A mode (the record order of your edit). However, the sort order and contents of the Timeline can be 
changed and filtered to make it easier for you to find specific groups of clips for grading.
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Changing Timelines

If you’re working on a project that has more then one timeline, you can switch timelines right from 
within the Color page.

To switch timelines in the Color page:

>> Choose another timeline from the Timelines pop-up menu at the top of the Viewer.

Timeline selection at the top center of the Viewer

To switch among timelines using the DaVinci control surface:

>> Press the MODES button above the fourth trackball on the Center panel, then press the 
SWITCH TIMELINE soft key. Press MODES to return to the main page of controls when 
you’re done.

A and C Mode Sorting

By default, the Timeline is set to Record mode sorting, otherwise known as A mode sorting. In this 
mode, clips appear in the Timeline according to the order in which they were edited. This lets you 
see the order of clips as they’ll appear in the final program.

A Mode sorting, i.e., record order

However, you can change the sort order of the clips in the Timeline to Source mode, or C mode 
sorting. In C mode sorting, all clips are rearranged in ascending order from left to right according 
to their source timecode, and their record timecode is temporarily ignored.

Sorting and Filtering Clips in the Timeline
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C Mode sorting, i.e., source clip order

Sorting by C mode makes it easy to identify a range of similar clips. For example, if you’re working 
on a documentary, sorting by C mode will arrange all of a particular subject’s head shots from 
a specific interview contiguously, one after another, since they all come from the same range of 
timecode on the same source tape. This makes it easy to balance them, copy grades among them, 
or group them.

When you’re finished, you can switch the Timeline back to A sort mode, and all of the clips will go 
back to being arranged in the order in which they were edited.

To toggle between A and C mode sorting, do one of the following:

>> Choose an option from the View > Timeline Thumbnail Mode Source/Record submenu.

>> Press Command-Page Down to toggle to C mode sorting.

>> Press A/C MODE on the T-bar panel of the DaVinci control surface.

While in C mode, the word “SOURCE” appears at the right in the Timeline Ruler

Source mode indicated at the right of the Timeline ruler

A checkbox in the Conform Options group of the Master Project Settings lets you change the 
behavior of C mode sorting. Opening the Settings window and clicking Master Project Settings 
reveals the Sort Timeline Using Reel Name and Timecode checkbox.
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Project settings, Master project settings

With this checkbox turned on (the default), all clips in the Timeline are sorted by reel number first, 
and then by source timecode. This way, clips with similar timecode from the same reel will appear 
next to one another in C mode.

If you turn this checkbox off, reel number is ignored, and all clips in the Timeline are sorted only by 
source timecode. This may result in clips from multiple sources being mixed together, but it is useful 
in specific situations. 

For example, when grading dailies from a three camera shoot, you may want to see consecutive 
clips from all three cameras lined up one after the other on the Timeline, so that Cam1_Shot1, 
Cam2_Shot1, and Cam3_Shot1 appear first, followed by Cam1_Shot2, Cam2_Shot2, and Cam3_
Shot2, and so on. In this situation, you don’t want clips from cameras 2 and 3 to be placed at the end 
of the Timeline simply because of their reel number.

Flags and Markers

You have the option of flagging or marking clips in the Color page just like you can in the Edit page, 
in order to keep track of specific media or frames that you may need to do something to later. For 
example, you could flag every closeup of a particular actor with a blemish that you want to spend 
some time fixing with a green flag. 

Methods of flagging and marking clips in the Color page:

>> To flag a clip: Right-click any clip’s thumbnail, and choose a flag color from the Flags 
submenu. Flags are not frame-specific, so flagging one clip will result in flags also being 
placed on all other clips that share the same source media in the Media Pool.

>> To remove all of a clip’s flags: Move the playhead to a clip, and choose Mark > Clear Current 
Timeline Flags, or right-click a clip’s thumbnail and choose the top Remove Flags option 
from the Flags submenu.

>> To mark a frame of a clip: Move the playhead to the frame of a clip you want to mark, then 
choose Mark > Add Marker (M), or right-click a clip’s thumbnail and choose a marker color 
from the Marker submenu.

>> To remove a single marker: Move the playhead to the frame with the marker you want to 
remove, and choose Mark > Clear Current Marker (Shift-Command-0).

>> To remove all of a clip’s markers: Move the playhead to a clip, and choose Mark > Clear 
Current Timeline Markers (Command-0), or right-click that clip and choose the top remove 
markers option from the Markers submenu.
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Timeline Filtering

A pop-up button at the far right of the toolbar underneath the Timeline presents options for 
dynamically filtering which clips are shown in the Timeline. This allows you hide all the other clips in 
the Timeline except for the subset on which you want to focus.

Timeline filtering options

For example, once you’ve added flags or markers to clips, it’s easy to hide every other clip in the 
Timeline that doesn’t fit the criteria; for example, hiding clips that don’t have a green flag. This does 
nothing to alter the original edit, and you can return the Timeline to its original state at any time

To filter the Timeline:

>> Click the Timeline Filtering pop-up button in the Toolbar, and choose an available option.

To return the Timeline to normal:

>> Click the Timeline Filtering pop-up button, and choose All Clips.

There are several criteria by which you can filter the Timeline:

>> All Clips: No clips are filtered, and every clip in the current edit is shown.

>>Graded Clips: Filters all clips that have been graded.

>> Ungraded clips: Filters all clips that have not yet been graded.

>> Unrendered clips: Filters all clips that have not yet been rendered.

>> Stereoscopic 3D Clips: Filters stereo 3D clips, a submenu presents options for filtering All 
Stereo Clips, or just Stereo clips that have been Autoaligned, those with Convergence 
adjustments, those with Floating Windows adjustments, or stereoscopic clips with swapped 
media for the left and right eyes.

>> Flagged Clips: Filters all clips that have a particular flag, a submenu presents each color.

>>Marked Clips: Filters all clips that have a particular mark, a submenu presents each color.

>>Modified clips: Submenu, filters all clips that have been modified within a specified time.

>> Tracked clips: Filters all clips with motion tracking.
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>>Grouped clips: Filters all clips belonging to a particular group, a submenu shows the 
available groups.

>>Different Frame Rate Clips: Filters all clips with frame rates that don’t match that of the project.

>> Clips with Noise Reduction: Filters all clips using noise reduction.

>> Clips with Input Sizing: Filters all clips that have had any Input Sizing parameters adjusted.

>> Common Media Pool Clips: Filters all clips sharing the same source in the Media Pool as 
the current clip.

>> Selected Clips: Filters all currently selected clips.

>> Clips with Matte Nodes: Filters all clips with an exposed Matte node in the Node Editor.

>> Clips with Mattes Available: Filters all clips with a matte assigned to them, whether they’re 
used or not.

>> Clips with Collaborative Update Available: Filters all clips that have been flagged as having 
been updated during a collaborative workflow.

You can use timeline filtering in conjunction with A or C mode sorting to arrange clips in whatever 
way is best for the task you’re trying to accomplish. Clip filtering can also be used in the Lightbox, 
and a currently selected clip filtering method will simultaneously isolate clips in the Timeline and 
Lightbox as you switch back and forth.
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The Lightbox shows you all clips in the Timeline as a grid of thumbnails, arranged in rows from left 
to right and top to bottom. This lets you quickly evaluate, compare, and search for clips you want to 
use when making selections, creating groups, flagging clips, or when scanning for a particular scene 
or looking for an individual clip.

The Color page Lightbox displays all the clips in the Timeline

At the right of the Lightbox is a vertically oriented Timeline Ruler letting you know the timecode 
value at the beginning of each row of clips. At the bottom right is a Zoom slider that lets you change 
the size of the thumbnails.

Selecting a clip in the Lightbox is the same as selecting a clip in the Timeline, and right-clicking a 
clip in the Lightbox shows the same contextual menu items you’d see if you right-clicked a clip in the 
Timeline. Furthermore, you can also grade the current clip in the Lightbox using a control surface, 
or by exposing the color controls to grade the current clip using a mouse or other input device.

Methods of using the Lightbox:

>> To show or hide the Lightbox: Click the Lightbox button in the toolbar, or at the bottom 
right of the Lightbox if the color controls are hidden.

>> To show color controls in the Lightbox: Click the Show Color Controls button to show 
or hide the tool palettes along the bottom of the interface, which let you adjust clips in 
the Lightbox.

>> To show thumbnail info in the Lightbox: Click the Clip Info button to turn each clip’s 
thumbnail Info off and on.

Using the Lightbox
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>> To filter the Lightbox: Use the Clip Filtering pop-up menu in the toolbar, or at the bottom 
right of the Lightbox if the color controls are hidden.

>> To resize clips in the Lightbox: Drag the Zoom slider to the right to increase thumbnail size, 
or to the left to decrease thumbnail size.

The Zoom slider, Lightbox button, Lightbox Filtering pop-up, and Thumbnail Info buttons

The Lightbox can also be output to video, in order to see its contents on a broadcast display 
or projector.

To output the contents of the Lightbox to video: 

>> Click the Output Lightbox to Video button at the upper right-hand corner of the Lightbox.

The button for outputting the Lightbox to video

For more information about clip selections, groups, and grade management, either in the Timeline 
or Lightbox, see Chapter 13, “The Gallery and Grade Management.”
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The Info palette is hidden by default. Clicking the Info palette button at the far right of the toolbar 
reveals it at the right of the Timeline. The Info palette has two tabs that display different information. 
There are no user-editable controls in the Info palette.

Info palette displaying System Status

Clip Info

The first tab displays information about whichever clip is currently selected in the Timeline.  
This information is not editable, but is provided for reference, and includes:

>> File Name: The name of the media file on disk.

>> Reel Name: The reel name of that clip, if one is being read properly.

>> Start T/C: The source timecode value of the first frame in the clip.

>> End T/C: The source timecode value of the last frame in the clip.

>> Duration: The duration of the clip, in timecode.

>> Frames: The duration of the clip, in frames.

>> Version: The name of the remote or local version used by that clip.

>> Frame Rate: The frame rate used by that clip.

>> Source Res: The native resolution of the source clip.

>> Codec: The codec or format used by the source clip.

The Info Palette and Clip Information
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System Info

The second tab displays information about operational modes currently in use by Resolve. It’s 
meant to provide the status of different Resolve features that can be enabled, disabled, or cycled 
among various options. This information includes:

>> Clips: The total number of clips in the Timeline.

>> Proxy: The status of Proxy mode (On or Off).

>> Clip Cache: The status of the Clip Cache mode (Off, All, Dissolves, User, User & D).

>> Ref Transform: The status of Reference Still reposition. 

>> Ref Mode: The status of the Reference Mode (Gallery, Timeline, Offline).

>>Wipe Style: The currently selected Wipe Style for split screens (Wipe-H, Wipe-V, 
Wipe-M, Wipe-A).

>> Convergence: The current Convergence setting (Linked Zoom, Opposite)

>> Stereo Grade: The currently displayed Eye and Gang mode (Left or Right - Gang or Solo).

>> Stereo Display: The current Stereo Display mode (Mono or Stereo).

Clip Details

You can right-click any clip thumbnail in the Timeline and choose Clip Details to show a translucent 
window with all of that clip’s information available at a glance. You can drag this window anywhere 
you like, even to another display.

The Clip Details window
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This information is not editable, but is provided for easy reference, and includes:

>> File Name: The name of the media file on disk appears at top.

>> Start Timecode: The source timecode value of the first frame in the clip.

>> End Timecode: The source timecode value of the last frame in the clip.

>> Duration: The duration of the clip, in timecode.

>> Frames: The duration of the clip, in frames.

>> Reel Name: The reel name of that clip, if one is being read properly.

>> Version: The name of the remote or local version used by that clip.

>> Format: The codec or format used by the source clip, along with the frame size and bit depth.

>> Codec: The codec used by the source clip.

>> Folder: Which directory on disk the source media resides in.

>> Description: The description field of the Metadata editor.

>>Notes: The notes field of the Metadata editor.

>> EDL Comments: EDL comments for that event, if any exist.
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The Undo and Redo commands in DaVinci Resolve work differently depending on which page is 
currently open. In the Edit page, Undo and Redo affect edits made to the Timeline (covered in more 
detail in Chapter 4). In the Color page, Undo and Redo affect color adjustment operations.

Every time you adjust a control or a parameter in the Color page, a memory of that state of the 
grade is saved to an internal list for that clip. Each clip has its own memory stack, which means that 
Undo and Redo will undo different operations depending on which clip is the current clip. Each 
clip’s undo stack is unlimited, however the memory stack of every clip in a project is cleared when 
you quit Resolve, and every time you start Resolve each clip is a clean slate.

To Undo and Redo, do one of the following:

>> Choose Edit > Undo (Command-Z).

>> Choose Edit > Redo (Shift-Command-Z)

>>On the DaVinci control surface, press the UNDO and REDO buttons on the T-bar panel.

If you have the DaVinci control surface, there is one other control that lets you control the Undo 
stack more directly when using the trackballs, rings, and pots. Pressing RESTORE POINT manually 
adds a memory of the current state of the grade to the Undo stack. Since discrete undo states are 
difficult to predict when you’re making ongoing adjustments with the trackball and ring controls, 
pressing RESTORE POINT lets you set predictable states of the grade that you can fall back on.

About Undo and Redo
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The Left Palette panel contains four palettes that relate to color and contrast adjustments in different 
ways. The controls found within these palettes provide the foundation for any grade, and this 
chapter covers how you use the Camera Raw palette, Color Wheels, Primary Controls, RGB Mixer, 
and Motion Effects palettes to manipulate your image.

Left palette selection buttons

Note: If you’re using DaVinci Resolve with a computer monitor that’s smaller than 1920x1080, then 
the Left and Center Palette panels are consolidated into a single panel, and all the palette buttons 
appear together.

Color Controls
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When a timeline uses clips that are linked to camera raw source media recorded from cameras from 
Blackmagic Design, RED, ARRI, Sony, and Vision Research, all clips in raw media formats are initially 
debayered using the settings found in the Camera Raw panel of the Project Settings.

However, if there are individual clips that you want to apply different settings to, for example altering 
the ISO to pull more detail out of the highlights or shadows, then you can use the controls found in 
the Camera Raw palette to individually alter the parameters found within.

The Camera Raw palette showing the available parameters for CinemaDNG media.

The Camera Raw palette is automatically set to the mode (seen within the Mode pop-up menu) that 
is appropriate to the clip that’s currently selected. If the current clip is not in a raw format, then the 
parameters within the Camera Raw palette are disabled.

All settings that currently populate the Camera Raw palette are also accessible from the DaVinci 
control surface.

To access camera raw settings on the DaVinci control surface:

1.	 Press the CAMERA RAW soft key on the Center panel.

2.	 Use the Center panel knobs to make camera raw parameter adjustments.

3.	 When you’re finished, press the MAIN soft key to return to the main page of controls.

This section covers general use of the Camera Raw palette. For in-depth documentation about 
specific Camera Raw parameters, see Chapter 5, “Camera Raw Settings.”

Camera Raw
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Copying, Versioning, and Protecting Camera Raw Settings

Ordinarily, a clip’s camera raw settings are copied along with its grade, or saved inside stills grabbed 
from that clip, when you use the various grade management techniques covered in Chapter 7, 
“Copying and Managing Grades.” 

DaVinci Resolve version 9 and later differ from earlier versions of Resolve in that when you create 
new versions, you now have the option to save individual camera raw settings for each version, so 
long as the Save with Version checkbox is turned on in the Camera Raw palette.

Camera Raw master settings

This means that you can have different versions with different camera raw settings, if, for example, 
you wanted to compare the results of two different camera raw adjustments on the same clip.

If you’re copying and rippling grades among multiple clips, you can also protect each clip’s camera 
raw settings from being overwritten using the “Copy Grade: Preserve Source Settings” option 
found in the contextual menu of the Gallery. For more information on the Copy Grade settings, see 
Chapter 13, “The Gallery and Grade Management.”
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Making Changes to Clip Camera Raw Settings

If you want to make individual adjustments to a particular clip’s camera raw settings, choose “Clip” 
from the Decode Using pop-up menu in the Camera Raw palette. This makes all the parameters in the 
Camera Raw palette editable, and changes you make override the project-wide camera raw settings.

Changes to the parameters in the Camera Raw palette can also be rippled across multiple 
clips at once.

To ripple camera raw adjustments across multiple clips:

1.	 Select a range of clips in the Color page timeline.

2.	 Open the Camera Raw palette, and make whatever adjustments are necessary to the current 
clip. The name of each parameter you adjust changes to amber, showing you which parameters 
have been modified, and which have not.

3.	 To ripple your changes, do one of the following:

>> Click the Apply Changes button to ripple only the altered parameters (in amber) to the 
other clips you’ve selected in the Timeline. This preserves differences between clips in the 
parameters you haven’t adjusted (in gray).

>> Click the Apply All button to ripple every parameter of the current clip to the other clips 
you’ve selected, overwriting all the camera raw settings at once.

The Apply Changes and Apply All buttons in the Camera Raw palette
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Clip Decoder Settings

There’s much more information on the various format-specific Master settings, as well as the 
occasionally format-specific Clip Decoder settings, in Chapter 5, “Camera Raw Settings.” However, 
with the exception of the RED Clip Decoder settings that appear for R3D clips, most other formats 
share a set of Resolve-specific controls that provide wide-latitude access to the raw image data for 
purposes of making different kinds of adjustments. 

Camera Raw Clip Decoder settings

These controls include:

>> Color Temp: Designed to alter the “warmth” of the image. Adjustable in degrees Kelvin. 
Lower values correct for “warmer” lighting, while higher values correct for “cool” lighting. 
+6500 is unity. The range is +2000 to +50,000.

>> Tint: Color balance correction for images with a green or magenta color cast, such as 
fluorescent or sodium vapor bulbs. 0 is unity. The range is –150 to +150.

>> Exposure: Increases or lowers image lightness in units relative to ƒ-stops. If your intended 
exposure adjustment lifts image data above the maximum white level, don’t worry; all 
image data is preserved and can be retrieved in subsequent adjustments. 0 is unity. The 
range is –4 to +4.

>> Sharpness: A debayer-specific sharpness filter applied to provide the appearance of 
enhanced image detail. 20 is unity. The range is 0 to 100.

>> Highlights: Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-
range media by lowering this parameter, and achieves a smooth blend between the 
retrieved highlights and the unadjusted mid tones for a naturalistic result. 0 is unity. The 
range is –100 through +100.
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>> Shadows: Lets you selectively lighten or darken shadow detail. Raising this value retrieves 
shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The 
range is –100 through +100.

>> Color Boost: Lets you naturalistically raise the saturation of regions of low saturation, 
sometimes referred to as a vibrance operation. Can be used also to lower the saturation of 
regions of low saturation. 0 is unity. The range is –100  through +100.

>> Saturation: Adjusts the color intensity of the image. 0 is unity. The range is –100 through +100.

>>Midtone Detail: When this parameter is raised, the contrast of regions of the image with 
high edge detail is raised to increase the perception of image sharpness, sometimes 
referred to as definition. When this parameter is lowered to a negative value, regions of the 
image with low amounts of detail are softened while areas of high-detail are left alone. 0 is 
unity. The range is –100 through +100.

Resetting Camera Raw Settings

If you’ve made changes to the parameters of the Camera Raw palette and you decide you need to 
reset them, there are two options, found in the Options menu.

>> Reset: Resets all parameters in the Camera Raw palette to their default settings.

>> Revert: Similar to the “Original Memory” command, Revert changes all camera raw 
parameters back to the state they were at when you first selected the current clip. You 
should see some nice pixel detail reappear in formerly “flat” areas of the image, although 
the color channel you’re correcting may become exaggerated as a result.

If necessary, you might need to alter the color balance of the highlights or shadows 
(whichever was clipped) to achieve a more realistic coloration within the patched region. 
The result can be better seen by comparing the RGB Parade scopes before and after 
this adjustment.

When you’re done, you should see a bit more pixel detail in the formerly clipped regions of 
the image, with more pleasing color rendition.
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Color Match Palette

The Color Match palette lets you sample one of three types of standardized color charts, the X-Rite 
ColorChecker, the Datacolor SpyderCheckr, and the DSC Labs SMPTE OneShot charts.

The result is analyzed to generate an automatic color correction to use to create a neutral grade for 
the image, to use as a starting point for the rest of your grade.

The X-Rite ColorChecker, Datacolor SpyderCheckr, and DSC Labs SMPTE OneShot charts compared,  

of which are supported by the Color Match palette

The Color Match palette
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To sample a color chart to make an automatic correction:

1. 	 Select the clip with a chart you want to sample. If necessary, you can use the View > Show 
Current Clip With Handles option to show additional frames at the beginning of the current 
clip to reveal a color chart in the leader of your media. 

2. 	 If necessary, choose an option from the Source Gamma pop-up menu that corresponds to the 
gamma with which the media was recorded. 

3. 	 Then, choose a target gamma and color space that corresponds to the format you want this 
clip to be matched to. 

4. 	 Click the Viewer tool pop-up, choose the Color Chart overlay, and use its corner-pinning 
controls to line the sampling boxes up with the color patches of the chart. 

5. 	 When you’re finished, click the Match button, and the clip will be automatically corrected.

Aligning the Color Match target with the chart in the video

A clip before and after automatic color matching
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Configuration Controls

Here’s a more detailed explanation of each of the parameters found in the Color Match palette.

>> Source Gamma: Defines the source gamma the media was recorded with. You must select 
the correct gamma or the results will not be as accurate.

>> Target Gamma: Lets you select a target gamma that you want the corrected clip to use. 
While this will most likely be the gamma you’re outputting the finished program at, you can 
choose other target gamma values for specialized workflows.

>> Target Color Space: The color space you’ll be outputting the finished program with.

>> Target Color Temp: An adjustable color temperature control that lets you manually adjust 
the target color balance of the resulting correction to be warmer (lower values) or cooler 
(higher values).

>> Target White Level: A checkbox that’s disabled by default, which lets you manually choose 
the target white point that the automatic correction should use. Raising or lowering this 
value will stretch or compress the contrast of the final correction. 

>>Match button: Once you’ve chosen the appropriate settings, and aligned the color match 
target with the chart that was recorded, click to execute the match. The default is 6500K.

>> Chart type pop-up menu: You can choose from among the supported chart types in this 
pop-up. At the time of this writing, these include the X-Rite ColorChecker, the DataColor 
SpyderChecker, the DSC Labs SMPTE OneShot, and the DSC Labs ChromaDuMonde 24+4.

>> Source: A checkbox that lets you turn on a split-color comparison of each color in the target 
chart, with the calculated match of that color as performed by the Color Match algorithm. 
Each color patch’s percentage of deviation is listed below.

Reset Controls

The Color Match option menu has a variety of commands you can use to reset your work in the 
Color Match palette.

>> Reset Match Configuration: Resets the Configuration parameters described above.

>> Reset Match: Resets the matching operation without resetting the Configuration controls.

>> Reset Adjustments: Resets the Adjustments parameters described below.

>> Reset All: Resets all controls and adjustments in this palette.
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Adjustments Controls

The adjustments section of the Color Match palette has the same highlight and shadow recovery, 
Color Boost, and Midtone Detail controls that are found on the Camera Raw palette, but these can 
be used for any media format you like. You won’t have the kind of wide latitude that you do when 
using these controls with raw clips, but you can still accomplish quite a lot.

>> Highlights: Makes it easy to selectively retrieve blown-out highlight detail in high-dynamic-
range media by lowering this parameter, and achieves a smooth blend between the 
retrieved highlights and the unadjusted mid tones for a naturalistic result. 0 is unity. The 
range is –100 through +100.

>> Shadows: Lets you selectively lighten or darken shadow detail. Raising this value retrieves 
shadow detail recorded below 0 percent, while leaving the midtones alone. 0 is unity. The 
range is –100 through +100.

>> Color Boost: Lets you naturalistically raise the saturation of regions of low saturation, 
sometimes referred to as a vibrance operation. Can be used also to lower the saturation of 
regions of low saturation. 0 is unity. The range is –100 through +100.

>>Midtone Detail: When this parameter is raised, the contrast of regions of the image with 
high edge detail is raised to increase the perception of image sharpness, sometimes 
referred to as definition. When this parameter is lowered to a negative value, regions of the 
image with low amounts of detail are softened while areas of high-detail are left alone. 0 is 
unity. The range is –100 through +100.
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If you’ve had any exposure to color correction tools in any application, the controls found within the 
Color Wheels palette should look familiar. These controls correspond to the most basic color correction 
functionality available in DaVinci Resolve, and are designed to let users without control surfaces have 
easy access to color balance and YRGB contrast manipulation using a mouse, tablet, or trackpad.

Color Wheels for primary grading, in Primaries mode

The Color Wheels palette has two distinct modes of operation. Primaries mode contains the 
traditional DaVinci Lift/Gamma/Gain controls that allow tonally specific yet widely overlapping 
regions of adjustment. Log mode, on the other hand, contains Shadow/Midtone/Highlight/Offset 
controls that offer more restrictive yet customizable regions of adjustment.

How to Use Color Balance Controls and Master Wheels

Each of the modes in the Color Wheels palette use the same controls, albeit in different ways. This 
section explains, in a generic way, how to use these controls to make adjustments.

Color Balance controls provide a way to adjust all three color channels simultaneously with a single 
move of the pointer, according to the mode that’s currently selected. These controls correspond 
to the trackballs found on the DaVinci control surface, but there are a variety of keyboard modifiers 
that let you make specific adjustments via the GUI.

To make adjustments using the color balance controls:

>> Click and drag anywhere within the color ring: Moves the Color Balance indicator relative to 
its previous position, and rebalances the three color channels in whatever range of image 
tonality is governed by that control. You don’t need to drag the Color Balance indicator itself. 
This simulates the kind of relative control you get when using a trackball to manipulate these 
parameters. As the Color Balance indicator moves, the RGB parameters underneath change 
independently to reflect the independent adjustments being made to each channel.

Color Wheels Palette
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>> Shift-Click and drag within the color ring: Jumps the Color Balance indicator to the absolute 
position of the pointer, letting you make faster, more extreme adjustments to the color 
balance governed by that control.

>> Double-click within the color ring: Resets the color adjustment without resetting the 
corresponding contrast adjustment for that control.

>> Command-click and drag within the color ring: Adjusts YRGB contrast identically as if you 
were dragging that control’s master ring.

>> Click the reset control at the upper-right of a color ring: Resets both the Color Balance 
control and its corresponding master ring.

The Master Wheels, located below the Color Balance controls, let you adjust the YRGB channels 
together to adjust Lift, Gamma, and Gain by individually adjusting the black point, the white point, 
and distribution of midtones that fall in-between. This has the practical effect of letting you adjust 
image contrast when you manipulate any two of these wheels together.

Lift, Gamma and Gain master wheels to balance the grades

The Master Wheels correspond to the rings surrounding the trackballs on the DaVinci control 
surface, which let you modify image contrast via YRGB adjustment (as opposed to modifying image 
contrast via Y-only adjustment, covered later in this chapter).

To adjust a Master Wheel:

>> Drag it to the left or right: Dragging it to the left makes that area of the image darker, and 
to the right makes that area of the image lighter. The effect will vary according to the mode 
you’re in. As you make an adjustment, the YRGB parameters located underneath all change 
together to reflect the simultaneous adjustment you’re making to all channels.
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Understanding the Primaries Mode Controls

The Color Wheel palette’s Primaries mode lets you rebalance color and adjust contrast via the 
traditional DaVinci controls, which govern three overlapping tonal ranges referred to as Lift, 
Gamma, and Gain. The Lift/Gamma/Gain color balance and Master Wheel controls are tied to 
the YRGB Lift/Gamma/Gain sliders found in the Primaries palette; adjustments made to one set 
of controls are mirrored in the other.

Though they may look different, the sliders and Color Balance wheels actually adjust the same components, but in different ways.

These tonal ranges are defined by image lightness, on a scale where 0 is absolute black and 1023 
is absolute white. The following illustration shows an approximation of how the Lift, Gamma, and 
Gain tonal zones broadly overlap, and how each zone’s influence falls off towards the opposing 
extremes of image tonality.

Graphic displays the relationship of the Lift, Gamma and Gain controls over the image brightness range that they control

The Lift color balance control region of influence starts at black, and then falls off through the 
middle grays to diminish to no influence at white. Meanwhile, the Gamma color balance control has 
its greatest influence over the image in the middle grays, and its influence diminishes towards black 
and white. Lastly, the Gain control is the inverse of Lift, having its greatest effect on the image at 
white, with its influence falling off to diminish at black.

Because these tonal ranges overlap so broadly, you can make very soft, subtle, naturalistic 
adjustments using these controls. Furthermore, you can capitalize on their overlap by moving an 
adjacent color balance control toward a color that’s complementary to an adjustment you’ve just 
made to restrict further how much of the image is affected.

The following image shows the interaction of extreme corrections made to a grayscale image using 
all three Color Balance controls. Lift has been pushed toward green, Gamma has been pushed 
toward blue, and Gain has been pushed toward red.

Lift Gamma Gain
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Extreme adjustments showing the overlap of the Lift, Gamma, and Gain color balance controls 

Source footage courtesy of Gianluca Bertone DP, www.bertonevisuals.com

Notice how, even though these corrections are extreme, the colors blend smoothly. This is the reason 
for the broad overlap among all three controls, and why Lift, Gamma, and Gain are so effective in 
making corrections to the ambient color temperature of a scene to account for inconsistencies in 
lighting or camera settings.

3 Way Master Wheel Adjustments

The Master Wheels located below the Color Balance controls let you precisely modify image contrast 
by YRGB adjustments, which individually alter the black point, the white point, and distribution of 
midtones that fall in-between. 

These controls correspond to the rings surrounding the trackballs on the DaVinci control surface.

>> Lift: Lets you adjust the perceived shadow density of the image by altering the black point 
of the image. Dragging the Lift master wheel to the left makes the darkest values in the 
image darker, increasing the distance between the black and white points of the image, 
and stretching all the midtone values in-between. Dragging the Lift master wheel to the 
right makes the darkest values in the image lighter, reducing contrast and squeezing all the 
midtone values between the black and white points.

>>Gamma: Lets you adjust the overall perceived lightness of the image by altering the 
distribution of midtones that fall between the Lift and Gain master wheel settings. Dragging 
the Gamma master wheel to the left darkens the overall image, while dragging it to the 
right brightens it. Most Gamma contrast adjustments have a minimal effect on the black 
and white point of the image, but large adjustments may push either boundary of image 
lightness farther out. This interaction is described in more detail below.
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>>Gain: Lets you adjust the lightness of the highlights by altering the white point of the image. 
Dragging the Gain master wheel to the left makes the lightest values of the image darker, 
squeezing the midtones between the white and black points of the image. Dragging Gain 
to the right makes the lightest values even lighter, eventually clipping at maximum white.

White Point

Midtones

Black Point

Waveform display shows the clips contrast range

These contrast adjustments are not limited by one another. For example, raising or lowering the 
Gamma master wheel by a large amount may push the highlights of the image higher or the shadows 
of the image lower, regardless of the current Lift or Gain contrast setting. 

As a result, these controls are somewhat interactive, and you may find yourself going back and forth 
between controls as you make your final contrast adjustments. This is one of the reasons a control 
surface is valuable, as it allows you to adjust all three settings simultaneously.

Offset Color and Master Controls

The fourth set of Color Balance and Master Wheel controls is actually shared with the Log controls 
and with the Offset sliders in the Primaries palette. These are the Offset controls, which let you 
make linear adjustments to rebalance the entire tonal range of the RGB channels.

>> The Offset color balance control: Works as a simultaneous adjustment to all three Offset 
sliders located in the Primaries palette; adjustments made to the Offset color balance 
control also alter the Offset sliders. Used subtly, this makes it easy to neutralize color 
imbalances in the darkest part of the image, while simultaneously rebalancing every other 
part of the image. Used more dramatically, this control makes it easy to add a color wash 
throughout the entire image.

>> The Offset master wheel: Acts as a global adjustment to image lightness, an operation 
sometimes referred to as setup, raising or lowering all YRGB channels together.

When using a DaVinci control surface, the Offset color balance control is adjusted in either Lift/
Gamma/Gain or Log modes via the fourth trackball, while the Offset wheel is adjusted via the ring 
surrounding the fourth trackball.
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Contrast and Pivot

The Primaries mode of the Color Wheels palette also shares a pair of controls for adjusting image 
contrast with the Log controls. The Contrast parameters let you quickly narrow or widen image 
contrast about a user-definable pivot point. Regardless of which Color Wheels mode you’re in, 
these parameters are identical.

>> Contrast: This one parameter lets you increase or reduce the distance between the darkest 
and lightest values of an image, raising or lowering image contrast. The effect is similar 
to using the Lift and Gain master controls to make simultaneous opposing adjustments. 
Bright and dark parts of the image are pushed apart or brought together about a center 
point defined by the Pivot parameter.

>> Pivot: Changes the center of tonality about which dark and bright parts of the image are 
stretched or narrowed during a contrast adjustment. Darker images may require a lower 
Pivot value to avoid crushing the shadows too much when stretching image contrast, while 
lighter images may benefit from a higher Pivot value to increase shadow density adequately.

Contrast and pivot can also be adjusted using the DaVinci control surface via the CONTRAST and 
PIVOT knobs on the Center panel’s default page, regardless of whether you’re in Lift/Gamma/Gain 
or Log mode.

Saturation, Hue, and Lum Mix in the 3-Way Color Controls

The Saturation, Hue, and Lum Mix parameters mirror the three knobs found at the right of the 
Center panel of the DaVinci control surface. These are mirrored by the same parameters in the Log 
mode of the Color Wheels palette.

>> Saturation: Increases or decreases overall image saturation. At higher values, colors appear 
more intense, while at lower values, color intensity diminishes until, at 0, all color is gone, 
leaving you with a grayscale image.

>> Hue: Rotates all hues of the image around the full perimeter of the color wheel. The default 
setting of 50 shows the original distribution of hues. Raising or lowering this value rotates all 
hues forward or backward along the hue distribution as seen on a color wheel.

>> Lum Mix: Lets you control the balance between YRGB contrast adjustments you’ve made 
using the Master Wheels or ganged Custom curves, and Y-only adjustments to contrast 
made using the Y channel Lift/Gamma/Gain controls of the Primaries palette or the 
unganged Luma curve. At the default of 100, YRGB and Y-only adjustments to contrast 
contribute equally. Reducing this value diminishes the effect of Y-only contrast adjustments 
until, at 0, Y-only contrast adjustments are turned off.

>> Additionally, you’ll notice that at a Lum Mix setting of 100, individual adjustments to R, G, or 
B using the RGB sliders or unganged Custom curves result in automatic adjustments being 
made to the other two color channels in order to maintain constant Luma levels. At a Lum Mix 
setting of 0, individual color channel adjustments have no effect on the other color channels.
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Like most parameters in Resolve, clicking and dragging a parameter’s name or value to the left or 
right lowers and raises that parameter with a virtual slider, while double-clicking that parameter’s 
number lets you edit it numerically, and double-clicking that parameter’s name resets the parameter 
to its default position.

Auto Correction in the Primaries Mode Controls

The Auto Color button provides a quick way to automatically balance the blacks and whites of a clip 
based on the current frame at the position of the playhead. Resolve looks for the darkest levels in 
the image to neutralize the RGB color balance in the blacks, and the brightest levels to neutralize 
the RGB color balance in the highlights. Furthermore, Master Lift and Master Gain are adjusted to 
maximize image contrast at the outer boundaries of 0 and 100 percent. Using this control with the 
Primaries mode palette open causes these automatic adjustments to be made using the color and 
contrast controls, so you can see what’s changed.

The Log Mode of the Color Wheels Palette

The Shadow/Midtone/Highlight color balance and Master Wheel controls operate independently 
of the Lift/Gamma/Gain color balance and Master Wheel controls found in the Primaries mode. 
While the Log mode uses the same types of controls as the Primaries mode, the way each control 
affects the image is very different.

To switch between the Primaries and Log modes of the Color Wheels:

>> Choose an option from the mode pop-up, click the right mode button, or press Option-Z.

Log color wheels, with behavior that is very different from the Primaries mode color wheels
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There are two ways of using the Log mode controls. The first takes advantage of the way these 
controls work to make fast, filmic adjustments to log-encoded media while it’s normalized by LUTs 
or manual adjustments added after it in the image processing pipeline.

The other way of using the Log controls is to take advantage of the more restrictive, but adjustable 
tonal range of the Shadow/Midtone/Highlight controls to stylize normalized clips by tinting specific 
regions of the image.

Using the Log Mode Controls to Grade Log-Encoded Media

The Log controls are so named because they’re designed to work specifically with media with Log-C 
or similar gamma and color encoding, derived from the Cineon Log gamma curve, developed by 
Kodak to digitally store flat-contrast, wide-gamut image data that preserves image detail with a 
wide latitude for adjustment.

       

An example of a log-encoded clip (left), and the same clip after being normalized (right)

As discussed in the “Camera Raw Encoding” section of Chapter 3, you can debayer most raw formats 
to a log-encoded image in order to derive the maximum amount of image data and adjustable 
latitude from that source. However, the resulting image needs to be normalized to occupy the final 
range of color and contrast that you intend for the final result. You can do this one of two ways:

>> You can make a very careful curves adjustment in a second node to stretch the log-encoded 
out to fit the contrast profile you want. By making this adjustment in Node 2, you make 
room for a customizing adjustment made using the Log controls in Node 1, prior to the 
normalization adjustment. This is key.

>> You can also apply a 1D Output or 3D LUT to the first node of a clip to normalize the image. 
This is a faster, if less flexible operation, but a smooth tonal range may be easier to obtain. 
Since a LUT applied within a node is always the last adjustment within that node’s order of 
operations, you can also use Node 1’s Log controls to customize the look of the footage.

In either case, it’s important that the normalizing adjustment happens after your Log control 
adjustments, for the Log control adjustments to work as they should. With your node tree set up 
in this way, you’ll be monitoring an ordinary-looking image, but taking advantage of the Log mode 
controls’ unique tonal ranges to manipulate the log-encoded image data with great specificity. 
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When using the Log mode controls, here’s a workflow to consider as you learn how they work:

>> First, use the Offset master wheel to set the black point, and use the Contrast and Pivot 
parameters to stretch or compress contrast as necessary to achieve the tonal range 
you require.

>> Second, use the Offset color balance control to adjust the overall color balance of the 
image to your liking.

>> Third, use the Shadow/Midtone/Highlight color balance and Master Wheel controls to 
make specific, targeted adjustments to the color and contrast of the image in tonal ranges 
that match where that data is in the log-encoded image.

Working in this way, you’ll find that adjustments made with the Offset color balance and Master 
Wheel controls and Contrast controls control the log-encoded image very nicely to create an overall 
adjustment, while the Shadow, Midtone, and Highlight controls allow you to fix specific issues, such 
as shadow balance and density, after your main adjustment has been set.

The following illustration shows an approximation of how the default ranges of the Shadow, Midtone, 
and Highlight controls divide the tonal range of a log-encoded image. 

This graphic shows the tonal range of each of the Log controls when used with a log-encoded image

As you can see, when used with a log-encoded image the color interactions between each 
adjustment overlap very softly, while still allowing more specific adjustments than those made by 
the Lift/Gamma/Gain controls.

Furthermore, the boundaries of the Shadows, Midtones, and Highlights Log controls can be 
customized using the Low and High Range parameters. This gives you added flexibility to apply 
more specific contrast and color adjustments.
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Once you’ve made an adjustment using Log mode controls along with a normalizing LUT or curve 
adjustment, you can always apply additional nodes and use the Primaries mode of the Color Wheels 
palette to make further alterations to the now normalized image, working as you normally would 
with any of the other tools in Resolve.

Using the Log Mode Controls to Stylize Normalized Media

You can also use the Log mode controls on normalized images. Although the results you get 
will be somewhat different, this can be a fast way to create interesting stylizations. Whereas the 
broadly overlapping tonal ranges of the Lift, Gamma, and Gain color balance controls allow subtle 
adjustments to be made very easily, the Log palette’s color balance controls affect much more 
restrictive tonal zones that overlap much less when used on normalized images.

The following illustration shows an approximation of how the Shadows, Midtones, and Highlights, 
by default, divide the tonal range of the image into non-overlapping thirds. As you saw in the 
previous section, these divisions were originally intended to map to log-encoded media. However, 
with normalized media these divisions provide a different, and potentially useful, set of ranges from 
the Primaries mode controls. 

Shadows Midtones Highlights

High RangeLow Range

This graphic shows the tonal range of each of the Log controls with the additional low and high range to expand or contract the range

With normalized media, the Shadows really do only affect the darkest shadows, falling off at 
approximately the bottom third of image tonality. The Midtones affect only the middle third of 
grays, and the Highlights affect the brightest top third of image values. However, these default 
ranges of image tonality can be adjusted using the Low Range and High Range controls, which are 
described in more detail later.

The following image shows the default interaction of extreme corrections made to a grayscale 
image using the Log mode controls. The Shadows have been pushed toward green, the Midtones 
have been pushed toward blue, and the Highlights have been pushed toward red.
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Extreme adjustments showing the overlap of the Shadow, Midtone, and Highlight color balance controls

As you can see, with normalized media the color interaction between each adjustment is very subtle. 
The darkest shadows end up bright green, the midtone values are vivid blue, and the highlights are 
almost pure red. This restrictiveness is useful when you want to limit a correction to a specific tonal 
range within the image without needing to use a Luma qualifier. It’s also quite useful for making 
bold, stylistic color adjustments when creating a non-naturalistic look.

Adjusting Tone Ranges In Log Mode

Two parameters let you modify the range of Shadows and Highlights that each Color Balance 
control affects, in turn narrowing and widening the range of Midtones. Keep in mind that while the 
ranges can be customized, the amount of overlap between each range cannot.

>> Low Range: Moves the border where the Shadows and Midtones meet. Lowering this 
parameter widens the range affected by the Midtones, and narrows the range affected by 
the Shadows. Raising this parameter narrows the Midtones and widens the Shadows.

>> High Range: Moves the border where the Midtones and Highlights meet. Lowering the 
High Range parameter narrows the range affected by the Midtones, and widens the 
range affected by the Highlights. Raising this parameter narrows the Highlights and 
widens the Midtones.

There are also Saturation and Hue parameters which mimic these settings found within other 
palettes and modes.
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Adjusting Contrast in Log Mode

When using the Log mode controls, your primary tools for adjusting image contrast will usually be 
the Offset master wheel and Contrast and Pivot parameters. Using these three controls, you can set 
a black point and adjust the overall contrast very quickly.

The Shadow, Midtone, and Highlight master wheels let you adjust image lightness within the 
same restrictive ranges of image tonality that are defined by the Low Range, High Range, and 
Pivot parameters. These adjustments should appear smooth, if somewhat narrower then the Lift/
Gamma/Gain controls, when used with log-encoded media. However, when used with normalized 
images, severe adjustments made with one master wheel may not always make a smooth transition 
to the next adjacent range of image lightness.

Note: Because these controls are so restrictive when used with normalized images, it’s easy to 
create solarization effects by raising the shadows to be higher than the Midtones, or lowering the 
Highlights to fall below the Midtones, to give two examples.

Log Offset Color and Master Controls

The Log controls also share the same Offset color balance and Master Wheel controls that appear 
in the Lift/Gamma/Gain mode of the Color Wheels palette (which are tied to the Offset controls of 
the Primaries palette). 

>> The Offset color balance control: Works as a simultaneous adjustment to all three Offset 
sliders located in the Primaries palette; adjustments made to the Offset color balance 
control also alter the Offset sliders. Used subtly, this makes it easy to neutralize color 
imbalances in the darkest part of the image, while simultaneously rebalancing every other 
part of the image. Used more dramatically, this control makes it easy to add a color wash 
throughout the entire image.

>> The Offset wheel: Acts as a global adjustment to image lightness, an operation sometimes 
referred to as setup, raising or lowering all YRGB channels together.

When using a DaVinci control surface, the Offset color balance control is adjusted in either Lift/
Gamma/Gain or Log modes via the fourth trackball, while the Offset wheel is adjusted via the ring 
surrounding the fourth trackball.

Switching to Log Mode Using the DaVinci Control Surface

You can switch to the Log grading mode of the currently selected node by pressing the LOG soft 
key on the Center panel of the DaVinci control surface. Press the MAIN soft key to return to the 
more traditional Lift/Gamma/Gain mode of adjustment.
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The Primaries palette occupies the Left Palette panel by default when you first open the Color 
page, and contains the original set of DaVinci Resolve color adjustment sliders. These sliders serve 
two uses. First, they’re highly visible indicators of the individual YRGB channel adjustments that are 
made using the trackballs, rings, and knobs of a control surface. Second, they provide control of 
individual YRGB Lift/Gamma/Gain parameters using a mouse, tablet, or trackpad.

Primary grading controls

RGB Lift/Gamma/Gain Sliders

The most prominent controls of the Primaries palette are the individual Luma (or Y), Red, Green, 
and Blue sliders, four each for Lift, Gamma, and Gain. These sliders correspond to a set of knobs on 
the POTS page of the DaVinci control surface, and provide precise Lift/Gamma/Gain style control 
over each of the YRGB channels of the image. When used in conjunction with a Parade Scope video 
analysis of the image, these controls can enable you to fix irregular color imbalances in specific 
channels quickly.

Additionally, the Luma (Y) Lift/Gamma/Gain sliders correspond to the three knobs arranged 
vertically to the left of the Center panel of the DaVinci control surface. These three controls allow 
easy Y-only adjustments to contrast, where an increase in contrast results in perceptually diminished 
color saturation. 

Making Y-only adjustments to contrast is a great way to increase contrast when you’re going for 
muted saturation or a gritty look. This kind of adjustment is also useful in situations where you’re 
trying to increase shadow density without increasing image colorfulness.

Four Master Wheel controls appear underneath each group of Lift/Gamma/Gain sliders. The first 
three of these controls are identical to the Lift/Gamma/Gain master wheels in the Primaries mode 
of the Color Wheel palette, and control YRGB contrast, while the fourth is identical to the Offset 
master wheel found in the Log mode of the Color Wheel palette.

Primaries Palette
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Finally, each group of Lift/Gamma/Gain sliders has its own reset button. To reset individual channels, 
double-click the single-letter label underneath that slider.

To adjust RGB Lift/Gamma/Gain using the DaVinci control surface:

1.	 Press the POTS soft key on the main page of the Center panel.

2.	 Use the variously identified LUM/RED/GREEN/BLUE and OFFSET/BLACK/GAMMA/GAIN 
knobs to make the required adjustments.

3.	 Press the MAIN soft key to return to the Center panel’s main page.

Offset Sliders and Wheel

These vertical sliders mirror the settings of the Offset color balance controls in the Color Wheel 
palette, except that they provide individual control over the Red, Green, and Blue color channels. 
When you drag one of the Offset sliders up or down, you raise or lower that color channel in its 
entirety, which can be useful for adjusting color channels that are particularly problematic.

Offset RGB and master controls

Each Offset slider also has a pair of arrow buttons, one at the top and one at the bottom. These 
buttons provide “Printer Point” adjustment of these values, which let you adjust each Offset channel 
in discrete increments. Printer Points can be useful for projects that have tight integration with a film 
lab, and are designed to emulate color adjustments made using optical printers.

The Offset wheel control underneath the Offset sliders lets you adjust all three sliders at once, 
performing a setup adjustment. The Offset sliders, Printer Point buttons, and Offset wheel can be 
adjusted using the DaVinci control surface.
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To adjust the Offset sliders individually using the DaVinci control surface:

>> Use the MASTER OFFSET, RED OFFSET, GREEN OFFSET, and BLUE OFFSET knobs on the 
main page of the Center panel.

To adjust Offset Printer Points using the DaVinci control surface:

1.	 Press the PRINTER LITES soft key on the main page of the Center panel to display the Printer 
Points controls page on the Transport panel.

2.	 Use the + and – MASTER, RED, GREEN, and BLUE buttons that appear on the Transport panel.

3.	 Press PRINTER LITES again to return the Transport panel controls to their previous state.

There’s also a special set of keyboard shortcuts, mapped to the numeric keypad of an extended 
keyboard, that lets you make Printer Point adjustments in discrete increments, adding or subtracting 
a point at a time.

To use the Printer Lights Hotkeys:

>> Choose Color > Printer Lights Hotkeys, or press Option-Command-Grave Accent (`)

When you enable Printer Lights Hotkeys, there are two sets of shortcuts you can use to manipulate 
printer points. If you want to directly manipulate RGB, there’s one set for that, which makes sense 
when used on a numeric keypad.

However, if you want to work in the classic way by manipulating cyan, magenta, and yellow, there’s 
another set of shortcuts for that, using the remaining keys on the numeric keypad.

Note: The increments used by the Printer Point buttons are defined by the Printer Light Step 
Calibration parameters, found in the General Options of the Setup window. For more information, 
see Chapter 3, “Project Settings, Caching, and Preferences.”

Red Green Blue

7 +Red 8 +Green 9 +Blue

4 – Red 5 – Green 6 –Blue

Red Green Blue

1 +Cyan 2 +Magenta 3 +Yellow

Minus (–) –Cyan 0 –Magenta Period (.) –Yellow
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Saturation, Hue, and Lum Mix in the Primaries palette

The Saturation, Hue, and Lum Mix parameters mirror the three knobs found at the right of the 
Center panel of the DaVinci control surface, and are mirrored by the same parameters found in the 
Color Wheel palette.

>> Contrast: This one parameter lets you increase or reduce the distance between the darkest 
and lightest values of an image, raising or lowering image contrast. The effect is similar 
to using the Lift and Gain master controls to make simultaneous opposing adjustments. 
Bright and dark parts of the image are pushed apart or brought together about a center 
point defined by the Pivot parameter.

>> Pivot: Changes the center of tonality about which dark and bright parts of the image are 
stretched or narrowed during a contrast adjustment. Darker images may require a lower 
Pivot value to avoid crushing the shadows too much when stretching image contrast, while 
lighter images may benefit from a higher Pivot value to increase shadow density adequately.

>> Saturation: Increases or decreases overall image saturation. At higher values, colors appear 
more intense, while at lower values, color intensity diminishes until, at 0, all color is gone, 
leaving you with a grayscale image.

>> Hue: Rotates all hues of the image around the full perimeter of the color wheel. The default 
setting of 50 shows the original distribution of hues. Raising or lowering this value rotates all 
hues forward or backward along the hue distribution as seen on a color wheel.

>> Lum Mix: Lets you control the balance between YRGB contrast adjustments you’ve made 
using the Master Wheels or ganged Custom curves, and Y-only contrast adjustments made 
using the Y-channel Lift/Gamma/Gain controls of the Primaries palette or the unganged 
Luma curve. At the default of 100, YRGB and Y-only contrast adjustments contribute 
equally. Reducing this value diminishes the effect of Y-only contrast adjustments until, at 0, 
Y-only contrast adjustments are turned off.

Additionally, you’ll notice that at a Lum Mix setting of 100, individual adjustments to R, G, 
or B using the RGB sliders or unganged Custom curves result in automatic adjustments 
being made to the other two color channels in order to maintain constant Luma levels. At 
a Lum Mix setting of 0, individual color channel adjustments have no effect on the other 
color channels.

Like most parameters in Resolve, clicking and dragging a parameter’s name or value to the left or 
right lowers and raises that parameter with a virtual slider, while double-clicking that parameter’s 
number lets you edit it numerically, and double-clicking that parameter’s name resets the parameter 
to its default position.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

536

COLOR PAGE BASICS11

The RGB Mixer palette lets you remix different amounts of image data from one channel to another, 
and has a wide variety of creative and utilitarian uses. Furthermore, the RGB Mixer can be used 
either to remix the color channels, or to add different proportions of each color channel into a 
monochrome image.

RGB mixer palette

By default, the RGB Mixer palette is set to mix any amount of the Red, Green, and Blue color 
channels into any of the other channels. Each color channel has a dedicated control group of Red, 
Green, and Blue sliders that you use to do the mixing, and the default values of these can be seen 
in the screenshot above.

Each slider has an overall range of -2.00 to +2.00. This means that you also have the option of 
subtracting any combination of color channel values from a particular channel. For example, you 
can lower the Red control group’s Green slider to -.24 to subtract 24 percent of the Green channel 
from the Red channel.

RGB Mixer Palette
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Preserve Luminance

With “Preserve Luminance” turned on in the Options menu at the upper right of the Palette panel, 
any channel adjustment you make is prevented from altering the luma of the image by automatically 
raising or lowering the other two channels to compensate. In the following example, you can see 
that when “Preserve Luminance” is turned on, lowering the Green control group’s Green slider 
results in the Red and Blue channels being raised by the same amount (as seen in the Parade scope). 
Conversely, raising a color channel’s slider ends up lowering the other two channels by the same 
amount to keep overall image luminosity the same.

The result of an RGB Mixer adjustment with “With luminance level preserved” turned on.  

You can see that lowering the green channel slider also raises red and blue.

Resetting the RGB Mixer

Choosing Reset from the RGB Mixer’s Option menu resets each slider to its default position, where 
Red = 1.00 for Red output, Green = 1.00 for Green output, Blue = 1.00 for Blue output, and all other 
sliders = 0.

Swap Channels Buttons

A set of three buttons at the bottom of the RGB Mixer lets you easily swap two channels with one 
another. This can be useful as part of a creative look, or corrective in instances where two channels 
are accidentally reversed.

>> Swap Red and Green: Swaps these two color channels.

>> Swap Green and Blue: Swaps these two color channels.

>> Swap Red and Blue: Swaps these two color channels.
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Using the RGB Mixer in Monochrome Mode

When you enable Monochrome in the RGB Mixer palette’s Options menu, two of the sliders within 
each Output group are disabled. This leaves the Red > Red slider, the Green > Green slider, and the 
Blue > Blue slider as the only available controls.

Sliders at their default values when “To monochrome” is enabled

Keeping in mind that each of the color channels that makes up an image is itself a grayscale channel, 
the RGB sliders in Monochrome mode let you add different proportions of the Red, Green, and 
Blue color channels together to create custom grayscale versions of a shot.

To understand why this is useful, let’s consider the default values of the Red, Green, and Blue sliders. 
To emulate the human eye’s sensitivity to the wavelengths of light, the Rec. 709 video standard 
defines an isolated Luma (Y’) component as consisting of 0.2126 of the Red channel, 0.7152 of the 
Green channel, and 0.0722 of the Blue channels added together. This can be seen in the default 
values (rounded to the nearest integer percentage) of 21, 71, and 7.

This is the standard method of deriving a black and white version of a color image, and in fact 
produces identical results to those obtained by setting the Saturation parameter to 0. 

However, there have traditionally been other ways of mixing the colors of life into different 
grayscale interpretations. For example, photographers often use colored filters in conjunction with 
black & white film stocks, such as a yellow/green filter to emphasize pleasing skin tone for lightly-
complexioned people. A much older example is the use of black & white film stocks with different 
sensitivities (old orthochromatic stocks were not sensitive to red wavelengths, recording only blue 
and green to create an image).

Using the RGB Mixer with “To monochrome” turned on gives you the ability to mix your own 
custom blends of all three color channels to emphasize the creative characteristics you require. 
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For instance, increasing the mix of blue and decreasing red and green can give skin tones a darker, 
metallic sheen. The following screenshots show multiple versions of the same image with different 
monochrome mixes.

Three monochrome mixes of the same image. The top image is the result of setting saturation to 0.

Like the parameters in Color mode, you can use the RGB Mixer’s Monochrome mode to subtract 
one color channel from the others, for even more creative effects.
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RGB Mixer Controls on the DaVinci Control Surface

All of the RGB Mixer palette controls are available from the DaVinci Resolve control surface.

To open the RGB Mixer curve controls on the DaVinci Resolve control surface:

>> Press the CURVES soft key on the main page of the Center panel.

To exit the RGB Mixer curve controls:

>> Press the MAIN soft key on the Center panel.

To adjust the principle color regions using knobs:

>> Adjust one of the four groups of knobs on the Center panel. All are labeled to identify 
which RED/GREEN/BLUE source channels are paired with RED/GREEN/BLUE destination 
channels. For example GREEN->BLUE adds or subtracts an amount of the Green color 
channel from the Blue color channel.

>> Press the PRESERVE LUM soft key to turn on the “With luminance level preserved” checkbox.

>> Press MONO to turn on the “To monochrome” checkbox.

>> Press COLOR to turn off the “To monochrome” checkbox.
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Motion Effects Palette

The Motion Effects palette contains two sets of controls for applying optical-flow-calculated effects 
to clips in your program, enhanced Spatial and Temporal noise reduction, and motion-estimated 
artificial motion blur.

Noise Reduction Controls

Two sets of parameters let you apply GPU-accelerated Spatial and/or Temporal noise reduction 
that’s designed to let you subdue noise in problematic clips, in close to real time on workstations 
with appropriate processing power. Both methods of noise reduction can be used separately or 
together, in varying amounts depending on the needs of the particular material you’re working on. 
Furthermore, each set of controls is highly customizable, allowing for varying amounts of noise 
reduction to the chroma and luma of an image, as well as numerous options for how to apply this 
noise reduction.

Noise Reduction and Motion Blur controls

Spatial NR Controls

The Spatial NR controls let you smooth out regions of high-frequency noise throughout the image, 
while attempting to avoid softening by preserving detail. It’s effective for reducing noise that 
Temporal NR can’t.

>> Radius: Options include Large, Medium, and Small. A smaller radius offers greater real 
time performance, and can provide good quality when using low Luma and Chroma 
Threshold values. However, you may see more aliasing in regions of detail when using low 
NR Threshold values.
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>> Setting Radius to be progressively larger results in higher quality within areas of greater 
visual detail at high Luma and Chroma Threshold values, at the expense of slower 
performance. An NR Radius of Medium should provide suitable quality for most images 
when using medium NR Threshold settings. As with many operations, there’s an adjustable 
tradeoff between quality and speed.

>> Luma Threshold: Lets you determine how much or how little noise reduction to apply to 
the luma component of the image. The range is 0-100, where 0 applies no noise reduction 
at all, and 100 is the maximum amount. Too high a setting may eliminate fine detail from 
the image.

>> Chroma Threshold: Lets you determine how much or how little noise reduction to apply to 
the chroma component of the image by smoothing out regions of high-frequency noise 
while attempting to preserve the sharpness of significant edge details. The range is 0-100, 
where 0 applies no noise reduction at all, and 100 is the maximum amount. Too high a 
setting may eliminate fine color detail from the image, although you may find you can raise 
the Chroma Threshold higher than the Luma Threshold with less noticeable artifacting.

>> Luma/Chroma Threshold ganging: Ordinarily, the Luma and Chroma Threshold parameters 
are ganged together so that adjusting one adjusts both. However, you can ungang these 
parameters in order to adjust different amounts of noise reduction to each component of 
the image. For example, if an image softens too much at a certain level of noise reduction, 
but you find there’s more color speckling than there is luma noise, you can lower the Luma 
Threshold to preserve detail while raising the Chroma Threshold to eliminate color noise.

>>NR Blend: Lets you dissolve between the image as it’s being affected by the Spatial NR 
parameters (at 0.0) and the image with no noise reduction at all (100.0). This parameter lets 
you easily split the difference when using aggressive temporal noise reduction.

Temporal NR Controls

The Temporal NR controls analyze images across multiple frames in order to isolate noise from 
detail. Motion estimation settings let you exclude moving subjects from this operation in order to 
prevent unwanted motion artifacts.

>>Number of Frames: The number of frames you want Resolve to average in order to separate 
detail from the noise. You can choose between 0 and 2 frames. 0 applies no frame averaging, 
2 applies maximum frame averaging. A value of 2 frames gives the best analysis, but can 
yield unwanted artifacts for fast-moving images. A value of 1 can yield better results for 
fast-moving images.

>>Motion Est. Type: Picks the method Resolve uses to detect motion in the image. The 
default, Faster, is less processor intensive, but less accurate. Choosing Better can effectively 
exclude motion more accurately, but is more processor intensive. None lets you disable 
motion estimation altogether, with the result being the application of Temporal NR to the 
entire image.
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>>Motion Range: Three settings, Small, Medium, and Large, let you set the speed of motion 
that Motion Estimation should expect to exclude. A Small setting assumes slow-moving 
subjects with little or no motion blur, allowing Temporal NR to affect more of the image at 
a given Motion Threshold setting. A Large setting assumes fast motion with blur occupying 
a larger area of the image, which excludes more of the image from Temporal NR at the 
same Motion Threshold setting. Choose the setting that gives you the best compromise 
between a reduction in noise and the introduction of motion artifacts when adjusting the 
Motion Threshold parameter.

>> Luma Threshold: Lets you determine how much or how little Temporal NR to apply to the 
luma component of the image. The range is 0-100, where 0 applies no noise reduction 
at all, and 100 is the maximum amount. Too high a setting may eliminate fine detail from 
the image.

>> Chroma Threshold: Lets you determine how much or how little Temporal NR to apply to the 
chroma component of the image. The range is 0-100, where 0 applies no noise reduction 
at all, and 100 is the maximum amount. Too high a setting may eliminate fine color detail 
from the image, although you may find you can raise the Chroma Threshold higher than the 
Luma Threshold with less noticeable artifacting.

>> Luma/Chroma Threshold ganging: Ordinarily, the Luma and Chroma Threshold parameters 
are ganged together so that adjusting one adjusts both. However, you can ungang these 
parameters in order to adjust different amounts of noise reduction to each component of 
the image, depending on where the noise happens to be worst.

>>Motion Threshold: Defines the threshold separating which moving pixels are in motion (above 
this threshold) versus which moving pixels are static (below this threshold). Using Motion 
Estimation, Temporal Noise Reduction is not applied to regions of the image that fall above 
this threshold, in order to prevent motion artifacts by not applying frame-averaging to parts 
of the image that are in motion. Lower values omit more of the image from Temporal NR 
by considering more subtle movements. Higher values apply Temporal NR to more of the 
image by requiring faster motion for exclusion. You can choose between 0 and 100, where 
0 applies Temporal NR to no pixels, and 100 applies Temporal NR to all pixels. The default 
value is 10.7, which is a suitable compromise for many clips. Be aware that if you set too high 
a Motion Threshold, you may see artifacts in moving parts of the image.

>>NR Blend: Lets you dissolve between the image as it’s being affected by the Temporal NR 
parameters (at 0.0) and the image with no noise reduction at all (100.0). This parameter lets 
you easily split the difference when using aggressive temporal noise reduction.
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Using Noise Reduction

The following procedure suggests a method of using the Noise Reduction (NR) parameters to 
achieve a controlled result.

Applying noise reduction to an image:

1.	 Enable Temporal NR by choosing either 1 or two frames from the Number of Frames 
pop-up menu.

2.	 Choose options from the Motion Est. Type and Motion Range pop-up menus corresponding 
to how much motion is in the image. If there’s a lot of motion, you may need to choose Better 
and Large. If there’s not very much motion, lesser settings may suffice.

3.	 With Luma and Chroma Threshold linked, slowly raise either parameter until you just start 
to see a reduction in noise within the non-moving areas of the image, then make smaller 
adjustments to determine the maximum amount of Temporal NR you can add without creating 
motion artifacts, or overly softening image detail you want to preserve. 

4.	 If there’s obviously more chroma than luma noise in the image, you can disable Luma/Chroma 
linking at a satisfactory level of luma noise reduction, and then raise the Chroma Threshold to 
apply more aggressive Temporal NR to address color speckling in the picture.

5.	 If you’re not satisfied with the tradeoff between the maximum possible threshold of noise 
reduction and the prevention of motion artifacts, you may want to adjust the Motion Threshold 
setting, lowering it to omit more of the motion from the noise reduction operation, or raising 
it to include more motion. If you’re still not satisfied, you can also try better Motion Est. Type 
and Motion Range settings.

Before and After Temporal NR to reduce noise in unmoving areas of the image
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	 Keep in mind that the strength of Temporal NR is to reduce noise in unmoving parts of the 
image. When you’ve achieve the best tradeoff between noise reduction in the still areas and 
avoidance of motion artifacts in the moving areas of the image, then it’s time to turn to Spatial 
NR to further eliminate noise throughout the rest of the picture.

6.	 Enable Spatial NR by raising either the Luma or Chroma Threshold parameters, which are 
linked by default, until you strike a suitable balance between the reduction of noise, and an 
unwanted increase in image softness.

7.	 If there’s obviously more chroma than luma noise in the image, you can disable Luma/Chroma 
linking at a satisfactory level of luma noise reduction, and then raise the Chroma Threshold to 
apply more aggressive Spatial NR to address color speckling in the picture.

Before and after noise reduction improves the ‘look’

8.	 If you’ve had to use a high Spatial NR Luma or Chroma Threshold setting to reduce noise 
visibly, and areas of detail look a bit chunky or aliased, you can choose a larger setting from 
the Radius pop-up menu to enable a more detailed analysis of the scene.

	 This will result in higher visual quality, but larger NR Radius settings are more processor 
intensive, and may reduce real time performance if you don’t have adequate GPU resources 
available to your system.

9.	 If you’ve found suitable noise reduction settings, but the result is too aggressive and makes 
the image appear too processed, you can try raising the Spatial NR and/or Temporal NR Blend 
parameters to fade between the noise reduction added by each set of controls, and the image 
as it was before you added noise reduction.
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Try Applying Temporal NR First, then Applying Spatial NR

Because Temporal NR analyzes multiple frames for its noise isolation, it tends to be better at 
preserving detail accurately in regions of the image where there’s little motion. If you try applying 
Temporal NR first and get a successful result, even if only in part of the image, you may reduce how 
much Spatial NR you have to apply, thus improving the overall quality of your final result.

Keep in mind that while Temporal NR does a great job in unmoving parts of an image but is less 
effective when dealing with subjects in motion, Spatial NR is able to reduce noise everywhere in the 
frame falling below its threshold, even when there’s motion. Ultimately, a combination of the two is 
almost always going to be a winning combination. 

Spatial NR Radius, How Large Should You Go?

Larger NR Radius settings can dramatically improve the quality of high-detail regions in shots where 
you’re using aggressive Spatial noise reduction, but it’s not necessary to always jump to the large 
Radius setting, which provides the highest precision. In many cases, when evaluating an image that 
you’re applying noise reduction to, you may not actually be able to perceive the additional quality, 
and you’ll waste processing time on an unnecessary level of correction.

It’s a good idea to make sure that you’re evaluating the full-frame image on a large enough display 
to see the noise you’re working on within the viewing context of the intended audience. Zooming 
really far into a clip while applying noise reduction may encourage you to use higher quality settings 
than are necessary, because an excessively enlarged detail of an image lets you see subtle changes 
that you wouldn’t notice at actual size.

Limiting Noise Reduction in Useful Ways

As with any other correction in the Color page, noise reduction can be limited using HSL Qualification 
or Power Windows. This means you can focus your efforts on reducing noise in the most problematic 
areas of an image (for example, in shadows and background regions), while sparing elements that 
you don’t want to affect (such as faces or better-lit areas of the image).

Furthermore, you can use Spatial NR in lieu of Blur operations to perform a subtler form of 
complexion smoothing, using the HSL Qualifier or a Window to isolate an actor’s skin tone for 
targeted noise reduction.

Controlling the Order of Operations for Noise Reduction

You can apply noise reduction at any point in your image processing tree using a dedicated node. If 
you have an image with noise that you think might be enhanced by whatever corrections you need 
to make (increasing the contrast of underexposed clips often increases whatever noise is within an 
image), there are two approaches to noise reduction:
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>> Apply noise reduction at the beginning of a node tree: This lets you pre-emptively eliminate 
any noise before it becomes a problem as a result of whatever adjustments you’re planning 
to make. The result can be smoother, but you may also notice that the edge detail within 
the image is a bit softer.

>> Apply noise reduction at the end of a node tree: The alternative is to make your adjustments 
first, and then apply noise reduction in a separate node afterwards. In this case, you may 
find that the noise reduced regions of the image aren’t quite as smooth, however the edge 
detail within the image may be visibly sharper as a result.

>> Apply Noise reduction to only one color channel of an image: Using the Splitter/Combiner 
nodes, you can also apply noise reduction to only one color component of an image. If 
you’re grading a video clip with a noisy Blue channel, this can be a way to focus noise 
reduction where it’s needed.

Neither result is universally better or worse than the other. Which is preferable depends on the 
image you’re working on, and the type of result you’re looking for (you might prefer some shots to 
be a bit softer, while you’d like other shots to be a bit sharper). The real point is that the node-based 
image processing of DaVinci Resolve lets you choose which technique works best for you.

Note: If you apply noise reduction and make color adjustments within the same node, noise 
reduction is processed first, followed by color adjustments.

Using Noise Reduction Controls with the DaVinci Control Surface

All three Noise Reduction controls are available via knobs on the PRIMARIES, NOISE REDUCTION 
control group on the Center panel.

To open the Noise Reduction controls on the DaVinci control surface:

>> Press the PRIMARIES or MAIN soft key on the Center panel, whichever is visible (depending 
on which control group is currently displayed).



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

548

COLOR PAGE BASICS11

Motion Blur

Motion Blur settings use optical-flow based motion estimation to add artificial motion blur to clips 
that have none. This can be useful in cases where a program was shot using a fast shutter speed, 
and you later decide that the resulting video has too much strobing. By analyzing the motion within 
a clip, the Motion Blur settings can selectively apply blurring to the image based on the speed and 
direction of each moving element within the scene.

Motion Blur controls

Three parameters let you set how much motion blur to add, and at what quality:

>>Motion Est. Type: A setting of Better provides more accurate pixel mapping at the expense 
of being more processor intensive. Faster provides a more approximate result, but is less 
processor intensive.

>>Motion Range: Determines what speed of motion to consider when defining regions 
being blurred.

>>Motion Blur: Raise this parameter to add more motion blur to the image, lower it to add less. 
The range is 0-100, where 0 applies no motion blur, and 100 applies maximum motion blur.
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OpenFX is an open plug-in standard intended to enable easier development of cross-platform 
visual effects plug-ins for a variety of applications. Popular plug-in packages include the GenArts 
Sapphire plug-ins which are a ubiquitous tool for feature and broadcast work, but there are many 
other plug-in collections from other vendors available, and the numbers grow as this format 
becomes more widely adopted. With OpenFX support, you can use plug-ins to do many stylized 
operations that would be difficult or impossible to do using the other tools in Resolve.

This kind of optical effect would be impossible to do without plug-in support

The installation and licensing of OpenFX plug-ins is handled by a vendor’s own installer. Once 
installed, OpenFX plug-ins appear within the Library of the Open FX Panel, which can be opened 
by clicking the FX button at the bottom right of the Node Editor.

Click the FX button to open the OpenFX Library

When you click the FX button, the Open FX Panel opens out of the right side of the Node Editor 
to show the Library, resizing the Viewer, Gallery, and Node Editor to make room. The OpenFX 
Library is organized hierarchically. Each vendor’s plug-ins appear under a header with the name 
of that plug-in collection and a disclosure triangle at the right that can be closed to make room 
for browsing other collections. Within a given collection, plug-ins may be further organized into 
categories, separated by headers with disclosure triangles, which let you make the Hierarchy as 
compact or spread out as you like.

OpenFX
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The Library in the Open FX Panel

Since many OpenFX plug-in collections are quite large, a Search field at the top of the Library lets 
you quickly find plug-ins by name or partial name. Typing a few letters is enough to isolate only 
those plug-ins that have that character string within their name.

Applying OpenFX Plug-Ins

Once you’ve found an OpenFX plug-in you want to use in the Library, simply drag and drop it onto 
a new node to apply that plug-in’s effect within your grade. Nodes with an OpenFX plug-in applied 
have an FX badge in the upper right-hand corner.

A node with an OpenFX plug-in applied

You can only apply one OpenFX plug-in to a node at a time, but by using multiple nodes you can 
add as many OpenFX plug-ins to your grade as you need.
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OpenFX Plug-ins Are Processor Intensive

Because they create such a wide variety of effects, some OpenFX plug-ins can be extremely 
processor intensive, all the more if you add multiple plug-ins to a single grade. If you find your 
playback performance dropping because of a particularly expensive effects operation, you can 
right-click that clip’s thumbnail and choose Mark Clip for Render Cache to flag the clip for caching. 
Then, choosing Playback > Render Cache > User will initiate the caching of all user-flagged clips, 
which will render during inactive moments when you’re not working. Once fully cached, you can play 
these clips back in real time, at least until you change that clip’s grade again. For more information 
on caching, see Chapter 3, “Project Settings, Caching, and Preferences.”

OpenFX Settings

When you select a node with an OpenFX plug-in applied to it, the Open FX Panel switches to the 
Settings, which show you every single parameter associated with that plug-in, ready for customization.

The parameters of a GenArts Sapphire plugin

Adjust any of the standard controls to manipulate that plug-in’s effect on the image.
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OpenFX On-Screen Controls

When you select a node with an OpenFX plug-in applied to it that has on-screen controls, the 
Viewer Mode pop-up automatically changes to OpenFX Overlay mode, and the available controls 
appear within the Viewer. Different plug-ins expose different custom controls, letting you control 
the effect or manipulate the image, depending on that plug-in’s function.

Adjusting the on-screen controls exposed by the GenArts Sapphire Glint Rainbow plug-in

Using OpenFX

The following procedures describe how you can work with OpenFX plug-ins within the Color page.

Methods of working with OpenFX:

>> To find an OpenFX plug-in: Click the FX button at the bottom right of the Node Editor to 
open the Open FX Library. Then type a name, or part of a name, into the search field at the 
top. The list shrinks to only show those plug-ins that have the text you typed somewhere 
within their name.

>> To collapse or open a category of OFX plug-ins: Most OFX plug-ins you get will be 
organized into categories, each with its own title bar in the Library. If you move the pointer 
over any one of these title bars, a small Close button appears that you can use to hide all 
of the plug-ins within that category. You can also Option-click the Close button to close 
(and later open) all categories at once, which is useful if you have a large collection of OFX 
plug-ins from different vendors and you want to browse the available categories without 
endless scrolling.
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>> To add an OpenFX plug-in to a node: Drag a plug-in from the OpenFX Library onto a 
node. If you drag a plug-in onto a node that already has a plug-in, the previous plug-in 
will be overwritten.

>> To remove an OpenFX plug-in from a node: Right-click a node showing the FX badge, and 
choose Remove OFX Plug-in from the contextual menu.

>> To edit the parameters of an OpenFX plug-in: Select any node with an FX badge, and open 
the Open FX Panel to show the Settings list. You can switch to the Library by clicking the 
Library button.

>> To sample a color parameter within an OpenFX plug-in: Some OFX plug-ins have a color 
swatch parameter, which exposes an eyedropper button in the Settings. Clicking the 
eyedropper turns the pointer into an eyedropper you can use to sample the contents of 
the Viewer.

>> To use OpenFX on-screen controls in the Viewer: Select any node with an FX badge, and 
the on-screen controls, if there are any, should appear in the Viewer. If not, make sure the 
Viewer mode pop-up is set to FX.
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The Curves palette, selectable via one of the toolbar buttons above the Center Palette panel of the 
Color page, has six modes that provide different curve-based methods of manipulating the color 
and contrast of an image. Each curve lets you adjust a customizable region of the image based 
either on image tonality (zones of lightness or darkness), or hue (specific colors). All curves can be 
adjusted using either the pointer, or knobs on the DaVinci control surface.

Tip: All curves in DaVinci Resolve can be used to affect the overall image, or limited to affect only a 
specific portion of the image as a part of a secondary operation using HSL Qualification, Windows, 
Imported Mattes, or any combination of the three.

Adjusting Curves Using the Mouse

All curves have identical controls for basic on-screen adjustment using the mouse.

Methods of adjusting curves using the on-screen interface:

>> To add a control point: Click anywhere on or around a curve. A control point is added at the 
position of the mouse where you clicked, and the curve is altered, if necessary, to match the 
new control point’s position.

>> To add a control point without altering the curve: Hold the Shift key down, and click 
anywhere on or around a curve. A control point is added at the horizontal position of the 
pointer where you clicked, but the curve is not altered.

>> To remove a control point: Right-click any control point to make it disappear.

>> To reset a curve to a completely neutral setting: Click Reset.

>> To reset all Custom curves: Right-click anywhere within the Curves tab and outside of each 
curve control box and choose Reset Custom Curve.

By default, individual control points influence the portion of each curve that falls between its 
neighboring two control points. 

Control point adjustments affect the entire portion of a curve between adjacent control points.

Curves
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In the screenshot to the left, you can see that the control point at the position of the pointer is 
affecting the larger part of the curve that falls between the lower left-hand control point (which is 
there by default), and a user-created control point placed up within the highlights of the curve.

In the screenshot to the right, an additional control point to the left of the one being adjusted limits 
the area of the curve that is adjusted. By careful placement of additional control points, you can 
make extremely targeted adjustments to images using the Custom curves. 

This example highlights the importance of using control points to “lock off” portions of a curve at 
a neutral or nearly neutral position to prevent changes to specific portions of an image, even while 
using other control points to make changes.

Note: The Hue vs. Hue/Sat/Lum and Lum vs. Sat curves also have an optional adjustment mode 
using Bezier curves that will be covered in those sections.

Custom Curves

DaVinci’s Custom curves provide smooth adjustment of each clip’s Y, R, G, and B channels.

The Luminance, Red, Green, and Blue (YRGB) Custom curves at their neutral defaults

The YRGB Custom curves are useful for making more tonally specific, channel-by-channel 
adjustments to an image than can be accomplished using the Color Balance controls. They’re 
also useful for making strange and wonderful stylistic adjustments through unusual alterations to 
different combinations of color channels.

Each Curve Control area is square, and the default, neutral position of a curve is a diagonal line that 
runs from the lower-left black point of the image through the upper-right white point. 

The horizontal axis represents the range of image tonality in the original image, while the vertical 
axis represents the range of alteration you can make. By adding control points to the surface of 
the curve and raising or lowering different areas, you are actually remapping the original horizontal 
“input” value of a color channel to an “output” value of your choosing.
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Controls attached to each Custom curve; the handle on the upper-right hand side  

is the YSFX vertical slider, and the slider underneath is the Curve Mix slider

Tip: The background grid makes it easy to see which parts of any curve are at or near the diagonal 
default that represents no change made.

Ganging and Unganging Custom Curves

By default, the Custom curves are ganged, meaning that changes made to one curve are 
automatically made to all of the other curves.

When Custom curve ganging is enabled, changes to one curve are applied to all curves.

When ganged together, curve adjustments affect a clip’s YR GB channels all together, resulting 
in an adjustment to image contrast that’s similar to using the Master Wheels in the Color Wheels 
palette, or the ring controls of the DaVinci control surface. When making this type of adjustment, 
increasing contrast also increases image saturation, while reducing contrast also reduces image 
saturation. Since curves can be manipulated with greater specificity than the three Master Wheels, 
you can make much finer contrast adjustments using the YRGB curves than when using the Master 
Wheels only.
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To enable or disable Custom curve ganging:

>> Click the Options menu at the upper right-hand corner of the palette, and choose Gang 
Custom Curves. A checkbox indicates when it’s enabled.

Turning ganging off lets you use the full power of Custom curves to alter the image. Unlike the Color 
Balance controls, each of which adjust all three color channels simultaneously, the Curve controls let 
you adjust each channel individually when Gang Custom Curves is turned off. 

Turning off curve ganging lets you independently adjust each curve

Tip: When curve ganging is disabled, the Luma curve allows you to adjust the Y channel by 
itself, which is similar to using the Y-only Lift/Gamma/Gain knobs of the DaVinci control surface.  
When making this type of adjustment, increasing luma contrast results in a perceptual decrease of 
image saturation.

Copying Custom Curve Channels

Even if you’ve unganged the Custom curves, you can still mirror one curve’s adjustments to another 
by copying it. To copy a Custom Curve from one channel to another:

>>Option-drag the curve you want to copy onto the curve you want to paste to. The pointer 
appears with a plus sign underneath to indicate that you’re successfully dragging one curve 
onto another.
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Curve Intensity Sliders

Curve Intensity sliders underneath each curve control let you mix between the current curve’s effect 
on the clip, and the original state of the image before you altered the curve. The default Intensity 
of 100 results in that curve exerting its full effect on the image, while an intensity of 0 results in that 
curve having no effect on the image.

The Intensity sliders provide an easy way to “split the difference” between a curve adjustment and 
the previous state of the image.

Lowering the Curve Mix slider reduces the effect of that curve’s adjustment on the image.

YSFX Sliders

Each of the Custom curves (Y’, R, G, and B) has a vertical YSFX slider at the left of each curve control 
that lets you invert any or all color channels by any amount you want, to create different types of 
stylized effects.

Image with the Luma channel modified using the vertical YSFX slider

As with all other adjustments in the Color page, YSFX may be combined with Power Windows or HSL 
qualification to limit channel inversions to specific portions of the image for creative purposes.
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Large View Custom Curves

For clips where you need to make finer adjustments than the default size of the Custom curves will 
allow, you can temporarily enlarge the Custom curves inside a floating window. In this “large curve 
view,” it’s possible to do nearly everything you could do with the ordinary, smaller curves. When 
you’re finished making your adjustment, you can send this window away.

To use the Large Curve mode:

>> Click the Zoom Curves control, at the bottom center of the Curves palette.

Use the Large Curve view to make subtle changes

To exit the Large Curve mode:

>> Click anywhere outside of the floating window to close it.

Adjusting Custom Curves with the DaVinci Control Surface

The controls that correspond to the Custom curves on the DaVinci control surface are available 
by default when you first open Resolve (the rotary knobs on the Center panel will be labeled 
PRIMARIES). If these buttons are not visible, you need to switch to the Primaries controls using the 
soft keys.

To open the Primary Curve controls of the DaVinci Resolve control surface:

>> Press the PRIMARIES soft key on the center panel.

>> If the Center panel is currently in CURVES mode, then press the MAIN soft key on the 
Center panel.

The rotary knobs on the Center panel update to show the CHANNEL OFFSET/CUSTOM 
CURVES and YSFX controls.
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To make curve adjustments:

>> Adjust the DARK LUM, MID-DARK LUM, MID-LIGHT LUM, or LIGHT LUM rotary knobs.

By default, all adjustments you make using these controls are ganged across all four YRGB 
curve controls. However, if you turn Custom curve ganging off, then these controls only 
affect the Luminance curve.

These controls correspond to the following default control point positions on the Curve controls.

Each rotary curve control corresponds to one of these four default control point positions

You also have the option of using the fourth trackball from the left to adjust individual control points 
on curves to any position you like. This works for all curves in DaVinci Resolve that have control 
surface mappings.

Methods of selecting and adjusting individual control points using the master trackball of the 
Center panel:

>> To select a control point to adjust: Spin the fourth ring control to the left or right to select 
the next control point in that direction (it takes about half of a turn to select another 
control point).

Selected control points are highlighted in cyan.

>> To move a selected control point: Adjust the fourth trackball to move the control point up, 
down, left, or right. Selected control points are constrained between whichever control 
points are to the left and right.

Another set of rotary knobs let you adjust Curve Mix and YSFX parameters.

To adjust the Curve Intensity sliders:

>> Adjust the LUM CURVE, RED CURVE, GREEN CURVE, or BLUE CURVE rotary knobs.

To make YSFX adjustments:

>> Adjust the LUM YSFX, RED YSFX, GREEN YSFX, or BLUE YSFX rotary knobs. 
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Soft Clip

The Soft Clip mode provides an interface for adjusting highlight and shadow soft clipping either 
overall, with Gang Clips enabled, or on a per-channel basis. The Soft Clip controls are intended to 
provide clip-by-clip adjustment, as opposed to the Generate Soft Clip LUT settings, which let you 
set one soft-clipping setting for the entire program. For more information on the Soft Clip LUT 
setting, see Chapter 3, “Project Settings, Caching, and Preferences.”

High and Low soft clip controls within the Curves palette

Soft clipping lets you apply a “knee” to any clipping that occurs at the upper or lower extremes of 
the image, and can be used to quickly ease off any unpleasantly harsh loss of detail that occurs as a 
result of blowing out the highlights or crushing the shadows too aggressively.

In the following example, the screenshot at top has had the highlights deliberately blown out by 
excessively boosting the highlight contrast. As you can see, the edges of the clipped area lack 
detail. The screenshot at bottom shows the same image with soft clipping increased for all three 
color channels. The result retrieves detail, compressing the highlights to bring the tops of each 
color channel back within the allowable range.
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Using High Soft Clip to pull highlight details into the viewable range

Ganging and Unganging Soft Clip Controls

Soft clipping can be simultaneously applied to all three color channels by ganging them together 
(the default), or you can disable Soft Clip ganging to individually adjust each channel. For example, 
using soft clipping on individual channels can be useful for legalizing RGB out-of-gamut errors for 
channels that over or undershoot your QC standards.

To enable or disable Soft Clip ganging:

>> Click the Options menu at the upper right-hand corner of the palette, and choose Gang Clips.  
A checkbox indicates when it’s enabled.

Tip: Applying too much soft clipping to individual color channels may add an unwanted color 
tint to the corresponding highlights or shadows of an image. To avoid this, use the soft clipping 
parameters with ganging enabled to clip all three color channels equally.
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Soft Clip Controls

Whether all channels are ganged or not, soft clipping is controlled via two sliders and two additional 
parameters for each color channel.

High Clipping Point

The High Clipping Point vertical slider (to the left of each Clip Curve control) lets you adjust the 
maximum signal level above which the signal is clipped. Any pixels above the clipping level are 
made equal to the clipping level. 

The High Clipping Point defaults to a digital level of 1023 relative to the DaVinci Resolve internal 
video scopes. Lowering this slider causes the highlights of the image to clip at a lower level, resulting 
in lower, dimmer maximum levels.

At the default top position, no clipping occurs and image data that you push above 1023 on the 
internal scopes is preserved and passed through the image processing pipeline to subsequent 
nodes. For example, in the following two screenshots, the highlights in the screenshot at top are 
blown out raising the gain dramatically in Node 1. In the screenshot at bottom, a subsequent 
adjustment in Node 2 lowers the gain and retrieves all the previously clipped values.

RGB Parade displays the clipped imageSelecting and adjusting the high clip
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Middle–the image is clipped using the Gain control in Node 2; Bottom–image data that was clipped in Node 1 is  

retrieved in Node 3 by lowering the Gain control. This illustrates the preservation of deliberately clipped data.

However, if at any point in a node tree you lower the High Clip vertical slider, even by a single 
digit, all image data above the new clipping threshold is discarded from that node forward. In the 
following example, the High Clip slider in Node 1 is lowered. The result is that all clipped image 
data is discarded. As a result, when Node 2 lowers the gain, there is no image detail left to retrieve, 
and all three channels exhibit flattening.
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Lowering the High Clip slider in Node 1 forces all image data above the new High Clip threshold to be irretrievably  

discarded. Clipped data cannot be brought back by subsequent nodes

High Soft

The High Soft parameter sets the threshold, below the clipping point, at which highlights begin 
to compress before hard clipping. At 0, no soft clipping occurs. As you raise this value, more and 
more of the clipped highlight values are compressed, rather than clipped, resulting in softer, more 
pleasant “glowing” highlights. In the following screenshots, an image with deliberately boosted 
highlights is shown with High Soft set to 0, 500, and 1000, so you can see the difference.

Important: Image data that was clipped “in camera” is not necessarily retrievable using the Soft 
Clip controls, although there may be some preserved overhead in the super-white highlights of 
Y’CbCr-encoded video data.

Low Soft Clipping Point

The Low Soft Clipping Point vertical slider (to the right of each Clip Curve control) lets you adjust 
the minimum signal level at which the signal clips. This defaults to a digital level of 0 relative to the 
DaVinci Resolve internal video scopes. Raising this slider causes the shadows of the image to clip at 
a higher level, resulting in lighter minimum levels, and a lower-contrast image with lighter (possibly 
milky) shadows.

Low Soft

The Low Soft slider sets the threshold, above the minimum clipping point, at which shadows begin 
to compress before hard clipping. At 0, no soft clipping occurs. As you raise this value, more and 
more of the clipped shadow values are compressed, rather than clipped, resulting in a softer, more 
pleasant rolloff in the shadows.
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Using Soft Clipping Controls with the DaVinci Control Surface

The soft clipping controls can also be manipulated using the DaVinci control surface, which provides 
separate controls for ganged and individual color channels.

To open the soft clipping control on the DaVinci Resolve control surface:

>> Press the CLIPS soft key on the Center panel.

To exit the soft clipping controls:

>> Press the MAIN soft key on the Center panel.

To make a ganged soft clipping adjustment:

>> Adjust the MASTER CLIP or MASTER SOFT rotary knobs of the SCENE WHITE CLIPS or 
SCENE BLACK CLIPS control groups (there are 4 individual knobs).

These controls adjust all four corresponding YRGB High Soft, High Clip, Low Soft, or Low 
Clip parameters simultaneously.

To adjust soft clipping for individual color channels:

>> Adjust the RED/GREEN/BLUE CLIP or RED/GREEN/BLUE SOFT rotary knobs of the SCENE 
WHITE CLIPS or SCENE BLACK CLIPS control groups (there are 12 individual knobs).

Each control adjusts an individual YRGB color channel.

The Hue and Sat Curves

Three sets of Hue curves, and one additional Lum vs. Sat curve, let you make different types of 
curve-based alterations to the image. Whereas the Custom curves let you make adjustments to the 
color channels of an image based on tonality (for example, boosting the Red channel in the highlights 
while lowering it in the shadows), the Hue curves let you make adjustments to the hue, saturation, 
or luma of elements in an image based on their hue.

Curves controls including six-vector selection and bezier handle button
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For example, you could use the Hue vs. Sat curve to selectively lower the saturation of everything 
that’s blue, while raising the saturation of everything that’s blue.

You can use these curves to make adjustments similar to those made using HSL qualification, but 
with one critical difference. Curve adjustments are mathematically smoother than the matte-limited 
adjustments of HSL qualifiers, so it can sometimes be easier to make specific alterations that blend 
smoothly with the rest of the image, without the potential for artifacts at the edges of qualified keys 
that can sometimes defeat a seamless result. 

On the other hand, it is often easier to define more distinct boundaries between separate elements 
using HSL qualification. Only time and experience will help you determine which tools are best for 
which situations.

Top–Original image, Bottom–the image as altered by the Hue vs. Sat curve shown in the middle
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Unlike the Custom curves, which default to a diagonal position where lower left represents the 
black point and upper right represents the white point, Hue and Sat curves are flat. In the case of 
the Hue vs. Hue/Sat/Lum curves, the horizontal range of the curve from left to right represents the 
overall range of possible hues, from red through green through blue and then cycling back to red.

Because the range of hues cycle smoothly from the left to the right edge, changes that affect the 
curve near the left boundary of these curves loop smoothly around to the right boundary, and vice 
versa, such that the left and right sides of the curve always move together (as you can see in the 
above screenshot).

Important: When using Hue curves, the range of hue that you isolate with control points is always 
relative to the RGB input connected to that node. That means if you change the hue of a shirt from 
blue to red using Hue vs. Hue and you then want to raise the same shirt’s saturation with the Hue 
vs. Sat curve within the same node, you need to add control points to the same range of blue for 
both curves.

Image Sampling for Hue and Sat Curves

There’s an additional way to use Hue curves in Resolve. Whenever one of the Hue vs. Hue, Hue vs. 
Sat, Hue vs. Lum, and Lum vs. Sat curve tabs are open, clicking or clicking and dragging over any 
range of pixels within the viewer area samples the hues and/or image tonality of that region of the 
picture, and automatically places three control points on the currently open curve that correspond 
to the range of color and contrast you sampled. This also works if you use the cursor from the 
DaVinci control surface with the fourth trackball to sample a range of color.

Additional Controls in the Hue and Sat Curves

While the Hue vs. Hue, Hue vs. Sat, Hue vs. Lum, and Lum vs. Sat curves can be adjusted similarly to 
the Custom curves, they have additional controls running underneath the curve graph.

>> Six-Vector Color Patches: The Hue curves each have six buttons for automatically adding 
control points to manipulate the red/yellow/green/cyan/blue/magenta ranges of hue. 
Clicking any of these buttons adds three control points; two to define the outer range of 
hue to be adjusted, and a middle control point that you use to make the adjustment.

>> Input and Output (Hue Rotate/Saturation/Lum) fields: These two numeric fields correspond 
to the horizontal and vertical adjustment values for the currently selected control point. 
Click any control point on a curve to view or alter these values. The label of the second field 
depends on the curve that’s selected.

>> Enable Bezier button: Turning this button on forces a curve to use Bezier control handles, 
rather than the default DaVinci Resolve curve control points, to manipulate each control 
point on the curve. With Bezier handles enabled, click any control point to reveal its two 
Bezier handles. Drag either handle to alter the shape of the curve at that control point.

The following sections describe each available curve in more detail.
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Hue vs. Hue

The Hue vs. Hue curve lets you change any hue to any other hue. In the following example, the 
image at top is the unadjusted original. The image at bottom has had the magenta jacket shifted to 
an olive green via a set of three control points.

Changing the hue of the woman’s jacket using the Hue vs. Hue curve; Top–original image, Bottom–altered image

One excellent use of the Hue vs. Hue curve is to quickly and subtly alter elements that require only 
minor adjustments. For example, a sky that appears a bit too cyan can be made into a richer shade 
of blue with a small adjustment. 

Hue vs. Hue is also useful for making more radical changes to elements that might be too noisy 
to key successfully using the HSL qualifier controls. For example, red autumnal foliage blowing in 
the wind might result in a chattery matte, but you can use the Hue vs. Hue curve to change reds to 
greens, without having to worry about aliased matte edges giving your correction away.
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Hue vs. Sat

The Hue vs. Sat curve lets you selectively alter the saturation of any hue within the image. This is a 
terrific tool for creative effect, allowing you to quickly and easily boost the saturation of elements 
you want to catch the viewer’s eye, while reducing the saturation of elements you’d prefer the 
audience not dwell upon.

This can be extremely useful for legalizing over-saturated overshoots or undershoots during a QC 
pass. For example, desaturating reds that are off the charts while leaving everything else alone.

Lowering the saturation of the woman’s jacket using the Hue vs. Sat curve; Top–original image, Bottom–altered image

The Hue vs. Sat curve can also be a powerful tool for increasing the color contrast of images that 
seem lackluster and flat. By boosting the saturation of colorful elements that are distinct from the 
dominant palette of a scene, you can add variety to an otherwise monochromatic image.
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Hue vs. Lum

The Hue vs. Lum curve lets you increase or decrease the lightness of elements of specific colors.

Darkening the woman’s jacket using the Hue vs. Lum curve; Top–original image, Bottom–altered image

This is a tricky curve to use with highly compressed footage, as it can quickly reveal artifacts in the 
image if you aren’t careful. However, if you’re working with very high-quality footage, this can be 
a great tool to darken specific hues to add richness and depth, or to lighten colorful elements to 
which you want to draw attention.
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Lum vs. Sat

The Lum vs. Sat curve is similar to the Custom curves in that alterations to the saturation of an image 
are based on user-definable ranges of image tonality, rather than hue. In the following example, 
the Lum vs. Sat curve is being used to decrease selectively the saturation of everything falling 
into the highlights and shadows of the image, while increasing the saturation of everything within 
the midtones.

In the following example, a vividly saturated treatment results in shadows that seem artificially 
colorful. Using the Lum vs. Sat curve, it’s easy to gradually desaturate everything below a certain 
range, with a nice smooth falloff.

This is an outstanding curve to use for creative effect, for example, slightly boosting saturation 
within the midtones while reducing saturation in the shadows to increase the depth of the darkest 
portions of the image. It’s also a great curve to use to solve QC violations. For example, if you 
have illegal saturation in the highlights of an image, you can use the Lum vs. Sat curve cleanly and 
smoothly to lower the specific values that are causing problems.
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Selective desaturation in the shadows and highlights using the Lum vs. Sat curve; Top–original image, Bottom–altered image
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Sat vs. Sat

The Saturation vs. Saturation curve lets you selectively manipulate image saturation within specific 
regions defined by the image’s original image saturation. Control points added to the left of this 
curve affect areas of progressively lower saturation, effectively letting you increase or decrease the 
saturation of lower-saturated features. Control points added to the right affect areas of progressively 
higher saturation, letting you increase or decrease the most saturated features of an image.

Like all curves, this operation is extremely useful for stylizing the image. You can create custom 
vibrance operations, where you selectively increase the saturation of low-saturated regions of the 
image in different ways to give the picture more “pop.” It’s also an excellent tool for taking care 
of over-saturated areas of the picture when adhering to conservative QC requirements. You can 
specifically desaturate only the most over-saturated parts of the picture, without affecting similar 
hues at lower levels of saturation.

In the following example, you can see that the portion of the image with the highest saturation has 
been desaturated, while the rest of the image has been left alone.
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Desaturating only the highest saturated elements in the picture by lower control points at the right of the Sat vs. Sat curve
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Using Hue and Sat Curves with the DaVinci Control Surface

Using these curves with the DaVinci control surface unlocks their speed, letting you make fast, 
controlled adjustments to specific elements within each scene.

To open the Hue and Sat curve controls on the DaVinci Resolve control surface:

>> Press the CURVES soft key on the center panel.

To exit the Hue and Sat curve controls:

>> Press the MAIN soft key on the center panel.

To adjust the principle color regions using knobs:

>> Adjust one of the 18 knobs in the PRIMARIES CURVE GRADE control groups corresponding 
to the RED/YELLOW/GREEN/CYAN/BLUE/MAGENTA colors paired with HUE/SAT/LUM.

To sample a region of a shot to place curve control points:

1.	 Press the soft key corresponding to the curve you want to adjust (HUE - HUE, HUE - SAT, HUE 
- LUM, LUM - SAT).

2.	 Press the CURSOR button (located above the fourth trackball).

3.	 Use the fourth trackball to move the on-screen cursor to the pixel you want to sample.

4.	 Press the first of the three buttons underneath the fourth trackball to sample the color at the 
position of the cursor.

	 Three control points appear on the currently selected curve. The outer two control points 
define region of the curve you’re adjusting, and the center control point (selected by default) 
lets you make the actual adjustment.

5.	 To hide the cursor when you’re finished sampling, press the CURSOR button again.

To select and adjust control points using the fourth trackball of the Center panel:

>> To select a control point to adjust: Spin the fourth ring control to the right or left to select 
the next control point in that direction (it takes about half of a turn to select another control 
point). Selected control points are highlighted in cyan.

>> To move a selected control point: Adjust the fourth trackball to move the control point up, 
down, left, or right. Selected control points are constrained between whichever control 
points are to the left and right. 
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Broadcast Safe settings can be enabled while you grade, to limit both the luma and chroma of the 
video signal to one of three levels of acceptable overshoots and undershoots. 

To turn on Broadcast Safe limiting:

1.	 Open the Lookup Tables panel of the Project Settings.

2.	 Choose a range from the Broadcast safe IRE (mV) levels pop-up. There are three levels of 
aggressiveness you can choose among for limiting the signal. Choose the range that 
corresponds to your QC requirements.

3.	 Turn on the Make Broadcast Safe checkbox. Broadcast safe is now enabled, and automatically 
limits the luma and chroma of the signal as the very last image processing operation performed 
in Resolve, after all other grading, adjustments, and LUTs have been applied.

Please note that the clipping imposed by Broadcast Safe itself does not have an inherently soft roll-
off. For best results, Broadcast Safe should be used in conjunction with the Soft Clip controls in the 
Color page, or a Soft Clip LUT.

Automatic Broadcast Safe Limiting
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Monitoring What Broadcast Safe Will Clip

Whether you have Broadcast Safe Limiting turned on or not, you can turn on a false-color preview 
of what image values are currently “unsafe” given the current “Broadcast safe IRE (mV) levels” that 
are selected in the Lookup Tables panel of the Project Settings. To do so, choose View > Display 
Broadcast Safe Exceptions, and a color overlay will highlight which areas of the picture are unsafe 
for broadcast.

Blue highlights indicate Quality Control (QC) violations above the maximum allowable levels, while 
yellow highlights indicate QC violations below the minimum allowable levels.
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The Color page has another mode available to aid you in using DaVinci Resolve in on-set grading 
workflows. Turning the Resolve Live option on puts Resolve into a live grading mode, in which an 
incoming video signal from a camera can be monitored and graded during a shoot.

Resolve Live has been designed to let you use all of the features of DaVinci Resolve to grade these 
on-set video previews, in the process saving video snapshots that contain a captured image, your 
grade, and reference timecode from the camera. The idea is that, using Resolve Live, you can 
work with the cinematographer to develop looks and test lighting schemes on the footage being 
captured during the shoot, and then later you can use those looks to build dailies, and as a starting 
point for the final grade once the edit has been completed.

Additionally, you can use Resolve Live in conjunction with other Color page features such as the 
Alpha Output to build test composites to check green screen shots, comparing them against 
imported background images in order to aid camera positioning and lighting adjustments. The 
built-in video scopes can also be used to monitor the signal levels of incoming video. Finally, you 
can use 1D and 3D LUTs to monitor and grade log-encoded media coming off the camera.

Configuring Your System for Resolve Live

Setting up Resolve Live is straightforward. Whether your’e using a tower workstation or a laptop, 
any of the Blackmagic Design DeckLink or UltraStudio video interfaces can be used to connect your 
DaVinci Resolve workstation to a camera and external video display. The important thing to keep in 
mind is that, if you want to connect to a live incoming signal and output that signal for monitoring at 
the same time, you need to either use two separate DeckLink PCIe cards or UltraStudio Thunderbolt 
interfaces, or a single DeckLink Duo or DeckLink Studio card with multiple separate inputs and 
outputs on a single PCIe card.

The Preferences window has a Video I/O and GPU panel that provides two sets of options for 
configuring video interfaces connected to your computer, one for capture and playback, and one 
for Resolve Live input. If you only have a single video interface, you can only do one or the other. If 
you have two interfaces, then you can use these options to use one interface for playback, and the 
other interface for Resolve Live.

Resolve Live
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Screenshot of preferences

During the shoot, the digital cinema camera in use needs to be connected to your DaVinci Resolve 
workstation via HD-SDI, which must be configured to carry both the video image and timecode that 
mirrors the timecode being written to each recorded clip. Most cameras allow timecode output 
over HD-SDI, and both DeckLink and UltraStudio interfaces can pass this timecode to Resolve. 
Without a proper timecode reference, you won’t be able to take the shortcut of automatically 
syncing your saved Snapshots to recorded camera original media using ColorTrace, although you 
can always apply grades manually.

If you’re shooting with any of the Blackmagic Design cameras, you also have the option of connecting 
the camera directly to your Resolve Live workstation using Thunderbolt, eliminating the need for a 
second video interface. In this configuration, Thunderbolt carries both video and timecode for easy 
capture by Resolve.

Grading Live

Once your camera and computer are appropriately connected and configured, using Resolve Live 
is straightforward. This section describes the live grading workflow as it was designed to be used. 
Once you’re familiar with the capabilities of Resolve Live, you may find your own ways of working 
that are more in tune to the needs of your particular project.
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Getting Started

When working with Resolve Live on a new shoot, you should begin with an empty project and a 
new empty timeline, since the live grading workflow involves capturing live graded snapshots to an 
otherwise unoccupied timeline. One recommended way of organizing the live grades of a shoot is 
to create one new project per day of shooting. This way, snapshots captured during shoots using all 
24 hours of time-of-day timecode won’t conflict with one another. Also, separate projects can make 
it easier to use ColorTrace to copy grades from your live grade snapshots to the camera original 
media you’ll be creating dailies from, eventually.

Tip: Having an empty Media Pool and timeline doesn’t mean you can’t install useful LUTs and pre-
import reference stills and saved grades to the Gallery, as these can be valuable tools for expediting 
your on-set grading.

Once you’ve created your new project, you also need to choose the disk where all snapshots you 
take will be saved. By default, snapshots are saved on the scratch disk at the top of the Scratch Disks 
list in the Media Storage panel of the Preferences window. They’re automatically saved in a folder 
named identically to the current project.

Going Live

Once you’ve created your day’s project, you need to turn on Resolve Live to begin work.

To turn on Resolve Live:

1.	 Open the Color page.

2.	 Choose Color > Resolve Live On/Off (Command-R).

	 A red Resolve Live badge at the top of the Viewer indicates that Resolve Live is turned on, and 
the transport controls are replaced by the Freeze and Snapshot buttons.

A red badge shows that Resolve Live is active and showing incoming video from the camera
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At this point, the video from the connected camera should become visible within the Viewer, 
the camera timecode should be displayed in the Viewer’s timecode window, and you can begin 
using all of the capabilities of the Color page to begin grading whatever is onscreen, including 
Gallery split-screens for matching and comparing. The current color adjustments in all palettes are 
automatically applied to both the image in the Viewer and the video output to an external display 
(if there is one). 

While Resolve Live is on, much of Resolve’s non-grading functionality is disabled, so when you’re 
finished, be sure to turn Resolve Live off.

To turn off Resolve Live, do one of the following:

>> Click the Exit button at the bottom left-hand corner of the Viewer.

>> Choose Color > Resolve Live On/Off (Command-R).

Using Freeze

In Resolve Live mode, the Freeze button (it looks like a snowflake) freezes the current incoming video 
frame, so you can grade it without being distracted by motion occurring during the shoot. When 
you’ve made the adjustment you need, you can unfreeze playback in preparation for grabbing a 
snapshot.

To freeze incoming video:

>> Click the Freeze button (that looks like a snowflake).

The snowflake button freezes the image so you can grade a particular frame

Using Snapshot

Once you’re happy with a grade, clicking the Snapshot button saves a snapshot of the current still 
in the Viewer, the incoming timecode value, and your grade into the Timeline. Snapshots are simply 
one-frame clips. They use grades and versions just like any other clip. In fact, ultimately there’s no 
difference between the timeline created by a Resolve Live session and any other timeline, other 
than that the Resolve Live timeline only has a series of one frame clips, which appear in the Timeline 
of the Edit page as s series of 1-frame stills.
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To save a Snapshot, do one of the following:

>> Click the snapshot button (with a camera icon).

>> Choose Color > Resolve Live Snapshot (Command-Option-R).

The snapshot button saves a frame and the grade for future use

For example, you may begin the process of building and refining a grade for a particular scene 
during an unrecorded run-through. Then, once shooting starts, you may take snapshots of each 
shot’s slate, and then of significant takes that follow, tweaking where necessary and in conjunction 
with the DP’s feedback once things get going. New camera setups may require further tweaks, 
which you’ll save as snapshots for those shots, and as you work in this way you’ll find yourself building 
up a timeline of snapshots that correspond to that day’s shoot.

As you work, keep in mind that you must temporarily turn Resolve Live off in order to open a grade 
from a previous snapshot in the Timeline, in order to use it as a starting point for another shot. You 
can also save grades into the Gallery.

Using Resolve Live Grades Later

Since each Snapshot you capture during a Resolve Live session contains timecode that was captured 
from the camera, grades from snapshots with timecode that overlaps recorded camera original 
media can be synced using ColorTrace when the time comes to start making dailies.

Keep in mind that snapshot grades correspond to the monitored output of the camera during the 
shoot. If you shot using a raw format, you’ll need to use whatever in-camera debayering settings 
were used for monitoring during the shoot if you want the grades from your snapshots to produce 
the same result.

For more information on using ColorTrace, see Chapter 9, “Preparing and Conforming Projects.”
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Using LUTs in Resolve Live Workflows

Many on-set workflows use Look Up Tables (LUTs) to calibrate displays, normalize log-encoded 
media for monitoring, and preview looks in the video village to test how the current lighting scheme 
will work with the intended grade. You can apply LUTs using the Look Up Table panel of the Settings 
window, or within a grade as part of a node tree.

However, you can also export LUTs, if necessary for monitor previewing, using an HDLink 
connected in-between the camera’s video output and a display, or using a display capable of 
loading LUTs internally.

If you’re exporting LUTs using the Generate 3D LUT command of the Thumbnail timeline’s contextual 
menu, you should limit yourself to using only Primaries palette and Custom Curves palette controls 
within a single node. These are the only grading controls that can be mathematically converted into 
a LUT. For more information on exporting LUTs, see “Exporting Grades and LUTs” in Chapter 13, 
“The Gallery and Grade Management.”

Note: DaVinci Resolve exports LUTs in the .cube and .cube_shaperlut formats. Both are DaVinci-
developed LUT formats, with no relation to the Iridas SpeedGrade .cube format.



12
Advanced Color Features
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This chapter covers more advanced features found in the Color page, including how to create 
secondary adjustments to manipulate specific features in an image using Qualifiers and Power 
Windows, and how to use motion tracking to make Power Windows follow along with the motion 
of subjects and the camera. Additional features are also covered such as image stabilization, blur, 
sharpen, and mist effects, transforms, stereo grading, and window burn insertion. A section on 
advanced node structures show you how to combine Color page effects in even more detailed 
ways. Lastly, a section on keyframing describes how to create animated effects.

Advanced Color Features

Secondary Qualifiers� 587

Adding a Secondary Operation to the Node Editor� 588

Basic Qualification: Sampling the Image� 590

Using Highlight to See What You’re Isolating� 594

Qualifier Parameters� 595

Matte Finesse Controls� 598

The Many Ways to Invert a Key� 601

Combining Qualifiers and Windows� 601

Power Windows� 602

Adding Nodes with Windows� 603

The Window Palette Interface� 604

Managing Windows� 606

Showing and Hiding On-Screen Window Controls� 606

Window Transform Controls� 607

Drawing a PowerCurve� 609

Resetting the Window Palette� 611

Combining Power Windows With the Mask Control� 611

Copying and Pasting Windows� 613

Saving Window Presets� 613

Using Windows and Qualifiers Together� 614

Window Tracking and Image Stabilization� 617

Window Tracking� 617

Combining Tracking and Dynamic Keyframes� 620

Controls in the Window Tracker Palette� 620

Object Tracking Workflows� 625

Image Stabilization� 637

Using Stabilization to Create a Match Move� 641



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

587

ADVANCED COLOR FEATURES12

Tracking and Stabilizing with the DaVinci Control Surface� 644
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Secondary correction describes isolating a specific part of the image, or a specific subject, using 
a key. Keys in Resolve are grayscale images that define which areas of the picture you want to alter 
(in white) and which parts of the picture you want to leave alone (in black). Keys are generated 
either using the controls in the Qualifier palette, by using a Power Window, or by importing an 
external matte.

This section covers the use of the Qualifier palette, which lets you pull a Chroma or Luma key, with 
which to isolate the correction you need. The Qualifier controls are fast and flexible when you 
need to isolate an irregularly shaped subject with a distinct range of color or lightness. Since you’re 
generating a key by sampling the image, there’s no need for tracking or keyframing, so in the right 
situation Qualifiers can be your fastest solution. In the following example, the client likes the slightly 
cool treatment overall, but wishes that the skin tones were a little more vibrant. This is exactly the 
sort of situation where Qualifiers can help out. Adding a second node, and using the HSL Qualifier 
to isolate the face makes it relatively simple to add color exactly where you want it.

Top–The image with a simple primary correction. Middle–Adding a second node and using HSL Qualification to  

isolate the skin tones. Bottom–The final adjusted image.

Secondary Qualifiers
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Just about every control in the Color page can be limited using qualification. This makes the 
Qualifier palette a jack-of-all-trades tool with 101 uses. A few practical examples include keying a 
red element that’s too intense for broadcast to darken it or desaturate it, keying a range of green 
foliage to shift its hue to a more attractive color, keying an actor’s skin tone in a commercial to apply 
some selective softening to it, or keying a range of sky to add blue.

Adding a Secondary Operation to the Node Editor

Any node can be switched between functioning as a primary correction, where the adjustments you 
make affect the entire image, and a secondary correction, where you’re adjusting a specific element 
in the scene. The only difference is that nodes being used for secondary corrections are limited 
using a Qualifier, Power Windows, or an external matte.

If you’re planning to add a secondary operation to the current grade, you’ll need to first add another 
node in the Node Editor. With regard to HSL qualification, it’s important to understand that you’ll be 
sampling the YRGB values being fed to that node from any previous nodes in the tree. That means 
that the state of the image being fed to a node you’re qualifying affects the key you’re pulling.

For example, if the image coming out of Node 1 is well saturated and has a neutral color balance 
with a wide range of colors, but the image coming out of Node 2 applies a low saturation, 
monochromatically orange color wash, you may find it more difficult to pull a detailed key from 
Node 2 than you would from Node 1. 

Choosing your battles–the image coming out of Node 1 will be easier to key then the highly stylized image coming out of Node 2

This is important because you have the flexibility of determining from what image you want to 
try pulling a qualified key. By connecting the node that’s outputting the best YRGB image for the 
key you’re trying to create to the node you’re qualifying, you can control what you’re keying. This 
flexibility is described in more detail in Chapter 6, “Manipulating and Combining Keys.”
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The DaVinci Resolve Qualifier palette interface is straightforward. To the left, graphical controls 
above numeric parameters let you manually adjust what ranges of each color component contributes 
to the key you’re creating. To the right, Blur and Shrink parameters let you alter the key, while a set 
of Selection Range tools below lets you define a key by sampling pixels of the image, either using 
the pointer, or by using the fourth trackball of a DaVinci control surface.

Qualifier palette with HSL controls selected

The default qualification mode is the HSL Qualifier, which uses three color components, hue, 
saturation, and luma, to define a key. However, you can also use the RGB or LUM (Luma) qualification 
modes to pull keys using other combinations of color components. The LUM qualifier mode, in 
particular, lets you make targeted adjustments to specific ranges of image lightness. This is a 
technique employed by many colorists to alter color temperature within a specific range of image 
highlights or shadows.
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Basic Qualification: Sampling the Image

The most straightforward way to use image qualification is to sample the image in the Viewer. A set 
of four controls let you sample the image in different ways.

>> Sample Eyedropper: The first control you use whenever sampling the image. It defines the 
initial range of the qualification; you must use this tool before any of the others. Clicking 
once with this tool selects a single pixel value, while clicking and dragging selects a range 
of image values that add together.

Color Picker button

>> Add/Subtract Color Range: These two controls let you add areas of the image to, or subtract 
them from, the currently selected inner range of values that define the core of the key. As 
with the eyedropper, you can click on single pixels, or drag over a range of color.

Add and Subtract color buttons

>> Add/Subtract Softness: These two controls let you redefine the softness that transitions 
from the inner range of the key, falling off towards the outer edge of the key. Just like the 
other controls, you can click on single pixels, or drag over a range of color.

Add and Subtract qualifier softness

Note: When you select one of the sampling controls, it remains selected until you select another 
sampling control. If you select another clip in the Timeline, then click in the Viewer to sample a key 
and nothing happens, make sure that you select the Eyedropper control in the Qualifier palette.

If you’re working with the Resolve on-screen interface, the easiest way to qualify a subject is to use 
the pointer in conjunction with the sampling controls.
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Example image to qualify

To sample a subject in the Viewer for qualification:

Eyedropper in the OSD menu of the viewer

1.	 Open the Qualifier palette, and click the eyedropper.

2.	 Either click a pixel of the subject you want to sample, or click and drag across a range of pixels 
within that subject.

Picking to qualify the ocean

3.	 To see the key you’re creating as you work, click the Highlight button. The area of the image 
you’re isolating appears in color, while the area of the image being excluded appears 
solid gray. 
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Viewer image with highlight turned on, isolated region appears in color, omitted region appears gray

	 Even though the highlight obscures the rest of the image, this doesn’t prevent you from using 
the sampling tools to select pixels you can’t see.

4.	 To subtract from the inner range of the key you’re creating, click the minus Color Range control, 
and click or drag across the portion of the keyed image that you’d like to exclude.

5.	 To add softness to the outer range of the key you’re creating, click the plus Softness control 
and then click or drag across the portion of the image you’d like to include as a soft edge.

6.	 When you’re finished, click the Highlight control to turn the highlight off, and make whatever 
adjustment you need. In this example, the saturation has been raised and the color balance 
changed to make the adjustment obvious.

Increased saturation of the qualified blue shirt

If you have a DaVinci control surface, you can use the fourth trackball to sample the image, referring 
to either the Viewer or the display connected to the video output of your DaVinci workstation.
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To sample a subject using the DaVinci control surface:

1.	 Press VECTORS on the T-bar panel to open the Qualifier palette, which defaults to the HSL 
Qualifier controls.

2.	 Press CURSOR (the third button above the fourth trackball) on the Center panel, to display the 
small cursor crosshairs in both the Viewer and the video output display.

3.	 Use the fourth trackball to position the cursor over the subject you want to sample, and 
press the leftmost of the three buttons appearing underneath the fourth trackball to sample 
the image.

4.	 Press HILITE on the Transport panel to turn on the highlight so you can see the key you’re 
creating, and then use the knobs at the top of the Center panel to adjust the range and 
softness parameters to obtain the most accurate key for your purposes.

Qualifier Presets

There is a set of HSL Qualifier presets, or Six Vector presets, that you can use to isolate automatically 
a predefined wedge of color (green, blue, red, magenta, yellow, or cyan) or chroma intensity (chroma 
light, chroma dark, or both). These presets are available either from the Color > Presets menu, or 
from the DaVinci control surface.

Selecting one of these presets automatically sets the HSL Qualifier to the corresponding range or 
color or lightness. Afterwards you can continue modifying the HSL Qualifier to suit your purpose.

To choose a Six Vector preset from the DaVinci control surface:

1.	 Press the PRESETS soft key on the Center panel. The Center panel’s soft keys update with all 
the available lightness and color presets.

2.	 Press the soft key corresponding to the preset you want to use. The HSL Qualifier updates with 
the new settings, and the Center panel goes back to the main page of soft key controls.
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Using Highlight to See What You’re Isolating

The Highlight control lets you overlay a representation of the key you’re creating over the current 
image in the Viewer. Overlays are also mirrored to your video output, so they’ll show up on an 
external display as well, in the event that you’re hiding the on-screen Viewer.

There are two types of highlights with which you can evaluate a qualification you’re creating. Each 
is useful for different tasks.

>> Flat-Gray: The default highlight that Resolve uses shows the selected portion of the image 
with the original colors, and the unselected portion of the image with a flat gray. It is useful 
for seeing the subject you’re isolating even while you’re adjusting the Qualifier controls, 
which lets you also see the color or contrast adjustments you’re applying at the same time.

Oranges qualified and highlighted

>> High-Contrast: Pressing Option-Shift-H, you can show what’s called a “high-contrast” 
highlight, which should be familiar to you if you’ve used other color correction applications 
and plug-ins; it’s a more typical display wherein the selected portion of the image is white, 
and the unselected portion of the image is black. The high-contrast highlight is useful in 
situations where you need to eliminate holes in a key, or evaluate how “chattery” a key is 
since irregularities are easier to spot when divorced from the original image.

Hi-Contrast B&W highlighting
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To enable or disable a flat-gray highlight, do one of the following:

>> In the Qualifier palette, click the Highlight control.

>> Choose View > Highlight (Shift-H).

>>On the T-bar Panel of the DaVinci control surface, press HILITE. To enable or disable a high-
contrast highlight, do one of the following:

>> Choose View > Highlight BW (Option-Shift-H).

>>On the T-bar panel of the DaVinci control surface, press SHIFT DOWN and then press HILITE.

To make high-contrast black and white the default highlight:

1.	 Open the Settings window.

2.	 Open the General Options and turn on “Mattes display high contrast black and white.”

3.	 Click Save.

	 The next time you click the Highlight control in the Qualifier palette, or press HILITE on the 
DaVinci control surface, the high-contrast highlight will display.

Using Highlight to Solo Nodes

There’s one other use of the Highlight control, and that’s to solo individual nodes in the Viewer and 
video out, rather then outputting the sum of the entire node tree. For example, if you’re trying to 
adjust a stack of nodes attached to a Parallel or Layer Mixer node, it’s difficult to see what you’re 
doing while adjusting one of the stack of nodes, because only the final result is being output. 

However, if you turn on Highlight with no key being generated, then only the currently selected 
node is output, making it easy to view just one node as you adjust it. Just make sure you turn 
Highlight off before moving on, or you may confuse yourself.

Qualifier Parameters

Each of the Qualifier modes has parameters that correspond to the relevant color components 
for that mode, with which you can identify a range and softness, similar to using the sample tools. 
These parameters can be edited as virtual sliders using the pointer, or you can modify them using 
the knobs of the DaVinci control surface.

HSL Qualification Controls

The HSL Qualifier is by far the most versatile mode of the Qualifier palette. It’s also the qualifier 
that’s easiest to understand, and the easiest to adjust by hand if you don’t feel the need to sample 
the image. By selecting range and softness for each of three different color components, hue, 
saturation, and luma, you can isolate a wide variety of colorful subjects, or ranges of image lightness 
and saturation.
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Oranges qualified and highlighted

One of the HSL Qualifier’s key strengths, and one of it’s most underutilized features, is that you can 
enable or disable each of the three HSL components using the Hue, Sat, and Lum checkboxes, 
found at the bottom left of each Qualifier range control. This lets you ignore specific color 
components, while focusing on others that are more important. For example, if you’re trying to 
isolate the saturated parts of an image, regardless of the hue or brightness, you can turn off the Hue 
and Lum qualifiers so that only Sat is used to sample the image.

Qualification with saturation only to isolate the most saturated portion of the picture
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The HSL parameters include:

>> Hue Center: Defines the center of the range of Hue being isolated.

>> Hue Width: Defines the width of the range of hue being isolated. Widening or narrowing 
this parameter widens and narrows the range of hue about the current Hue Center.

>> Hue Soft: Widens or narrows the falloff at both sides of the currently selected range of hue.

>> Hue Symmetry: Lets you selectively alter the angle of Hue Soft falloff at either the right or 
left side. Lowering this parameter makes the softness to the right of the hue range grow 
steeper. Raising this parameter makes the softness to the left of the hue range grow steeper.

>> Sat Low/High: Two parameters let you define the upper and lower range of saturation 
being isolated.

>> Sat Low Soft/High Soft: Two parameters let you define the upper and lower softness falling 
off outside the current range of saturation.

>> Lum Low/High: Two parameters let you define the upper and lower range of luma 
being isolated.

>> Lum Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of luma.

RGB Qualification Controls

The RGB Qualifier mode lets you isolate range and softness in the Red, Green, and Blue channels 
of an image. While this is not necessarily an intuitive way of manually creating a qualification from 
scratch, it can provide a different way of isolating potentially trickier ranges of the RGB color space. 

If you start by sampling the image, then you can widen and narrow each color channel’s isolated 
range of values. In some cases, you may find it’s faster to isolate a specific range of continuous color 
by adjusting these controls.

RGB qualification controls
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The RGB parameters include:

>> Red Low/High: Two parameters let you define the upper and lower range of the Red channel 
being isolated.

>> Red Low Soft/High Soft: Two parameters let you define the upper and lower softness falling 
off outside the current range of red.

>> Blue Low/High: Two parameters let you define the upper and lower range of the Blue 
channel being isolated.

>> Blue Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of blue.

>>Green Low/High: Two parameters let you define the upper and lower range of the green 
channel being isolated.

>>Green Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of green.

Luma Qualification Controls

The Luma Qualifier mode simply pulls a key from the Luma channel all by itself. It’s identical to the 
HSL qualifier with H and S turned off. This single-component keyer is more useful than you might 
think; it’s a common technique to isolate a range of highlights, midtones, or shadows throughout 
the image to alter the color temperature selectively.

Also, keep in mind that the luma component is the sharpest keyable component when you’re 
working with heavily compressed video. Keys that are noisy or chunky with HSL qualification may be 
sharper if you just use the Luma Qualifier, although you won’t be able to be chromatically specific.

The Luma Qualifier has four parameters:

>> Lum Low/High: Two parameters let you define the upper and lower range of the luma 
component being isolated.

>> Lum Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of luma.

Matte Finesse Controls

After you’ve used the sample controls and Qualifier parameters to create the most useful key for 
your purposes, you may find that it has problems that cannot be overcome easily by the available 
adjustments. Issues such as chattery edges, holes, or noisy bits can sometimes be easily fixed 
using the Matte Finesse controls. These controls filter the output of the Qualifier controls and are 
adjustments that are made to the matte itself, so they may work well in some instances, and poorly 
in others, depending on what you’re trying to do.
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Denoise

Raising the Denoise parameter selectively reduces the noise in a key, getting rid of stray areas of 
qualification and filling small “holes” in a difficult matte. Raising Denoise excessively can result in 
a soft spread around the edges of the matte. The range is 0 (minimum) to 100 (maximum), with 0 
being the default setting.

Before/After raising Denoise

Black Clip

Raising Black Clip applies a “lift” adjustment such that translucent areas of the matte (gray areas 
when viewing a high-contrast highlight) are pushed towards black. The range is 0 to 100, with 0 
being the default setting.

Before/After raising Black Clip

White Clip

Lowering White Clip applies a “gain” adjustment such that translucent areas of the matte (gray 
areas when viewing a high-contrast highlight) are pushed towards white. The range is 0 to 100, with 
100 being the default setting.

Before/After lowering White Clip
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Blur Radius

In small amounts, blurring a key does well to take the edge off problem edges. However, blurring a 
key can also feather the edges of a key past the border of the subject you’re keying, with the result 
being a visible “halo” around your subject depending on the adjustment you’re making. The range 
is 0 to 2000, with 0 being the default. With such a large maximum blur radius, combined with the 
capabilities that the In/Out Ratio provides in customizing the direction of spread, you can turn some 
pretty precarious mattes into surprisingly smooth and useful results.

Tip: If haloing is a problem, you can try adjusting the In/Out Ratio parameter, or you may want to 
consider using the Qualifier Softness parameters to feather the edges of the key, instead. 

Using the blur parameters to soften the edges of a key

In/Out Ratio

Controls whether the “Blur Radius” is applied equally to the inside and outside of the edge of the 
matte (zero), applied only within the matte (negative values), or applied only outside the matte (positive 
values). Using In/Out Ratio can help eliminate fringing when using the Blur Radius parameter.

(Left) In/Out Ratio lowered so blurring ends at the edge of the matte and feathers inward,  

(Right) In/Out Ratio raised so that blurring starts at the edge of the matte and feathers outward

However, you can also use In/Out Ratio even in situations where no Blur Radius is applied at all. 
Raising In/Out Ratio will fill in small black holes in the matte, while lowering In/Out Ratio below 0 will 
eliminate speckling by pushing small white bits of the matte towards black.

(Left) In/Out Ratio controls lowered to expand holes in the Matte,  

(Right) In/Out Ratio controls raised to fill in small black holes in the matte



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

603

ADVANCED COLOR FEATURES12

The Many Ways to Invert a Key

Sometimes, you’ll need to isolate a subject or range of values in an image, and then make a change 
to everything else. One way to do this is to add an Outside node after the node in which you’ve 
created the key. This lets you make one set of adjustments to what you’ve keyed, and another set of 
adjustments to everything outside the key.

If you just need to make a simple adjustment, you can invert the key from within the Qualifier palette. 
However, there are three other ways to invert a key.

>> The Qualifier Invert button: Clicking this control simply inverts the key being generated by 
all of the controls within the Qualifier palette.

>> Key Palette Input Invert: The Qualifier Invert control within the Key palette provides another 
control with which you can invert the key that’s generated by the Qualifier palette.

>> Key Palette Output Invert: The Output Invert control within the Key palette is notable 
because it inverts the sum of all keys applied within that node. For example, if you’re using 
a Qualifier in conjunction with a Window, the two invert controls mentioned previously 
will only invert the Qualifier key; the Window key remains unaffected. However, using the 
Output Invert control inverts the overall combination of the Qualifier key and the Window, 
all together.

Combining Qualifiers and Windows

This is covered in more detail shortly, but if you create a key using one of the Qualifier modes, and 
you then add a Window, the final key that’s output by that node is limited to the intersection of the 
Qualifier key and the Window. This makes it easy to use a Window to “garbage matte” out bits of a 
key that you don’t want, that can’t be eliminated by further adjustment of the Qualifier controls.

(Left) The woman’s skin tone is too close to other elements in the scene.  

(Right) A Circular Power Window is used to further isolate the woman being isolated.
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Power Windows are another way of making secondary correction, being essentially shapes you can 
use to isolate regions of the image. Different controls let you use oval, rectangular, polygonal, or 
custom curved shapes. Because you can isolate regions of the image by drawing, Power Windows 
produce exceptionally clean results, with edges that can be precisely positioned and feathered to 
achieve a variety of effects.

Before/After PowerCurve Power Window isolates the sky area for a targeted correction

Power Windows are excellent when what you need to adjust can be encompassed within a clearly 
defined geometrical area. For example, the oval of a person’s face, the front of a car, or a wide 
expanse of sky are all good candidates for windowed adjustments. A drawback of windows can be 
that they must be animated to follow whatever subject they’re isolating. Fortunately, this is where 
DaVinci Resolve’s powerful tracker comes in, making it easy to track Power Windows quickly and 
accurately to follow along with the subject being isolated.

Circular Power Window to focus attention to the skin

Power Windows
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DaVinci Resolve makes it easy to combine multiple Power Windows in different ways, to intersect 
with one another and create even more sophisticated shapes. For example, multiple windows can 
be added together, or one window can be used to cut out part of another window, which saves you 
from the need to make complicated keyframing operations to animate that window’s shape.

Multiple Windows combined to isolate and mask the image

This section covers the use of Power Windows, how to create and modify them, as well as how to 
combine multiple windows, and combine windows and qualifiers to create highly specific isolations.

Adding Nodes with Windows

As with qualifiers, you must first add a node to a grade’s node tree before you begin windowing a 
correction. This is because all of the windows within a particular node work together to limit that 
node’s grade. As a reminder, any node can be changed from a primary operation that affects the 
entire image, to a more targeted secondary operation, simply by turning on a window, using a 
qualifier, or enabling an external matte.

Serial nodes showing the window on Node 2

If you don’t create a new node before creating a window, you’ll discover you’ve inappropriately 
changed a primary correction into a secondary correction. If you create a new serial node, you’ll 
then need to use the controls found within the Window palette to turn on a window to customize 
for your purposes. However, there are also a set of commands you can use to add serial nodes with 
a window already turned on, saving you a few clicks or button presses in the process.
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To add a new node with a window already turned on:

>> Choose Nodes > Node + CPW (Option-C), or press the button of the same name on the 
T-bar panel of the DaVinci control surface to create a new serial node with a circular window.

>> Choose Nodes > Node + LPW (Option-Q), or press the button of the same name on the 
T-bar panel of the DaVinci control surface to create a new serial node with a linear window.

>>Choose Nodes > Node + PPW (Option-G), or press the button of the same name on the T-bar 
panel of the DaVinci control surface to create a new serial node with a polygonal window.

>>Choose Nodes > Node + PCW (Option-B), or press the button of the same name on the T-bar 
panel of the DaVinci control surface to create a new serial node with a PowerCurve window.

When you add a node with a Power Window, the Window palette automatically opens up, ready 
for editing.

The Window Palette

The Window palette is divided into three sets of controls: the Window list, the Presets, and the 
Transform and Softness controls.

The Window Palette Interface

Once you’ve created a node with which to apply a Power Window correction, you need to open the 
Window palette if it hasn’t been opened already.

To open the Window palette:

>> Click the Window palette button.

>> Press the WNDWS button on the T-bar panel of the DaVinci control surface.
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The majority of the Window palette is occupied by the Window List, within which you can create as 
many windows as you need for the task at hand. There are five types of windows you can create, 
each of which has a different geometry. You can use these windows individually, or you can combine 
them to create even more complex shapes and interactions. The Window palette has four groups 
of controls that let you use these windows in different ways.

The Window palette Window list

>>Window List: A row of buttons at the bottom of this list lets you add new windows to this 
list, which you can then customize as necessary. Each window in the list exposes an On/
Off button, shape type, invert button, mask button that governs how that window interacts 
with the other windows that are currently enabled (adding to other nodes by default, 
or subtracting from other nodes in Mask mode), and a Layer Name field you can use to 
identify what each window is for.

>> Transform parameters: Controls the overall size, aspect ratio, position, and rotation of the 
currently selected window. 

>> Softness parameters: Controls the edge softness of the currently selected window. Different 
window shapes have different softness options.

>>Window Preset pop-up menu: A menu to which you can save presets of individual or 
multiple windows for easy recall later.

>>Option pop-up menu: The Option pop-up menu has commands for resetting windows, 
deleting windows, saving and managing window presets, and copying and pasting 
track data.

There are five types of windows you can create:

>> Circular: An oval that can be shaped, sized, and feathered to solve an amazing number 
of problems.

>> Linear: A four-point shape that can be edited into any kind of rectangle or trapzoid you 
might need. In addition to the center and corner controls, you can also drag any of the four 
sides to change the shape.

>> Polygonal: A four-point shape that can be expanded with additional control points to create 
complex sharp-cornered polygonal shapes.

>> PowerCurve: A Bezier drawing tool that you can use to create any kind of shape, curved, 
polygonal, or mixed, that you require.

>>Gradient: A simple two-handled control for dividing the screen into two halves, with options 
for the center, angle, and feathering of the shape. Good for fast sky adjustments.
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Managing Windows

To manipulate a window, first you need to create the type of window you want to use, or if you’ve 
got a group of windows created already, you need to select the window you want to work on.

Methods of creating and selecting windows:

>> To create a new window: Click the Create Window button (at the bottom of the Window list) 
that corresponds to the window you want.

>> To create a new window using the DaVinci Control Surface: Press WNDOWS on the T-bar 
panel, then use the UP and DOWN buttons on the Trackball panel to select the window 
type you want to apply, and press ADD.

>> To select a window using the on-screen controls: Click anywhere within a window to select 
it in the Viewer.

>> To select a window from the Window list: Click the Shape icon button corresponding to the 
window you want to select. 

To delete a window you no longer want: 

>> Select a window, then choose Delete Selected Window from the Option pop-up.

To reset one or all windows:

>> To reset one window to its default shape: Select a window, then choose Reset Selected 
Window from the Option pop-up.

>> To reset all windows: Choose Reset All Windows from the Options pop-up.

Showing and Hiding On-Screen Window Controls

When you open the Window palette, the Viewer goes into Power Window mode. Enabling a window 
makes that window’s on-screen controls appear within the Viewer, and are mirrored to video out so 
you can see the window controls on your external display. If you like, you can change how and where 
the on-screen controls appear.

To choose whether on-screen controls are mirrored to video out, or disabled:

>> Choose an option from the View > Window Outline submenu.

There are three options:

>>Off: Hides the window outline on both the external display and the Viewer.

>>On: The default, shows the window outline on both the external display and the Viewer.

>>Only UI: Hides the window outline on your external display, but leaves it in the Viewer.

To show or hide window on-screen controls using the DaVinci control surface:

>> Press SHIFT UP and then DISPLAY/CURSOR, above the fourth trackball on the Center panel.
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This command is a three-way toggle. The first use of this command hides the window outline 
on your external display, but leaves it in the Viewer. The second use of this command hides 
the window outline on both the external display and Viewer. The third use of this command 
shows the window outline on both the external display and Viewer.

Window Transform Controls

Windows have transform parameters that are similar to those found in the Sizing palette. These 
parameters let you alter the window, affecting all of its control points together.

Window transform controls

>> Size: Scales the entire window up or down. 50.00 is the default size.

>> Aspect: Alters the aspect ratio of the window. 50.00 is the default value, larger values make 
the window wider, and smaller values make the window taller.

>> Pan: Repositions the window along the X axis. 50.00 is the default position, larger values 
move the window to the right, smaller values move the window to the left.

>> Tilt: Repositions the window along the Y axis. 50.00 is the default position, larger values 
move the window up, smaller values move the window down.

>> Rotate: The default value is 0. Increasing this parameter rotates the shape clockwise, 
decreasing this parameter rotates the shape counterclockwise. 

>>Opacity: Lets you vary the transparency of an individual window’s contribution to a 
node’s key.

The transform parameters also correspond to onscreen controls found in the Viewer, which can be 
manipulated directly using the pointer.
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Manipulating the window position on the Viewer

While many of the on-screen controls correspond to parameters within the Window palette, 
some on-screen controls, such as the control points that govern reshaping linear, polygonal, and 
PowerCurve windows, are only adjustable via the pointer.

On-screen controls for window transforms:

>> To select a window: Click on one of an arrangement of many windows to select it, making 
that window’s controls active.

>> To reposition a window: Drag anywhere within the window’s onscreen control. Window 
position corresponds to the Window palette’s Pan and Tilt parameters. For a Gradient 
window, drag the center control point.

>> To resize a window while locking its aspect ratio: Drag one of the four blue corner points out 
to enlarge, or inwards to shrink. This corresponds to the Window palette’s Size parameter.

>> To squish or stretch a window, altering its aspect ratio: Drag one of the blue top, bottom, 
left, or right control points. These adjustments correspond to the Window palette’s 
Aspect parameter.

>> To rotate a window: Drag the top inner blue rotate handle, in the middle of the window. For 
a gradient, drag the bottom arrow handle.

>> To change a window’s center of rotation: Command-drag the bottom inner blue rotate 
handle to a new location.

>> To alter window softness: Drag any one of the magenta softness handles. Different window 
shapes have different sets of handles, which correspond to the Softness parameters.

>> To reshape a linear window: Drag any of the green corner handles to corner pin the window, 
or drag one of the green top, bottom, or side handles to move an entire side segment of 
the window around.
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>> To reshape a polygonal window: Turning on a polygonal window reveals a simple green 
rectangle with four corner control points. Click anywhere on the surface of the rectangle to 
add additional control points with which to reshape the polygon, and drag any green control 
point to alter its shape. Polygonal windows are limited to a maximum of 128 control points.

>> To change the size and aspect of a PowerCurve or polygon: Command-drag any control 
point to freely resize the PowerCurve about the center point.

>> To remove control points from polygonal or PowerCurve windows: Middle-click the control 
point you want to remove.

Note: Removing a control point from a Polygonal window that has already been  
animated results in that control point abruptly popping on and off at the keyframes 
creating the animation.

Window Softness

Each type of window has different Softness parameters, depending on how adjustable that window is.

>> Circular: A single parameter, Soft 1, lets you adjust the uniform softness of the oval’s edge.

>> Linear: Four parameters, Soft 1-4, let you adjust the softness of each of the four sides of the 
linear window independently. Magenta softness control points on the top, bottom, left, 
and right let you adjust the softness of each side of the linear shape independently.

>> Polygon: Two parameters, Inside Softness and Outside Softness, let you adjust the overall 
softness of a polygonal window. There are no on-screen softness control points.

>> PowerCurve: Two parameters, Inside Softness and Outside Softness, let you adjust the overall 
softness of a PowerCurve. Using the on-screen controls, you can adjust the magenta inside 
and outside softness control points independently, creating any softness shape you need. 

>>Gradient: A single parameter, Soft 1, lets you adjust the uniform softness of the gradient 
window’s edge.

Drawing a PowerCurve

The PowerCurve window is the only window that doesn’t display any on-screen controls when it’s 
first turned on. Instead, you must click within the Viewer to add control points, drawing your own 
custom shape to isolate whatever region you want.
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PowerCurve window to isolate a car

Tip: Turning on the Viewer’s full-screen mode can make it easier to draw detailed shapes. You can 
also zoom into and out of the Viewer while you’re drawing, using either the scroll wheel of a mouse 
or by pressing Command-Plus or Command-Minus.

To draw a PowerCurve:

1.	 Turn on the PowerCurve window style control.

2.	 Click anywhere in the Viewer to start adding control points and drawing the shape you need. 

3.	 Click and drag to add and shape Bezier curves, or just click and release to add a hard angle.

4.	 To finish drawing and close the shape, click the first control point you created.

Methods of modifying a PowerCurve:

>> To add points: Click anywhere on a PowerCurve to add control points.

>> To reshape a PowerCurve: Drag any control point to a new location.

>> To resize a PowerCurve: Command-drag any control point to resize the whole shape. 
Vertical and horizontal sizing are not locked.

>> To move a PowerCurve: Drag anywhere within or just outside a PowerCurve to move it.

>> To symmetrically alter a Bezier curve: Drag any Bezier handle. The opposite handle 
automatically moves in the other direction.

>> To asymmetrically alter a Bezier curve: Option-drag any Bezier handle. The opposite handle 
stays in place while you drag the current handle. Once you’ve created an asymmetric pair 
of Bezier handles, they move together as one if you simply drag a handle. You need to 
Option-drag to change the angle.

>> To change a curve into a corner: Option-double-click any Bezier curve control point to 
change it to a sharp-angled corner point.
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>> To change a corner into a curve: Option-click any corner point and drag to pull out a Bezier 
handle, changing it to a curve.

Note: Corner points cannot be moved; dragging them always turns them into curves.

>> To remove points: Middle-click the control point you want to remove.

Note: Removing a control point from a PowerCurve that has already been animated results 
in that control point abruptly popping on and off at the keyframes creating the animation.

Resetting the Window Palette

The entire Window palette can be reset using the Option menu’s Reset command.

Combining Power Windows With the Mask Control

Adding multiple windows to a single node is an easy way to create composite keys. When combining 
windows, the Mask control defines whether one window adds to another window, or subtracts from 
that window.

In the following example, Circular and PowerCurve windows have both been created, and each 
window’s Mask control is also turned on (by default), resulting in both masks being added together 
so that the sunset look correction affects both the sky and the woman’s face.

The two images show the combination of the key mattes
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By turning the Mask control of the Circular window off, the Circular window is subtracted from 
the PowerCurve.

Turning off the Mask control of the Circular window

Now, the woman’s face is being protected from the aggressive sky treatment.

The two images show the result of subtracting the circular window
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Since windows can be individually tracked and keyframed, you can quickly set up complex 
interactions of windows to solve common problems you’ll encounter. For example, when you’re 
tracking a window to follow a moving subject that moves behind something in the frame, you can 
use a second window with Mask turned off to cover the object in front. Now, when the tracked 
window intersects the subtractive window, the correction will disappear along with the subject.

You can also use the Mask control to create more complex shapes than you can with a single window.

Mattes and mask used together to make complex shapes

Furthermore, once you reach the limits of what shapes you can create using the four available windows, 
you can combine multiple nodes containing multiple shapes and qualifiers using the Key Mixer. 

Copying and Pasting Windows

If there’s a particular window you’ve created that you want to either duplicate within the current 
node, or apply to another node, you can copy and paste an individual window’s shape from one 
item in the Window list to another.

Methods of copying and pasting Windows:

>> To copy a Window: Click any enabled Window in the Window list, then click the Window 
palette option menu and choose Copy Window.

>> To duplicate a Window: After copying a window, create another window of the same type 
that you copied, and then click the Window palette option menu and choose Paste Window.

>> To paste a Window to another node: Double-click or otherwise select another node, open 
the Window palette, choose the same type of window that you copied in the Window list, 
and then click the Window palette option menu and choose Paste Window.

Saving Window Presets

If you find there’s a particular window shape or combination of windows that you use frequently, you 
can save one or more windows as a preset for easy recall whenever needed. For example, if you’re 
working on a documentary within which you find you need to do a lot of face brightening, you can 
create preset face ovals for close-up, medium, and wide shots, to save you from having to customize 
a stock circular window for every single new shot. You can also save groups of windows together as 
a single preset, in order to reuse complicated multi-window shapes.
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Window presets are available from a group of Presets controls in the upper right-hand corner of the 
Window palette.

Methods of working with Power Window presets:

Controls for saving, applying, and deleting window presets

>> To save a window preset: Once you’ve created one or more windows you want to save, click 
the plus button, type a name into the resulting dialog, and click OK. That preset is now 
available in the Preset pop-up.

>> To recall a window preset: Choose a preset in the Preset pop-up, and it’s instantly applied. 
Recalled window presets overwrite whatever other windows were set up in that node.

>> To update an already saved preset: Recall a preset, change the resulting window(s), then click 
the Checkmark button to overwrite the current preset with the altered window arrangement.

>> To delete a window preset: Choose a preset in the Preset pop-up, and click the 
Trashcan button.

Once recalled, windows created by presets can be modified and tracked just like any other window.

Using Windows and Qualifiers Together

Another use of windows is to act as a “garbage matte” when used together with a qualifier. By 
default, when you use a window and qualifier together, a key is only output where both the window 
and qualifier intersect. This makes it easy to exclude unwanted parts of a key that are too difficult to 
eliminate by further refinement of the qualifier controls.

For example, the following qualification is intended to isolate the woman’s face, but some of the 
similarly colored wood and sky in the background is also included.

Instead of driving yourself crazy trying to eliminate the unwanted parts of the key by modifying 
the current qualification, which is doing a great job of isolating the skin tones, you could instead 
use a window to isolate her face, excluding everything outside the window, and simplifying your 
job considerably.
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A qualified image with highlight on

If she moves, then you can simply track the window to follow. Simple tracking is covered later in 
this chapter.

Now with additional Power Window isolation

Furthermore, you can use the window’s Invert control to do the reverse, excluding all qualified portions 
of the key inside the window, and including all qualified portions of the key outside the window.

If you need to build more complex qualifier/window combinations than this, you can add more 
windows, or you can use multiple qualifiers and windows with the Key Mixer node, which is discussed 
later in this chapter.
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Manipulating Windows Using a Control Surface
Window shape and position can also be manipulated using the DaVinci control surface. All Windows 
controls are located on the T-bar panel, except for the ADJ WINDOW button above the fourth 
trackball of the Center panel.

To enable, mask, or disable a window:

1.	 Press WNDWS on the T-bar panel. The Window palette should appear.

2.	 Press the soft key that corresponds to the type of window you want to turn on, CPW (Circular Power 
Window), LPW (Linear Power Window), PPW (Polygonal Power Window), or PCW (PowerCurve 
window). The appropriate window controls should appear with an orange highlight.

3.	 Press the MATTE/MASK soft key to toggle among turning the window on, turning Mask on, 
and turning the window off.

To reposition a window using the Pan and Tilt knobs:

1.	 Press the unlabeled soft key at the bottom-right of the T-bar panel to toggle between the 
current knob mappings on the T-bar panel, and the PAN and TILT mappings.

2.	 Use the Pan and Tilt knobs to adjust the window’s position.

To reposition a window using the fourth trackball:

1.	 If necessary, press WNDWS on the T-bar panel to open the Window palette.

2.	 Press ADJ WNDW, above the fourth trackball on the Center panel.

3.	 Use the fourth trackball to reposition the window.

4.	 When you’re finished, press ADJ WNDW again to exit adjust window mode.

To alter a window’s Zoom, Aspect, or Rotation:

>> Use the ZOOM, ASPECT, and ROTATE knobs on the T-bar panel.

To alter a window’s softness, do one of the following:

>> For Circular and Linear windows: use the SOFTNESS knob on the T-bar panel.

>> For Polygonal and PowerCurve windows: press the unlabeled soft key at the bottom-right of 
the T-bar panel to toggle between the current knob mappings, and the PAN, TILT, INSIDE 
SOFT and OUTSIDE SOFT knob mappings.

To invert a window:

>> Press the INVERT soft key on the T-bar panel.
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The Tracker palette has two modes, available from the Palette menu. In Window mode, the tracking 
controls let you match the motion of a window to that of a moving feature in the frame. In Stabilizer mode, 
the same underlying technology is used to smooth or stabilize the motion within the entire frame.

Window Tracking

DaVinci Resolve has an incredibly simple, yet powerful, object tracker that allows you to track  
quickly and accurately any Power Window (Circular, Linear, Polygonal, PowerCurve or Gradient) to 
follow any moving feature. This avoids the need to use dynamic keyframes to manually animate a 
window’s position. 

In particular, you can use the tracker to match a window’s position to either foreground or background 
elements that move within the frame.

A Power Window tracking a woman’s face; the motion path resulting from the track is shown as the wiggly white line

Simple Tracking Using the Tracker Menu

The simplest way to track a feature using a Power Window is to use the commands found in the 
Playback menu. These commands include:

>> Track Forward (Command-T): Tracks a window to a feature from the current position of the 
playhead forward, ending at the last frame of a clip.

>> Track Reverse (Option-T): Tracks a window to a feature from the current position of the 
playhead backward, ending at the first frame of a clip.

>> Track Stop (Command-Option-T): Interrupts any track. This is useful for letting you cancel 
a long track that goes wrong (the Stop button of a control surface stops tracking as well).

Most window tracks are easy to accomplish using these three commands.

Window Tracking and Image Stabilization
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To track any Power Window to match a moving feature within the frame:

1.	 Move the playhead to the frame of the current shot where you want to begin (you don’t have 
to start tracking at the first frame of a shot).

2.	 Turn on any window, and adjust it to surround the feature you want to track.

	 Typically, you’ll have done this anyway, for example, framing someone’s moving face with a 
Circular Window to lighten their highlights.

3.	 To initiate tracking, do one of the following:

>> Choose Color > Track Forward (press T)

>> Choose Playback >Track Backward (Option-T)

>>On the T-bar panel of the DaVinci control surface, press OBJECT TRACK MODE, and then 
press either the TRACK FWD or TRACK REV soft keys on the Center panel.

Resolve automatically opens the Viewer page, places a series of tracking points within the window 
you’ve created, and performs the track from the current frame; forward to the last frame or backward 
to the first frame.

Resolve analyzes a cloud of tracking points that follow the vectors of every trackable group of 
pixels within the window you’ve created, and the results are fast and accurate. After tracking, the 
window you’ve placed automatically moves, resizes, and rotates to match the motion of the feature 
you’re tracking.

Object tracking in progress. Tracking points are automatically placed over trackable features of the image

Once a clip has tracking data applied to one of its windows, a small tracking icon appears within 
that clip’s icon in the Thumbnail timeline.
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A tracking icon in the top left corner of the Thumbnail timeline shows that clip has been tracked

If the track you’ve performed is unsuitable, you can reposition the window to cover a different area 
of the subject you’re trying to track, and initiate tracking again. New tracking data overwrites any 
previous tracking data applied to that window.

Once you’re satisfied with your track, you can continue to resize, reposition, or reshape the window 
being tracked. Tracking data is separate from the window transform parameters (which can be 
keyframed), so changes you make to a window offset it from the originally tracked path.

Simple Ways of Working With Existing Tracking Data

If there’s a portion of a shot that you haven’t tracked (for example, you started tracking at a later 
frame, or you ended tracking before the end of the shot), then the window you’re tracking remains 
wherever it was at the first or last frame that was tracked. If you want to fill in these gaps, you 
can always move the playhead to the first or last frame that was tracked, and then use the Track 
Backward or Track Forward command to track the rest of the frames in that shot.

Tips For Better Tracking

In situations where a feature changes shape in such a way as to confuse the tracker, you can try 
tracking a smaller part of the feature by using a smaller window. Once you’ve achieved a successful 
track, you can resize the window as necessary, and it will have no effect on the track that’s already 
been made.

Also, if you’re tracking a feature that moves behind something onscreen and disappears for the 
rest of the shot, there’s an easy way to avoid having an awkward window sitting in the middle of 
the scene. You can use dynamic keyframes to animate the Post Mixing Gain slider (in the Key tab of 
the Color page) to fade from the correction’s full strength of 1.0 down to 0, the value at which the 
correction disappears, along with the window itself.

Tracking One Frame at a Time

Holding the Option key down while clicking the track forward or track backward buttons in the 
Tracker palette lets you track a moving feature one frame at a time, making it easier to make 
adjustments to follow a difficult track when you’ve set tracking to Frame mode (by clicking the 
Frame button). 



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

622

ADVANCED COLOR FEATURES12

In Frame mode, you can move the window you’re tracking to more faithfully conform to troublesome 
motion as you’re moving one frame at a time through the track; manual changes to a window’s 
position will be stored frame-by-frame, rather than used to offset the entire tracked motion path as 
in Clip mode.

Copying and Pasting Tracking From One Window to Another

There will be plenty of times you’ll apply multiple windows to a single moving subject, such as a car, 
when you can use a single motion track for all the windows. Commands in the Option menu let you 
copy and paste track data from one window to another within the same node, saving time when you 
want several windows tracking together as one.

To copy track data from one window to another:

1.	 Open the Window palette, then select a window that has tracking applied to it (indicated 
by a tracking badge in the corner of the shape icon), and choose Copy Track Data from the 
Option pop-up. 

2.	 Select another window, and choose Paste Track Data from the Option pop-up.

Once you’ve copied track data from one window, you can paste it to as many other windows as  
you like.

Combining Tracking and Dynamic Keyframes

You can easily combine object tracking and keyframing to animate windows. For example, you’ll 
typically use object tracking to make a window follow the position and orientation of a moving 
feature, but you can add dynamic marks to the window track of the correction in the Color page 
with which to alter its size and shape to better conform to a feature’s changing form.

Controls in the Window Tracker Palette

Occasionally, you’ll run into a shot that doesn’t quite track well enough using the Tracker menu’s 
simple controls. In these cases, the Viewer page provides the complete set of object tracking 
controls that can be used to modify tracking operations in different situations.
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The Tracker palette

The Object Tracking Controls are divided into seven groups.

Tracking Type

The Tracker palette’s Option pop-up menu lets you choose between Window mode (for matching 
a window to the motion of a feature in the frame), and Stabilizer mode (for subduing unwanted 
camera motion, covered later).

Object Tracking

The Object Tracking controls provide the most basic tracking functions, some of which are mirrored 
within the Tracker menu.

Choose which type of transform you want to track before tracking

A series of four checkboxes let you turn on and off which transforms you’d like motion tracking to 
apply automatically to the window. These checkboxes must be selected before you perform a track 
in order to restrict the transforms that are used. 
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>> Pan: Enables tracking of horizontal position.

>> Tilt: Enables tracking of vertical position.

>> Zoom: Enables tracking of size.

>> Rotate: Enables tracking of orientation.

Note: Once tracking or stabilization has been done, disabling these checkboxes does nothing to 
alter the result. To make changes, you need to enable or disable the necessary checkboxes first, 
and then reanalyze the clip.

After you’ve defined the transforms you want to use for the track, the next three buttons let you 
proceed with the analysis of the subject being tracked.

>> Track Reverse button: Initiates tracking from the current frame backward, ending at the first 
frame of the clip.

>> Pause button: Stops tracking (if you’re fast enough to click this button before tracking is 
finished).

>> Track Forward button: Initiates tracking from the current frame forward, ending at the last 
frame of the clip.

Clip/Frame Controls

Two buttons let you set how manual adjustments to the position of tracked windows affect the 
overall track.

Selecting clip or frame to apply adjustments

>> Clip: The default mode, in which changes you make to the position of a window are globally 
applied to the entire track. For example, if you track a feature, and then move the window, 
the window moves along a motion path that’s consistently offset from the original track 
for the duration of the clip. Use this mode if you’re happy with the track, but you want to 
modify the window’s overall shape and position relative to the motion path it’s following.

>> Frame: In this mode, changes you make to the position of a window are only applied to the 
current frame. This mode is required for using the Interpolate commands explained below. 
Key Frame mode is also useful for making corrections to individual frames that were badly 
tracked, or for making manual, frame-by-frame adjustments to window position to cover 
untrackable sections.
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Interactive Mode Controls

The Interactive controls let you make manual changes to the automatically generated tracking point 
cloud that Resolve creates, so you can try different ways of obtaining better tracking results in 
challenging situations.

Interactive mode actions

>> Interactive Mode checkbox: Turns the Interactive tracking mode on and off. When you 
enter Interactive mode, you can manually alter the point cloud that Resolve uses to track 
the feature within the current window. You’ll then make your track while in Interactive mode.

>> Insert: Lets you add tracking points to whatever trackable features exist within a bounding 
box that you’ve drawn in the Viewer. Inserted tracking points are automatically placed 
based on trackable pixels in the image.

>> Set Point: Lets you use the cursor (using the DaVinci Resolve control surface), to manually 
place individual tracking points, one by one, with which to track a feature. If there is no 
trackable pixel group at the coordinates where you placed the cursor, a tracking point will 
be placed at the nearest trackable pixel group.

>> You must place at least two tracking points at different pixel groups to track rotation, and 
at least three to track zoom.

>> Delete: Eliminates all tracking points within a bounding box that you’ve drawn in the Viewer.

For more information, see “Using the Interactive Tracking Controls” later in this section.

Keyframes Interpolation Controls

The controls in the Interpolate section provide ways of dealing with occlusions, or objects that 
temporarily obscure features that you’re tracking. 

Keyframe Interpolation controls
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By marking a hole in the middle of two successfully tracked sections of a clip, you can interpolate a 
motion path to fill the gap so that the vignette moves smoothly from the point where tracking is lost 
to the point where tracking is found again. These features require the tracker to be in Frame mode 
(see the previous section).

>>Mark: Lets you mark the beginning and/or end of sections of track data that you want 
to overwrite with a linear interpolation from the window position at the first frame to the 
window position at the second mark. Once a clip has been marked in the Viewer, you 
can use the Rev, Fwd, or Between buttons to interpolate an animation motion path to fill 
the gap in tracking data. Viewer marks appear as vertical yellow lines in the tracking bar 
underneath the transport controls.

>> Between: After using the Mark button to specify both the beginning and end of a gap in 
tracking data, click Between to interpolate a motion path to fill the gap.

For more information, see “Using the Interpolate Commands” later in this section.

The Tracker Graph

The Tracker Graph provides a visual display of the tracking data that’s being analyzed. Each of the 
transform controls that can be tracked has an individual curve, which lets you evaluate each tracked 
parameter on its own.

Add keyframe and Interpolate between

A vertical slider to the right of the Tracker Graph lets you scale the height of the curve data within 
to make it easier to see it all within the graph. Above the Tracker Graph, a timeline ruler contains a 
playhead that’s locked to the playheads in the Viewer and Keyframe Editor.

You can draw a bounding box in the Tracker Graph with which to select a portion of one or more 
curves to delete sections of low-quality tracking data using the Clear Selected Keyframes command 
found in the Palette Options menu. To eliminate the current bounding box from the Tracker Graph, 
click once anywhere within the graph.
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Additional Commands in the Tracker Palette Options Menu

There are some additional commands located in the Palette Options pop-up menu.

>> Clear Track Data: Lets you delete tracking data for the current clip. When you click Clear 
Track Data, a Clear Tracking window appears with four checkboxes that let you choose for 
which window, within the current clip, to clear tracking data. By default, every checkbox is 
turned on.

>> Clear Selected Keyframes: When you drag a bounding box over parts of one or more 
curves in the Tracker Graph, this command lets you delete that part of the graph. This is 
useful when you want to eliminate sections of low-quality track data. Portions of curves that 
are cleared in this way have linear interpolation automatically applied to them, similar to if 
you used the Keyframes Interpolation controls.

>> Clear All Tracking Points: Clears the tracking points in the Power Window at the frame 
you are on.

>> Show Track: Turn this checkbox on to show the motion path produced by the tracking 
you’ve done.

>> Copy Track Data: Lets you copy track data from the currently selected window. Windows 
can be selected directly in the Viewer while the Tracker palette is open.

>> Paste Track Data: Pastes copied track data to the currently selected window. Windows can 
be selected directly in the Viewer while the Tracker palette is open.

Object Tracking Workflows

The next few examples illustrate how to use the Tracker palette’s controls in practical situations.

Using Interactive Mode to Manually Choose Tracking Features

Interactive Mode lets you manually remove or add tracking points to improve tracking performance 
in situations where the automatic image analysis in Resolve provides unsatisfactory results.

For example, you can delete tracking points within a window that correspond to overlapping features 
you don’t want to track. Suppose a car that you’re tracking drives by a sign that partially obscures 
the car. Without intervention, the PowerCurve that’s isolating the car will deform improperly when 
the car moves along and then away from the sign.

Using Interactive Mode, you can delete the tracking points that will overlap the sign you don’t want 
to track, improving the result.

To eliminate specific, unwanted tracking points from a track:

1.	 Open the Tracker palette.
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2.	 Turn on the Interactive Mode checkbox.

Selecting Interactive Mode

3.	 In the Viewer, drag a box around the tracking points you want to eliminate within the window, 
and click the Delete button. The points within the selection area are deleted.

Dragging a box around tracking points that need to be deleted

4.	 Click the Delete button. The points within the selection area are deleted.

Deleting tracking points
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Remaining tracking points ready to be used

5.	 Now, drag a box around the specific area where you’d like to add new tracking points, then 
click the Insert button.

6.	 When you’re finished tracking, click the Exit Interactive button.

Note: If you delete tracking points and then disable Interactive Mode without performing a new 
track first, Resolve goes back to using automatically placed tracking points.

In another interactive tracking example, you may sometimes run into situations where you want to 
eliminate all automatically placed tracking points altogether, placing your own in specific regions 
of the image.

To eliminate automatic tracking points, adding your own instead:

1.	 Open the Tracker palette.

2.	 Turn on the Interactive Mode checkbox.

Selecting Interactive Mode

3.	 In the Viewer, drag a box around all the tracking points in the window, and click the Delete 
button to eliminate all tracking points from the image.
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Selection box surrounding all tracking points

4.	 Click the Delete button to eliminate all tracking points from the image. 

Deleting tracking points

5.	 Drag a box around the specific area where you’d like to add new tracking points. In this case, 
you only want to track the top half of the woman’s face, since the bottom half is cut off by the 
fence posts.

Placing the selection box over the top of the window

6.	 Now, click the Insert Track Points button.	
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The Insert button of Interactive Mode automatically  

adds tracking points within the current bounding box.

	 New tracking points are automatically added to whichever features are appropriate for tracking 
within the box you’ve drawn.

Tracking with the remaining tracking points

	 Note: If no appropriate tracking features can be found, no points will be added.

While in Interactive Object Tracking mode you may also choose to add tracking points one by one.

To add a single tracking point:

1.	 Open the Tracker palette.

2.	 Turn on the Interactive Mode checkbox.

3.	 Using the DaVinci control surface, press the CURSOR button above the fourth trackball of the 
Center panel, and move the onscreen cursor to the detail of the image that you want to add a 
tracking point to.

4.	 Click the Set Point button, within the Interactive Mode controls of the Tracker palette. 

	 This adds a tracking point corresponding to the feature of the image that you clicked, and 
you’re ready to start tracking.
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Dealing With Occlusions When Tracking

Sometimes you’ll find that you need to deal with a gap in the useful tracking data. For example, 
objects in the frame that pass in front of the feature you’re trying to track cause gaps in the tracking 
information for a clip.

In situations where a subject being tracked becomes totally occluded by another object in the 
frame, there’s an easy method of interpolating to cover holes in the available tracking data. In the 
following example, the woman walks behind another fence post, this time one that’s taller then she 
is. The window tracking her face will become completely lost at this point, but interpolation will help 
to salvage this shot.

Original clip

To interpolate a motion path using the Keyframes controls:

1.	 Move the playhead to the first trackable frame of the moving feature you’re correcting, and 
create a Power Window that surrounds it.
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Adding the Power Window

2.	 Use Track Forward to track the feature as far as you can before it becomes obscured behind 
something else in the frame.

3.	 When the Power Window stops tracking the feature, stop the track.

The Power Window is obscured by the post

4.	 Open the Tracker palette.

5.	 Click the Frame radio button to put the Tracker controls into frame-by-frame adjustment 
mode. This is an important step.
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Selecting frame control

6.	 Move the playhead to the frame where the feature you’re tracking reappears from behind the 
occlusion, then drag the window so that it again overlaps the feature.

Moving the playhead and position the window

7.	 Use Track Forward to continue tracking the feature until the end of the clip. Alternately, you 
could have started from the end of the clip and used Track Reverse to track the feature as far 
as possible, if that’s easier.

	 Now that you’ve identified the gap in reliable tracking data for this clip, it’s time to set up 
the interpolation. 

Notice the gap in the tracking data where the window was behind the post
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8.	 Drag a bounding box over the portion of the curves in the Tracker Graph that fall between the 
good tracking data at the beginning and end of the shot.

9.	 Click the Tracker palette option pop-up menu, and choose Clear Selected Keyframes.

	 The portions of curves that you selected are deleted, and have linear interpolation automatically 
applied to them so that there’s no hole in the track data or the motion of the window, which 
now moves smoothly from the last outgoing frame of reliable tracking data to the first incoming 
frame of new reliable tracking data.

Using the Keyframes Interpolation Controls

Another common example of tracking occlusion is when the feature you’re tracking moves off 
screen; examples include a person walking, or a stationary feature that moves when the camera 
pans. While you can track the feature as long as it’s fully within the frame, once it starts to move 
off screen, you may lose your track, and the window will be stuck at an awkward position on screen 
even though the feature it’s supposed to be isolating is gone.
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1.	 Track the moving object until it goes offscreen. 

The beginning and end frames of a clip with a window tracking the face of an actor moving offscreen

2.	 Move the playhead to the last reliably tracked frame in the clip, which succeeds in following 
the actor pretty far offscreen, but it doesn’t go all the way off.

The last reliable frame of tracking

3.	 Click the Mark button. Keyframes appear on each of the curves in the Tracker Graph.
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Adding a tracking keyframe in preparation to interpolate between 

4.	 Click the Frame radio button to put the Tracker controls into frame-by-frame adjustment 
mode. This is an important step.

Selecting Frame mode

5.	 Now, move the playhead to the frame where the window should have moved all the way off 
screen, which in this case is the last frame of the clip. Once there, click the Mark button to add 
another set of keyframes.

Adding a tracking keyframe in preparation to interpolate between 

6.	 Back in the Viewer, drag the window to where it would be if it had followed along with the now 
offscreen actor.

Moving the window offscreen as if it had tracked the actor all the way
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7.	 With the poorly tracked area of the Tracker Graph isolated with keyframes, click the 
Between button.

Select Interpolate Between

	 A motion path is automatically interpolated to smoothly move offscreen, from the last reliable 
frame of track data, to the position you manually set in the last frame of the clip.

Tracks now show data between the keyframes

	 As a result, playing through the clip shows that the window now moves smoothly offscreen 
along with the feature you’re tracking.

Manually Repositioning Tracks

Since interpolation generates a smoothly linear motion path, it may not work if you’re tracking an 
irregularly moving feature that becomes obscured. In these cases, you have the option of manually 
tracking a window to fit the likely trajectory of the hidden feature, frame by frame.

To manually reposition or track a window that can’t be interpolated properly:

1.	 Open the Tracker palette, and click Frame to change the tracking mode.

2.	 Click the Tracker palette Option pop-up, and choose Show Track to see the motion path in the 
Viewer. This will help you see the adjustments you’re making.

3.	 Move the playhead to the last frame that was successfully tracked.

4.	 Move the playhead frame by frame, and adjust the position of the window at each frame to 
move along with the feature that you’re trying to track.
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	 Continue adjusting the window frame by frame until you’ve reached the end of the clip, or 
reached the end of the gap in tracking data so that the window is now at the beginning of the 
next successfully tracked section of the clip.

This technique may not be fun, but it’ll get the job done in a pinch. You can also use this technique 
to reposition specific motion path points in the middle of an otherwise successful track to make 
them fit better. 

Tip: You can also turn on the motion path by pressing the SHOW TRACK soft key on the Center 
panel of the DaVinci control surface when you’re in OBJECT TRACK MODE.

Image Stabilization

The Image Stabilization mode of the Tracker palette lets you smooth out or even steady unwanted 
camera motion within a clip. The analysis is performed in such a way as to preserve the motion of 
individual subjects within the frame, as well as the overall direction of desirable camera motion, 
while correcting for unsteadiness.

Image stabilization in DaVinci Resolve consists of three steps. First, you analyze the clip. Second, 
you choose the Stabilization settings you want to use. Third, you click Stabilize to calculate 
the result.

The Stabilizer mode of the Tracker palette

As with Object Tracking, you can choose which aspects of motion to stabilize, but this must be 
done before you do the initial image analysis.
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Analyze Controls

The Analyze controls automatically scan through the entire clip, identifying trackable features that 
can be used to stabilize the shot.

A series of four checkboxes let you turn on and off which axes you’d like to stabilize. These checkboxes 
must be selected before you perform an analysis in order to restrict the data that’s generated.

>> Pan: Enables horizontal stabilization.

>> Tilt: Enables vertical stabilization.

>> Zoom: Enables stabilization of size.

>> Rotate: Enables stabilization of orientation.

Note: Once stabilization has been done, disabling these checkboxes does nothing to alter the 
result. To make changes, you need to enable or disable the necessary checkboxes first, and then 
reanalyze the clip.

The next three buttons let you perform the stabilization analysis.

>> Track Reverse button: Initiates tracking from the current frame backward, ending at the first 
frame of the clip.

>> Pause button: Stops tracking (if you’re fast enough to click this button before tracking 
is finished).

>> Track Forward button: Initiates tracking from the current frame forward, ending at the last 
frame of the clip.

Interactive Mode Controls

The Interactive controls let you make manual changes to the automatically generated tracking point 
cloud that Resolve creates, so you can try different ways of obtaining better stabilization results in 
challenging situations.

>> Interactive Mode checkbox: Turns the Interactive stabilization mode on and off. When 
you enter Interactive mode, you can manually alter the point cloud that Resolve uses to 
stabilize the image. You’ll then make your analysis while in Interactive mode. When you 
exit Interactive mode, your manual changes to the point cloud are eliminated, and Resolve 
again uses automatically placed point clouds to do all stabilization.

>> Insert: Lets you add tracking points to whatever analyzable features exist within a bounding 
box that you’ve drawn in the Viewer. Inserted stabilization points are automatically placed.

>> Set Point: Lets you use the cursor (using the DaVinci Resolve control surface), to manually 
place individual tracking points, one by one, with which to track a feature. If there is no 
trackable pixel group at the coordinates where you placed the cursor, a tracking point will 
be placed at the nearest trackable pixel group. You must place at least two tracking points 
at different pixel groups to track rotation, and at least three to track zoom.
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>>Delete: Eliminates all stabilization points within a bounding box that you’ve drawn in the Viewer.

The procedures for using Interactive Mode for stabilization are the same as for tracking. See the 
“Object Tracking Workflows” section earlier in this chapter.

Stabilization Parameters and Controls

There are four controls in the Stabilization group:

Stabilization selections

>> Strong: Lets you choose how tightly you want to use the stabilization track to eliminate motion 
from a shot. With a value of 100, stabilization is maximized in an effort to “lock” the shot in 
place and eliminate all camera motion. This value is a multiplier. Since some clips might look 
more natural with looser stabilization, choosing a number lower than 100 lets a percentage 
of the original camera motion show through. Zero (0) disables stabilization altogether. 
Additionally, you can invert the stabilization by choosing -100, as described in the section 
on performing a match move below, and you can use a negative value either lower or higher 
than -100 to under or overcompensate when inverting the stabilization, simulating the effects 
of parallax where foreground and background planes move together but at different speeds. 

>> Smooth: Lets you apply mathematical smoothing to the analyzed data used to stabilize 
the clip, and is meant to be used when the Strong parameter is less than 100, allowing 
camera motion in the shot while eliminating unwanted wiggling. Lower values perform less 
smoothing, allowing more of the character of the original camera motion to show through, 
while higher values smooth the shot more aggressively.

>> Zoom: When this checkbox is turned on, the image is resized by a large enough percentage 
to eliminate the blanking (black edges) that is the result of repositioning the image to 
eliminate unwanted camera motion. The higher a value Smooth Frames is set to, the more 
Resolve will need to zoom into an image to eliminate these blanked edges. If you turn 
this off, the image is not zoomed at all, and whatever blanking intrudes into the image is 
output along with the image, on the assumption that you’ll have dedicated compositing 
artists deal with eliminating this blanking by filling in the missing image data in a more 
sophisticated manner. You may also leave this checkbox turned off if you’re planning on 
animating the Input Sizing Zoom parameter to dynamically zoom into and out of a shot 
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being stabilized to eliminate blanking only where it occurs, using only as much zooming as 
is necessary for each region of the shot.

>> Stabilize: After you’ve tracked the clip and adjusted the previous two controls, you need to 
click Stabilize to calculate the resulting effect of the Strong, Smooth, and Zoom controls on 
your clip. Whenever you make changes to the Strong, Smooth, or Zoom parameters, you 
need to click Stabilize to recalculate the resulting effect on your clip.

Using Stabilization

Image stabilization in DaVinci Resolve is easy, but you need to follow a specific series of steps for it 
to be successful.

To stabilize an image:

1.	 Open the Tracker palette, and choose Stabilizer from the Palette mode pop-up menu.

2.	 Turn off any of the Analyze checkboxes (Pan, Tilt, Zoom, Rotate) that correspond to transform 
axes you don’t want to smooth.

3.	 Click the Track Forward button to track the clip forward (or Track Reverse if you’d rather start 
from the end of the clip and work backwards).

Multiple tracking points are automatically placed to analyze the motion of the image for stabilization

	 This analyzes the clip, but no stabilization is yet applied.

4.	 Adjust the Strong parameter to reflect what kind of stabilization you want. If you want to eliminate 
all possible motion from the shot, leave Strong set to 100. If you want to use stabilization to 
smooth out the shot but leave some motion in the frame, reduce the strong parameter to be 
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less than 100 but greater then 0. This parameter is a multiplier, so higher numbers reflect a 
higher percentage of smoothing being applied to the clip’s range of motion, and lower numbers 
reflect a lower percentage of smoothing being applied to the original range of motion. 

5.	 If you’ve set the Strong parameter to a value less than 100 to calm the motion in the shot, rather than 
lock the shot completely, you can also adjust the Smooth parameter to mathematically smooth 
what motion that remains in the shot. This lets you even out any “wobbling” that you don’t want, 
while retaining the camera motion that you do want. The Strong and Smooth parameters work 
together, so experiment with different values in each parameter to get the result you need.

6.	 Choose how you want the edges of the stabilized clip to be handled using the Zoom checkbox:

>> If you want Resolve to zoom into the image as much as is necessary to prevent blanking 
(black edges) from intruding into the frame (the result of repositioning the image to steady 
camera motion), then turn on the Viewer Zoom checkbox.

>> If you want to leave the scale of the image alone, allowing blanking (black edges) to intrude 
into the frame so that you either (a) have an effects artist deal with filling in these holes 
later, or (b) manually animate the Input Sizing Zoom parameter to eliminate blanking in a 
dynamic way, then turn off the Viewer Zoom checkbox.

7.	 With all of these controls adjusted, click Stabilize. The clip is immediately transformed to apply 
the amount of stabilization you selected via the Smooth Frames slider.

8.	 Play the clip and examine the stabilization effect. If you need to make any changes, choose 
new Strong and Smooth Frames values, then click Stabilize.

	 Any time you change any of the Stabilization parameters, you need to click Stabilize to 
recalculate the resulting transform to your clip.

Using Stabilization to Create a Match Move

In some circumstances, such as when you’re using the HSL Qualifier to create transparency for 
a composite (using the Alpha Output described later in this chapter), you may find you need to 
apply the motion from a foreground clip to the background clip so that the two clips appear to be 
moving as one. This is referred to as doing a “match move,” and is a necessary step when creating a 
composite for purposes of doing a sky replacement, for example. This can be done in a simple way 
using the Stabilizer mode of the Tracker palette.

To match the motion of a background clip to a foreground clip:

1.	 First, edit a foreground clip onto track V2, and a background clip onto track V1, and follow the 
instructions in the section titled “Using a Qualifier Key to Create Transparency” later in this 
chapter to create a region of transparency in the foreground clip that lets the background 
show through.
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Creating transparency to replace the sky in a superimposed clip with a sky image edited into a lower video track

	 In this example, the sky is being keyed so that it can be replaced with a more attractive 
photo of a sky.

Before (top) and after setting up a sky replacement by connecting an HSL qualifier of the blue in the sky  

to the Alpha Output to create transparency
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	 If you’re planning on match moving a still image, you must first turn the still image clip into a 
compound clip in the Edit page, otherwise this match moving procedure won’t work. If you’re 
match moving a movie clip, this isn’t necessary. Also, depending on the range of motion you’re 
going to be matching, you’ll probably need to use a background image that’s somewhat larger 
than the region you’re keying, to make sure you have full coverage as the layer moves to match 
the foreground motion. If necessary, you can zoom into the image using the Zoom parameter 
in the Transform section of the Edit page Inspector.

2.	 In this example, the foreground clip happens to have a camera pan, which gives the composite 
away as the sky doesn’t move along with it. To move the compound clip of the sky image to 
match this pan, open the Tracker pallet.

3.	 Choose its Stabilizer mode, and then click the Analyze Forward button to analyze the motion of 
the entire clip. Then, click the Tracker palette’s Option menu, and choose Copy Track Data.

4.	 Select the clip that you want to match (in this case the sky image compound clip), then open 
the Tracker Palette’s Option menu and choose Paste Track Data.

5.	 Now, for this to work correctly, you need to set the Strong parameter to –100, and click the 
Stabilize button. Setting a negative value inverts the tracking data you copied in step 3, which 
enables it to become a match move. If you’re feeling extra tricky, you can set the Strong 
parameter to a little less then –100, say –94, which introduces a disparity of foreground and 
background motion that simulates parallax..

Inverting the Strong parameter with a negative number to create matched motion

	 At this point, playing through the clip should result in a nicely matched correspondence 
between the movement of the foreground and background layers.
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The background sky layer after it’s been matched to the motion of the foreground layer, the sky now  

follows along with the motion of the camera in the superimposed clip

Tracking and Stabilizing with the DaVinci Control Surface

All of the tracking commands are available via the DaVinci Resolve control surface.

To open and close tracking controls:

>> Press OBJECT TRACK MODE at the top of the T-bar panel.

All of the tracking controls appear on the soft keys of the Center and T-bar panels.

To do simple tracking:

>> Use the TRACK FWD, TRACK REV, and STOP TRACK soft buttons on the left side of the 
Center panel.

>> Press SHOW TRACK if you want to see the resulting motion path.
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To turn tracking on and off for Pan, Tilt, Zoom, and Rotate:

1.	 Press the P/T/Z/R ENABLE soft key.

	 The middle four soft keys of the Center panel change to display PAN ON/OFF, TILT ON/OFF, 
ZOOM ON/OFF, and ROTATE ON/OFF.

2.	 Use these buttons to toggle any of these checkboxes on or off, then press BACK to go back to 
the other tracking controls.

To interpolate between two separately tracked ranges of frames:

1.	 Use the transport controls to move the playhead to the first frame you want to place a mark, 
and press MARK.

	 A Viewer Mark appears on the tracking bar, identifying either the beginning or the end of the 
gap in that clip’s motion tracking data.

2.	 If necessary, use the transport controls to move the playhead to the second frame where you 
want to place a mark, and press MARK.

	 A second Viewer Mark appears in the tracking bar, identifying both the beginning and end of 
the gap in that clip’s motion tracking data.

3.	 To perform the interpolation, do one of the following:

>> If you marked both the first and last tracked frames that surround a gap in tracking data, 
press the INTRPLT BETWEEN soft key.

>> If you marked the last tracked frame in the first half of the clip, then use the transport 
controls to move the playhead to the first tracked frame of the second half of the clip and 
press the INTRPLT REV soft key.

>> If you marked the first tracked frame in the second half of the clip, then use the transport 
controls to move the playhead to the last tracked frame of the first half of the clip and press 
the INTRPLT FWD soft key.

To move the playhead to different “cue” frames:

>> Press the CUE START, CUE LOWER, CUE UPPER, or CUE END soft keys on the T-bar panel.

To use Interactive mode:

1.	 Press the INTERACTIVE soft key at the left of the center panel.

	 Additional button controls appear on the soft keys of the Transport panel, including INSERT 
(POINTS), DELETE (POINTS), CLEAR (POINTS), and SET POINT.
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2.	 Do one of the following:

>> To eliminate all tracking points, press the CLEAR soft key.

>> To add a single tracking point, press CURSOR (above the fourth trackball), use the fourth 
trackball to position the on-screen cursor over the feature you’d like to add a tracking point 
to, and then press the SET POINT soft key.

>> To eliminate a range of tracking points in order to prevent the tracking of an undesirable 
feature, use the mouse to draw a bounding box around the tracking points you want to 
remove, and press the DELETE soft key.

>> To add a range of tracking points to a specific feature, use the mouse to draw a bounding 
box around the feature you want to track, and press the INSERT soft key.

3.	 Use the TRACK FWD, TRACK REV, and STOP TRACK soft buttons on the left side of the 
Center panel to perform the necessary tracking.

4.	 Press the INTERACTIVE soft key again to leave Interactive mode.
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This section covers effects that aren’t, in and of themselves, considered color corrections. However, 
they allow you to make stylistic and corrective alterations to the image that other applications 
typically apply with “filter” operations.

Blur Palette Effects

The Blur palette has three different modes of operation—blur, sharpen, and mist. While the 
functionality of the blur and sharpen modes somewhat overlap, each mode provides dedicated 
controls that the other ones lack.

As with virtually everything else in the Color page, the operations performed in the Blur palette 
can be limited as a secondary operation using HSL Qualifiers, Windows, or Imported mattes, which 
makes it easy to apply these effects to specific portions of the image.

Many of the controls in the Blur palette consist of three ganged sliders, one for red, one for green, 
and one for blue. 

By default, these ganged sliders move together as one, resulting in each color channel of the image 
being equally affected. A small orange button to the left of each control’s name lets you ungang 
these sliders, in order to apply degrees of adjustment to individual color channels.

Blur

The default mode, Blur lets you apply an exceptionally high-quality Gaussian blur, or another equally 
high-quality sharpening operation to your image. This mode of operation has the simplest controls.

Two sets of linked parameters let you adjust the extent and directionality of blur or sharpening. 
Which is applied depends on the direction in which you adjust the Radius control.

Blur Radius controls are ganged by default, but can be unganged

Blur Effects
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>> Radius: This is the primary control for adding blur or sharpening. The default value of 0.50 
results in no effect being applied to the image. Raising the radius slider increases blur, to 
an incredibly soft maximum value of 6.00. Lowering the radius increases sharpness, with a 
minimum value of 0.00 providing maximum sharpness.

Tip: If you raise the Radius slider all the way to 1.00 and the image isn’t blurred enough, add 
another node and use it to add another blur operation.

>> H/V Ratio: Lets you add directionality to the current operation. At the default value of 0.50, 
the image is affected in both the horizontal and vertical directions equally. Raising H/V 
Ratio makes the effect increasingly directional along the horizontal axis, while lowering 
makes the effect increasingly directional along the vertical axis.

To adjust the Blur controls using the DaVinci control surface:

1.	 Press the VECTORS button on the T-bar panel, or the VECTORS soft key on the Trackball’s 
main page.

2.	 Use the BLUR AMOUNT and H/V RATIO knobs to add either blur or sharpening.

3.	 When you’re finished, press the PRIMARIES soft key to return to the Center panel’s main page.

Sharpening

While the Blur controls also let you apply sharpening simply by lowering rather then raising the 
Radius sliders, the actual Sharpen mode provides additional controls specifically for tailoring 
sharpening operations.

Sharpening with Coring Softness and Level
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>> Radius: This is the primary control for adding blur or sharpening. The default value of 0.50 
results in no effect being applied to the image. Raising the radius slider increases blur, to a 
maximum value of 1.00. Lowering the radius increases sharpness, with a minimum value of 
0.00 providing maximum sharpness.

>> H/V Ratio: Lets you add directionality to the current operation. At the default value of 0.50, 
the image is affected in both the horizontal and vertical directions equally. Raising H/V 
Ratio makes the effect increasingly directional along the horizontal axis, while lowering 
makes the effect increasingly directional along the vertical axis.

>> Scaling: Multiplies the amount of scaling being applied by the Radius control for  
sharpening operations. The scaling parameter has no effect if Radius is set to 0.50 or  
above for blur effects.

The Coring Softness and Level parameters work together to allow you to be selective about which 
parts of the image you’re sharpening, without the need to build a secondary operation.

>> Coring Softness: Lets you limit how much of the image is being sharpened, based on the 
threshold of image detail defined by the Level parameter. With Level at 0, Coring Softness 
adjusts the blend between sharpening of the most detailed areas of the image (such as 
the eyes, lips, and dimples of a face), and low detail areas of the image that are not being 
sharpened at all (such as the cheeks, forehead, and chin).

>> Level: Sets the threshold at which image detail is omitted from a sharpening operation 
when Coring Softness is raised. The default setting of 0 sets the threshold low enough 
to omit all but the most highly detailed edges of an image. Raising Level gradually omits 
areas of reduced complexity, which results in more of the image being included in a 
sharpening operation.

To adjust the Sharpening controls using the DaVinci control surface:

1.	 Press the VECTORS button on the T-bar panel, or the VECTORS soft key on the Center panel’s 
main page.

2.	 On the Center panel, press the IMAGE MODE soft key repeatedly to cycle to the RESOLVE 
IMAGE SHARPENING controls.

3.	 Use the SHARP AMOUNT, SCALING, LEVELS, and SOFTNESS knobs to create the desired 
sharpening effect.

4.	 When you’re finished, press the PRIMARIES soft key to return to the Center panel’s main page.
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Mist

The Mist mode lets you combine blur and sharpen operations in such a way as to create effects 
similar to those achieved via “Vaseline on the lens” or Pro-Mist optical filters.

Mist including Mist Mix control

Unlike the Blur or Sharpen modes, where the Radius sliders provide immediate access to the 
desired effect, the Mist mode requires you to lower the Radius and Mix sliders together to get a 
desirable result. By varying the amounts of Radius and Mix, you can create many variations on the 
mist effect.

>> Radius: When creating a Mist effect, you first need to lower Radius to sharpen the image. 
This operations then combines with a lowering of the Mix parameter to provide the 
combination of detail and blurring that results in a mist effect.

>> H/V Ratio: Lets you add directionality to the current operation. At the default value of 0.50, 
the image is affected in both the horizontal and vertical directions equally. Raising H/V 
Ratio makes the effect increasingly directional along the horizontal axis, while lowering 
makes the effect increasingly directional along the vertical axis.

>> Scaling: Multiplies the amount of scaling being applied by the Radius control, and lets you 
intensify a mist effect beyond the Radius slider’s ordinary range. The scaling parameter has 
no effect if Radius is set to 0.50 or above for blur effects.

>>Mix: After you sharpen the image using the Radius slider, decreasing the Mix parameter 
adds a superimposed blur that mixes with the high-detail areas of the picture to create the 
mist effect.
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To adjust the Mist controls using the DaVinci control surface:

1.	 Press the VECTORS button on the T-bar panel, or the VECTORS soft key on the Center panel’s 
main page.

2.	 On the Center panel, press the IMAGE MODE soft key repeatedly to cycle to the RESOLVE 
MIST EFFECT controls.

3.	 Use the RADIUS, H/V RATIO, SCALING, and MIX knobs to create the desired mist effect.

4.	 When you’re finished, press the PRIMARIES soft key to return to the Center panel’s main page.
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DaVinci Resolve has a powerful tool set for making geometric transforms, using advanced 
algorithms for optical-quality sizing operations. This section covers the nuts and bolts of resolution 
independence in DaVinci Resolve, and how to use the Sizing palette.

Resolution Independence in DaVinci Resolve

DaVinci Resolve is a resolution-independent application. This means that, whatever the resolution 
of your source media, it can be output at whatever other resolution you like. This also means that 
you can freely mix clips of any resolution, fitting 4K, HD, and SD clips into the same timeline, and 
scaling each to fit the project resolution as necessary.

Your project’s resolution can be changed at any time, allowing you to work at one resolution, 
and then output at another resolution. This also makes it easy to output multiple versions of a 
program at different resolutions, for example, outputting both HD and SD sized versions of the 
same program.

Finally, the controls found in the Sizing palette let you transform clips individually, either to push 
into a clip for creative intent, or to pan and scan media of one format to fit better into a different 
output format.

Using High Resolution Media in Lower Resolution Projects

Every set of transform and sizing parameters and settings that resize clips is combined intelligently, 
so that the highest resolution media is always used as the source for any transform. For example, 
if you’re using 4K media within a 1920x1080 project, and you need to enlarge a clip using the Input 
Sizing palette’s Zoom parameter, the image is scaled relative to the native 4K resolution of the 
source, and the result is fit into the current timeline resolution. This automatically guarantees the 
highest quality for any image transform you make.

Timeline Resolution

This is one of the most fundamental settings in your project, defining its frame size. You can choose 
a predefined resolution from the “Set timeline resolution to” pop-up menu, or you can type a 
custom resolution into the X and Y fields below.

Media used in a project does not have to match the timeline resolution, in fact it’s common to 
mix resolutions within the same timeline. Clips that don’t match the current resolution will be 
automatically resized according to the currently selected Image Scaling setting (described below).

As mentioned earlier, you can change the timeline resolution at any time. When you do so, all Power 
Windows, Sizing palette adjustments, tracking, keyframing, and other geometric operations are 
automatically and accurately scaled to fit the new resolution.

2D Transforms
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Pixel Aspect Ratio (PAR)

The Timeline Format settings, found in the Master Project Settings, let you specify a Pixel Aspect 
Ratio in addition to the frame size. Defaulting to Square Pixel, which is appropriate for high definition 
projects, there are also options for 16:9 anamorphic, 4:3 standard definition, or Cinemascope. Which 
options are available depends on what timeline resolution you’ve selected.

In addition, each clip has individually adjustable PAR settings, for situations where you’re mixing 
multiple types of media within a single project. For example, if you’re mixing SD clips with non-
square pixels and HD clips with square pixels, you can sort out all of the SD clips in the Media 
Pool and assign them the appropriate NTSC or PAL non-square pixel ratio PAR setting. For more 
information, see Chapter 3, “Working in the Media Page.”

Image Scaling

If a clip’s native resolution doesn’t match the Timeline Resolution, then the currently selected Input 
Scaling Preset dictates how the mismatched clip will be handled. The default setting is “Scale 
entire image to fit,” which shrinks or enlarges the image to fit, in the best way possible, the current 
dimensions of the frame, adding letterboxing or pillarboxing as necessary.

The Image Scaling parameters are found in the Project Settings window, and there are two sets of 
parameters that let you set the quality and method used for these automatic transforms.

Image Scaling filters let you choose the mathematical method used to resize clips:

>> Uses sharper filter: Usually provides the best quality in projects, using the optical quality 
processing unique to DaVinci Resolve.

>> Uses smoother filter: May provide a more pleasing result for projects using clips that must 
be scaled down to standard definition, as this filter exhibits fewer sharp edges at SD 
resolutions.

>> Uses bilinear filter: A lower quality setting that is less processor intensive. Useful for 
previewing your work on a low-performance computer before rendering, when you can 
switch to one of the higher quality options.

>> Input scaling preset: Checking this box lets you choose an Input Sizing preset to apply to 
the project.

>>Output scaling preset: Checking this box lets you choose an Output Sizing preset to apply 
to the project.
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Input Image Scaling options let you choose how clips that don’t match the current project resolution 
are handled. The illustrated examples below show an SD clip being fit into an HD project using each 
of the different options.

>> Center crop with no resizing: Clips of differing resolution are not scaled at all. Clips that are 
smaller than the current frame size are surrounded by blanking, and clips that are larger 
than the current frame size are cropped.

>> Scale full frame with crop: Clips of differing resolution are scaled so that the clip fills the 
frame with no blanking. Excess pixels are cropped.

>> Scale entire image to fit: The default setting. Clips of differing resolution are scaled so 
that each clip fills the frame without cropping. The dimension that falls short has blanking 
inserted (letterboxing or pillarboxing). 
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>> Stretch frame to all corners: Useful for projects using anamorphic media. Clips of differing 
resolutions are squished or stretched to match the frame size in all dimensions. This way, 
anamorphic media can be stretched to match full raster, or full raster media can be squished 
to fit into an anamorphic frame. An added benefit of this setting is that it makes it easy to 
mix anamorphic and non-anamorphic clips in the same project.

Output Image Scaling

Another group of settings found in the Image Scaling panel of the Project Settings lets you 
optionally choose a different resolution to be output via your video output interface, for monitoring, 
outputting to tape, or rendering. If you set the resolution in the Render Settings list of the Deliver 
page to something other than the Timeline Resolution, these settings are used to make the change. 
This can be used in situations where you’re working on a high resolution 4K project, but you want to 
monitor using an HD display, and output HD resolution media for approval.

>> Lock to timeline format: Turned on by default, so that these settings mirror the Image 
Scaling and Input Image Scaling settings described above. Turning this checkbox off lets 
you choose different settings for monitoring, outputting to tape, or rendering, using the 
other settings in this group.
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>> Set output resolution to: Lets you choose an alternate resolution.

>> For “X x Y” processing: Lets you specify a different custom alternate resolution.

>> Pixel aspect ratio is: Lets you specify an alternate pixel aspect ratio to match the alternate 
timeline format.

>>Mismatched resolution files: Lets you choose an alternate way of handling mismatched 
resolution files given the alternate resolution you’ve chosen. These options work identically 
to those of the “Input Image Scaling” group.

Edit Page Transform Parameters and Imported Sizing Information

A set of Transform parameters corresponding to each clip in the Timeline is available from the 
Inspector. These parameters operate independently of the Sizing controls found in the Color page, 
and exist primarily to store incoming transform data from imported AAF and XML projects coming 
from other applications.

The transform parameters in the Inspector of the Edit page

If, when importing an AAF or XML project file, you turned on the “Use sizing information” checkbox, 
then every clip that had position, scale, rotation, or crop settings applied in the originating NLE will 
have those adjustments applied to these transform parameters.

The transformation applied by these parameters is combined with whatever Input and Output 
Sizing adjustments are being made to output the final geometric result.

Edit, Input, Output, and Node Sizing on the Color Page

The Sizing palette on the Color page has another dedicated set of keyframable transform 
parameters that work with the DaVinci Control Surface to let the colorist apply pan and scan 
adjustments while working through a project. These parameters work independently of the Edit 
page Transform parameters, allowing you to keep imported transform settings separate from other 
transform settings that you apply. However, for convenience the Edit sizing controls are available in 
the Color page as well.
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Format Resolution on the Delivery Page

By default, the Format Resolution setting in the Render Settings of the Deliver page matches the 
Timeline Resolution when “Match timeline settings” is enabled in the Output Scaling Preset in 
Project Settings.

Choosing a new resolution from the “Set Resolution to” pop-up menu lets you override the current 
Format Resolution setting before rendering. Using this control, you can queue up multiple jobs, 
each set to a different resolution, to output multiple formats during a single render session. For more 
information on rendering and setting up jobs for the Render Queue, see Chapter 10, “Deliver.”

The Four Color Page Sizing Modes

The Sizing Palette on the Color page can be put into three modes: Input Sizing, Output Sizing, and 
Node sizing. 

>> 	Edit Sizing: These controls mirror those found in the Inspector of the Edit page.

>> Input Sizing: These controls let you make sizing adjustments to individual clips that affect 
their overall geometry (pan, tilt, zoom, and rotation). These controls are useful for doing clip 
by clip pan and scan adjustments.

>>Output Sizing: These controls are nearly identical, except that they affect every clip in the 
entire timeline, all at once. Output sizing is useful for making a formatting adjustment to an 
entire timeline, such as changing an HD timeline to an SD timeline with simple adjustments 
to crop and pan the resulting framing.

>>Node Sizing: Lets you add targeted sizing adjustments at any point within the node tree. 
Like Input Sizing, Node Sizing is specific to a particular clip. Unlike Input Sizing, Node Sizing 
is affected by operations that split color channels (such as the splitter/combiner nodes) 
and limit the image (such as qualifiers and windows). You can also add as many node sizing 
adjustments to a clip’s grade as you need.

Sizing Order of Processing on the Color Page

Input Sizing adjustments are applied before all image processing that takes place in the node 
graph, including Node Sizing, while Output Sizing adjustments are applied after image processing 
in the node graph.

Using Node Sizing

Using Node Sizing, you can apply individual sizing adjustments on a per-node basis. All Node Sizing 
adjustments within a grade are cumulative, and any keyframing done to Node Sizing parameters is 
stored in that node’s Node Format keyframe track in the Keyframe Editor. Two good examples of 
Node Sizing include realigning color channels individually in conjunction with the Splitter/Combiner 
nodes, or duplicating windowed regions of an image by moving them around the frame.
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Example 1: Using node sizing on individual color channels:

1.	 Choose Nodes > Add Splitter/Combiner Node to add this node structure to the current grade.

2.	 Select one of the three Corrector nodes connected between the Splitter and Combiner nodes 
that corresponds to the color channel you want to transform.

Adding the Splitter/Combiner nodes to use Node Sizing on individual color channels 

3.	 Open the Sizing palette, choose Node Sizing from the mode pop-up, and use the Sizing 
parameters to transform that channel as necessary. For example, if you have an old video clip 
with misaligned color components, you could pan a misaligned channel to the left or right to 
try and improve its alignment.

       

Before and after panning the green channel

Example 2: Using Node Sizing to duplicate a windowed area of an image to cover a blemish:

1.	 Create a new node.

2.	 Open the Window palette, create a Circular window, and then shrink and reposition it to 
surround a feature you want to remove.

3.	 Open the Tracking palette, and track the window to follow the feature to be removed.
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4.	 After the track is complete, now move the window to an adjacent area of clean detail that’s 
right next to the feature you want to remove. This is the area of the image you’re going to 
duplicate and cover the unwanted feature with.

5.	 Now, open the Sizing palette, choose Node Sizing from the mode pop-up, and use the Sizing 
parameters to move a duplicate of the windowed area to cover up the unwanted feature.

       

Before/After using Node Sizing to clone an area of the image to cover up the actor with a plant to create a clean background

When you’re done, playing through the clip should show that the duplicated area of the image is 
still tracking the feature you want to remove.

Sizing Controls

Input, Node, and Output Sizing share many of the same controls. When the Sizing palette is set to 
Input Sizing mode, the controls transform each clip individually. If you’re simply pushing in on one 
or two clips, or making individual pan & scan adjustments to account for a change in format, these 
are the controls you want to use.

The Sizing palette
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>> Pan: Moves the clip along the horizontal, X axis. Positive values move the clip right, negative 
values move the clip left.

>> Tilt: Moves the clip along the vertical, Y axis. Positive values move the clip up, negative 
values move the clip down.

>> Zoom: Positive values enlarge the clip, negative values shrink the clip.

>> Rotate: Positive values rotate the clip clockwise. Negative values rotate the clip 
counter-clockwise.

>>Width: Positive values stretch the image wider, negative values squish the image narrower.

>> Height: Positive values stretch the image taller, negative values squish the image shorter.

>> Key Lock: (Node Sizing only) Lets you choose how regions of the image that are isolated by 
one or more windows will be transformed. There are two options:

>>Off: While off, the transform controls will move the windowed region to another area 
of the frame, effectively duplicating the windowed area.

>>On: While on, the transform controls will move other areas of the frame into the 
windowed regions, effectively covering up the windowed area with another portion 
of the picture.

>> Flip Image: Two buttons let you flip the image in different dimensions.

>> Flip Horizontal control: Reverses the image along the X axis, left to right.

>> Flip Vertical control: Reverses the clip along the Y axis, turning it upside down.

Sizing OSC

An onscreen control currently mirrors the sizing parameters, showing you a preview of the 
transformed image, shown by an orange outline, relative to the size of the frame, shown in gray. 
Zoom and reset controls make it easier to see the full display.

Blanking Controls

Output Sizing mode also has a set of Blanking controls that you can use to add custom blanking 
to a clip or project. For example, you can use these controls to add nonstandard letterboxing or 
pillarboxing to an image. Along with all other Output Sizing adjustments, blanking is added last in the 
image processing pipeline, so it’s not affected by any of the color or contrast adjustments you make.

>> Left: Adjusts the left pillarbox.

>> Right: Adjusts the right pillarbox.

>> Top: Adjusts the top letterbox.

>> Bottom: Adjusts the bottom letterbox.
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Blanking presets are also available by choosing from the Color > Output Blanking submenu. 
Choosing one of these options automatically sets the Blanking parameters of the Sizing palette’s 
Output Sizing mode. The following presets are available: 

>> 1.33: SD or 4:3

>> 1.66: European theatrical

>> 1.77: HD or 16:9

>> 1.85: Theatrical flat aspect ratio

>> 2.35: Original anamorphic (scope) theatrical wide-screen

>> 2.39: Current 35mm anamorphic (scope) theatrical wide-screen

>> 2.40: Current 35mm anamorphic (scope) theatrical wide-screen (rounded up for Blu-Ray)

Anti-aliasing at the edges of blanking is handled by a setting in the Image Scaling panel of the 
Project Settings. For more information, see Chapter 2.

Resetting the Sizing Palette

You can reset every control within the Sizing palette at any time by choosing Reset from the Palette 
Options pop-up menu, or by clicking the reset button in the upper left-hand corner of the palette.

Input and Output Sizing Presets

If there are Input or Output Sizing settings that you find yourself using repeatedly, you can save 
them as presets for easy recall. For example, if there’s a group of input settings that you use to 
resize a clip of a particular format to match the current project, you can save it as a preset that you 
can use whenever. 

>> Preset pop-up menu: Provides access to all the currently saved presets in the 
current  database.

>> Delete preset: To delete a preset, select it from the pop-up menu, click the trash can 
button, then click OK.

>> Add preset: To add a preset, make whatever settings adjustments you need, then click the 
plus button. When the Format Preset dialog appears, enter a name, check that the settings 
are correct, then click Save.

>> Change preset: To change a preset, load the preset you want to change, make whatever 
changes you need, then click the check button.

The Input and Output Sizing modes save different presets. Each of these sets of presets is available 
from the “Override input scaling” and “Override output scaling” pop-up menus in the Image 
Scaling panel of the Project Settings.
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Sizing Controls With the DaVinci Control Surface

There are two sets of DaVinci control surface mappings for the sizing controls. The most obvious 
controls can be seen permanently mapped to the knobs and soft keys of the Transport panel. This 
makes these controls easy to access for projects where you’re panning & scanning nearly every shot 
of a film-scanned program. 

To adjust PTZR settings:

1.	 Press the OUTPUT or INPUT soft key to switch between Output Sizing and Input Sizing modes. 

2.	 Use the PAN, TILT, ZOOM, and ROTATE knobs of the Transport panel, and the H FLIP and V 
FLIP soft keys.

To adjust Input and Output Blanking:

1.	 Press the INPUT BLANKING or OUTPUT BLANKING soft key on the Transport panel.

2.	 Use the knobs labeled LEFT, RIGHT, TOP, and BOTTOM to make a blanking adjustment. 

3.	 Press SIZING when you’re finished.

Another set of DaVinci control surface mappings appears when you press the SIZING button of 
the T-bar panel. In this case, the Center panel knobs and soft keys update to a page showing 
the following:

>> Ref Wipe Sizing Adjustments: These controls, on the middle screen of the Center panel, 
let you reposition a still from the Gallery that’s being displayed in a split screen. This can 
make it easier to compare features that would otherwise be obscured by the still’s position 
on screen.

>> Input Sizing Adjustments: The Input Sizing controls are displayed on the right screen of the 
Center panel. These are similar to the mappings on the Transport panel, but the Center 
panel’s second row of knobs also exposes PITCH, YAW, H SIZE, and V SIZE controls, and 
there’s an additional MODIFY PAR button that lets you change the pixel aspect ratio 
of a clip.

>>Output Sizing Adjustments: If you press OUTPUT soft key on the Center panel, the knobs 
and soft keys change to show the Output Sizing controls. Press BLANKING to expose all 
the preset aspect ratios on the Transport panel, along with the USER which allows you to 
expose user definable presets.

To save and recall user definable blanking aspect ratios:

1.	 Press SIZING on the T-bar panel.

2.	 Press the OUTPUT soft key on the Center panel.
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3.	 Press the OUTPUT BLANKING soft key on the Transport panel, and then enter the blanking 
aspect ratio as a number (e.g., 2.4) using the number pad on the Transport panel to set your 
customized blanking.

4.	 Press the BLANKING soft key on the Center panel.

5.	 To apply the new ratio, press the BLANKING soft key on the Center panel, then press USER on 
the Transport panel, and press one of the USER 1-5 soft keys.

Tip: With the Input Sizing Adjustments controls exposed on the Center panel, you can set the 
Transport panel to display the Output Sizing controls, for simultaneous presentation of every sizing 
control that’s available.
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Stereo 3D Palette

This palette contains all the controls necessary for working on stereoscopic (colloquially known as 
3D) projects. It provides controls for choosing which eye to grade, adjusting convergence, swapping 
and copying grades and media between matching left- and right-eye clips in paired timelines, auto-
processing the color and geometry of left- and right-eye clips to match, stereo monitoring setup, 
and controls for floating windows.

Stereoscopic 3D palette

Your project must contain stereo 3D clips in order to open this palette. For more information on 
setting up a stereo 3D project, see the “Stereoscopic Workflows” section of Chapter 9, “Preparing 
and Conforming Projects.”

Stereo Eye Selection

Most colorists work by grading one eye first (typically the left), and rippling their grades to the 
other eye, making separate adjustments to each eye’s clips when necessary to match undesirable 
variation between cameras.

The first three buttons in the Stereo 3D palette let you choose which eye to grade while you’re 
working, as well as whether or not to ripple each clip’s grade to the matching opposite-eye clip. 
Whenever you switch eyes, the 3D badge above each clip’s thumbnail changes color (blue for right, 
red for left) and the thumbnails themselves update to show that eye’s media.

The Left eye is master and ganged with the right
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>> Left button: Displays the left-eye image and grade.

>> Ripple Link button: When enabled (orange), all changes you make to the grade of the 
currently selected eye are automatically copied to the correspondingly opposite eye. 
When disabled (gray), grades made to the currently selected eye are made independently.

>> Right button: Displays the right-eye image and grade.

Tip: You can also choose which eye you’re viewing and grading by right-clicking a clip’s thumbnail 
and choosing Stereo > Switch Eye or by choosing View > Switch Eye To > Left Eye or Right Eye.

Using Ripple Link When Grading Stereo 3D Clips

You would turn Ripple Link off to suspend rippling when you want to make an individual adjustment 
to the grade of one eye to obtain a better match between the two. When you’re finished matching 
the two clips, you can turn it back on to resume automatic grade rippling. 

Stereo 3D grade rippling is always relative, so differences between the grades that are applied to 
the left- and right-eye clips are preserved. In fact, when you add or remove nodes to or from one 
eye, the same nodes are automatically added to or removed from the corresponding clip it’s paired 
with, regardless of whether or not Ripple Linked is enabled.

Important: Regardless of whether or not Ripple Link is enabled, local versions created for one stereo 
3D-identified clip are automatically available to the paired timeline.

Stereo 3D Geometry Controls

The next group of parameters lets you adjust the geometry of stereo 3D clips. The Pan, Tilt, and 
Zoom controls are provided as a convenience, and simply mirror the same parameters found in the 
Transform palette’s Input mode. Convergence, Pitch, and Yaw are the three parameters that are 
unique to the Stereo 3D palette.

Stereoscopic 3D Geometry controls

>> Convergence: Adjusts the disparity between the left and right eyes, to define the point of 
convergence (POC), or the region within the image where the left- and right-eye features 
are in perfect alignment. If necessary, Convergence can be animated using the Stereo 
Format parameter group in the Sizing track of the Keyframe Editor.
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Features that overlap perfectly in both right- and left-eye clips are at zero parallax, putting 
that feature’s depth at the screen plane. Matching features that are divergent in the left- 
and right-eye clips have increasingly positive parallax, and appear to be farther away from 
the audience. Matching features that are divergent and reversed in the left- and right-eye 
clips have increasingly negative parallax, and appear to be closer to the audience than the 
screen plane.

>> Linked Zoom button: When enabled (orange), both the left- and right-eye clips are 
automatically zoomed whenever Convergence is adjusted so that both eyes always fill the 
screen. When disabled (gray), changes to Convergence will cause the opposing left and 
right edges of each eye’s clip to have blanking intrude. 

>> Pitch: Pivots the image around the horizontal center plane of the frame.

>> Yaw: Pivots the image around the vertical center plane of the frame.

Sizing Repositioning in Stereo 3D

Generally, you’ll want to reposition stereo 3D clips with Ripple Link turned on, but you may 
occasionally find yourself needing to make a manual adjustment to one eye in particular with Ripple 
Link disabled. As with color adjustments, Sizing adjustments made with Ripple Link disabled are 
only applied to the clip in the current timeline. When Ripple Link is turned on, all Sizing adjustments 
are automatically copied to the correspondingly numbered shot of the other stereo 3D timeline.

Warning: It is not advisable to use the Rotate parameter when transforming stereo 3D clips. 
Geometrically, rotation tilts a stereo pair of clips inappropriately, and ruins the “side-by-side” 
convergence that’s necessary to create the stereoscopic illusion.

Protecting Stereo Adjustments When Copying Grades

Each version of a grade has independent stereo adjustments stored along with the Sizing settings. 
To prevent accidental overwrite of convergence and alignment data when copying grades from 
one clip to another, you can right-click within the Gallery and choose one of the following options 
to turn them on:

>> Copy Grade: Preserve Convergence

>> Copy Grade: Preserve Floating Windows

>> Copy Grade: Preserve Auto Align

When enabled, these options lets you overwrite a clip’s grade without overwriting specific Stereo 
3D parameters.

Tip: Stereo 3D and Sizing settings are processed before node-based corrections in the Resolve 
image processing pipeline.
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Swap and Copy Controls
Another set of controls lets you swap and copy grades, and swap clips, in situations where you need 
to reverse what’s applied to a pair of left- and right-eye clips.

Swap and Copy grades between eyes

>> Swap Grade: Exchanges the grades that are applied to the left- and right-eye clips.

>> Swap Shot: A checkbox that, when enabled, switches the actual media used by two 
corresponding left- and right-eye clips. Useful in situations where the eyes of a stereo 3D 
clip were mislabeled, and you want to switch the clips without rebuilding both EDLs.

>> Copy Left to Right: Copies the left-clip grade to the corresponding right-eye clip.

>> Copy Right to Left: Copies the right-clip grade to the corresponding left-eye clip.

Batch Grade Management for Stereo 3D Projects

There are also a series of batch-processing commands that are useful for stereoscopic grading that 
are available when you right-click one or more selected clips in the Thumbnail timeline: 

>> Stereo Batch Copy: Copies every grade from the left-eye clips to the right-eye clips.  

>> Stereo Batch Sync: Copies grades from one eye to the other only when their node graphs have 
the same number of nodes. This prevents you from accidentally overwriting a custom grade 
with a different node structure that was necessary to match two eyes for a problem shot.

The Copy Grade, Swap Grade, Swap Shots, Ripple Link, and Switch Eye commands are also available 
from the Stereo submenu of the Timeline contextual menu. 

Automatic Image Processing for Stereo 3D

It’s common during stereoscopic shoots for minor divergences in geometry and color to appear in 
the source footage. To make the process of grading stereo 3D media less onerous, DaVinci Resolve 
provides a set of auto-adjustment controls that gives you a starting point for matching left- and 
right-eye clips together.

Auto align and color match buttons



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

670

ADVANCED COLOR FEATURES12

Auto Process—Stereo Alignment

For the stereoscopic effect to work without causing headaches, it’s critical that both eyes are aligned. 
This can be tricky to adjust using manual controls, but is something that can be automatically 
analyzed. You can perform stereo 3D alignment to a single clip, or you can select a range of clips to 
align all of them automatically at once. There are two options. Which is more appropriate depends 
on the type of geometry issues you’re needing to address.

>> Transform Alignment: Analyzes the image and makes vertical and rotational adjustments to 
line up the left- and right-eye images as closely as possible.

>> Vertical Skew: Analyzes the images and makes a vertical-only adjustment to line up the 
left- and right-eye images.

To align one or more clips automatically:

1.	 Select one or more stereo clips in the Thumbnail timeline of the Color or Format pages.

2.	 Choose which frame of each clip you want to use for the analysis by opening the Stereo 3D 
palette, clicking the Option menu, and choosing Auto Process > First or Auto Process > Middle.

3.	 Do one of the following:

>> Using the Stereo 3D palette, click either of the Stereo Alignment buttons. The button to the 
left is for Automatic Transform, while the button to the right is for Automatic Vertical Skew.

>> Right-click the thumbnail, and choose Transform Alignment or Vertical Skew from the 
contextual menu.

The Stereo Alignment window appears, and a progress bar shows the remaining time this 
operation will take.

Auto Process—Color Matching

Due to the design of different stereo 3D rigs, sometimes the color and contrast of one eye’s media 
doesn’t precisely match that of the corresponding eye. DaVinci Resolve provides two commands for 
quickly and automatically matching two eyes together.

>> Stereo Color Match (Primary Controls): Uses the Lift/Gamma/Gain controls to match one 
eye to the other. The result is a simple adjustment that’s easy to customize, but may not 
work as well as Custom Curves in some instances.

>> Stereo Color Match (Custom Curves): Uses the Custom Curves to create a multipoint adjustment 
to match one eye to the other. The result can be more effective with challenging shots.

>> Stereo Color Match (Dense Color Match): Performs a pixel by pixel, frame by frame color 
match that is incredibly accurate. This operation is processor intensive, so if you’re going to 
batch process many clips, or if you’re matching long clips, you’ll want to make sure you have 
adequate time. Because this is so precise match, it’s recommended to use Dense Color 
Match after you’ve used one of the stereo alignment commands.
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Tip: For the best results, it’s recommended to use automatic color matching in a separate node, 
independent of other corrections.

Stereo 3D color match works differently depending on whether or not one of the stereo 3D-paired 
clips has already been graded. The following procedure shows how to match a pair of left- and 
right-eye clips before you make any manual adjustments of any kind.

To match a pair of left- and right-eye clips automatically:

1.	 Select one or more clips in the Thumbnail timeline of the Color page.

2.	 Do one of the following:

>>Open the Stereo 3D palette, and click one of the two Color Match controls.

	 The Color Matching window appears, and a progress bar shows the remaining time this 
operation will take. You can also use automatic color matching to match an ungraded clip to 
a paired clip that’s already been graded. This only works for grades consisting of one or more 
primary corrections; secondary corrections cannot be auto-matched.

To match an ungraded clip automatically to a paired stereo clip that’s graded:

1.	 To suspend stereo grade linking temporarily:

>>Open the Stereo 3D palette, and turn off the Ripple Link button

>> Right-click the Thumbnail timeline, and choose Stereo > Ripple Link > Solo.

2.	 Make a primary adjustment to a clip in the left-eye timeline to create a simple base grade. 
The left-eye clip now has a grade, and the right-eye clip does not.

3.	 Do one of the following to switch eyes:

>> In the Stereo 3D palette, click Right.

>> Right-click the Thumbnail timeline again, and choose Stereo 3D > Switch Eye.

	 This procedure only works when you use the Stereo Color Match commands on the ungraded 
clip of a left- and right-eye stereo pair, to match it to the graded clip.

4.	 To make the match, do one of the following:

>> In the Stereo 3D palette, click one of the two color match controls.

>> Right-click one of the clips, and choose one of the two options from the Stereo Color 
Match submenu.

	 Both clips should match one another very closely.
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Stereo 3D Monitoring Controls

To output both eyes to a stereo 3D display, you need to click the Vision: Mono or Stereo radio 
button, and then choose a display mode from the Output pop-up menu.

Monitoring controls for Stereo 3D

>> Vision: Two radio buttons let you choose between Mono, where only one eye is monitored in 
the Viewer and your video output interface, and Stereo, where both eyes can be displayed in 
the Viewer and output to video in a variety of different formats. For more information about 
outputting Stereo 3D to an external display, see Chapter 4, “Stereoscopic Workflows.”

>>Output: A pop-up menu that provides different stereo viewing options for previewing 
stereo 3D signals in different ways. By default, this option is also linked to the Viewer display 
Internal Video Scope options. For detailed descriptions of each stereo 3D viewing mode, 
see the following section, “Output Options.”

>> Link Viewer to Waveform: When enabled (orange), the Viewer and internal video scopes 
both use the same option for stereo 3D viewing as specified in the Output pop-up menu. 
When disabled, you can choose different stereo 3D viewing options for the Viewer and 
internal video scopes.

>> Viewer: Lets you choose a stereo 3D viewing option for the Viewer.

>>WFM: Lets you choose a stereo 3D viewing option for the internal video scopes.

>> Cbd Size: If any stereo 3D viewing options are set to Checkerboard, this parameter becomes 
enabled, and lets you define the size of the checkerboard boxes, in pixels.

Dual 4:2:2 Y’CbCr stereoscopic video streams are output via HD-SDI on selected Blackmagic I/O 
devices when you turn on the ”Enable dual SDI 3D monitoring” checkbox on the Master Project 
Settings panel of the Project Settings. You can select either Side-by-Side or Line-by-Line output 
to be fed to your stereo-capable display, depending on your display’s compatibility. For more 
information, see the “Stereoscopic Workflows” section of Chapter 6, “Conforming Projects.”
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Output Options

Additionally, the Viewer and video scopes can be set to display both “eyes” in one of a variety of 
different modes.

>> Side by Side: Displays both images side by side. Each eye is squeezed anamorphically to fit 
both eyes into the same resolution as the GUI viewer.

>> Line by Line: An interlaced mode where each eye is displayed on alternating lines. The 
thickness of the lines as seen in the Viewer depends on how zoomed in you are.

>> Checkerboard: Displays both eyes via an alternating checkerboard pattern. This is an 
excellent mode for identifying regions of the image where there’s variation in color or 
geometry between the two eyes.

>> Anaglyph (B/W): Each eye is desaturated and superimposed via Red/Cyan anaglyph 
to show the disparity between both eyes in different regions of the image. Left-eye 
divergence is red, and right-eye divergence is cyan. Regions of alignment between both 
eyes appear grayscale. 

Anaglyph modes are useful for evaluating the geometric differences between both eyes, 
as well as for identifying the point of convergence (where both eyes align most perfectly) 
that places a region of the image at the screen plane. 

Red/cyan color coding also identifies the direction of parallax. For any given feature, disparity 
such that red is to the right and cyan is to the left indicates positive parallax (backward 
projection away from the audience). Red to the left and cyan to the right indicates negative 
parallax (forward projection towards the audience).

>> Anaglyph (Color): Similar to Anaglyph (B/W), except that regions of close alignment are 
shown in full color. Incidentally, both anaglyph modes can be previewed on ordinary 
displays using old-fashioned red/cyan anaglyph glasses, enabling stereo 3D monitoring on 
non-stereo 3D-capable displays.

>> Difference: Superimposes grayscale versions of both eyes using the difference composite 
mode. Corresponding left/right-eye pixels that are perfectly aligned appear black, while 
pixels with disparity appear white. This mode is extremely useful for evaluating geometric 
differences between both eyes, as well as for identifying the point of convergence, without 
the distraction of color that the anaglyph modes present.

>> None: Only displays the eye corresponding to the currently selected timeline in the 
Viewer. However, this option also works in conjunction with the “Enable dual SDI 3D 
monitoring” checkbox in the Master Project Settings of the Project Settings which, 
when turned on, outputs each eye to an individual HD-SDI output of your Blackmagic 
I/O card. For more information about outputting Stereo 3D to an external display, see 
Chapter 4, “Stereoscopic Workflows.”
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The viewer set to display an anaglyph stereo image in color

Floating Windows

Floating Windows are meant to correct for “Window violations,” where elements of the image with 
negative parallax, that project forward from the screen plane towards the audience, are cut off by 
the edge of the frame. In these instances, differences between the images being shown to the left 
and right eyes can result in a visual paradox that’s difficult for viewers to reconcile. Specifically, when 
a forward-projecting element is cut off by the left or right edge of the frame, one eye sees things 
that the other eye does not.

If the subject is moving quickly, this may not be an issue, but if the cut off (or occluded) element 
lingers onscreen, it causes problems for viewers that defeat the stereo 3D illusion. The viewer’s 
binocular vision (or stereopsis) is providing one depth cue, while occlusion is providing a completely 
different depth cue. 

To fix this, you can use Floating Windows to crop the cut off object from the eye on the side of the 
object that’s cut off, thus eliminating the portion of the stereo image that is unseen to the other eye 
that causes the problem.

The objective of using Floating Windows is to manipulate the illusion of the viewer’s “window into 
the scene.” In addition to fixing Window violations, it has been proposed that Floating Windows 
can be used as a creative tool by manipulating the geometry of this Window to alter subtly the 
viewer’s perception of the screen orientation.

>> By cropping the right-hand side of the right-eye frame, you also create the illusion that the 
right edge of the “window into the image” is tilted farther forward toward the viewer. 

>> By cropping the left-hand side of the left-eye frame, you create the illusion that the left 
edge of the Window is tilted toward the viewer. 

>> If you crop both the left-hand side of the left-eye frame and the right-hand side of the right-eye 
frame, you create the illusion that the entire plane of the “virtual screen” is coming toward you. 
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>> If you apply opposite-angled Windows to the left- and right-eye clips at one or both of the 
edges of the frame, it appears to “tilt” the screen toward or away from the viewer.

Tip: For more information about Floating Windows, see www.dashwood3d.com/help/stereo3d-
virtual-floating-windows/ and river-valley.tv/the-dynamic-floating-window-a-new-creative-tool-for-
3d-movies/.

Animating Floating Windows

Floating Windows can be animated using the Float Window keyframing track, found within the 
Sizing track of the Keyframe Editor, to push the edge of the frame in as needed, and then pull it back 
out when the partially occluded subject has moved fully into the frame. For more information about 
animating keyframing tracks, see Chapter 6, “Keyframing.”

Floating Window controls

Floating Windows have the following controls and parameters.

>> L/R/T/B buttons: Lets you choose an edge to which to apply a Floating Window. Click the 
button corresponding to the edge you want to adjust. Each edge has its own position, 
rotate, and softness settings.

>> Position: Adds masking to the currently selected edge.

>> Rotate: Rotates the currently selected edge, letting you create an angled Window.

>> Softness: Feathers the edge of the currently selected edge, letting you create a soft 
Window that can be less noticeable to viewers.

To add a Floating Window to fix a Window violation:

1.	 Choose to which eye you want to add the Floating Window. 

>> To apply a Floating Window to eliminate a Window violation on the right-hand side of the 
screen, click the right eye view. 

>> To apply a Floating Window to eliminate a Window violation on the left-hand side of the 
screen, click the left eye view.
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2.	 Choose which edge you want to adjust by clicking the L or R buttons.

>> To eliminate a Window violation on the right-hand side, click R.

>> To eliminate a Window violation on the left-hand side, click L.

3.	 Adjust the Position parameter as necessary to crop the portion along the edge of the selected 
eye that’s not visible in the other.

4.	 Optionally, if you feel that the Window adjustment you’ve just made is too obvious, increase 
the Softness parameter to make that edge less noticeable.

Stereo Controls on the DaVinci Control Surface

If you’re doing convergence adjustments and stereographic work throughout a program, you can 
use many of the controls described in this section from the DaVinci control surface.

To show the Stereo Transform Controls page on the Transport panel:

1.	 Press the 3D soft key. The Transport panel’s knobs and soft keys are remapped with all available 
Stereoscopic commands.

2.	 When you’re finished, press MAIN.

To show the Floating Windows controls on the Center panel:

1.	 From the main page of the Center panel, press the 3D soft key. The Floating Windows, Auto 
Match, and Auto Align controls appear on the Center panel. 

2.	 Press the 3D OVERLAY soft key to expose the Stereoscopic sizing controls on the Transport 
panel. Press 3D OVERLAY again to return to the ordinary sizing controls.

3.	 When you’re finished, press the MAIN soft key to return exit the 3D control page.
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Data Burn In

The Data Burn In palette lets you display select metadata as a “window burn” that’s superimposed 
over the current image in the Viewer. This window burn is written into files that you render in the 
Deliver page, and it’s also output to video, for viewing on your external display, or for 
outputting to tape.

Data Burn-in palette

Window burns are useful as a reference when creating offline media that you need to keep track of 
later. It’s also useful for watermarking review files that you don’t want to be distributed accidentally, 
for adding logos or “bugs” to programs in preparation for broadcast, or for temporarily displaying 
timecode or clip names to refer to on your monitor when reviewing dailies with a client.

Tip: There’s also an Output Option checkbox on the Deliver page, “Burn in this text,” that lets you 
quickly enter a line of custom text to output as a window burn without using the Data Burn In palette.

Viewer displaying a logo, custom text, timecode and file path
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Project vs. Clip Mode

The Palette mode pop-up menu lets you choose whether you want to edit burned-in metadata on 
a clip-by-clip basis to be applied when rendering individual source clips, or one set of burned-in 
metadata that will be displayed for the entire duration of the Timeline, to be applied when rendering 
either individual source clips or as one single clip.

Setting Up Burned-In Metadata

Setting up different clip and project metadata to output as a window burn is easy.

To set up a window burn:

1. 	 Choose Project or Clip mode from the Palette mode pop-up menu.

2.	 Turn on the checkboxes of whatever items of metadata you want to display in the “Add to Video 
Output” column. More information about the available items appears later in this chapter.

	 The first item of metadata is centered near the bottom of the frame, above Action Safe. Each 
additional item of metadata you turn on for display is added above whichever items are already 
displayed, regardless of their position in the “Add to Video Output” list.

3.	 Click any currently enabled item of metadata from the list to highlight it in orange, and edit 
that item’s Custom Output parameters at the right. More information about the available 
parameters appears later in this chapter.

To reset the current window burn setup:

>> Click the Options pop-up menu, and choose Reset to reset the current mode of the Data 
Burn In palette.

Saving and Loading Burn-In Presets

If there are common sets of metadata that you regularly use and switch among, you can save each 
set up as a preset for future use.

To save a burn-in preset:

1.	 Click the Preset name field, and type a name.

2.	 Click the Preset Options pop-up menu, and choose Add Preset. That preset is added to the 
list of saved presets.
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To delete a burn-in preset:

1.	 Choose a preset from the Preset menu.

2.	 Click the Preset Options pop-up menu, and choose Del Preset.

To modify a burn-in preset:

1.	 Choose a preset from the Preset menu.

2.	 Edit it however you like.

3.	 Click the Preset Options pop-up menu, and choose Update Preset.

Data Burn-In Options

The leftmost column in the Data Burn In palette contains a scrollable list of all the options that you 
can add to the video output as a window burn. Each option has a checkbox that lets you turn it on 
or off. You can also select in the Option pop-up if you would like the item name rendered as a prefix 
to the burn-in data.

Note: If two clips overlap in the Timeline, the metadata that matches the currently visible clip in the 
Viewer is what will be displayed in the window burn. 

>> Record Timecode: The timecode relative to the Timeline, as set in the Conform Options in 
the Master Project Settings of the Project Settings.

>> Record Frame Number: The number of frames from the first frame of the Timeline.

>> Source Timecode: Each clip’s individual timecode.

>> Record TC & Frame Num: Both metadata options combined in one line.

>> Source TC & Frame Num: Both metadata options combined in one line.

>> Source & Record TC: Both metadata options combined in one line.

>> Audio Timecode: The timecode of audio that’s been synced to a clip.

>> Keycode: Also referred to as edge-code, the identification codes running along the edge 
of film stocks that provide an absolute reference for which digital frames correspond to 
which film frames.

>> Source File Name: The full file path, including file name, of the media file that’s linked to 
the current clip.

>> Record File Name: The file name as defined in the Render Settings list of the Deliver page.

>> Source Clip Name: The file name of the media file that’s linked to the current clip, without 
the file path.
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>> Custom Text1: A line of text that you type into the Text field of the Custom Output 
parameters. You can use any characters you like.

>> Custom Text2: A second line of text that you can customize.

>> Custom Text3: A third line of text that you can customize.

>> Logo1: Lets you superimpose a graphic over the image in a customizable location. 
Compatible graphics formats include PNG, TGA, TIF, BMP, and JPG. Alpha channels are 
supported for transparency in logos.

>> Logo2: Lets you superimpose a second graphic.

>> Logo3: Lets you superimpose a third graphic.

>> Reel Name: The currently defined reel number for the current clip.

>> Shot: Shot metadata, if it’s been written to the file by a camera, or entered into the Metadata 
Editor on the Media page.

>> Scene: Scene metadata, if it’s been written to the file by a camera, or entered into the 
Metadata Editor on the Media page.

>> Take: Take metadata, if it’s been written to the file by a camera, or entered into the Metadata 
Editor on the Media page.

>> Angle: Angle metadata, if it’s been written to the file by a camera, or entered into the 
Metadata Editor on the Media page.

>> Day: Day metadata, if it’s been written to the file by a camera, or entered into the Metadata 
Editor on the Media page.

>> Date: Date metadata, if it’s been written to the file by a camera, or entered into the Metadata 
Editor on the Media page.

>> Circled Take: Corresponds to Good Take metadata, if it’s been written to the file by a 
camera, or entered into the Metadata Editor on the Media page.

>> Camera: Corresponds to the Roll/Card metadata, if it’s been written to the file by a camera, 
or entered into the Metadata Editor on the Media page.

>> Roll/Card: Corresponds to the Roll/Card metadata, if it’s been written to the file by a 
camera, or entered into the Metadata Editor on the Media page.
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Tags For Populating Text Fields With Metadata

When entering custom text using any of the appropriate options listed above, you can use tags 
to automatically populate a custom field with data from the current clip. If necessary, you can also 
use multiple tags together as long as they’re separated by commas, spaces, or a dash. When using 
these tags, the tag is replaced by the metadata it references in the window burn.

>> Tape Number from EDL: %T

>> Resolution of the rendered file (i.e., 2048x1556): %R

>> Event number from the EDL: %E 

>> Clip number as displayed in the Timeline thumbnail: %I 

>> Version name of the rendered file: %V 

>> Stereo project, Left or Right eye: %{eye}

>> Reel Number extracted from source filename/clipname: %L 

>> Shot: %{shot}

>> Scene: %{scene}

>> Take: %{take}

Custom Output Options

The parameters in the Custom Output panel let you modify the look, position, and in some 
cases content, of the selected metadata item. Pan and Tilt are individually customizable for each  
metadata item.

You have the option of independently styling each item of metadata, depending on whether the 
Gang Render Text Styles option is checked in the Option pop-up. When turned on, all text metadata 
share the same font, size, color, background, justification, and opacity. When turned off, each item 
of metadata can have individual settings.

>> Font: Defaults to Courier, but you can choose any font that’s installed on your system.

>> Size: Defaults to 48, but you can choose standard increments from 6 to 72.

>> Color: Defaults to white, but you can choose from a range of predefined colors in this 
pop–up menu.

>> Background: Defaults to black, although the apparent color is influenced by the Opacity 
setting. For a more garish look, you can choose from a range of predefined colors in this 
pop-up menu.

>> Justify Text: Defaults to Center. The only other option is Left.
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>>Opacity: Defaults to 0.50. Lets you define the transparency of the burned-in metadata’s 
background color.

>> Pan: Lets you change the horizontal orientation of the current item of metadata. The default 
value is the center of the frame, relative to the current project’s frame size.

>> Tilt: Lets you change the vertical orientation of the current item of metadata. The first item 
of metadata is centered near the bottom of the frame, above Action Safe. Each subsequent 
item of metadata you turn on is automatically placed above the previous item of metadata, 
regardless of its order in the “Add to Video Output” list.

>> Show for first: Turning on this checkbox lets you specify a number of frames during which 
the current item of metadata will be displayed before dissolving away over one second. 
When enabled, the current item of metadata will cut onscreen with the beginning of each 
new clip, remain onscreen for the duration specified, and then dissolve away.

>> Show for last: Turning on this checkbox lets you specify a number of frames before the end 
of each clip during which the current item of metadata will appear onscreen after fading up 
over one second, before cutting away with the end of the clip.

>> Text: A text field that lets you enter custom text to display as one of three possible custom 
text items.

>> Logo: A field that displays the file path of any currently selected graphic that you’re displaying 
as one of the three possible Logo graphics. Compatible graphics formats include PNG, 
TGA, TIF, BMP, and JPG. Alpha channels are supported for transparency in logos.

>> Import File button: Lets you choose a graphics file to use as a logo.
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Node Editor Basics

By default, every clip has one node in the Node Editor that contains the first corrections you make 
to a clip. However, you also have the option of creating multiple nodes, where each node contains 
one or more corrections that affect the image.

Node Editor

The specific arrangement of nodes you create lets you exert precise control over the order of 
operations performed by your grade, which provides many advantages. This section covers different 
ways of creating, editing, and arranging node trees to harness the full power of DaVinci Resolve.

The Node Editor Interface

As you work within the Node Editor, you may find the need to zoom into or out of it to get a better 
look at the node tree, and to pan around the working area to deal with large collections of nodes.

To expand the size of the Node Editor’s working area:

>> Drag the border between the Node Editor and the Gallery to the left or right to make it 
wider or narrower.

>> Right-click anywhere within the Node Editor (except on a node) and choose Toggle Display 
Mode, which hides the Viewer and moves the Node Editor to the right of the Gallery, 
enlarging it considerably. Right-click and choose Toggle Display Node again to return to 
the default layout.

>> You can toggle Display mode using the DaVinci control surface by pressing SHIFT UP and 
the DISPLAY/CURSOR button above the fourth trackball on the Center panel.
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To zoom and pan within the Node Editor, do one of the following: 

>> Scroll up to zoom in, scroll down to zoom out.

>> Use the Node Editor’s zoom slider.

>> Click and drag the gray area of the Node Editor to pan around.

>> Right-click and choose Zoom In or Zoom Out.

>> Right-click and choose Zoom to Window to fit the node tree to the current size of the 
node graph.

>> Right-click and choose Original Size to return the node graph to the default size.

The Components of a Node Tree

Ambitious grades may require trees of multiple nodes to create the necessary effect. This section 
covers the mechanics of putting nodes together into the structures that are described in more 
detail later in this chapter.

Every serial and parallel node you add is a “corrector” node, which is capable of either primary or 
secondary correction, depending on whether or not you enable the Qualifier/Window/Matte 
controls. As a result, each Corrector node has two inputs and two outputs, which lets you separately 
manage the RGB image channel, and the Key channel. The Key channel can be used to define areas 
of isolation for image processing operations, or transparency for compositing.

A single node, the round RGB and triangular KEY inputs and outputs are clearly visible

Nodes are attached to one another via “connections,” seen as lines that connect one node to 
another. Image data flows from left to right, starting with the Source bar all the way at the left of 
the Node Editor, through each node in the tree, and ending at the Output bar at the right of the 
Node Editor.
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A simple serial arrangement of corrections

Here’s an explanation of the different components of a basic node tree, and how they fit together:

>> Source Bar: The source is the clip as processed by the Sizing and Source decode settings, 
ungraded. It’s represented by the gray bar to the center left of the node graph. The Source 
bar outputs RGB data, and is connected to the RGB input of the first node in your tree. 
You can connect the Source bar to more than one Corrector node, creating multiple 
simultaneous streams of image processing that you can eventually recombine in different 
ways using the Parallel or Layer Mixer nodes.

>>Nodes: Each node in the node graph represents a collection of image processing 
operations that can be enabled or disabled separately from any other node in the graph. 
By separating operations into multiple nodes, you’re able to precisely control image 
processing operations to create many different corrections and effects. The RGB input and 
output of each node in the Node Editor must be connected for a grade to be enabled. 
Each node’s thumbnail image shows the state of the image at that particular stage of the 
grade, giving you a visual indication of what that node is doing.

>> RGB Inputs and Outputs: The yellow dots at the upper right and left of each node are used 
to connect the RGB image output from one node to the RGB input of the next node. For a 
Corrector node to have an effect, you must connect both its RGB Input and its RGB output 
to neighboring nodes in the tree.

>> Key Inputs and Outputs: The blue triangles at the bottom right and left of each node are 
used to route the key channel generated by a node’s Qualifier or Window controls, or 
imported via a Matte clip that you previously associated with a clip in the Media page. 
When you connect the Key output of one node to the Key input of another, you basically 
copy the first node’s key to the second node. You can also combine the Key outputs of 
multiple nodes in various ways using the Key Mixer node.

>>Output Bar: The RGB output of the last node in a tree must be connected to the Output 
bar, which “completes the circuit” of image processing, and passes that correction on 
to the next stage in the DaVinci Resolve image processing pipeline. If the output is not 
connected, the node tree has no effect on the clip. You can only connect one RGB output 
at a time to the Output bar.
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>> Second Source Bar (for HDR): You can access the alternate highlight exposure of RED HDR 
media by exposing this optional second Source bar. For more information, see “Node 
Tree Structures.”

>> Alpha Output Bar: It’s possible to create regions of transparency for compositing directly 
in DaVinci Resolve by connecting a Key output to an optional Alpha Output bar. For more 
information, see later in this chapter, “Manipulating and Combining Keys.”

Node Badges and Labels

Nodes appear with various labels and badges to help you identify what each node is contributing 
to the overall grade. How long a label and how many badges appear depends on the size of each 
node, as set by the Node Editor’s Zoom slider.

Nodes showing the kinds of labeling and badges that are available for identifying what operations each node is performing

>>Node number: Nodes are numbered in the order in which they were created, making it 
possible for you to select specific nodes by number via the DaVinci Control Surface.

>> Adjustment badges: As you apply various operations within a node, up to four badges 
appear at a node’s default size in the Node Editor (three if a Color Space label appears) 
identifying which operations have been applied. At larger sizes, more badges can appear 
at once. Each palette has a badge. If you apply more operations than a node has area to 
display, a single “downward arrow” badge appears.

>> Color Space labels: If you switch a node to use a color space other then RGB, that color 
space’s three letter label appears between the node number and any Adjustment badges 
that appear.

Labeling Nodes

Nodes can be labeled to identify a particular node’s function in your grade. This can make it easier 
to revise a grade months later. Node labels are also saved when you save a still, so labels can also 
make it easier to decipher a saved grade down the road. At each node’s default size in the Node 
Editor, nodes can appear with up to 12 characters of text, although larger nodes can accommodate 
more text.
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To label a node:

1.	 Right-click a node and choose Change Label.

2.	 Type a label into the Change Node Label dialog, and click OK.

	 The label you entered appears above the node in the Node Editor.

Selecting Nodes

The node that’s currently selected in the Node Editor is highlighted in orange, and is referred to 
as the current node. When you adjust any of the parameters or settings in the Color page, you’re 
adjusting parameters within the current node. You can only select one node at a time.

To select a node, making it the current node, do one of the following:

>> Double-click any node in the node graph.

>> Using the Transport panel of the DaVinci control surface, press the PREV NODE or 
NEXT NODE buttons.

>> Using the Transport panel of the DaVinci control surface, enter the number of the node you 
want to select using the keypad, and then press the SELECT NODE button.

When you select another clip in the Timeline, the default behavior is that the last node that was 
selected when you worked on that clip is the one that’s selected when you move to that clip again. 
However, a setting in the Project Settings window, “Switching clips,” lets you change this behavior. 
For more information on this option, see Chapter 3.

Disabling Nodes

In the process of creating a node tree, it’s often useful to turn nodes off to disable their effect on 
your grade. It’s also useful to turn the entire node tree off and on in order to see “before and after” 
views of the current clip. Disabled nodes are not processed during rendering, and they remain 
disabled when you save that grade along with a still in the Gallery and then apply that grade to 
another shot.

To toggle individual nodes off and on:

>> Click the number of any node in the node graph to disable that node by itself. 

>> Select a node, and choose Nodes > Enable/Disable Current.

>> Press Control-D.

>>On the DaVinci control surface, press the DISABLE CURRENT button (on the T-bar panel).
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To turn every node off and on at once: 

>> Press Option-D to toggle all nodes off and on. 

>>On the DaVinci control surface, press SHIFT-DOWN and then the DISABLE CURRENT 
button (on the T-bar panel).

Important: When you turn every node off and then on again, every node is re-enabled, even nodes 
that had previously been individually disabled.

Bypass All Grades

You can also use a separate command to disable grading altogether. This is useful if you’ve toggled 
specific nodes off in the node tree, and you want a before and after look at the node tree with those 
nodes turned off. When Bypass All Grades is enabled, grading is disabled for all clips in the entire 
Timeline until you disable it.

To toggle grading off and on, do one of the following:

>> Click the disable grading button at the bottom right-hand corner of the Node Editor.

>> Choose View > Bypass All Grades (Shift-D)

Resetting Nodes

If you’re dissatisfied with your current operations and want to start over, there are three ways you 
can reset nodes in the Node Editor. These are available as items in the Color menu, and buttons on 
the DaVinci control surface’s T-bar panel.

>> Reset Selected Node Grade: Resets the currently selected node, eliminating all keyframes, 
to the default parameter settings.

>> Reset Grades and Keep Nodes: Resets every node in the current node tree, without 
affecting the node tree’s structure; all nodes remain where they were. However, each node 
has been reset to the default parameter settings, and all keyframes have been eliminated.

>> Reset All grades and Nodes: Deletes every node and keyframe, and restores a single node 
set to the default parameter settings.

Previewing and Restoring Node Trees

There are two other methods of quickly dealing with unwanted changes you’ve made to node trees, 
without needing to use undo.

>> Preview Memory: Lets you preview the effect of any saved grade on the current clip. To 
preview, choose Color > Preview Memory (Shift-Command-M), and then right-click any 
saved still in the Gallery (or Memory) and choose Add Correction. If you like the effect, 
then you can leave it be. If you don’t like the effect, then choosing Color > Preview Memory 
again reverts the clip to the original grade.
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>>Original Memory: This command lets you quickly revert a clip’s grade to its original state 
when you first selected that clip. This is useful for getting immediately back to a clip’s original 
grade if you’ve made a series of changes that you then regret. Selecting another clip in the 
Timeline and then reselecting the clip you made changes to resets what is considered to 
be the current grade.

Caching Specific Nodes to Improve Performance

You can flag specific nodes to be cached, along with all nodes appearing upstream in that node 
tree. By caching nodes using processor-intensive effects, you free up real-time capability for the 
remaining downstream nodes in a grade. Choosing Playback > Render Cache > User only caches 
nodes that you’ve flagged for caching.

When you choose Playback > Render Cache > Smart mode, Resolve automatically caches any nodes 
that use Motion Blur, Noise Reduction, or OFX plug-ins, without you needing to do anything.

To flag a node and all corrections made in upstream nodes for caching:

>> Right-click any node and choose Node Cache > On from the contextual menu.

Editing Node Trees

There is no limit to the number of nodes you can create and connect to one another, and you can make 
as many or as few parameter adjustments as you like within each node. The following procedures 
describe the ways you can add nodes to the node graph as you build each grade’s node tree.

Adding Nodes

The simplest thing you can do to add to the complexity of a node tree is to add additional nodes, 
in order to add more adjustments to the current grade.

Basic methods of adding nodes to the tree:

>> To add a serial node after the currently selected node: Press Option-S key, choose Nodes 
> Add Serial from the menu, or press the ADD SERIAL button on the T-bar panel of the 
DaVinci Resolve control surface.

>> To append a serial node to the very end of the node tree: Press Option-A, choose Nodes 
> Append Node from the menu, or press the APPEND NODE button on the T-bar panel of 
the DaVinci Resolve control surface.

>> To add a serial node before the currently selected node: Press Option-Shift-S, or choose 
Nodes > Add Before Current, or press SHIFT DOWN and then ADD SERIAL on the T-bar 
panel of the DaVinci Resolve control surface.

>> To add nodes in parallel to the currently selected node: Press Option-P, choose Nodes > 
Add Parallel from the menu, or press the ADD PARALLEL button on the T-bar panel of the 
DaVinci Resolve control surface.
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>> To layer nodes with the currently selected node: Press Option-L, choose Nodes > Add 
Layer from the menu, or press the ADD LAYER button on the T-bar panel of the DaVinci 
control surface.

>> To add a disconnected node to the node graph: right-click anywhere within the node 
graph’s background, then choose Add Node > Corrector from the contextual menu. 
Disconnected nodes have no effect on a node tree until they’re connected.

Adding Nodes with Windows Turned On

There are also dedicated commands for adding serial nodes with Circular/Linear/Polygon/Curve 
windows automatically turned on, for convenience. 

To add a node to the tree with a Window automatically enabled:

Choose an item from the Nodes menu, or press the button on the T-bar panel of the DaVinci 
Resolve control surface that corresponds to the following:

>>Node + CPW: Circular Power Window (Shift-C)

>>Node + LPW: Linear Power Window (Shift-Q)

>>Node + PPW: Polygonal Power Window (Shift-G)

>>Node + PCW: Power Curve Window (Shift-B)

Whenever you add a node to a tree, it’s numbered consecutively to come after the next most recent 
node you’d added, regardless of the order in which it appears in the node tree. For example, if 
you’ve already added three nodes, and then you decide to add another node in between Nodes 1 
and 2, the new node will be Node 4, and the order of the nodes will be 1, 4, 2, and 3.

Deleting Nodes

If there’s a node that you no longer need, you can choose to remove it completely from the node 
tree to remove its effect permanently.

To delete a node, do one of the following:

>> Select a node, then press the Forward-Delete key.

>> Right-click a node, and choose Delete Node.

>> Using the DaVinci Resolve control surface, select any node, and press the DEL-CURRENT 
button (on the T-bar panel).

After you’ve deleted a node, the node to the left and right of the node you deleted are automatically 
connected so that the node tree is unbroken. Also, all the nodes in a tree are renumbered after the 
deletion of any node, so there’s no discontinuity in node order. For example, if you have three 
consecutively numbered nodes in a tree and you delete the second one, the node that was formerly 
number 3 is renumbered to be 2.
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Disconnecting and Reconnecting Nodes

For a node tree to work, every node in the Node Editor must be connected into a working node 
tree, from the Source bar, through each node in the tree, to the Output bar. Any disconnected node 
will result in that clip’s grade being disabled. However, you may find the need to disconnect some 
parts of a node tree in order to reconnect them in different ways.

To disconnect two nodes:

>> Click a link to select it (selected links turn yellow), and then press the Forward-Delete key.

>> Right-click a link and choose Delete Link.

To connect two disconnected nodes:

>> Click-and-drag from the RGB or Key output of one node to the corresponding RGB or Key 
input of another, and when the dotted line turns solid, release the mouse button.

You can connect any node’s RGB or Key output to as many inputs as you want, but you can only have 
one connection going to a node’s input. The exception to this is a node with multiple inputs, designed 
to combine the output of multiple nodes. These include the Parallel, Mixer, and Key Mixer nodes.

To insert a disconnected node between two other nodes:

>> Drag a disconnected node onto the connection between any two other nodes in a node 
tree, and when a plus icon appears over the node you’re dragging, drop it to insert the node.

Rearranging Node Order

The order in which nodes are connected in your tree affects the result of a grade. For example, 
if you boost the highlights in the first node, and then you try to isolate a portion of the picture in 
a second node that you now realize has been clipped, you may to need to change your order of 
operations to optimize your corrections.

To reorder two or more nodes:

1.	 Delete every link that connects the nodes you want to rearrange.

2.	 Drag the nodes into the new order you want them in the node graph (it pays to be tidy), and 
then reconnect the RGB outputs and inputs until all nodes in your tree are reconnected in the 
order you want them.

Keeping Node Trees Organized

It’s a good idea to keep the arrangement of your nodes in the node graph clean and neat. It’ll make 
it easier to read your tree if you need to revisit a grade later on, and it will also make it easier for other 
colorists working on the same project to figure out what you’re doing. The following procedures 
describe how to rearrange the nodes in your tree, and the node tree working area, to help you keep 
on top of your grades.
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To move a node to another position in the grid:

>> Click a node with the pointer and drag it to a new position.

Another nice organizational feature of the Node Editor is an automatic tooltip that appears whenever 
you hover the pointer over a particular node, that shows you a concise list of all the operations 
applied to that particular node.

Copying Nodes and Node Settings

You may save time when assembling complicated node trees by recycling nodes or node settings 
from previous grades.

Copying Nodes From Other Clips

When constructing node trees, you may sometimes find it necessary to copy nodes from one clip’s 
grade to another. This can be accomplished by exposing the node tree of any still that’s saved in the 
Gallery, or any clip in the Thumbnail timeline, and copying individual nodes from the exposed node 
tree to the Node Editor.

Dragging a node from a node graph to the node editor

To copy nodes from any still in the Gallery:

1.	 Right-click a still in the Gallery, and choose Display Node Graph. A Node Graph window 
appears displaying that still’s node tree.

2.	 Drag any node from the node tree directly over any connection line in the Node Editor. When 
a small plus icon appears over the Corrector node icon you’re dragging, drop the node to 
insert it into that connection.

3.	 Click Exit when you’re finished.
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To copy nodes from any clip in the Timeline:

1.	 Click the thumbnail in the Timeline of the clip to which you want to copy nodes.

2.	 Right-click the thumbnail of the clip you want to copy nodes from, and choose Display 
Node Graph.

	 Note: The Display Node Graph command only appears in the contextual menu of a clip in the 
Thumbnail timeline that is not currently selected.

3.	 Drag any node from the node tree directly over any connection line in the Node Editor. When 
a small plus icon appears over the Corrector node icon you’re dragging, drop the node to 
insert it into that connection.

4.	 Click Exit when you’re finished.

Using this mechanism, you can also copy every node in the node tree using the Apply Color button, 
or copy just the Sizing (Pan/Tilt/Zoom/Rotate parameters) using the Apply Sizing button.

Copying Node Settings

You may also find yourself needing to copy one node’s settings to another node. In particular, this 
is the only way of copying tracking data or keyframes from one node to another, either within the 
same grade, or from one grade to another.

To copy a node’s settings to another node:

1.	 In the Node Editor, select the node with settings you want to copy, and choose Edit > Copy 
(Command-C).

2.	 Select the node you want to paste these settings to, and choose Edit > Paste (Command-V).
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There are several ways you can organize nodes in a tree. Each method lets you control a group of 
image processing operations in different ways to achieve specific results. This section covers how to 
use Serial nodes, Parallel nodes, and Layer nodes, as well as how to use LUTs, work with HDR media 
that lets you combine two different exposures using two different Source bars, and apply additional 
project-wide adjustments using the Timeline grade.

Serial Node Structures

The simplest, and most common node structure is a serial cascade of nodes, where a linear series 
of nodes is connected, one after another. 

Serial nodes, the output of one node goes into the next

Much of the time, this method of constructing a tree of multiple operations is all you need to do. It’s 
a simple and intuitive way of organizing your adjustments, similar in principle to the stacks of layers 
used in other grading and compositing applications to apply multiple operations to a clip.

Controlling What Feeds a Node’s RGB Input

When you create a grade using serially arranged nodes, each node’s output is used as the next 
node’s input, so the order in which the nodes are arranged determines the order of image 
processing operations. 

In the following screenshot, the node tree shows a series of three operations that are applied to a 
log-exposed, low-contrast clip. The first node expands clip contrast and increases saturation. The 
second node isolates the green foliage to intensify its color. The third desaturates and warms the 
image. At right, you can see the result of this node tree.

Node two pulls a clean key from the image data fed it by node one

Node Tree Structures
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If, instead, we reversed the order of Nodes 2 and 3, the result will be a less effective key.

By comparison, node three pulls a less then optimal key from the image data fed it by node two

Because the secondary operation is sampling the desaturated image, rather than the source, the 
HSL Qualifier’s key has less image data to work with, and thus you get an inferior result.

Parallel Node Structures

Another way to organize your corrections is to use a Parallel node structure, which lets you apply two or 
more overlapping adjustments at a single stage of a node tree. You can use the Parallel node structure 
for organizational reasons when there is a group of secondary corrections that you want to apply all at 
once. You can also use this structure for the unique way it blends overlapping image adjustments.

The Parallel Mixer node that makes this possible has multiple RGB inputs and a single RGB output. This 
lets the Parallel Mixer mix together multiple Corrector nodes, outputting a single image as a result.

When you add a Parallel node to an existing node, DaVinci Resolve automatically adds one Corrector 
node below the current node, and adds a Parallel Mixer node to its output.

Adding a Parallel node to Node 2 automatically adds the Parallel Mixer

Tip: If you want to create a series of Parallel nodes that connect to the output of the currently 
selected node, create a Serial node before you create your first Parallel node.

If you’re manually connecting another node to a Parallel Mixer node, you must first create an 
additional input to connect it to.
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To create an additional, unconnected input on a Parallel Mixer node:

>> Right-click a Parallel Mixer node and choose Add One Input.

Ordinarily, the RGB input of every Corrector node that’s connected to a Parallel node is connected 
to the output of the same node. This results in a stack of nodes that take the same state of the image 
as their input. This makes it easy to apply multiple secondary operations without worrying about 
whether or not a change to one will affect the keys of the others.

Further Parallel nodes can be added as you wish with each using a common source

If you add another node in parallel, the Parallel Mixer automatically adds another input. You can 
have as many nodes in parallel as you need. 

The adjustments made by all nodes that are connected to a Parallel Mixer are combined equally, 
regardless of which nodes are highest. In the following example, a separate overlapping Window is 
applied by each of three nodes in parallel.
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As you can see in the image at right, the three tints created by the overlapping Windows are all mixed 
together equally; the colors blend with one another as if they are optically mixed. Most of the time, 
this is exactly what you want when you’re blending overlapping naturalistic color adjustments.

Converting Parallel Mixers to Layer Mixers

On the other hand, if you need your overlapping color adjustments to have priority over one another, 
or if you want to combine multiple adjustments using composite modes, then you may want to use 
the Layer Mixer node instead. If you’ve created a Parallel Mixer structure and you want to convert it 
to a Layer Mixer, you can.

To change a Parallel Mixer node into a Layer Mixer node:

>> Right-click a Parallel Mixer node and choose Morph Into Layer Mixer Node.

Layer Mixer Node Structures

The Layer Mixer is structurally quite similar to the layout used by the Parallel Mixer. However, there 
are two key differences. First, the Layer Mixer node combines multiple adjustments with priority 
given to the image adjustment in the lowest overlapping node input. Second, you have the option 
of combining all of the Corrector nodes that are connected to a Layer Mixer using one of several 
different composite modes, to create a wide variety of visual effects.

Because of their similarities, layering nodes with the Layer Mixer works in much the same way  
as creating a Parallel node structure. 

Layer Mixer Prioritization

In the following example, the same node structure from the Parallel Mixer example is shown, this 
time with the three overlapping color adjustments mixed together using the Layer Mixer.

The Parallel Mixer blends all input nodes together
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Now, instead of the three adjusted color tints being blended, you can see that the green tint, which 
is connected to the lowest input of the Layer Mixer, is dominant and covers the overlapping regions 
of the two other adjustments. Meanwhile, the blue tint, which is connected to the middle input 
of the Layer Mixer, covers the overlapping portion of the orange tint, which is connected to the 
highest input of the Layer Mixer.

Rearranging which connections are attached to which Layer Mixer inputs changes each node’s 
priority, and like the Parallel Mixer, you can add more inputs if you need to connect more 
nodes manually.

The Layer Mixer’s prioritization is most useful when you have an overlapping adjustment that you 
need to override any other adjustments happening on that stack. In the following example, two 
nodes are connected to the Layer Mixer node. Node 2 is applying a high-contrast, cool look to the 
entire clip. Node 3 isolates the skin tone, which is unflattering with the background stylization, and 
applies a different, more naturalistic adjustment.

The Layer Mixer prioritizes nodes connected to lower inputs such that each node’s output completely obscures whatever is behind it
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Using the layer mixer, grades on Node 4 will have a greater priority over Node 2, so the final grade combines  

the high contrast from Node 2 with the adjusted skin tone from Node 4

Because of the Layer Mixer’s prioritization, the adjustment made to the man’s skin tone completely 
covers the adjustment made to the node that comes above it, providing the best of both worlds 
with one simple adjustment.

Tip: If you want to “solo” overlapping nodes that are connected to the Layer Mixer to see their 
individual adjustment, turn on Highlight (Shift-H, or the HILITE button on the Transport panel of the 
DaVinci control surface). This lets you view just that node’s effect, regardless of what other nodes 
adjustments are overlapping.

Using Composite Modes With the Layer Mixer

You have the option of combining the adjustments made by all nodes connected to a Layer Mixer 
node using the same Composite modes that are available when compositing clips in the Timeline. 
This lets you combine different overlapping image adjustments using compositing math to achieve 
creative effects or utilitarian fixes.

The following simple example shows two overlapping Corrector nodes connected to a Layer 
Mixer node that’s set to the Add composite mode. Node 2 has no adjustment, but Node 4 has an 
extremely high-contrast curve adjustment applied, along with a push to orange in the highlights 
and a blur, that effectively isolates the highlights of the image and fires them up.
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Combining two nodes using the Layer Mixer set to Add to create a glowing effect

By adding both treatments together, a hot glow has been created, blowing out the highlights of 
the image. Many, many other effects are possible using the different composite modes that are 
available. For more information on composite modes, see Chapter 7, “Edit Page Effects.”

Adjusting Layer Node Strength Using Key Output Gain

Whether you’re combining overlapping corrections, or mixing different adjustments using 
Composite modes, you’ll run into situations where you want to reduce the influence of one 
overlapping adjustment relative to the other nodes that are connected to the Layer Mixer node. 
This can be accomplished using each overlapping node’s Key Output Gain parameter, located in 
the Key palette.

Using the Output Gain parameter in the Key palette
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Key Output Gain defaults to 1.00, but lowering this value reduces the strength of that node’s 
contribution to the Layer Mixer. Using the previous example, selecting Node 4 (the high-contrast 
image used to create the glow), opening the Key palette, and reducing the Key Output Gain 
parameter to 0.50 reduces the intensity of the glow effect by half.

You can use Key Output Gain to mix the proportion of any number of overlapping adjustments in 
order to create the perfect combination for your purposes.

Tip: You can also use the Key Output Gain parameter to mix the proportion of adjustments being 
combined using the Parallel Mixer node.

Converting Layer Mixers to Parallel Mixers

You can easily convert a Layer Mixer to a Parallel Mixer should you discover that you need to mix 
your overlapping corrections evenly rather then combine them with priority. Keep in mind that you’ll 
lose the ability to use Composite modes.

To change a Layer Mixer node into a Parallel Mixer node:

>> Right-click a Parallel Mixer node and choose Morph Into Parallel Node.

Applying a LUT Within a Node

Look up tables (LUTs) are frequently used to create a starting point adjustment for media acquired 
with some sort of logarithmic (log) exposure. DPX log film scans, digital media using the ARRI 
ALEXA’s Log-C encoding, Sony’s S-Log exposure setting, or RED R3D media that is debayered using 
the REDFilmLog setting are all examples of media using a logarithmic exposure curve, designed 
to protect as much detail in the highlights and shadows of a digitally encoded image as possible. 
While log-encoded media retains a lot of image data, the picture is initially flat and unsuitable for 
use without grading. The exposure and color must be adjusted to “linearize” the media, making it 
look the way it’s supposed to, in order to start grading. You can do this manually, or, as a shortcut, 
you can use a LUT that’s tailored to your type of media and the exposures you’re using.

LUTs are also commonly used in onset workflows where dailies are managed with corresponding 
LUTs. These LUTs were used to monitor the media as it was being recorded, and define a baseline 
reference for how each scene is meant to look, at least so far as field monitoring is concerned.

In either instance, LUTs, when used in this way, are adjustments that are applied to affect the look 
of a clip, in much the same way as you’d make adjustments using any of the contrast or color 
controls in the Color page. While there’s an entire group of LUT controls in the Look Up Tables 
section of the Project Settings, those are designed to apply LUTs, in different parts of the image 
processing pipeline, to the entire Timeline. This is useful when you want to apply a single color and 
contrast transformation to the entire program at once, but less so if you want to apply different 
LUTs on a per clip basis. (For more information on using the Look Up Table settings, see Chapter 2, 
“Project  Settings.”)
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DaVinci Resolve lets you apply LUTs within a grade by connecting a LUT to a particular node in the 
Node Editor. 

To apply a LUT within a node:

>> Right-click any node, and choose a LUT from the 1D Input LUT, 1D Output LUT, or 3D 
LUT submenus.

LUTs that you apply using the 3D LUT or 1D Output LUT submenus impose their transformation 
after all other Color page adjustments applied by that node. This means that you can use Color 
and Contrast controls to trim whatever effect the selected node’s LUT is having on the image. 
For example, if the contrast adjustment made by an applied LUT clips the highlights of the image 
too much, you can use that node’s Contrast controls to lower the highlights, restoring detail to 
the image.

The LUT submenus list whichever LUTs have been installed on your workstation. For more information 
on installing LUTs, see Chapter 3, “Project Settings, Caching, and Preferences.”.

RED HDR Input Support

The RED EPIC and SCARLET cameras are capable of shooting in an HDR mode that effectively 
“brackets” two different exposures of each frame. The resulting image data stores two channels 
of image data: the regular exposure, and a “highlight exposure” that’s underexposed by a user-
selectable margin (+3, +4, +5, or +6 ƒ-stops difference).

By default, the Input bar in the node graph feeds the regular exposure to your grade’s node tree. 
To take advantage of the additional “highlight” exposure, you can add an additional Source input 
to the node graph that feeds a second stream of image data that you can mix with the regular 
exposure in different ways.

Note: You can also take advantage of the highlight exposure of RED HDR media by enabling and 
adjusting the Magic Motion controls in the Camera Raw palette.

To set up a node tree combining the normal and highlight HDR versions:

1.	 Using the first default node (Node 1), grade the image to see if you even need to use the 
alternate exposure that’s available. We’ll assume for this example that you do. In this example, 
the sky of the default exposure is pretty blown out, but there may be detail that can be 
retrieved using the highlight exposure.
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Using HDRx images with the Layer Mixer

2.	 Create a Layer Mixer node by choosing Nodes > Add Layer (Shift-L), or press the ADD LAYER 
button of your control surface.

	 Two nodes are created, a Layer Mixer node that’s added after Node 1, and a third node 
(Node 3) that’s connected to a second RGB input of the Layer Mixer node in parallel to Node 1.

The Source currently supplies two input, but you can add a second source which is the short exposure in the HDR image

3.	 Right-click anywhere within the node graph (except on a node) and choose Add Source from 
the contextual menu.

	 A second Source bar appears underneath the first, which outputs the highlight exposure of 
the image as a separate image stream.
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A node tree that uses a Layer Mixer node to mix two Corrector nodes,  

each connected to separate outputs for the regular and highlight exposures.

4.	 Delete the connection between the top Source bar and Node 3, and then connect the bottom 
Source bar to the RGB input of Node 3.

	 Immediately, the image in the node thumbnail and Viewer updates to show the darker, 
underexposed version of the HDR image. This is because, by default, the Layer Mixer is mixing 
100% of Node 3 over Node 1.

5.	 Select Node 3 and use one of the following two procedures to create a useful combination of 
the two exposures:

>> 	To create a mix of the two exposures, open the Key tab, and drag the Post Mixing Gain 
slider to the left to lower the contribution of Node 3 to the overall image (you can also do 
this using the DaVinci control panel by pressing the KEY MODE soft button, and then using 
the Post Mix Gain rotary control). Using dynamics (keyframing), this is a good way to animate 
a dissolve from the regular exposure to the highlight exposure if you’re going from a dark 
environment to a bright environment in the same take and you want to create a smooth 
transition between both exposures.

Dissolving between the regular and highlight exposures of RED HDR media using the  

Post Mixing Gain slider of a Corrector node connected to a Layer Mixer node.
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Tip: You can also use the Blend Type and Blend Bias parameters in the Camera Raw palette to blend 
the two exposures without building a dedicated node tree.

>> To use the highlight exposure to selectively put detail back into the image (for example, to 
retrieve blown-out windows), use a Power Window, HSL Qualification, or a combination of 
the two to isolate the region you want to retrieve in Node 3. (Be careful if you’re using HSL 
Qualification to combine both exposures, as keyed edges can be tricky to blend.)

Isolating a region of the image to replace using the highlight exposure image of a RED HDR clip

Final node display with isolations
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Clip vs. Timeline Grading

The Node Editor has two modes. The default Clip mode lets you create individual grades for each 
clip or group in the Timeline. However, the Timeline mode lets you apply a single grade simultaneously 
to every clip in the Timeline, as seen in the Thumbnail timeline in the following screenshot. 

A paragon of sophisticated grading, the author applies a red edge vignette to every clip in the project  

simultaneously using the Timeline grade.

There are a variety of reasons you might want to do this. For example, if you’re working on a 
commercial spot, you might elect to use Clip grades to do general correcting and scene-to-scene 
balancing, and then use the Timeline grade to apply a single stylistic grade to the entire spot 
simultaneously. That way, any changes the client wants made to the style of the grade can be 
instantly applied to the whole spot.

Another example would be using the Timeline grade to apply corrections meant to address QC 
issues running throughout a program, desaturating highlights or selectively darkening a specific 
shade of red wherever it appears.

A Note About RED HDR Media and Performance

Since RED HDR media records two complete streams of image data, DaVinci Resolve must 
simultaneously decode two separate tracks whenever you add a second Source bar. (If you don’t 
add the second Source bar, only the first stream is decoded.)

Because of this, whether you’re relying on your computer’s CPU to decode RED media, or you’re 
using a single RED ROCKET card, you’ll get half the performance when using the highlight stream 
of an HDR clip. 

To improve performance, you can set any RED HDR clip’s Render Cache Mode to “User” by 
choosing Color > Render Cache Mode, pressing Option-R, or pressing the CACHE MODE button 
on the T-bar panel of your control surface repeatedly until you toggle to User mode. DaVinci 
Resolve renders all cached clips in the background, so the next time you play a cached clip, it will 
play at full speed.

If you regularly use RED HDR media, two RED ROCKET cards are recommended for optimal 
decoding performance.
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To switch between Clip and Timeline grading modes:

>> Choose the mode from the pop-up menu at the top right of the Node Editor.

Selecting Track mode in the Node Editor

Note: When you reset the Timeline grade using the Color > Reset All Grades and Nodes command, 
the Output Sizing parameters are reset as well.

Timeline Grades and Saved Stills

When you save a Gallery still, the Clip and Track grades are both saved. However, when you apply a 
grade from that still, you only apply either the Clip grade, or the Track grade, depending on which 
mode the Node Editor is in. For more information on saving and applying grades, see Chapter 7, 
“Copying and Managing Grades.”



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

708

ADVANCED COLOR FEATURES12

Each node’s key input and key output makes it possible to route key channel data from one node 
to another so you can apply isolated corrections. Furthermore, the Key Mixer lets you combine 
a variety of keys from different nodes to create more detailed keys with which to tackle complex 
operations. This section covers all the ways you can recombine key data, as well as how keys can 
be used in conjunction with the Alpha Output bar to create regions of transparency in a clip for 
compositing right within DaVinci Resolve.

Outside Nodes

Whenever you use a Power Window or HSL Qualifier to limit a correction within one node, a special 
node structure lets you automatically create a second node, called an Outside node, to apply 
additional adjustments to the inverse of the region you isolated in the previous node. Outside 
nodes make it easy to apply separate corrections to an isolated subject and its surroundings. 

In the following example, the sky has been isolated using a Power Window, and an Outside node 
has been added to make an additional correction to everything else within the shot.

The Outside node automatically has its key input inverted

To add an Outside node to a node, creating a secondary correction:

1.	 Select a node that has been limited using a Power Window or HSL Qualifier.

2.	 Do one of the following:

>> Choose Nodes > Add Outside

>> Press Shift-O

>> Press the ADD OUTSIDE button on the T-bar panel of the DaVinci control surface.

	 A new node is created immediately after the selected node, with the RGB and key outputs of 
the first node automatically connected to those of the new node. 

When selecting the new node and opening the Key palette, you can see that the Key Input’s Invert 
control is on by default, which is what inverts the key from the previous node.

Manipulating and Combining Keys
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The Key Input’s Invert control is on by default for each node

If, instead of inverting the incoming key, you want to copy the existing key in order to perform 
another operation to the same isolated region, you can disable the key input’s Invert control.

Feeding Keys From One Node to Another

One of the most powerful aspects of the Node Editor is the ability to create keys based on a 
specific part of the node tree, and feed the result into a completely different correction somewhere 
else in the node tree. This is one of the reasons for the separate key input and output on every 
Corrector node.

The key that’s created whenever you use the HSL Qualifier, create one or more Windows, or use 
an external matte can be output from one node’s key output and fed to the key input of any other 
node in a tree. There are many reasons to do this, but the following example shows a common 
problem you can solve with this technique.

Using a key from one node to make an adjustment with a different node:

1.	 Use Node 1 to apply a basic primary correction, increasing contrast and balancing the color to 
achieve a pleasing ambient color temperature. 

2.	 Add a Serial node (Node 2), followed by a Layer Mixer node which also adds Node 4 (as seen 
in the following screenshots). Then, completely desaturate Node 4 and add contrast make it 
super-high contrast black and white, desaturate Node 2 just a bit, and right-click the Layer 
Mixer node to choose the Overlay blend mode with which to combine these two layers.

	 The result is a highly stylized image, but the skin tone on the actor’s face and hands in the 
resulting image are too monochromatic, and you want to give them some differentiation. 
Simply adding another node after the Layer Mixer and keying the skin tone may not work well 
because the low level of saturation will make a key difficult to pull. 
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Serial nodes to create a stylized image

3.	 Add another node after the Layer Mixer (Node 5 in the screenshot), and then right-click in the 
gray background area of the Node Editor, and choose Add Node > Corrector to create an 
unattached node, (Node 6).

4.	 Connect the RGB output of Node 1 to the RGB input of Node 6, and then connect the Key 
output of Node 6 to the Key input of Node 5. Now you’re ready to pull a high-quality key from 
the very first correction in Node 1, skipping all the complication coming afterwards.

5.	 Use the HSL Qualifier in Node 6 to pull a good strong skin tone key based on the primary 
image. Given the way the node tree is now set up, that key is fed to Node 5, and will limit 
whatever adjustments you make there.

Using Node 6 to pull a key from the image output by Node 1, and feeding that key to Node 5
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	 So now things are almost ready for an adjustment to be made to the actor’s skin tone, however 
the same automatic setting that makes it easy to create Outside nodes is inverting the key that 
Node 6 is feeding to Node 4, which is isolating everything except for the skin tone. This is the 
opposite of what is needed.

6.	 Double-click Node 5 to select it, open the Key palette, and click the Key Input Invert control 
so that Node 5’s key is identical to Node 6’s key.

Using the Key palette to control the key levels

7.	 Now, you can make your adjustment to Node 6’s grade, to lower the contrast, brighten, and 
increase the saturation of the actor’s skin tone.

Inverting the key being input into Node 5, to make an adjustment to the actor’s skin tone

As a result of this operation, the background remains desaturated and contrasty, while the actor’s 
skin tone has the richer color we need for the shot.
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Before/After Selective adjustment of skin tone

This example could have been handled in a variety of different ways, but the point is that you can add 
nodes that connect to the state of the image at any part of a node tree, and use them to generate 
keys to feed to any other node, regardless of what’s happening to the picture in between.

Using External Mattes

The External Matte node has evolved over the years. What was once purely a means for importing 
matte channels for defining opacity and limiting adjustments has expanded to become a way to 
import the RGB channels of a media file to be used for overlaying grain, texture, and stylized distress 
onto an image, and even as a way to use the channels of a clip itself as a matte.
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Matte clips are added to your project in the Media page. You can add them by attaching them to a 
clip, so a particular matte is only available to a particular clip as part of a Clip Grade, or you can add 
unattached mattes that stand alone in the Media Pool, which are then available to any Track Grade. 
For more information about adding Matte clips in the Media page, see “Adding and Removing 
External Mattes” in Chapter 4, “Media.”

Whether attached or unattached, mattes operate within a grade using EXT MATTE (external matte) 
nodes. EXT MATTE nodes have the following outputs: 

An external matte connected to the first node of a grade

>> RGBY Outputs: Four blue triangular key outputs let you output the Red, Green, Blue, and 
Luma channels of a matte clip as a key that you can attach to any other node’s key input. 
An interesting aspect of these four outputs is that each one is dedicated to individual R, 
G, B, and Y color channels. Ordinarily, External Matte clips are written with the matte data 
written simultaneously to all three RGB channels. However, you could also render separate 
mattes to each color channel, so that the Red channel has one matte, the Green channel 
another, and the Blue channels still another, thereby exporting three separate mattes within 
a single media file, for convenience. You can then use each one of these mattes individually 
by connecting the correct output of the Ext Matte node.

>> RGB Output: A round orange RGB output lets you connect the RGB image data of a matte 
clip to any other clip’s RGB input. This is especially useful when you’re combining a matte clip 
with the current clip using a Layer Mixer node, to create a textured composite of some kind.
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External Mattes to Limit Adjustments

Going back to the External Matte node’s original use, mattes are typically grayscale media files that 
represent image opacity, and are meant to be used either as alpha channels for creating opacity 
within a corresponding RGB clip, or as a matte for limiting effects. 

An example of a matte channel would be the key created by a green screen keyer. If you output just 
the key, that would be an external matte. If you receive an external matte along with an effects clip, 
you can attach the matte to its corresponding RGB clip in the Media page. Then, you can access 
that matte via an External Matte node in the Node Editor, so you can use the key it outputs to limit 
different kinds of corrections you want to apply. 

In the following example, the keyed matte of a green screen composite clip is used to apply different 
corrections to the inside and outside of a keyed composite, in order to make the subject match the 
background more convincingly.

A matte attached to clip Makeup_composite.mov, as seen in the Media Pool

To use an attached matte to limit an adjustment within a Clip Grade:

1.	 Right-click any node, and choose the attached matte you want to use from the Add Matte 
submenu of the contextual menu. OpenEXR files with RGBA passes embedded within them 
(RGBA + RGBA + RGBA etcetera) expose multiple entries in this submenu. 

	 By default, the EXT MATTE node that appears has its first output connected to the Connect 
one of the EXT MATTE node’s triangular key outputs to the key input of a node you want 
it to limit.

2.	 Select the node to which the EXT MATTE node is attached, and add an Outside node to make 
it possible to add adjustments on either side of the matte.
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Node Editor displaying the influence of the external matte on multiple nodes when the keys are linked 

3.	 If necessary, select Node 1, and use the Key palette controls to modify the incoming key, 
inverting or blurring it as necessary to create the isolation you need.

	 Note: Don’t select the EXT MATTE node, because it exposes different controls in the Key 
palette for transforming, flipping, looping, and freezing the matte.

	 At this point, you can add adjustments to the inside and the outside of this composited shot 
to improve the composite.
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Before/After: An external matte is used to apply separate grades to the foreground and background of a previously composited clip

Ideally, external mattes are exported so that they match the size and duration of the RGB clip 
they’re supposed to accompany. If they don’t match or if you’re using some other grayscale clip as 
an external matte to create some sort of effect, then there are parameters in the Key palette that 
you can use to retime or transform a matte so it works better in your grade.

To slip the sync of a matte relative to the clip it’s attached to:

1.	 Select the Ext Matte node you want to slip.

2.	 Open the Key palette, and raise or lower the Offset parameter until the matte is perfectly 
aligned with the clip it’s supposed to match.
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To transform a matte:

1.	 Select the Ext Matte you want to transform.

2.	 Open the Key palette, and turn off the Lock Matte checkbox.

3.	 Use the Pan, Tilt, Zoom, Rotate, Width, Height, HFlip, or VFlip parameters to adjust the matte 
so it has the correct geometry.

It’s worth mentioning that you can attach as many external mattes to a single clip in DaVinci Resolve 
as you like. For example, if a CGI shot has been delivered with a set of isolation mattes for each of 
three characters in the scene, you can import all three mattes and use them to isolate adjustments 
that you want to make in the Node Editor. 

External Mattes to Add Texture

You can also use external mattes as creative tools, to add grain and texture. For example, you might 
use a more abstract animated matte, or a grayscale film scan of dirt and dust, to apply correction 
for effect.

Light leak and dirt and dust images From Warren Eagles’ Scratch FX collection (FXPHD), designed to add texture to your grades

Once attached to a clip, external mattes can be exposed in the Node Editor, and their key output 
can be used just like any other key in a node tree. 

To use an attached matte to create texture a Clip or Track Grade:

1.	 When applying a matte as part of a Clip or Timeline Grade, right-click any node and choose 
the attached or unattached matte you want to use from the Add Matte submenu of the 
contextual menu. Unattached mattes appear in the Add Matte > Track Mattes submenu.  

2.	 Disconnect the EXT MATTE node’s Key output connection to the Key input of the node it’s 
connected to by default.

3.	 Add a Layer Mixer to the end of the node tree.

4.	 Disconnect the bottom Corrector node’s RGB input, and then connect it to the EXT MATTE 
node’s round RGB output.
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A node tree set up to feed an EXT MATTE node’s RGB output to the input of a node connected to a Layer Mixer, 

in order to blend it with the grade using composite modes

5.	 Right-click the Layer Mixer node, and choose Overlay from the Composite Mode submenu to 
blend the Ext Matte node most effectively with the grade.

6.	 If necessary, you can use the grading controls of the Corrector node to which you’ve attached 
the EXT MATTE node to change the characteristics of the texture clip, desaturating it for 
instance. You can also select the EXT MATTE node itself, open the Key palette, and use the 
Transform, Offset, Loop, or Freeze controls described later to change how the matte appears.

The resulting texture effect, blended with the grade using the Overlay composite mode

	 Tip: If you want the texture you create to be unaffected by blur or sharpening operations 
within the grade, be sure to add it to the very end of the node tree
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External Mattes to Create Transparency

You can also use an EXT MATTE node to create transparency in a clip, for compositing with clips 
underneath it on the Timeline.

To use an attached matte to create transparency in a clip:

1.	 Right-click any node, and choose the attached matte you want to use from the Add Matte 
submenu of the contextual menu.

	 Adding an EXT MATTE node to a Clip Grade applies the effect to only that clip, whereas 
adding an EXT MATTE node to a Track Grade applies the effect to the entire Timeline.

2.	 Right-click any empty area of the Node Editor, and choose Add Alpha Output to reveal the 
output bar on the right that lets you assign a key to be used to define clip transparency.

3.	 Connect one of the EXT MATTE node’s triangular key outputs to the Alpha Output bar at the 
right of the Node Editor.

The node setup for using an external matte to composite two layer

	 The areas of the matte defined by the key are now rendered transparent.

The final composite created using the external matte node 
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Key Palette Controls for the External Matte Node

When you select an EXT MATTE node, the Key palette displays different parameters only for mattes. 
Be aware that you must turn off the Lock Matte checkbox before you can make adjustments to 
transform the matte.

The Key Palette showing a texture layer added as an EXT MATTE node

>> Transform: Standard Pan, Tilt, Zoom, Rotate, Width, and Height parameters let you 
transform a matte to fit the image better.

>> Flip Image: Two buttons let you flip the matte clip horizontally or vertically.

>>Offset: Adjust this parameter to offset the start point of a matte clip.

>> Lock Matte: When turned on, locks the sizing of a matte to whatever changes are made to 
the Input Sizing of that clip, so the matte transforms to follow the clip.

>> Loop: Turning on this checkbox enables matte clips to loop endlessly, which lets shorter 
matte clips cover longer durations.

>> Freeze: Turning on this checkbox freezes the matte clip on a single frame. Adjust the Offset 
parameter to choose which frame to freeze on.

You can also use external mattes as creative tools. For example, you might use a more abstract 
animated matte, or a grayscale film scan of dirt and dust, to apply correction for effect.
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Using the Key Mixer

The Key Mixer node lets you mix keys output from multiple Corrector nodes, combining them in 
different ways to create a single key output. This makes it possible to build much more intricate 
keys than you can with a single Qualifier or set of four Windows. In particular, the Key Mixer node is 
the only way to combine multiple keys made using Qualifiers and Windows, adding, subtracting, or 
intersecting them to create a highly specific result.

Adding Two Keys Together

In the following example, you’ll learn how to set up a Key Mixer to combine the keys output by 
two Corrector nodes in a node tree. Then you’ll learn how to change the way the input keys are 
combined using the Key palette.

To combine two or more keys using the Key Mixer:

1.	 Right-click anywhere on the gray area of the Node Editor, and choose Add Node > Key Mixer.

2.	 Create two Corrector nodes, then attach their RGB inputs to the RGB output from an 
appropriate node in the main part of the tree, and attach their key outputs to the key inputs of 
the Key Mixer.

3.	 Next, attach the key output of the Key Mixer node to the key input of the node you want to use 
to make the correction. Remember, the objective is to use the key that’s output by the Key 
Mixer to limit the adjustment being made using another node, in this case Node 4.

Setting up the node tree you’ll need to combine two keys together

	 Keep in mind, especially since this is a significant reordering of nodes in the Node Editor, that 
every node needs to be connected properly for the overall grade to work.
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4.	 Now that the node structure is fully connected, use Windows, Qualifiers, or both to create keys 
in each of the nodes that you connected to the Key Mixer. In this example, Node 2 is isolating 
the main skin tone, and Node 3 is isolating the blue of his jeans.

	 By default, all keys connected to the Key Mixer are added together, as you can see in the Key 
Mixer’s thumbnail. 

	 However, you can use the controls in the Key palette to change this, in order to isolate the 
intersection of two keys, or to subtract one key from another.

Combining multiple keys with the Key Mixer

	 If you wanted, you can use the controls in the Key palette to change this, in order to isolate the 
intersection of two keys, or to subtract one key from another. This is covered in the next section.

5.	 Continuing with the previous setup where both keys are added together by default, selecting 
Node 5 and dropping the saturation to be very faint stylizes the entire background, while 
leaving the various hues of the man we’ve isolated alone.

Final grade, the talent in color with a B&W background
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Subtracting One Key from Another

The way multiple keys are combined within the Key Mixer depends on a pair of Key Input buttons 
you can toggle using the Key palette. In the following example, a partial blue tint is washed 
throughout the midtones of the image using a qualifier, but you want to exclude the red sign from 
this operation. Using the Key Mixer, you can subtract one key from another.

A selective blue tint added to the midtones of the image includes the red sign

To change the Key Input settings for a node connected to a Key Mixer:

1.	 In this example, Node 2 is isolating part of the midtones of the image, and feeding its key 
through the Key Mixer to node 5, which is using it to apply a partial blue tint. However, in 
preparation for subtracting the skin tone from this operation, Node 3 is isolating the sign.

A node setup in preparation of subtracting the Bar sign from the midtone isolation being used to add a partial blue tint
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2.	 To reveal the controls you’ll use to change how the key from Node 3 interacts with the key from 
Node 2, double-click the Key Mixer to select it, then click the line connecting Node 3 to the 
Key Mixer to select that input.

The connection from Node 3 to the Key Mixer is selected and highlighted yellow

3.	 Open the Key palette; the Input Link parameters are labeled with the number of the connection 
line that you’ve selected, in this case Input Link 2.

The Key Mixer parameters change when a Key Mixer is selected

4.	 Use the two buttons next to the Key Input label at the upper left of the Key Mixer palette, 
Invert and Matte, to control how the keys interact within the Key Mixer.
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>> To subtract Node 3’s key from that of Node 2: Select the Input Link 2 connection, and turn 
off both the Key Input Matte button and the Key Input Invert button.

>> To limit the output to the intersection of both keys: Select the Input Link 1 connection, and 
turn off the Key Input Matte button.

>> 	When you’re finished, the result should resemble the following screenshot.

The result of subtracting a key of the sign from a key of the overall midtones of the image,  

and using that to add a selective blue tint

Adding Inputs to Key Mixer Nodes

New Key Mixer nodes have two key inputs by default. If necessary, additional inputs can be added 
in order to combine even more keys with one another.

To add inputs to the Key Mixer:

>> Right-click a Key Mixer node, and choose Add One Input.

When combining three or more keys, the interaction of keys using the Key palette controls becomes 
even more complex, but the rules outlined above still apply.
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Using the Key Palette

The Key palette contains parameters and controls that you can use to modify key channel data 
being fed into or routed out of the currently selected node. 

Key palette showing controls when a Node is selected

For example, the Key Input Invert control is always enabled, which is why the Outside node works 
automatically. Clicking this control results in keys that are fed into that node exactly mirroring the 
original key.

The controls that are available in the Key palette vary depending on what kind of node you 
have selected:

>> Corrector Nodes: Have three sets of parameters. Key Input parameters let you make 
adjustments to keys being fed through a node’s Key Input connection. Qualifier parameters 
let you make adjustments to the internal key created with the HSL Qualifier or Window 
controls. Finally, the Key Output parameters let you make adjustments to the key data 
being output by a node’s Key Output connection, and includes the incredibly powerful 
Offset Gain parameter that governs the strength of that node’s contribution to the overall 
grade. This functionality is covered more extensively in the next section.

>> Ext Mattes: Have two sets of parameters. Transform parameters let you make geometric 
transformations to a matte so it fits the clip it’s being applied to better. An Offset control 
lets you slip the sync between an external matte and the clip to which it’s applied. This 
functionality is covered in the section on External Mattes.

>> Key Mixer Nodes: Have two sets of parameters that are dependent on which of the 
connections attached to a Key Mixer’s key inputs is selected. Input parameters let you 
adjust how much of a contribution a key makes to the total key mix, and whether the 
contribution is additive or subtractive.

The Output parameters let you adjust the inversion and strength of the key that’s output 
by the Key Mixer. This functionality is described more extensively in the Key Mixer section.

Layer Mixer and Parallel Mixer nodes have no adjustable controls in the Key palette.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

727

ADVANCED COLOR FEATURES12

Corrector Node Key Input Controls
>> Input Invert: Inverts the key being fed into the key input. On by default, which is why Outside 
nodes work to automatically adjust everything outside of the secondary operation taking 
place in the node before.

>> Input Matte: Lets you switch the key input between Matte and Mask modes. In Matte mode 
(on by default) the key input combines via intersection with keys generated internally using 
the Qualifier or Windows palette. In Mask mode, the key input is added to the internal 
key instead.

>>Gain: Controls the strength of the key connected to the key input.

>>Offset: Controls the contrast of the key connected to the key input.

>> Blur Radius: Blurs the key connected to the key input

>> Blur H/V Ratio: Alters the horizontal/vertical ratio of the blur that’s being applied to the  
key input.

Qualifier Controls
>>Qualifier invert: Inverts the key created by that node’s Qualifier palette.

>>Qualifier matte: Lets you switch the interaction of the keys generated by the Qualifier 
and Window palettes between Matte and Mask modes. In Matte mode (the default), the 
Qualifier and Windows palettes combine via intersection. In Mask mode, they’re added 
together instead.

>>Gain: Lets you raise or lower the strength of the key generated by the Qualifier palette.

>>Offset: Lets you adjust the contrast of the key generated by the Qualifier palette.

Key Output Controls
>>Output invert: Inverts the overall key.

>>Gain: Using the key output, this parameter governs the strength of that node’s contribution 
to the overall grade. Setting Gain to 0 results in that node having no effect at all, while the 
default setting of 1.00 applies the full strength of any adjustments made with that node. 
The maximum setting of 2.00 increases the intensity of any part of the key output that’s less 
than 100 percent white. You can also use this parameter to keyframe the key output to fade 
that node’s contribution in or out with one set of keyframes.

>>Offset: Lets you adjust the contrast of the Output key. This has no effect if the entire key is 
100 percent white (a solid key).
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The Many Uses of Key Output Gain

Several of the techniques discussed in here and in “Secondary Qualifiers,” can be further customized 
using the Key Output Gain parameter, which makes it easy to control the strength of a node’s effect 
on your grade with a single adjustment. In the following example, two simple Serial nodes are 
applied to a clip, with the first one expanding image contrast, and the second one using a variety of 
controls to add some extreme warmth to the highlights.

A tint applied only to the highlights of the image

If you decided that you want to reduce the amount of warmth added by the second node without 
readjusting the controls you used to create the effect, you could open the Key palette and lower the 
Key Output Gain parameter to fade the effect with a single adjustment.

Four versions of this grade shown using the Versions option of the Split Screen controls,  

with Output Gain set to 1, .75, .5, and.25 for comparison

This principle also works for controlling the strength of individual nodes that are being combined in 
parallel, that are combined using the Layer node, or for simply fading out the effect of any node in 
the node tree you want to “turn down” a bit.
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Isolating and Splitting Color Channels

Resolve provides two different methods of making channel-specific adjustments, depending 
on whether you need to apply an adjustment to just one channel within a single node, or apply 
separate adjustments to all three channels across several nodes.

Enabling and Disabling Individual Node Channels

Within the contextual menu of each node in the Node editor is a series of four options:

Disabling channels and switching color spaces

>> A Color Space submenu that lets you change the color space that node works in between 
RGB (the default red/green/blue), YUV (actually Y’/Cb/Cr), HSL (Hue/Saturation/Lightness), 
and LAB (Luminosity/A/B).

>> Three checked Enable Channel 1-3 options let you turn individual channels off or on, limiting 
which channels operations within that node will affect.

In combination, these controls let you choose a color space for a node to work within, and then 
choose which channels of that color space you want to affect with that node’s adjustments. In the 
following example, you’ll see how to use these features to selectively sharpen just the Y’ (luma) of 
an image without affecting the chroma, which can be a more subtle effect than simply sharpening 
the entire image.
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To use channel disabling and color space conversion to sharpen luma only:

1.	 Add a node with which to apply the sharpening you want to the current clip.

2.	 Right-click the new node, and choose YUV from the Color Space submenu of the 
contextual menu.

3.	 Apply sharpening by doing one of the following:

>> Using that node’s contextual menu, uncheck Enable Channel 2 and Enable Channel 3, which 
correspond to the U (Cb) and V (Cr) channels, leaving only Channel 2 (Y) enabled. Then, 
open the Blur palette, and drag the ganged Radius sliders down to sharpen the Y channel.

>> You can also just open the Blur palette, ungang the Radius sliders, and drag the red 
slider down to sharpen the Y channel, since any control with three gangable sliders will 
automatically assign those sliders to whichever channels are used by the currently selected 
Color Space.

Before - The original image, After - Sharpening applied to only the Y’ channel of the image 

As you can see, while the Blur palette ordinarily provides separate R, G, and B controls that can be 
unganged from one another, the Color Space submenu lets you apply sharpening to the channel 
definitions of other colorspaces, providing many other corrective and creative possibilities with the 
same controls.
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Splitter/Combiner

Another method of applying corrections to individual color channels is using the Splitter/Combiner 
nodes, which break the Red, Green, and Blue channels apart into separate node tree branches, 
each capable of accepting multiple serial and parallel nodes of image adjustment. There are two 
ways you can create a Splitter/Combiner node structure.

Methods of adding Splitter/Combiner nodes:

>> To add a pre-made Splitter/Combiner node structure: Choose Nodes > Add Splitter/
Combiner Nodes (Option-Y). A Splitter and Combiner node appear already connected to 
three corrector nodes, one for each color channel.

>> To manually construct a Splitter/Combiner node structure: Right-click in any empty area 
of the Node Editor, and choose from the Add Node submenu to create a Splitter node, a 
Combiner node, and three Corrector nodes, wiring them together as necessary to create 
the desired effect.

Supported Color Spaces for Conversion

The Colorspace submenu available when you right-click a node in the Node Editor supports four 
different color spaces that you can set each node to work within. When you choose a color space 
other than RGB, all channel-specific controls (the Custom curves, Soft curves, RGB Lift/Gamma/
Gain sliders, and RGB mixer) operate on the particular channels of that color space, rather than 
the default YRGB channels. By switching color spaces, you can achieve very different kinds of 
adjustments by swinging values among mathematically different axes.

YUV converts the image into Y’, Cb, and Cr channels. The Y’ channel governs luminance, while the 
Cb and Cr are color difference channels that work within the broadcast model of color.

HSL converts the image into Hue, Saturation, and Lightness channels. Lightness is identical to 
Luminance, while Hue and Saturation are exactly as described.

LAB operates on the L, A, and B channels. The L channel governs luminance, while the A and B 
channels are color difference channels; A adjusts color on an axis from magenta to green, B adjusts 
color on an axis from yellow to blue.
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The Splitter Combiner node structure

The Splitter node takes an incoming image and provides individual outputs for each color channel 
(top/red, middle/green, bottom/blue). When you connect each of these output to a Corrector node, 
that color channel automatically connects to all three internal channels of that node, so that the 
default three nodes in a Splitter/Combiner structure are internally processing red/red/red, green/
green/green, blue/blue/blue. The Combiner then pulls the Red, Green, and Blue channels out of 
each node connected to its three inputs, and reassembles them into a single RGB image again. Of 
course, what happens in between the Splitter and Combiner is entirely up to you.

One of the simplest ways of showing the possibilities of this node structure is to combine it with 
Node Sizing in the Sizing palette. Using Node Sizing, you can correct for misaligned channels in older 
archived video, or create channel misalignments for creative looks. In the following example, a simple 
Node Sizing adjustment to a split Blue channel will create an interesting “prism vignette” effect.

To use Node Sizing on individually split channels:

1.	 Choose Nodes > Add Splitter/Combiner Node (or press Option-Y) to add a pre-made Splitter/
Combiner node structure to the node editor.

2.	 Select the middle of the three corrector nodes appearing in between the Splitter and 
Combiner nodes (Node 5 in the following screenshot).

3.	 Open the Sizing palette, choose Node Sizing from the Mode pop-up, and then raise the zoom 
parameter by a small amount; this example uses 1.014. 
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Zooming just one color channel using the Splitter/Combiner nodes

	 As you can see in the screenshot, just the Green channel has been zoomed in on across the 
entire image. This is only possible using Node Sizing. This is cool, but not quite what you need.

4.	 Open the Window palette, add a Circular window, turn on its Invert control, and transform it to be 
a very soft, horizontally aligned vignette. This limits the individual scaling done to the Green 
channel to just the outer edge of the image, similar to a lens with excessive chromatic aberration.

The resulting channel split effect

You could easily keep going, applying varying amounts of zoom with different window shapes to 
each of the other color channels, and perhaps adding some blur to enhance the effect, but this 
example should show the creative potential available when using this technique.
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Compositing Using the Alpha Output
While DaVinci Resolve can use the alpha channel of imported media for compositing, the Alpha 
Output bar in the Node Editor is an optional output that you can turn on to create clip transparency 
using operations inside DaVinci Resolve to create composites against other clips on lower video 
tracks. There are many ways of using the Alpha Output, but this section will focus on three examples. 

Using a Qualifier Key to Create Transparency

In this first example, the Alpha Output will be used to composite a green screen clip with a 
background plate.

A green screen clip, ready for compositing

In preparation for this composite, the background plate is on track V1 of the Timeline, and the green 
screen clip has been superimposed on track V2.

A superimposed green screen clip on track V2 of the Timeline, above a background plate on track V1, ready for compositing.
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To create a chroma-key composite in the Color page:

1.	 Right-click anywhere within the gray area of the Node Editor and choose Add Alpha Output 
to add the Alpha Output bar at the left of the Node Graph.

	 An Alpha Output bar appears underneath the Output bar at the right of the Node Editor.

The image Output bar with Alpha output bar below

2.	 Add a Serial node after Node 1 and connect its key output to the Alpha Output bar. This is a 
fast way to build this composite if you’re confident that the corrections you’ve made in Node 
1 won’t adversely affect the key (or if you know they’ll improve it by expanding the contrast of 
a flat-contrast source clip).

	 Alternately, you could create a second processing branch by adding a disconnected node 
(Node 2), connecting the Source bar to its RGB input, and then connecting its key output to 
the Alpha Output bar you just added. Creating a second image processing branch from which 
to pull your key lets you key directly from the source, avoiding any problems that grading the 
first node could introduce to the key.

Node 1 grades the clip, expanding contrast to improve both the image, and its ability to be keyed.  

Node 2 uses Qualifier controls to pull the key.
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3.	 Use the Qualifier controls of Node 2 to key out the green background, and then turn on the 
Invert checkbox to create the proper composite. You can also use a Power Window to garbage 
matte out any elements you don’t want intruding into the shot.

An HSL Qualification to key the green feeding the Alpha Output to create transparency

4.	 You can also use a Power Window to garbage matte out any elements you don’t want intruding 
into the shot.

A Power Curve used to garbage matte out unkeyable lighting fixtures
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5.	 If necessary, you can add another node to the output of Node 2 to make whatever corrections 
are necessary to the background plate clip to make the composite blend more seamlessly, 
such as using the Hue Vs. Sat curve to desaturate green spill. Making these corrections after 
Node 2, where the qualifier is used, guarantees that any color adjustments won’t affect the key.

Adding more color adjustments to a node added after the Qualifier

With all this set up, you end up with a nice green screen composite that’s visible in both the Color 
and Edit pages.

The result, with a window garbage matte cropping out the equipment, ready for further refinement 

Using a Matte to Create Transparency

If you’ve been provided with a separate Matte clip for defining clip transparency, you can use that 
Matte clip within the node tree of a superimposed clip to create a composite using the Alpha Output.
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To create a composite using an external matte:

1.	 To associate an external matte with a clip, open the Media page, select the clip you want to 
add a matte to in the Media Pool, navigate to the matte file using the Library browser, and then 
right-click the matte file and choose Add as Matte. For more information on importing mattes, 
see Chapter 3, “Working in the Media Page.”

2.	 Open the Color page and select the foreground clip in the Thumbnail timeline, then right-click 
Node 1 in the Node Editor and choose the matte you added from the Add Matte submenu.

	 An EXT MATTE node appears underneath Node 1, with the first of its four key outputs 
connected to Node 1’s key input. (Working with external mattes is covered in more detail in a 
prior section of this chapter.)

3.	 Now, right-click anywhere within the node graph (other than on a node) and choose Add 
Alpha Output from the contextual menu.

	 An Alpha Output bar appears underneath the Output bar.

4.	 Drag a connection line from the second key output of the EXT MATTE node to the Alpha 
Output bar.

Using an external matte in the grade and to the Alpha output
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	 You should now see a successful composite, with the external matte creating a region of 
transparency in the foreground clip though which the background clip shows through.

Use an OFX Plug-in to Create Transparency

If you’ve installed an OFX plugin capable of keying, you can right-click the node you’ve applied it to 
and choose Use OFX Alpha to route the key created by the plug-in out the KEY output of that node. 
When Use OFX Alpha is enabled, the HSL Qualifier and Window palette output is ignored, the only 
key that’s output is from the OFX plug-in.

Choosing Use OFX Alpha in the Node Editor

Before and after the final composite, created by connecting an Ext Matte node to the Alpha Output in the node graph
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Once Use OFX Alpha is enabled, and you’ve created a key using your OFX plug-in of choice, you can 
right-click anywhere within the node graph (other than on a node) and choose Add Alpha Output 
from the contextual menu to make the Alpha Output bar appear, and you can then connect the KEY 
output from the node with the OFX plugin to the Alpha Output to use it to create transparency.

Setting up a composite using an OFX plugin

Note: When Use OFX Alpha is enabled for a node, you cannot use a window to create a garbage 
matte within that node as you would when keying with the HSL Qualifier. To create a garbage matte 
with which to exclude unwanted and unkeyable elements from the edges of the picture, you’ll need 
to combine the key from a window in another node with the key output by the OFX plugin using a 
Layer Mixer node.

Combining an OFX key with a Window using a Key Mixer to add a garbage matte

Compositing Entirely Within an OFX Plug-In

Certain OFX plug-ins that are capable of combining two image streams to create a composite can 
now be used as of Resolve version 11.1 by exposing a “second layer input” on the node to which 
that plug-in has been applied. This makes it possible to composite the image you’re grading with 
the RGB output from an EXT MATTE node.
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Combining a clip with an EXT MATTE image using the second layer input of a node with an OFX plug-in applied to it

To create a composite using an OFX plug-in:

1. 	 Open the OpenFX Panel, use the Library to find the OFX compositing plug-in that you want to 
use, and drag it onto the appropriate node to apply it. The above example shows the Genarts 
Sapphire plug-in “S_MathOps,” which mathematically combines two image streams using 
one of a long list of blending modes.

2. 	 Right-click the node with the OpenFX plug-in applied to it, and choose Second Layer Input 
from the contextual menu. A second RGB input should appear on the left of the node, 
underneath the first.

Adding the second layer input of a node with an OFX plug-in applied to it
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3. 	 Open the Media page, locate the clip you want to composite in the Library, and import it as 
an unassigned matte.

4. 	 Open the Color page again, right-click the node with the OpenFX plug-in applied to it,  
and choose Add Matte > Track Mattes > “name of matte imported in step 3” from the 
contextual menu.

5. 	 By default, the EXT MATTE node that appears is connected via one of its key outputs. Delete 
the key connection, and drag a new connection line from the EXT MATTE node’s RGB output 
to the second RGB input of the node with the OpenFX plug-in. 

The composited image, node tree, and OFX parameters shown side by side

6. 	 At this point, the node tree is wired up to composite the clip with the EXT MATTE image, and 
you need only adjust the parameters of the OpenFX plug-in to achieve the result you desire.
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Keyframing

Whether it’s referred to as keyframing, dynamics, or marks, DaVinci Resolve provides an interface 
for automatically interpolating color adjustment parameters in various ways from one setting  
to another.

For example, if you have a clip with varying exposure settings, you can animate a series of contrast 
adjustments using Dynamic keyframes to make the changes in exposure less distracting. 

The Keyframe Editor with dynamic keyframes animating the parameters of Node 2

In another example, you can insert Static keyframes (marks) at the cut points of clips. These 
keyframes actually consist of multiple shots that are merged in a single piece of media to create 
individual adjustments for each shot, separated by a keyframe.

In both cases, you use the Keyframe Editor to create a series of keyframes with which to change 
parameters from one value to another. In this section, you’ll learn how to work with the Keyframe 
Editor to set up these kinds of animated changes.

Round static keyframes added to all parameters, enabling individual adjustment of shots merged together within a single clip
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The Keyframe Editor Interface

The Keyframe Editor has all the controls necessary to create and modify keyframes for the currently 
selected clip. If necessary, you can even make it wider in a single screen layout by clicking its expand 
button (at the bottom left of the Keyframe Editor), or use the Color page’s Dual Screen layout to 
place the keyframe editor on a second screen, for even more room.

The Node Editor shown in wide mode, pushing all other palettes to the left

The Keyframe Editor consists of the following components. 

>> The Timeline Ruler: Mirrors the record timecode of the currently selected clip; dragging 
within the Timeline Ruler moves the playhead, and a timecode display to the left shows the 
current frame.

>> The Keyframe Track Header: Each node in the current grade has a corresponding keyframe 
track, and the header contains controls you can use to manage the keyframing. 

The Keyframe Track Header

>> Track Disclosure Triangle: Exposes individually keyframable groups of parameters 
underneath the main keyframe track. 

>> Enable/Disable Button: A round orange button lets you enable or disable that track’s 
corresponding node. 

>> Lock Button: Lets you prevent any changes from being made to that track’s 
corresponding node.
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>> Auto-Keyframe Button: Turn this button on to automatically create a Dynamic keyframe 
every time you adjust any parameter within that node.

>> Keyframe Tracks: To the right of the track header, the keyframe tracks are where you 
create and edit the keyframes that animate parameter changes. A topmost “master 
keyframe track” shows every keyframe applied on every keyframe track in the Keyframe 
Editor, even keyframes applied to a keyframing track hidden inside a track with a closed 
disclosure triangle.

>> Keyframes: Each keyframe appears as a small diamond for a Dynamic keyframe or as a 
circle for a Static keyframe. Dynamic keyframes are associated with dissolves while Static 
keyframes (marks) act instantly. Grades are linked to the preceding keyframe, which may be 
a default one on the first frame of the master clip. Keyframes can be selected by clicking on 
them, or moved by dragging them to another position in the keyframe track.

>> Sizing track: The Pan, Tilt, Zoom, Rotate, and Convergence (in Stereo 3D projects) parameter 
have an entirely separate track for creating animated pan and scan adjustments.

>> Track Selection Bar: A colored bar shows the currently selected scope of keyframing: all 
tracks at once, just the current correction node, or the Sizing settings. This will be covered 
in more detail later in this chapter.

Ordinarily, the Keyframe Editor takes up the rightmost bottom third of the Color page. However, you 
can make it wider to have more room to work if you have a scene requiring complex keyframing.

To expand and collapse the Keyframe Editor:

>> Click the Expand/Collapse button at the lower left-hand corner of the Keyframe Editor.  
The Keyframe Editor widens or narrows accordingly.

To zoom into and out of the Keyframe Tracks:

>> Use the zoom slider to zoom into or out of the Keyframe Editor.

>> Right-click any keyframe track and choose Maximum Zoom to zoom all the way in.

>> Right-click any keyframe track and choose Reset Zoom to fit the entire clip into the available 
width of the Keyframe Editor.

All/Color/Sizing

Perhaps the most important control for keyframing, the Keyframe Timeline mode, lets you switch 
the scope of what tracks get keyframed when you use the Start Dynamic or Add Static Keyframe 
commands, either from the keyboard or via the buttons of your control surface. This command 
alternates among three modes:

>> All: The default mode. Adds keyframes to every track in the Keyframe Editor, keyframing 
every parameter in every node all at once, including the Sizing settings. In this mode, an 
orange bar appears highlighting the topmost “master keyframe track.”
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>> Color: Only adds keyframes to the node currently selected in the Node Editor. In this 
mode, a green bar appears highlighting the keyframe track corresponding to the node 
currently selected.

>> Sizing: Only adds keyframes to the Sizing track, which is useful when you’re keyframing “pan 
and scan” style transforms. In this mode, a blue bar appears highlighting the Sizing track.

>> EXT MATTE: Only appears if there’s an External Matte node in the node tree. Lets you 
keyframe External Matte-specific parameters in the Key palette.

Even though All is the default setting, it may be to your advantage to switch to the Color or Sizing 
keyframing modes to avoid creating a lot of unnecessary keyframes. Even though keyframing 
everything all at once is a fast way to work, the extra keyframes may slow you down when you later 
need to make adjustments to nodes that didn’t need to be keyframed in the first place.

To change the keyframing mode, do one of the following:

>> Choose an option from the Keyframe Mode pop-up at the top right of the Keyframe Editor.

>> Choose an option from the Mark > Keyframe Timeline Mode submenu.

>> Press the ALL/COLOR/Sizing button on the Transport panel of the DaVinci control surface 
repeatedly until you’ve chosen the mode you need.

Tip: This control has one other function. Choosing a mode also affects what is copied when you use 
the various grade management tools in DaVinci Resolve. For example, if you choose Color, then you 
can copy a clip’s color grade without copying its sizing. If you choose Sizing, then you can copy the 
sizing without copying the color grade. For more information, see “Copying Grades” in Chapter 13, 
“The Gallery and Grade Management.”

Keyframing Methods

There are two different types of keyframes used by DaVinci Resolve to create automated changes. 
Each type of keyframe interpolates parameters differently.

Dynamic Keyframes (Dynamics)

Dynamic keyframes are the most conventional type of keyframe you’ll use, and are the type of 
keyframe used for creating animated changes from one state to another. For example, if you need 
a grade to become brighter over time to compensate for a change in lighting conditions, you’ll use 
Dynamic keyframes.

Nearly every parameter and control in the Color page can be keyframed, but it’s important to 
understand that the Interface controls do not animate to match whatever dynamically keyframed 
changes are taking place. Instead, visible Interface controls that correspond to keyframed changes 
will jump from their initial position at one keyframe to their final position when the playhead reaches 
the next keyframe. 
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This can be most confusing with Curves, which can be interpolated using Dynamic keyframes just 
like any other control or parameter. Just keep in mind that the actual settings are animating, even 
though the controls are not.

To animate a node using Dynamic keyframes:

1.	 Move the playhead in the Keyframe Editor’s Timeline ruler to the frame where you want to 
begin a change.

2.	 Do one of the following to place a Dynamic keyframe at that frame:

>> 	Choose Mark > Make Dynamic Keyframe.

>> 	Press the START DYNAMIC button on either the T-bar or Transport panels of the DaVinci 
control surface.

	 Dynamic keyframes are green.

3.	 If necessary, adjust your clip at this first position of your animated change.

4.	 Now, move the playhead to the frame that is at the second position of the animated change 
you’re making, and create another Dynamic keyframe using the commands described in step 2.

5.	 After you’ve created this second keyframe, make whatever adjustments are necessary to the 
clip to create the final look you need.

	 At this point, playing from the first keyframe to the second keyframe should show a smoothly 
animated change from the first adjustment to the second.

Static Keyframes (Marks)

Static keyframes, or marks, are keyframes that are used to create abrupt, one frame changes from one 
state to another. They’re typically used to mark edit points separating one shot from another when 
multiple shots appear within a single clip. However, Static keyframes are also useful in any situation 
where you need a sudden change from one setting to another, such as when creating a lightning effect. 

Dynamic keyframes are round
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To automate a node using Static keyframes:

1.	 Find the frame at which you want the abrupt change to take place, and place a keyframe at 
that frame by doing one of the following:

>> 	Choose Mark > Make Static Keyframe.

>> 	Press the MARK button on either the T-bar or Transport panels of the DaVinci 
control surface.

	 Static keyframes (marks) are white.

2.	 Move the playhead to any frame before the keyframe to make changes to the entire segment 
of the clip leading up to the keyframe, or move the playhead to any frame after the keyframe 
to make changes to the entire segment of the clip appearing after the keyframe. The playhead 
does not need to be on top of the keyframe, but if it is, you’ll be adjusting the second portion 
of the clip.

Note: If you’re using Static keyframes to automate grading changes between multiple shots 
appearing within a single clip, keep in mind that you can’t add nodes from one keyframe to the next 
as you would if you had split the clip in the Edit page.

Mixing and Converting Dynamic and Static Keyframes

Typically, if you’re creating multiple animated changes within a clip, you’ll want to use all Dynamic 
keyframes. Similarly, if you’re creating a series of abrupt changes, you’ll use all Static keyframes. 
However, you can mix Dynamic and Static keyframes together, so long as you keep in mind the 
following rules:

If you add a Dynamic keyframe to the right of a Static keyframe: There will be no interpolation from 
the Static keyframe to the Dynamic keyframe. However, if you add a Static keyframe to the right of 
a Dynamic keyframe, there will be interpolation.

No dynamic interpolation following the static keyframe
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If you accidentally create the wrong kind of keyframe, it’s easy to convert it into the type of 
keyframe you need.

To change one kind of keyframe into another:

1.	 Click the keyframe you want to convert to select it.

2.	 Right-click the selected keyframe, and choose either Change to Dynamic Keyframe or Change 
to Static Keyframe.

Using Specific Keyframing Tracks

If you’re simply using the Color mode of the All/Color/Sizing command to do keyframing, then 
you’ll be adding keyframes to every parameter of the currently selected node whenever you apply 
a single keyframe. However, often that’s overkill in situations where you only need to keyframe a 
single setting or group of settings.

For example, you may find that you need to keyframe a color adjustment in order to change the 
color temperature and brightness when the camera pans across a window, but you don’t want to 
keyframe the Windows palette controls because you want to adjust them independently. This can 
be done by opening a Corrector track to expose the keyframing tracks within. 

Keyframing tracks let you keyframe different sets of similarly functioning parameters separately from 
one another. For example, there’s one keyframing track for all the color adjustment parameters, and 
another keyframing track governing the parameters found within the Qualifier palette.

Keyframing tracks let you keyframe different sets of similarly functioning parameters separately from 
one another. For example, there’s one keyframing track for all the color adjustment parameters, and 
another keyframing track governing the parameters found within the Qualifier palette.

Try Creating Keyframed Changes in a Separate Node

One tip to keep in mind is that you don’t have to create keyframed changes within the same nodes 
you’re using to create other adjustments. If you want to create some automated changes without 
altering the nodes you’ve already adjusted, you can simply create a new node in which to make your 
keyframed changes. That way, if you don’t like the result, or you somehow find yourself hopelessly 
tangled up in a needlessly complicated set of keyframes, its easy to reset either just the keyframes 
or the entire node without affecting the rest of your grade.
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To reveal a node’s keyframing tracks:

>> Click the disclosure triangle next to the number of the node you’re keyframing.

To keyframe an individual keyframing track manually:

1.	 Make whatever adjustments you need to the currently selected node, and click its disclosure 
triangle to reveal its keyframing tracks.

2.	 Move the playhead in the Keyframe Editor to where you want to add the first keyframe, then 
right-click within the keyframing track you want to animate, and choose Add Static Keyframe 
or Add Dynamic Keyframe (this example shows a Dynamic keyframe).

	 A keyframe appears at the position of the playhead in that keyframing track.

3.	 Move the playhead in the Keyframe Editor to where you want to add the next keyframe, then 
right-click within the keyframing track and again choose either Add Static Keyframe or Add 
Dynamic Keyframe (this example shows a Dynamic keyframe).

Keyframing just the Circular Power Window using its individual keyframe track 

Individual keyframing tracks within a Color Corrector node
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	 Now, you can make whatever changes you need to the controls governed by the keyframing 
track you keyframed, in order to create the necessary animated effect.

Tip: You can also animate individual keyframing tracks using automatic keyframing, explained in 
more detail later in this chapter.

The Corrector Keyframing Tracks

All of the parameters governing the adjustment of color and contrast controls, as well as various 
effects, Power Windows, and other adjustments are sorted into various sub-tracks within the 
Corrector track.

>> Linear Win: Controls parameters corresponding to the Linear Window.

>> Circ Win: Controls parameters corresponding to the Circular Window.

>> Polygon Win: Controls parameters corresponding to the Polygon Window.

>> PowerCurve: Controls parameters corresponding to the PowerCurve Window.

>>Gradient Win: Controls parameters corresponding to the Gradient Window.

>> Color Corrector: Controls all parameters found in the Camera Raw, Color Wheels, Primary 
Controls, RGB Mixer, and Curves palettes.

>>Qualifier: Controls all parameters in the Qualifier palette.

>> Defocus: Controls all parameters in the Key palette.

>>NR: Controls the Spatial and Temporal Noise Reduction and Motion Blur parameters found 
in the Motion Effects palette. 

>>OFX: Controls all parameters of whichever OFX plugin is applied to the current node.

>>Node Format: Controls all parameters of the node sizing mode of the Sizing palette for the 
current node.

The Sizing Keyframing Tracks

The Sizing keyframing tracks govern sizing transforms and stereoscopic adjustments separately 
from the color controls.

>> Input Sizing: Controls the Input Sizing parameters found within the Sizing palette. 

>> Convergence: Controls the Convergence parameter in the Stereo 3D palette.

>> Float Window: Controls the Left, Right, Top, and Bottom Position/Rotate/Softness Floating 
Windows parameters.

>> Auto Align: Controls the Pitch and Yaw parameters in the Stereo 3D palette.

Tip: Output Sizing can only be keyframed when you choose Track mode in the Node Editor.
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The Ext Matte Node’s Freeform Isolation Track

If your node tree has an External Matte, the EXT MATTE node exposes a Freeform Isolation track in 
the Keyframe Editor. This is useful for time offsets or Sizing repositioning of the Ext Matte image.

Automatic Keyframing

Every track in the Keyframe Editor has an Auto-Keyframing button that can be turned on or off. 
When auto-keyframing is enabled for a particular track, every change made to a parameter or 
control associated with that keyframe track automatically generates a keyframe.

Used with a keyframing track, auto-keyframing makes it simple to set up animated changes to 
specific adjustments within a node. This is a lot easier than manually placing keyframes one by one.

On the other hand, turning on auto-keyframing for the Corrector track correspondingly enables auto-
keyframing for every keyframing track belonging to that node. In this case, keyframes will automatically 
be placed on whatever keyframing track corresponds to the parameters or controls you adjust.

Auto-keyframing selected for Circular Window on Node 1

When auto-keyframing is disabled, changes you make alter existing keyframes. How this alteration 
works depends on the location of the playhead, and the type of keyframes in the Keyframe Editor. 
For more information, see the next section.

Modifying Keyframes

Once you’ve started adding keyframes to animate changes to a grade, there are a variety of 
methods available to navigate and edit these keyframes to further customize these effects. This 
section covers the different ways you can navigate among, alter, and remove keyframes.

Navigating Among Keyframes

For many operations, it’s necessary to move the playhead directly on top of the keyframe you want 
to modify. While you can always use the transport controls or pointer to move the playhead, there 
are also commands for jumping to a specific keyframe.
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To move the playhead among a series of keyframes, do one of the following:

>> Choose Playback > Next Keyframe (Option-Grave) or Playback > Previous Keyframe 
(Option-Semicolon).

>>On the Transport panel of the DaVinci control surface, press SHIFT then STEP REV to 
move the playhead to the previous keyframe, or press SHIFT then STEP FWD to move the 
playhead to the next keyframe.

Moving Keyframes

If you need to change the timing of a series of keyframes, you can move the position of any keyframe, 
along with whatever values that keyframe contains.

To move a single keyframe using the on-screen interface:

>> Use the pointer to drag any keyframe to another location.

>> Drag keyframes in a Corrector or Sizing track to simultaneously move all other keyframes 
on the same frame within that corrector.

To move a single keyframe using the DaVinci control surface LIFT MARK button:

1.	 Move the playhead to the keyframe you want to move. This procedure works for either Dynamic 
and Static keyframes.

2.	 Press LIFT MARK on either the T-bar or Transport panels.

3.	 Move the playhead to the frame you want to move that playhead to.

4.	 Press MARK on either the T-bar or Transport panels. 

To move multiple keyframes at the same time:

1.	 If necessary, open the keyframe track with the keyframes you want to move.

2.	 Hold the Shift key down, and drag a bounding box around the keyframes you want to move. 
Selected keyframes appear highlighted in red.

3.	 Keeping the Shift key held down, drag anywhere within the keyframe track to move all selected 
keyframes to the left or right.

Changing Keyframe Values

Unlike many other applications, DaVinci Resolve lets you alter keyframe values when the playhead 
isn’t directly on an existing keyframe. How this works depends on the location of the playhead 
relative to the keyframes that are in the Keyframe Editor, and what kind of keyframes you’re editing.

>> If the playhead is to the left or on the first Dynamic keyframe: The Dynamic keyframe at or 
to the right of the playhead updates with the new adjusted values.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

754

ADVANCED COLOR FEATURES12

>> If the playhead is to the left or on the last Dynamic keyframe: The Dynamic keyframe at or 
to the left of the playhead updates with the new adjusted values.

>> If the playhead is between two Dynamic keyframes: The Dynamic keyframe to the left of 
the playhead updates with the new adjusted values, but the Dynamic keyframe to the right 
is unaffected.

>> If the playhead is between two Static keyframes (marks): Adjustments made between two 
Static keyframes always affect the keyframe to the left of the playhead. The entire segment 
of the clip between that keyframe and the next is affected equally.

Changing Dynamic Attributes

By default, the transition from one Dynamic keyframe to the next is linear. However, if you need to 
alter the acceleration of value interpolation from one Dynamic keyframe to the next, then you can 
change that keyframe’s Dynamic Attributes.

To change a keyframe’s Dynamic Attributes:

1.	 Right-click a keyframe in the Keyframe Editor, and choose Change Dynamic Attributes.

2.	 When the Dynamic Attributes window appears, do one or both of the following:

>> Choose a new outgoing acceleration curve using the Start slider, affecting the interpolation 
occurring to the right of that keyframe.

>> Choose a new incoming acceleration curve using the End slider, affecting the interpolation 
occurring to the left of that keyframe.

	 As you choose different acceleration curves, the display to the right shows the resulting  
curve graph.

Changing the dissolve profile



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

755

ADVANCED COLOR FEATURES12

3.	 When you’re happy with the curve, click OK.

By using different Start and End values, you can make animated adjustments “ease in” or “ease 
out” of a particular keyframe, to create a more gradual or abrupt transition.

Tip: The default dynamic profile start and end of each new keyframe can be set in the Editing and 
Ripple panel of the Project Settings.

Deleting Keyframes

You have the option to delete individual keyframes, or to delete all the keyframes within a particular 
grade at once.

To delete individual keyframes, do one of the following:

>>Move the playhead on top of the keyframe you want to delete, then choose Mark > Delete 
Keyframe. Every keyframe at the position of the playhead is deleted.

>> Using the DaVinci control surface, press DELETE on either the T-bar or Transport Panels. 
Every keyframe at the position of the playhead is deleted.

>> Using the pointer, click a keyframe in the Keyframe Editor to select it, then right-click that 
keyframe and choose Delete Selected Keyframe. Only the selected keyframe is deleted.

To delete every keyframe for the current clip:

>> Choose Mark > Delete All Keyframes.

Copying Keyframes

It’s possible to copy a set of keyframes from one node to another, either within the current grade, 
or in another clip entirely.

To copy a set of keyframes from one node to another:

1.	 Select a node to copy keyframes from, and choose Edit > Copy (Command-C).

2.	 Select another node to paste keyframes to, and choose Edit > Paste (Command-V).

Tip: This procedure also works for tracking data that you want to copy from one node to another, 
either in the current clip, or another clip altogether.

Keyframes and Saved Stills

If you save a still from a clip using keyframes within the grade, the keyframes are not saved. However, the 
still and grade that are saved reflect whatever parameter values were at the position of the playhead. 

For example, if a clip has a dynamically keyframed transition from a saturation of 50 to a saturation 
of 0, and you place the playhead right in the middle of both keyframes when you save a still, the 
grade and still that are saved have a saturation of 25.
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Adding EDL Marks

Just as clip grades are separate from the track grade that can be applied to the entire Timeline, 
so clip keyframes are separate from track keyframes. Keyframes you apply to the track grade work 
exactly the same as clip keyframes. However, there is one extra option you have when keyframing 
the track grade.

If you find yourself wanting to adjust a track grade individually to take into account variations from 
one clip to the next, you can use the Add EDL Marks on Tracks command to add a Static keyframe 
(mark) to the Keyframe Editor at the position of every edit point in the entire Timeline.

To add EDL Marks:

1.	 Choose Track from the Node Editor’s mode pop-up menu.

2.	 If you want to keyframe a grade, then create whatever grade you need to apply to the entire 
Timeline. If you want to keyframe Sizing settings, you don’t need to do anything else.

3.	 Right-click the Corrector track or the Sizing track in the Keyframe Editor, and choose Add EDL 
Marks on Tracks.

	 Marks appear at the frame of every edit point in the Timeline. You may want to widen the 
Keyframe Editor to make it easier to work with all these keyframes.

After you’ve added EDL marks, you can delete them if you decide you don’t want them any more.

To delete EDL marks:

>> Right-click the Corrector track in the Keyframe Editor, and choose Add EDL Marks on Tracks.

If you’ve added your own keyframes in addition to the EDL marks, then the Delete EDL Marks on 
Tracks command only eliminates the EDL marks. Your custom marks are left alone.
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The interactive Dirt and Dust Removal tool provides an interface for dustbusting right from within 
DaVinci Resolve. This is a raster-based effect, and results in a duplicate set of “dustbusted” media 
being created within a hidden subdirectory. 

If, at any point, you’re unsatisfied with the adjustment you’ve made, you need only use the Undo 
command to return the clip you’re working on to its prior state.

Note: The Dirt and Dust Removal tool only works with DPX image sequences. Media in a raw, ProRes, 
or DNxHD format must first be converted to a DPX image sequence before it can be operated on 
with this tool.

To use the Dirt and Dust Removal tool:

>> Click the Onscreen Control pop-up menu at the bottom left of the Viewer, and choose  
Dust Removal.

Selecting the Dirt and Dust tool in the viewer OSD menu

To open the Dirt and Dust Removal tool setup options:

>> Right-click the Dirt and Dust Removal icon showing in the Onscreen Control pop-up to 
open the setup window.

Dirt & ROI Settings Parameters

In the Dirt & ROI Settings window, there are a number of parameters that you can use to optimize 
this tool for the particular problem you’re trying to solve.

>> Algorithm: The Algorithm pop-up menu lets you select the method of filtration to use when 
painting out dirt or dust. Different options provide different methods for replacing the 
problem pixels with image data copied from other frames in time, or from other regions of 
the current frame. You’ll want to choose an option that works best for the type of camera 
and subject motion happening within the clip you need to clean. For more information on 
the advantages of each algorithm, see the next section.

Dust Removal
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>> Aggression: Increase or decrease the Aggression and Blend sliders depending on the 
degree of correction you want to apply.

>> Blend: Sets the % of the original image to be feathered at the edges of the repair.

>>Optimize: Turning this option on provides better-looking results, at the expense of increased 
processing time.

>> ROI Mode: Determines whether a correction is applied with a single click, or via a paint 
stroke. There are three options.

>> Click and Clean: Applies a correction with one click, and is fast to use on small dust spots. 

>> Draw and Clean: Lets you “paint” over a larger dirty area with the mouse or a pen, with 
the correction being applied at the conclusion of your paint stroke.

>> Cnc Size: Defines the width of the “brush” that’s used to paint out dirt and dust.

Algorithms for Dirt and Dust Removal

There are six algorithms you can choose from that determine how the pixels you paint over are 
automatically replaced.

>> Auto-temporal –/+ 1: When an ROI is drawn, the previous frame, the next frame and the 
current frame will all be used for analysis. The best of these 3 will be automatically selected 
and used for removing the dirt in the current frame.

>> Auto-temporal –/+ 2: This is the same as the above, but the frames used instead are the 
current frame, previous-to-previous frame (i.e., 2 frames back), and next-to-next frame (i.e., 
2 frames forward). Therefore, if the ROI is drawn on frame 100, frame 98, frame 100 and 
frame 102 will be used for analysis. The best of these 3 will be used for removing the dirt 
in the current frame. The advantage of this selection is that it will avoid the appearance of 
frozen grain, which may be possible in case of dirt against a stationary background.

>> Temporal –/+ 1: if the ROI is drawn by dragging the mouse from left to right, the next frame 
will be used for motion-compensated dirt removal. If the ROI is drawn by dragging the 
mouse from right to left, the previous frame will be used.

>> Temporal –/+ 2: if the ROI is drawn by dragging the mouse from left to right, the next-
to-next frame will be used for motion-compensated dirt removal. If the ROI is drawn by 
dragging the mouse from right to left, the previous-to previous frame will be used.

>> Spatial: In case of fast or blurred motion, using the previous or next frames may give 
unsatisfactory results. In this case, the same frame itself can be used for removing the dirt. 
This will use surrounding information in the current frame to remove the dirt.

>>Median: The Median filter performs a blending of the pixels, smoothing out the region. Use 
this when other options do not replace the image, or when there is no support information 
in which to reconstruct the original. Using small boxes will produce better results.



13
The Gallery and Grade Management
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The Gallery and Grade Management

The Gallery provides a way to save, browse, and use saved still frames from different clips in a 
program. Each project is saved with its own individual set of stills, and each still you save consists of a 
DPX image of the saved frame, and the grade metadata. You can use saved stills for reference when 
matching one clip to another, or you can use them to copy grades to other clips, or other timelines. 

There are two ways to work with the contents of the Gallery. The Color page has a small Gallery, to 
the left of the Viewer, that provides quick access to saved stills and grades as you work. The Gallery 
window, which can be opened via a button at the bottom of the Gallery, provides a dedicated 
interface for organizing your grades, copying grades and memories between projects, and for 
accessing a dedicated collection of DaVinci Resolve Looks.

This chapter provides information on the commands, options, and procedures that are available in 
each of these areas.

Using the Gallery� 760

Saving and Deleting Stills� 760

Where Are Stills Saved?� 762

Playing Stills and Setting Up Image Wipes� 762

Labeling and Searching for Stills� 763

Gallery Options� 764
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The Gallery Window� 768
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Importing and Exporting Stills� 770
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Using Local Versions by Default� 774
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The Importance of “Version 1”� 782

Rendering Versions� 783

Protecting Adjustments with the Copy Grade Options� 784

Copying Grades� 784

Clip Grades and Timeline Grades in Saved Stills� 785

Choosing Which Part of a Grade to Copy With All/Color/Sizing� 785
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Copying Grades Using the Mouse� 785

Copy Forward Commands� 786

Copying Using Memories� 786

Copying Using Preview Memory� 787

Copying from Stills in the Gallery� 788

Append Node Graph� 788

Copying Individual Nodes and Settings� 789

Copying Grades Using the DaVinci Control Surface� 790

Copy Forward Keys� 790

Scroll� 790

Rippling Changes Using the DaVinci Control Surface� 792

Using Groups� 795

Creating and Managing Groups� 795

Using Group Modes to Control Which Grades Ripple and Which Don’t� 797

Exporting Grades and LUTs� 802
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The Gallery in the Color page and the expanded Gallery window environment share many of the 
same commands for organizing stills. However, the commands for saving stills and customizing 
split-screen views are restricted to the Color page.

Color page Viewer and Gallery with Video Scopes

Saving and Deleting Stills

One of the most common operations is to save a clip as a still for future reference.

To save an individual still in the Color page, do one of the following:

>> Choose View > Grab Still (Option-Command-G).

>> Right-click on the Viewer and choose Grab Still.

>> Press GRAB STILL on the Transport panel of the DaVinci control surface.

It’s also possible to save stills automatically for every clip in the entire Timeline. This can be useful 
if you’re planning to export a set of grades to hand off to another colorist, or if you need to apply a 
series of grades manually from one project to another when ColorTrace™ won’t work.

Using the Gallery
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To save a still for every clip in the current project, do one of the following:

>> Right-click the Viewer, and choose one of the following options:

>>Grab All Stills from First Frame: The first frame of each clip in the current Timeline is 
saved to the Gallery.

>>Grab All Stills from Middle Frame: The middle frame of each clip in the current Timeline 
is saved to the Gallery.

>>Grab Missing Stills from First Frame: Only the first frame of clips with no stills in the 
Gallery already are saved to the Gallery.

>>Grab Missing Stills from Middle Frame: Only the middle frame of clips with no stills in 
the Gallery already are saved to the Gallery.

Once the Gallery is filled with many stills, it may be necessary to make multiple selections for 
operations such as reorganizing, deleting, or exporting stills.

To select a range of stills, do one of the following:

>> Click one still, then Shift-click another to select a contiguous range of stills.

>> Command-click any stills you like to make a discontiguous selection.

>> Right-click any still, and choose one of the following commands:

>> Select All: Selects every clip in the Gallery

>> Select Current to Last: Selects every still from the one you’ve clicked through the last 
still in the Gallery.

>> Select First to Current: Selects every still from the one you’ve clicked through the first 
still in the Gallery.

If you need to remove one or more stills, this can only be done using the Gallery’s contextual menu.

To delete one or more stills, do one of the following:

1.	 Select one or more stills in the Gallery.

2.	 Right-click one of the selected stills and choose Delete Selected.

Each still is also saved with a variety of metadata that is used by DaVinci Resolve to manage the 
contents of the Gallery in different ways. This metadata can also be used for searching and sorting, 
and is viewable by opening the Still Properties window.
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To display a still’s properties:

>> Right-click a still in the Gallery and choose Properties. 

A floating translucent window appears displaying the date the still was created, what clip it 
was grabbed from, when it was grabbed, and the source and record timecode values of the 
frame it came from.

Right-click on a still to choose Still Properties

Where Are Stills Saved?

By default, all stills you save are saved in the DPX format, and are placed in the directory path 
defined in the “Gallery stills stored at” field in the General Options panel of the Project Settings. 
This path defaults to a hidden “.gallery” directory that’s created at the location of the first Media 
Storage Volume you specify in the DaVinci Resolve Preferences window.

Playing Stills and Setting Up Image Wipes

There are many ways to play a still in the Color page, making it visible as an image wipe in the Viewer 
and on the external display connected to your video interface.

To play a still, displaying it as an image wipe or full screen, do one of the following:

>> Double-click a still in the Gallery.

>> Select a still in the Gallery, and click the Image Wipe button on the top Viewer toolbar.

>> Click a still in the Gallery, then right-click in the Viewer and choose Toggle Wipe.

>> From the View menu, choose Next Still (Option-Command-N) or Previous Still (Option-
Command-P) to select a still in the Gallery, and then choose Wipe On/Off (Command-W) 
to play it.

>> Press PREV STILL or NEXT STILL on the Transport panel of the DaVinci control surface to 
select a still, then press PLAY STILL. Press PLAY STILL again to dismiss the still.

Whenever you play a still, the Viewer mode’s pop-up menu changes to Split mode.
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Once displayed, the wipe between the current clip and the still being referenced can be moved and 
reoriented in different ways. If you want a full-screen view so you can flip back and forth between 
the still and the current clip, simply adjust the split until the still fills the entire Viewer.

To adjust a wipe in the Viewer, do one of the following:

>> Drag the pointer within the Color page’s Viewer to move the wipe.

>> Push the T-bar lever up and down on the T-bar panel of the DaVinci control surface.

To customize an image wipe in the Viewer, do one of the following:

>> Use the controls at the top of the Viewer toolbar 

>> Choose one of the following from either the View menu or the Viewer contextual menu:

Image wipes can be customized in the following ways:

>>Wipe Style: Cycles among the Vertical Wipe, Horizontal Wipe, Blend Wipe, and Alpha 
Wipe modes.

>> Invert Wipe: Reverses each half of the wipe.

Labeling and Searching for Stills

By default, all stills are identified by a three number code. The first number is the video track the clip 
is on, the second number is the clip’s position number in the current Timeline, and the third number 
is the version number.

All stills are numbered

If you’ve saved many stills, it can help to label the important ones with whatever text you like (it’s 
best to avoid using the forward slash character). Once labeled, you can search for stills by label 
using the search field, at the upper right-hand corner of the Gallery.

To label a still:

1.	 Right-click a still in the Gallery and choose Change Label.

2.	 Type a name into the Change Still Label dialog, and click OK.
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	 The new label appears underneath the still number.

You can also label stills for easier identification

To search for a still by label:

>> Click the Search field to place the cursor within, then type the name or description you are 
searching for.

As soon as you start typing, DaVinci Resolve automatically begins to filter the results of the 
currently selected album in the Gallery to match what’s been typed. 

Gallery Options

When you right-click the gray area of the Gallery, behind the Still icons, you can open a contextual 
menu that provides a variety of additional options for controlling how many stills are saved, how 
they’re displayed, and how they’re arranged in the Gallery. There are the following options:

>> Trace Timeline: When enabled, selecting a clip in the Timeline also automatically selects 
the first still that was saved from that clip to the Gallery.

>>One Still Per Scene: When enabled, restricts the Gallery to save only a single still for each 
clip in the Timeline. If multiple stills have already been saved before turning this option on, 
those stills will remain in the Gallery until you save another still from the same clip, at which 
time all other stills from that clip will disappear.

>> Apply Display LUT: If you have a Display LUT selected in the Look Up Tables panel of the 
Project Settings, it’s applied to the video output via a connected video interface, and 
also to the Viewer. Ordinarily, you don’t also want the display LUT applied to stills you’re 
saving since it’s meant to be temporary. Accordingly, stills are saved with a LUT-free image. 
However, in instances where you may also want to save a reference to the currently used 
Display LUT, turning on “Apply Display LUT” saves the Display LUT along with the still, 
and applies that LUT when that still is used for split-screen reference. Keep in mind that 
the internally saved Display LUT is only used when playing that still in the Viewer; the DPX 
image that’s saved remains unaffected.
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>> Sort Stills By: Choosing an option from this submenu changes the sort order of all clips in 
the Gallery. The options are: 

>> Record Timecode: Sorts all stills by their position in the program.

>> Source Timecode: Sorts all stills by the timecode of the source clip they came from.

>> Create Time: Sorts stills based on when you saved each still.

>> Clip and Create Time: A two-level sort; stills are sorted primarily based on the ID number 
of the clips they came from, and secondarily based on the time they were created.

>> Use Timeline Keyframes: Saves keyframes from the Timeline along with the saved still 
and grading information. These keyframes will be applied to whatever clip this grade is 
copied to. 

>> Show All Stills: This command shows all available stills in the current album if any have been 
hidden, for example by searching or by using the Show Current Timeline Only command.

>> Show Current Timeline Only: Choosing this option restricts the Gallery to only showing 
the stills that were saved from the currently selected Timeline. All other stills from other 
Timelines are hidden until you switch to that Timeline.

Organizing Stills Using Albums

All stills you save are always placed into the currently open album of the Gallery, which defaults for 
new projects to “Album 1.” However, you can create additional albums with which to organize your 
stills into whatever categories you require. Albums can be shown, created, and removed using the 
Gallery in either the Color page or Gallery windows.

Use Albums to organize your stills
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To show or hide the Albums list:

>> Click the Album button, at the bottom of the Gallery but above the Memories.

If hidden, the Albums list appears, to the left of the Gallery, containing all albums that 
are currently available in the project that’s open, as well as the PowerGrade album at the 
bottom. If the Albums list is already visible, then it becomes hidden, making more room for 
still thumbnails in the Gallery.

Once you’ve displayed the Albums list, there are a variety of ways you can quickly and easily work 
with albums.

Methods of working with albums:

>> To add a new album: Click the Plus (+) button at the bottom of the Albums list. A new album 
is created, numbered incrementally.

>> To add a new PowerGrade album: Right-click the Gallery browser and choose Add 
PowerGrade Album. A new album is created, numbered incrementally.

>> To rename an album: Double-click any album in the list, and when it is selected, type a new 
name and press Return.

>> To navigate albums: Click any album to make it the current album. Using the DaVinci control 
surface, you can use the PG UP/GALLERY/PG DOWN button; press SHIFT UP and GALLERY 
to move to the next album up the list, or press SHIFT DOWN and GALLERY to move to the 
next album down the list.

>> To move clips from one album to another: Drag and drop a still from the Gallery to an album.

>> To remove an album: Select an album, then click the Minus (–) button at the bottom of 
the Album list. All clips inside that album will be deleted along with the album, so use this 
control carefully.

PowerGrade Albums

PowerGrade albums are meant to be repositories for grades you want to reuse frequently, or for 
stills that you need to reference from multiple projects, such as when grading a series that shares 
common looks from episode to episode.
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PowerGrades are associated with your user login

Unlike stills saved to the other albums in the list, which are ordinarily available only to the project in 
which they were saved, stills saved to a PowerGrade album are shared among all projects that you 
create within a particular user of a specific database. How widely PowerGrade album grades are 
available depends on the type of database you’re using.

If you’re using a disk database, stills saved to PowerGrade albums are available to every project 
saved to the particular disk location specified by the disk database. However, if you switch to an SQL 
database, then the contents of the PowerGrade album are unique to each individual database you 
create, and are available only to the other projects that are saved within that database. 

Creating a new database creates a new PowerGrade album, which is a clean slate. However, you can 
always use the Gallery window to copy PowerGrade stills from other projects and databases to the 
current one, and you can create as many PowerGrade albums as you need to organize your grades. 
For more information about project management and databases, see Chapter 16, “Managing 
Databases and Remote Grading.”

Functionally, PowerGrade albums are identical to any other album, and you can save, organize, 
and use stills in PowerGrade albums as you would with other albums. Since PowerGrade albums 
are special in that they’re maintained by Resolve, the last PowerGrade album cannot be deleted.
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While you can do quite a lot of stills management using the Gallery as it appears in the Color page, 
the Gallery window provides additional functionality for copying stills among different projects and 
databases, for organizing your stills and memories, and for accessing the DaVinci Resolve Looks 
that accompany the application.

Gallery window

The Gallery window is divided into four areas:

>> Stills navigator: Lets you navigate the contents of other projects and databases that are 
available. Independent projects, as well as database > user > project relationships, appear 
in this hierarchical list. Click the disclosure triangle next to any item on this list to reveal its 
contents. Click any project in the list to reveal its albums and stills in the Group Stills browser.

>>Group Stills browser: Displays the contents of the currently selected item in the Stills 
navigator. One or more selected stills can be copied to the current project by selecting an 
album in the Project Stills browser, and dragging and dropping the selected stills to the 
Project Stills browsing area.

>> Project Stills browser: Contains the same Album list and Project Stills browser that’s visible 
in the Color page Gallery.

>> Project Memories: Provides a larger view of the project memories that are visible in the 
Color page Gallery.

The Gallery Window
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Customizing the Gallery Window

There are two ways of customizing the Gallery window to create more room when browsing large 
collections of stills.

To expand different areas:

>> Click the expand button at the bottom left of the Group Stills or Project Stills browsers to 
expand that half of the interface to take up the entire screen. Once expanded, a collapse 
button appears at the bottom left of the expanded area that lets you return the interface 
to the way it was.

To resize different areas:

>>Move the pointer to the border between any areas of the Gallery. When the pointer changes 
to the resize cursor, drag the border to resize the adjacent interface areas to whatever size you 
need. Dragging all the way to the edge of the screen hides that interface area completely.

What’s Available in the Stills Navigator

The Stills Navigator accesses a variety of content via a hierarchical list. Disclosure triangles to the left 
of each item in the Stills browser let you access the contents of each item, and many items have 
several nested levels of content within, each accessed by its own disclosure triangle.

The Gallery Stills database show all projects connected so you can import those stills

>> DaVinci Resolve Looks: A collection of predefined grades, categorized by type, that provides 
excellent examples of different looks available in Resolve. These grades are installed with 
DaVinci Resolve and cannot be altered.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

772

THE GALLERY AND GRADE MANAGEMENT13

>> Databases: Each database that’s available appears within this list. Each database has a 
nested series of Users, Projects, and Timelines within, as well as one nested PowerGrade 
item for each user, which provides access to the saved stills within.

>>Orphans: Stills are saved to a separate directory which is defined in the General Options 
panel of the Project Settings. Whenever you delete a database, the stills that corresponded 
to that database become orphaned. All orphaned stills that lack a connection to any current 
database appear within the Orphan item in the Stills Navigator.

Importing and Exporting Stills

It’s possible to import still images in different graphics formats into the Gallery, which can be 
particularly useful when a client provides reference images to which they’d like you to refer. It’s also 
possible to export stills from the Gallery, which is good for sending a series of reference stills for 
approval to a remote client. In both cases, you can choose whether to import or export images with 
an accompanying LUT.

For both import and export, DaVinci Resolve supports the following file formats: DPX, CIN, TIFF, 
JPEG, PNG, PPM, BMP and XPM.

To import one or more still images:

1.	 Right-click anywhere on the gray background of the Gallery.

2.	 Choose one of the following commands:

>> Import: Imports image files, along with a matching DRX file, if one is present in the 
selected directory.

>> Import With Output LUT: Imports an image and DRX file, along with a matching LUT file,  
if one is present in the selected directory.

3.	 When the Import Stills dialog appears, choose the type of files you want to import from the 
“Files of type” pop-up menu, then navigate to the files you want to import, select them, and 
click Import. 

To export one or more still images:

1.	 Select one or more stills in the Gallery.

2.	 Right-click one of the selected stills, and choose one of the following commands:

>> Export: Two files are saved for each still you selected. An image file in the format of your 
choice, and a DRX (DaVinci Resolve eXchange) file that contains the grading metadata.

>> Export With Display LUT: Along with the image and DRX file, a Display LUT is also exported.
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3.	 When the Export Stills dialog appears, choose a file format to export to from the “Files of type” 
pop-up menu, then choose a location, type a name into the Save As field, and click Save.

	 Each of the selected stills is exported with all accompanying files. Each file uses as its prefix the 
name you typed into the Export Stills dialog, followed by an underscore, the still ID number of 
the selected still, and the three letter file extension.

Using and Organizing Memories

Stills and memories contain identical information, and can be split screened, copied, appended, 
exported, and can display their node graph just like any other still. However, stills that are assigned 
as a memory make them easier to access via keyboard shortcuts, and from dedicated buttons on 
the DaVinci control surface.

Place grades you will use often in Memories for faster recall

To that purpose, the Memories thumbnail display makes it easy to keep track of which stills have 
been assigned to which memories in situations where you’re using multiple memories to copy 
grades throughout a program.

To copy stills and memories back and forth, do one of the following:

>> Drag a still onto a memory bank.

>> Drag a memory into the Gallery.

Tip: In this way, memories can be used to copy stills from one album to another.

To save the current clip’s grade to a memory for future use, do one of the following:

>> Choose Color > Memories > Save Memory A–H (Shift-Option-1 through 8)

>> Using the DaVinci control surface, press CRNT on the Transport or T-bar panel, then press 
the letter of the memory bank you want to save to. Use the SHIFT UP button to save to 
another memory sharing the same button.

If you save a grade to a memory that already contains something, the previous memory 
is overwritten.
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To apply a memory to the current clip in a timeline, do one of the following:

>> Right-click a memory and choose Add Correction.

>> Choose Color > Memories > Load Memory A–H (Command-1–8)

>> Using the DaVinci control surface, press the letter of the memory bank you want to apply. 
Use the SHIFT UP button to apply a memory that shares the same button.

To clear a memory:

>> Right-click a memory, then choose Clear.
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Working quickly requires a mastery of the numerous grade management features built into DaVinci 
Resolve. These features are designed to help you copy and ripple grades to individual clips, among 
manually defined groups of clips via the Node Editor’s Clip mode, or among automatically linked 
clips that share the same source clip in the Media Pool (when using Remote versions). Multiple 
versions of grades are supported for every clip, as are various options for previewing, overwriting, 
and appending these versions.

Choosing to Copy Grades Manually or Automatically Using Versions

Each grade you apply to a clip is a version. Each clip can have multiple versions, although only one 
version can be applied at a time. By default, the first grade applied to every clip in a timeline is a 
local version named “Version 1.” A clip’s version name and/or number appears underneath the clip 
thumbnail, to the right. You can also see the version name, along with a list of all the other versions 
that are currently available to that clip, by right-clicking a clip in the Timeline and looking for the 
version names that appear underneath the Local Versions submenu.

Selecting versions of grades from the Timeline Thumbnails

Note: Double-clicking the version name underneath a clip’s thumbnail in the Timeline toggles the 
version names to the codec used by each clip. Double-click again to toggle back.

There are two different types of versions in DaVinci Resolve, each of which provides a different 
method of grade management and linking among the clips and timelines of a project.

>> Local Versions: The default mode of grade management. Clips using local versions are 
unlinked, so each clip has its own grade which is not shared with any other clips in any other 
timelines. Changing the grade of a clip using a local version has no effect on any other clip 
in that project. 

>> Remote Versions: An alternate mode of grade management that you can enable. All clips 
using remote versions that share the same source clip in the Media Pool are automatically 
linked, in all timelines, and share the same set of grades.

Using Versions to Manage Grades



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

776

THE GALLERY AND GRADE MANAGEMENT13

If you use local versions to grade all your clips, you don’t have to worry about one clip’s grade being 
accidentally copied to other clips that happen to come from the same file in the Media Pool, which 
can make it easier to work. On the other hand, you need to manually copy every grade that you want 
to duplicate, even among clips that clearly come from the same take or angle. You can always create 
a group to share a grade among clips using local versions, but that’s an extra step.

Switching to use remote versions, instead, puts you into a mode where clips using remote versions 
that share the same media file are automatically linked together. This gives you a convenient 
shortcut for grading your program, since a grade that’s applied to one linked clip is automatically 
copied to every other clip it’s linked to, which can be convenient when grading a series of headshots 
appearing throughout a program that come from the same interview take. Another use of remote 
versions is when you’re importing a new edit of an already graded timeline. Using remote versions, 
you can set your project up so that new incoming timelines are automatically relinked to the previous 
timeline’s grades.

The only disadvantage to using remote versions is that when you find you need to make individual 
adjustments to clips that are linked, it’s an extra step to either create another version, or switch that 
clip to use a local version, in order to keep its adjustment separate. This will be discussed in more 
detail later in this chapter.

Mixing Versions

Each clip is capable of having multiple local and remote versions at the same time; you get to 
choose which to apply. Which type of versioning is best depends on the type of project you’re 
working on, the way in which the media was shot, and how you like to work. The following sections 
explain the differences in workflow.

Using Local Versions by Default

Since local versions are the default method of grading when you first create a new project (unless 
you’ve edited your settings presets), you don’t need to do anything to enable this mode at first. As 
the name implies, local versions are local to the Timeline in which they appear, so local versions 
are not rippled to linked clips, and they’re not shared among different timelines. This makes it 
easy to avoid accidentally having grades copied when you don’t want them to be, but you lose the 
conveniences that automatic linking can provide.

However, you can always switch the clips in a timeline to use Remote versions if you change your 
mind, either individually, or all together.
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Using Remote Versions to Enable Automatic Linking

Remote versions let all clips from the same source media file in the Media Pool share their grades 
automatically, either within a single timeline, or across multiple timelines in the same project. 
However, to enable the convenience of remote grades, you need to put Resolve into this mode of 
working using the Settings Window. 

To enable remote grades to be used:

>>Open the Project Settings, open the Color panel, and turn off “Use local version for new 
clips in timeline.”

Turning this option off only affects clips that are added to Timelines from that point onward. You can 
keep track of which clips use remote versions by the (R) that appears to the right of the version 
name/number in the Thumbnail Timeline.

Turning off “Use local version for new clips in timeline” to enable remote grades to be used by default

How Automatic Linking Works

When clips using remote versions have been added to a timeline, any other clips in any timeline that 
(a) use remote versions also, and (b) refer to the same file in the Media Pool are linked. Selecting a 
clip using a remote grade in the Color page that is automatically linked to one or more clips displays 
a small “linked” badge at the left of that clip’s timecode in the Thumbnail Timeline.

The linking arrow shows this clip has the same source as the one selected on the Timeline

Tip: The Timeline Filtering pop-up in the Color Page tool bar has an option named “Common Media 
Pool Clips” that only shows clips in the Timeline that are linked to the currently selected clip.
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Adjustments that you apply to a remote version of one linked clip are automatically rippled to every 
other clip it’s linked to, which can save you an enormous amount of time when you’re getting started 
with a new program. For example, if every reverse angle from the same take in a particular angle of 
coverage is automatically linked using remote versions, then the grade you apply to one reverse 
angle clip will ripple to every other reverse angle clip throughout the Timeline.

Timeline with two automatically linked clips shown

So long as remote versions are enabled, there are other ways that linked clip relationships are 
formed. If, after conforming an AAF, XML, or EDL, you used the Split Clips button in the Color page 
to split one conformed clip into many, each of the clips you split would be linked, since they too 
would share the same source media in the Media Pool.

Finally, automated linking also occurs for clips that appear in multiple timelines that also use remote 
versions. As a result, the grade you apply to one linked clip is automatically rippled to every other 
clip it’s linked to.

Note: Media management or media consolidation operations that split large source media files into 
many individual media files will defeat automatic linking within the same timeline, since each clip will 
be conformed to its own individual media file. 

Starting With Remote Versions, Then Switching to Local Versions

It’s possible to combine the best aspects of remote and local versions into a single workflow, taking 
advantage of your ability to freely switch from one to the other. Since remote versions make it easy 
to copy grades among clips that are similar, you can switch to using remote versions first, and then 
grade your way though the Timeline until you get to the point where you need to start making 
much more specific changes to individual clips. Then, it’s easy to either switch each linked clip that 
needs individual adjustment to use a local version, or to use the Copy Remote Grades To Local 
command (described later) to copy the current remote version of each and every clip to a local 
version, at which point you can make all the specific tweaks you need to without worrying about 
changes being accidentally copied.
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Creating a Master Timeline

Versions 9 and before of DaVinci Resolve automatically created a Master Timeline whenever you 
added clips to the Media Pool. This changed in version 10, which by default has no Master Timeline. 
However, if you want to create a Master Timeline in order to use it as you would have before, this is 
easy to do.

If you want a Master Timeline to have a single timeline that always contains all clips currently in 
the Media Pool, there’s a way you can create one. However, you need to do it immediately upon 
creating a new project, before adding any media to the Media Pool. Once you’ve added one or 
more clips to the Media Pool, the option you need to do so will be disabled.

To create a new Master Timeline:

1.	 Create a new project, open the General Options panel of the Project Settings, and turn on the 
“Automatically match master timeline with media pool” checkbox. If you also want all clips to 
use Remote versions as you grade by default as in previous versions of Resolve, you can turn 
off the “Store grade with local version by default.”

2.	 Click Apply, and close the Project Settings window.

3.	 Open the Edit page, and choose File > New Timeline.

4.	 When the New Timeline Properties window appears, turn the Empty Timeline checkbox off, 
and click Create New Timeline.

	 Now, in addition to the new Timeline, a Master Timeline appears in the Timeline list.

Once created, the Master Timeline contains every clip in the Media Pool of the current project. If you 
color correct the clips in the Master Timeline, you’ll find there’s only one set of versions available, 
found underneath the Local submenu of the Color page Timeline’s contextual menu. It’s important 
to understand that local versions within the Master Timeline are in fact the remote versions found in 
every other timeline of that project. 

In fact, it would be fair to say that the remote versions found in other timelines are actually the 
Master Timeline’s versions. When you grade a clip in the Master Timeline, those grades ripple out 
to every other instance of that clip, in every other timeline within that project, via remote versions.

Sharing of remote versions among the Master Timeline and newly conformed timelines is why you 
can grade a collection of clips that you import into Resolve without any editorial structure, grade 
and output offline media, and then reimport a project file that relinks to the original clips along with 
their grades. It’s also why you can grade clips in one timeline, and then import additional reedited 
timelines via AAF, XML, or EDL, which automatically inherit all remote versions of grades that were 
created in previous timelines.
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Differentiating Clips with Individual Versions

If you’ve enabled Resolve to add clips with remote versions, there are times when you may want 
to suspend automatic linking. As convenient as automatic grade rippling among linked remote 
versions is, there are many instances where you may need to stop it. For example, if the Media Pool 
contains a source media file with the entire content of an interview, then every clip that has been 
conformed to that source media will be linked, which is ordinarily good since you’d expect they’d all 
share the same grade. However, if the DP fiddled with the exposure of the camera in the middle of 
the interview, such that some clips are lighter and others are darker, you may find yourself needing 
to make different adjustments to clips from different parts of the interview.

One way of doing this, which can be useful in timelines where you only need to make a few of these 
kinds of changes, is to create a new remote version for every clip to which you need to make an 
individual adjustment. Since each version is its own grade, and differently named versions don’t link 
to one another, this is a simple solution.

To suspend linking by creating a new remote version:

1.	 Move the playhead to the clip you need to alter individually.

2.	 Do one of the following:

>> Choose Color > Add Version (Option-Shift-A).

>> Right-click the thumbnail in the Timeline, and choose Remote Versions > Create New Version.

>> Using the DaVinci control surface, press ADD VERSION on the T-bar panel.

3.	 Grade the new version that’s appeared.

	 While this method works well, keep in mind that multiple linked clips using the same version 
number will always be linked with one another. In other words, suppose Clip 5, Clip 7, and Clip 
9 are linked using the default Version 1, which has a strong blue grade applied.

Three clips automatically linked, sharing a blue grade

	 Then, you set Clip 7 to use Version 2 with a different grade, tinted sepia. Clip 7 is now unlinked 
from Clips 1 and 3.
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	 However, switching Clip 9 to also use the sepia-tinted Version 2 means that Clip 7 and Clip 9 
are now linked together, but Clip 5 is no longer linked.

	 Every new remote version you create, and every change you make, becomes available to all 
other clips in all other timelines that comes from the same source Media Pool clip as the shot 
you’re working on. However, any clip can use any version, and which version is used by a linked 
clip is not rippled. 

	 For example, Timeline 1 contains a clip named “Max CU,” which has three remote versions. 
Timeline 5 also contains “Max CU,” which is currently set to use “Version 2.” If you open 
Timeline 1 and add one more remote version to “Max CU,” that new version will also be 
available to “Max CU” in Timeline 5, but it will still be set to use “Version 2.”

Switching a Clip to Use Local Versions

You can also suspend remote version grade linking by switching individual clips to use local versions. 
This makes it easy to create a situation where some clips are linked, and other clips are not. Keep 
in mind that each clip has both local and remote versions, so you can switch from one to the other 
without losing anything.

To suspend linking by setting individual clips to use a local version:

>> Right-click a clip thumbnail, choose the submenu of the corresponding remote version you 
want to copy, and choose Copy to Local.

>> The remote version is copied to a local version, which now appears as the current version 
that’s used, with an (L) appearing at the end of the name.

Setting the second of the three clips to use another version with a different remote grade sets it apart

Setting the third of these clips to share the same remote version as the second clip now links those two together,  

omitting the first clip
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You can also set every clip in the entire Timeline to use local versions. If you switch an entire Timeline 
to local versions, then no clip in that Timeline will be linked to any other unless you create a group 
(covered later in this chapter). This is the default state, but it’s useful even when you’ve switched to 
using remote versions when you want to grade one Timeline differently from the others in a project, 
for example when doing a trim pass for another video or stereo 3D format, or when grading another 
cut, such as a trailer, that uses the same media but requires a different look.

To suspend linking by switching from remote versions to local versions:

>> Right-click any clip thumbnail, and choose one of the following commands:

>> Use Local Grades: Switches all clips to their local versions. If there are already local 
versions defined for each clip, those will appear. If there are no local versions yet 
defined, each clip will be ungraded.

>> Copy Remote Grades to Local: Copies the currently assigned remote version of each 
clip to a local version.

Because Undo is used only for individual clip operations, the Use Local Grades and Copy Remote 
Grades To Local commands cannot be undone. However, switching a Timeline from remote to local 
versions is not a one-way trip. You can select Use Remote Grades to switch every clip in a Timeline 
back to the remote versions at any time.

To switch a Timeline back to using remote versions:

>> Right-click any clip thumbnail, and choose Use Remote Grades.

If you’re switching back and forth between local and remote versions, keep the following rules in mind:

>> If you select Use Remote Grades, change your remote grades, and then Copy Remote 
Grades To Local on that Timeline again, you’ll overwrite all of your previously graded local 
versions. This is a good workflow if you don’t like what you’ve done with your local versions, 
and you want to start over by recopying the remote versions.

>> If you select Use Remote Grades, change your remote grades, and then select Use Local 
Grades, you’ll return to your previously graded local versions, as they were before you 
selected Use Remote Grades. This is a good workflow if you just want to switch back to 
your remote versions in order to copy the remote versions of specific clips to local versions.

Working with Versions

Each clip can have as many local and remote versions as you like. There are commands for creating, 
renaming, and deleting the versions that are available to each clip when using the pointer, keyboard 
shortcuts, or the DaVinci control surface. When using the DaVinci control surface, the buttons affect 
whichever type of version (remote or local) is currently applied to the current clip.
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To create a new local or remote version quickly, do one of the following:

>> Choose Color > Add Version (Option-Shift-A).

>> Using the DaVinci control surface, press ADD VERSION on the T-bar panel.

A new version is created, identical to the type of version that was previously selected 
(remote or local), named “Version x” where x is the number of the versions that have been 
created. All keyframes and motion tracking are copied from the previously selected version 
to the new one.

To create a new version, with a name, and a choice of whether to copy keyframes:

1.	 Right-click a clip thumbnail, and choose one of the following:

>> Local Versions > Create New Version

>> Remote Versions > Create New Version

2.	 Type a name for the version in the dialog that appears, and choose either “Copy all marks” or 
“Copy the first mark only,” depending on whether or not you want to copy all the keyframes 
into the new version. 

	 Note: Motion tracking will be copied regardless of whether “Copy all marks” is selected or not.

3.	 Optionally, you can choose one of the preset version names from the pop-up list. These names 
are defined in the Versions panel of the Project Settings.

4.	 Click OK.

To delete a specific version:

>> Right-click a clip thumbnail, choose the submenu of the remote version you want to delete 
(it can’t be the currently selected version), and choose Delete.

To delete all versions:

>> Right-click a clip thumbnail, and choose one of the following commands from the contextual 
menu corresponding to the scope of the versions you want to delete:

>> Local Versions > Delete All Versions

>> Remote Versions > Delete All Versions

>> Delete All Versions

All versions are deleted as specified, except for the currently selected version, which is now 
the only one remaining.

To load a particular remote or local version, do one of the following:

>> Right-click a clip thumbnail, choose the submenu of the corresponding remote version you 
want to copy, and choose Load.
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To rename a version:

1.	 Right-click a clip thumbnail, choose the submenu of the corresponding remote version you 
want to copy, and choose Rename.

2.	 In the Version Name dialog, type a name into the text field. Optionally, you can choose one of 
the preset version names from the pop-up list. These names are defined in the Versions panel 
of the Project Settings.

Selecting a Version name from the dropdown list, the names on the list come from assignments  

made using the Versions panel of the Project Settings

3.	 Click OK.

	 That name now appears underneath the clip thumbnail in the Timeline.

The Importance of “Version 1”

There are specific operations in Resolve where “Version 1,” otherwise known as “the default version,” 
is the only version that’s used, regardless of how many other versions are available, or which version 
was previously selected. The default version can be named anything you want, but whatever its 
name, the default version is the first version in the list, and it’s important. Here are some examples:

>> Importing additional timelines that use the same clips: In this case, if you’re importing 
timelines and ”Use local version for new clips in timeline” is disabled in the Color panel of 
the Project Settings, then only the default version of each clip is relinked. 

>>Whenever you switch a timeline between local and remote versions: In this case, every 
clip in the Timeline will be switched to the default version, regardless of what you had 
selected previously.

Consequently, if you plan to reconform your clips to a newer version of the edit that you’re importing, 
or pursue other workflows that are off the beaten path, it’s a good idea to make sure, no matter 
how many versions you end up creating, that the most important grade is always copied back to 
the default version.
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To copy any version quickly to the default version:

1.	 Choose Color > Memories > Save Memory A (Option-1). You can use any memory you want, 
but Memory A is convenient for this example.

2.	 Choose Color > Default Version (Option-Shift-D).

3.	 Choose Color > Memories > Load Memory A (Command-1) to apply the saved memory to the 
default version.

To copy any version quickly to the default version using the DaVinci control surface:

1.	 Press CRNT and then press A (or any memory button you like). These controls are available on 
either the Transport or T-bar panel.

2.	 Press DEFAULT VERSION on the T-bar panel.

3.	 Press A (or whichever Memory button you used) to apply the saved memory.

To jump immediately to the default version, do one of the following:

>> Choose Color > Default Version (Option-Shift-D).

>> Press DEFAULT VERSION on the T-bar panel.

Rendering Versions

When the time comes to render your clips in the Deliver page, each clip’s currently selected 
version will be rendered. If you need to render a different version for a given clip, you can either 
make sure it’s selected in the Color page Timeline before you open the Deliver page, or use the 
Versions submenu in the Deliver page Timeline. This contextual menu also provides access to the 
Stereo 3D commands, the Edit PAR (Pixel Aspect Ratio) command, and a command for updating 
the Render Window Timeline thumbnails to reflect any changes you’ve made in case the they 
haven’t updated automatically.

Additionally, the Commercial Workflow output option, located in the Deliver page, provides a 
method of rendering multiple versions for each clip when outputting your project in Source Order 
(as individual media files). There are two additional options in the Version submenus of each clip in 
the Thumbnail Timeline contextual menu that let you control which versions are rendered when you 
use Commercial Workflow.

>> Render Disabled: Turning this option on excludes that version from being rendered when 
Commercial Workflow is enabled.

>> Render Flat Pass: Turning this option on forces the selected version to render with the 
grade turned off, essentially outputting the original media.

For more information on rendering versions using the Commercial Workflow option, see Chapter 
14, “Deliver.”
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There are various methods you can use to copy grades from one clip to another. Which is appropriate 
to your need depends on your style of working with Resolve.

Protecting Adjustments with the Copy Grade Options

Before going into the myriad of ways that grades can be copied from one clip to another, you 
should know of a series of options, available from the contextual menu of the Gallery (right-click 
anywhere in the gray area of the Gallery), that let you carefully specify grading, sizing, and stereo 
data to be preserved when overwriting grades in clips you’re copying to. There are three options:

>> Copy Grade: Preserve number of nodes: Lets you choose 0–10 nodes to be protected 
when applying a grade. When set to 1, the first node of the copied grade is ignored, but all 
other nodes are copied. When set to 5, the first five nodes of a copied grade are ignored, 
as long as there are at least five nodes in the grade of the clip you’re copying to. This option 
is useful for colorists who routinely use the first few nodes for shot matching and scene 
balancing, with additional nodes applying individual or stylistic adjustments.

>> Copy Grade: Preserve Camera Raw Settings: When enabled, the stereo adjustments of the 
current clip are preserved when you copy a grade. This is useful for instances where you’re 
copying stylistic grades from unrelated clips, and you want to make sure you don’t lose the 
specific convergence adjustments that you’ve painstakingly applied to each clip. Note, this 
doesn’t include protection for the Window controls.

>> Copy Grade: Preserve Input Sizing: When enabled, Input Sizing adjustments are not 
overwritten by those of the copied grade.

>> Copy Grade: Preserve Convergence: When enabled, Convergence adjustments in the 
Stereo 3D palette are not overwritten by those of the copied grade.

>> Copy Grade: Preserve Floating Windows: When enabled, Floating Windows adjustments 
in the Stereo 3D palette are not overwritten by those of the copied grade.

>> Copy Grade: Preserve Auto Align: When enabled, Auto Alignment adjustments in the 
Stereo 3D palette are not overwritten by those of the copied grade.

Copying Grades
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Clip Grades and Timeline Grades in Saved Stills

Every time you save a still into the Gallery or a memory, it contains both the Clip Grade, and the 
Timeline Grade, if one is applied. Which grade is applied when you copy from a still depends on 
which mode you’re in, which is selectable from the pop-up menu in the upper right-hand corner of 
the Node Editor.

Node Editor Clip and Track selector

If you’re in Clip mode, you’ll only copy the saved clip grade. If you’re in Timeline mode, you’ll only 
copy the saved timeline grade.

Choosing Which Part of a Grade to Copy With All/Color/Sizing

When copying grades using the techniques described in this section, you can use the All/Color/
Sizing setting that are available via the Keyframe Timeline Mode submenu of the Mark menu, the 
pop-up menu that’s visible at the upper-right of the Keyframes Editor, or your control surface. When 
copying a grade in conjunction with the settings in this menu, the following rules apply:

>> All: When All is selected, both the grade and the sizing are copied.

>> Color: Only the grade is copied, the target clip retains its original Input Sizing settings.

>> Sizing: Only the Input Sizing is copied, the target clip retains its original grade.

Copying Grades Using the Mouse

The second-easiest way of copying a grade from one clip to another, or from a still or memory in the 
Gallery to a clip, is by using the third button of your mouse, usually mapped as the “middle-click” 
of the mouse scroll wheel. 

To copy a grade from a clip or still to another clip using the pointer:

1.	 Select the clip thumbnail you want to copy the grade to in the Timeline.

2.	 Middle-click the clip thumbnail, gallery still, or memory you want to copy the grade from.

	 The grade of the second clip is copied to the first.

Tip: If you’re using a trackpad, third party software may allow you to define a “three-finger-click” 
that works the same as mouse button 3. If you’re a pen and tablet user, you may be able to define a 
stylus button to perform the same button-3 action.
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Copy Forward Commands

Another simple way of copying grades is to use the equals (=) and minus (–) keys on the keyboard to 
copy grades forward from one or two clips behind the currently selected clip. This is a great way to 
copy grades in scenes with a shot-reverse-shot structure, where you’re cutting between two angles 
of coverage, each of which uses the same grade.

>> To copy a grade from one clip back: Press Equals (=)

>> To copy a grade from two clips back: Press minus (–)

Copying Using Memories

Memories are virtually identical to stills, except that they’re labeled with a letter (A–Z) for easy 
access via keyboard shortcuts or DaVinci control surface buttons. A memory bank above the Gallery 
browser provides a visual reference of which saved grade is assigned to which letter. This makes it 
easy to keep track of multiple saved memories in instances where you’re copying them to several 
different clips throughout a scene or program. 

For example, you might save a memory for each angle of coverage in a complicated scene, making 
it easy to copy grades forward. In another example, you might save a memory for the grade applied 
to each interview subject’s headshot in a documentary, so you can copy that grade forward as you 
work through the documentary.

To save the current clip’s grade to a memory for future use, do one of the following:

>> Choose Color > Memories > Save Memory A–H (Option-Shift-1–8)

>> Using the DaVinci control surface, press CRNT on the Transport or T-bar panel, then press 
the letter of the memory bank you want to save to. Use the SHIFT UP button to save to 
another memory sharing the same button.

If you save a grade to a memory that already contains something, the previous memory  
is overwritten.

To apply a memory to the current clip in a timeline, do one of the following:

>> Right-click a memory and choose Add Correction.

>> Choose Color > Memories > Load Memory A–H (Command-1–8)

>> Using the DaVinci control surface, press the letter of the memory bank you want to apply. 
Use the SHIFT UP button to apply a memory that shares the same button.

To clear a memory:

>> Right-click a memory, then choose Clear.
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Copying Using Preview Memory

You can also preview the effect of a memory or saved grade on the current clip, with the option to 
either keep it if it works, or go back to the previous grade if it doesn’t. 

To Preview Memory:

1.	 Move the playhead to a clip for which you want to preview a memory.

2.	 Choose Color > Preview Memory (Shift-Command-M).

3.	 Do one of the following: 

>> Right-click any saved still in the Gallery and choose Add Correction.

>> Choose Memories > Load > Memory A–H (Command-1–8).

	 The selected grade or memory is now being previewed.

4.	 Now, do one of the following to either accept or reject the memory:

>> If you like the effect, then you can leave it be and move on to another clip.

>> If you don’t like the effect, then choosing Color > Preview Memory again reverts the clip to 
the original grade.

To Preview Memory using the DaVinci control surface:

1.	 Move the playhead to a clip on which you want to preview a memory. You can use the PREV 
SCENE and NEXT SCENE buttons to move quickly.

2.	 Press PVW MEM on the T-bar panel, and then press the letter of the memory bank you want 
to preview. Use the SHIFT UP button to apply a memory that shares the same button.

3.	 Do one of the following:

>> If you like the grade you’re previewing, there’s no need to do anything else. Simply move to 
another clip and continue working.

>> If you don’t like the grade you’re previewing, press PVW MEM again and the clip’s grade will 
revert to its original state. Pressing PVW MEM repeatedly toggles the current clip between 
its original and the previewed grade.
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Copying from Stills in the Gallery

As mentioned previously, each still you store in the Gallery contains the grading information as 
well as the image of the frame it was saved from. This saved grade can be applied to any clip in 
the Timeline.

To apply a grade from a still to the current clip in a timeline, do one of the following:

>> Right-click a still in the Timeline and choose Add Correction.

>>Middle-click a still in the Timeline.

Append Node Graph

You can also append a saved grade to any clip in a timeline. This adds the entire node graph of the 
saved still to the end of the node tree of the current clip. In other words, the current clip’s grade isn’t 
overwritten, the applied grade is added to the end of it.

By planning ahead, you can save fragmentary grades that create specific effects or adjustments 
using only a few nodes. You can then use these fragmentary grades as a toolkit that you can add to 
other grades in order to mix and match different adjustments and effects. 

For example, you could create a three-node glow effect, save it, and then apply that effect at the 
end of a completely different clip’s grade.

Appending grades places them after the original nodes

To append a saved grade or memory, do one of the following:

>> Double-click a still in the Gallery.

>> Right-click a still in the Gallery or Memories, and choose Append Node Graph.
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Copying grades from clip to clip copies everything except for keyframes and motion tracking. 
However, there is one way you can copy the motion tracking from one clip to another, and that’s by 
copying and pasting individual node settings.

To copy a node’s settings from one clip to another:

1.	 Select a node in the Node Editor, and press Command-C to copy its settings.

2. Select another clip, and either select an existing node, or create a new node, and press 
Command-V to paste the previous node’s settings, including any motion tracking applied to 
windows used by that node.

Copying Individual Nodes and Settings



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

792

THE GALLERY AND GRADE MANAGEMENT13

There are a number of methods of copying grades that are exclusive to the DaVinci control surface.

Copy Forward Keys

The simplest way of copying grades using the DaVinci control surface is to use the comma and colon 
keys on the keypad of the Transport panel to copy grades from one or two clips behind the currently 
selected clip. This is a great way to copy grades in scenes with a shot-reverse-shot structure, where 
you’re cutting between two angles of coverage, each of which uses the same grade.

>> To copy a grade from one clip back: Press comma (,)

>> To copy a grade from two clips back: Press colon (:)

Scroll

Scroll mode lets you quickly preview the effects of many different grades applied to clips in the 
Timeline on the currently selected clip, with the option to either accept or reject the previewed 
grade to which you’ve “scrolled.” This can be useful for checking to see if any of the previous grades 
you’ve created in a scene will work for the currently selected clip.

To use Scroll mode:

1.	 Move the playhead to the clip to which you potentially want to copy a new grade. You can use 
the PREV SCENE and NEXT SCENE buttons to move quickly.

2.	 Do one of the following to enter Scroll mode:

>> Press SCROLL on the Transport panel.

>> Press MODES, above the fourth trackball on the Center panel, then press the SCROLL 
MODE soft key.

3.	 Now, do one of the following to preview different grades from other clips:

>> Press the PREVIOUS SCENE and NEXT SCENE soft keys to move from clip to clip in the 
Timeline, previewing each grade to the current clip.

>> Turn the SCROLL SCENES knob to scroll smoothly along multiple clips in the Timeline.

>> Turn the SCROLL FRAMES knob to scroll along different frames of any clip, previewing the 
effects of keyframed grades at different points in time.

>> Press the TOGGLE DECK KEYS soft key to use the transport controls on the Transport 
panel to play through the Timeline, previewing grades as you go.

>> Press a number on the keypad of the Transport panel, and then the SCENE NUMBER soft 
key, to jump to a clip and preview its grade.

Copying Grades Using the DaVinci Control Surface
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	 As you scroll from clip to clip, a red outline indicates the clip with the grade being previewed, and 
an orange outline indicates the current clip to which you’re previewing each scrolled grade. 

4.	 When you’re finished, do one of the following to either accept or reject a scrolled grade:

>> Press EXIT AS WAS if none of the grades you scrolled through was suitable. This exits Scroll 
mode and leaves the clip as it was previously.

>> Press EXIT AS IS if you’ve found a grade that works for the current clip. This exits Scroll 
mode and copies the scrolled grade.

When you press the TOGGLE DECK KEYS soft key in Scroll mode, each of the Transport Control 
buttons on the Transport panel functions as a means of previewing the grades of other clips in  
the Timeline.

>> STEP FWD: Move to the next clip and preview its grade.

>> STEP REV: Move to the previous clip and preview its grade.

>> FWD: Plays (scrolls) forward at 1 scene per second, previewing each new grade as it appears.

>> REV: Play (scrolls) the clips in reverse at 1 scene per second, previewing each new grade as 
it appears.

>> FFWD: Shuttles (scrolls) forward through the Timeline at 4 scenes per second, previewing 
each new grade as it appears.

>> RWD: Shuttles (scrolls) reverse through the Timeline at 4 scenes per second, previewing 
each new grade as it appears.
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DaVinci Resolve has a mechanism for rippling specific changes made to one clip to a range of other 
clips in the Timeline. This is only possible using the controls of the DaVinci control surface.

The general idea of the ripple function is that you select a clip, make a change, and then ripple that 
change to a range of other clips. This rippled change can be applied to the same node in each clip, 
or the change can be added as an appended node within each rippled clip.

The Ripple mode that’s used when you press the RIPPLE VALUE button can be changed in the 
Editing and Ripple panel of the Project Settings. There are four options.

>> Exact values changed: Changes made to the current clip are rippled to the specified clips 
using the exact parameters that were changed. For example, if Lift in the current clip is 
changed to 0.75 of its range, each clip you ripple will have a Master Gain setting of 0.75. 
Only parameters you adjust are rippled. 

>> Percent value changed: Changes made to the current clip are rippled to the specified clips 
by the percentage of change you made to the altered parameters. For example, if the 
current clip has a Lift level of 1.00 and is changed to 0.90 units, then the Lift setting of each 
clip you ripple will have a relative reduction of 10% relative to its previous value.

>> Unit value changed: Changes made to the current clip are rippled to the specified clips by 
the same delta of change, using whichever units make sense for the effected parameter. 
For example, if the current clip had a Lift of 0.80 and you increased it to 0.90, each rippled 
scene’s master gain level increases by 0.10.

>> All values are copied: The current clip’s grade is rippled to the specified clips in its entirety. 
No comparison is made with the original clip’s parameters, and all memory parameters  
are rippled.

The following procedure describes in detail how you can use the DaVinci control surface to ripple a 
change to a range of other clips. While this procedure may appear complicated, it’s just that there 
are several options. Once you learn the sequence of commands, this process is actually quite fast.

To ripple a change using the Ripple Mode soft key commands:

1.	 (Optional) Press MODES, then press RIPPLE MODES. Four commands appear mapped to the 
middle soft keys of the Center panel, which can be used later to execute different types of 
ripple operations.

2.	 Move the playhead to the clip you want to adjust.

3.	 Adjust the current clip that you want to ripple to other clips in the Timeline.

4.	 Define the range of clips you want to ripple to using the number pad on the Transport panel. 
The following combinations will work:

Rippling Changes Using the DaVinci Control Surface
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>> An absolute range of clips is defined by entering two clip numbers separated by a comma. 
For example, if you want to ripple the current change to clips 10 through 15, you’d press 
“10 , 15” 

>> To specify every clip from the beginning of the Timeline, use the Minus (–) key. For example, 
to specify a range of clips from the beginning to clip 20, you’d press “– , 20”

>> To specify every clip to the end of the timeline, use the Plus (+) key. For example, to specify 
a range of clips from the clip 50 to the end, you’d press “50 , +”

>> To specify every clip in the whole Timeline, press “– , +”

5.	 (Optional) You can control whether the rippled change is applied in an appended node, or an 
existing node, in every rippled clip:

>> If you want to apply the rippled change as a new node that’s appended to the end of every 
rippled clip’s grade, press SHIFT DOWN. 

>>Otherwise, the rippled change will be applied to the same node in every rippled clip that 
you made your adjustment to in the current clip. In other words, if you made a change to 
Node 2, it would be rippled to Node 2 of all the clips you specified. If one of the rippled 
clips doesn’t have the same number of nodes, you may get an error.

6.	 To execute the ripple, do one of the following:

>> Press RIPPLE VALUE on the Transport panel to ripple a change using the currently selected 
Ripple Mode in the Project Settings.

>> Press one of the Center panel soft keys corresponding to the ripple function you want to 
perform. There are four soft keys:

>> STATIC RIPPLE: Changes made to the current clip are rippled to the specified clips 
using the exact parameters that were changed. For example, if Lift in the current clip 
is changed to 0.75 of its range, each clip you ripple will have a Master Gain setting of 
0.75. Only parameters you adjust are rippled. Identical to the “Exact values changed” 
ripple setting.

>> RELATIVE RIPPLE: Changes made to the current clip are rippled to the specified clips 
by the percentage of change you made to the altered parameters. For example, if the 
current clip has a Lift level of 1.00 and is changed to 0.90 units, then the Lift setting of 
each clip you ripple will have a relative reduction of 10% relative to its previous value. 
Identical to the “Percent value changed” ripple setting.

>> ABSOLUTE RIPPLE: Changes made to the current clip are rippled to the specified 
clips by the same delta of change, using whichever units make sense for the affected 
parameter. For example, if the current clip had a Lift of 0.80 and you increased it to 
0.90, each rippled scene’s master gain level increases by 0.10. Identical to the “Unit 
value changed” ripple setting.
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>> FORCED RIPPLE: The current clip’s grade is rippled to the specified clips in its entirety, 
overwriting all previous nodes and parameters in the rippled clips.

The adjustment you made in step 4 is applied to the designated range of clips.

Admittedly, that was a long and detailed procedure, but the actual button sequences are 
straightforward once you put them together. Here are some examples of button sequences that 
ripple an adjustment you’ve just made in different ways:

>> “10 , 15” then SHIFT DOWN then RIPPLE VALUE: Copies the change you’ve made to 
the current clip, and applies it as a new node that’s appended to the end of clips ten 
through fifteen.

>>MODES then RIPPLE MODES then “34 , 45” then FORCED RIPPLE: Copies the entire grade 
of the current clip, using it to overwrite the grade of clips 34 through 45.

>>MODES then RIPPLE MODES then “– , +” then SHIFT DOWN then RELATIVE RIPPLE: 
Copies the change you’ve made to the current clip as a relative percentage, and applies it 
as a new node appended to the end of every single clip in the entire Timeline.

Warning: Once you ripple a change in this manner, there is no going back. Since Undo is a per-clip 
operation, there is no global undo for changes made to the entire Timeline. Proceed with caution.
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Using Groups

Grouping is one of DaVinci Resolve’s most powerful features for organizing grades amongst multiple 
clips. Groups are manually created collections of clips with automatic linking relationships that make 
it easy for you to control the rippling of grades among sets of clips that you define. When clips have 
been grouped together, selecting one member of the group reveals a group “linked” badge at the 
top-right of each clip’s thumbnail belonging to the group.

The link icon indicates this clip is in a group

As of Resolve 11, grading grouped clips is far easier than it has ever been. Once grouped, you can 
choose from one of four Node Editor modes to grade the current clip. Which mode you choose 
determines whether that grade will automatically ripple to every other member of that group, or 
whether the grade will only affect that one clip. In this way, you can combine multiple node trees, 
some which will ripple, and one which won’t, to create the final look of each clip in that group.

For example, you might group together every clip from the same angle of coverage in a scene. 
You might also group together every clip from a particular section of b-roll that will be graded 
with the same treatment. This way, whenever you make a change or otherwise update one 
member of the group using one of the rippled Node Editor modes, every clip in the group will be 
changed together.

This section discusses how to create and manage groups, how best to use them, and what issues 
you need to be aware of to use groups to best advantage.

Creating and Managing Groups

The following procedures describe how to create, load, modify, and delete groups.

To create a new group:

1.	 Select one or more clip thumbnails in the Timeline. You can select a contiguous range of clips 
by clicking one and then Shift-clicking another, or you can make a discontiguous selection by 
Command-clicking individual clip thumbnails anywhere in the Timeline.

2.	 Right-click one of the selected clip thumbnails, and choose Add Into New Group.
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3.	 Type a name into the field of the Group Name dialog, and click OK.

	 The new group is created, and the clips you had selected now appear with the “linked” group 
badge above the thumbnails.

To load a different group, do one of the following:

>>Move the playhead to another clip that’s a member of that group.

>> Right-click any clip belonging to any group, and choose Group > “Name of group” > Load.

The selected group now becomes the current group. Using the Add Into Current Group 
command will add a clip to the newly loaded group.

To add one or more clips to an existing group:

1.	 Load the group you want to add clips to.

2.	 Select one or more clip thumbnails in the Timeline. You can select a contiguous range of clips 
by clicking one and then Shift-clicking another, or you can make a discontiguous selection by 
Command-clicking individual clip thumbnails anywhere in the Timeline.

3.	 Right-click one of the selected clip thumbnails, and choose Group > “Name of group”  
> Assign to Group.

	 The selected clips now appear with the “linked” group badge above the thumbnails.

To remove one or more clips from an existing group:

1.	 Select one or more clip thumbnails in the Timeline that you want to remove from a group. 
You can select a contiguous range of clips by clicking one and then Shift-clicking another, 
or you can make a discontiguous selection by Command-clicking individual clip thumbnails 
anywhere in the Timeline.

2.	 Right-click one of the selected clip thumbnails, and choose Remove From Group.

To rename a group:

1.	 Right-click any clip belonging to any group, and choose Group > “Name of group” > Rename.

2.	 Type a new name into the field of the Group Name dialog, and click OK.

	 The group is renamed. The new name appears as a new submenu of the Timeline 
contextual menu.

To delete a group:

>> Right-click a clip belonging the group you want to delete, and choose Group > “Name of 
group” > Delete.

This clears the group, while preserving the last applied grade within each clip.
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Using Group Modes to Control Which Grades Ripple and Which Don’t

When you create a group and then select any clip that is a member of that group, additional Node 
Editor modes become available that let you apply multiple levels of grades to the clips in that group.

Available options in the Node Editor modes pop-up

Node trees you create using the Group Pre-Clip and Group Post-Clip modes automatically ripple 
changes to every member of a group. Node trees created with the Clip mode are specific to each 
clip. Node trees created with the Timeline grade affect the entire Timeline, all at once. Combining 
node trees made using these different modes makes it easy combine clip-specific changes with 
group-wide changes that make grading faster.

>>Group Pre-Clip: Node trees assembled in this mode affect every clip in the group 
simultaneously. Pre-Clip adjustments are useful for creating an overall grade that you want 
to use as a starting point for the scene, such as when you need to normalize a group of 
log-encoded clips in a specific way, or when you want to create a base grade that generally 
improves every clip in a scene. 

>> Clip: The Clip grade corresponds to the local or remote version associated with that clip. 
Node trees assembled in the Clip mode only affect the specific clip that’s selected. All 
Local and Remote versions you create are in Clip mode. Clip adjustments are useful for 
matching clips to one another in a scene, doing clip-specific secondary adjustments, or 
making any other sort of adjustment that you only want applied to the current clip, rather 
then to the group as a whole. Clip adjustments are applied after Pre-Clip adjustments.

>>Group Post-Clip: Node trees assembled in this mode also affect every clip in the group 
simultaneously, but these adjustments are applied after the Clip adjustments. Post-Clip 
adjustments can be useful for applying a creative look to an overall scene, so that later 
revisions to a scene’s look can be accomplished with a single set of adjustments that 
automatically affect the entire group.
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>> Timeline (formerly Track): Node trees assembled in this mode affect every single clip in the 
entire Timeline. Timeline adjustments are useful when you have a single change that you 
want to apply to every single clip at once.

The image processing of each Node Editor mode is sequential, making it easy to keep track of the 
order of operations affecting a particular clip. 

An Example of Grading a Group of Clips

This section shows an example of how you might approach grading a group of clips using the 
different Node Editor modes that are available. Keep in mind that this is only one of many possible 
approaches you could take to the use of groups, and was chosen because it exercises everything 
you can do to a single grade.

To get started, select a series of clips that you want to group, and right-click one of them and choose 
Create New Group to group them together, entering a name and clicking OK when prompted. 
One convenient advantage of simply creating groups from a selection is that you’re not limited to 
selecting a continuous range of clips in the Timeline. Another advantage is that you can use the 
View > Timeline Thumbnail Mode > Source (C-mode) command, or timeline filtering, to isolate the 
range of clips you want to use for creating a group.

There are different ways you might choose to group clips together:

>> All clips within a particular scene

>> All clips recorded from a specific camera

>> All headshots of a particular person

>> All clips from a particular angle of coverage

>> All exteriors of a particular location

The list could go on and on, but you get the idea. You can group any selection of clips together that 
have reason to share a common grade. In this example, all clips from a particular scene are selected, 
excluding an intercut exterior shot that requires a separate grade.

Once you’ve created a group, choose Group Pre-Clip from the Node Editor mode pop-up. This is 
the first grade that’s applied, as the underlying grade that affects the entire group. Using this node 
tree, adding a LUT to normalize the clips, a Color Wheel adjustment, and some Curve adjustments 
to tune the color provide a primary grade that now affects every single clip in the group.
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With this accomplished, you can see there’s some variation among the clips in the scene that needs 
to be corrected in order for every clip to match. Choose Clip from the Node Editor mode pop-
up. Grades that you make in Clip mode only affect the clip to which they’re applied, so now you 
can work clip by clip using the Image Wipe and Split-Screen controls to compare clips and make 
whatever adjustments are necessary to make each one match the main look for the scene.

A primary adjustment applied to the Group Pre-Clip mode

Scene balancing adjustments made using the Clip mode



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

802

THE GALLERY AND GRADE MANAGEMENT13

Once all the clips are balanced with one another, you can choose Post-Clip Group from the Node 
Editor mode pop-up. This lets you add one more grade on top of the Pre-Clip and Clip grades that 
you’ve already applied, that you can use for any number of things. In this example, a single stylistic 
adjustment is applied that now affects all of the clips at once. If a client wants to see something 
different, you can easily make the necessary changes to one clip, and all other clips in that group 
will immediately be altered as well.

At this point, the scene is graded via a well organized set of corrections. If the client later wants 
a change affecting the underlying primary grade that everything is built on, you can adjust the 
Pre-Clip grade. If you spot an inconsistency with your shot matching at any point, you can make a 
fast tweak to the relevant Clip grade. And if the client wants a stylistic change, you can make any 
necessary adjustments to the Post-Clip grade to change the overall look of the whole scene. In each 
case, groups give you total control over which adjustments will ripple across the whole group, and 
which adjustments will be clip-specific.

Using Undo in Groups

Each Node Editor mode has a separate undo stack, meaning that separate multiple-level undo is 
saved for Group Pre-Clip, Clip, and Group Post-Clip.

A stylistic adjustment applied to the Group Post-Clip mode
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Saving Stills and Grades in Groups

When you save a still for a clip that’s part of a group, the result is that the still reflects the look of 
the combined Pre-Clip, Clip, and Post-Clip node trees, but the grade that’s saved within depends 
on the Node Editor mode you had selected when saving the still. For example, if the Node Editor 
is set to Group Pre-Clip, then you’ll only save the Pre-Clip grade; the Clip, Group Post-Clip, and 
Track grades will be ignored. Copying a saved grade to a clip in a group results in that grade being 
copied to the node tree of whichever Node Editor mode is currently open.

Groups and Versions

Local or Remote versions you create relate only to the Clip grade. Group Pre-Clip and Group Post-
Clip grades cannot be versioned.
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Exporting Grades and LUTs

If you find it necessary to exchange grades with other workstations, there are two ways you can do 
so directly: by exporting grades, or LUTs.

To export a grade:

1.	 Save the grade you want to export as a still in the Gallery.

2.	 Right-click the saved still in the Gallery, and choose Export.

3 .	 Choose a location for the resulting still image and saved grade files, type a name into the Save 
As field, and click Save.

	 Two files are saved. A DPX formatted file contains the still image of the frame that was stored. 
A DRX (DaVinci Resolve eXchange) file contains all the grading information.

To Import a grade: 

1.	 Right-click anywhere in the gray area of the Gallery, and choose Import.

2.	 Choose the DPX file that was exported from your Resolve workstation, or someone else’s. The 
accompanying DRX file must be in the same location, although you can’t select it directly.

	 The still you imported appears in the Gallery, containing the grading information you wanted 
to import.

To export a LUT:

1.	 Right-click a clip thumbnail in the Timeline of the Color page, and choose Generate 3D LUT.

2.	 Choose a location for the resulting LUT file in the file dialog, although that location must be a 
folder inside the appropriate file path for your operating system. 

>>On OS X: Library/Application Support/Blackmagic Design/DaVinci Resolve/LUT/

>>On Windows: C:\ProgramData\Blackmagic Design\DaVinci Resolve\Support\LUT

>>On Linux: /home/resolve/LUT

	 If you like, you can create a new folder in which to save your custom LUTs.

3 .	 Type a name into the Save As field, and click Save.

	 A LUT file is saved, in the .cube format, which is a DaVinci-developed LUT format (no relation 
to the Iridas SpeedGrade .cube format).

Once created, you can use an exported LUT from within Resolve, applying it to a clip or node 
directly, or applying it to the entire project using the settings found in the Look Up Tables panel of 
the Project Settings. You can also copy the LUT to a memory stick to give to someone for monitoring 
or previewing in an onset workflow, or to someone using another grading application that can read 
this LUT format.
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What’s the Difference Between a LUT and a Shaper LUT?

DaVinci Resolve is capable of importing and using LUTs within its 32-bit floating point image 
processing pipeline. The .cube format can be used as either a simple 33x33x33 3D LUT, or as a 
shaper LUT, which is actually a method of using two LUTs, a 1D LUT and a 3D LUT together, that 
addresses signal processing issues that 3D LUT can’t handle.

For processor efficiency, 3D LUTs are designed with reasonable lower and upper limits for the data 
they will handle. It’s well known that when a 3D LUT is fed values that are outside of the range that 
LUT is designed to handle, the out-of-range data will be clipped. Since many LUTs are designed with 
digital cinema workflows in mind, the practical result is that feeding a video signal with super-white 
in it to a 3D LUT that’s designed for full-range data (0–1) will clip the super-white part of the signal.

Shaper LUTs handle this issue by first using a 1D LUT to process video signals with out-of-range 
data, fitting the signal into a range that the 3D LUT won’t clamp. The output of the 3D LUT includes 
the reverse transformation, to effectively zero out the 1D LUTs transform, while retaining whatever 
processing the 3D LUT was meant to apply.

Shaper LUTs are also useful for dealing with extremely large data sets, such as OpenEXR files that can 
theoretically handle an image data range of –infinity to +infinity. Using a Shaper LUT, you can remap the 
incoming data to fit more precision in the 0–1 range, leaving less important data outside the range.
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Once you’ve finished grading your project, you need to either render it, or output it to tape to 
deliver it to your client. This is where the Deliver page comes in. This chapter describes the overall 
interface of this page, as well as providing some general information about how effects are output 
from DaVinci Resolve in different situations.

Deliver page

Rendering Files vs. Outputting to Tape

Because the Deliver page does double duty, you control whether you’re rendering files or outputting 
to tape using the toggle buttons to the left of the Transport controls, underneath the Viewer.

Render or Edit to Tape modes

The Deliver page is divided into five areas of functionality, each of which lets you set up a different 
part of a render or output to tape.

The Deliver Page Interface
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The Render Settings list contains the customizable settings that affect how media is rendered out 
of Resolve. These settings are covered in more detail later in “File-based Output.” If you’re using 
the Edit To Tape option, these settings are all disabled. 

Render settings
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The Deliver Page Timeline 

The Deliver page’s Thumbnail and Mini-Timeline match the Color page

The Deliver page Timeline also has the Timeline Filter pop-up at the right-hand side of the toolbar. 
Using this pop-up to filter the contents of the Timeline lets you restrict the range of media you want 
to output in different ways. For example, if you’ve already rendered a timeline, but you’ve since 
made some changes, you can use the “Show Modified Clips” option to display only the clips that 
have changed within a particular timeframe. Another possibility is to choose the “Show Unrendered 
Clips” option to show all clips that have not yet been rendered.

The Viewer

When rendering file-based media, the Viewer shows you exactly how the media being output will 
look using the current settings, and the Transport controls move the playhead throughout the 
current Timeline. 

Deliver Viewer

When outputting to tape, the Viewer shows you the tape output so you can set up insert or assembly 
edit points, and the Transport controls move the tape in the deck if device control is enabled.
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The Render Queue

The Render Queue is a list of all the jobs you’ve queued up for file-based rendering. Each job can 
have an individualized range of clips and render settings, which you can use to render multiple 
sections or clips of a timeline, the same timeline output to multiple formats, or multiple timelines.

The Render Queue displays all jobs

The Render Queue also has the option to show either just the jobs within the current project, or jobs 
queued up and saved within all projects in the currently open SQL database (for the current user) or 
disk database (at the currently selected disk location). This can be exceptionally useful in situations 
where you’ve broken a program into multiple reels, with each reel being a different project. This 
can be turned on and off via the “Show All Projects” option of the Render Queue Option menu.
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When you’re outputting to tape, how effects are rendered depends on whether you’re rendering 
individual source clips or as a single clip. 

When Rendering a Single Clip or When Outputting to Tape

Whether you’re rendering a QuickTime or DNxHD master of your project as a single clip, rendering 
a DPX image sequence for film output, or outputting directly to tape, all supported compositing, 
speed, and transform effects are rendered by Resolve and “baked” into the output media. 
Unsupported effects are completely ignored, cannot be seen, and have no effect on media that’s 
rendered and output.

When Rendering Individual Source Clips for Round-Trip Workflows

In workflows where you’re rendering individual media files to send a project back to an NLE or 
finishing application for final finishing (adding titles and other effects before final delivery), Resolve 
handles different types of effects in different ways.

Unsupported effects do not appear in Resolve. However, this effects data is internally preserved, 
and when you export an XML or AAF file to send back to your NLE of choice, these effects reappear, 
applied to the color corrected media that you rendered out of DaVinci Resolve and sent back.

Effects that DaVinci Resolve does support such as composite modes, opacity settings, speed 
effects, and transitions are handled differently. Even though these effects are visible in Resolve 
while you work, they’re not “baked” into the final media that you render in preparation for sending 
back to your NLE or finishing application. Instead, the portion of each media clip that’s used in your 
project is rendered as an individual file, and the XML file that you export from Resolve contains all of 
the effects information necessary to reassemble the rendered media into a timeline that uses Final 
Cut Pro effects applied to Resolve-graded media.

Effects Processing
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*These effects are only sent back in AAF round trips when you’re updating an existing AAF file, 
rather then generating a new AAF file.

After you’ve reimported your project back into your NLE or finishing application, you’re free to 
readjust these effects while completing your program, without the need to re-render individual 
clips in Resolve.

Important: One exception to the preservation of media and effects in round-trip workflows is that 
nested sequences from Final Cut Pro 7 and Media Composer are not compatible with Resolve; XML 
and AAF files containing nested sequences cannot be imported. On the other hand, Final Cut Pro 
X projects containing compound clips can be imported.

More About Rendering Speed Effects

If you’re rendering a project with speed effects, you should be aware that Resolve can optionally 
render speed effects using Optical Flow processing, resulting in high-quality slow motion and fast 
motion effects delivered straight out of Resolve. If you’re satisfied with Optical Flow processing 
in Resolve, there may be no need for you to do a round-trip export if the main reason you were 
doing so was to send the processing of slow motion clips to another application for rendering, and 
rendering the Timeline in Single clip mode will “bake” the speed effects in using whatever settings 
you’ve selected for the project, or for each clip if you’ve selected individual Retime Process settings 
for different clips.

EDL FCP 7 FCP X Premiere 
Pro

Media 
Composer*

Color Corrections N/A N/A Rendered N/A N/A

Composite Modes N/A Sent Back Sent Back Sent Back Rendered

Alpha Channels N/A N/A N/A N/A N/A

Transitions Sent Back Sent Back Sent Back Sent Back Sent Back

Opacity Settings N/A Sent Back Sent Back Sent Back Sent Back

Position, Scale, Rotation N/A Sent Back Sent Back Sent Back Sent Back

Linear Speed Effects Sent Back Sent Back Sent Back Sent Back Sent Back

Variable Speed Effects N/A Sent Back Sent Back Sent Back Sent Back

Long Duration Still Images N/A N/A N/A N/A N/A

Freeze Frames N/A N/A N/A N/A Rendered

The chart shows which effects are rendered by DaVinci Resolve, and which effects are passed back in different round trip workflows.
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However, if you want to send unrendered speed effects to another application, rendering your 
project in Individual source clips mode guarantees that the full range of each original clip of 
media will be rendered, with the speed effect itself exported within the XML, AAF, or EDL file 
that’s exported.

Note: Resolve adds three frame handles to clips with speed changes applied to them, and to 
rendered clips that don’t match the project’s frame rate. This is done to facilitate reconform in NLEs 
that require handles beyond the actual length of each of these clips.

Determining the Rendered Output Resolution of Clips in Mixed 
Timelines

Ordinarily, rendering individual source clips results in each clip being rendered at either the project 
resolution or the Resolution pop-up in the Render Settings (which overrides the project resolution), 
with clips that don’t match the project resolution being resized or not according to the settings 
you’ve chosen in the Image Scaling panel of the Project Settings. 

However, if you’re rendering dailies for projects containing clips with mixed resolutions, you can 
choose to render each clip at its original resolution by turning on the “Render at source resolution” 
checkbox in the V

Rendering Edit and Input Sizing Adjustments

Whether or not sizing is rendered into your final media depends on the ”Disable edit and input 
sizing” checkbox in the Output options of the Deliver page. 

>> If this checkbox is turned off: Input Sizing and Edit page transform Pan/Tilt/Zoom/Rotate 
adjustments are “baked” into the final rendered media using the optical-quality sizing 
algorithms available to Resolve. This is best if your sizing adjustments are approved and 
final, and you want to “bake” sizing adjustments into the final media your delivering. 

>> If this checkbox is turned on: Input Sizing and Edit page Pan/Tilt/Zoom/Rotate adjustments 
are not rendered, and each clip will be rendered at its original resolution. However, the 
Input and Edit sizing adjustments you’ve made will be exported as part of the XML or AAF 
file that you’re exporting. This is best for workflows where the editor wants to continue 
adjusting sizing after you’ve handed off the graded project relative to the original size of 
the clips.

Keep in mind that if you want to render Input Sizing adjustments into the media you’re outputting, 
the “Force sizing to highest quality” checkbox guarantees that Resolve will use the highest-quality 
sizing setting, even if you’ve temporarily chosen a faster-processing option for a slower computer.
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Rendering Mixed Frame Rate Timelines

Mixed frame rates are supported by DaVinci Resolve when any option other then none is selected in 
the “Mixed Frame Rate format” pop-up menu, either in the Conform Options of the Master Project 
Settings panel, or in the Import AAF or XML dialog. When you choose the appropriate option that 
corresponds to the application you’re exchanging projects with (or Resolve if you’re working entirely 
within DaVinci Resolve), then Resolve conforms and processes all clips in the Timeline to play at 
whichever frame rate is selected in the “Timeline frame rate” pop-up menu. For example, 23.98, 
29.97, 30, 50, 59.94 and 60 fps clips will all play at 24 fps if that’s what “Timeline frame rate” is set to 
in the Master Project Settings.

How clips in mixed framerate timelines are rendered out depends on whether the Render Settings 
are set to render Individual source clips or a Single clip.

>> Individual source clips: All clips are rendered individually at their original frame rate.

>> Single clip: All clips are converted to the “Timecode calculated at” frame rate and rendered 
as a single media file. Clips are converted using whatever method is selected in the Retime 
process pop-up of the Editing panel in the Project Settings, or in the individual Retime 
process setting found in the Video inspector of each clip that overrides the project-wide 
setting. You can choose Optical Flow processing for the highest quality conversion that’s 
available in Resolve.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

816

THE DELIVER PAGE INTERFACE14

This section describes the options that are available for file-based delivery. The workflow is simple; 
you define the format and other settings that dictate how the media is to be rendered, define a 
range of clips in the currently selected session, and then add a job containing these settings to the 
Render Queue. 

You can queue up as many different render jobs as you like, each with different formats, output 
options, and ranges of clips, depending on what you’re trying to accomplish. When you’re ready to 
render, simply click the Start Render button.

Choosing Which Set of Output Controls to Use

The Render Settings you can choose from for outputting from Resolve appear in three different 
sets of controls, labeled Basic, Intermediate and Advanced. You can choose the set of controls that 
meets your needs, based on the following description.

>> Basic contains only the most essential controls needed for defining whether to render 
a single clip or multiple clips, the render format, audio settings, and the file name and 
destination for the media you’re delivering, along with Presets controls for using and saving 
Easy Setups for commonly performed delivery tasks. This setting is appropriate for most 
situations where your output is fairly straightforward.

>> Intermediate adds additional parameters for adjusting more specific aspects of your 
render, such as data rate limiting for H.264 and AAC encoding, manual video/data level 
adjustment, data burn-in presets, and options for controlling how sizing, debayer quality, 
and flat pass are output. Intermediate also lets you create additional output passes, to 
output the same job with different format, codec, and data burn-in settings. 

>> Advanced provides all of the outputting options of DaVinci Resolve, including file name 
prefix and suffix editing, subfolder organization, render speed controls for limiting LAN 
bandwidth usage, commercial workflow options for rendering multiple versions and 
organizing media in different ways, and stereoscopic rendering control.

Using Easy Setups for Fast Rendering

The Intermediate and Advanced sets of controls provide an Easy Setup pop-up menu. This pop-up 
lets you quickly choose a preset that automatically populates all the settings appropriate to 
rendering media for your particular workflow. DaVinci Resolve ships with four options.

Easy Render setup selection

Rendering Your Final Output
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None

Nothing is automatically selected, all options are available. You must manually choose the settings 
and options you need. All Render settings are saved on a per-project basis.

Final Cut Pro XML Round-Trip

Selects the appropriate settings for projects that were sent from Final Cut Pro 7 or Final Cut Pro X to 
Resolve using XML. This is meant for situations when you’re rendering media intended for a return 
trip to Final Cut Pro (by exporting an XML file from the Edit page). “Render clips in” is set to Source, 
The “Render to” setting on Mac OS X defaults to Apple ProRes 422 (HQ), Output Size defaults to 
the current Timeline Resolution (as set in the Master Project Settings of the Project Settings), and 
Render Clip with Unique Filename is turned on.

Export to Final Cut Pro

Selects the appropriate settings for projects where media is being initially ingested into DaVinci 
Resolve, graded, and output for offline editing in Final Cut Pro. The Render Properties settings are 
similar to Final Cut Pro XML Round-Trip, except that Render Clip with Unique Filename is turned off, 
so that the File Name, Reel Name, and timecode of the rendered media are identical to the originally 
ingested clips in Resolve. This makes it easy to reconform the finished Final Cut Pro offline edit to the 
original clips in your Resolve project, using either XML or EDL workflows (to reconform to the original 
media via XML, you’ll need to turn “Automatically import source clips into media pool” off).

Avid AAF Round-Trip

Selects the appropriate settings for projects that were sent from Avid Media Composer or Symphony 
to Resolve using AAF. This is meant for situations when you’re rendering media intended for a return 
trip to Media Composer or Symphony (by exporting an AAF file from the Edit page). “Rendering 
clips in” is set to Source, the “Render to” setting defaults to DNxHD 1080p 220/185/175 10 bit, 
Output Size defaults to the current Timeline Resolution (as set in the Master Project Settings of the 
Project Settings), and Render Clip with Unique Filename is turned on.

Video Sharing Export

Selects the appropriate settings for exporting your program as a QuickTime H.264-encoded file 
suitable for uploading to Vimeo, YouTube, and many other video file sharing services. Sets “Render 
timeline as” to single clip, and sets the Video Format to QuickTime, the Codec to H.264, sets the 
video data rate to 10,000 Kb/s, on Mac OS X the Audio Codec to AAC, and the audio data rate to 
320 Kb/s. The Resolution and Frame rate settings automatically match those of your project, but you 
can change the Resolution setting to something smaller (such as 1280 x 720) if you want to export a 
smaller size.
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To create a new Easy Setup:

1.	 From the Intermediate or Advanced tab, choose None from the Easy Setup pop-up menu, to 
unlock every setting in the Render Settings pane.

2.	 Choose the particular settings you require for your new preset.

3.	 Type a name into the “Save user setup as” field, and click Save.

	 The new preset now appears in the Easy Setup pop-up menu.

To load an Easy Setup:

>> Choose an option from the Easy Setup pop-up menu. Every setting in the Render Settings 
pane updates to reflect the preset you selected.

To delete an Easy setup:

>> From the Intermediate or Advanced tab, choose the option from the Easy Setup pop-up 
menu that you want to delete, and click Delete. That setup disappears from the menu.

The Two Basic Rendering Workflows

While there are numerous options available in the Render Settings List of the Deliver page, there 
are basically two ways you can render your project, depending on which of the “Render timeline as” 
radio buttons you click in the Output group.

Render individual source clips or a single clip

To Individual Source clips

Selecting the individual source clips option sets up a render where each clip is rendered as an 
individual media file in whichever format you choose. The result will be a collection of as many 
media files as there are clips in the range you’ve selected to render. 

>> Timecode: The timecode written to each clip is cloned from the original source media, 
making it easy to reconform media for projects being passed between Resolve and NLEs. 

>> Frame Rate: If you’re rendering a project that uses mixed frame rates, rendering to source 
renders each clip at its own individual frame rate, to accommodate round-trip workflows.
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To a Single clip

When you select the Single clip option in the Output parameters, you’re setting up a render wherein 
all clips in the session are output together, as a single media file in whatever format you choose. This 
means you’ll be rendering the selected range of the session to a single MXF or QuickTime file, or as 
a single collection of image sequences.

>> Timecode: The timecode that’s written out is dictated by the “Start timeline timecode at” 
setting. Media files contain a continuous timecode track, while image sequences have 
timecode written into each frame’s data header, and integrated into the file name (as a 
frame count). 

>> Frame Rate: If you’re rendering a project that uses mixed frame rates, rendering to a single 
clip converts every clip in the entire session to the project frame rate.

All Available Render Settings for Output

This section covers the different render settings that are available for customizing your output. 
Depending on which Render Setting mode you chose, some of these may be hidden, but this 
section covers the full list found in the Advanced panel of controls. 

If you choose one of the Easy Setups, then some of these settings will be locked, and others will be 
editable, depending on the requirements of that setup. If none of the Easy Setups is suitable for 
the task at hand, you can leave the Easy Setup pop-up menu set to none, and manually choose the 
necessary settings for the task at hand.

Video

The settings in the Format section relate to the file format or codec used, including the output 
resolution, frame rate, data level, and audio settings.

>> Render timeline as: Lets you choose which rendering mode to use. For more information 
about this setting, see the corresponding section earlier in this chapter. There are 
two options:

>> Individual source clips: Renders each clip as an individual media file.

>> Single clip: Renders every clip within the specified range of the current session as a 
single media file.

>> Video Format: A pop-up menu that gives access to the container formats that are currently 
available on your system. The available options depend on whether you have Final Cut Pro 
and QuickTime installed, and on the operating system you’re using. This list is constantly 
growing, as new file formats are added over time, so be sure to check each new version for 
the latest supported formats.
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>> DPX: An uncompressed image sequence format favored by the film industry for 
mastering and delivery for DCDM mastering.

>> Cineon: An older uncompressed image sequence format developed by Kodak, 
designed for film scanning and digital mastering.

>> Tiff: “Tagged Image File Format,” an image sequence format compatible with many 
desktop video applications on many platforms, and is also used when delivering for 
DCDM mastering.

>> EXR: The OpenEXR format is a high-dynamic-range image sequence format 
developed by ILM for applications requiring high quality and multiple channels. Used 
for outputting ACES media.

>> JPEG 2000: A high-quality compressed image sequence format used for DCP encoding. 

>>QuickTime: Apple’s file-based media format, used when delivering ProRes.

>>MXF: The Material eXchange Format is a file-based media format, used when 
delivering DNxHD.

>> easyDCP: An option that allows you to master a DCP or IMF directly from Resolve in 
conjunction when you have an installed license of Frauenhofer’s EasyDCP software. 
More information about DCP mastering can be found at the end of this chapter.

>> AVI: A deprecated file-based media format that remains popular with Windows 
applications.

>>MXF OP1A: A version of the Material eXchange Format that conforms to the SMPTE 
378M standard.

>> Codec: A pop-up menu that lets you choose the codec, bit depth, and color space, based 
on what’s available to the container format you’ve selected above.

>> H.264: If you choose QuickTime as the Video Format, and H.264 as the codec, 
additional options appear underneath Compression Quality, below.

>> Compression quality: If the currently selected option in the Render to pop-up menu has 
options for changing the compression quality, this pop-up menu lets you choose the 
quality you want to use. Otherwise, it’s disabled.

>> Data Rate: (Available for QuickTime H.264 encoding) You can choose automatic, or select a 
maximum data rate with which to export H.264 clips.

>> Key Frames: (Available for QuickTime H.264 encoding) You can choose automatic, or select 
a duration for manual keyframe insertion.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

821

THE DELIVER PAGE INTERFACE14

>> Frame Reordering: (Available for QuickTime H.264 encoding) On by default, Frame 
Reordering enables the encoding of B frames to improve the quality of the resulting 
compressed movie file. Turning off Frame Reordering will speed encoding performance at 
the expense of visual quality.

>> Field rendering: If you’re processing interlaced source material, this checkbox sets Resolve 
to render each field individually before reintegrating them back into a single frame, in order 
to process clips most accurately with filtering operations that would otherwise violate field 
boundaries and cause problems. If you’re not rendering interlaced media, you should leave 
this checkbox turned off, as it is more processing intensive.

>> Render at Source Resolution: When Render Timeline As is set to “Individual source clips,” 
this checkbox lets you render each clip at the same resolution as its source media file, 
letting you preserve mixed frame sizes for final delivery.

>> Resolution: The output resolution for rendering. This setting defaults to the current 
resolution of the project as set in the Master Project Settings panel of the Project Settings, 
modified by whatever transforms are applied in the Sizing palette in Output mode. However 
you can change the resolution here if you need to output at a different resolution. Using 
this setting, you can queue up different render jobs at different resolutions, in order to 
output both HD and SD resolution media in the same render session, for example. Some 
file formats require specific resolutions, in which case the Output Size settings will be 
automatically set to the necessary resolution.

>> Frame rate: Typically identical to the “Timecode calculated at” frame rate in the Master 
Project Settings panel of the Project Settings. However, you may wish to set this to a 
variation of the current conformed rate. This will adjust the metadata written within the file 
and is used to aid playback for the range of systems available worldwide. Use the pull-down 
to select from the available options.

>> Video/Data level: Defaults to “Auto,” which simply renders all clips with the data level 
appropriate to the currently selected codec in the “Render to” pop-up menu, which is 
usually the preferred behavior. Choosing one of the other options (“Normally scaled legal 
video” or “Unscaled full range data”) outputs all clips using the selected data range. For 
more information on this setting, and on data range handling in general, see Chapter 4, 
“Before You Conform.”

>> Data burn in preset: A pop-up menu that defaults to “Same as Project,” which leaves the 
current Data Burn In palette settings enabled while rendering, inserting a window burn 
into the media being output. Choosing “None” disables window burns while rendering. 
Note that when rendering as Individual Source Clips, individual clip burn in presets can be 
assigned if they’ve been created in the Data Burn In palette.
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Audio

Settings in this section relate to audio output.

>> Export audio: Turn this checkbox on to render the source audio, or audio that you’ve 
synchronized in Resolve, along with the media being output by Resolve.

>> Audio codec: Lets you choose between Linear PCM (the default) and AAC audio. AAC 
audio encoding is only available on Mac OS X.

>>Quality: (Available for AAC encoding) Five settings you trade between speed and quality 
when encoding AAC audio.

>> Data Rate: (Available for AAC encoding) Lets you choose the maximum data rate for 
AAC encoding.

>> Render X channels of audio: This control’s functionality depends on the “Render timeline as” 
setting. When “Render timeline as” is set to “Individual source clips,” you can choose which of 
the audio tracks available in the source media will be output. There is also a “Same as source” 
option that automatically outputs however many audio channels are in the source media to 
the rendered media being created by Resolve, which lets you easily generate dailies with 
the correct audio from camera original media with varying numbers of audio tracks. When 
“Render timeline as” is set to “Single clip,” then the Render pop-up lets you choose which 
of the currently mapped Audio Mixer Output channels will be output along with the video.

>> Audio bit depth to: Lets you specify the bit depth at which to output the source audio.

Note: While clip audio is rendered out, audio chase tracks that you’ve synced are not 
output, either when rendering media or outputting to tape.

File

The settings in this section relate to how media named and where it is written.

>> Save as: Three options let you automatically name the media file(s) that are output automatically.

>> Use Timeline Name: When this option is selected, the name of the Timeline is used.

>> Use Source Filename: When this option is selected, the filename of each clip’s 
corresponding source media file is cloned, and used as the filename of media being 
output by Resolve. This is preferred when you’re generating offline media for use by 
an editor that you later want to reconform to the originating Resolve project. When 
this checkbox is turned off, you can customize filenames using the other options in this 
section of settings.

>> Custom name/File prefix: Lets you add custom text to the beginning of the name of all 
rendered files. If you’re not using the source filename, and not rendering to a file format that 
uses timecode, you can enter a filename here.

>> File suffix: Lets you add custom text to the end of all rendered files.
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>>When entering text to use for the Prefix or Suffix, you can also use variables to automatically 
add to the filename based on clip metadata (you can also use these variables in the “Render 
job to” file path field).

	 %L		  Reel Name extracted by Resolve from source filename or clip name

	 %R		  Resolution of the rendered file

	 %T		  Tape number extracted from imported EDL

	 %E		  Event number from imported EDL

	 %V		  Version Name of the rendered file

	 %I		  Resolve-generated index number of the clip in the timeline

	 %		  For stereo 3D projects, the eye (“left” or “right”)

	 %{scene}	 Scene metadata

	 %{take}		  Take metadata

	 %{shot}		 Shot metadata

	 %S		  Stereo session, “Left” or “Right”

	 %{eye}		  Same as %S

>> Use filename digits: Lets you specify how many digits to use when rendering an image 
sequence, although the specified digits will also be used for any media format. This is 
particularly useful if you’re outputting media to be used by an application that has strict 
requirements for image sequence numbering. Defaults to 8 digits.

>> Start timeline timecode at: This option is only available when rendering clips in Single clip 
order. Specifies the timecode that will be written to the media being output by Resolve. 
For DPX files, timecode is written into the header data, and is simultaneously converted 
to a frame count that’s inserted into the filename of each frame file, which provides 
a logical count of the frame numbers. For other media formats, timecode is written to 
the appropriate metadata container. You may find it useful to use custom start times, for 
example starting each reel of a project at a particular value, depending on the standards 
employed at your shop.

>> Each clips starts at frame: This option is only available when rendering clips in Single clip 
order. This permits timecode to the header, and frame count to be written to the filename 
of image sequences, which is ideal for VFX workflows.

>> File Subfolder: Lets you specify a subdirectory into which to render the media files being 
output. If the specified subdirectory doesn’t exist, a new one with that name will be created 
within the currently specified “Render job to” directory.

>> Render unique filenames: When enabled, additional characters are added to every rendered 
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media file to guarantee that each rendered media file has a completely independent name. 
This prevents multiple rendered clips from the same source media file from overwriting 
one another when saved to the same directory. “Uniquely” named clips append the clip 
name with the track and clip number identifying a clip’s position in the currently selected 
session. For example, a clip that’s linked to a media file named “DropThatThingCU.mov,” 
and edited as the twenty-fifth clip on track V2, will be named “DropThatThingCU_V2-0025.
mov” when rendered.

>> Add Prefix/Add Suffix: Radio buttons let you choose whether to add the unique 
identifier at the beginning or end of a clip. Choosing Prefix would result in “V2-0025 _
DropThatThingCU.mov,” whereas choosing Suffix would result in “DropThatThingCU_
V2-0025.mov” when rendered.

>> Render to: Click the Browse button to choose a directory in which to write the media being 
output by Resolve. After you’ve selected a directory, the path name appears in the “Render 
job to” field.

>> To add a directory within the File Browser dialog, Right-click a volume or directory and 
choose New Folder. Type a name into the dialog that appears, and click OK. A new 
directory with that name is created in the File System.

>> Render at: A pop-up menu lets you throttle the speed at which media is rendered. 
Ordinarily you’ll leave this set to the default of Maximum. However, some storage systems 
that are shared by multiple rooms in a facility use storage area networks (SANs) with 
insufficient bandwidth for multiple real-time image streams. DaVinci Resolve’s incredibly 
fast rendering speeds can cause playback problems with other users accessing the SAN if 
available bandwidth is insufficient. In this case, you can throttle the render speed to limit 
SAN bandwidth usage to between 1 to 50 percent of full rendering speed.

>> Disk space used: Shows the amount of disk space available on the target volume.

>> Disk space used after render: Shows the new disk usage based on the specified range of 
the current session that you’re rendering.

Options
>> Add frame handles: Lets you specify front and rear handles to be output in frames. This is 
particularly useful in round trips, when the finishing editor might want additional handles 
with which to roll edit points or add transitions, while fine-tuning the graded edit.

>> Disable input sizing: When turned off, Input Sizing Pan, Tilt, Zoom, and Rotate adjustments 
are “baked” into the output. When turned on, all Input Sizing adjustments are disabled, 
but output to XML or AAF files that are round-tripped back to an NLE.

>> Force sizing to highest quality: If you’ve been working with the “When resizing and scaling:” 
option set to Bilinear to improve performance when working on slower workstations, turning 
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this checkbox on automatically renders all clips using the “Uses Sharper filter” setting of 
the Image Scaling panel in the Project Settings. For more information, see Chapter 2, 
“Project Settings.”

>> Force debayer res to highest quality: When rendering camera raw media formats that allow 
variable quality debayering, it’s common to lower the debayering quality to improve real 
time performance while grading. Turning this checkbox on guarantees that media will 
always be rendered at the highest available quality, saving you from forgetting to manually 
change the debayer setting back when setting up a render at 3am.

>> User render cached images: When this checkbox is turned on, Resolve will write media 
from the cache to the files being output to save time. If you’re caching using the same 
media format you’re outputting to, this can be convenient. However, if you’re caching in a 
lower-quality format then the one you’re outputting to, you’ll want to turn this checkbox off 
to force Resolve to process all media as it’s being rendered, writing at the maximum quality 
you’re outputting to.

>> Enable flat pass: Three options let you choose whether or not to render each clip with its 
grade applied.

>>Off: Resolve always applies each clip’s grade when rendering.

>>With clip settings: For each version of a clip, the system will check that version’s pass 
flat flag. If it’s turned on, the system disables color correction for that version of the 
clip. Otherwise, that version will be rendered with its grade intact. Versions can be 
individually flagged by right-clicking a clip’s thumbnail in the Timeline, choosing the 
submenu of the version you want to flag, and choosing Enable Flat Pass.

>> Always On: When checked, Resolve disables the grade of every clip being rendered.

>> Place clips in separate folders: Useful if you need to preserve the filenames of files you’re 
outputting when the filenames of clips coming from the same source media file may cause 
them to overwrite one another. This option is also commonly used when rendering VFX 
shots for additional postproduction work, allowing the VFX department to identify clips 
quickly and distribute the work accordingly.

>> Preserve X Source directory levels: Retains a user-specified depth of the original 
directory structure used by a clip’s corresponding source media file, recreating it 
when rendering new files for output. The number you select determines how many 
levels of subdirectories Resolve will automatically create within the currently specified 
“Render job to” directory to match the path used by the source files. Defaults to 0, 
which creates no matching subdirectories.

>> From Head/From Tail: When setting how many directory levels of each clip’s file path 
to preserve (using the “Preserve x levels” parameter), click one of these buttons to 
specify whether that number of path levels is defined relative to the head or the tail of 
each media file path.
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>> Use commercial workflow: Automatically renders every version that’s applied to each 
clip in the session, except for versions that have been flagged using the “Render 
Disabled” flag, found in the Version submenu for each clip in the Timeline. This option 
is typically used when you’ve graded multiple versions of a clip to be used for VFX work, 
and you want to deliver each grade as a separate media file. This is also used when 
rendering programs for commercial broadcast where you have two or more versions 
of a grade for each scene. When using this option, alternate methods of outputting 
each rendered media file are used, and four additional settings are enabled.

>> Alternative pass offset: Lets you separate the timecode values written into each version 
of a clip with an offset. For example, if the default version timecode is 01:00:20:00, and 
you select a 10 minute offset in the Alternative Pass Offset timecode entry, then the 
second graded version of that clip will start at 01:10:20:00, the third version will start 
at 01:20:20:00, and so on until every version is rendered. You can offset the clips by 
whatever value you like, but the idea is to make it easy for editors and VFX artists 
to find the versions of each grade. If the clips are shared with a finishing artist, and 
they know that each alternate pass is 10 minutes apart, then it’s easy for the finisher 
to change the clip version just by adding 10 minutes to the referenced timecode. To 
simplify the workflow further, you can put separate source reels in separate folders 
using the next three options.

>> Place reels in separate folders: Automatically places all media that’s output using a 
particular reel name into corresponding folders.

>> Place clips in separate folders: Automatically places alternate grades of clips into 
separate folders.

>> Use version name for folders: Labels each folder with the name of the version when 
using the Commercial Workflow option.

>> Render Stereoscopic 3D: Three options let you choose how to render stereoscopic 
timelines, rendering just one eye’s worth of media at a time, or rendering a single set of 
stereo media in one of four ways, depending on the option you choose from the “Both 
eyes as” pop-up menu.

>> Left eye: Lets you render only the left-eye media from a stereo timeline.

>> Right eye: Lets you render only the right-eye media from a stereo timeline.

>> Both eyes as: Lets you select from four ways of rendering the left and right eyes of 
stereo media as a single set of media files. “Separate files” lets you output both the 
left-eye and right-eye media as individual media files, all at once. Side-by-side and 
Line-by-Line let you output Frame Compatible media that can be output to a stereo-
capable television. Anaglyph lets you output a traditional anaglyph red/cyan stereo 
image for viewing on any display using red/cyan glasses.
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Additional Outputs
>> Create Additional Output: This button lets you specify additional sets of media to be 
rendered, with individual “Render to” format settings, into individually named subfolders 
(optional), and using individual “Data burn in preset” options. This is useful for setting 
up multiple rendered passes when your client requires two sets of media, for example 
QuickTime ProRes 422 (HQ) media along with MXF DNxHD media. This is also useful when 
you need to output two sets of media where one has window burns, and the other is clean. 
When you click the Create Additional Output button, a new group of settings appears in 
the Render Settings list, named “Output x,” where x is the total number of outputs you’ve 
added. If you want to eliminate an output, click the Delete button at the bottom of that 
output group.

Preventing Clip Overlap When Rendering Output Media

Three of the options listed above, “Render each clip with a unique filename,” “Render each clip 
to a separate directory,” and “Use commercial workflow,” are all ways of organizing your rendered 
media to avoid clip overlap. These options are necessary because each clip has one logical range 
of timecode, and because multiple clips often refer to a single source media file with one name.

When rendering a clip, DaVinci Resolve automatically overwrites any other media files that have the 
same name. So, in instances where you’re trying to preserve the previous filename of the source 
media file, or where you’re rendering out multiple versions of the same clip, it’s entirely likely that the 
clips you’re trying to output will overwrite one another, leaving you with the last clip you rendered. 
The three options mentioned previously prevent this in different ways.

Defining a Range of Clips and Versions to Render

Once you’ve defined the Render Settings, now you need to decide how much of the Timeline you 
need to render. A Mini-Timeline and Thumbnail Timeline are available to help you navigate your 
project’s clips in order to choose which ones you want to render. Track controls let you enable and 
disable whole tracks from being output; for example if you need to render a textless version of a 
timeline in which all the title clips are on track V4, you can disable track V4. Furthermore, you can 
also use these controls to choose which clip versions you want to render.

To render the entire Timeline, do one of the following:

>> Click the Select All button.

>> Right-click any clip in the Mini-Timeline (above the Thumbnail Timeline), and choose 
Select All.

To disable a video or audio track to exclude those clips from being rendered:

>> Click the video or speaker icon to the right of that track’s name in the Timeline header.
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To render a filtered subset of clips in the Timeline:

1.	 Choose an option from the Timeline Filter button to the right of the screen underneath  
the Timeline. 

	 The contents of the thumbnail Timeline are restricted to show only the clips matching the 
selected criteria. For example, if you’ve already rendered a session, but you’ve since made 
some changes, you can use one of the “Show Modified Clips” options to display only the clips 
that have changed within a particular timeframe. Another possibility is to choose the “Show 
Unrendered Clips” option to show all clips that have not yet been rendered.

2.	 Do one of the following:

>> Click the Select All button.

>> Right-click any clip in the Mini-Timeline (above the Thumbnail Timeline), and choose 
Select All.

To define a continuous range of clips to render:

1.	 To define the first clip in the range you want to render, do one of the following:

>> Right-click a clip thumbnail, and choose Mark In.

>> Click the first clip, and click the Mark In button at the bottom right-hand side of the Viewer.

2.	 To define the last clip in the range you want to render, do one of the following:

>> Right-click a clip thumbnail, and choose Mark out from the contextual menu.

>> Select the last clip, and click the Mark Out button at the bottom right-hand side of the Viewer.

	 In and Out points appear within the Timeline ruler, and an orange bar shows the range you’ve 
selected to render. The In and Out fields update with the first and last frame numbers, in 
timecode and frame count, and the Duration field updates with the total number of frames 
you’ll be rendering.

To render a single clip:

>> Right-click any clip thumbnail, and choose Render This Clip.

An orange bar in the Timeline ruler shows that clip is selected for rendering. If you need 
to render several clips individually, you can select each clip one-by-one, and add it as an 
individual job to the Render Queue.

To select an arbitrary range of clips to render:

1.	 Move the playhead to the first of the range of frames you want to render, and set an In point 
by doing one of the following: 

>> Right-click the Timeline ruler and choose Mark In. 

>> Click the Mark In button at the bottom of the Render Timeline. 
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2.	 Move the playhead to the last of the range of frames you want to render, and set an Out point 
by doing one of the following: 

>> Right-click the Timeline ruler and choose Mark Out.

>> Click the Mark Out button at the bottom of the Render Timeline. 

	 In all cases, In and Out points appear within the Timeline ruler, along with an orange bar, to 
show the range of your program that you’ve selected to render. The In and Out timecode 
fields update with the first and last frame numbers, and the Duration field updates with the 
total number of frames you’ll be rendering.

Choosing Which Versions to Render For Each Clip

By default, the currently selected version is rendered for each clip. If you want to render a different 
version, the easiest thing to do is to make sure they’re selected on the Color page Timeline before 
you open the Deliver page.

However, a Versions submenu, within the Render Timeline’s contextual menu, also provides options 
to manage grade versions, as well as access to the Stereo submenu for managing stereo grades, the 
Edit PAR (Pixel Aspect Ratio) command, and a command for updating the thumbnails in the Render 
Window timeline to reflect any changes you’ve made. Most of these commands are duplicates of 
options that are available from the Thumbnail Timeline of the Color page.

To choose which Version to Render:

>> Right-click any clip thumbnail in the Timeline, and choose a version from the 
Versions submenu.

Tip: You can right-click a clip in the Thumbnail Timeline of the Color or Render screen and rename 
any version of a grade. Again, this is to assist a facility’s workflow when sharing material between 
suites and applications.

Using the Render Queue

Once you’ve defined the settings necessary to render the type of media you require, and the range 
of the current session you want to render, you need to add all that information as a job to the Render 
Queue. You can add as many jobs to the Render Queue as you need, depending on the files you 
need to output.

Each job can have individually specified ranges of clips and individual clip settings, which can include 
different render directories, different formats, resolutions, data levels, burn-in settings, etcetera. As 
a result, you can use the Render Queue to queue up the render of multiple sections of the current 
session, or multiple versions of the same media. Furthermore, you can queue up multiple sessions, 
if you have several differently graded sessions.
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To add a job to the Render Queue:

1.	 Select a session.

2.	 Choose a range of clips to render using the Deliver page Timeline.

3.	 Choose the settings you require in the Render Settings list, either individually, or by using one 
of the Easy Setups.

4.	 Click the Add Job button at the bottom right of the Render Settings list.

5.	 If there’s already media in the “Render job to:” directory, you may get a dialog telling you 
“This render may overwrite existing clips in this folder.” If you want to continue, click Yes, 
otherwise click No.

	 That render setup is now added as a job to the Render Queue.

To remove jobs from the Render Queue, do one of the following:

>> To clear a specific job: Click the X at the upper right-hand corner of a job’s entry in the 
Render Queue.

>> To clear all rendered jobs: Click the Render Queue Option menu (at the upper right-hand 
corner) and choose Clear Rendered.

>> To clear all jobs: Click the Render Queue Option menu (at the upper right-hand corner) and 
choose Clear All.

To start rendering:

1.	 Click the Start Render button, underneath the Viewer to the right of the interface.

2.	 If there are jobs in the Render Queue that have already been rendered, a dialog will appear 
asking “Selected items contain already rendered items. Do you want to re-render them?” 
Clicking Yes will re- render all jobs in the Render Queue. Clicking No only renders the jobs that 
have not yet been rendered. Clicking Cancel cancels the entire rendering operation.

	 Rendering begins, starting with the highest job in the list. The Overall Progress bar starts to fill 
up, from right to left, indicating how much of what’s been queued up has been rendered so far.

	 The Start Render button changes to the Stop Render button, which can be clicked at any time 
to stop rendering.

To edit a job that has or has not been rendered:

1.	 Click a job in the Render Queue to select it.

	 The selected Render Queue’s settings repopulate the Render Settings list, and resets the 
selected range of the Timeline.
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2.	 Change whichever settings you need to.

3.	 Click Add Job to add the alterations as a new Job in the Render Queue. If necessary, remove 
the original job from the Render Queue.

Rendering Jobs from Multiple Projects at Once

You can also render queue items from multiple projects in the currently open SQL or Disk database, 
all at once. This can be exceptionally useful in situations where you’ve broken a program into 
multiple reels, with each reel being a different project.

To render output from multiple projects at once:

1.	 Open each project, set up whatever jobs you want to render in the Render Queue, and save 
that project without rendering.

2.	 When you’ve set up the last project, click the Render Queue Option menu (at the upper right-
hand corner) and choose Show All Projects.

	 All queued items in projects belonging to the currently selected user (if using an SQL 
database) or in the currently specified disk location (if using a disk database) now appear in 
the Render Queue.

3.	 Click Start Render to begin rendering every item from every project in the queue.

4.	 When you’re finished, turn Show All Projects off to go back to displaying only the current 
project’s render queue items.
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For projects requiring Digital Cinema Package (DCP) or Interoperable Master Format (IMF) mastering 
for digital cinema or broadcast distribution, DaVinci Resolve can be integrated with Fraunhofer’s 
easyDCP application in order to master these files, play them back for testing, and generate Key 
Delivery Messages (KDMs) for theatrical distribution, all directly within Resolve. This means you can 
encode a DCP master straight from your program’s source media, all within the 32-bit floating point 
image processing pipeline of Resolve, for the highest possible quality result.

Licensing EasyDCP

DaVinci Resolve and DaVinci Resolve Lite includes a demo version of easyDCP. Details of operation 
and restrictions of the demo version can be found later in this chapter. The fully functional version of 
easyDCP operates via licensing modules purchased from http://www.easyDCP.com (info@easyDCP.
com) and every new DaVinci Resolve system (server) needs its own license and specific certificates 
for DCP and KDM generation and for playback of DCPs.

Requesting your Server Certificate Set

For your DaVinci Resolve system to generate DCPs and KDMs you need to request a specific set 
of configuration files called the Server Certificate Set. To begin, first purchase your encoding, 
encryption, decoding and decryption modules from easyDCP. They will provide a password to 
access your easyDCP.com account.

Then, from the Resolve file menu, select easyDCP, Request Server Certificate Set. Fill in the detail 
listed on the request form and save the form to your desktop or somewhere it can be easily found. 
This html file can be emailed to info@easyDCP.com. After sending the html, a customized Server 
Certificate Set for your installation will be generated and made available for download in your 
easyDCP Website User Account.

The Server Certificate Set generated for your DaVinci Resolve will contain files based on your 
purchased modules and your specific Resolve server hardware. The table below shows the modules 
and the licenses and certificates generated, followed by a brief description of each item.

License Server Certificate Signer Certificate

DCP Encoder X X

DCP Encoder with Encryption X X X

DCP Player X

DCP Player with Encryption X X

EasyDCP Output
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>> License: The License is used to activate the purchased modules on a specific hardware server.

>> Server Certificate: Each DCP render (referred in the industry as an ‘Instance’) using 
encryption or decryption has an individual server certificate. This certificate is required to 
be able to receive Key Delivery Messages (KDMs), which unlock encrypted DCPs.

>> Signer Certificate: A Signer Certificate is used to sign certain files within a DCP package 
and/or Key Delivery Message (KDM) to verify which authority generated the DCP instance.

Importing your Server Certificate Set

Once generated and downloaded to your DaVinci Resolve server, the Server Certificate Set needs 
to be imported into Resolve.

To import your server certificate:

1. 	 Choose File > easyDCP > Import Server Certificate Set.

2. 	 Use the Import Server Certificate dialog to select the file, enter your Certificate Set password, 
then click Import.

3. 	 To verify your easyDCP license and the Server Certificates, choose easyDCP > About easyDCP.

From this point onward, you can use the controls from within the Settings window, the Deliver page, 
and the File menu to master and play DCPs.

DaVinci Resolve includes a demo version of easyDCP

DaVinci Resolve and DaVinci Resolve Lite includes a demo version of easyDCP. The demo version of 
the DCP encoder embeds visible DaVinci Resolve and easyDCP logo watermarks in the rendered 
Digital Cinema Package (DCP) images. The demo version does not include encryption so these 
DCPs can be used for screening in a digital equipped cinema. The demo version of the DCP 
playback module will play 15 seconds in full quality. After that playback quality reduces drastically. 
Furthermore, audio won’t be rendered after 15 seconds of playback.
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EasyDCP Color Management

The Look Up Tables panel of the Project Settings has an easyDCP Color Management section with 
a Timeline Colorspace pop-up menu. You should set this to the color space used in your current 
Resolve timeline. If, for example, you are grading using a Rec. 709 monitor for TV deliverables but 
also wish to make a DCP, select Rec. 709 and Resolve will render the DCP with the correct Rec. 709 
to XYZ matrix. 

EasyDCP Output in the Deliver Page

To master to a DCP in the Deliver page, use the following procedure, which walks you through all of 
the easyDCP settings that are available in the Render Settings list.

To master a DCP or IMF:

1. 	 Set “Render timeline as” to Single clip.

2. 	 Choose easyDCP from the Render to pop-up.

3. 	 Choose the appropriate option from the Codec pop-up that corresponds to the type (DCP or 
IMF) resolution (2K or 4K), and aspect ratio (native, scope, or flat) of your intended output.

4. 	 Set the Composition Name. This field is intended to hold a standardized name for the DCP 
being encoded. You can either type a name into this field directly, or you can press the “...” 
button to open the easyDCP Composition Name Generator window. An editable Film Title 
field appears, along with a number of pop-up menus that let you select various DCP attributes 
such as content type, aspect ratio, language of audio and subtitles, and so forth. As you 
populate each attribute, the name being generated appears at the top of the window, and 
clicking OK copies the resulting Composition Name into the Composition Name field of the 
Render Settings.

5. 	 Turn on the “Encrypt” checkbox to encode an encrypted DCP. This sets the encoder to 
generate a Digest containing the keys used during encryption. This Digest will allow you to 
play the resulting DCP on your system, and to generate KDMs to allow that DCP to be played 
on other servers.

	 Note: If you do not encrypt the DCP it can be played on any DCP player/decoder without 
restriction.

6. 	 There are two DCP package types you can output, determined by the “Use Interop 
packaging” checkbox:

>> The standard package conforms to the “Interop” specifications for DCPs, which is turned 
on by default. With “Use Interop packaging” turned on, however, the frame rate of your 
output is limited to either 24fps or 48fps, so you need to make sure that your timeline 
conforms to these frame rates.
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>> If you want to generate DCP packages with other frame rates to match your timeline, you 
need to turn “Use Interop packaging” off to generate a SMPTE-standard DCP. This supports 
additional frame rates including 25, 30, 50 and 60 fps. However, SMPTE-Standard-DCPs are 
not supported on all JPEG2000-based playback systems so it’s generally recommended to 
use the Interop standard unless you know the player supports the SMPTE-Standard DCPs.

7. 	 Turn on the “Encrypt” checkbox to encode an encrypted DCP. This sets the encoder to 
generate a Digest containing the keys used during encryption. This Digest will allow you to 
play the resulting DCP on your system, and to generate KDMs to allow that DCP to be played 
on other servers.

	 Note: If you do not encrypt the DCP it can be played on any DCP player/decoder without 
restriction.

8. 	 Set the Subtitles Path. If you have a properly formatted subtitle file, click the Browse button to 
link to it.

9. 	 If you’re including an audio mix in the DCP, go to the Audio section, turn on the Render 
audio checkbox, and choose the number of channels in the “Render channels of audio” pop-
up menu that corresponds to the number of Audio Mixer output channels defined in the 
Edit page.

10. 	Choose all necessary options from the Output Options to ensure the quality you need.

11. 	Click the Add Job to Render Queue button, and then click Start Render to create your DCP.

A DCP will be created and placed at the location you chose, ready for playback or delivery.

KDM Generation and Management

Key Delivery Messages (KDMs) are required to allow an encrypted DCP play on a designated 
projector at a particular theater at a specified time. DaVinci Resolve is capable of creating KDMs, 
which is convenient for exporting KDMs for select screenings, but commercial distributors may 
require thousands of KDMs. Fortunately, easyDCP allows you to use external Distribution KDM 
(DKDM) utilities to generate KDMs for your clients, so you don’t have to tie up your Resolve 
workstation with this task. 

Publishing your encrypted Digital Cinema Package

While you can play your encrypted DCP on the same DaVinci Resolve system that generated it, if 
you wish to publish the DCP so other players can decode and play you need to generate a KDM to 
send to the player. The user of the other player, or players, will need to generate a Server Certificate 
for each of their players and send this to you so when you generate the KDM it will be just for 
those players.
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Select the DCP in the Media page Library. Right-click and select Generate KDMs. From the pop-up 
select the location of the Server Certificate file if the KDM is for one player, or folder for multiple 
players. Set the start and end dates that the KDM will be valid for, an output folder to place the 
KDM, and then select Generate.

You can now send your DCP and the KDMs to the player you authorized. The user there will import 
the KDM and the DCP will play between the start and end dates.

Playing your Digital Cinema Package

To play a DCP you’ve output from Resolve, use the Media page to add it to the Media Pool and edit 
it into a timeline like any other clip.

Decoding the JPEG2000 images embedded within the DCP in real time is computationally intensive. 
If your system is underpowered you can reduce the decoded resolution of the files by selecting Half 
or Quarter Resolution Decode from the File > easyDCP menu. A smaller, less bandwidth-intensive 
version of the JPEG2000 files will be decoded by discarding some levels of the wavelet stage inside 
the decoder, which will directly increase the playback performance. 

Playing third party Digital Cinema Packages

To play a non-encrypted DCP simply select the DCP in the Media page like any other clip. To play 
an encrypted DCP from a third party you first must publish your Server Certificate. They use the 
certificate to generate KDMs for their DCP to play on your DaVinci Resolve system. From the File 
menu select easyDCP, then select Export Server Certificate, and on the pop-up menu choose a 
location to save the file. Send this to the third party for KDM generation.

When you receive a KDM or a Digest for an encrypted DCP you must first import the file into your 
DaVinci Resolve system. Using the File, easyDCP menu select Import KDM/Digest, and then select 
the file. Then simply select the encrypted DCP in the Media Page Library to play.
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Tape Output

This section covers how to use the Deliver page to output a timeline, either in whole or in part, 
to a device-controllable VTR connected to a compatible Blackmagic Design video interface. For 
whichever output interface you use, you need to make sure that the RS-422 interface is connected 
to that of the VTR, and that device control has been established.

To switch to tape output in the Deliver page:

>> Click the Edit to Tape button, located to the left of the transport controls underneath the 
Deliver page Viewer.

The Deliver page updates to reflect the relevant controls for editing to tape.

The Tape Output Interface

While in Edit to Tape mode, the Deliver page is used to control the VTR, in order to establish In and 
Out points for insert or assemble editing of the selected portion of the current timeline to tape.

>> Edit to Tape Queue: The Render Queue turns into the Edit to Tape Queue, which lets 
you set up a batch of either previously rendered media files, or In and Out point-defined 
segments of the current Timeline for simultaneous output to tape.

>> Transport Controls: The transport controls, while similar in appearance to those used while 
in Render mode, now control the VTR. While in Edit to Tape mode, the transport controls 
of the DaVinci control surface also control the deck, rather then your program.

>> Shuttle Control: A Shuttle Control appears in what was formerly the Scrubber Bar, which lets 
you shuttle through the range of reverse and forward speeds compatible with that deck.

>> In and Out Controls: In Edit to Tape mode, the In and Out buttons to the right of the 
transport controls define a range of the tape to Insert or Assemble edit to, within the 
current Timeline. While in Edit to Tape mode, you can still define In and Out points to 
define a specific range of the Timeline by right-clicking a clip in the Thumbnail or Mini-
Timeline, and choosing Mark In or Mark Out. You can only add In or Out points to the 
beginning and end of clips. 

>> Cue In and Cue Out controls: Buttons next to the timecode In and Out fields cue the tape 
to those frames on tape.

Edit to Tape controls
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Insert/Assemble Pop-Up Menu

A pop-up menu under the In and Out buttons lets you choose how to edit the selected part of the 
Timeline to tape. There are two options:

>> Insert: Performs an insert edit to tape, in which selected tape tracks are seamlessly and 
frame-accurately overwritten without interrupting the timecode or control track. You must 
be outputting to either a blacked tape, or a prerecorded tape to make an insert edit.

>> Assemble: Performs an assemble edit, in which every track of tape is overwritten, including 
the video, audio, timecode, and control tracks. 

>> Crash: Similar to an assemble edit, except there is no pre-roll period to let the VTR get up 
to speed. A crash edit also overwrites every track of the tape, including the video, audio, 
timecode, and control tracks, and may result in a more visible jump at the resulting edit point. 
However, in some instances crash edits may be the only option for a particular operation.

Note: When DaVinci Resolve is performing a Batch Output operation, you can only output clips 
using assemble editing or crash recording.

Start Record Button

Once you’ve set In and Out points to define how much of the tape to record to, the Start Record 
button initiates device-controlled tape output.

Setting Up for Tape Output

Before you perform an edit to tape, the Deck Capture and Playback panel of the Project Settings has 
a number of options that you should set to match the format and type of tape output you’re doing.

Capture and Playout Settings

These settings affect both capture and playback when using the Tape Ingest options of the Media 
page, or the Tape Output options of the Deliver page.

>> Video capture and playback: You can choose the video format (frame size and frame rate) 
with which to output to tape from this pop-up menu. HD timelines can be downconverted 
to SD, and SD timelines can be upconverted to HD using the format conversion of your 
DeckLink card.

>> Video connection: Selects between the available signal options: YUV 422 SDI, RGB 444 
Dual Link, and 444 single link using 3 Gb/s. Which options are available depend on which 
video capture card you are using. All three are available when using the Blackmagic Design 
DeckLink HD Extreme 3+ card.
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>> Colorspace: Lets you specify the data range (normally scaled or full range) that’s used when 
ingesting from or outputting to tape. This option switches the data range of the signal 
output by your video capture card, but only during capture from tape in the Media page, 
or output to tape in the Deliver page. When capture or output is not currently occurring, 
your video capture card goes back to using the identically named data range setting in the 
Master Project Settings pane, which governs how you monitor the signal being output on 
an external broadcast display or projector.

>> Video bit depth: You have the option of switching between 8- and 10-bit output. Ordinarily 
this should be left at the default setting of 10-bit.

>> Use deck autoedit: If supported by your video deck, this is the best method to record video 
to the deck, as it enables the deck to roll the edit using the specified preroll, and control 
the edits via serial device control. If this checkbox is turned off, a basic edit On/Off mode 
is used by the deck, with the potential for frame inaccuracies if the “Non auto edit timing” 
setting is not properly adjusted.

>>Non auto edit timing: Adjusts the edit synchronization of the connected deck when auto 
edit is turned off.

>> Deck preroll: Set the number of seconds for preroll. How much is appropriate depends on 
the performance of your deck.

>> Video output sync source: When using a DeckLink card this is set to Auto. Other capture 
cards may require you to set the sync source to “Reference” for playout and “Input” for 
ingest. This setting is only available if you have the DVS card installed on your system.

>> Add 3:2 pulldown: Inserts or removes the 3:2 pulldown required to record or play 23.98 fps 
media to or from a 29.97 tape format.

Playout Settings

These settings only affect the video signal that’s output when you use the Edit to Tape mode of the 
Deliver page.

>>Output Source Timecode: Turn this checkbox on to output each individual clip’s source 
timecode, resulting in discontinuous timecode being written to tape. This is useful when 
backing up a project’s media via videotape.

>>Output LTC: With a DeckLink HD Extreme 3 or 3D+, longitudinal timecode (LTC) is available 
on track 16 of the HD-SDI video signal, making it easy to use a Mini Converter de-embedder 
to extract this analog timecode audio signal and feed it directly to a recording device. This 
is particularly helpful if you have outboard video processing equipment such as a noise 
reducer or format converter that does not pass through the VITC timecode.
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>>Delay LTC by x frames: When outputting LTC timecode to bypass outboard processing gear, 
such as a noise reducer or format converter, you can compensate for the processing delay by 
delaying the timecode by a matter of frames to ensure that the processed image and timecode 
reach the deck at the same time. With a DVS card there is a separate timecode output.

>> Enable audio output: When this checkbox is enabled, DaVinci Resolve will play whatever 
audio is currently edited into the Timeline, along with the video being output, so both can 
be recorded to tape. You’ll need to set the channel mappings that determine which audio 
tracks are output to which channels using each track’s channel pop-up menu in the Audio 
Mixer, and then you need to choose the appropriate settings for Offset and Channels. Use 
the “Offset (frames)” setting to sync the audio and video, if necessary. For the best results, 
set the “Output (channels of audio)” to match the Output setting of the Audio Mixer.

>>Offset audio by x frames: Lets you specify an offset between the audio track and video 
to achieve proper A/V sync in cases where the video is being delayed by outboard 
processing hardware.

>>Output x channels of audio: Choose the number of audio channels as defined in the 
Audio Mixer to output to tape. For the best results, this setting should match however 
many audio channels are selected in the Output pop-up menu of the Audio Mixer. For 
more information on the Audio Mixer, see Chapter 7, “Working With Audio.”

>> Set batch playout head handle to x seconds: When batch outputting multiple clips, you can 
specify a number of frames before the In point of each clip to be output as well.

>> Set batch playout tail handle to x seconds: When batch outputting multiple clips, you can 
specify a number of frames after the Out point of each clip to be output as well.

>> Apply gaps between clips: Adds a black gap, of the specified duration in frames, between 
every two clips being output when outputting in batch mode.

Edit to Tape Queue Option Menu Settings

The following settings and options are available in the Option Menu found at the top right-hand 
corner of the Edit to Tape Queue.

>> Clear Recorded: Clears all queue items that have already been output to tape.

>> Clear All: Clears every queue item.

>> Sort by Reel & Timecode: Does a multi-criteria sort by reel and timecode, reel first, 
then timecode.

>> Sort by Timecode: Sorts by timecode only.

>>Output Source Timecode: Sets tape output to write source timecode to tape (each clip’s 
individual timecode), rather then record timecode (from the Timeline).

>> Use Preview for Tape Output: Enables Preview mode when outputting to tape. Preview 
mode lets you test how an edit to tape operation will work before actually recording it.
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Tape Output Procedures

There are a few different ways you can output media to tape, depending on what you need  
to accomplish, and on how intensive your grades are relative to the processing capabilities of 
your workstation.

Power Mastering

Power Mastering allows you to select either a range of clips, or an entire timeline, to be output to 
tape in real time, without rendering. This can save you from a time-consuming render, and it also 
saves disk space. Power Mastering is a no-compromise procedure, since your program is still output 
at full quality.

If there are a handful of clips with grades that you know are too processor-intensive to be Power 
Mastered, you can use the Render Cache controls in the Color page to cache the problem clips 
before output. For more information, see Chapter 6, “The Color Page Interface.”

Outputting a Program From the Timeline

The simplest method of outputting to tape is to output a single Timeline, either in its entirety, or in 
part if you’re insert editing a small section that has been revised.

To Power Master to tape:

1.	 Use the Render Cache, if necessary, to cache any clips that are too processor-intensive to 
output in real time.

	 Click the Edit to Tape mode button to the left of the transport controls to switch to tape output.

2.	 Define how much of the current Timeline to output by moving the playhead throughout the 
program, and then right-clicking the thumbnails of clips that define the beginning and end of 
the range you need to output and using the Mark In and Mark Out commands.

3.	 Use the transport controls to find the In point on tape at which you want to start recording, and 
click the In button.

4.	 Choose Insert from the pop-up menu, if you’re either outputting to a striped and blacked 
tape, or inserting over an existing program on tape.

5.	 Click the Power Mastering (lightning bolt) button at the top-right of the Edit to Tape Queue to 
add the job you’ve just set up to the Edit to Tape Queue.

6.	 Click Start Record to begin the process of outputting to tape.

7.	 Device control is used to record to the designated section of tape; a progress bar appears at 
the bottom of the Render Queue to show how long this will take.
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If you don’t want to Power Master, you can render the section of the Timeline you need to output 
as a single clip first, as a self-contained media file, and then add that clip directly to the Edit to 
Tape Queue. This might be an easier solution if you’re outputting an extremely processor-
intensive timeline.

To output a pre-rendered media file to tape:

1.	 Click the Render mode button to the left of the transport controls to switch to File-rendering 
mode, and then render out a section of the Timeline that you need to output to tape as a 
single clip. Be sure you render it to a drive volume that has fast enough performance to play 
back in real time without dropping frames.

2.	 Click the Edit to Tape mode button to the left of the transport controls to switch the Deliver 
page to tape output.

3.	 Click the Plus (+) button at the top-right of the Edit to Tape Queue, and then use the VTR 
Record dialog to select the media file you rendered in Step 1, and click Add Clip(s) to Queue.

	 The media file you selected is added to the Edit to Tape Queue as a Power Mastering job, and 
will be output in its entirety.

4.	 Use the transport controls to find the In point on the tape at which you want to start recording, 
and click the In button.

5.	 Choose Insert from the pop-up menu, if you’re either outputting to a striped and blacked 
tape, or inserting over an existing program on tape. 

6.	 To preview what the edit will look like before actually writing it to tape, choose “Use Preview for 
Tape Output” from the Edit to Tape queue option-menu, and then click Start Record to watch 
Resolve run through the edit using the deck. After previewing the edit, turn this setting off.

7.	 Click Start Record to begin the process of outputting to tape.

	 Device control is used to record to the designated section of tape; a progress bar appears at 
the bottom of the Render Queue to show how long this will take.
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Batch Outputting Multiple Clips

You also have the option of outputting a number of clips to tape in a batch operation, as opposed 
to outputting from the Timeline. When you set up a batch of multiple clips in the Edit to Tape 
Queue, then DaVinci Resolve will automatically record them sequentially to tape.

How the timecode is generated during batch output depends on the “Output Source Timecode” 
setting in the Playout panel of the Project Settings. If this is turned off, then a continuous timecode 
track will be written to cover everything being output to tape. If this is turned on, then each clip’s 
source timecode will be written to tape discontinuously.

When batch outputting to tape, you can add black handles to each of the clips to space them out, 
making later ingest easier, using the “Set batch playout head/tail handle” settings in the Playout 
panel of the Project Settings.

To make a Batch Record multiple clips to tape:

1.	 Use the transport controls to find the In point on tape at which you want to start recording, and 
click the In button.

2.	 Do one of the following to add items to output to the Edit to Tape Queue:

>> Click the Plus (+) button, choose one or more media files from the VTR Record browser, and 
click Add Clip(s) to Queue.

>> Right-click any clip in the Timeline, choose Render This Clip, and then click the Power 
Mastering button (the lightning bolt) to add that clip to the Queue.

3.	 Choose either Assemble or Crash from the Output pop-up menu. Because you’re outputting 
clips with discontinuous timecode, you cannot insert edit when batch outputting.

4.	 Once you’ve added all the clips you want to output to the queue, click Start Record to begin 
outputting to tape.

	 Device control is used to record to the designated section of tape; a progress bar appears at 
the bottom of the Render Queue to show how long this will take.
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Exporting Timelines to Other Applications

Once you’ve graded a program, you need to export your final graded timeline as EDL, AAF or XML 
files in order to send it to another application for finishing, or to complete a round trip from an NLE.

To send a graded project to another application, you need to render the graded clips first using 
the controls on the Deliver page to render the timeline as individual source clips. In this mode, the 
reel name and timecode metadata of each rendered clip is mirrored by the exported project file, 
to maintain the correlation between exported EDL, XML, or AAF data and the rendered media. For 
detailed information about rendering in the Deliver page, see Chapter 14, “Deliver.”

If you render using the Easy Setups that correspond to Final Cut Pro XML or Avid AAF round trips, 
then an XML or AAF will be exported to the same directory you’ve rendered to. However, you can 
still export an XML, AAF, or EDL file separately should the need arise.

Furthermore, the robust project compatibility of DaVinci Resolve makes it possible to import one 
type of project exchange file, such as XML, and then export a completely different kind, such as 
AAF or EDL. This lets you use DaVinci Resolve as a project exchange utility.

Exporting to AAF/XML� 844

Exporting an EDL� 845

Exporting a Missing Clips EDL� 846

Exporting to CDL� 847

Exporting to ALE� 849

Exporting to ALE with CDL� 850
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If you’re doing a round trip with an application that uses AAF, Final Cut Pro 7 XML, or Final Cut 
X XML project exchange formats, the Edit page is where you export your timeline after you’ve 
rendered the graded media. If you’re planning your round trip workflow in advance, keep the 
following in mind:

>> You can re-edit imported projects before export: If necessary, you can freely re-edit projects 
you’re planning to export. When you export an AAF or XML file, the timeline will be sent 
back to the originating NLE, or onward to the finishing application of choice.

>> Unsupported effects: If there were effects or clip constructs in the original sequence  
that were not compatible with DaVinci Resolve, how those effects will be handled depends 
on the project format you’re exporting to, and whether or not you’ve edited the project.  
For XML projects, unsupported effects are saved internally by Resolve, and are exported 
with the XML file that you output no matter what. Consequently, they should reappear 
when you reopen the exported file in the originating NLE. For AAF projects, you can  
export unsupported effects as long as you don’t re-edit the project. However, if you 
do re-edit the project, then you can only export an AAF file that’s been stripped of all 
unsupported effects.

>> Project formats can be converted to other formats: Using DaVinci’s Export commands, 
compatible project formats can be converted from one format to another. For example, 
an imported EDL can be output as Final Cut Pro X XML. For that matter, Final Cut Pro 7 
XML can be imported and then exported as Final Cut X XML. Or, an AAF file from Media 
Composer can be imported and then exported as a Final Cut Pro XML file to be opened 
in any NLE or finishing application compatible with that format, such as Premiere Pro  
or Smoke.

Important: If you export a timeline with multiple tracks as an EDL, only the events on the currently 
selected video track in the Edit page will be exported.

To export an AAF or XML file after you’ve rendered the graded clips:

1.	 Do one of the following:

>> To export the current timeline, choose File > Export AAF, XML

>>Open the Edit page, right-click the timeline you want to export in the Timelines list, and 
choose Export > AAF/XML.

2.	 When the Export XML dialog appears, type a name for the file and choose a location for the 
exported XML file, then click Save.

	 An XML version of that timeline is saved, complete with references to the graded media you 
rendered, and is ready for import into an NLE or finishing application.

Exporting to AAF/XML
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If you’ve re-edited a timeline, or you’ve rendered media with reel names or timecode that doesn’t 
match the original media you imported, you can export a new EDL that reflects these changes, and 
that can be reimported into whatever application you want to send the graded project to. For more 
information about EDL workflows, see Chapter 9, “Preparing and Conforming Projects.”

To export an EDL:

1.	 Open the Edit page and select the timeline you want to export an EDL from in the 
Timelines list.

2.	 If you want to export a track other than Video 1, you can click the track name in the header of 
any video track in the Timeline to choose a specific track to export.

3.	 Right-click the timeline in the Timelines list, and choose Export > EDL from the 
contextual menu.

4.	 When the Save EDL dialog appears, type a name and choose a location for the exported EDL, 
then click Save.

	 The EDL is saved, and a dialog appears reminding you of the file path to which it was saved 
(click OK to dismiss it).

Exporting an EDL
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This command lets you export a quick report of which clips are currently offline in the currently 
selected track of the timeline in the Edit page. This report is in EDL format, with one event for each 
clip that’s offline, which describes the reel number and source timecode of the missing media, as 
well as the record timecode of the missing media’s position on the Timeline.

Here’s an example of an exported Missing Clips EDL:

Once you’ve exported this information, you can hand it off to whomever can help you track down 
the missing media.

To export a Missing Clips EDL:

1.	 Open the Edit page and select the timeline you want to export a Missing Clips EDL for in the 
Timeline browser.

2.	 Click the track name in the header of the video track you want to examine for missing clips, if 
it’s not already selected.

3.	 Right-click the timeline in the Timelines list, and choose Export > Missing Clips EDL from the 
contextual menu.

4.	 When the Save Missing Clips EDL dialog appears, type a name and choose a location for the 
exported EDL, then click Save.

	 The EDL is saved, and a dialog appears reminding you of the file path to which it was saved 
(click OK to dismiss it).

TITLE: ( no title )

001 A001_C002_0820GA_001 V C 10:28:27:03 10:28:28:00 01:00:00:00 01:00:00:21

002 A004_C012_0820MC_001 V C 14:07:31:21 14:07:35:13 01:00:12:13 01:00:16:05

003 A017_C001_0820CV_001 V C 21:16:14:22 21:16:15:00 01:00:16:05 01:00:16:07

Exporting a Missing Clips EDL
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DaVinci Resolve can export and import basic grading data to and from other applications via a 
Color Decision List (CDL). CDLs are an industry-standard file format originally developed by the 
American Society of Cinematographers’ technology committee. Resolve supports the 1.2 CDL 
standard that defines the slope, offset, and power for each of the red, green, and blue channels, as 
well as the overall saturation of each clip in a program.

CDL files are formatted similarly to EDLs, with SOP (Slope/Offset/Power), and SAT (Saturation) 
values embedded as metadata in much the same way as comments are in a more typical EDL. 
Here’s an example of a single CDL event:

Because the CDL definition of a grade is so narrow, projects you’re planning to export to other 
applications via a CDL must be constrained to only those operations the CDL mathematically 
defines. Here are some things to keep in mind:

Only primary corrections in the first node of each clip are exported.

Restrict yourself to using the Lift/Gamma/Gain, Offset, and Saturation controls.

Keyframes are never exported. If keyframes are present in a grade, only the parameter 
values at first frame of the clip are used.

The track grade is completely ignored.

If there is an HSL Qualification or a Power Window in the first node, it is ignored and the 
corrections in that node are exported as if it were a primary correction.

Do not make Y’ only adjustments; they’re not compatible with CDLs. To ensure that your 
exported CDL is accurate, set the Lum Mix parameter in the Primary Controls palette 
for each grade to 0. For workflows involving frequent CDL export, you can turn on the 
“Luminance Mixer defaults to zero” option in the General Options panel of the Project 
Settings window to make sure this parameter is always set to 0.

If your timeline conforms to all of these restrictions, then you’re ready to export a CDL.

020 001 V C 03:02:49:13 03:02:53:00 01:01:28:11 01:01:31:22

*ASC_SOP (1.109563 1.717648 0.866061)(-0.238880 -0.390357 0.353743)

(0.672948 1.384022 0.889876)

*ASC_SAT 1.000000

Exporting to CDL
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To export a CDL:

1.	 Open the Edit page, right-click the timeline you want to export in the Timelines browser, and 
choose Export > CDL from the contextual menu.

2.	 A window appears reminding you to make sure that Lum Mix is set to 0 for each clip’s grade. 
Click Save, or Cancel if you need to adjust the grades of your clips to better comply with the 
standards required for CDL export.

3.	 Enter a name for the CDL, choose a location to save it to, and click OK.

For more information on importing a CDL to add grades to your project, see Chapter 9 “Preparing 
and Conforming Projects.”
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DaVinci Resolve is also capable of exporting ALE (Avid Log Exchange) files. ALE is a tab-delimited, 
ASCII text- based clip logging list format that enables the exchange of clip metadata that can’t be 
included with MXF files.

ALE files are divided into three sections, labeled Heading, Column, and Data. The Heading provides 
information about the clips being logged, including the picture and audio format, and the frame 
rate. Underneath, the Column line defines each of the columns of metadata being exported in the 
list. Underneath that, the Data section contains multiple lines, one for each event being referenced 
in the list, that contain all the data corresponding to that clip.

Note: If you’re exporting stereoscopic clips, additional parameters are included in the ALE file: 
Pan (relative to timeline resolution), Tilt (relative to timeline resolution), Zoom, Rotate, Convergence 
(relative to timeline resolution), HFlip (0 or 1), and VFlip (0 or 1).

Here’s an example of a short ALE export:

Exporting to ALE

Heading

FIELD_DELIM	 TABS

VIDEO_FORMAT	 1080

AUDIO_FORMAT

FPS	 24

Column

Name, Tracks, Start, End, Take, Tape, Source File, FPS, Reel #, Scene, Shoot date, 

Manufacturer, DESCRIPT, COMMENTS, ResolveShot, ResolveDay, ResolveAngle, ResolveRes, 

ResolveCodec, ResolveVersion, ResolveNumTracks, ResolveOrigFilename, ResolveCircled, KeyKode

Data

A001_C002_V01.CBF6A4FD139AD.mxf, V, 10:28:27:03, 10:28:28:00

A001_C002_V01.CBF6A4FD139AD.mxf/Volumes/Disk_1/Avid MediaFiles/MXF/1/

A001_C002_V01.CBF6A4FD139AD.mxf, DaVinci Resolve

A016_C008_V01.CBF6A4FD13ABD.mxf,V, 23:35:56:03, 23:36:00:11

A016_C008_V01.CBF6A4FD13ABD.mxf	 /Volumes/Disk_1/Avid MediaFiles/MXF/1/

A016_C008_V01.CBF6A4FD13ABD.mxf, DaVinci Resolve

A004_C012_V01.CBF6A4FD1438E.mxf, V, 14:07:31:21, 14:07:35:15

A004_C012_V01.CBF6A4FD1438E.mxf	 /Volumes/Disk_1/Avid MediaFiles/MXF/1/

A004_C012_V01.CBF6A4FD1438E.mxf, DaVinci Resolve

Note: The commas shown above are not normally in the ALE but shown here for field clarity
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Avid Media Composer and Symphony support the import of ALE files with CDL parameters 
embedded to attach SOP (Slope/Offset/Power) and SAT (Saturation) metadata to each clip that’s 
logged in the ALE. When you import an ALE with CDL file into Media Composer, the SOP and SAT 
data populate metadata columns for preservation and export in various Avid workflows. Here’s an 
example of the Heading, Column, and Data sections of a sample ALE with CDL, with one line of clip 
and CDL data.

To export an ALE with CDL file:

1.	 Open the Edit page, right-click the timeline you want to export in the Timelines browser, and 
choose Export > ALE with CDL from the contextual menu.

2.	 A window appears reminding you to make sure that Lum Mix is set to 0 for each clip’s grade. 
Click Save, or Cancel if you need to adjust the grades of your clips to better comply with the 
standards required for CDL export.

3.	 Enter a name for the ALE file, choose a location to save it to, and click OK.

	 The ALE file is saved, and a dialog appears reminding you of the file path to which it was saved 
(click OK to dismiss it).

Heading

FIELD_DELIM	 TABS

VIDEO_FORMAT	 1080

AUDIO_FORMAT

FPS	 24

Column

Name, Tracks, Start, End, Take, Tape, Source File, FPS, Reel #, Scene, Shoot date, 

Manufacturer, DESCRIPT, COMMENTS, ResolveShot, ResolveDay, ResolveAngle, ResolveRes, 

ResolveCodec, ResolveVersion, ResolveNumTracks, ResolveOrigFilename, ResolveCircled, KeyKode, 

ASC_SOP, ASC_SAT

Data

A001_C002_V01.CBF6A4FD139AD.mxf, V, 10:28:27:03, 10:28:28:00

A001_C002_V01.CBF6A4FD139AD.mxf	 /Volumes/Disk_1/Avid MediaFiles/MXF/1/

A001_C002_V01.CBF6A4FD139AD.mxf, DaVinci Resolve

(1.0260 1.0260 1.0260)(-0.0260 -0.0260 -0.0260)(0.8237 0.8237 0.8237)	 0.8640

Note: The commas shown above are not normally in the ALE but shown here for field clarity

Exporting to ALE with CDL
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Even though DaVinci Resolve works with disk databases by default, which save user-accessible 
project files to a disk location of your choosing, many users prefer the previously standard method 
of postgres database project management. Fortunately, this can be easily enabled. Resolve works 
from an internal database server, so it’s possible to create multiple databases for maximum flexibility 
in organizing your projects. For example, you might create a database for each year, for each month, 
for each multi-episode series you work on, or any other organizational criteria that makes sense for 
the kinds of projects on which you work. Furthermore, facilities with multiple Resolve systems can 
implement a shared Remote Database Server.

Tip: However you elect to organize your databases, keep in mind that smaller databases with less 
project data load and save faster.

If you’re upgrading from an older version of DaVinci Resolve, you’ll already be using an SQL database 
since that was the only method of working previously. As usual, you’ll be prompted to upgrade your 
previous database when you open Resolve.

In either case, this section covers how to go back and forth between database management, and 
independent project management.

Switching to an SQL Database

To switch to SQL database project management, you need to open the Database Manager and 
create a new database for Resolve to use.

To switch to database management:

1.	 If necessary, click the Back to Log In button to return to the Login screen.

Database Manager button

Database Manager window

Using Databases
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	 The Database Manager appears.

2.	 Click Create New (the Plus button).

3.	 In the “Create a New Database” dialog that appears, make the following changes:

Creating a new database

>> Type a name for the database into the Label field. This is the name you’ll see, so choose 
something readable and clear, but avoid using special characters.

>> Type an abbreviated, lower caps version of this name into the DB Name field. This name 
must be unique to the other databases currently in the list, but you cannot use spaces or 
special characters in this field.

>>Make sure the Driver pop-up menu is set to QPSQL. This guarantees that you’re creating a 
database, and not a directory reference for project-based management.

4.	 Click OK to create the database, and click OK when you’re prompted that the database has 
been created successfully.

5.	 To begin using that database, select it in the list, and click Select.

	 DaVinci Resolve will now save projects into that database.
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Switching to a Disk Database

If you’re already using databases, and you’d like to switch to the simpler Disk Database approach, 
this is also easy to do using the Database Manager, but you’ll be creating a different kind of item in 
the list. This is also the way you choose which directory Resolve uses to save the projects created 
by a particular User.

Note: Linux systems can only use an SQL database, while OS X and Windows systems can use either 
an SQL database or disk database management.

To switch to project-based management:

1.	 If necessary, click the Back to Log In button to return to the Login screen.

2.	 Click the Database button at the bottom right of the Login screen to open the Database 
Manager window.

3.	 Click Create New (the Plus button).

4.	 In the “Create a New Database” dialog that appears, make the following changes:

Dialog for creating a new database

>> Choose DISK from the Driver pop-up menu. This disables most of the fields that are available.

>> Click the Host field, then choose a location and create a directory using the File Browser 
dialog that appears. When you’re ready, select the directory you want to use, and then 
click Choose.

>> Type a name into the Label field so you can identify this disk location.

5.	 Click OK.

6.	 To begin using that Disk database, select it in the list, and click Select.

	 DaVinci Resolve will now save projects directly to that disk directory.
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The Database Manager is where all databases are managed, whether they’re traditional SQL-based 
databases, or Disk databases that allow direct project-based management.

While there’s a lot of project management you can do from the Project Manager, if you’re using 
databases, the Database Manager is critical for providing the interface to upgrade, create, backup, 
restore, and select databases on your system.

Database Manager window

What’s in a Database?

To provide a better understanding of why databases are useful, it helps to know how data is 
managed within each database. The following is the hierarchy of information that’s stored within 
each database:

Database > Users > Projects > Timelines > Clips > Timecode > Versions > PTZR/Grade

In plain English, each database is organized into a number of users. Each user is a container that 
holds one or more projects that are unique to that user. Each project contains one or more timelines, 
and each timeline contains one or more clips. Each clip contains a range of timecode and a reel, 
each of which points to three independent sets of adjustment data: Source settings (such as R3D or 
ALEXA metadata), and versions that contain pan/tilt/zoom/rotate/3D (PTZR) settings, and grades, 
which are applied to each clip in that order.

Working With the Database Manager
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Where Are My Disk Databases, Anyway?

In the exceptionally rare instance that your system administrator needs to know where your DaVinci 
Resolve database is located, due to some catastrophic occurrence, every database that Resolve 
creates is located within a file hidden deep within your system with a location determined by the 
operating system you’re using:

On OS X:

Library/Application Support/Blackmagic Design/DaVinci Resolve/ Resolve Disk Database

On Windows: 

C:\ProgramData\Blackmagic Design\DaVinci Resolve\Support\Resolve Disk Database

This is primarily useful to know if only to demonstrate the importance of backing up your entire 
system to make sure this critical file is preserved. Do not, under any circumstances, remove, rename, 
or attempt to edit this file. The consequence of failure is the loss of all your database-managed 
project information.

Note: Linux cannot use disk databases, and only uses SQL databases.

Database Management

Here’s a breakdown of all the commands that are available for managing the databases used by 
Resolve. The Create Database (+) and Disconnect Database (–) buttons are located at the bottom 
left of the Database Manager; all other commands are available from the Options pop-up menu at 
the upper right corner.

Methods of database management:

>>New Database: Click Create New to add a new database to the Database list. See the 
previous section for more information on how to do this.

>> Delete Database: Select a database and click this button to delete it, along with all users 
and projects inside of it. It’s highly recommended to back up databases you’re about to 
delete in case you later decide you need to retrieve their contents.

>> Select: To choose a new active working database, click on a database from the list and 
click Select. This database will now be used for saving all new projects. Other Internal, 
Remote, and Disk databases will continue to appear in this list, and you can import projects 
from those databases using the Group Projects browser in the Project Manager. However, 
whenever you save a project, regardless of its origin, it will be written to the active working 
database selected here.

Where Are My Disk Databases, Anyway?

In the exceptionally rare instance that your system administrator needs to know where your DaVinci 
Resolve database is located, due to some catastrophic occurrence, every database that Resolve 
creates is located within a file hidden deep within your system with a location determined by the 
operating system you’re using:

On OS X:

Library/Application Support/Blackmagic Design/DaVinci Resolve/ Resolve Disk Database

On Windows: 

C:\ProgramData\Blackmagic Design\DaVinci Resolve\Support\Resolve Disk Database

This is primarily useful to know if only to demonstrate the importance of backing up your entire 
system to make sure this critical file is preserved. Do not, under any circumstances, remove, rename, 
or attempt to edit this file. The consequence of failure is the loss of all your database-managed 
project information.

Note: Linux cannot use disk databases, and only uses SQL databases.
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>> Restore: If you have previously backed up a database, or have one from another system 
you can restore this database over the original or create a new empty database to restore 
to. Select the destination database and then click “Restore.” Navigate using the open 
Finder to the database you wish to restore and select “Open.” You then need to confirm to 
overwrite the database you selected as the destination and the database will be restored.

>> Backup: You back up databases like any other file. This provides added protection should 
your system drive fail, or a backup can be used to move multiple projects between systems. 
Selecting ‘Backup’ will open the Finder window and you can define the file name and 
location to back up. Be sure not to change the .backup extension.

>>Optimize: If the database in Resolve becomes so large that it affects performance, you may 
need to optimize it to improve access speed. Click “Optimize” and the database will be 
vacuumed of unnecessary spaces and reindexed.

>> Upgrade: If you have databases that were created using previous versions of DaVinci 
Resolve, they probably need to be upgraded to be accessible. It’s generally a good idea to 
back up any database you’re planning to upgrade, in case something goes wrong.

>> Connect: If you are connecting to a Remote Database Server, click Connect, change the 
IP address in the Host field to the IP address of the computer you’ve set up as the Remote 
Database Server, then type the remote database’s name into the DB Name field. Accept 
the default “postgres” entry in the User field for all new databases with full read/write 
access, or change this to “MySQL” for read-only access to legacy DaVinci databases. For 
more information on Remote Database Servers, see the next section of this chapter.

>> Disconnect: Disconnects databases to which you’ve previously connected, whether they’re 
local on your machine or connected to via a Remote Database Server. 

Note: You cannot actually delete databases in DaVinci Resolve, you can only disconnect them so 
they don’t appear in the Database list. However, disconnected databases can still be reconnected 
if you remember their name. The only way to completely delete a database entry in PostgreSQL 
is to do so from the command line, or to use the PGAdmin III application that accompanies the 
PostgreSQL installation that’s part of the Resolve installation process.

Configuring and Using a Remote Database Server

Multiple DaVinci Resolve systems can also work on the same project at the same time using a 
shared database, which is enabled by setting up a Remote Database Server. Once you’ve set one 
up, there are two ways of using a shared database.
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>> The simplest case is for one user to open up a project, with subsequent users opening 
the same project in Read Only mode. For example, an assistant could be working with the 
colorist to prepare files for the next reel by conforming shots, managing VFX replacements, 
doing dust busting repairs, and so on. Using a Remote Database Server in this way, Resolve 
automatically prevents two users from working on the same project by creating a copy of a 
project that’s already in use, and any changes made will have to be in this duplicate project.

>> Alternately, you can use the Collaborative Workflow features introduced in Resolve 11 to 
enable an owner to open up a project on a Shared Database, and multiple collaborators to 
open the same project, with all participants actually writing data to the same project file. 
The rule with collaborative workflow is that the first person to open a project, the owner, is 
the only one who can make editorial changes to the Timeline. Collaborators can grade and 
edit Media Pool metadata, but they cannot alter edits in the Timeline.

However you decide to work, the Database Server can be one of the actively used Resolve 
workstations, or it can be another computer on your network with DaVinci Resolve installed that 
simply hosts your projects (a dongle or video card is not required). All machines participating in a 
collaborative workflow must be on the same network.

Use of a separate workstation to operate as the Remote Database Server is recommended for 
facilities with more than two DaVinci Resolve systems, to ensure that something as simple as a user 
shutting down their system doesn’t make all projects suddenly unavailable. By clicking the Connect 
button in the Database Manager, you can enter the information that enables a connection to the 
remote database. 

For more information on setting up and using a Remote Database Server, see Chapter 17, 
“Collaborative Workflow.”

About Locked Projects

Large projects being worked on in parallel can be split into sections, so multiple colorists can work 
simultaneously in different suites. For example, a feature film may be split into reels, or the film 
separated from the trailer and video press kit. Each section can use grades from the other segments 
as required to keep the shots balanced.

If you are sharing a database with other DaVinci Resolve systems, but you’re not using Collaborative 
Workflow, then some of the projects will appear with a Lock icon to the left of the project name. 
When a shared project is loaded, it is automatically locked in Read-only mode to prevent multiple 
users from accessing the project at the same time. If you load a locked project and make changes 
anyway, you’ll need to save a new project file using a new name to preserve your work.

To unlock a project: 

>> Log in as Admin, and then click the Unlock button.
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Requirements

The following requirements must be met for remote grading to work.

>> The same version of DaVinci Resolve must be installed on both systems.

>> The display resolution must be the same on both systems.

>> The timeline to be graded must be conformed on both machines prior to the start of the 
remote grading session. 

>> The number of clips on the timeline and the duration of each clip must be identical. 

>>While grading, the active timeline and versions on the remote client system are constantly 
updated. Creating, deleting, or switching the timeline on the client’s DaVinci Resolve is not 
allowed. Doing so will terminate the remote grading session immediately.

>> You cannot make any grading adjustments on the remote client’s DaVinci Resolve 
workstation until the remote grading session has ended. 

Setup

To start a remote grading session, the client’s DaVinci Resolve must be able to connect to the 
colorist’s system using TCP/IP.

1.	 Open DaVinci Resolve on the remote client’s workstation (the one that’s being remotely 
controlled), log in, and open the project that will be remotely graded

2.	 Choose View > Remote Grading (Ctrl-G) on the remote client’s workstation. A window is 
displayed with text fields to enter the IP address and port number of the colorist’s system.

Remote Grading
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3.	 Set the IP address field to the IP of the colorist’s DaVinci Resolve workstation. If the colorist’s 
system already has a public IP address, the port number can be left at its default value (15000). 
If the colorist’s system is on a private network, the colorist or their network administrator 
should set the port number to one on the public IP router that is internally routed to port 15000 
of the colorist’s DaVinci Resolve. 

4.	 Once the remote client clicks Connect, the client’s DaVinci Resolve system will attempt to 
establish a connection with the remote colorist’s workstation. 

5.	 Once the connection is established, a pop-up appears on the colorist’s screen asking for 
permission to accept a Remote Grading connection. 

6.	 Click OK to accept, minimize the size of this dialog window, and continue grading normally. 

The Remote Grading session will remain active until one of the users chooses to disconnect or an 
error occurs causing DaVinci Resolve to automatically terminate the session. 

Restrictions

To allow operation over low bandwidth and a potentially long latency Internet connection there are 
some restrictions to remote operation.

>>When playback is started, the playback speeds on the two DaVinci Resolve systems 
may differ. The frame positions are only guaranteed to be synchronized when playback 
is stopped.

>> Input/output/display LUTs applied from the Config page on the colorist’s DaVinci Resolve 
will not have any effect on the client system. LUTs selected on the client’s DaVinci Resolve 
will be applied instead.

>> Presets applied from the Config/Color pages on the colorist’s system will not have any 
effect on the client’s system. Presets selected on the client’s DaVinci Resolve will be 
applied instead.
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Collaborative Workflow

Multi-user collaborative workflow allows simultaneous editing, grading and metadata entry within 
a collaborative project. Multiple users can simultaneously access the same Timeline within the 
same project. For example an Editor, a Colorist, and an assistant doing metadata entry on the 
Media Page can all work simultaneously on the same Timeline. This chapter describes how to set 
up multiple DaVinci Resolve workstations for collaboration in this way, and how to work within a 
collaborative workflow.

Setting Up to Collaborate� 864

Setting Up a DaVinci Resolve Project Server� 864

Connecting to Projects in a Collaborative Workflow� 866

Troubleshooting Tips� 867

Opening Projects to Collaborate Upon� 870

Switching Roles as Owners and Collaborators� 871

Using Collaborative Workflow� 872

Collaborative Workflow Commands� 872

An Example of Collaborative Example� 873
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Multi-user collaborative workflow allows simultaneous editing, grading and metadata entry within a 
collaborative project. Multiple users can simultaneously access the same Timeline within the same 
project. For example an Editor, a Colorist, and an assistant doing metadata entry on the Media Page 
can all work simultaneously on the same Timeline. To accommodate this, Timelines in a collaborate 
workflow must be set to use Remote grades.

Setting Up a DaVinci Resolve Project Server

All participants in a Collaborative Workflow must have the Full Version of DaVinci Resolve, and a 
Database Server must be be set up. The Database Server can be one of the actively used Resolve 
workstations, or it can be another computer on your network with DaVinci Resolve installed that 
simply hosts your projects. A dongle or video card is not required to use the database, although it’s 
easier if you have a dongle on hand to set it up initially. Most importantly, all machines participating 
in a collaborative workflow must be on the same network.

Set up of a Database Server requires an at least cursory knowledge of command line text editing. If 
you don’t understand the following instructions, it’s best to have an IT professional do this for you.

To set up a Mac as a DaVinci Resolve database server:

1.	 If you haven’t already, install the full version of DaVinci Resolve on the Mac that you plan 
to use as the remote Database Server. This machine doesn’t need video cards or a dongle 
connected (although it’s good to have a dongle available for the last step), but the Resolve 
application installer sets up PostgreSQL as well as the database structure which is configured 
for Resolve.

	 Once you have installed the software and restarted the system, you need to set up the 
permissions and access to the PostgreSQL server application running on this machine. Be 
sure to follow the instructions carefully.

2.	 Make sure you log in as a user with Admin privileges, then open the Terminal application, 
located in the /Applications/Utilities folder, and open up the postgres environment for editing 
by typing:

	 sudo su - postgres

3.	 At the prompt, type that computer’s administrator password and press return.

4.	 When  the “postgres$” prompt appears, you’ll create a backup of the “pg_hba.conf” setup 
file for safety by typing:

	 cp /Library/PostgreSQL/8.4/data/pg_hba.conf /Library/PostgreSQL/8.4/data/pg_hba.conf.backup

Setting Up to Collaborate
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5.	 In the next step, you’ll add your particular local IP network range (the example given in these 
instructions is 192.168.1.88, though this value may well be different on your network).  Open 
the System Preferences, then open the Network panel, and write down the IP address you 
see there. The computer being used as the Network Server should not use DHCP, instead 
it should have a manually entered, stable IP address so that other computers can reliably 
connect to it.

6.	 In the following instruction, change the four values of the IP address below to match the one 
you wrote down, and then keep the number that follows after the forward slash (/) as 24, which 
specifies that the fourth number of the IP address can be any number.

	 echo “host all all 192.168.1.88/24 md5” >> /Library/PostgreSQL/8.4/data/pg_hba.conf

7.	 With this accomplished, open a Finder window, open /Applications/PostgreSQl 8.4/, and 
double-click the Stop Server application to run it and stop PostgreSQL.

8.	 After you get a message stating the server has stopped, double-click the Start Server 
application to start it up again. You should get a message that the server has started, and this 
lets you know that you’ve successfully restarted the Database Server with the new settings 
you’ve entered.

9.	 With this accomplished, plug in a Resolve Dongle, if necessary, in order to run Resolve. At the 
Resolve login screen, click the Database button in the lower right-hand corner, then click the 
Plus (+) button in the lower left-hand corner to create a new database that you’ll be using as 
the shared database on that computer. 

10.	 In the Create New Database dialog, enter a name into the Label and DB Name fields. This 
name doesn’t have to be anything special, although the DB Name field doesn’t allow caps or 
special characters other than underscores. Make sure that the Driver pop-up is set to QPSQL, 
then click Create New Database.

11.	 To use that database on this computer, select it in the list, then click the Option menu at the 
upper right-hand corner, and choose Select to open that database and return to the DaVinci 
Resolve login screen.

12.	 At this point, you can either continue using DaVinci Resolve, or you can quit.
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Connecting to Projects in a Collaborative Workflow

You now have a remote Database Server that you can connect to from each of the Resolve systems on 
that network. PostgreSQL runs automatically, so you must have this computer turned on whenever 
you wish to open a project it’s serving in Resolve on another computer. However, DaVinci Resolve 
does not have to be actively running on the Database Server for this to work.

To connect DaVinci Resolve on one computer to the Database Server on another:

1.	 Open DaVinci Resolve on a computer that’s on the same network as the Database Server. At 
the Resolve login screen, click the Database button in the lower right-hand corner, then click 
the Option pop-up menu at the upper right-hand corner of the Database Manager (it looks 
like three vertical dots), and choose Connect.

2.	 In the Connect dialog, type the label and name of the database on the Database Server that 
you want to connect to in the Label and DB Name fields. Next, type the IP address of the 
Database Server into the Host field, and make sure that the Driver pop-up is set to QPSQL. 
When you’re done, click Connect Database.

3.	 If all the information you entered was correct, then that database should appear in the 
Database Manager list. With it selected in the list, click the Option menu at the upper right-
hand corner, and choose Select to open that database and return to the DaVinci Resolve 
login screen.

This computer should now have access to the same users and the same projects that are hosted on 
the Project Server, and you can work as you normally would.

To create a new project to be used in a collaborative workflow:

1.	 Open DaVinci Resolve on a computer with a database that’s connected to a Database Server, 
log in as a user, and click the plus (+) button to create a new project.

2.	 Enter a name for the new project, and click Create. If you’ve just now opened Resolve, the 
default new project thumbnail at the upper left-hand corner appears with this new name, 
otherwise a new project with a blank thumbnail appears in the Project Manager.

3.	 Right-click the new project you created, and choose Collaboration from the shortcut menu.

4.	 The owner can now import whatever media is necessary for that project, editing a new 
timeline, or importing a timeline from another application. Projects in collaborative workflows 
can use media on a storage area network (SAN) so that each owner and collaborator can be 
properly linked to the same media. Alternately, each participant in a collaborative workflow 
can work with an exact duplicate of the media copied to a local volume. Each participant’s 
media volume must be identically named, so that each participant can be properly linked to 
the same media with the same file path.
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At this point, each new timeline you create will use Remote versions, which is important for 
collaborative workflow to function properly. You can now add media and create new timelines as 
necessary to start working.

Troubleshooting Tips

DaVinci Resolve manages all projects using PostGreSQL, which is an open-source database 
management system. If you have difficulty connecting to a shared database, or difficulty opening 
databases in general, it’s probably because the Database Server you set up has been inadvertently 
misconfigured. Here are some ways you can check to see what the problem might be.

Checking to See If PostgreSQL Is Running Properly

To double-check whether PostgreSQL is running as it should, you can open Terminal and enter the 
following command, followed by Return:

	 ps -ef | grep PostgreSQL

If all is well, the text output by this command should resemble the following:

	 502   118     1   0 12May14 ??         0:12.77 /Library/PostgreSQL/8.4/bin/postmaster -D/Library/

PostgreSQL/8.4/data

	 501 88287 88143   0 11:34AM ttys000    0:00.00 grep PostgreSQL

The first line indicates the server is running.

Checking the PostgreSQL Setup File

Many problems can be chalked up to the “pg_hba.conf” file being misconfigured. To read the 
content of this file, open Terminal and enter each of the following commands, followed by Return:

	 sudo su - postgres

At the prompt, type your password and press return.

	 cd /Library/PostgreSQL/8.4/data/

	 cat pg_hba.conf
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The contents of the “pg_hba.conf” file should appear. Properly configured, it should resemble the 
following sequence of text, but with your IP address:

Deleting and Restoring the Original “pg_hba.conf” File

If the “pg_hba.conf” file is misconfigured, you can restore the backed up “pg_hba.conf.backup” file 
in order to restore PostgreSQL to its previous configuration by entering the following commands.

With this accomplished, open a Finder window, open /Applications/PostgreSQl 8.4/, and double-
click the Stop Server application to run it and stop PostgreSQL. After you get a message stating the 
server has stopped, double-click the Start Server application to start it up again. You should get a 
message that the server has started, and this lets you know that you’ve successfully restarted the 
Database Server with the original working settings.

At this point, you can try the procedure described above in “Setting Up a DaVinci Resolve 
Project Server.”

Reconnecting Database Entries That Have Disappeared

In some cases, misconfigured databases that have been stopped while Resolve has been launched 
can result in the list of databases in the Resolve database manager being cleared out. If this happens, 
it’s simple to reconnect to these databases using the PGAdmin Setup application.

To find lost database entries: 

1.	 Open /Applications/PostgreSQl 8.4/, and double-click pgAdmin III.

2.	 Click the “Add a connection to a server” button.

3.	 Enter the following into the New Server Registration window:

>> Type ”localhost” into the Name field.

>> Type “DaVinci” into the Password field.

# TYPE DATABASE USER CIDR-ADDRESS METHOD

# “local” is for Unix domain socket connections only

local all all md5

# IPv4 local connections:

host all all 127.0.0.1/32 md5

# IPv6 local connections:

host all all ::1/128 md5

host all all 192.168.1.88/24 md5

rm pg_hba.conf

cp pg_hba.conf.backup pg_hba.conf
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4.	 Click “OK.”

5.	 When prompted about saving passwords, click “OK.”

6.	 In the Object Browser, you should be able to see localhost as an entry in the Object browser 
list. Click the disclosure triangle to the left of localhost, and then click the disclosure triangle 
to the left of Databases.

	 You should now be able to see all of your Resolve database entries in a list, and you can 
use these database names to reconnect to these databases from within the DaVinci Resolve 
database manager.
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In a collaborative workflow, one person is the Owner of the Timeline, and this is typically the editor 
of the program. The first person who opens a project is the owner. The owner is the only one who’s 
allowed to add media or create bins in the Media Pool, or alter the edit of the Timeline in the 
Edit page. 

Once a project has been opened by the owner, the same project can also be opened by Collaborators 
on other workstations. In this way, grading done by a colorist in the Color page or metadata edited 
by an assistant working in the Media page can be published for use by the owner. Those published 
changes can be reviewed by the owner, and then accepted or rejected a clip at a time, or all at once. 
If the owner so chooses, published changes can also be automatically accepted.

It should be reiterated that, in collaborative workflows, shared projects should use media on a 
storage area network (SAN), and each owner and collaborator should be connected to that SAN so 
that the opened project they collaborate on is properly linked to the same media.

To open a timeline as the owner in a collaborative workflow:

1.	 Open DaVinci Resolve on a computer with a database that’s connected to a Database Server, 
and log in as a user.

2.	 To be the owner of a collaborative project, right-click that project and make sure that the 
Collaborative option in the contextual menu is checked, and turn it on if necessary. 

3.	 Finally, make sure you’re the first person on the network to open that project.

4.	 So long as you’re the first person on the network to open up a project that’s with Collaborate 
turned on, you’ll be the owner of that project until you close it. As the owner, you are the only 
person allowed to add media and bins to the Media Pool, and edit the timelines within.

To collaborate on a project that’s currently opened by the owner:

1.	 Open DaVinci Resolve on a computer with a database that’s connected to a Database Server, 
and log in as the same user the owner logged in with.

2.	 Right-click the project you want to collaborate on, and choose Open in Collaboration Mode.

3.	 Collaborators can make the following changes:

>> Edit metadata in the Media page.

>> Create and modify either Local or Remote grades in the Color page, and create and 
manage multiple versions.

Opening Projects to Collaborate Upon
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Once you’ve started collaborating, it’s easy for owners and collaborators to switch roles using the 
Reload Project as Collaborator and Reload Project as Owner commands.

To switch roles during collaboration:

1.	 The current owner of a project must initiate the switching of roles by relinquishing ownership of 
the project. This can be done by choosing File > Collaboration > Reload Project as Collaborator.

2. 	 At this point, any collaborator can choose File > Collaboration > Reload Project as Owner to 
become the owner. The first collaborator to do so becomes the owner, at which point no other 
collaborators can use this command until the new owner relinquishes ownership by using the 
Reload Project as Collaborator command.

Switching Roles as Owners and Collaborators
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Once an owner and one or more collaborators are set up to work on the same project, the actual 
process of the owner and collaborators working together is fairly simple. The basic rule is as follows:

>> Changes made by collaborators: Must be checked in by each collaborator using one of the 
Publish commands; the owner can then use one of the Update commands to update the 
Timeline with those changes.

>> Changes made by the owner: When the owner changes the Timeline, the project must be 
saved by the owner; collaborators will only see those changes when they use the Reload 
Project command. 

While in collaborative mode, all commands for publishing changes, and for updating, reverting, or 
reloading projects are found within the button with the bell icon that’s at the bottom of the screen 
between the gear button (Project Settings) and the name of the project. This button only appears 
when you’re in collaboration mode.

Collaborative Workflow Commands

The Bell button is actually a pop-up menu that gives access to all of the commands that are useful 
for collaborative workflow. These same commands are also available in the File > Collaboration 
submenu. Be aware that some of these commands are for use by the owner of a project, while 
others are for use by the Collaborators on that project.

>> Publish All Changes: (Collaborators) Checks in all changes you’ve made to the grades of 
a timeline or to the metadata of clips in the Media Pool since the last time you published. 
When you Publish changes, the owner is alerted by a red highlight on the bell button, 
and the checked-in clips are highlighted red in the owner’s timeline in the Edit page (clip 
thumbnails are highlighted red in the Color page).

>> Publish Changes for Selected Clips: (Collaborators) Checks in only the changes made to 
one or more clips you’ve selected, allowing you to do partial check-ins.

>> Update All Clips: (Owners) Updates every single checked in change to a clip that’s highlighted 
red, so that the owner’s timeline now reflects all changes checked in by the collaborators.

>> Update Selected Clips: (Owners) Updates only those clips you’ve selected.

>> Revert All Clips: (Owners) Lets the owner revert all updated clips back to their original state 
prior to the update. This is useful if the owner has reviewed the changes and decided to 
reject them.

>> Revert Selected Clips: (Owners) Lets the owner revert only those clips that are selected, 
which is useful if you only want to reject a subset of changes.

Using Collaborative Workflow
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>> Reload Project: (Collaborators) If the owner has re-edited the Timeline, or made any 
grading changes, then the owner must save the project. Collaborators then use the Reload 
Project command to update the Timeline to its current state. If a collaborator has made any 
changes that haven’t been checked in, a dialog will appear offering the options to either 
check in these changes, or discard them, prior to reloading the project.

>> Automatic Update: (Owners) In order to automatically receive all published changes made 
by collaborators, without having to use the Update commands, the owner can turn on 
Automatic Update so that a check appears next to this menu command.

An Example of Collaborative Example

Here’s a brief description of how a typical collaborative workflow might work once a project has 
been set up. 

The Owner and Collaborator Open the Project

After the owner and a collaborator have opened the same project and selected the same timeline 
on which to work, the collaborator begins grading and the owner continues to edit the timeline.

Collaborators Check In Changes

Once the collaborator has finished grading a series of clips, for example grading every clip in a 
scene, the collaborator clicks the Collaboration pop-up (the bell button) and chooses Publish All 
Changes. The bell button on the owner’s workstation immediately lights up red to indicate that 
there are changes available to the owner.

A highlighted Bell button and red highlighted clips indicates changes are available

Additionally, the clips that have been graded are highlighted red as well to indicate what changes 
are available for updating and review.

A highlighted Bell button and red highlighted clips indicates changes are available
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The Owner Updates Clips

Taking a break from editing, the owner clicks the Collaboration pop-up and chooses Update All 
Clips, so the grades appear in the owned Timeline. After reviewing each changed clips, the owner 
decides one of them isn’t suitable, so the owner selects it and chooses Revert Selected Clips from 
the Collaboration pop-up to return that clip to its previous state. The owner then places a purple 
marker on that clip with a note containing further instructions.

Tip: You can filter the Timeline using the “Clips with collaborative update available” option in the 
color page to help you focus on reviewing just the updated clips.

Multiple Collaborators Working Together

If other collaborators are working together, for example an assistant colorist who’s drawing custom 
windows for the lead colorist, then each collaborator can select whatever clip they’ve finished 
and choose Update Selected Clips to check in their change. When this happens, all the other 
collaborators and the owner will see the bell button light up in red, and the altered clip highlighted 
red. Collaborators can then select the checked-in clip and choose Update Selected Clips. 

If the lead collaborator doesn’t like the change, the Revert Selected Clips command can be used 
to return that clip to its previous state. This doesn’t affect the assistant collaborator’s work, and 
the two collaborators can confer as to what new changes need to be made prior to the assistant’s 
next check-in.

Collaborators Reload the Project

To make sure these changes get back to the collaborator(s), the owner then saves the project, and 
contacts the collaborator via email, Skype, or hollering down the hall, to let them know the Timeline 
has changed. The collaborator then chooses Reload Project from the Collaboration pop-up, clicks 
Publish when prompted to publish any changes that have been made since the last check-in, and 
clicks Yes when asked to open the current project.

At this point, the collaborator’s timeline is updated to reflect the state of the owner’s timeline, 
complete with all editing changes, clips with check-ins that were reverted, and markers with notes 
that were added. The collaborator can now proceed with their work. 

If multiple collaborators are working on a project, then each collaborator must use the Reload 
Project command.
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DaVinci Resolve control panels

The DaVinci Resolve control panels are designed to meet modern workflow ergonomics and ease 
of use so colorists can quickly and accurately construct both simple and complex creative grades 
with minimal fatigue. The panels feature high resolution liquid crystal displays (LCD) and backlit 
hard keys to accommodate a darkened grading environment. The color and intensity of the keys 
and the LCD panel brightness are user programmable so each colorist can set up his/her personal 
panel configuration.

There are three panels in the control panel set. The center Trackball panel is where the majority of 
controls and feedback for the colorist are found and it includes a slide-out keyboard.

On either side of the Trackball panel are two interchangeable panels, the position of which is 
determined by operator preference. The T-bar panel, shown above on the left, has a T-bar Mix/
Wipe control and a number of menu and function keys. The Transport panel, shown above on the 
right, has the Timeline Transport controls and a Jog/Shuttle control as well as a numerical keypad 
and associated function keys.

All panels have soft keys and variable control pots within the LCD panel, which provide an accurate 
visual reference to the control without the risk of parallax errors. 

A key feature of the panel design is real-time feedback, provided to the colorist via the full color 
LCD panels where you can see, at a glance, the relative settings of the controls and a highlight of 
the last control touched. For example, if a control is out of its default reset, the panels show this with 
a selectable color highlight.

DaVinci Resolve Control Panels
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Menus, Soft Keys and Soft Pot Controls

The soft menu structure is designed to offer simultaneous control over multiple functions and a 
fast, logical and efficient way to move between the menus. These soft menus, the soft keys, and the 
operation of these in conjunction with the variable pots are covered in the preceding chapters of 
this manual as their state changes depending on the operation being performed.

You will find the LCD on each of the panels has a two-line title description of the menu’s main 
function and there are two lines of text above each pot or switch describing the control. The T-bar 
and Transport panels also have a “more” key to the bottom right of the LCD which will select a 
second layer of menus.

The T-bar and Transport panels have quite independent controls compared to the Trackball panel. 
For example, the T-bar panel’s default menu is for Windows adjustment while the default menu for 
the Transport panel is Sizing. This allows users to control windows or sizing at any time, regardless 
of the Trackball panel mode and eliminates the need to change the work surface to adjust window 
position or input sizing.

While the menus change with the GUI, the hard keys, trackballs, T-bar and shuttle control remain 
relatively constant, so the majority of this chapter describes groups and individual key functions.

Shift Key Convention

Before describing the hard key operation, it is important to understand two keys on the left and 
right panels. These shift keys, Shift Up and Shift Down, provide access to potentially two more 
functions on each of the next key selected.

For example, on the T-bar panel, next to the Shift Up key is the Base Mem key. If you select Shift Up 
and then Base Mem, the operation is to Base Mem ALL, as designated on the upper-left corner of 
the Base Mem key. To select Base Mem Current, first select Shift Down, then Base Mem. To permit 
a fast and single-handed operation, this function does not require you to hold the Shift Up or Shift 
Down key while selecting the second key; just select them sequentially, first the Shift key, then  
the function.
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Trackball Panel

The center panel has the traditional four trackballs, each with a surrounding control ring and no 
end stop in either direction. Three variable controls are on each side of the panel, three keys above 
the trackballs, three below the leftmost and rightmost trackballs, and on the LCD panel, three LCD 
displays, each with eight variable controls and four keys. The LCD screens are menu driven and thus 
the controls, soft keys, and the display itself depends on the application’s current operation.

 v

The Trackball panel includes a slide-out keyboard

The center panel offers a slide-out keyboard for naming files, stills and nodes, as well as for a 
number of other operations. The rightmost trackball operates similar to a mouse for moving the 
on-screen cursors and Power Windows and can also double as a primary grade Offset control. The 
other three trackballs, from left to right, are in the traditional DaVinci format of Lift, Gamma, and 
Gain when Resolve is set for Linear grading; when in Log grading they are Lowlights, Mid-tones, 
and Highlights.

The control ring surrounding these trackballs provides a master amplitude control of the 
associated trackball. 

On the left side of the panel are three luminance knobs. From top to bottom they are Luminance 
Gain, Gamma and Lift.

On the right side there are three more controls, from top to bottom: Saturation, Hue (has the effect 
of hue rotation), and Luminance Mix. 



RESOLVE CONTROL PANELS18

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

882

Above the three leftmost trackballs you will see three buttons for resetting the grade:

>> RGB: This key only resets the RGB balance to detent.

>> All: Select All to reset both RGB and level.

>> Level: Select the Level key to reset the level while maintaining RGB differential.

Above the rightmost trackball the three keys are:

>> Adjust Window: Selection turns on the Viewer Shape cursors for the current node and 
allows the trackball to position the current window.

>>Modes: This key allows access to a number of menus and acts as an on/off toggle.

>> Shift Up Cursor: This shift function changes the cursor views on the main monitor. The user 
can select the cursor display, including: Windows, Off, On the GUI but not the main SDI 
monitor, or displayed on both.

>> Cursor: The Cursor is used for the color picker when in Curves and Vector/Secondary 
modes. This key also controls the Window display.

Under the leftmost and rightmost trackballs there are three keys. Operation for the keys under the 
left-hand side trackball is not yet implemented.

The keys under the right-hand side trackball provide left, center, and right mouse buttons.

T-bar Panel

The T-bar panel, typically located on the left for a right-handed colorist, has an LCD display with four 
variable controls and nine soft keys. The lower section of the panel houses the T-bar and six groups 
of hard keys. Each group and their keys are described below.

Mode Control Group

The Mode Control group provides navigation to a number of the GUI pages and a few commonly 
used functions.

>> Config: This key selects the Project Setting window where you will set up DaVinci Resolve 
for each project.

>> Browse: Select Browse to call the Media page where you can review files on attached 
storage and directly access the SAN. 

>> VSR (Shift Down Browse): This selection is reserved for future use.

>> Conform: Selects the Lightbox display on the color page.

>> Shift Up Conform: Toggles the display of the Lightbox on the SDI output.
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>> Deck (Shift Up Revival): The Deck key selects the Capture mode for importing a batch list 
from an EDL.

>> Revival: This key opens the Revival Dirt and Dust-busting window.

>> Scene (Shift Down Revival): To select the Scene Cut Detection window, select the Shift 
Down key followed by the Revival key.

>> Current ~ Viewer: This key toggles between the page you are on and the Enhanced 
Viewer page.

>>Object Track Mode: This key selects the Object Tracking menus.

>> Clip/Track/Unmix: This is a toggle key between the Clip/Track modes and the Unmix mode.

>> User (Shift Up Cache Mode): This will mark a clip for render cache.

>> Cache: This key is a toggle function to select one of the cache modes. Cache All will 
background cache all clips. This operation will start when you move from the current clip 
to another. Dissolve will cache clips with dissolves. User will cache clips as marked by the 
colorist. User & Dissolve will cache clips marked for cache as well as dissolves.

>> Editor: Selects the Edit page where you can edit the Timeline, import AAF, EDL or XML’s 
and apply speed changes, Composite and Dissolve/Wipe effects etc.

>> Proxy On/Off: DaVinci Resolve has three proxy modes to permit real-time playback if 
the correction or resolution is too high for the selected playback speed. If you have  
pre-generated proxies, Resolve will use these when this key is selected. If you don’t have 
pre-generated proxies, Resolve will make high quality proxies on the fly.

>> Auto Color: This is a popular key. Using this key, DaVinci Resolve will automatically make a 
basic primary color correction to balance the blacks and whites of your image.

>> Page Up (Shift Up Gallery): In larger projects you may have a number of gallery albums 
holding stills. This key will change the Gallery page to the next higher album on the list.

>>Gallery: Used to select the Gallery GUI page where you can manage, import and export 
your stills.

>> Page Down (Shift Down Gallery): The inverse of the Shift Up Gallery function, this selects 
the Gallery album one lower than the current.

>> A/C Mode: This toggle key will display the clips in the Timeline in the order of the EDL 
(the record order, often referred to as C Mode), or the ascending order of the source clip 
timecode, called A Mode.

>> Handles Mode: This selection is reserved for future use.



RESOLVE CONTROL PANELS18

DAVINCI RESOLVE COLORIST REFERENCE MANUAL

884

Timeline Management Group

When grading clips, colorists often try different looks. This group of keys offers a quick way to 
navigate through these versions and to split and join clips on the Timeline.

>> Split (Shift Up Undo): This key will split the clip at the position of the cursor on the Timeline.

>> Undo: Undo is one of the favorite keys of colorists. Try any grade, and if you don’t like it, 
simply Undo. There are multiple steps of undo available while you are within the one page.

>> Join (Shift Up Redo): The reverse of split. Place the Timeline cursor at the junction of two 
clips that have sequential timecode and select Join to make just one clip.

>> Redo: Sometimes you hit Undo once too many times. Redo will put back into effect the last 
item you undid. As with Undo, there are multiple levels of Redo.

>> Restore Point: This selection is reserved for future use.

>> Save: Remember this key; it’s your friend. Save often, and also consider the autosave 
function found in the Config page.

>> Add Version: When you make a grade on any clip, DaVinci Resolve stores the parameters 
for that clip. If you want to try different grades, don’t lose your good grades, just use the 
Add Version feature. This key will make a second, third, or more version of the grade for 
that clip.

>> Default Version: If you have multiple versions of grades for a clip, this key is used to select 
the Default version, regardless of which version is currently displayed.

>> Previous Version: This will select the grade one version lower in order. For example, if you 
are on version three, select Previous Version to get to version two. Once the Default version 
is reached, selecting Previous Version again will select the highest version.

>>Next Version: Use this key to select the next higher version of the grade. Once the top 
version is reached, selecting Next Version again will select the DefaultKeyframing Group
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Keyframing Group

On the bottom right of the Color page is the Keyframe timeline for the current clip. The Keyframing 
group of keys is used in association with the Keyframe timeline and controls the selection of marks 
for the start and end of dynamic transitions of the grade.

>> Start Dynamic: Use Start Dynamic to select the first keyframe in a transition. The transition 
may be a grade change, resizing, the addition of a matte, or any number of 100 variables, 
all of which are associated with the node graph and the Clip or Track timeline.

>> Ripple Value: If you have a grade or effect, or just an adjustment, and you would like to 
ripple this effect over another effect or over a large number of other clips, use Ripple Value.

>> Delete: This key deletes the selected keyframe.

>> Lift Mark: If you place a keyframe in the wrong spot, put your cursor on the keyframe and 
use Lift Mark to remove it.

>> Trim: This key is used with the numerical keypad to trim a keyframe’s position.

>>Mark: Like the Start Dynamic key, Mark is a major key. It places a Static keyframe on the 
Keyframe timeline.

>> Scene (Shift Down Mark): This selection is reserved for future use.

Memory Access Group

DaVinci Resolve has a number of hot keys, called Mems, where you can store a grade for quick 
reference. In fact, every time you make a grade for a clip, a memory of the grade is kept. While you 
could save a still for each clip, having thousands of stills to scroll through would take time, so there 
are 26 quick and easy memory locations to store a grade, called A-Z Mems.

Every clip has its own metadata for the grade that is stored by DaVinci Resolve as a memory. There 
are a number of keys available to select or revert to these stored metadata memories, or to clear 
the metadata to revert to a base grade or no grade state.

All Base Mem (Shift Up Base Mem):

This is used to reset the current color correction of every node in the node graph for the 
current clip, leaving the nodes in place.

>> 	Base Mem: Used to reset the grade of the current node. 

Current Base Mem (Shift Down Base Mem): 

Will reset all the grades of nodes of the current clip.
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Please note that there is an exception to the rule to clear the Base Mem. It is possible, in fact 
very helpful sometimes, to have a clip preset that is not cleared when you select Base Mem. For 
example, when a film is over scanned and the frame edges are shown as well as the image. Instead 
of making an input resize adjustment for every clip to remove the framing, a preset resize can be 
made and stored, with a label, and this preset is not deleted when using Base Mem.

>> Preview Mem: To preview one of the Memory grades on any clip, select the clip on the 
Timeline, select Preview Mem and then the Memory letter. This key is a toggle so if you do 
not like the grade on the memory for that clip, select Preview Mem again and the grade will 
revert to the original.

>>Original Mem: Each clip by default has a memory of its grade and sizing, etc. If you 
are grading a clip and move from it to another clip, the grade for the first clip is saved 
automatically in a memory for that clip. If you come back to that clip and make a change 
to the grade, then decide you don’t like the change, select Original Mem to return to the 
grade status you found originally.

>> Scroll: When you select Scroll you can navigate up and down the Timeline to find and select 
a clip and its grade to recall to the current clip.

>> View (Shift Up Current): The Color page has two display modes. The normal mode includes 
the viewer, stills and node graph on the top of the page. Selecting View toggles to the 
alternate page with a wide Node Graph view and stills but no viewer. Select View again to 
toggle back to the normal mode.

>> Current: Select Current before selecting a Mem key (A, B, C to Z) and the current grade on 
the active timeline clip will be stored in the memory selected.

>> Shift Up: The Shift Up key permits the operator to select the upper secondary function of 
keys on the control panel. This operation does not require you to hold the Shift Up key, just 
select it prior to the second key.

>> Shift Down: The Shift Down key permits the operator to select the lower secondary function 
of keys on the control panel. This operation does not require you to hold the Shift Down 
key, just select it prior to the second key.

>>Macro: This key displays the Split Screen controls on the T-bar Panel LCD display.

>>Memory Keys: The A, B, C to Z keys, selected directly or with the appropriate Shift Up 
or Shift Down preselection will recall the grade stored in this memory and will apply it 
automatically to the clip that is active on the Timeline.
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Menu Navigation and Node Control Group

DaVinci Resolve is a nodal-based color enhancement system. Grades are not stored in layers, but 
in nodes. In operation they can appear to be in layers if you select the Serial nodes, but greater 
grading flexibility is available by using the Parallel and Layer nodes.

This group also gives you quick access to the main menus to control primaries, secondaries (known 
here as Vectors), image sizing and Windows. It also offers a quick way to add and manage nodes.

All three panels have LCD panels which display the menus

>> 	Primary: The first grade for every clip will be likely be a primary. This is where you balance 
the clip and correct for offsets in the black and white balance. Selecting Primary switches 
DaVinci Resolve from other grading modes and automatically selects the Primary menus 
for the LCD displays.

>> 	Vectors: When you select and isolate a particular color, and change that color, you are 
making a secondary correction. The Vectors key updates the menus to provide all the 
Secondary controls, including the hue selection and control.

>> 	Sizing: The input and output image resizing engines are controlled using the menus 
selected by Sizing.

>> 	Windows: The Windows key opens the menus for Circular, Linear, Polygon and PowerCurve 
windows that can be used as a matte or mask for primary and secondary grades.

>> 	Outside Node: Selecting the Outside Node key will add another node after the current 
node and automatically link both image and key paths. If the original node has a grade 
within the matte shape the new Outside node would control the grade in the inverse (i.e., 
outside the matte).

>> 	Add Matte: If there is a matte clip associated with the clip, by selecting this key the Matte 
node will be displayed on the node graph.

>> 	Disable Current: This key is a toggle key and it disables or enables the grade on the 
current node.

>> 	Delete Current: To delete the current node. Remember to use Undo if you had the wrong 
node selected.
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>>Node + CPW: Adding a Serial node is a one button selection, Add Serial, however to also 
add a window requires a number of extra key selections. The Node + CPW key adds a 
node after the current node on the node graph and simultaneously adds a Circular Power 
Window, thus reducing the number of keystrokes.

>>Node + LPW: As above, adds a Serial node after the current node with a Linear Power Window.

>>Node + PPW: A Polygon Power Window is also selected when adding a Serial node.

>>Node + PCW: This key, like the others above, adds a Serial node after the current node, but 
also sets up the PowerCurve Window to permit the marking of freeform shape points and 
Bezier spline curves on the viewer to construct a freeform window.

>> Add Serial: The most common node to use on the node graph is a Serial node. A Serial 
node is a full-featured color correction processor offering primaries, secondaries, windows, 
tracking, image stabilization, sharpening and blur, matte blur, etc. Serial nodes are added 
one after the other in a cascade mode, similar to adding one layer of correction on top of 
the last. All grades in a preceding node(s) will impact the source image and therefore the 
grades in following nodes.

>> Add Parallel: Unlike adding a Serial node, adding a Parallel node first actually adds two 
nodes. One behaves like a Serial node with full color correction capabilities. The second is 
a Parallel Mixer node. This mixer accepts the image from the original Serial node and from 
the new Serial node and the output is a mix of these two. If the current node is one of the 
Serial nodes immediately preceding the Parallel Mixer node and you select Add Parallel 
again, another input to the mixer will be created as will another preceding Serial node. 
In each case, the input to these Serial nodes will be common, effectively making them 
in parallel to each other. The key advantage is that the source image is available to many 
nodes, whereas in a straight Serial node graph, each time you restrict a color in a node the 
following nodes have little ability or limited range to use that color.

>> Add Layer: The Layer node is similar to the Parallel node in that it accepts the image 
inputs from more than one node. The key difference to a Parallel node is that the mixing 
of the inputs in a Layer node is prioritized towards the latest additions to the input list. For 
example, select Add Layer and DaVinci Resolve will add a node in parallel to the current 
node and link the output of the current and the newly made Parallel node to the two inputs 
of the Layer Mixer node. The previous current node will have the lowest priority in the mix, 
and the newly made Parallel node the highest priority. Add one more Layer node, a third 
input node will be created with a higher mix priority than the first two nodes.

>> Append Node: Often when navigating around the Node editor and making correction 
trims, the colorist decides he/she needs an additional node for more correction. Using 
the Append Node key will always add a Serial node to the very end of the node graph, 
regardless of which node in the graph is the current node.
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Reference Configuration Group

This area of the T-bar panel includes six keys and the fader T-bar. It is primarily used for control of 
stills display with and without reference wipes. The fader bar controls the mix or wipe position when 
the appropriate mode is active.

>> Key: This key is not yet implemented.

>> Circle: This key is not yet implemented.

>>Wipe: The Wipe key selects a wipe for reference comparison with the current image.

>> H/V: This key toggles the wipe between horizontal and vertical.

>> Box: This key is not yet implemented.

>>Mix: Select this key to mix in preference to wipe.

>> Still: The Still key permits comparison of the current clip with the selected still.

>>Memory: Use this key to compare the current clip with a memory.

>> Highlight: When in the Qualifier (Vector) menus making secondary qualifiers, it’s common 
to select the Highlight key to show a high contrast separation of the qualified color and all 
other parts of the image. Toggle this key to turn off. Highlight is used so often it’s also on 
the T-bar panel and, when in Vectors mode, on the Trackball panel.

>>Mode (ShiftDownHighlight): Used to toggle the Highlight mode from grey to high contrast.

>> Timeline: Select the Timeline key when you want to compare the current to the 
Timeline image.

>>Offline: Select the Offline key when you want to compare the current to the Offline image.

>> Reference On/Off: This toggle key will turn the reference view on or off. When on, you can 
see the current clip in comparison to a reference.
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Transport Panel

The Transport panel, typically located on the right for a right-handed colorist, has an LCD display 
with four variable controls and nine soft keys. The lower section of the panel houses the Jog/Shuttle 
knob and six groups of hard keys. Each group and their keys are described below.

Reference Configuration Group

Located at the top left-hand side of the Transport panel are the Deck and Still Select keys. These 
are all related to controlling the tape deck or virtual decks when in Multi-playhead mode, and to 
grabbing and selecting stills. There is also an Undo and Redo key, a Shift Up and a Save key.

>> Split (Shift Up In): DaVinci Resolve associates grading information based on source 
timecode so it’s important to have each source clip identified as a different clip from the 
others. The Split key will split one clip into two on the frame selected. Each can therefore 
have its own grade. This is a quick, accurate and easy way to split a long image sequence 
into multiple clips.

>> In: When marking an In point you can use the GUI, a keyboard shortcut, or this key.

>> Join (Shift Up Out): Join is the reverse of the Split key. If you have clips with contiguous 
timecode, place the Viewer on the first frame of a clip and select Join to merge the 
preceding clip.

>>Out: The Out key is used to select an Out point on the Timeline or deck.

>> Duration: To define a duration, first select the time using the numerical keypad (the colon 
separates the hours, minutes, seconds and frames), and then select Duration.

>>Gang: The Gang control permits the user to gang multiple clips so they will play back from 
the first frame in synchronization. This is particularly helpful for checking the impact of a 
grade on a couple of key shots when using Playheads.

>> Undo: The colorist’s friend. DaVinci Resolve has virtually unlimited Undo steps available 
within the page you are working in.

>> Redo: If you want to redo a step, use Redo. Ideal when used with Undo to compare two 
grades quickly.

>> Source (L): This key is not implemented.

>> Place (Shift Up A ( R )): This key is not implemented.

>> A ( R )): This key is not implemented.

>> F: This key is not implemented.

>> Place (Shift Up B): This key is not implemented.
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>> B: This key is not implemented.

>>G: This key is not implemented.

>> Place (Shift Up C): This key is not implemented.

>> C: This key is not implemented..

>> H: This key is not implemented.

>> D: This key is not implemented.

>> I: This key is not implemented.

>> E: This key is not implemented.

>> J: This key is not implemented.

>> Shift Up: Use the Shift Up key as a pre-selector for the keys with an upper option. Select the 
keys sequentially and do not hold the Shift Up key while selecting the second key.

>> Preroll: The Preroll key is used in conjunction with the numerical keypad to select a preroll time.

>> Cue: Selecting Cue will force the transport to the preroll position.

>> Previous Still: If you have a still selected the Previous Still key will select the one preceding.

>>Next Still: The next still is selected if this key is used.

>> Play Still: Using Play Still, DaVinci Resolve will automatically display a wipe on the Viewer 
between the current scene and the current still. You can use the fader T-bar to move the 
wipe position and in the Reference Wipe menus change the reference image as required 
by moving or resizing. Selecting Play Still a second time will toggle this mode off.

>> Save: The most important key on the panel. Besides using the auto-save feature, you can 
and should consistently save your project with this key. It only takes a few seconds and can 
save you hours.

>>Grab Still: At any time when you are grading, selecting the Grab Still key will automatically 
grab a full resolution frame from the Timeline and attach the node graph metadata for later 
display and use.
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Transport Control Keys Group

Most colorists will use the Transport Control keys every minute of every grade, so they are located 
for quick and easy access. While not technically within this key group, the Jog/Shuttle knob is 
directly above these keys.

>> Jog: Rotate the Jog control to step forward or backward a few frames at a time.

>> Shuttle: On the outside of the Jog rotary control is the Shuttle knob. This knob has a detent 
at the null position and is turned clockwise or counter clockwise to shuttle the Transport/
Timeline forward or reverse at the rate selected by the rotation of the Shuttle knob.

>> Loop: You may wish to repeat a review of a grade of a clip, or a selection of clips on the 
Timeline; this Loop toggle key selects or deselects the Loop operation.

>> Render: Once you have finished your grade, the Render key selects the Deliver page used 
for configuring the render parameters for your project and starting the render.

>> Rec: (Shift Down Render) This key is not yet implemented.

>> Previous Node: Within the Node Editor on the Color page you are likely to have a number 
of nodes. These are numbered based on the order that you added them. DaVinci Resolve 
node graphs are completely user configurable, so you can add nodes anywhere and in any 
order you like. Thus, the Previous Node key will select the node one lower in numerical order.

>>Next Node: Similar to the Previous Node key, this selects the node adjacent to the current 
node, in this case the next higher numerical position.

>> Highlight: When in the Qualifier palette making secondary qualifiers, it’s common to select 
the Highlight key to show a high contrast separation of the qualified color and all other 
parts of the image. Toggle this key to turn on or off. Highlight is used so often it’s also on 
the T-bar panel.

>>Mode: (Shift Down Highlight) Used to toggle the Highlight mode from grey to high contrast.

>> Shift Down: This is the preselection key for functions indicated on the lower portion of the 
second keys legend.

>> First Frame: Selects the first frame of the current clip.

>> Last Frame: Selects the last frame of the current clip.

>> Step Reverse: To step the viewer one frame in reverse along the Timeline.

>> Step Reverse Keyframe: (Shift Down Step Reverse) This key steps backward one keyframe 
on the Clip/Track Timeline display.

>> Step Forward: A single frame step forward for each key press.
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>> Step Forward Keyframe: (Shift Down Step Forward) For keyframe steps forward on the 
Clip/Track Timeline display.

>> Previous Scene: Selects the first frame of the previous scene.

>>Next Scene: Selects the first frame of the next scene.

>> Rewind: Places the Transport, or Timeline, in rewind.

>> Reverse: Select this key to play the Clip/Timeline in reverse.

>> Stop: You guessed it. This stops the current transport operation.

>> Forward: The Forward key will play the Clip/Timeline forward.

>> Fast Forward: The inverse of the Rewind key; fast forward shuttles along the Timeline/Transport.

Memory Access Keys Group

For fast and direct access to A to Z Memories, or Mems, use this section of the Transport panel. This 
is an extremely powerful feature. With any clip selected on the Timeline, with a single key press, 
for example “A,” the grading parameters stored in memory A, including the node structure, sizing, 
etc., will be automatically applied to the current clip.

>>O (Shift Up A): Selects memory O

>> A: Selects memory A

>> I (Shift Down A): Selects Memory I

>> R (Shift Up B): Selects memory R

>> B: Selects memory B

>> J (Shift Down B): Selects Memory J 

And so forth.

>> All (Shift Up Base Mem): This function will return all grades for all nodes on the clip to the 
default grade/settings and will clear dynamic keyframes. Note: There is an exception to 
the rule. If a Preset Size has been set for the clip, the Base Mem sizing will default to this 
preset size.

>> Base Mem: The Base Mem key clears the current node of all its grades and keyframes. 
Again, with the preset exception noted above.

>> Reset (Shift Down Base Mem Crnt): This key deletes all nodes in the clip except for the first 
node and resets the grades to default and clears the keyframes.
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>> Preview Mem: To preview one of the memory grades on any clip, select the clip on the 
Timeline, select Preview Memory and then the memory. This key is a toggle, so if you do 
not like the grade on the memory for that clip, select Preview Mem again and the clip’s 
grade will revert to the original.

>>Original Mem: Each clip, by default, has a memory of its grade, sizing, etc. The metadata 
for every clip is saved in reference to the source timecode. If you are grading a clip and 
move from it to another clip, the grade is saved automatically in a memory for that clip. If 
you come back to the clip and make a change to the grade, then decide you don’t like the 
change, select Original Mem to return to the grade status you found originally.

>> Scroll: The Scroll key selects a soft menu on the Trackball panel so clips or frames can be 
scrolled via the rotary control in the soft menu.

Numerical Entry Key Group

On the center right-hand side of the Transport panel is the Numerical Entry key group. Here you 
will find numbers 0 to 9 and associated keys for entering timecode and clip numbers. You will notice 
the numbers you type are displayed in a scratchpad area at the bottom of the Keyframe palette.

>> Current: To store a new grade in any memory, first select the Current key and then the 
memory of your choice.

>> All Color PTZR: This key is a toggle that selects the parameters that will be copied when 
updating a grade. Generally, all aspects of the grade are copied, including the pan, tilt, 
zoom and rotation sizing transforms, but on occasion you may wish to copy only the grade 
and not the sizing parameters. In this case, use the All/Color/PTZR to select the mode you 
need. You can see the Keyframe Timeline toggle between the master or the node selected 
and the input PTZR parameters.

>> Select Node: Use this key in conjunction with the numerical keys to select any node on 
the current node graph. First, select the node number, and then Select Node. The current 
node will change to the selected node.

>> Backspace: The Backspace key moves you one item left in the numerical scratch pad 
display. This permits correction of your numerical entries.

>> 0 to 9: You guessed it. These are the numbers!

>> , (Comma): The comma is used just before the frame count if you wish to indicate a drop 
frame timecode.

>> : (Colon): When typing in timecode, the convention is to type the hours followed by a colon, 
then the minutes, a colon, the seconds, a colon, and finally the frames. DaVinci Resolve does 
not need to have leading numbers entered where they offer no value and the default value 
is 0, so to type one hour, three minutes, zero seconds and sixteen frames, you do not need 
to type 01:03:00:16. Simply type 1:3::16 and then press Enter. This speeds timecode entry.
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>> Clear: Will clear the scratchpad number.

>> - (Minus): Select the Minus key prior to the number to reduce the number.

>> + (Plus): Select the Plus key prior to a number to increase the number.

>> Take/Enter: Select the Take/Enter key to accept or enter any input.

Keyframing Group

The Keyframe keys are on the bottom right-hand side of the Transport panel. The functions are 
replicated on the T-bar panel. On the bottom right of the Color page is the Keyframe timeline for 
the current clip in the Timeline. The Keyframe group of keys is used in association with the Keyframe 
timeline and controls the selection of keyframes for the start and end of dynamic transitions of  
the grade.

>> Start Dynamic: This key is used to select the first point in a transition, a Dynamic keyframe. 
The transition may be a grade change, a sizing or reposition, or the addition of a matte or 
any number of 100 variables, all of which are associated with the Node Editor and the Clip 
or Track Keyframe timeline.

>> Ripple Value: If you have a grade or effect, or just an adjustment and you would like to 
ripple this effect over another effect or a large number of other clips, use Ripple Value.

>> Delete: This key deletes the keyframe.

>> Lift Mark: If you place a keyframe in the wrong spot, put your cursor on the keyframe and 
use Lift Mark to remove it.

>> Trim: This key is used with the numerical keypad to trim a keyframe position.

>>Mark: Like the Start Dynamic key, Mark is a major key. It places a Static keyframe on the 
Clip Timeline.

>> Scene (Shift Down Mark): This selection is reserved for future use.
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